Note • Before using this information and the product it supports, read the information in Appendix E, Notices.
# Table of Contents

## Preface

- Who Should Read This Guide .................................................. xv
- What This Guide Contains ..................................................... xvi
- Related Publications ............................................................ xvii
- Contacting Customer Support .................................................. xvii
- Conventions Used in This Guide ............................................... xviii
  Terminology: Reports, Spreadsheets, and Graphs xviii

## 1 • About ITUAM

- What Is ITUAM? ................................................................. 1-2
- Benefits of ITUAM ............................................................. 1-2
- System Features ............................................................... 1-3

### ITUAM System Component Overview .................................... 1-4

- ITUAM Data Collectors .......................................................... 1-4
- ITUAM Application Server ..................................................... 1-4
- Database Server ............................................................... 1-7
- Web Server ........................................................................ 1-8

### About CSR and CSR+ Files .................................................. 1-10

- ITUAM System Architecture Diagram—ITUAM on Windows Only .................................................. 1-12
- ITUAM System Architecture Diagram—ITUAM on Windows and on UNIX or Linux .......................... 1-13
2 • Installing ITUAM on Windows and Getting Started

ITUAM System Components ............................................................... 2-3

System Specifications ................................................................. 2-5
Server Specifications ................................................................. 2-5
Client Specifications ................................................................. 2-8
Report Design Specifications ....................................................... 2-9

Pre-Installation Setup ................................................................. 2-9
System Setup Checklist .............................................................. 2-10
Internationalization Setup ......................................................... 2-13
Enabling ASP.NET (Windows 2003 Server Only) ......................... 2-17

Installing SQL Server Reporting Services .................................... 2-18
About Licensing Reporting Services ............................................ 2-18
Overview of Reporting Services Components .......................... 2-18
System Requirements for Reporting Services ............................ 2-19
Installing Reporting Services ...................................................... 2-20

Installing Crystal Reports ........................................................... 2-20

About ITUAM Installation ............................................................ 2-23
Example Installations ................................................................. 2-25

Installing ITUAM ........................................................................ 2-26
Installing the Base Package ......................................................... 2-26
Installing the Base Collector Package ......................................... 2-29
Installing the TDSz Collector Package ....................................... 2-30
Installing All Other Collector Packages .................................. 2-31
Modifying an Existing Installation ............................................ 2-32

Upgrading to a New Release of ITUAM ........................................ 2-32

Setting Up a Windows Account for ITUAM ................................. 2-34
Using an ITUAMUser Account ..................................................... 2-34
Using a Local System or Other Windows Account ..................... 2-36

Setting Up and Connecting to a Database ................................. 2-38
About ITUAM Data Sources ....................................................... 2-38
Backing Up the Database ......................................................... 2-39
Setting Up and Connecting to a DB2 for Linux, UNIX, and Windows Database .................. 2-40
Setting Up and Connecting to a DB2 for z/OS Database .............. 2-49
Setting Up and Connecting to a Microsoft SQL Server Database .................................................. 2-60
Setting Up and Connecting to an Oracle Database .................... 2-72
Setting Up and Connecting to an MSDE Database ..................... 2-79
# Table of Contents

**Getting Started** .................................................................2-83
Set Up ITUAM .................................................................2-83
Increase the Event Viewer Maximum Log Size ................................2-92
Set Up the Web Server .........................................................2-93
Set Up SQL Server Reporting Services ....................................2-98
Set Up Crystal Reports .........................................................2-105
Start ITUAM Web Reporting ................................................2-110
Troubleshooting .................................................................2-111

Starting ITUAM Administrator from IBM Director ....................2-111
Moving and Resizing Dialog Boxes .........................................2-111
Viewing Online Help ............................................................2-111

**3 • Installing ITUAM on UNIX/Linux and Getting Started**

ITUAM System Components ..................................................3-3
System Specifications ........................................................3-4
Installing Perl .................................................................3-5
Installing ITUAM ...............................................................3-5
System Setup Checklist .......................................................3-6
About ITUAM Installation ....................................................3-7
Installing ITUAM Processing Engine and ITUAM Data Collectors for UNIX and Linux ................................3-11

Installing JDBC Drivers .......................................................3-13
Installing and Setting Up the DB2 JDBC Driver .......................3-13
Installing the SQL Server JDBC Drivers ................................3-16
Installing the Oracle JDBC Driver ..........................................3-16
Installing Other JDBC Drivers ..............................................3-17

Setting Up and Connecting to a Database ................................3-18
About ITUAM Data Sources ..................................................3-18

Getting Started .................................................................3-19
Set Up the ITUAMDBConfig.xml Configuration File ..................3-19
About the ituam.par File ......................................................3-25
Working With the processes Directory ...................................3-26
Run a Sample Process .........................................................3-27
# Table of Contents

## 4 • Setting Up the System

- Setting Up the Account Code Structure ........................................ 4-3
  - Account Code Structure Example ............................................. 4-3
  - Defining the Account Code Structure ...................................... 4-4
  - Defining Alternate Account Code Structures .............................. 4-8
- Working With Rates ................................................................. 4-9
  - Defining Rate Codes ............................................................... 4-9
  - Defining Alternate Rate Tables ............................................... 4-15
  - Defining Rate Groups .............................................................. 4-16
- Working With Clients ............................................................... 4-19
  - Defining Clients .......................................................................... 4-19
  - Setting Up Client Budgets ......................................................... 4-21
  - Defining Client Contacts ......................................................... 4-24
- Setting Up a Calendar ............................................................... 4-25
  - Setting Up Calendar Information .............................................. 4-25
  - Using 13 Accounting Periods .................................................... 4-26
  - Calendar Considerations ......................................................... 4-26
- Working With Users and Groups ................................................ 4-27
  - Default Administrator User and Group ..................................... 4-27
  - Defining Users ............................................................................ 4-27
  - Defining User Groups ................................................................. 4-32
- Using Web Reporting Headlines .................................................. 4-38
- Maintaining Identifiers ............................................................... 4-39
- Configuring System Settings ...................................................... 4-41
  - Organization Information ......................................................... 4-42
  - Processing Settings ................................................................. 4-43
  - Reporting Settings ..................................................................... 4-44
  - Database Settings ..................................................................... 4-46
  - Web Settings .............................................................................. 4-47
  - Table Audit Settings ................................................................... 4-52
  - Database Load Archive Settings .............................................. 4-53
  - Configuration Options ............................................................... 4-54
## 5 • Report Administration

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About ITUAM Reports</td>
<td>5-3</td>
</tr>
<tr>
<td>Location of ITUAM Reports</td>
<td>5-3</td>
</tr>
<tr>
<td>Types of ITUAM Reports</td>
<td>5-4</td>
</tr>
<tr>
<td>Tables Used for Reports</td>
<td>5-5</td>
</tr>
<tr>
<td>CIMSSummary Table</td>
<td>5-5</td>
</tr>
<tr>
<td>CIMSDetail Table</td>
<td>5-6</td>
</tr>
<tr>
<td>CIMIdentTable and CIMSDetailIdent Tables</td>
<td>5-9</td>
</tr>
<tr>
<td>Defining Decimal Positions for Unit, Rate, and Money Values in Reports</td>
<td>5-10</td>
</tr>
<tr>
<td>Defining Decimal Positions for Money Values in the CIMSSummary Table</td>
<td>5-11</td>
</tr>
<tr>
<td>Customizing Report Parameters (Optional)</td>
<td>5-14</td>
</tr>
<tr>
<td>Creating Custom Parameters for Web Reports</td>
<td>5-14</td>
</tr>
<tr>
<td>Creating Custom Parameters for Batch Reports Only</td>
<td>5-16</td>
</tr>
<tr>
<td>Saving Custom Parameters</td>
<td>5-16</td>
</tr>
<tr>
<td>Adding Reports to the Report List</td>
<td>5-17</td>
</tr>
<tr>
<td>Defining Report Groups</td>
<td>5-19</td>
</tr>
<tr>
<td>Changing the Logo in Reports</td>
<td>5-22</td>
</tr>
<tr>
<td>Working With Batch Reporting/Published Reports</td>
<td>5-23</td>
</tr>
<tr>
<td>Creating Published Reports</td>
<td>5-23</td>
</tr>
<tr>
<td>Distributing Published Reports</td>
<td>5-24</td>
</tr>
<tr>
<td>Storing Published Reports Using the Published Folder Structure</td>
<td>5-25</td>
</tr>
<tr>
<td>Deleting Published Reports</td>
<td>5-26</td>
</tr>
<tr>
<td>Creating a Report Cycle</td>
<td>5-27</td>
</tr>
<tr>
<td>Running a Report Cycle</td>
<td>5-44</td>
</tr>
<tr>
<td>Folder Permissions Required for Publishing and Viewing Batch Reports</td>
<td>5-48</td>
</tr>
<tr>
<td>Creating a Virtual Directory for the Published Folder</td>
<td>5-49</td>
</tr>
<tr>
<td>Drilling Down in Published Reports</td>
<td>5-50</td>
</tr>
</tbody>
</table>
6 • Database Administration

Creating a Database ................................................................. 6-2
Creating a Database in Microsoft SQL Server ............................ 6-2
Creating a Database in MSDE 2000 ........................................... 6-3
Creating an ITUAM Data Source and Initializing the Database ..... 6-4

Backing Up and Maintaining Databases .................................. 6-4

Setting the Database Recovery Model .................................... 6-5

Managing ITUAM Data Sources .............................................. 6-5
Setting a ITUAM Data Source as the Web Site/ITUAM Data Collectors Default .......... 6-6

Using Multiple Databases for ITUAM Web Reporting .................. 6-8

Managing Database Tables .................................................... 6-10
Loading and Exporting Tables ............................................... 6-11
Loading and Exporting Client and Rate Tables .......................... 6-12
Creating and Dropping Tables ............................................... 6-13
Converting Daily Summary Tables to a Monthly Summary Table .... 6-13
Updating the Rate Identifiers Table ........................................ 6-13
Viewing Tables ........................................................................ 6-13

Managing Database Objects ................................................... 6-14
Creating and Dropping Database Objects .................................. 6-15

Loading, Archiving, and Purging the Database ......................... 6-17
Loading the Database .............................................................. 6-17
Archiving, Purging, and Restoring Database Loads ..................... 6-19
Tracking the History of Database Loads ................................... 6-22

Profiling the Database and Tables ........................................... 6-24
Upgrading the Database .......................................................... 6-25
# 7 • Processing Data on Windows

**About Processing Data** ..................................................... 7-3

**Data Processing Frequency** ........................................... 7-4

**Required Folder or Directory Permissions for Data Processing** ........ 7-5

**ITUAM Processing Engine Components** .................................. 7-6

- CIMSAcct ................................................................. 7-7
- CIMSSort ................................................................. 7-11
- CIMSBill ................................................................. 7-11
- CIMSAdminLib ......................................................... 7-15
- ITUAM Processing Engine Architecture Diagram ....................... 7-16

**Account Codes and Account Code Conversion** .......................... 7-17

- About Exception File Processing ....................................... 7-17

**Accounting Dates** .......................................................... 7-18

- About the Close Date ...................................................... 7-18
- How Accounting Dates Are Calculated ................................ 7-19

**ITUAM Administrator Processing** ....................................... 7-21

- Adding Process Definitions ............................................... 7-22
- Setting Process Definition Options ..................................... 7-23
- Processing Data Using ITUAM Administrator .......................... 7-38
- Viewing Events ............................................................... 7-38

**Setting Up Account Codes and Performing Account Code Conversion** .................................................. 7-40

- Defining the Account Code Structure ................................... 7-40
- Defining the Account Code .................................................. 7-41
- Setting the Account Code Conversion Options .......................... 7-43
- Creating an Account Code Conversion Table ........................... 7-45
- Account Code Conversion Example ....................................... 7-47

**Prorating Resources** ......................................................... 7-50

- Prorating Resources vs. Prorating Money ................................ 7-55

**Normalizing CPU Values** ................................................... 7-56

**Include/Exclude Processing** ............................................... 7-59

**Rebilling Rate Codes After Changing Rate Code Values or Conversion Factors** ............................................. 7-65
8 • Processing Data on UNIX or Linux

About Processing Data ................................................................. 8-3
Data Processing Frequency ......................................................... 8-3
Required Folder or Directory Permissions for Data Processing .......... 8-4

ITUAM Processing Engine Components ...................................... 8-5
CIMSAcct ............................................................... 8-6
CIMSSort ........................................................... 8-10
CIMSBill .......................................................... 8-10
CIMSSSort .......................................................... 8-13
CS_libs .............................................................. 8-14
CS_aggtools .......................................................... 8-14
ITUAM Processing Engine Architecture Diagram ......................... 8-15

Setting Up the Control File (ProcCntl.xml) ................................. 8-16
Control File Example ............................................................. 8-16
Control File Structure ............................................................. 8-17

Accounting Dates ........................................................................ 8-26
About the Close Date ................................................................. 8-26
How Accounting Dates Are Calculated ....................................... 8-27

Account Codes and Account Code Conversion .............................. 8-30
About Exception File Processing ................................................ 8-30

Setting Up Account Codes and Performing Account Code Conversion 8-31
Defining the Account Code Structure ............................................ 8-31
Defining the Account Code ........................................................ 8-32
Setting the Account Code Conversion Options ............................. 8-34
Creating an Account Code Conversion Table ............................... 8-36
Account Code Conversion Example ........................................... 8-39

Setting Up Shifts ......................................................................... 8-41
Using the SHIFT Control Statement ............................................ 8-42

Normalizing CPU Values ............................................................. 8-44

Include/Exclude Processing ........................................................ 8-46

Processing Data: Setting Up the Data Processing Scripts ................. 8-47
Nightly Script (nightly.sh) .......................................................... 8-47
Nightly Job Script (nightly.pl) ..................................................... 8-49
Processing Script (procCIMS.pl) .................................................. 8-49
9 • Working With ITUAM Financial Modeler

About ITUAM Financial Modeler ....................................................... 9-2
Installing ITUAM Financial Modeler .............................................. 9-2
Starting ITUAM Financial Modeler .................................................. 9-3
Logging On to ITUAM Financial Modeler ....................................... 9-3
Getting Started—Open or Create a Cost Model ............................... 9-3
Opening an Existing Cost Model ..................................................... 9-3
Creating a New Cost Model ............................................................ 9-4
Setting Up Cost Models ............................................................... 9-5
Creating Budgets ........................................................................... 9-5
Adding and Removing Cost Pools and Subpools .............................. 9-6
Distributing Budgeted Costs ............................................................ 9-7
Adding and Removing Rate Codes .................................................. 9-8
Calculating Rates .......................................................................... 9-9
Sharing the Cost Model ................................................................ 9-15
Managing Cost Models .................................................................. 9-16

Working With Reports ..................................................................... 9-17
Running Reports ........................................................................... 9-17
Saving, Printing, and Editing Reports .............................................. 9-21

10 • Working With ITUAM Web Console

About ITUAM Web Console ............................................................ 10-2
Setting Up and Starting ITUAM Web Console ................................. 10-2
Configuring IIS for Apache Tomcat ................................................ 10-2
Starting ITUAM Web Console ........................................................ 10-3
Logging On to ITUAM Web Console ................................................ 10-4
Viewing Job Logs ........................................................................... 10-4
# Table of Contents

## 11 Troubleshooting and Additional Information

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Installation Problems</strong></td>
<td>11-3</td>
</tr>
<tr>
<td>Unable to launch regasm.exe error is displayed</td>
<td>11-3</td>
</tr>
<tr>
<td><strong>Data Processing Problems</strong></td>
<td>11-3</td>
</tr>
<tr>
<td>General data processing problems</td>
<td>11-3</td>
</tr>
<tr>
<td>When account codes are converted using CIMSAcct, some records seem to be lost</td>
<td>11-3</td>
</tr>
<tr>
<td><strong>System Problems</strong></td>
<td>11-4</td>
</tr>
<tr>
<td>A prompt for the Windows installation CD is displayed while you are using ITUAM Administrator</td>
<td>11-4</td>
</tr>
<tr>
<td>Performance of the ITUAM system is slow</td>
<td>11-4</td>
</tr>
<tr>
<td>Computer “locks up”, provides unexpected results, or seems to run very slowly</td>
<td>11-4</td>
</tr>
<tr>
<td><strong>Web Reporting Problems</strong></td>
<td>11-5</td>
</tr>
<tr>
<td>Problems accessing the Web site or generating reports</td>
<td>11-5</td>
</tr>
<tr>
<td>An error message is displayed when ActiveX Data Objects (ADO) or ODBC is used to open a database connection in an ASP page</td>
<td>11-12</td>
</tr>
<tr>
<td><strong>Database Connection Problems</strong></td>
<td>11-13</td>
</tr>
<tr>
<td>An error message is displayed when selecting an ITUAM Data Source (Oracle only)</td>
<td>11-13</td>
</tr>
<tr>
<td>The ITUAM Web Reporting Session Is Lost (Oracle only)</td>
<td>11-13</td>
</tr>
<tr>
<td><strong>Crystal XI Problems</strong></td>
<td>11-14</td>
</tr>
<tr>
<td><strong>SQL Server Reporting Services Problems</strong></td>
<td>11-15</td>
</tr>
<tr>
<td>Report Server cannot decrypt the symmetric key message is displayed</td>
<td>11-15</td>
</tr>
<tr>
<td>The user account does not have adequate permissions message is displayed when you try to generate a report</td>
<td>11-15</td>
</tr>
<tr>
<td><strong>Executing Stored Procedures to Debug ITUAM</strong></td>
<td>11-16</td>
</tr>
<tr>
<td><strong>Creating a Test Database for Troubleshooting</strong></td>
<td>11-17</td>
</tr>
<tr>
<td>Option 1: Using the SaveDBSQLServer.wsf Script</td>
<td>11-17</td>
</tr>
<tr>
<td>Option 2: Exporting Data From a Database</td>
<td>11-18</td>
</tr>
<tr>
<td>Loading Data Into a Test Database</td>
<td>11-19</td>
</tr>
<tr>
<td><strong>Performing Disaster Recovery</strong></td>
<td>11-21</td>
</tr>
<tr>
<td><strong>About ITUAM Data Sources for SQL Server Databases</strong></td>
<td>11-22</td>
</tr>
<tr>
<td><strong>Installing Crystal Reports 9</strong></td>
<td>11-24</td>
</tr>
<tr>
<td><strong>Installing Crystal Reports 10</strong></td>
<td>11-25</td>
</tr>
</tbody>
</table>
### A • Database Tables

- **CIMSAuditClient Table**  
  A-4
- **CIMSAuditClientContact Table**  
  A-5
- **CIMSAuditClientContactNumber Table**  
  A-7
- **CIMSAuditRate Table**  
  A-9
- **CIMSAuditTransactionTable**  
  A-11
- **CIMSCalendar Table**  
  A-14
- **CIMSClient Table**  
  A-14
- **CIMSClientBudget Table**  
  A-15
- **CIMSClientContact Table**  
  A-16
- **CIMSClientContactNumber Table**  
  A-17
- **CIMSConfigTable**  
  A-18
- **CIMSConfigOptions Table**  
  A-20
- **CIMSConfigAccountLevel Table**  
  A-21
- **CIMSCPUNormalization Table**  
  A-21
- **CIMSDetail Table**  
  A-22
- **CIMSDetailIdent Table**  
  A-23
- **CIMSHheadline Table**  
  A-23
- **CIMSGlobalTable**  
  A-24
- **CIMSGlobalIdent Table**  
  A-24
- **CIMSGlobalCategory Table**  
  A-24
- **CIMSGlobalCategorySource Table**  
  A-24
- **CIMSGlobalMachineList Table**  
  A-24
- **CIMSLanguage Table**  
  A-25
- **CIMSLoadTracking Table**  
  A-26
- **CIMSRate Table**  
  A-28
- **CIMSRateGroup Table**  
  A-31
- **CIMSRateIdentifiers Table**  
  A-31
- **CIMSRateShift Table**  
  A-32
- **CIMSRateToRateGroup Table**  
  A-33
- **CIMSSreport Table**  
  A-33
- **CIMSSreportCustomFields Table**  
  A-34
- **CIMSSreportDistribution Table**  
  A-34
## Table of Contents

- **CIMSGlobalReportDistributionCycle Table** ..................................................... A-35
- **CIMSGlobalReportDistributionParm Table** ..................................................... A-36
- **CIMSGlobalReportDistributionType Table** ..................................................... A-36
- **CIMSGlobalReportGroup Table** ..................................................................... A-36
- **CIMSGlobalReportStart Table** ...................................................................... A-37
- **CIMSGlobalResourceToReportGroup Table** .................................................... A-37
- **CIMSGlobalResourceUtilization Table** .......................................................... A-38
- **CIMSGlobalSummary Table** ......................................................................... A-39
- **CIMSGlobalSummaryDaily Table** .................................................................. A-42
- **CIMSGlobalSummaryToDetail Table** ............................................................. A-42
- **CIMSGlobalTransaction Table** ..................................................................... A-43
- **CIMSGlobalUser Table** ................................................................................. A-45
- **CIMSGlobalUserConfigOptions Table** ............................................................ A-46
- **CIMSGlobalUserFavorites Table** ................................................................. A-46
- **CIMSGlobalUserGroup Table** ....................................................................... A-47
- **CIMSGlobalUserGroupAccountCode Table** ................................................... A-48
- **CIMSGlobalUserGroupAccountStructure Table** ........................................... A-48
- **CIMSGlobalUserConfigOptions Table** ............................................................ A-48
- **CIMSGlobalUserGroupReport Table** ............................................................. A-50
- **Database Entity Relationship Diagrams** ....................................................... A-51
- **Summary-Related Tables** ............................................................................... A-52
- **Client Tables** ................................................................................................. A-53
- **User Tables** .................................................................................................... A-53
- **Report Tables** ................................................................................................. A-54
- **Report Distribution Tables** ........................................................................... A-55
- **Transaction-Related Tables** ........................................................................... A-56

## B • File Layouts

- **CSR File** ........................................................................................................ B-2
- **CSR+ File** ....................................................................................................... B-4
- **CIMSAcct Detail File** ....................................................................................... B-7
- **Ident File** ......................................................................................................... B-8
- **CIMSBill Detail File** ........................................................................................ B-9
- **Summary File** .................................................................................................. B-11
C \ Scripts

Running Scripts ............................................................................. C-3
Running Scripts Using Job Runner ............................................. C-3
Running Scripts Using a Batch File ........................................... C-5

General Scripts ............................................................................. C-6
BuildCSRFromDB.wsf Script ...................................................... C-6
CIMSLib.wsf Script ................................................................ C-7
CIMSUtils.wsc Script ................................................................. C-7
ClientPropagate.wsf Script ......................................................... C-7
ConvertSummaryDailyToMonthly.wsf Script ......................... C-8
CSRAggregator.wsf Script ........................................................... C-11
DropIdentFromDB.wsf Script ...................................................... C-12
DropIdentBeforeLoad.wsf Script .............................................. C-12
FTP.wsc and FTPSample.wsf Scripts ....................................... C-13
ListUnusedIdentifiers.wsf .......................................................... C-13
OracleLogonTrigger.bat Script ............................................... C-14
ProRate.wsf Script ................................................................ C-16
PurgeLoads.wsf Script ................................................................. C-17
Rebill.wsf and ResourceConversion.wsf Scripts .................. C-19
SampleBulkUserLoad.wsf Script ............................................. C-22
SampleExportSummary.wsf Script ........................................... C-23
SampleSQLMaintenance.bat Script .................................... C-24
SaveDBSQLServer.wsf ............................................................... C-26
Schedule.wsf ........................................................................... C-26
Table.wsf Script ................................................................ C-27
ZeroCost.wsf Script ................................................................ C-28

Batch Reporting Scripts ............................................................... C-29
ReportDistribution.wsf Script ................................................ C-30
BatchReport.wsf Script ............................................................... C-31
AllAccts.wsf Script ................................................................ C-38
EmailDistribution.wsf Script ................................................ C-40

Client Load Scripts ..................................................................... C-42
LoadClientTableFromCSVFile.wsf Script ................................. C-42

Data Source Parameters ............................................................. C-42
Table of Contents

D  •  Control and Processing Statements

ITUAM Processing Engine Control Statements (Windows) ........................................ D-2
CIMSAcct Control Statements .................................................................................. D-2
CIMSBill Control Statements .................................................................................. D-13
Processing Control Statements .............................................................................. D-24

ITUAM Processing Engine Control Statements (UNIX or Linux) ......................... D-26
CIMSAcct Control Statements ................................................................................ D-26
CIMSBill Control Statements .................................................................................. D-35

E  •  Notices

Trademarks ........................................................................................................ E-3

Glossary

Index
Preface

This guide provides a comprehensive set of procedures and references for installing, configuring, and managing the components that compose the IBM® Tivoli® Usage and Accounting Manager system.

For the purposes of world-wide marketing, IBM Tivoli Usage and Accounting Manager is sometimes referred to as IBM Usage and Accounting Manager or ITUAM. Users of this product may see these names in presentations and product collateral. For the purposes of this guide, the product is referred to as ITUAM unless referring to another document or entity that contains the full name.

Who Should Read This Guide

This guide is for system administrators responsible for the deployment and administration of ITUAM and its related components.

Readers should be familiar with the following:

- Microsoft® Windows® operating system and the following Microsoft products and technologies:
  - Internet Explorer
  - ASP.NET
  - .NET Framework 1.1
  - Component Object Model (COM)
  - Windows Script Host (WSH)
- Relational database architecture and concepts
- Extensible Markup Language (XML)
What This Guide Contains

The following table describes the chapters in this guide. If you are installing and setting up ITUAM for the first time, you should begin with Chapter 1, About ITUAM and then continue to Chapter 2, Installing ITUAM on Windows and Getting Started and Chapter 3, Installing ITUAM on UNIX/Linux and Getting Started (if you are using a UNIX® or Linux® system for data processing) before continuing to the other chapters in the guide.

Note • Because Windows server is required for database administration and Web reporting, you need to complete the installation and setup steps in Chapter 2, Installing ITUAM on Windows and Getting Started even if you are performing data processing on a UNIX of Linux system.

<table>
<thead>
<tr>
<th>Ch. No.</th>
<th>Chapter Name</th>
<th>Content Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>About ITUAM</td>
<td>Describes the overall structure and feature set of the ITUAM system.</td>
</tr>
<tr>
<td>2</td>
<td>Installing ITUAM on Windows and Getting Started</td>
<td>Discusses the installation of the ITUAM system components on Windows and provides a Getting Started section. Also provides information for setting up and connecting to a database.</td>
</tr>
<tr>
<td>3</td>
<td>Installing ITUAM on UNIX/Linux and Getting Started</td>
<td>Discusses the installation of the ITUAM system components on UNIX or Linux and provides a Getting Started section.</td>
</tr>
<tr>
<td>4</td>
<td>Setting Up the System</td>
<td>Explains how to configure the various components of the system.</td>
</tr>
<tr>
<td>5</td>
<td>Report Administration</td>
<td>Describes how to administer and distribute reports.</td>
</tr>
<tr>
<td>6</td>
<td>Database Administration</td>
<td>Describes how to use ITUAM Administrator to create and administer databases.</td>
</tr>
<tr>
<td>7</td>
<td>Processing Data on Windows</td>
<td>Provides an overview of the data processing cycle on a Windows system.</td>
</tr>
<tr>
<td>8</td>
<td>Processing Data on UNIX or Linux</td>
<td>Provides an overview of the data processing cycle on a UNIX or Linux system.</td>
</tr>
<tr>
<td>9</td>
<td>Working With ITUAM Financial Modeler</td>
<td>Describes ITUAM Financial Modeler. This Web-based application provides an interface for performing IT finance-related tasks, such as cost analysis and allocation and rate calculation.</td>
</tr>
<tr>
<td>10</td>
<td>Working With ITUAM Web Console</td>
<td>Describes ITUAM Web Console. This Web-based application provides a Web-based interface for viewing job logs.</td>
</tr>
</tbody>
</table>
As you use this guide, you might find it helpful to have these additional guides available for reference:

- **IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide**
- **IBM Tivoli Usage and Accounting Manager Data Collectors for Microsoft Windows User’s Guide**
- **IBM Tivoli Usage and Accounting Manager Data Collectors for UNIX and Linux User’s Guide**

**Contacting Customer Support**

Before contacting IBM Tivoli Software Support with a problem, refer to the IBM Tivoli Software Support site by clicking the Tivoli link at the following Web site:

http://www.ibm.com/software/support/

If you need additional help, contact software support by using the methods described in the IBM Software Support Guide at the following Web site:

http://techsupport.services.ibm.com/guides/handbook.html

The IBM Software Support Guide provides the following information:

- Registration and eligibility requirements for receiving support.
- Telephone numbers, depending on the country in which you are located.
- A list of information you should gather before contacting technical support.
## Conventions Used in This Guide

Some or all of the following conventions are used in this guide:

<table>
<thead>
<tr>
<th>Symbol or Type Style</th>
<th>Represents</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alternate color</td>
<td>hyperlinked cross-references to other sections or chapters in this guide; if you are viewing this guide online, you can click the cross-reference to jump directly to its location</td>
<td>...see Chapter 1, About ITUAM.</td>
</tr>
<tr>
<td><strong>Italic</strong></td>
<td>words that are emphasized</td>
<td>...the entry <em>after</em> the current entry...</td>
</tr>
<tr>
<td></td>
<td>a new term</td>
<td>...called a <em>source object</em>.</td>
</tr>
<tr>
<td></td>
<td>the titles of other manuals</td>
<td><em>IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide</em></td>
</tr>
</tbody>
</table>
|                      | variables in file names or system names | *IUSR_computername*  
*AcctExcp-yyyyymmdd.txt* |
| **Bold**             | names of interface items such as tabs, boxes, buttons, lists, and check boxes. | Select the **Use 13 Periods** check box  
Enter the path in the **Process Definition Path** box |
| **Monospace**        | directories, file names, command names, computer code, computer screen text, system responses, command line commands, what the user types | *Processes folder*  
*BatchReport.wsf*  
*script*  
*Type*  
*inetmgr* |
| `< >`                | the name of a key on the keyboard | Press `<Enter>` |
| ‣                    | navigating a menu or a folder | File › Import › Object |

### Terminology: Reports, Spreadsheets, and Graphs

For simplicity, in this guide, the term “report” refers to reports, spreadsheets, and graphs.
About ITUAM

This chapter describes the overall structure, benefits, and features of the ITUAM system.

What Is ITUAM? ................................................................. 1-2
Benefits of ITUAM ............................................................. 1-2
System Features ............................................................... 1-3

ITUAM System Component Overview .................................... 1-4
ITUAM Data Collectors ....................................................... 1-4
ITUAM Application Server .................................................. 1-4
Database Server ............................................................... 1-7
Web Server ................................................................. 1-8

About CSR and CSR+ Files ..................................................1-10
ITUAM System Architecture Diagram—ITUAM on Windows Only ................. 1-12
ITUAM System Architecture Diagram—ITUAM on Windows and on UNIX or Linux ........ 1-13
About ITUAM
What Is ITUAM?

What Is ITUAM?
ITUAM is a full-featured resource accounting and chargeback system that enables users to consolidate accounting data from multiple IT resources into a common output format for costing and reporting. This output is database ready and may be used for multiple purposes such as reporting and as a feed to internal or third-party systems.

ITUAM tracks usage data associated with:
- Operating systems
- Databases
- Network systems
- Storage systems
- Internet systems
- E-mail systems
- Other applications or monitors that create usage metering data

Benefits of ITUAM
Keeping track of IT usage can be a formidable task for any organization. Most sizable enterprises consist of many platforms, systems, and subsystems, each costly to own, maintain and operate. In addition, each component has its own unique record format and metrics.

With ITUAM, you can process, access, and analyze IT resource usage metrics from many IT resources and view the results right in your Web browser. ITUAM helps you to better understand who is using IT resources and how the resources are being used.

The following are just a few of the benefits of ITUAM:
- Enterprise-wide cost analysis of IT systems. ITUAM enables enterprise-wide cost analysis of IT systems. ITUAM allows you to allocate, distribute, or charge IT costs to users, cost centers, and organizations in a manner that is fair, understandable, reproducible, and easy to administer.

- Centralized data processing. ITUAM centralizes the processing of your accounting data on one computer and allows you to view the data on the Web via extensive customizable reporting features. It is possible to view both high-level and detailed information with a few clicks of a mouse.

- Full data access and reporting capabilities. ITUAM integrates Microsoft SQL Server Reporting Services or Crystal Reports with a Database Management System (DBMS) to give your enterprise full data access and reporting capabilities.
System Features

ITUAM features include:

- Report, spreadsheet, and graph generation and viewing via the Web.
- Batch processing and report generation. (You can also run processes and reports individually.)
- Multi-level drill down capabilities to view detailed cost and usage information in reports.
- Integration with ITUAM Data Collectors.
- Up to 128-byte account code with powerful account code conversion.
## About ITUAM

**ITUAM System Component Overview**

This section provides an overview of the ITUAM system components and the platforms on which they can be run. Note that although it is possible to run all components on a Windows platform, it is not possible to run all components on a UNIX or Linux platform. For example, you can run ITUAM Processing Engine and the database on UNIX or Linux, but the ITUAM Administrator and Web Reporting applications run only on Windows.

### ITUAM Data Collectors

ITUAM Data Collectors read and convert usage metering data generated by applications (usually standard usage metering files such as log files) and produce a common output file that is used by ITUAM.

For detailed information about ITUAM Data Collectors, refer to the following documents:

- IBM Tivoli Usage and Accounting Manager Data Collectors for Microsoft Windows User’s Guide
- IBM Tivoli Usage and Accounting Manager Data Collectors for UNIX and Linux User’s Guide

### ITUAM Application Server

The ITUAM application server contains the following key components:

- **ITUAM Processing Engine**. This component can be run on Linux, UNIX, or Windows systems.

  ITUAM Processing Engine is available as a Java™-based engine for Linux and UNIX systems or a COM-based engine for Window systems.

- **ITUAM Administrator**. This is a Windows-based application. If you are running ITUAM Processing Engine on UNIX or Linux, ITUAM Administrator cannot be run on the same server. A Windows server is required for this application.

### ITUAM Processing Engine

ITUAM Processing Engine is a fast, efficient data processing engine capable of processing and applying business rules to large volumes of data. ITUAM Processing Engine consists of multiple programs. The four main programs are as follows. Some programs differ depending on the ITUAM platform (UNIX/Linux or Windows).

- **CIMSAcct (all platforms)**. This program processes the input sources provided by ITUAM Data Collectors and performs functions such as account code conversion. CIMSAcct produces an output file containing records that are properly formatted for input into CIMSBill.
**CIMSSort (all platforms).** This is a program in the Windows environment and a subroutine in the UNIX/Linux environment that sorts the output from CIMSAcct and produces a sorted file that is ready to be processed by CIMSBill.

**CIMSBill (all platforms).** This program processes the output from CIMSAcct and builds output files that contain the billing information that is used to generate invoices and reports.

**CIMSAdminLib (Windows).** This program loads the output files from CIMSAcct and CIMSBill into the ITUAM database.

CIMSAdminLib is the central controlling library for all Windows-based ITUAM functions. It contains all the COM objects used to manipulate ITUAM data.

**CIMSLoad (UNIX/Linux).** This program loads output files from CIMSBill into the ITUAM database.

For more information about ITUAM Processing Engine, see Chapter 7, Processing Data on Windows or Chapter 8, Processing Data on UNIX or Linux.

ITUAM’s powerful data processing capability provides all the data needed to produce complete and detailed reports, spreadsheets, and graphs. The actual generation of reports, however, is completed by SQL Server Reporting Services or Crystal Reports on the Windows platform (see Web Server on page 1-8).

**ITUAM Administrator**

ITUAM Administrator is the administration tool for the ITUAM system. This Windows-based GUI application allows the system administrator and ITUAM administrators to configure and maintain the information contained in the database such as rates, users and groups, clients, system configuration settings, and processing and reporting settings. ITUAM Administrator also enables administrators to perform real-time processing.

ITUAM Administrator uses a tree structure that you can expand or collapse. To open a node in the structure, double-click the node.
The following table shows the administrative tasks performed by the system administrator and the ITUAM administrator.

<table>
<thead>
<tr>
<th>System Administrator Tasks</th>
<th>ITUAM Administrator Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defining and configuring the ITUAM database</td>
<td>Defining account code structures</td>
</tr>
<tr>
<td>Selecting the Open Database Connectivity (ODBC) Data Source</td>
<td>Creating and maintaining rate, client, and calendar definitions</td>
</tr>
<tr>
<td>Creating, adding, and dropping database tables</td>
<td>Defining ITUAM users and groups</td>
</tr>
<tr>
<td>Creating, adding, and dropping database objects</td>
<td>Setting ITUAM users and groups</td>
</tr>
<tr>
<td>Performing database backup procedures</td>
<td>Setting reporting options</td>
</tr>
<tr>
<td>Defining and categorizing input sources</td>
<td>Configuring the ITUAM system settings</td>
</tr>
<tr>
<td>Scheduling input selection</td>
<td>Loading and exporting data to and from the database</td>
</tr>
<tr>
<td></td>
<td>Setting processing options</td>
</tr>
<tr>
<td></td>
<td>Executing processing jobs</td>
</tr>
<tr>
<td></td>
<td>Setting CIMSAcct and CIMSBill options</td>
</tr>
</tbody>
</table>
Database Server

The database stores administration information as well as the Ident, Detail, and Summary records that are produced by ITUAM Processing Engine (see Chapter 7, Processing Data on Windows or Chapter 8, Processing Data on UNIX or Linux for more information about these records). These records are used by SQL Server Reporting Services or Crystal Reports to provide robust Web reporting.

ITUAM supports the following databases:

- DB2 Universal Database (UDB) for Linux, UNIX, and Windows Version 8.1 or 8.2
- DB2 UDB for z/OS® Version 8
- Microsoft SQL Server 2000 or 2005
- Oracle 9 or 10 (UNIX or for Windows)
- MSDE 2000. MSDE 2000 is included with the ITUAM installation. However, MSDE has the following limitations:
  - Limit of 2 GB of storage
  - Limit of two processors per computer
  - Limited administrative tool
  - Does not support SQL Server Reporting Services

**Note** • ITUAM supports, but does not include, SQL Server Express Edition. SQL Server Express Edition replaces MSDE in SQL Server 2005.

Database support is not dependent on the location of the ITUAM application server. For example, you can have the ITUAM application server installed on UNIX or Linux and a SQL Server database on Windows.
Web Server

The Web server contains the following key components:

- IIS and the reporting application as follows:
  
  If you are using Crystal Reports, IIS and Crystal Reports must be installed on the same server.
  
  If you are using SQL Server Reporting Services, IIS can be on the same server or on a separate server than Reporting Services. Regardless of which server you choose to install Reporting Services on, the server must have SQL Server 2000 or 2005 installed. For more information, see Installing SQL Server Reporting Services on page 2-18.

  **Note** • SQL Server Reporting Services is not available for MSDE and ITUAM does not support Reporting Services on SQL Server Express Edition. SQL Server Express Edition replaces MSDE in SQL Server 2005.

  - ITUAM Web Reporting
  - ITUAM Financial Modeler
  - ITUAM Web Console

**ITUAM Web Reporting**

The ITUAM Web Reporting application provides comprehensive cost accounting, chargeback, and resource reporting in an easy-to-use, browser-based environment. ITUAM Web Reporting includes the following features that ensure that users receive the data they need in a clear, user-friendly format:

- **Drill down.** ITUAM Web Reporting invoices and many other reports include drill down that enables users to view detailed cost and usage information.

- **Multiple report formats.** ITUAM Web Reporting provides reports in report, graph, and spreadsheet format.

- **User customization options.** ITUAM Web Reporting users can set up their own list of favorite reports, spreadsheets, and graphs. Users can also create reports “on-the-fly” within the ITUAM Web Reporting Web site and publish reports for review by other users.

  ITUAM Web Reporting works with both SQL Server Reporting Services and Crystal Reports. Both tools provide a feature-rich environment for creating Web-based and paper reports.

  **Note** • SQL Server Reporting Services is not available for MSDE and ITUAM does not support Reporting Services on SQL Server Express Edition. SQL Server Express Edition replaces MSDE in SQL Server 2005.

ITUAM includes standard reports written in both Crystal Reports and the Report Definition Language (RDL) for SQL Server Reporting Services. RDL is an XML-based industry standard used to define reports.
Your report developer can use these standard reports as templates to create custom reports for your organization. Reports created specifically for your organization are referred to as “custom reports” in this guide to differentiate them from the ITUAM standard reports.

For more information about ITUAM Web Reporting, including descriptions of the standard reports that are provided with ITUAM, refer to the IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide.

**ITUAM Financial Modeler**

ITUAM Financial Modeler provides a browser-based interface for performing IT finance-related tasks, such as cost analysis and allocation and rate calculation. For more information about ITUAM Financial Modeler, see Chapter 9, Working With ITUAM Financial Modeler.

**ITUAM Web Console**

ITUAM Web Console provides an interface for viewing job log files. For more information about this application, see Chapter 10, Working With ITUAM Web Console.
About CSR and CSR+ Files

The primary method for input into ITUAM is the CSR or CSR+ file. The format of the CSR and CSR+ file records is the same, with the exception that the records in the CSR+ file contain an additional header at the beginning of the record. For a complete description of the CSR and CSR+ file format, see Appendix B, File Layouts.

Key pieces of information in the CSR and CSR+ records include identifiers and resources. All ITUAM Data Collectors define the most useful identifiers and resources to be collected from the usage data and provide this information in the records of the output CSR or CSR+ file.

For example, the ITUAM WinDisk data collector scans a Windows directory tree and provides a snapshot of the following:

- The amount of disk space used by each top level folder within a specified drive or folder.
- The number of files (including files in subfolders) within each of these folders.

In the following example, the output CSR records produced by the WinDisk collector contain one identifier and two resources: (Note that the CSR records produced by the WinDisk collector can contain more identifiers than shown in this example.)

```
WinDisk,20060827,20060827,00:00:00,23:59:59,,1,Folder,joan,2,DISKFILE,6,DISKSIZE,585727
WinDisk,20060827,20060827,00:00:00,23:59:59,,1,Folder,joe,2,DISKFILE,1,DISKSIZE,30
WinDisk,20060827,20060827,00:00:00,23:59:59,,1,Folder,mary,2,DISKFILE,0,DISKSIZE,0
```

The identifier name, Folder, is followed by the identifier value designating the folder name. In this example, data was collected from the folders joan, joe, and mary. Examples of other identifier names and values that might appear in a CSR or CSR+ record are those that designate device name, server name, system ID, job name, user ID, phone number, state code, or building number.

The resources consumed are designated by the rate codes DISKFILE (disk space used by the folder in gigabytes), and DISKSIZE (number of files in folder).

Processing Identifiers and Resources (Rate Codes)

All identifiers and resources in the CSR or CSR+ records must be defined in the ITUAM database. However, the process for defining identifiers and resources differs.

Resource rate codes require a monetary value and other user-defined options that must be defined before the CSR or CSR+ records are processed. The rate codes produced by many of the data collectors are preloaded in the a rate table used by ITUAM, the CIMSRate table. You can then use ITUAM Administrator to modify the monetary value and other options for the rate codes for your site as described in Working With Rates on page 4-9.
Note • The rate codes for some collectors are not pre-loaded in the CIMSRate table and must be added. To determine whether the rate codes for a specific collector are pre-loaded, refer to the documentation for that collector.

Because identifier names and values do not require additional definition, you do not need to define the names and values for ITUAM before the CSR or CSR+ records are processed. Identifier names and values in the records are automatically defined in the CIMSIIdent table when the CSR or CSR+ file is processed.
About ITUAM

ITUAM System Architecture Diagram—ITUAM on Windows Only

Figure 1-2 shows the most common Windows configuration in which ITUAM and the Web server are on one Windows server and the database is on a separate server (UNIX, Linux, Windows, or z/OS). For a detailed list of hardware and software specifications required for the ITUAM system, see page 2-5.

Figure 1-2 • Example ITUAM System Architecture—ITUAM on Windows
**ITUAM System Architecture Diagram—ITUAM on Windows and on UNIX or Linux**

Figure 1-3 shows the most common Windows and UNIX or Linux system configuration in which ITUAM Processing Engine is on a UNIX or Linux server; the ITUAM Windows components and the Web server are on a second Windows server; and the database is on a third server (UNIX, Linux, Windows, or z/OS). For a detailed list of hardware and software specifications required for the ITUAM system, see page 2-5 and page 3-4.

---

**Figure 1-3 • Example ITUAM System Architecture—ITUAM on Windows and UNIX/Linux**
About ITUAM

About CSR and CSR+ Files
Installing ITUAM on Windows and Getting Started

**Important!** If you are using a UNIX or Linux system to run the data processing component of ITUAM (ITUAM Processing Engine), you must also complete the steps in this chapter to install, configure, and get started using the required Windows-based components of the ITUAM system. This chapter also contains steps for setting up and connecting to a database for all supported database types and operating systems. Follow the information in this chapter in the order presented.

Chapter 3, *Installing ITUAM on UNIX/Linux and Getting Started* provides the steps for installing and setting up ITUAM Processing Engine on a UNIX or Linux system.

This chapter provides installation, configuration, and upgrade procedures for the Windows-based components of the ITUAM system and for setting up and connecting to a database (all supported database types and operating systems).

This chapter also provides a Getting Started section to help you to quickly set up the system components. If you are installing or setting up ITUAM for the first time, you should review the information in this chapter in the order presented.

**ITUAM System Components** ................................................................. 2-3

**System Specifications** ................................................................. 2-5
Server Specifications ................................................................. 2-5
Client Specifications ................................................................. 2-8
Report Design Specifications ..................................................... 2-9

**Pre-Installation Setup** ................................................................. 2-9
System Setup Checklist ............................................................. 2-10
Internationalization Setup ......................................................... 2-13
Enabling ASP.NET (Windows 2003 Server Only) ......................... 2-17
ITUAM System Components

Note • For an overview of the ITUAM system architecture, including detailed information about the following components, see Chapter 1, About ITUAM.

The ITUAM system is composed of the following hardware/software components:

■ ITUAM Data Collectors. ITUAM Data Collectors read and convert usage metering data generated by applications (usually standard usage metering files such as log files) and produce a common output file that is used by ITUAM.

■ ITUAM application server. Contains ITUAM administrative and processing applications. If you are using a DB2® or Oracle database on a server other than the ITUAM application server, the following applications must be installed on the application server as applicable. These applications are required to access the database.

   • A DB2 client that provides access to the database or DB2 Connect. These client installations include communication protocol support and support for application interfaces needed to access the database.

   • Oracle Client Software. The client installation includes OO4O (Oracle Objects for OLE), which is required to access the database.

Note • The ITUAM data processing component (ITUAM Processing Engine) can be run on a Windows or UNIX/Linux system. The installation and getting started information for ITUAM Processing Engine on a UNIX or Linux system is in Chapter 3, Installing ITUAM on UNIX/Linux and Getting Started.

■ Database server. Contains the DBMS (see Database Server on page 2-7 for supported databases).

■ Web server. Contains Microsoft IIS, ITUAM Web Reporting, and other ITUAM Web applications. If you are using Crystal reports for reporting, Crystal Reports must be installed on this server. If you are using SQL Server Reporting Services reports for reporting, Reporting Services can be installed on any server that has SQL Server 2000 or 2005 installed.

   If you are using a DB2 or Oracle database, the applicable database client application must be installed on this server. See the preceding description for the ITUAM application server.

If you are running ITUAM Processing Engine on a Windows system, the most common configuration is to have all ITUAM components and the Web server on one Windows server and the database on a second UNIX/Linux, z/OS, or Windows server (see example Figure 1-2 on page 1-12). In general, a configuration involving multiple servers might offer users better performance.
If you are running ITUAM Processing Engine on a UNIX or Linux system, the most common configuration is to have ITUAM Processing Engine on one UNIX or Linux server; ITUAM Administrator and other Windows-based ITUAM components and the Web server on a second Windows server; and the database on a third UNIX/Linux, z/OS, or Windows, server (see example Figure 1-3 on page 1-13).

**Note** • If you install the ITUAM application server and Web server on separate servers, you need to install ITUAM Administrator on the Web server (see Install ITUAM Administrator and ITUAM Web Applications on the Web Server (If Using a Separate Server) on page 2-93).

In addition, the system might include multiple clients containing the ITUAM Administrator application, terminal emulation software such as Microsoft Terminal Services, or both (see Client Specifications on page 2-8).
System Specifications

Server Specifications

The following are the server specifications for the Windows components of the ITUAM system. The specifications reflect a two server configuration in which ITUAM components and the Web server are on one server and the database is on another server. However, ITUAM, the Web server, and the database can be on one server or each component can be on a separate server.

Note • If you run ITUAM Processing Engine on a UNIX or Linux server, use the following specifications to set up the Windows-based components of the ITUAM system and the database. Then refer to Chapter 3, Installing ITUAM on UNIX/Linux and Getting Started for the specifications required to run ITUAM Processing Engine on a UNIX or Linux server.

ITUAM Application Server/Web Server

■ Any of the following Microsoft Windows operating systems with the latest service pack:
  • Windows Server 2003 x86 Standard, Enterprise, Datacenter, or Web Edition
  • Windows Server 2003 x64 Standard, Enterprise, Datacenter, or Web Edition
  • Windows 2000 Professional or Server
  • Windows XP Professional x86

Note • It is recommended that you do not run ITUAM Web Reporting on a 64-bit Windows system. Microsoft SQL Server Reporting Services and Crystal Reports display unpredictable behavior when run on a 64-bit system.

■ Microsoft IIS 5.0 or later (Included with the preceding Windows operating systems. To install IIS, click Control Panel ➤ Add/Remove Programs ➤ Add/Remove Windows Components and select Internet Information Services (IIS). For more information, about installing IIS, refer to the Microsoft documentation.)
Installing ITUAM on Windows and Getting Started

System Specifications

- One of the following report applications:
  - Microsoft SQL Server Reporting Services (included with SQL Server 2000 and 2005, see Installing SQL Server Reporting Services on page 2-18)

  **Note** • SQL Server Reporting Services is not available for MSDE and ITUAM does not support Reporting Services on SQL Server Express Edition. SQL Server Express Edition replaces MSDE in SQL Server 2005.

  Or


- Microsoft .NET Framework 1.1 (If you are using Windows XP or Windows 2000 Server, you can install the .NET Framework during the installation of ITUAM or you can download it from the Microsoft Web site. If you are using Windows Server 2003, the .NET Framework is included with the operating system. Install IIS before installing the .NET Framework.)

- ASP.NET (For Windows XP and Windows 2000 Server, ASP.NET is installed with the .NET Framework and no other configuration for ITUAM is required. For Windows 2003 Server, ASP.NET is installed, but must be enabled as described in Enabling ASP.NET (Windows 2003 Server Only) on page 2-17.)

- IBM 32-bit Runtime Environment for Java 2 (JRE) version 5.0. You can install the IBM JRE during installation or you can download it from the IBM Web site (see page 2-10).

  **Note** • Make sure that you install the JRE on the Windows server even if you are running ITUAM Processing Engine on a UNIX or Linux server. The JRE is required for Java-based ITUAM applications on the Windows system.

- Apache Tomcat 5.5 (required by ITUAM Web Console, installed if ITUAM Web Console is selected for installation)

- If you are using a DB2 or Oracle database and the database is on a separate server:
  - A DB2 client or DB2 Connect
  - Oracle Client Software

- 30 GB minimum available hard drive space

- 3 GHz or faster processor

- 2 GB minimum of memory
Database Server

The following are the specifications for the database server. These specifications are applicable regardless of whether you are running ITUAM Processing Engine on a UNIX/Linux or Windows system.

- Any of the following DBMS platforms:
  - DB2 UDB for Linux, UNIX, and Windows Version 8.1 or 8.2
  - DB2 UDB for z/OS Version 8
  - Microsoft SQL Server 2000 or 2005 with the latest service pack
  
  **Note** • ITUAM supports SQL Server clusters. A cluster refers to a group of two or more servers that work together and represent themselves as a single virtual server to a network.

  - Oracle 9 or 10 (for UNIX or Windows)
  
  **Note** • ITUAM supports only native Oracle drivers for Oracle.

  - MSDE 2000. MSDE 2000 is included with the ITUAM installation. However, MSDE has some limitations as discussed in *Database Server* on page 1-7.

  **Note** • ITUAM supports, but does not include, SQL Server Express Edition. SQL Server Express Edition replaces MSDE in SQL Server 2005.

- 80 GB minimum available hard drive space (depending on particular data requirements)
- 3 GHz or faster processor (multi-processors are helpful)
- 2 GB minimum of memory
Client Specifications

The following are the specifications for installing ITUAM Administrator on a client (optional) and for viewing reports.

For Installing ITUAM Administrator (Optional)

**Important!** If you are using a DB2 database, a DB2 client or DB2 Connect must be installed on the client. If you are using an Oracle database, Oracle Client Software must be installed on the client.

ITUAM Administrator is a Windows-based GUI application that enables administrators to create and maintain the administrative and processing settings for ITUAM. Administrators can access ITUAM Administrator remotely using terminal emulation software to connect to the application on the server (recommended) or directly by installing ITUAM Administrator on a client.

The following are the suggested specifications for installation on a client:

- Any of the following Microsoft Windows operating systems with the latest service pack:
  - Windows Server 2003 x86 Standard, Enterprise, Datacenter, or Web Edition
  - Windows Server 2003 x64 Standard, Enterprise, Datacenter, or Web Edition
  - Windows 2000 Professional, Server, or Datacenter Server
  - Windows XP Professional x86 or x64
  - Windows 98
- 40 MB minimum available hard drive space
- 400 MHz or faster processor
- 128 MB minimum of memory

You can also install and run ITUAM Processing Engine on a client. However, it is strongly recommended that you run ITUAM Processing Engine on the server. If you run ITUAM Processing Engine on the client, large amounts of data must be transferred from and to the server over the network during processing, which might result in slower performance.

You can use terminal emulation software to connect from a client to the process engine on the server.
For Viewing Reports
The following requirements apply to computers used to view reports in ITUAM Web Reporting:

- Internet Explorer 5.5 or later on the Windows platform.
- Internet or network access with necessary security permissions.

Report Design Specifications
The following are the specifications for designing Crystal and SQL Server Reporting Services reports.

For Designing Custom Crystal Reports
The following are the suggested specifications for computers used to design custom Crystal reports for use with ITUAM:

- Crystal Reports 9 or later (preferably the same edition that is on the Web server)
- 30 MB minimum hard drive space
- 128 MB minimum of memory

For Designing Custom SQL Server Reporting Services Reports
The following are the specifications for computers used to design custom SQL Server Reporting Services reports for use with ITUAM:

- Reporting Services Report Designer
- Microsoft Visual Studio .NET 2003 or another product that provides the Visual Studio 2003 shell (such as Visual Basic .NET 2003 or Visual C# .NET 2003)
- SQL Server 2000 or 2005 with the latest service pack
- 30 MB minimum hard drive space
- 128 MB minimum of memory

Pre-Installation Setup
Before you install ITUAM, you should review the following sections to make sure that you have all required third-party products and licenses and that you have your system set up correctly (including set up for internationalization if needed).
System Setup Checklist

Before installing ITUAM, make sure that you have installed and configured the components in the following list. Note that the Web server, database server, and ITUAM application server may be on one computer.

On the Web Server

- Windows Server 2003, Windows 2000 Server, or Windows XP.
- IIS 5.0 or later (included with Windows Server 2003, Windows 2000 Server, and Windows XP).
- Crystal Reports (if used for reporting).
- If SQL Server Reporting Services is used for reporting, Reporting Services can be installed on the Web server or another server. (Regardless of which server you choose to install Reporting Services on, the server must have SQL Server 2000 or 2005 installed.) See Installing SQL Server Reporting Services on page 2-18 for the steps required to install Reporting Services for ITUAM.

Note: The optional ITUAM Web Console application requires version 5.0.

- If you are using a DB2 or Oracle database on a server other than the Web server, the following applications must be installed on the Web server as applicable. These applications are required to access the database.
  - A DB2 client that provides access to the database or DB2 Connect.
  - Oracle Client Software.
- Open Web access (and FTP access if necessary). The server must have Port 80 open for HTTP access by other client computers in the organization.
Installing ITUAM on Windows and Getting Started

Pre-Installation Setup

On the Database Server

- DB2 UDB for Linux, UNIX, and Windows 8.1 or 8.2, DB2 UDB for z/OS 8, Microsoft SQL Server 2000 or 2005, Oracle 9 or later for Windows or UNIX, or MSDE 2000/SQL Server Express Edition.
- Available database user ID (login) that has permission to create tables, views, stored procedures, and indexes.

On the ITUAM Application Server

- Windows Server 2003, Windows 2000 Server, or Windows XP.
- ASP.NET.
  - For Windows XP and Windows 2000 Server, ASP.NET is installed with the .NET Framework and no other configuration for ITUAM is required.
  - For Windows 2003 Server, ASP.NET is installed, but must be enabled as described in Enabling ASP.NET (Windows 2003 Server Only) on page 2-17.
- Microsoft .NET Framework 1.1.
  - You can install the .NET Framework during the installation of ITUAM (see page 2-28) or you can download it from the Microsoft Web site.
  - If you download the .NET Framework, on the Windows Update page, click Pick updates to install and then click your operating system. Microsoft .NET Framework 1.1 appears in the Recommended Updates list if it is not installed on your system.
- IBM 32-bit JRE version 5.0. For more information, see page 2-10.
- If you are using a DB2 or Oracle database on a server other than the ITUAM application server, the following applications must be installed on the application server as applicable. These applications are required to access the database.
  - A DB2 client that provides access to the database or DB2 Connect.
  - Oracle Client Software.
Installing ITUAM on Windows and Getting Started

Pre-Installation Setup

**On All Servers**
- Terminal emulation software such as Microsoft Terminal Services or physical access to the server.
- Servers are connected to the network and are visible to each other—preferably on the same Windows *domain*.
- User has administrative access to the servers.
- File share enabled (preferred) or FTP access to all servers.
- If using ITUAM Data Collectors for UNIX and Linux, FTP or Secure Shell access from the servers to the UNIX/Linux system and vice versa.

**On All Clients Accessing ITUAM Web Reporting**
- Internet Explorer 5.5 or later on the Windows platform.

**On All Clients Running ITUAM Administrator**
- Administrative authority on the client to install ITUAM Administrator.
- If you are using a DB2 or Oracle database, the following as applicable:
  - A DB2 client that provides access to the database or DB2 Connect.
  - Oracle Client Software.

**On All Clients Running Terminal Emulation Software**
- Authority for the client computer and client user ID to access the servers via terminal emulation software.
Internationalization Setup

**Important!** • The steps in this section are applicable only if you are using a SQL Server database.

You can localize the following features in ITUAM to reflect the language required for your organization (the default is US English):

- Date and numeric formatting (such as numbers and currency) that appears in:
  - The ITUAM Web Reporting Web site
  - ITUAM Administrator
  - Reports

- Headers and footers that appear in reports

You cannot localize the text that is displayed in the ITUAM Administrator GUI or the Help text in ITUAM Administrator and ITUAM Web Reporting. In addition, it is not recommended that you change the text that is displayed on the ITUAM Web Reporting Web site. Changing this text requires changes to the Active Server Pages (ASP) and JavaScript code that runs the Web site.

**Setting Up Your System for Internationalization**

The language used by ITUAM is determined by the following settings:

- The locale ID set in the Site Localization ID (LCID) box in the Configuration dialog box (see Web Settings on page 4-47).

- On the Web server, the regional settings for the Crystal Reports services (see page 2-14).

- On the ITUAM application server, the language specified for the database ODBC Data Source(s) used by ITUAM (see page 2-15).

- On the server running ITUAM Administrator, the regional settings for the Windows user account logged on to the server running ITUAM Administrator (see page 2-15).

- On a client accessing ITUAM Web Reporting, the regional settings for the Windows user account logged on to the client (see page 2-15).

**Important!** • To avoid unexpected results, make sure that all of the preceding settings are set to the same language. If you want to use the same database to produce Web reports in different languages, you must set up a separate Web server and repeat the steps in this section for each language.
The following are the instructions for configuring internationalization settings for your organization. In most cases, you will already have these settings set to the correct language. The instructions are ordered by the component on which they are installed.

**Note** • Where individual steps are provided in the instructions, the steps reflect the Microsoft Windows Server 2000 operating system. If you are using another operating system, refer to the Microsoft documentation if needed.

<table>
<thead>
<tr>
<th>On the Web Server</th>
<th>Set the Crystal Report Application Server (RAS) User Log On Account (Crystal Reports 9 or 10 only)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If you are using Crystal Reports 9 or 10, the Crystal RAS uses the local system account for the Web server by default.</td>
</tr>
<tr>
<td></td>
<td>If you do not want Crystal Reports to use the regional settings for the local system account, set the log on to an account with the correct regional settings. It is recommended that you create a user for use as the RAS log on. This user should have a password that is never changed.</td>
</tr>
<tr>
<td></td>
<td>To set the Crystal RAS Log On:</td>
</tr>
<tr>
<td></td>
<td>1 In Windows Control Panel, double-click Administrative Tools ▶ Services.</td>
</tr>
<tr>
<td></td>
<td>2 Double-click Crystal Report Application Server.</td>
</tr>
<tr>
<td></td>
<td>3 On the Log On tab, click This account.</td>
</tr>
<tr>
<td></td>
<td>4 Enter the account and password.</td>
</tr>
<tr>
<td></td>
<td>A message stating that the log on will not take affect until you restart the service is displayed.</td>
</tr>
<tr>
<td></td>
<td>5 Click OK, and then restart the Crystal RAS service (right-click the service and click Restart).</td>
</tr>
</tbody>
</table>

**Set the Crystal Reports Cache, Job, and Page Server Log On Account (Crystal Reports XI only)**

If you are using Crystal Reports XI, the Crystal Reports Cache, Job, and Page Server use the local system account for the Web server by default.

If you do not want Crystal Reports to use the regional settings for the local system account, follow the same instructions as provided for creating a RAS user log on account (see preceding), except select the services Crystal Reports Cache Server, Crystal Reports Job Server, and Crystal Reports Page Server rather than Crystal Report Application Server.
## Pre-Installation Setup

### On the ITUAM Application Server

**Select the Language for the ODBC Data Source**

In the Windows ODBC Data Source Administrator, select the language for each ODBC Data Source used by ITUAM. The steps for configuring a data source for ITUAM are provided in Setting Up and Connecting to a Database on page 2-38.

**Note**  • The change to the language source will not appear in reports until you restart IIS. (To restart IIS, see page 11-5.)

### On the Server Running ITUAM Administrator

**Select the ITUAM Administrator User’s Regional Settings**

Select the regional settings for the user logged on to the server running ITUAM Administrator. To select the regional settings for the user:

1. In Windows Control Panel, double-click **Regional Options**.

   The Regional Options dialog box is displayed.

2. On the **General** tab, click the language that you want from the list.

3. Click **OK** to save the change and close the dialog box.

### On All Clients Accessing ITUAM Web Reporting

**Select the ITUAM Web Reporting User’s Regional Settings**

Set the correct regional setting for the user on each client that is using ITUAM Web Reporting. This enables Microsoft Excel to display dates, times, currency, and numbers in the correct format when you view a report as a spreadsheet.

To select the regional settings for the user, follow the steps in Select the ITUAM Administrator User’s Regional Settings.
Changing the Report Text (Optional)
ITUAM Web Reporting includes a variety of standard reports and spreadsheets for Crystal Reports and SQL Server Reporting Service. You can use these reports and spreadsheets as templates to create custom reports/spreadsheets (see see About ITUAM Reports on page 5-3), and then change the text as follows.

For Crystal reports:
1 In Crystal Reports, open the report that you want to change.
2 Right-click the text that you want to change, and then click Edit Text Option.
3 Save the report using the same file name in the Custom reports folder.

For SQL Server Reporting Services reports:
1 In Visual Studio .NET or another product that provides the Visual Studio 2003 shell, click File ▶ New Project.
2 In Business Intelligence Projects, double click Report Projects.
3 Right-click the Reports folder in the Solution Explorer window, and then click Add Existing Item.
4 Browse to find the report file that you want to edit, and then open the report.
5 Right click the text that you want to change, and then click Expression.
6 In the Edit Expression dialog box, change the text in the Expression box.
7 Click OK.
8 Repeat steps 1 through 5 for each text area that you want to change.
9 Click File ▶ Select Items when you are finished.
Enabling ASP.NET (Windows 2003 Server Only)

**Note** • If you are using Windows XP or Windows 2000 Server, the steps in this section are not required.

ASP.NET is required for ITUAM Web Reporting. In Windows Server 2003, ASP.NET does not work unless it is enabled. To enable ASP.NET:

1. In IIS Manager, navigate to **Web Service Extensions** and click it.
   
   Note that you can easily start IIS Manager by clicking Start ➤ Run. Type `inetmgr` in the **Open** box, and then click **OK**.

2. Click **Active Server Pages** and then click **Allow**.

3. Click **ASP.NET <version number>** and then click **Allow**.

4. Make sure that Allowed is displayed in the status column for these features.

If you want to ensure that ASP.NET has been installed on the server:

1. In Windows Control Panel, click **Add/Remove Programs**.

2. Click **Add/Remove Windows Components**. The **Application Server** check box should be selected.

3. If the **Application Server** check box is not selected, click **Details**, and then select the **ASP.NET** check box.
Installing SQL Server Reporting Services

**Note** • This section is applicable only if you want to use SQL Server Reporting Services for reporting.

The installation steps in this section are preceded by a brief overview of the licensing requirements, components, and system requirements for SQL Server Reporting Services. For more detailed information about obtaining, licensing, installing, and using Reporting Services, refer to the Microsoft documentation.

**About Licensing Reporting Services**

Reporting Services is part of the SQL Server 2000 or 2005 license. There is not a separate license for Reporting Services. If you have a licensed copy of SQL Server, you may run Reporting Services on the same server for no additional license fee. If you want to run Reporting Services on a server that is not licensed for SQL Server, you must obtain a SQL Server license for that additional server.

For example, if you want to have your ITUAM database on one server and Reporting Services and IIS on a separate Web server, you must obtain a separate SQL Server license and install SQL Server on the second server.

**Overview of Reporting Services Components**

Reporting Services is composed for four main components:

- **Report Server.** A Web service that handles report management and processing. It connects to a SQL Server database for report metadata and caching.
- **Report Server database.** A SQL Server database used for report metadata and caching.

Report Server requires a local or remote connection to the Report Server database. If you have Report Server on one server and the Report Server database on another server, a separate SQL Server license is required for each server.
System Requirements for Reporting Services

For the Server Running Reporting Services:

- SQL Server 2005

  Or

  SQL Server 2000 with the following:
  
  - The latest SQL Server 2000 Service Pack.
  
  - The latest Reporting Services Service Pack (see Installing Reporting Services on page 2-20).

- ASP.NET. For Windows XP and Windows 2000 Server, ASP.NET is installed with the .NET Framework and no other configuration for ITUAM is required. For Windows 2003 Server, ASP.NET is installed, but must be enabled as described in Enabling ASP.NET (Windows 2003 Server Only) on page 2-17.

For the browser used with Reporting Services Report Manager:

For the browser used to access and manage Report Server using Report Manager, the client computer must have Microsoft Internet Explorer 6.0 with Service Pack 1 (SP1), with scripting enabled.
Installing Reporting Services

The following steps reflect installing Reporting Services from a CD. To perform the installation from another source, refer to the Microsoft documentation. You must have SQL Server 2000 or 2005 installed on the server to install Reporting Services.

**Note** • Once you have installed Reporting Services and ITUAM, you must complete configuration steps in both applications. See Set Up SQL Server Reporting Services on page 2-98.

To install Reporting Services from a CD:

1. Log on to Windows as a user in the Administrators group.
2. Insert the Reporting Services CD. If the CD does not start automatically, browse to your CD-ROM drive and double-click `setup.exe`.
3. Follow the instructions in the Reporting Services installation wizard.

Install the latest Reporting Services Service Pack after you install Reporting Services.

**Note** • If you do not have Visual Studio .NET 2003 or another product that provides the Visual Studio 2003 shell installed, you will receive notification when the installer checks for Reporting Services prerequisites. Visual Studio 2003 is not required unless you want to use Report Designer.

Installing Crystal Reports

**Note** • This section is applicable only if you want to use Crystal Reports XI for reporting. For information about installing other versions of Crystal Reports, see Chapter 11, Troubleshooting and Additional Information.


Crystal Reports XI Server Edition includes licensing for the following:

- One Crystal Reports Developer Edition report designer
- Five concurrent access licenses (CALs)

Crystal Reports XI Developer Edition includes licensing for the following:

- Crystal Reports XI Server
- Five named user licenses

To install Crystal Reports XI Server or Developer, install Crystal Reports Server first and then install Crystal Reports Developer. If possible, both components should be installed on the same drive.
Crystal Reports Server requires a database to store information about the system and its users. The following instructions describe how to install Crystal Reports Server using the default configuration which installs an MSDE database. If you want to create a database before installing Crystal Reports Server, you want use a different database, or both, refer to the BusinessObjects document *Installing Crystal Reports Server on Microsoft Windows*. This guide is available from the BusinessObjects Web site and is included with the Crystal Reports Server installation files.

**Important!** After you install the Crystal Reports XI components, you must follow the steps in *Set Up Crystal Reports* on page 2-105 before you can run reports.

**To install Crystal Reports XI Server:**

1. Log on to Windows as a user in the Administrators group.

2. Do one of the following:
   - If you are installing from the installation CD, insert the CD that contains Crystal Reports Server. If the CD does not start automatically, browse to your CD-ROM drive and double-click `setup.exe`.
   - If you are installing from another location, for example from a network drive, double-click `setup.exe`.

3. Click `Install Crystal Reports Server` and proceed with the instructions in the Installation Wizard until the Select Client or Server installation dialog box is displayed.

4. Click `Perform Server Installation`, and then click `Next`.

5. In the Directory Selection dialog box, enter an installation directory or accept the default. Click `Next`.

6. In the Install Type dialog box, click `New`. Leave the `Install MSDE or use existing local SQL Server` check box selected. Click `Next`.

7. The installation differs depending on whether MSDE or SQL Server is already installed on the server. Follow the instructions presented.

8. In the Start Installation dialog box, click `Next`.

9. Click `Finish` when the installation is complete. (If you do not want to launch the BusinessObjects Administration Console, clear the check box before you click `Finish`).
To install Crystal Reports XI Developer Edition:

1. Make sure that you have installed Crystal Reports Server as described in To install Crystal Reports XI Server: on page 2-21.

2. Double click the setup.exe file for Crystal Reports Developer (on the installation CD or other location) and follow the instructions presented in the Installation Wizard. A typical installation is recommended (i.e., click Typical in the Select Installation Type dialog box).

Install Crystal Reports Service Pack 1 after you install Crystal Reports Developer.
About ITUAM Installation

The ITUAM installation is composed of a base ITUAM package and seven collector packages. You must install the base package before you can install any of the collector packages.

Table 2-1 describes each of the packages and their contents. The base ITUAM installation consists of the ITUAM Base Package and Collector Package Base. The availability of the other collector packages depends on the packages that have been purchased for your organization. For examples of installations using these packages, see Example Installations on page 2-25.

<table>
<thead>
<tr>
<th>ITUAM Package</th>
<th>Installation File</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITUAM Base Package</td>
<td>Setup-ITUAM-version&amp;release.exe</td>
<td>This is the core ITUAM installation that includes ITUAM Administrator, ITUAM Processing Engine, ITUAM Web Reporting, and other Windows-based components. For a complete list of components, Select the Features That You Want to Install on page 2-27.</td>
</tr>
<tr>
<td>Collector Package Base</td>
<td>Setup-ITUAM-PKG1-version&amp;release.exe</td>
<td>This package contains the collectors that are provided with the ITUAM base package.</td>
</tr>
<tr>
<td>Collector Package for TDSz</td>
<td>Setup-ITUAM-PKG2-version&amp;release.exe</td>
<td>This package contains the Tivoli Decision Support for z/OS (TDSz) collector.</td>
</tr>
</tbody>
</table>

Table 2-1  •  ITUAM Installation Programs by Package
### About ITUAM Installation

**ITUAM Package** | **Installation File** | **Contents**
---|---|---
Collector Package for Databases | Setup-ITUAM-PKG3-version&release.exe | This package contains collectors for databases such as DB2, SQL Server, and Oracle.

Collector Package for Internet Infrastructure | Setup-ITUAM-PKG4-version&release.exe | This package contains collectors for Internet applications such as Apache and Microsoft IIS.

Collector Package for E-mail | Setup-ITUAM-PKG5-version&release.exe | This package contains collectors for E-mail applications such as Lotus Notes and Microsoft Exchange.

Collector Package for Network and Printing | Setup-ITUAM-PKG6-version&release.exe | This package contains collectors for network and printing applications such as Veritas NetBackup and Windows print.

Collector Package for Enterprise | Setup-ITUAM-PKG7-version&release.exe | This package contains all of the collectors contained in the packages 3 through 6. If you install this package, the individual collector packages 3 through 6 are not required.

---

Table 2-1 • ITUAM Installation Programs by Package (Continued)
Example Installations

The use of the ITUAM packages is shown in the following examples.

You have purchased the ITUAM Base Package and all collector packages other than TDSz:

Install the following packages:

- ITUAM Base Package
- Collector Base Package (Collector package 1)
- Collector Package for Enterprise (Collector package 7)

You have purchased the ITUAM Base Package and the Collector Package for TDSz:

Install the following packages:

- ITUAM Base Package
- Collector Base Package (Collector package 1)
- Collector Package for TDSz (Collector package 2)

You have purchased the ITUAM Base Package and the Collector Package for Databases:

Install the following packages:

- ITUAM Base Package
- Collector Base Package (Collector package 1)
- Collector Package for Databases (Collector package 3)

You have purchased the ITUAM Base Package, the Collector Package for Databases, and the Collector Package for E-Mail:

Install the following packages:

- ITUAM Base Package
- Collector Base Package (Collector package 1)
- Collector Package for Databases (Collector package 3)
- Collector Package for E-Mail (Collector package 5)
Installing ITUAM

This section describes the steps required to install ITUAM. Before you begin the installation, make sure that you have installed and configured the components described in System Setup Checklist on page 2-10 and that you have the required ITUAM installation files described in About ITUAM Installation on page 2-23.

To start the installation:

1. Log on to Windows as a user in the Administrators group.
2. Click the Windows Start button, and then click Run.
3. Enter the path to the setup program for the package that you want to install, and then click OK. The path depends on the location of the setup program, i.e., product CD, network drive, etc.

   **Note** • You must install the base package (Setup-ITUAM-version&release.exe) before you can install any of the collector packages.

4. Follow the steps provided in the InstallShield Wizard for each package as described in the following sections.

Installing the Base Package

**Note** • The ITUAM 6.1 installation includes Microsoft Data Access Components (MDAC) 2.8. This is the current MDAC version as of this release. If a later MDAC version is available at the time that you install ITUAM, you can download the new version from the Microsoft Web site.

The InstallShield Wizard contains the following steps that guide you through the installation of the ITUAM base package. The installation program is Setup-ITUAM-version&release.exe.

**Install the IBM Java Runtime Environment**

If you have not installed IBM 32-bit Runtime Environment for Java 2 (JRE) version 5.0, you will be prompted to install the JRE. Click Yes and then follow the steps in the InstallShield Wizard.

**Accept the Software License Agreement**

Read the license agreement, and then click Accept to continue the installation. If you click Decline, installation will not be completed.
Installing ITUAM on Windows and Getting Started

Installing ITUAM

Choose the Destination Location
Choose the default location for installation (C:\Program Files\IBM\ITUAM) or click Browse to choose another location. Click Next after making your selection.

Note • The folder in which you install ITUAM (ITUAM or other) should be backed up periodically.

Select the Features That You Want to Install
Select the ITUAM components that you want to install or clear the components that you do not want to install. Click Next after you have made your selections. For a detailed description of these components, see Chapter 1, About ITUAM.

Administrator. This option installs ITUAM Administrator. ITUAM Administrator is a graphical interface that enables you to create and maintain administrative and processing settings.

Financial Modeler. This option installs ITUAM Financial Modeler. ITUAM Financial Modeler is a Web-based application that provides an interface for performing IT finance-related tasks, such as cost analysis and allocation and rate calculation. For more information about this application, see Chapter 9, Working With ITUAM Financial Modeler.

Conversion Engine. This option installs ITUAM Conversion Engine. ITUAM Conversion Engine is a utility that is used by some ITUAM Data Collectors to convert data into CSR files. For more information ITUAM Conversion Engine, refer to the IBM Tivoli Usage and Accounting Manager Data Collectors for Microsoft Windows User’s Guide.

Processing Engine. This option installs ITUAM Processing Engine components including CIMSACCT.dll, CIMSBILL.dll, CIMSSORT.dll, and CIMSAdminLib.dll. These components process the CSR or CSR+ files and load the output into the ITUAM database. This option also installs ITUAM Aggregation Engine (CIMSAggregation.dll) used by ITUAM Data Collectors that run on Windows.

Web Console. This option installs ITUAM Web Console. This Web-based application provides an interface for viewing job log files. For more information about this application, see Chapter 10, Working With ITUAM Web Console.

Web Reporting. This option installs ITUAM Web Reporting. This Web-based application allows end users to view reports from a Web browser.

Scripts. This option installs scripts that can be used to automate tasks in ITUAM. For example, scripts that enable batch reporting, scripts used by ITUAM Data Collectors, etc. For a description of these scripts, see Appendix C, Scripts.

MSDE—Microsoft SQL Server 2000 Desktop Data Engine. This option installs MSDE 2000. In a production environment, it is strongly recommended that you use a DB2®, SQL Server, or Oracle database.

Note • ITUAM supports, but does not include, SQL Server Express Edition. SQL Server Express Edition replaces MSDE in SQL Server 2005.
Select the Program Folder

Choose the program folder. Use the default (ITUAM), type a new program folder name, or select one from the list. Click Next when you are finished.

Start Copying Files

Click Next to begin copying program files to your system. If IIS is running, a message asking you to confirm that is okay to shut down IIS is displayed. Click Yes. Note that the installer restarts IIS before finishing installation.

Install Microsoft .NET Framework 1.1

If you have not installed Microsoft .NET Framework 1.1, the Microsoft .NET Framework 1.1 Setup is displayed. Follow the instructions in the setup, and then click OK when the installation is complete.

Note • If the message Files In Use is displayed during the installation, click Ignore. The .NET Framework will continue to install.

Enter the IIS Web User Name

There are two options for controlling user access to the ITUAM Web Reporting Web site: anonymous access and Windows authenticated access. Anonymous access allows remote access by the IUSR_computername account. IIS user access is described in detail in Set the User Authentication Method for the Web Sites on page 2-94.

The InstallShield Wizard allows you to enter the IUSR_computername. This name is used for granting security permissions for ITUAM folders as described in Assign Folder Security Permissions on the Web Server on page 2-96.

In most situations, the IUSR_computername account that is displayed is correct and you can click Next to continue. If you want to confirm that it is correct, follow the instructions in To set anonymous access: on page 2-94 to locate the IUSR_computername. If the IUSR_computername is not correct (for example, you changed your computer name after installing IIS), you can change it here and then click Next.

If you do not enter the correct IUSR_computername here, you can assign the required folder privileges manually (see page 2-96). A series of error messages will be displayed. Click OK for each message.

Complete the Installation

Follow the instructions in the Setup Complete—Reboot Required dialog box, and then click Finish.
Installing the Base Collector Package

The InstallShield Wizard contains the following steps that guide you through the installation of the ITUAM base collector package. The installation program is Setup-ITUAM-PKG1-version&release.exe.

Select the Features That You Want to Install

Select the ITUAM collectors you want to install or clear the collectors that you do not want to install. These collectors enable you to gather usage data from many different sources for input into ITUAM. Click Next after you have made your selections.

For a detailed description of these collectors, refer to the *IBM Tivoli Usage and Accounting Manager Data Collectors for UNIX and Linux User’s Guide* and the *IBM Tivoli Usage and Accounting Manager Data Collectors for Microsoft Windows User’s Guide*.

Start Copying Files

Click Next to begin copying program files to your system.

Complete the Installation

In the Setup Complete dialog box, click Finish.
Installing the TDSz Collector Package

The InstallShield Wizard contains the following steps that guide you through the installation of the ITUAM TDSz collector package. The installation program is Setup-ITUAM-PKG2-version&release.exe.

Accept the Software License Agreement

Read the license agreement, and then click Accept to continue the installation. If you click Decline, installation will not be completed.

Select the Features That You Want to Install

Because this package installs only the TDSz data collector, leave all features selected, and click Next.

For a detailed description of the TDSz data collector, refer to the IBM Tivoli Usage and Accounting Manager Data Collectors for Microsoft Windows User’s Guide.

Start Copying Files

Click Next to begin copying program files to your system.

Complete the Installation

In the Setup Complete dialog box, click Finish.
Installing ITUAM on Windows and Getting Started

Installing All Other Collector Packages

The InstallShield Wizard steps are the same for each of the following collector packages:

- Database collector package (Setup-ITUAM-PKG3-version&release.exe)
- Internet collector package (Setup-ITUAM-PKG4-version&release.exe)
- E-mail collector package (Setup-ITUAM-PKG5-version&release.exe)
- Network and printing collector package (Setup-ITUAM-PKG6-version&release.exe)
- Enterprise collector package (Setup-ITUAM-PKG7-version&release.exe)

Accept the Software License Agreement

Read the license agreement, and then click Accept to continue the installation. If you click Decline, installation will not be completed.

Select the Features That You Want to Install

Select the ITUAM collectors you want to install or clear the collectors that you do not want to install. For a detailed description of these collectors, refer to the IBM Tivoli Usage and Accounting Manager Data Collectors for Microsoft Windows User’s Guide.

Start Copying Files

Click Next to begin copying program files to your system.

Complete the Installation

In the Setup Complete dialog box, click Finish.
Modifying an Existing Installation

Follow the steps in this section to modify an existing installation. For example, you have already installed certain ITUAM Data Collectors but now want to install others.

1. Run the ITUAM setup program that contains the feature that you want to install.
   
   Or
   
   In Windows Control Panel, click Add or Remove Programs, click the ITUAM package that contains the feature you want, and then click Change.

   The InstallShield Wizard is displayed.

2. Click Modify, and then click Next.

   Note • Do not click Repair to modify the installation. The Repair option should be ignored.

3. Select the check boxes for the components that you want to install.

   Important! • Do not clear a check box unless you want to delete that component.

4. Follow the instructions presented in the wizard to complete the installation.

Upgrading to a New Release of ITUAM

Important! • If you are performing an upgrade, you should back up the installation folder before you upgrade to a new version of ITUAM. If you have made changes to files in this folder and have not renamed these files, the files will be overwritten when you upgrade to a new version or release of ITUAM.

You should also confirm that you have a regular and working backup schedule for the following: the ITUAM folder; the folder that contains your process definitions (this folder is referred to as Processes in this guide); and your database.

To upgrade to a new release of ITUAM:

1. Follow the steps in To start the installation: on page 2-26.

2. In the InstallShield Wizard, if a message asking you to confirm that is okay to uninstall the existing ITUAM version is displayed, click Yes.

3. When prompted to modify, repair, or remove the existing installation, make sure that Remove is selected, and then click Next.

4. Click OK in the Confirm Uninstall message box.

5. If IIS is running, a message asking you to confirm that is okay to shut down IIS is displayed. Click Yes.
6 Read the license agreement (if presented), and then click Accept to continue the installation. If you click Decline, installation will not be completed.

7 Choose the default location for the upgrade. Click Next after making your selection.

**Important!** When you upgrade to a new version or release of ITUAM, make sure that you install the program in the same folder as the existing installation. If there is a reason that you want to keep your previous ITUAM version and install the upgrade, contact IBM Software Support.

8 Select the check boxes for the components that you want to upgrade, and then click Next.

**Important!** Do not clear a check box unless you want to delete that component.

9 Choose the program folder. Use the default (ITUAM), type a new program folder name, or select one from the list. Click Next when you are finished.

10 Click Next to begin copying program files to your system. If IIS is running, a message asking you to confirm that is okay to shut down IIS is displayed. Click Yes.

11 If presented, accept the default IIS Web user name or enter a new name as described in *Enter the IIS Web User Name* on page 2-28, and then click Next.

12 Follow the instructions in the Setup Complete—Reboot Required dialog box, and then click Finish.
Setting Up a Windows Account for ITUAM

It is strongly recommended that you create a Windows user account name ITUAMUser and that you run the ITUAM Web Reporting Web site under this user account. (If the ITUAM application server and the Web site are on the same server, the application server will also run under this account.)

You can also run the Web site under other Windows user or group accounts or under the Windows local system account: ASPNET (Windows 2000 Server) or NETWORK SERVICE (Windows Server 2003).

Using an ITUAMUser Account

To run the ITUAM Web Reporting Web site under the ITUAMUser account, do the following:

1. Make sure that the user account used to log on to the Web server is the ITUAMUser account.

2. In the ...IBM\ITUAM\Server\Web\CIMSReporting\Web.config file on the Web server, uncomment the identity element as follows. (The identity element follows the authorization element.)

   ```xml
   <authorization>
   <allow users="*"/> <!-- Allow all users -->
   <!--  <allow     users="[comma separated list of users]"
    roles="[comma separated list of roles]"/>
    <deny      users="[comma separated list of users]"
    roles="[comma separated list of roles]"/>
   -->
   </authorization>

   <identity impersonate="true" userName="ITUAMUser" password="password"/>
   ```

   Change password="password" to the password for the ITUAMUser account. It is recommended that you do not set the ITUAMUser account password to password.

   **Note** • The updated Web.config file will not be overwritten when you upgrade to a new release of ITUAM.
Installing ITUAM on Windows and Getting Started ■
Setting Up a Windows Account for ITUAM

3 Provide security permissions of Read and Write for the ITUAMUser account to the
...\IBM\ITUAM folder on the ITUAM application server and propagate the

permissions down through all subfolders and files as follows:
a Right-click the ITUAM folder, and then click Sharing and Security.

The ITUAM Properties dialog box is displayed.
b On the Security tab, click Add.

The Select Users, Computer, or Group dialog box (Windows 2000 Server or
Windows XP) or the Select Users of Groups (Windows Server 2003) dialog box is
displayed.
c Click Locations, click the local computer name, and then click OK.
d In the Enter object name to select box, type the ITUAMUser account, and then click

OK.
The ITUAMUser account is displayed in the Group or user names box with
permissions of Read & Execute, List Folder Contents, and Read.
e Click the ITUAMUser account, and select the Write permission in Group or user
names box. The permissions for the ITUAMUser account should show Read &

Execute, List Folder Contents, Read, and Write.
f

Click Advanced.
The Advanced Security Options dialog box is displayed.
On the Permissions tab, make sure that the ITUAMUser account is selected, select
both inheritance check boxes at the bottom of the tab, and then click Apply.
In Windows 2000 Server and Windows XP, these check boxes are Inherit from
parent... and Replace permission entries on all child objects....
In Windows Server 2003, these check boxes are Allow inheritable permissions...
and Replace permission entries on all child objects....

g Click Yes in the Security message box.
h When the security settings update completes, click OK to close the Advanced

Security Settings dialog box.
i

Click OK to close the Properties dialog box.

4 Provide a share permission of Read for the ITUAMUser account to the
...\IBM\ITUAM\Server folder. This folder contains the reports used with ITUAM.

To set the share permission:
a Right click the report folder, and click Sharing and Security.
b On the Sharing tab, click Permissions.
c Add the ITUAMUser account and select the Read permission for the account.

IBM Tivoli Usage and Accounting Manager Administrator's Guide

2-35 ■


Setting Up a Windows Account for ITUAM

Using a Local System or Other Windows Account

As described in Using an ITUAM User Account on page 2-34, it is strongly recommended that you create a Windows user named ITUAMUser.

If you do not run the ITUAM Web Reporting Web site under the ITUAMUser account, you can run the Web site under the local system account ASPNET (Windows 2000 Server) or NETWORK SERVICE (Windows Server 2003) or one or more Windows user or group accounts.

To run the ITUAM Web Reporting Web site under the local system account or another Windows account or accounts, do the following:

1. Make sure that the user account used to log on to the Web server is the account that you want to use to run the Web site.

2. Provide security permissions of Read and Write for the local system or user account to the .\IBM\ITUAM folder on the ITUAM application server and propagate the permissions down through all subfolders and files as follows:

   a. Right-click the ITUAM folder, and then click Sharing and Security.
      
      The ITUAM Properties dialog box is displayed.

      
      The Select Users, Computer, or Group dialog box (Windows 2000 Server) or the Select Users of Groups (Windows Server 2003) dialog box is displayed.

   c. Click Locations, click the local computer name, and then click OK.

   d. In the Enter object name to select box, type the local system or user account, and then click OK.
      
      The account is displayed in the Group or user names box with permissions of Read & Execute, List Folder Contents, and Read.

   e. Click the account, and select the Write permission in Group or user names box. The permissions for the account should show Read & Execute, List Folder Contents, Read, and Write.

   f. Click Advanced.
      
      The Advanced Security Options dialog box is displayed.

      On the Permissions tab, make sure that the account is selected, select both inheritance check boxes at the bottom of the tab, and then click Apply.

      In Windows 2000 Server, these check boxes are Inherit from parent... and Replace permission entries on all child objects....

      In Windows Server 2003, these check boxes are Allow inheritable permissions... and Replace permission entries on all child objects....

   g. Click Yes in the Security message box.
**Installing ITUAM on Windows and Getting Started**

**Setting Up a Windows Account for ITUAM**

**h** When the security settings update completes, click **OK** to close the Advanced Security Settings dialog box.

**i** Click **OK** to close the Properties dialog box.

**3** Provide a *share* permission of Read for the ITUAMUser account to the ...\IBM\ITUAM\Server folder. This folder contains the reports used with ITUAM.

To set the share permission:

**a** Right click the report folder, and click **Sharing and Security**.

**b** On the **Sharing** tab, click **Permissions**.

**c** Add the ITUAMUser account and select the Read permission for the account.

**4** If you are using an account other than the local system account, open the ...\IBM\ITUAM\Server\Web\CIMSReporting\Web.config file on the Web server and uncomment the identity element as follows. (The identity element follows the authorization element.)

```xml
<authorization>
   <allow users="*"/> <!-- Allow all users -->
   <!--
   <allow users="[comma separated list of users]"
      roles="[comma separated list of roles]"/>
   <deny users="[comma separated list of users]"
      roles="[comma separated list of roles]"/>
   -->
</authorization>

<identity impersonate="true" userName="ITUAMUser" password="password"/>
```

Edit the userName and password attributes, or if the Web site is run under multiple accounts, remove these attributes. It is recommended that you do not set user account passwords to password.

**Note** • The updated Web.config file will not be overwritten when you upgrade to a new release of ITUAM.
Setting Up and Connecting to a Database

The database stores administration information as well as the output records produced by ITUAM Processing Engine. These records are called the Ident, Detail, and Summary records and contain data processed from CSR or CSR+ records. Each process definition in the Processes folder (Windows) or processes directory (UNIX or Linux) produces separate Ident, Detail and Summary files.

You can use more than one database with ITUAM. For example, you might have a production database and a development database. For more information about creating multiple databases, see Chapter 6, Database Administration.

This section provides the steps required to set up and connect to a database by database type.

■ For DB2 for Linux, UNIX, and Windows, see page 2-40.
■ For DB2 for z/OS, see page 2-49.
■ For SQL Server, see page 2-60.
■ For Oracle, see page 2-72.
■ For MSDE, see page 2-79.

About ITUAM Data Sources

An ITUAM Data Source is required to connect to the ITUAM database.

On the Windows ITUAM application server, an ITUAM data source points to an ODBC data source, which points to a database. Regardless of the type of database you are using and the location of the database (Windows, UNIX/Linux, or z/OS), you must create an ITUAM Data Source for the database using ITUAM Administrator. The steps for creating an ITUAM Data Source are provided by database type beginning with Setting Up and Connecting to a DB2 for Linux, UNIX, and Windows Database on page 2-40.

If you are running ITUAM Processing Engine on a UNIX or Linux system, you must create an ITUAM Data Source in two places:

■ On the Windows system using ITUAM Administrator
  And

■ On the UNIX or Linux system using the ITUAMDBConfig.xml file (see Modifying the ITUAMDBConfig.xml File on page 3-19). On a UNIX or Linux system, ITUAM Processing Engine uses a JDBC driver to connect to the database.

The ITUAM Data Source on both the Windows and UNIX or Linux system must point to the same database.
Backing Up the Database

It is extremely important that you back up your ITUAM database(s) so that you can recover your data in case of media failure or natural disaster. A weekly database back up to a different server at another site is recommended.

If you are using a SQL Server or MSDE database, you can use the SampleSQLMaintenance.bat script (see SampleSQLMaintenance.bat Script on page C-24) to backup and maintain the database or you can use the steps shown in Backing Up and Maintaining Databases on page 5-5.

If you are using a DB2 or Oracle database, consult your DBA for assistance in backing up and maintaining the database.
Setting Up and Connecting to a DB2 for Linux, UNIX, and Windows Database

To enable ITUAM to use a DB2 for Linux, UNIX, and Windows database, follow the steps in this section.

Create a DB2 for Linux, UNIX, and Windows Database

To create a DB2 database, consult your DB2 DBA.

Create a DB2 User Account or Accounts for ITUAM

When you create a DB2 database, consider that there are two types of ITUAM users: the ITUAM administrator and ITUAM Web Reporting end users. You can create one DB2 user ID for both user types or create separate user IDs for each user type. For example, you can create a user ID for the end users that has fewer database permissions than the ID for the administrator. The administrator account must be able to create and manage its tables, views and stored procedures.

You can also create a separate user ID for the ITUAM Job Runner application. This application runs ITUAM Data Collectors in batch. The user ID for Job Runner must have the same database permissions as the ITUAM administrator.

Although not required, you can create a table space for the administrator and assign that as the Default table space. You can then use this table space for the end user account and the Job Runner account (if these accounts have been created).

Create a Buffer Pool and Table Spaces

After you create the database, create a buffer pool for the database and Regular and User temporary table spaces as shown in the following steps. This step ensures that you have a buffer pool of sufficient size and that you have required regular and temporary table spaces (some stored procedures require a temporary table space). Consult your DBA for assistance.

1. Start DB2 Control Center.
2. Navigate to the database and expand it.
3. Create a buffer pool for the database with a minimum page size of 16K. (Right-click Buffer Pools, and then click Create.)
4. Create the following new table spaces for the database (right-click Table Spaces, and then click Create):
   - A Regular table space.
   - A User temporary table space.

When asked to specify the buffer pool for these table spaces, select the buffer pool that you added in Step 3.
Enable ITUAM to Access the DB2 for Linux, UNIX, and Windows Database

ITUAM components such as ITUAM Administrator, ITUAM Web and batch reporting, and ITUAM Data Collectors all require access to the database. To enable these components to use the database, complete the following steps.

If the Database and ITUAM Are on Separate Servers, Install and Configure a DB2 Client or DB2 Connect

Note • If the database and ITUAM are on the same server, a DB2 client or DB2 Connect is not required. Continue to Enable Connection to the DB2 for Linux, UNIX, and Windows Database on page 2-41.

If the database is on a separate server than ITUAM, install either a DB2 client that provides access to the database or DB2 Connect on the ITUAM application server and configure a connection to the DB2 system. The DB2 clients and DB2 Connect include the DB2 ODBC driver.

For a detailed description of how to install and configure a DB2 client or DB2 Connect, refer to the IBM DB2 Information Center.

The following is an example of how to configure DB2 Connect to connect to the database. The requirements for your site might be different than this example.

1 Start DB2 Configuration Assistant.

2 In Configuration Assistant, click Selected ▶ Add Database Using Wizard.

   The Add Database Wizard is displayed.

3 On the Select how you want to set up a connection page, click Search the network, and click Next.

4 On the Select a database from the network search result page, navigate to the database that you want, and then click Next.

5 On the Specify a nickname for the database page, type an alias for the database and comments (both are optional), and then click Next.

6 On the Register this database as a data source page, click Register this database for ODBC and As system data source, and then click Finish.

   The Add Database Confirmation message box is displayed. You can use this box to close the wizard, add another database, change the database configuration that you just added, or test the connection to the database (recommended).

   You can view the database in the DB2 Control Center application.

Enable Connection to the DB2 for Linux, UNIX, and Windows Database

ITUAM requires an ODBC Data Source and one more ITUAM Data Sources to connect to a DB2 for Linux, UNIX, and Windows database.
An ITUAM Data Source points to an ODBC Data Source, which points to the database. The number of ITUAM Data Sources that you must create for an ODBC Data Source depends on the number of database users that you created for ITUAM.

If you created one DB2 user ID for all ITUAM users, create one ODBC Data Source and one ITUAM Data Source. See Example Configuration 1 on page 2-43.

If you created multiple DB2 user IDs (for example, one for the ITUAM administrators and one for the ITUAM Web Reporting end users), create one ODBC Data Source and then create a separate ITUAM Data Source that points to the ODBC Data Source for each user. Each ITUAM Data Source will contain the appropriate database user ID and password. See Example Configuration 2 on page 2-46.

When you install ITUAM for the first time, the ITUAM Data Source Maintenance dialog box opens automatically when you start ITUAM Administrator. This dialog box is initially blank. Use this dialog box to create the ITUAM Data Source.
Example Configuration 1

Assume that the DB2 user ID ITUAMADMIN and the password ADMIN is used to access the database. This user is used by both ITUAM administrators and the ITUAM Web Reporting end users.

In this situation, you would perform the following steps to create one ODBC Data Source that points to the database and one ITUAM Data Source that points to the ODBC Data Source.

1 Start ITUAM Administrator (Start ➤ Programs ➤ ITUAM ➤ ITUAM Administrator if you installed ITUAM in the default location).

2 In the ITUAM Data Source Maintenance dialog box, click Add. (If this dialog box is not open, click System Administration ➤ ITUAM Data Source Maintenance.)

3 In the Add ITUAM Data Source dialog box, type an ID for the ITUAM Data Source, and then click OK. In this example, the ID is ITUAM.

The Configure ITUAM Data Source dialog box is displayed.

4 If the ODBC Data Source for the database appears in the Select a System ODBC Data Source list, double-click the data source. In this example, the ODBC Data Source name is the same as the ITUAM Data Source ID (ITUAM).

The CLI/ODBC Settings dialog box is displayed. Continue to Step 5.

If the ODBC Data Source for the database does not appear in the Select a System ODBC Data Source list, complete the following steps:

a Click ODBC Data Source Administrator. The ODBC Data Source Administrator dialog box appears.

b On the System DSN tab, click Add. The Create New Data Source wizard is displayed.

c Click the DB2 driver that you want to use to set up the data source and then click Finish. The driver name – Add dialog box appears.

d In the driver name – Add dialog box, do the following:

   a In the Data source name box, type the name that you want to assign to the ODBC Data Source. In this example, the ODBC Data Source name is the same as the ITUAM Data Source (ITUAM).

   b In the Database alias list, click the alias for the database that you want the ODBC Data Source to point to. If the alias is not displayed in the list, click Add to add an alias. If you need assistance choosing or creating the database alias, consult your DB2 DBA.

   c In the Description box, type an optional description of the ODBC Data Source.

   d Click OK to close the dialog box and return to the System DSN tab.

   e Double-click the ODBC Data Source that you just added. The CLI/ODBC Settings dialog box appears. Continue to Step 5.
5 On the **Data Source** tab, do the following:

a  Type the DB2 user ID and password in the **User ID** and **Password** boxes. In this example, the user ID is **ITUAMADMIN** and the password is **ADMIN**.

b  Click **Connect** to test the connection.

6 On the **Advanced Settings** tab, the parameter **DBALIAS** is displayed. In this example, the alias is **ITUAMDB**. Add the parameter **CURRENTSCHEMA** as follows:

a  Click **Add**.

b  In the **Select a CLI/ODBC parameter** list, click **CURRENTSCHEMA**, and then click **OK**.

c  In the Schema for ‘SET CURRENT SCHEMA’ issued after connect dialog box, type the schema name, and then click **OK**. (Consult your DB2 DBA for the database schema.) In this example, the schema name is **ITUAM**.

**Note**  Type the schema name in uppercase letters regardless of whether the actual name is lower or mixed case.

d  Click **Apply**. The parameters DBALIAS and CURRENTSCHEMA are displayed in the parameter list on the **Advanced Settings** tab as shown in example **Figure 2-1**. Click **OK** to close the dialog box.

![Figure 2-1 • CLI/ODBC Dialog Box—DB2 for Linux, UNIX, and Windows (LUW) Example](image)
7 Click OK to return to the Configure ITUAM Data Source dialog box and do the following.

a In the Select a System ODBC Data Source list, make sure that the correct ODBC Data Source is selected.

b In the User ID and Password boxes, type the DB2 user ID and password. In this example, the user ID is ITUAMADMIN and the password is ADMIN as shown in example Figure 2-2 on page 2-45. The password is encrypted.

c In the Owner/Schema box, you must type the same schema value that was set for the CURRENTSCHEMA parameter in Step 6 on page 2-44.

In this example, the schema is ITUAM. Note that the period at the end of the schema name is required and will be added automatically if you do not include it.

**Important!** At this time, there is no automated check to ensure that the value in the Owner/Schema box matches the CURRENTSCHEMA parameter value, so it is very important that you confirm that the values are the same in both places.

d In the Additional Parameters box, type any additional parameters that are required to enable connection to the database. For more information, consult your DB2 DBA.

![Configure ITUAM Data Source Dialog Box—DB2 for LUW Example](image-url)
8 Click OK to save the data source information and close the Configure ITUAM Data Source dialog box. The data source entry is displayed in the ITUAM Data Source Maintenance dialog box as shown in example Figure 2-3.

Because the ITUAM data source entry is the only entry in the list, it is automatically set as the default data source. For more information about the default ITUAM Data Source, see Setting a ITUAM Data Source as the Web Site/ITUAM Data Collectors Default on page 6-6.

![ITUAM Data Source Maintenance Dialog Box—DB2 for LUW Example](image)

**Figure 2-3 • ITUAM Data Source Maintenance Dialog Box—DB2 for LUW Example**

**Example Configuration 2**

Assume that two DB2 user IDs have been created for the database: one for ITUAM administrators and one for ITUAM Web Reporting end users. The user IDs for the administrator and end user logins are ITUAMADMIN with a password of ADMIN and ITUAMUSER with a password of USER, respectively.

In this situation, you would perform the following steps to create one ODBC Data Source and two ITUAM Data Sources that point to the ODBC Data Source. One ITUAM Data Source will contain the user ID and password for the administrator and the other ITUAM Data Source will contain the user ID and password for the end users.

1 Complete the steps in Example Configuration 1 on page 2-43 to create the ITUAM Data Source for the ITUAM administrator.

2 To add the second ITUAM Data Source for the end user login, click Add in the ITUAM Data Source List Maintenance dialog box.

3 In the Add ITUAM Data Source dialog box, type an ID for the second ITUAM Data Source, and then click OK. In this example, the ID is ITUAM2.
4 In the Configure ITUAM Data Source dialog box, do the following. Consult your DB2 DBA for assistance.

   a In the Select a System ODBC Data Source box, click the ODBC Data Source that you created for the administrator login.

   b In the User ID and Password boxes, type the DB2 user ID and password. In this example, the user ID is ITUAMUSER and the password is USER as shown in example Figure 2-4. The password is encrypted.

   c In the Owner/Schema box, you must type the same schema value that was set for the CURRENTSCHEMA parameter in Step 6 on page 2-44.

   In this example, the schema is ITUAM. Note that the period at the end of the schema name is required and will be added automatically if you do not include it.

   **Important!** At this time, there is no automated check to ensure that the value in the Owner/Schema box matches the CURRENTSCHEMA parameter value, so it is very important that you confirm that the values are the same in both places.

   d In the Additional Parameters box, type any additional parameters that are required to enable connection to the database. For more information, consult your DB2 DBA.

Figure 2-4  Configure ITUAM Data Source Dialog Box—DB2 for LUW Example
5 Click OK to save the data source information and close the Configure ITUAM Data Source dialog box. Two data source entries are displayed in the ITUAM Data Source Maintenance dialog box as shown in example Figure 2-5.

For example purposes, the ITUAM data source entry is set as the default data source. For more information about the default ITUAM Data Source, see Setting a ITUAM Data Source as the Web Site/ITUAM Data Collectors Default on page 6-6.

![ITUAM Data Source Maintenance Dialog Box—DB2 for LUW Example](image)

Figure 2-5 • ITUAM Data Source Maintenance Dialog Box—DB2 for LUW Example
Setting Up and Connecting to a DB2 for z/OS Database

To enable ITUAM to use a DB2 for z/OS database, follow the steps in this section.

Set the DESCSTAT System Parameter

To use a DB2 for z/OS database with ITUAM, the DB2 DESCRIBE FOR STATIC (DESCSTAT) system parameter must be set to YES. This parameter is specified on the DSNTIP4 installation panel and in release 8.1 is set to YES by default. For more information about this parameter, refer to the IBM DB2 UDB for z/OS V8 Installation Guide.

Create a DB2 for z/OS Database

To create a DB2 for z/OS database, consult your DB2 DBA.

Create a DB2 User Account or Accounts for ITUAM

When you create a DB2 database, consider that there are two types of ITUAM users: the ITUAM administrator and ITUAM Web Reporting end users. You can create one DB2 user ID for both user types or create separate user IDs for each user type. For example, you can create a user ID for the end users that has fewer database permissions than the ID for the administrator. The administrator account must be able to create and manage its tables, views and stored procedures.

You can also create a separate user ID for the ITUAM Job Runner application. This application runs ITUAM Data Collectors in batch. The user ID for Job Runner must have the same database permissions as the ITUAM administrator.

Although not required, you can create a table space for the administrator and assign that as the Default table space. You can then use this tablespace for the end user account and the Job Runner account (if these accounts have been created).

Create a Buffer Pool and Table Spaces

After you create the database, create a buffer pool for the database and Regular and User temporary table spaces as shown in the following steps. This step ensures that you have a buffer pool of sufficient size and that you have required regular and temporary table spaces (some stored procedures require a temporary table space). Consult your DBA for assistance.

1. Start DB2 Control Center.
2. Navigate to the database and expand it.
3. Create a buffer pool for the database with a minimum page size of 16K. (Right-click Buffer Pools, and then click Create.)
4. Create the following new table spaces for the database (right-click Table Spaces, and then click Create):
   - A Regular table space.
   - A User temporary table space.
When asked to specify the buffer pool for these table spaces, select the buffer pool that you added in Step 3.

Enable ITUAM to Access the DB2 for z/OS Database
ITUAM components such as ITUAM Administrator, ITUAM Web and batch reporting, and ITUAM Data Collectors all require access to the database. To enable these components to use the database, complete the following steps.

Install and Configure DB2 Connect
Install DB2 Connect on the ITUAM application server and configure a connection to the DB2 system. For a detailed description of how to install and configure DB2 Connect, refer to the appropriate IBM DB2 Quick Beginnings for DB2 Connect guide.

The following is an example of how to configure DB2 Connect. The requirements for your site might be different than this example.

1 Start DB2 Configuration Assistant.
2 In Configuration Assistant, click Selected ▶ Add Database Using Wizard.
   The Add Database Wizard is displayed.
3 On the Select how you want to set up a connection page, click Manually configure a connection to a database, and then click Next.
4 On the Select a communications protocol page, click TCP/IP, and then click Next.
5 On the Specify TCP/IP communication parameters page, complete the following, and then click Next:
   - Host name. Type the host name, IP address, or IP name where the target database resides.
   - Service name. Type the service name of the server database manager instance or leave this box blank.
   - Port number. Type the port number associated with the DB2 server instance that contains the target database.

To determine the correct host name and port number, refer to the DDF configuration which is displayed in the z/OS startup messages as shown in the following example:

```
06.39.08 STC09640 DSNL0041 @DDF START COMPLETE 872
872   LOCATION    KSCDB201
872   LU          USIBMKS..KSCDB201
872   GENERICLU   -NONE
872   DOMAIN      demomvs.db2.ibm.com
872   TCPPORT     5663
872   RESPOR      5463
```

In this example, the host name is demomvs.db2.ibm.com and the port is 5663.
6 On the Specify the name of the database to which you want to connect page, type the database name and alias, and then click Next. Note that the database name is not a database within the DB2 for z/OS instance. It is the location name specified in the DDF configuration. In the preceding startup message, the database name is KSCDB201.

7 On the Register this database as a data source page, accept the default values, and then click Next.

8 On the Specify the node options page, click OS/390 or z/OS in the Operating System box. In the Instance name box, type the name of the instance where the database is located or leave this box blank. Click Next.

9 On the Specify the system options page, type the system name in the System name box. This is the z/OS system name where the target database is located. Click Next.

10 On the Specify the security options page, click Use authentication value in server’s DBM Configuration. Click Finish.

The Add Database Confirmation message box is displayed. You can use this box to close the wizard, add another database, change the database configuration that you just added, or test the connection to the database (recommended).

You can view the database in the DB2 Control Center application.

**Enable Connection to the DB2 for z/OS Database**

ITUAM requires an ODBC Data Source and one more ITUAM Data Sources to connect to a DB2 for z/OS database. You should have created the ODBC Data Source when you configured DB2 Connect (see Step 7 in the preceding section).

An ITUAM Data Source points to an ODBC Data Source, which points to the database.

When you install ITUAM for the first time, the ITUAM Data Source Maintenance dialog box opens automatically when you start ITUAM Administrator. This dialog box is initially blank. Use this dialog box to create the ITUAM Data Source.

The following are a data source configuration examples for a single DB2 for z/OS database and multiple databases.
Example Configuration—One Database

Assume that the user ID ITUAMADMIN and the password ADMIN is used to access the database. This user is used by both ITUAM administrators and the ITUAM Web Reporting end users.

In this situation, you would perform the following steps to create one ODBC Data Source that points to the database and one ITUAM Data Source that points to the ODBC Data Source.

1. Start ITUAM Administrator (Start ➤ Programs ➤ ITUAM ➤ ITUAM Administrator if you installed ITUAM in the default location).

2. In the ITUAM Data Source Maintenance dialog box, click Add. (If this dialog box is not open, click System Administration ➤ ITUAM Data Source Maintenance.)

3. In the Add ITUAM Data Source dialog box, type an ID for the ITUAM Data Source, and then click OK. In this example, the ID is ITUAM.

   The Configure ITUAM Data Source dialog box is displayed.

4. In the Select a System ODBC Data Source list, double-click the ODBC Data Source for the DB2 database. You should have created the ODBC Data Source when you configured DB2 Connect (see Step 7 on page 2-51). In this example, the ODBC Data Source name is the same as the ITUAM Data Source ID (ITUAM).

   The CLI/ODBC Settings dialog box is displayed.

5. On the Data Source tab, do the following:

   a. Type the DB2 user ID and the password in the User ID and Password boxes. In this example, the user ID is ITUAMADMIN and the password is ADMIN.

   b. Click Connect to test the connection.

6. On the Advanced Settings tab, the parameter DBALIAS is displayed with the alias that you selected in Step 6 on page 2-51. In this example, the alias is ITUAMDB.

   Add the parameters DBNAME and CURRENTSCHEMA. You can locate the database name and schema in the DB2 Control Center by expanding All Systems and navigating to Databases under the appropriate subsystem. The schema name is in the Creator column.

   To add the DBNAME parameter:

   a. Click Add. The Add CLI/ODBC parameter dialog box is displayed.

   b. In the Select a CLI/ODBC parameter list, click DBNAME, and then click OK.

   c. In the MVS DBNAME filter dialog box, type the database name, and then click OK. For this example, the database name is ITUAM.
To add the CURRENTSCHEMA parameter:

a Click Add.

b In the Select a CLI/ODBC parameter list, click CURRENTSCHEMA, and then click OK.

c In the Schema for ‘SET CURRENT SCHEMA’ issued after connect dialog box, type the schema name, and then click OK. For this example, the schema name is also ITUAM.

Note • Type the entire schema name in uppercase letters regardless of whether the actual name is in lower or mixed case.

7 Click Apply. The parameters DBNAME and CURRENTSCHEMA are displayed in the parameter list on the Advanced Settings tab as shown in example Figure 2-6. Click OK to close the dialog box.

Figure 2-6 • CLI/ODBC Dialog Box—DB2 for z/OS Example

8 Click OK until you return to the Configure ITUAM Data Source dialog box and do the following.

a In the Select a System ODBC Data Source list, make sure that the correct ODBC Data Source is selected.

b In the User ID and Password boxes, type the DB2 user ID and the password. In this example, the user ID is ITUAMADMIN and the password is ADMIN as shown in example Figure 2-7. The password is encrypted.
Installing ITUAM on Windows and Getting Started

Setting Up and Connecting to a Database

C In the Owner/Schema box, you must type the same schema value that you set for the CURRENTSCHEMA parameter in Step 6 on page 2-52.

In this example, the schema is ITUAM. Note that the period at the end of the schema name is required and will be added automatically if you do not include it.

Important! At this time, there is no automated check to ensure that the value in the Owner/Schema box matches the CURRENTSCHEMA parameter value, so it is very important that you confirm that the values are the same in both places.

D In the Additional Parameters box, type any additional parameters that are required to enable connection to the database. For more information, consult your DB2 DBA.

Figure 2-7 Configure ITUAM Data Source Dialog Box—DB2 for z/OS Example

9 Click OK to save the data source information and close the Configure ITUAM Data Source dialog box. The data source entry is displayed in the ITUAM Data Source Maintenance dialog box as shown in example Figure 2-8 on page 2-55.

Because the ITUAM data source entry is the only entry in the list, it is automatically set as the default data source. For more information about the default ITUAM Data Source, see Setting a ITUAM Data Source as the Web Site/ITUAM Data Collectors Default on page 6-6.
Example Configuration—Two Databases

If you are using multiple DB2 for z/OS databases with ITUAM, each database must have tables with a unique creator.tablename pair.

In the preceding example, the creator for the tables in the ITUAM database is ITUAM. Assume that ITUAM is your production database and you have also created a development database named ITUAMDEV that also has a creator of ITUAM. In this situation, you would perform the following steps to create tables for the ITUAMDEV database with a unique creator.

The following example shows you how to create a creator named ITUAMD for the tables in the ITUAMDEV database. The DB2 user ID and password for the DB2 subsystem is ITUAMADMIN and ADMIN, respectively.

1. In the DB2 Control Center application, create a database user. This will be the database creator. In this example, the user is ITUAMD. The user must have privileges to select, insert, update, and delete tables.

2. In ITUAM Administrator, open the ITUAM Data Source Maintenance dialog box and click Add.

3. In the Add ITUAM Data Source dialog box, type an ID for the ITUAM Data Source, and then click OK. In this example, the ID is ITUAMDEV. The Configure ITUAM Data Source dialog box is displayed.

4. Click ODBC Data Source Administrator. The ODBC Data Source Administrator dialog box is displayed.

5. On the System DSN tab, click Add. The Create New Data Source wizard is displayed.
6 Click the DB2 driver that you want to use to set up the data source and then click Finish. The driver name – Add dialog box is displayed.

7 In the driver name – Add dialog box, do the following:
   a In the Data source name box, type the name that you want to assign to the ODBC Data Source. For this example, the name is the same as the ITUAM Data Source ID (ITUAMDEV).
   b In the Database alias list, click the alias for the database that you want the ODBC Data Source to point to. If the alias is not displayed in the list, click Add to add an alias. If you need assistance choosing or creating the database alias, consult your DB2 DBA.
   c In the Description box, type an optional description of the ODBC Data Source.
   d Click OK to close the dialog box and return to the System DSN tab.

8 Double-click the ODBC Data Source that you just added. The CLI/ODBC Settings dialog box is displayed.

9 On the Data Source tab, do the following:
   a Type the DB2 user ID and the password in the User Id and Password boxes. In this example the user ID is ITUAMADMIN and the password is ADMIN.
   b Click Connect to test the connection.

10 On the Advanced Settings tab, the parameter DBALIAS is displayed with the alias that you selected in Step 7. You need to add the parameters DBNAME and CURRENTSCHEMA.
   To add the DBNAME parameter:
      a Click Add. The Add CLI/ODBC parameter dialog box is displayed.
      b In the Select a CLI/ODBC parameter list, click DBNAME, and then click OK.
      c In the MVS DBNAME filter dialog box, type the database name, and then click OK. In this example, the datase name is ITUAMDEV.
   To add the CURRENTSCHEMA parameter:
      a Click Add.
      b In the Select a CLI/ODBC parameter list, click CURRENTSCHEMA, and then click OK.
      c In the Schema for ‘SET CURRENT SCHEMA’ issued after connect dialog box, type the schema name, and then click OK. The schema name is database user that you created in Step 1 on page 2-55. In this example, the schema name is ITUAMD.
   The parameters DBNAME and CURRENTSCHEMA are displayed in the parameter list on the Advanced Settings tab as shown in example Figure 2-9. Click APPLY and then click OK to close the dialog box.
Click **OK** until you return to the Configure ITUAM Data Source dialog box and do the following:

**a** In the **Select a System ODBC Data Source** list, make sure that the correct ODBC Data Source is selected.

**b** In the **User ID** and **Password** boxes, type the DB2 user ID and the password. In this example, the user ID is `ITUAMADMIN` and the password is `ADMIN` as shown in example Figure 2-10 on page 2-58. The password is encrypted.

**c** In the **Owner/Schema** box, the schema value must be the same as the schema value that you entered for the CURRENCSHEMA parameter in Step 10 on page 2-56. In this example, the schema is `ITUAM`. as shown in example Figure 2-10 on page 2-58. Note that the period at the end of the schema name is required and will be added automatically if you do not include it.

**Important!** At this time, there is no automated check to ensure that the value in the Owner/Schema box matches the CURRENCSHEMA parameter value, so it is very important that you confirm that the values are the same in both places.
d In the Additional Parameters box, type any additional parameters that are required to enable connection to the database. For more information, consult your DB2 DBA.

![Configure ITUAM Data Source Dialog Box—DB2 for z/OS Example](image)

Figure 2-10  • Configure CIMS Data Source Dialog Box—DB2 for z/OS Example

12 Click OK to save the data source information and close the Configure ITUAM Data Source dialog box. The data source entry is displayed in the ITUAM Data Source Maintenance dialog box as shown in example Figure 2-11.

![ITUAM Data Source Maintenance Dialog Box—DB2 z/OS Example](image)

Figure 2-11  • ITUAM Data Source Maintenance Dialog Box—DB2 z/OS Example
13 Close the ITUAM Data Source Maintenance dialog box, and go to the Select ITUAM Data Source list at the bottom of the ITUAM Data Collectors main window. This list enables you to point ITUAM Administrator to the data source that you want to use. Make sure that you select the data source that you just created (in this example, ITUAMDEV).

14 Click System Administration \ Database \ Initialize Database and initialize the database as described in Initialize the Database on page 2-83.

The initialization process will create tables in the ITUAMDEV database with a creator of ITUAMD. To confirm that the tables have been created, start the DB2 Control Center and navigate to the subsystem that contains the ITUAMDEV database. Expand the subsystem, and click Tables. The tables for ITUAMDEV database should be displayed with a creator of ITUAMD.
Setting Up and Connecting to a Microsoft SQL Server Database

To enable ITUAM to use a SQL Server database, follow the steps in this section.

Create a Database

Note • The steps in this section reflect creating a database in SQL Server 2000. If you are using SQL Server 2005, refer to the Microsoft documentation if needed.

You can create a database using SQL Server Enterprise Manager or the OSQL or ISQL command-line interface. The following are the steps needed to create a database using Enterprise Manager:

1 In Windows, click Start ▶ Programs ▶ Microsoft SQL Server ▶ Enterprise Manager.

2 In the Tree window, under Console Root, navigate to Microsoft SQL Server ▶ SQL Server Group ▶ computername ▶ Databases.

3 Right-click the Databases folder, and then click New Database.

4 In the Database Properties dialog box, enter the configuration information for the new database as follows:

   • On the General tab do the following:
     • In the Name box, type a name for the database.
     • In the Collation name box, click SQL_Latin1_General_CP1_CI_AS. Make sure that you select only this database collation type and not a type that looks similar. ITUAM currently does not support other collation types.
     • Unless you need to change the default settings for the database, you do not need to reset values in the Data File or Transaction Log tabs.

5 Click OK when you are finished.
Create User Logins for the Database

There are two types of ITUAM users: the ITUAM administrator or administrators and ITUAM Web Reporting end users. After you create the database, you must create a database login for these users. You can create one login for both user types or separate logins. For example, you can create a login for the end users that has fewer database permissions than the login for the administrator(s).

**Note** • You can also create a separate login for the ITUAM Job Runner application. This application runs ITUAM Data Collectors in batch. The login for Job Runner must have the same database permissions as the ITUAM administrator.

The user login includes the user authentication method for the database (Windows authentication or SQL Server authentication). When creating a login, consider the following when choosing the authentication method:

- Windows authentication verifies the SQL Server user using the Windows user account. If the user is the ITUAM administrator, SQL Server uses the account on the computer running ITUAM Administrator.

- SQL Server authentication verifies the user using the SQL Server login ID and password. Using this authentication method, you could create a single login for all ITUAM administrators, a login for all ITUAM Web Reporting end users, or a login for both administrators and end users.

**Note** • There is an optional table audit feature that enables you to track changes that have been made to the data in certain database tables (see Table Audit Settings on page 4-52). This information includes the user ID of the person who made the change. If you use SQL Server authentication for multiple users, you will not be able to identify the actual user who made the change.

The authentication type that you can use is dependent on the SQL Server and IIS configuration as shown in Table 2-2 on page 2-62. Note that if you are using SQL Server Reporting Services for reporting, Windows authenticated access is recommended for configurations where authenticated access or anonymous access can be used for IIS. See Set the User Authentication Method for the Web Sites on page 2-94.
Setting Up and Connecting to a Database

The number of ODBC Data Sources and ITUAM Data Sources that you must configure for a database depends on the number of logins that you created for the database and the authentication method used for the logins. The steps required to set up ODBC and ITUAM Data Sources are provided in Install ODBC Data Sources on page 2-64. A summary table of possible ODBC and ITUAM Data Source configurations is provided on page 11-22.

To create a user login:

1. In the SQL Server Enterprise Manager, right-click the database that you created in Create a Database on page 2-60.
2. Click New ▶ Database User. The Database User Properties—New User dialog box is displayed.
3. In the Login name box, click <new>. The SQL Server Login Properties—New Login dialog box is displayed.

Table 2-2 • IIS and SQL Server User Authentication Requirements

<table>
<thead>
<tr>
<th>IIS and SQL Server Configuration</th>
<th>Required IIS User Authentication</th>
<th>Required SQL Server User Authentication</th>
</tr>
</thead>
<tbody>
<tr>
<td>IIS and SQL Server on the same server. ITUAM Web Reporting on an intranet site.</td>
<td>Authenticated access Or Authenticated access Or Anonymous access</td>
<td>Windows authentication SQL Server authentication SQL Server authentication</td>
</tr>
<tr>
<td>IIS and SQL Server on separate servers. ITUAM Web Reporting on an intranet site.</td>
<td>Authenticated access Or Anonymous access</td>
<td>SQL Server authentication SQL Server authentication</td>
</tr>
<tr>
<td>IIS and SQL Server on same or separate servers. ITUAM Web Reporting on an Internet site.</td>
<td>Anonymous access</td>
<td>SQL Server authentication</td>
</tr>
</tbody>
</table>

The number of ODBC Data Sources and ITUAM Data Sources that you must configure for a database depends on the number of logins that you created for the database and the authentication method used for the logins. The steps required to set up ODBC and ITUAM Data Sources are provided in Install ODBC Data Sources on page 2-64. A summary table of possible ODBC and ITUAM Data Source configurations is provided on page 11-22.

To create a user login:

Note • For example purposes, the following steps reflect creating a separate user login for ITUAM Web Reporting administrators and ITUAM Web Reporting end users. To create one login for both user types, follow the steps as if you are creating an administrator login.

1. In the SQL Server Enterprise Manager, right-click the database that you created in Create a Database on page 2-60.
2. Click New ▶ Database User. The Database User Properties—New User dialog box is displayed.
3. In the Login name box, click <new>. The SQL Server Login Properties—New Login dialog box is displayed.
4 On the General tab, do the following:
   - In the Name box, do one of the following:
     - To use Windows user authentication, enter the user name. To browse for a user, click the Browse button.
     - To use SQL Server user authentication, type a user login name.
   - In the Authentication area, click either Windows Authentication or SQL Server Authentication. If you select SQL Server Authentication, type a password.
   - In the Defaults area, click the default database for the login in the Database box. This is the database that you created in Create a Database on page 2-60.

5 If you are creating a login for an ITUAM administrator, on the Server Roles tab, select the System Administrators check box.

6 On the Database Access tab, select the Permit check box for the database you are creating the login for.
   A list of database permits is displayed with the public check box selected.

7 Leave the public check box selected and do one of the following:
   - If you are creating a login for an ITUAM administrator, select the db_owner check box, and then click OK.
   - If you are creating a login for ITUAM Web Reporting end users, select the db_datareader and db_datawriter check boxes, and then click OK.

8 If you selected SQL Server authentication, in the Confirm Password dialog box, type the login password again, and then click OK.

9 Click the Close button to close the Database User Properties—New User dialog box.

To confirm that the user login has been added, expand the database and click Users.
Enable Connection to the SQL Server Database

ITUAM requires an ODBC Data Source and one more ITUAM Data Sources to connect to a SQL Server database.

An ITUAM Data Source points to an ODBC Data Source, which points to the database. The number of ODBC Data Sources and ITUAM Data Sources that you must create depends on the number of logins that you created for the database and the authentication method used for the logins as follows:

- If you created one database user login for both the ITUAM administrators and ITUAM Web Reporting end users, or you created separate logins that both use Windows authentication, create one ODBC Data Source and one ITUAM Data Source. For an example of how to set up this configuration, see Example Configuration 1.

- If you created one login for the administrators and one login for the end users and both logins use SQL Server authentication, create one ODBC Data Source and two ITUAM Data Sources that point to the ODBC Data Source. One ITUAM Data Source will contain the user ID and password for the administrator login and the other ITUAM Data Source will contain the user ID and password for the end user login. For an example of how to set up this configuration, see Example Configuration 2 on page 2-67.

- If you created one login for the administrators and one login for the end users and each login uses a different authentication method, create a separate ODBC Data Source and ITUAM Data Source for each login. For an example of how to set up this configuration, see Example Configuration 3 on page 2-69.

When you install ITUAM for the first time, the ITUAM Data Source Maintenance dialog box opens automatically when you start ITUAM Administrator. This dialog box is initially blank. Use this dialog box to create the ITUAM Data Source.

Example Configuration 1

Assume that one user login has been created for the database. This login uses SQL Server authentication with user ID of ITUAMADMIN and a password of ADMIN. This login is used by both the ITUAM administrators and the ITUAM Web Reporting end users.

In this situation, you would perform the following steps to create one ODBC Data Source that points to the database and one ITUAM Data Source that points to the ODBC Data Source.

1. Start ITUAM Administrator (Start ➤ Programs ➤ ITUAM ➤ ITUAM Administrator if you installed ITUAM in the default location).
2. In the ITUAM Data Source Maintenance dialog box, click Add. (If this dialog box is not open, click System Administration ➤ ITUAM Data Source Maintenance.)
3. In the Add ITUAM Data Source dialog box, type an ID for the ITUAM Data Source, and then click OK. In this example, the ID is ITUAM. The Configure ITUAM Data Source dialog box is displayed.
4 Click ODBC Data Source Administrator. The ODBC Data Source Administrator dialog box is displayed.

5 On the System DSN tab, click Add. The Create New Data Source wizard is displayed.

6 Follow the steps provided in the wizard to point to the database. Consult your SQL Server DBA to determine the settings that you should select in the wizard. Note the following:

   • The wizard prompts you to type a name for the ODBC Data Source. In this example, the name is the same as the ITUAM Data Source (ITUAM).

   • Select the specific SQL Server installation that you want to connect to regardless of whether the database is on the local server. Do not select (local).

   • The wizard prompts you with the following: **How should SQL Server verify the authenticity of the login ID?** Click the correct authentication method (Windows or SQL Server). If you select SQL Server authentication, type the SQL Server user ID and password in the Login ID and Password boxes.

      In this example, you would click the SQL Server authentication method and then type the user ID ITUAMADMIN and the password in the Login ID and Password boxes.

      • **For Internationalization Only.** To select a language for the data source that is other than the default language, select the Change Language of SQL Server Messages to check box and click the language that you want from the list.

      **Important!** • Do not select the Use regional settings when outputting currency, numbers, dates, and times check box (the default for this check box is unselected). ITUAM does not support this option. Regional settings are supplied by the regional options for the user logged on to the computer (see Internationalization Setup on page 2-13).

7 When the wizard completes, click Test Data Source to make sure that the configuration was successful, and then click OK until the wizard and ODBC Data Source Administrator dialog boxes close.

8 In the Configure ITUAM Data Source dialog box, do the following:

   a In the Select a System ODBC Data Source list, make sure that ODBC Data Source that you just created is selected.

   b In the User ID and Password boxes, type the SQL Server user ID and password. In this example, the user ID is ITUAMADMIN and the password is ADMIN as shown in example Figure 2-12 on page 2-66. The password is encrypted.

   c In the Owner/Schema box, it is strongly recommended that you leave the default dbo. prefix. This prefix sets the owner of the database objects in the database to dbo, which allows any authorized database user to view the objects. For more information about the database objects in ITUAM, see Chapter 6, Database Administration.
In the **Additional Parameters** box, type any additional parameters that are required to enable connection to the database. For more information, consult your SQL Server DBA.

![Configure ITUAM Data Source Dialog Box—SQL Server Example 1](image)

**Figure 2-12 • Configure ITUAM Data Source Dialog Box—SQL Server Example 1**

9 Click **OK** to save the data source information and close the Configure ITUAM Data Source dialog box. The data source entry is displayed in the ITUAM Data Source Maintenance dialog box as shown in example **Figure 2-13 on page 2-67**.

Because the **ITUAM** data source entry is the only entry in the list, it is automatically set as the default data source. For more information about the default data source, see *Setting a ITUAM Data Source as the Web Site/ITUAM Data Collectors Default* on page 6-6.
Note that if you point to the master database when you set up the ODBC Data Source, the following message is displayed when you close the ITUAM Data Source Maintenance dialog box:

The data source <ODBC Data Source Name> is using the database 'master'. The use of the 'master' database to store ITUAM data is not recommended. Do you want to create a database called <ODBC Data Source Name> and use it instead?

If you want to use the master database, click No.

If you do not want to use the master database, click Yes and a database with the same name as the ODBC Data Source is created.

**Example Configuration 2**

Assume that two user logins have been created for the database: one login for the administrators and one login for the end users. Both logins use SQL Server authentication. The user IDs for the administrator and end user logins are ITUAMADMIN with a password of ADMIN and ITUAMUSER with a password of USER, respectively.

In this situation, you would perform the following steps to create one ODBC Data Source that points to the database and two ITUAM Data Sources that point to the ODBC Data Source. One ITUAM Data Source will contain the user ID and password for the administrator login and the other ITUAM Data Source will contain the user ID and password for the end user login.

1. Complete the steps in **Example Configuration 1** on page 2-64 to create the ODBC Data Source and the ITUAM Data Source for the ITUAM administrator login.
2 To add the second ITUAM Data Source for the end user login, click **Add** in the ITUAM Data Source List Maintenance dialog box.

3 In the Add ITUAM Data Source dialog box, type an ID for the second ITUAM Data Source, and then click **OK**. In this example, the ID is **ITUAM2**. The Configure ITUAM Data Source dialog box is displayed.

4 In the Configure ITUAM Data Source dialog box, do the following:
   a In the **Select a System ODBC Data Source** list, click the ODBC Data Source that you created for the administrator login.
   b In the **User ID** and **Password** boxes, type the SQL Server user ID and password. In this example, the user ID is **ITUAMUSER** and the password **USER** as shown in example Figure 2-14. The password is encrypted.
   c Leave the other boxes set to the defaults unless you have a specific reason otherwise (see Step 8 on page 2-65 for more information).

5 Click **OK** to save the data source information and close the Configure ITUAM Data Source dialog box.
Two data source entries are displayed in the ITUAM Data Source Maintenance dialog box as shown in example Figure 2-15.

Figure 2-15 • ITUAM Data Source Maintenance Dialog Box–SQL Server Example 2

Example Configuration 3

Assume that two user logins have been created for the database: one login for the administrators and one login for the end users. The administrator login uses SQL Server authentication and the end user login uses Windows authentication.

In this situation, you would perform the following steps to create two ODBC Data Sources that both point to the database and separate ITUAM Data Sources that point to each ODBC Data Source.

1 Complete the steps in Example Configuration 1 on page 2-64 to create the ODBC source and ITUAM Data Source for the ITUAM administrator login.

2 To add the ODBC Data Source and ITUAM Data Source for the end user login, click Add in the ITUAM Data Source List Maintenance dialog box.

3 In the Add ITUAM Data Source dialog box, type an ID for the second ITUAM Data Source, and then click OK. In this example, the ID is ITUAM2.
   The Configure ITUAM Data Source dialog box is displayed.

4 Click ODBC Data Source Administrator. The ODBC Data Source Administrator dialog box is displayed.

5 On the System DSN tab, click Add. The Create New Data Source wizard is displayed.
6 Follow the steps provided in the wizard to point to the database. Consult your SQL Server DBA to determine the settings that you should select in the wizard. Note the following:

- The wizard prompts you to type a name for the ODBC Data Source. For this example, the name is the same as the ITUAM Data Source (ITUAM2).
- Select the specific SQL Server installation that you want to connect to regardless of whether the database is on the local server. Do not select (local).
- The wizard prompts you with the following: **How should SQL Server verify the authenticity of the login ID?** Click the Windows authentication method.

7 When the wizard completes, click **Test Data Source** to make sure that the configuration was successful, and then click **OK** until the wizard and ODBC Data Source Administrator dialog boxes close.

8 In the Configure ITUAM Data Source dialog box, do the following:
   a. In the **Select a System ODBC Data Source** list, make sure that ODBC Data Source that you just created is selected.
   b. Leave the **User ID** and **Password** boxes blank as shown in example Figure 2-16.
   c. Leave the other boxes set to the defaults unless you have a specific reason otherwise (see Step 8 on page 2-65 for more information).

![Configure ITUAM Data Source Dialog Box—SQL Server Example 3](image-url)
9 Click **OK** to save the data source information and close the Configure ITUAM Data Source dialog box. Two data source entries are displayed in the ITUAM Data Source Maintenance dialog box as shown in example Figure 2-17.

For example purposes, the ITUAM data source entry is set as the default data source. For more information about the default data source, see *Setting a ITUAM Data Source as the Web Site/ITUAM Data Collectors Default* on page 6-6.

![ITUAM Data Source Maintenance Dialog Box—SQL Server Example 3](image)

**Figure 2-17 • ITUAM Data Source Maintenance Dialog Box—SQL Server Example 3**
Setting Up and Connecting to an Oracle Database

To enable ITUAM to use an Oracle database, follow the steps in this section.

Create a Database

To create an Oracle database or databases, consult your Oracle DBA.

Create an Oracle Account for ITUAM

When you create an Oracle database, consider that there are two types of ITUAM users: the ITUAM administrator and ITUAM Web Reporting end users. You can create one Oracle user ID for both user types or create separate user IDs for each user type. For example, you can create a user ID for the end users that has fewer database permissions than the ID for the administrator. The administrator account must be able to create and manage its tables, views and stored procedures.

You can also create a separate user ID for the ITUAM Job Runner application. This application runs ITUAM Data Collectors in batch. The user ID for Job Runner must have the same database permissions as the ITUAM administrator.

Although not required, you can create a table space for the administrator and assign that as the Default table space. You can then use this tablespace for the end user account and the Job Runner account (if these accounts have been created).
Modify the sqlnet.ora File

The IIS Web server that is used for ITUAM Web Reporting and other ITUAM Web-based applications can be set up to use either anonymous or Windows authenticated access (see Set the User Authentication Method for the Web Sites on page 2-94).

If you are using an Oracle database and want to use Windows authentication for IIS, modify the following line in the Oracle sqlnet.ora file:

```
SQLNET.AUTHENTICATION_SERVICES= (NTS)
```

Either comment out the line by placing a pound sign (#) at the beginning of the line or change NTS to NONE as shown in the following examples:

```
#SQLNET.AUTHENTICATION_SERVICES= (NTS)
```

Or

```
SQLNET.AUTHENTICATION_SERVICES= (NONE)
```

If this line is not modified, the following error is issued: ORA-12638: Credential retrieval failed.

Enable ITUAM to Access the Oracle Database

ITUAM components such as ITUAM Administrator, ITUAM Web and batch reporting, and ITUAM Data Collectors all require access to the database. To enable these components to use the database, complete the following steps.

**If the Database and ITUAM Are on Separate Servers, Install the Oracle Client**

Oracle Client Software must be installed on the client computer. The client installation includes OO4O (Oracle Objects for OLE), which is required to access the database.

Enable Connection to the Oracle Database

ITUAM requires an ODBC Data Source and one or more ITUAM Data Sources to connect to a SQL Server database.

An ITUAM Data Source points to an ODBC Data Source, which points to the database. The number of ODBC Data Sources and ITUAM Data Sources that you must create depends on the number of Oracle user IDs that you created for ITUAM.

If you created one user ID for all ITUAM users, create one ODBC Data Source and one ITUAM Data Source. See Example Configuration 1 on page 2-74.

If you created multiple user IDs (for example, one for the ITUAM administrators and one for the ITUAM Web Reporting end users), create one ODBC Data Source and then create separate ITUAM Data Sources that point to the ODBC Data Source for each user. Each ITUAM Data Source will contain the appropriate database user ID and password. See Example Configuration 2 on page 2-76.
Example Configuration 1

Assume that one Oracle user has been created for the database. This user is used by both ITUAM administrators and the ITUAM Web Reporting end users. The user ID is ITUAMADMIN and the password is ADMIN.

In this situation, you would perform the following steps to create one ODBC Data Source that points to the database and one ITUAM Data Source that points to the ODBC Data Source.

1. In the ITUAM Data Source Maintenance dialog box, click Add. (If this dialog box is not open, click System Administration → ITUAM Data Source Maintenance.)

2. In the Add ITUAM Data Source dialog box, type an ID for the ITUAM Data Source, and then click OK. In this example, the ID is ITUAM.

The Configure ITUAM Data Source dialog box is displayed.

3. Click ODBC Data Source Administrator. The ODBC Data Source Administrator dialog box is displayed.

4. On the System DSN tab, click Add. The Create New Data Source wizard is displayed.

5. Click the Oracle driver that you want to use to set up the data source, and then click Finish. The Oracle ODBC Driver Configuration dialog box is displayed.

6. In the Oracle ODBC Driver Configuration dialog box, do the following. Consult your Oracle DBA for assistance. The dialog box also includes a Help button.
   a. In the Data Source Name box, type the name that you want to assign to the ODBC Data Source. For this example, the name is the same as the ITUAM Data Source (ITUAM).
   b. In the optional Description box, type a description of the ODBC Data Source.
   c. In the TNS Service Name box, enter the location of the Oracle database from which the ODBC driver will retrieve data. This is the same name entered in the tnsnames.ora file using the Oracle Net Manager.
   d. In the optional User ID box, type a user ID for the Oracle database from which the ODBC drive will retrieve the data. If you do not provide the user ID in this box, you can type it when you test the connection to the database in Step 7.
   e. Leave the remaining options in the dialog box set to the defaults, or change the options as needed.

7. When you have set the options in the Oracle ODBC Driver Configuration dialog box, click Test Connection to make sure that the configuration was successful. The Oracle ODBC Driver Connect dialog box is displayed. Type a user ID and password for the database and click OK. If you entered a user ID in the User ID box, that user ID is displayed by default.

8. Click OK until you return to the Configure ITUAM Data Source dialog box, and do the following. Consult your Oracle DBA for assistance.
a In the **Select a System ODBC Data Source** list, make sure that ODBC Data Source that you just created is selected.

b In the **User ID** and **Password** boxes, type the Oracle user ID and password. In this example, the user ID is **ITUAMADMIN** and the password **ADMIN** as shown in example Figure 2-18 on page 2-75. The password is encrypted.

c In the **Owner/Schematic** box, type the name of the database schema that is used for the ITUAM database. Consult your Oracle DBA for the database schema. In example Figure 2-18, the schema is **ITUAM**. Note that the period at the end of the schema name is required and will be added automatically if you do not include it.

**Important!** The preceding steps associate a user ID with the schema for the ITUAM database. The user ID may or may not be the same as the schema name.

If the user ID is not the same as the schema name, you must install a trigger that changes the default schema of the user to the database schema. This is because other ITUAM administrative options and scripts and Crystal Reports require the user ID and schema but cannot access the ID and schema that are defined here.

For example, in Figure 2-18 the user ID is **ITUAMADMIN** and the schema is **ITUAM**. You would install a trigger that changes the default schema for the user **ITUAMADMIN** to the **ITUAM** schema. To create and install the trigger, use the **OracleLogonTrigger.bat** script as described on page C-14.

d In the **Additional Parameters** box, type any additional parameters that are required to enable connection to the database. For more information, consult your Oracle DBA.

![Figure 2-18 • Configure ITUAM Data Source Dialog Box—Oracle Example 1](image-url)
9 Click OK to save the data source information and close the Configure ITUAM Data Source dialog box. The data source entry is displayed in the ITUAM Data Source Maintenance dialog box as shown in example Figure 2-19. Because the ITUAM data source entry is the only entry in the list, it is automatically set as the default data source. For more information about the default data source, see Setting a ITUAM Data Source as the Web Site/ITUAM Data Collectors Default on page 6-6.

![ITUAM Data Source Maintenance Dialog Box—Oracle Example 1](image)

**Figure 2-19 • ITUAM Data Source Maintenance Dialog Box—Oracle Example 1**

**Example Configuration 2**

Assume that two Oracle users have been created for the database: one for ITUAM administrators and one for ITUAM Web Reporting end users. The user IDs for the administrator and end user logins are ITUADMIN with a password of ADMIN and ITUAMUSER with a password of USER, respectively.

In this situation, you would perform the following steps to create one ODBC Data Source and two ITUAM Data Sources that point to the ODBC Data Source. One ITUAM Data Source will contain the user ID and password for the administrator and the other ITUAM Data Source will contain the user ID and password for the end user.

1 Complete the steps in Example Configuration 1 on page 2-74 to create the ODBC Data Source and the ITUAM Data Source for the ITUAM administrator.

2 To add the second ITUAM Data Source for the end user login, click Add in the ITUAM Data Source List Maintenance dialog box.

3 In the Add ITUAM Data Source dialog box, type an ID for the second ITUAM Data Source, and then click OK. In this example, the ID is ITUAM2.

The Configure ITUAM Data Source dialog box is displayed.
4 In the Configure ITUAM Data Source dialog box, do the following. Consult your Oracle DBA for assistance.

- **a** In the Select a System ODBC Data Source box, click the ODBC Data Source that you added in Step 1 on page 2-76.

- **b** In the User ID and Password boxes, type the Oracle user ID and password. In this example, the user ID is ITUAMUSER and the password is user as shown in example Figure 2-20 on page 2-77. The password is encrypted.

- **c** In the Owner/Schema box, type the name of the database schema that is used for ITUAM. Consult your Oracle DBA for the database schema. In example Figure 2-20, the schema is ITUAM. Note that the period at the end of the schema name is required and is added automatically.

**Important!** As noted previously in the instructions for creating the ITUAMADMIN user, you must install a trigger that changes the default schema of the user to the ITUAM database schema if the user ID and schema are different. For example, in Figure 2-20 the user ID is ITUAMUSER and the schema is ITUAM. You would install a trigger that changes the default schema for the user ITUAMUSER to the ITUAM schema. To create and install the trigger, use the OracleLogonTrigger.bat script as described on page C-14.

- **d** In the Additional Parameters box, type any additional parameters that are required to enable connection to the database. For more information, consult your Oracle DBA.

---

**Figure 2-20 • Configure ITUAM Data Source Dialog Box—Oracle Example 2**
5 Click OK to save the data source information and close the Configure ITUAM Data Source dialog box. Two data source entries are displayed in the ITUAM Data Source Maintenance dialog box as shown in example Figure 2-21.

For example purposes, the ITUAM data source entry is set as the default data source. For more information about the default ITUAM data source, see page 6-6.

Figure 2-21 • ITUAM Data Source Maintenance Dialog Box—Oracle Example 2
Setting Up and Connecting to an MSDE Database

To enable ITUAM to use an MSDE database, follow the steps in this section.

**Note** • If you are using a SQL Server Express Edition database, which replaces MSDE in SQL Server 2005, refer to the Microsoft documentation where needed.

Create a Database

To create an MSDE database, use either the OSQL or ISQL command-line interface as follows. Press <Enter> after each command.

1. At the command prompt, log on to the database server. For example:

   ```
   osql -S servera-test -E
   ```

   Where `-S servera-test` indicates the server name and `-E` indicates use a trusted connection. Note that there are other switches that you may have to use depending on your environment. For example, you may have to specify the login ID (`-U`) and password (`-P`) switches. To view the OSQL switches, type `osql /?` at the command prompt.

2. At the `1>` prompt, type:

   ```
   create database database name
   ```

   Where `database name` is the name that you want to give the database.

3. At the `2>` prompt, type:

   ```
   go
   ```

   The following messages are displayed:

   ```
   The CREATE DATABASE process is allocating 0.63 MB on disk 'database name'.
   The CREATE DATABASE process is allocating 0.49 MB on disk 'database name_log'.
   ```

4. At the `1>` prompt, type:

   ```
   quit
   ```

**Note** • Because the MSDE master database contains system tables, it is recommended that you do not use this database as your ITUAM database. However, if you do choose to use the master database, it is supported by ITUAM.
Create User Logins for the Database

There are two types of ITUAM users: the ITUAM administrator or administrators and ITUAM Web Reporting end users. It is recommended that you use the default SQL Server user login sa with a password of sa for both ITUAM administrators and end users.

If you want to use a user login or logins other than sa, you can use the OSQL or ISQL command-line interface or a third-party product for maintaining the MSDE database.

Enable Connection to the Database

ITUAM requires an ODBC Data Source and one more ITUAM Data Sources to connect to an MSDE database.

An ITUAM Data Source points to an ODBC Data Source, which points to the database.

The following steps assume that you are using the database user login sa for both the ITUAM administrators and the ITUAM Web Reporting end users. In this situation, you would perform the following steps to create one ODBC Data Source that points to the database and one ITUAM Data Source that points to the ODBC Data Source.

Example Configuration

1. In the ITUAM Data Source Maintenance dialog box, click Add. (If this dialog box is not open, click System Administration ▶ ITUAM Data Source Maintenance.)

2. In the Add ITUAM Data Source dialog box, type an ID for the ITUAM Data Source, and then click OK. In this example, the data source ID is ITUAM.

The Configure ITUAM Data Source dialog box is displayed.

3. Click ODBC Data Source Administrator. The ODBC Data Source Administrator dialog box is displayed.

4. On the System DSN tab, click Add. The Create New Data Source wizard is displayed.

5. Follow the steps provided in the wizard to point to the database. Consult your SQL Server DBA to determine the settings that you should select in the wizard. Note the following:

   • The wizard prompts you to type a name for the ODBC Data Source. For this example, the name is the same as the ITUAM Data Source (ITUAM).

   • Select the specific SQL Server installation that you want to connect to regardless of whether the database is on the local server. Do not select (local).

   • The wizard prompts you with the following: How should SQL Server verify the authenticity of the login ID? Click the SQL Server authentication method and type sa in both the Login ID and Password boxes.

   • For Internationalization Only. To select a language for the data source that is other than the default language, select the Change Language of SQL Server Messages to check box and click the language that you want from the list.
Important! • Do not select the Use regional settings when outputting currency, numbers, dates, and times check box (the default for this check box is unselected). ITUAM does not support this option. Regional settings are supplied by the regional options for the user logged on to the computer (see Internationalization Setup on page 2-13).

6 When the wizard completes, click Test Data Source to make sure that the configuration was successful, and then click OK until the wizard and ODBC Data Source Administrator dialog boxes close.

7 In the Configure ITUAM Data Source dialog box, do the following:
   a In the Select a System ODBC Data Source list, make sure that ODBC Data Source that you just created is selected.
   b In the User ID and Password boxes, type sa (the SQL Server user ID and password) as shown in example Figure 2-22. The password is encrypted.
   c Leave the other boxes set to the defaults unless you have a specific reason otherwise (see Step 8 on page 2-65 for more information).

Figure 2-22 • Configure ITUAM Data Source Dialog Box—MSDE Example
8. Click OK to save the data source information and close the Configure ITUAM Data Source dialog box. The data source entry is displayed in the ITUAM Data Source Maintenance dialog box as shown in example Figure 2-23.

Because the ITUAM data source entry is the only entry in the list, it is automatically set as the default data source. For more information about the default data source, see Setting a ITUAM Data Source as the Web Site/ITUAM Data Collectors Default on page 6-6.

![ITUAM Data Source Maintenance Dialog Box—MSDE Example](image)

Figure 2-23 • ITUAM Data Source Maintenance Dialog Box—MSDE Example

Note that if you pointed to the master database when you set up the ODBC Data Source, the following message is displayed when you close the ITUAM Data Source Maintenance dialog box:

The data source <ODBC Data Source Name> is using the database 'master'. The use of the 'master' database to store ITUAM data is not recommended. Do you want to create a database called <ODBC Data Source Name> and use it instead?

If you want to use the master database, click No.

If you do not want to use the master database, click Yes and a database with the same name as the ODBC Data Source is created.
Getting Started

This section takes you through the steps required to set up and use ITUAM on a Windows system. You should follow these steps in the order presented.

To help you to get started quickly, this section does not contain the detailed information found in other chapters in this guide. Where applicable, references to more detailed information are provided.

Before getting started, make sure that you have installed the system components required by ITUAM as shown in System Setup Checklist on page 2-10.

Set Up ITUAM

To set up ITUAM, start ITUAM Administrator (Start ▶ Programs ▶ ITUAM ▶ ITUAM Administrator if you installed ITUAM in the default location) and follow the steps in this section.

*Note* • You can also start ITUAM Administrator from IBM Director. See Starting ITUAM Administrator from IBM Director on page 2-111.

Initialize the Database

When you add a ITUAM Data Source, the data source is displayed in the Select ITUAM Data Source list at the bottom of the ITUAM Administrator main window. This list enables you to point ITUAM Administrator to the data source that you want to use.

At this point, you should have created one ITUAM Data Source for the database and the data source ID should be displayed in Select ITUAM Data Source list.

To enable ITUAM to use the database referenced by the ITUAM Data Source, you must initialize the database. Initializing the database performs the following tasks:

- Creates new database tables
- Populates these tables with an initial set of data
- Creates necessary database objects

*Note* • A database should be initialized only once. Initializing will overwrite any existing data. You will receive a warning if you attempt to initialize a database that has already been initialized.

To initialize the database:

1. In the ITUAM Administrator main window, click System Administration ▶ Database ▶ Initialize Database.

The Database Initialization dialog box is displayed as shown in Figure 2-24 on page 2-84.
2 Click Initialize Database to populate the database with the necessary defaults.

**Note** • If the user ID that you are using to access the database does not have sufficient system administration authority, ITUAM might not be able to create database objects or to create objects with the appropriate permissions during database initialization. In this situation, a warning message is displayed recommending that you contact your database administrator before continuing.

3 In the Select Web Reports Version dialog box, click the report version that you are using for Web reporting (SQL Server Reporting Services or Crystal Reports 9, 10, or XI), and then click OK. The report version that you select determines the default report paths that are displayed in the Configuration dialog box (see Reporting Tab on page 2-88).

4 Click OK when the initialization is complete.
Create a Processes Folder

**Note** • If you are running ITUAM Processing Engine on UNIX or Linux, the processes directory is created automatically on the UNIX or Linux system as described in Working With the processes Directory on page 3-26.

In Windows, rename and move the Sample Processes folder. This folder is in C:\Program Files\IBM\ITUAM if you installed ITUAM in the default location.

It is recommended that you rename this folder Processes and move it to a location where you keep data that is backed up. However, you can give this folder any name and move it to any location. This folder is referred to as Processes in this guide.

The Processes folder is used to store process definitions. A process definition is a folder that contains the files required to process usage data from a particular source such as a database, operating system, or application. For more information about process definitions, see Chapter 7, Processing Data on Windows.

Note that the process definitions in the Sample Processes folder contain sample CSR or CSR+ files that you can process and load into the database as described in Process a Sample Resource File (Optional) on page 2-91.

**If ITUAM Administrator is Installed on Multiple Computers, Assign Shares to the Processes and Reports Folders**

If ITUAM Administrator is installed on multiple computers and the application points to the same database or databases, you should assign a share to the ...

...IBM\ITUAM\Processes and ...

...IBM\ITUAM\Server\Reports\type folders. (Unlike the Processes folder, which you must create, the Reports\type is created by default. You should have already created a share for the Server folder that contains the Reports\type folder when you set up the Windows user account in Setting Up a Windows Account for ITUAM on page 2-34.)

When you define the paths to these folders for ITUAM (see Enter the ITUAM Configuration Settings), use a Universal Naming Convention (UNC) name for the paths. The use of logical drive names is not recommended when using multiple computers.

An example of the use ITUAM Administrator is one in which the ITUAM application server and the Web server are on separate servers. In this situation, ITUAM Administrator must be installed on both computers and must be pointing to the same database or databases.

ITUAM application server and the Web server are on separate servers, the recommended location for the Reports\type folder is the Web server.
Enter the ITUAM Configuration Settings
To set the configuration settings for ITUAM in ITUAM Administrator, perform the following steps:

1. In the main window, click System Administration ▶ Configuration Information.

   The Configuration dialog box is displayed.

2. For the purpose of getting started, complete the Organization, Processing, and Reporting tabs as shown in the following sections. For information about the remaining tabs, see Configuring System Settings on page 4-41.

Organization Tab
Enter your organization name and address (maximum of 255 characters in each line). This information is displayed on the standard invoices that are provided with ITUAM.
Processing Tab

In the Process Definition Path box, enter the path to the Processes folder as shown in example Figure 2-25.

**Note** • If you are running ITUAM Processing Engine on UNIX or Linux, the path to the processes directory on the UNIX or Linux system is defined in the ituam.par file as described in *About the ituam.par File* on page 3-25.

![Configuration Dialog Box—Processing Tab](image)

**Figure 2-25 • Configuration Dialog Box—Processing Tab**

For more information about the Processing tab, see *Processing Settings* on page 4-43.
Reporting Tab

The Reporting tab contains the settings for ITUAM Web and batch reporting. The default report paths that are displayed on the Paths subtab are determined by the report type that you selected when you initialized the database. The Paths subtab contains the paths to the following report folders:

- **Standard.** ITUAM produces chargeback and resource accounting reports based on IT usage data from your organization. This folder contains a variety of standard reports that you can use as templates to create custom reports for your organization. For a description of each of the standard reports, refer to the IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide.

- **Custom.** This folder contains custom reports. Custom reports are those that your report developer creates either independently or from the standard reports.

- **Published.** This folder contains published reports. Published reports are reports that have been saved with the data that was generated at the time the reports were run. Publishing a report enables users to view a report without having to regenerate it.

**Note** • End user access to published reports is dependent on the security permissions described in Folder Permissions Required for Publishing and Viewing Batch Reports on page 5-48.

It is recommended that you keep the Standard folder in the default location because standard reports might be updated or added with a new version or release of ITUAM. (A list of new and updated reports is included in the release notes that accompany the new ITUAM version or release.)

You can keep the Custom and Published report folders in the default location or you can move the folders to any location. The reports in the Custom and Published report folders are not overwritten when you upgrade to a new version or release of ITUAM. It is recommended that if you move the Custom and Published report folders, you move the folders to a location where you keep data that is backed up.

Enter the paths for storing your reports or accept the default locations as shown in example Figure 2-26 on page 2-89.
For more information about the Reporting tab, see *Reporting Settings* on page 4-44.
Set the Account Code Structure

ITUAM uses an account code to identify entities for billing and reporting. This code determines how ITUAM interprets and reports input data. The account code structure defines the account code levels that are displayed in invoices and other reports.

To define the account code structure:

1 Click Chargeback Administration ➤ Chargeback Table Maintenance ➤ Account Code Structure.

The Account Code Structure List Maintenance dialog box is displayed.

2 Click Edit.

The Account Code Structure Maintenance dialog box is displayed as shown in Figure 2-27.

```
Figure 2-27  •  Account Code Structure Maintenance Dialog Box
```

3 Edit the example account code levels (descriptions and lengths) for your site and then click OK. You can add or delete levels as needed. For detailed instructions on how to define the account code levels, see Setting Up the Account Code Structure on page 4-3.
Process a Sample Resource File (Optional)

Note • This is an optional step intended to provide a quick introduction to processing CSR and CSR+ files. For more information about processing these files, see Chapter 7, Processing Data on Windows or Chapter 8, Processing Data on UNIX or Linux.

To process a sample resource file on a UNIX or Linux server, see Run a Sample Process on page 3-27.

The primary method for input into ITUAM is the CSR or CSR+ file. ITUAM includes sample CSR and CSR+ files from different databases, operating systems, and applications. The files are contained in process definition subfolders within the Processes folder that you created in Create a Processes Folder on page 2-85. You can process a sample CSR or CSR+ file as follows:

1  In the ITUAM Administrator main window, click Chargeback Administration ➤ Processing ➤ Process Definitions.

The Process Definitions List Maintenance dialog box is displayed as shown in example Figure 2-28.

![Process Definitions List Maintenance Dialog Box](image)

**Figure 2-28 • Process Definitions List Maintenance Dialog Box**

2  Click the process definition that contains the resource file that you want to process, and then click Process.

3  The processed data loads to the database and the Processing Complete! message is displayed. Click Yes to view the event log (the Event Viewer opens showing the files processed) or No to skip the event log.
To view the processing results, make sure that the process definition is selected, and then click **Edit**. Click the **Process Results** tab to view the processing results and output files, including the Summary, Ident, and Detail files. (For more information, see *Process Results Tab* on page 7-37.)

You can also view the data as it appears in the Summary, Ident, and Detail files in the database. In the ITUAM Administrator main window, click **Chargeback Administration** ➔ **Database Loading** ➔ **Load Tracking**, and then click the **Loads** tab.

### Increase the Event Viewer Maximum Log Size

ITUAM logs all events (successful and unsuccessful) to the Windows Event Viewer. To accommodate the large number of data loads generated by ITUAM, increase the maximum log size in the Event Viewer as shown in the following steps. (Note that these steps are for the Microsoft Windows Server 2000 operating system. If you are using another operating system, refer to the Microsoft documentation if needed.)

1. In Windows Control Panel, double-click **Administrative Tools** ➔ **Event Viewer**.
   
The Event Viewer window is displayed.

2. Right-click **Application**, and then click **Properties**.
   
The Application Properties dialog box is displayed.

3. On the **General** tab, increase the **Maximum log size** to at least 16000 KB.

4. Choose one of the following options under **When maximum log size is reached**:  
   - Click **Overwrite events older than** and enter 45 days.
   - Or
   - Click **Do not overwrite events**. This option requires that you clear the log manually rather than automatically when the log is full.

   To avoid deleting older events, do not click **Overwrite events as needed**.

5. Click **OK** when you are finished.
Set Up the Web Server

Follow the steps in this section to set up the Web server. If you are running all ITUAM components (including ITUAM Processing Engine) on a Windows server, the Web server may reside on the same server as the ITUAM application server or on a separate server. Note that these steps are for IIS 5.1 on the Microsoft Windows 2000 Server operating system. If you are using another operating system, refer to the Microsoft documentation.

Install ITUAM Administrator and ITUAM Web Applications on the Web Server (If Using a Separate Server)

**Note** • If the Web server resides on the same server as the ITUAM application server, skip this section and continue to *Set the User Authentication Method for the Web Sites* on page 2-94.

If you are installing the Web server on a separate server than the ITUAM application server, you must install ITUAM Administrator and ITUAM Web Reporting on the Web server. If you want to use the optional ITUAM Web Console and ITUAM Financial Modeler applications, you must also install these applications on the Web server.

To install the applications, run the ITUAM setup program and choose the ITUAM Administrator, ITUAM Web Reporting, ITUAM Web Console, and ITUAM Financial Modeler options (see *Installing the Base Package* on page 2-26).

When installation is complete, start ITUAM Administrator and point to the ITUAM Data Source for the database in the *Select ITUAM Data Source* list. To add a ITUAM Data Source for the database, see *Setting Up and Connecting to a Database* on page 2-38.
Set the User Authentication Method for the Web Sites

By default, the ITUAM Web Reporting application uses the IIS Default Web Site and sets the home directory path to ...Program Files\IBM\ITUAM\Server\Web.

Virtual directories for other ITUAM applications and files and for Crystal Reports and SQL Server Reporting Services are installed below the Default Web Site.

There are two options for controlling user access to the default Web site and virtual directories: anonymous access and authenticated access. Anonymous access allows remote access by the IUSR_computername account. Users can connect to the Web site or directory without a user name or password. Authenticated access uses the current Windows user information on the client computer to allow users to connect to the Web site or directory.

If the Web site and directories are accessed via the Internet, you must set the user access for the default Web site and directories to anonymous.

If you are using a SQL Server or MSDE database and the Web site and directories are accessed via an intranet, it is recommended that you set the Web site/directories to authenticated access.

If you are using a DB2 or Oracle database and the Web site and directories are accessed via an intranet, you can set the Web site/directories to authenticated access or anonymous access.

To set authenticated access:

1  In IIS Manager, navigate to the Web site or directory.
2  Right-click the Web site or directory, and then click Properties.
3  In the Properties dialog box, click the Directory Security tab.
4  In the Anonymous access and authentication control area, click Edit.
5  In the Authentication Methods dialog box, select the Integrated Windows authentication check box and clear all other check boxes.
6  Click OK until the Properties dialog box closes.
7  Restart IIS (see page 11-5).

To set anonymous access:

1  Complete Step 1 through Step 4.
2  Click the Anonymous access check box and clear all other check boxes.
3  Click Edit and do the following in the Anonymous User Account dialog box:
   a  Enter the Windows account IUSR_computername in the Username box. If the IUSR name is not displayed, click Browse to find it.
b Select the **Allow IIS to control password** check box. This option is recommended because it enables IIS to change the password for each access to the ITUAM Web Reporting Web site.

![Anonymous User Account Dialog Box](image)

FIGURE 2-29 • Anonymous User Account Dialog Box

4 Click **OK** until the Default Web Site Properties dialog box closes.

5 Restart IIS (see page 11-5).

**Features Not Available With Anonymous Access**

- **Auto logon for ITUAM Web applications.** ITUAM Web Reporting and the other ITUAM Web-based applications provide an auto logon feature. This feature enables end users and administrators to use the application without entering an ITUAM user ID and password to log on. (To enable auto logon, see *Web Settings* on page 4-47.) The auto logon feature is not available if you use anonymous access for IIS.

- **Tracking user IDs for transactions.** If you use anonymous access and are using the transaction audit feature, the user ID associated with the transaction will not reflect the actual user. The transaction audit feature enables ITUAM administrators to track miscellaneous, recurring, and credit transactions created in ITUAM Web Reporting. (For more information about transactions, refer to the *IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide.*) To enable transaction audits and other table audits such as client and rate, see *Table Audit Settings* on page 4-52.

**Note** • The table audit feature is available only if you are using a SQL Server database.
Assign Folder Security Permissions on the Web Server

The ITUAM Web application end users must have the following security permissions for the folders shown. The default location for these folders is C:\Program Files\IBM\ITUAM.

<table>
<thead>
<tr>
<th>Folder</th>
<th>Required Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>Read &amp; Execute</td>
</tr>
<tr>
<td>Server\Web\temp</td>
<td>Full Control</td>
</tr>
<tr>
<td>Server\Reports\type\Published</td>
<td>Read &amp; Execute, Write</td>
</tr>
<tr>
<td>Admin</td>
<td>Read &amp; Execute</td>
</tr>
</tbody>
</table>

If anonymous access is enabled for IIS, the user is IUSR_computername and that user name must be provided with these permissions. If Windows authenticated access is enabled, each Windows user that will be accessing the Web application must be provided with these permissions.

**Note** • If the user is IUSR_computername and you entered the correct IUSR_computername account during installation, ITUAM automatically sets the folder security permissions for the user. See Enter the IIS Web User Name on page 2-28.
Enable Secure Sockets Layer (SSL) for the ITUAM Web Reporting Site (Optional)

ITUAM provides an optional auto logon feature that enables users to access the ITUAM Web Reporting Web site without entering a user ID and password (see Web Settings on page 4-47). If you use this feature, Secure Sockets Layer (SSL) is not needed.

If you do not use the auto logon feature, you can enable SSL to protect the user ID and password needed to access the Web site. SSL is a protocol for ensuring security and privacy in internet communications via encryption. When SSL is enabled, https:// rather than http:// shows in the URL when a user accesses the Login page of the ITUAM Web Reporting Web site.

To set up and enable SSL for the Web site, you must first obtain a SSL certificate from a third-party certificate authority and install the certificate for the site. For the steps required to obtain and install the certificate, refer to the Microsoft Knowledge Base Article 298805.

Once you have installed the SSL certificate, complete the following steps to enable SSL for the login ID and password and then restart IIS. (To restart IIS, see page 11-5.)

In the IIS Manager Window:
1. Navigate to Default Web Site and expand it.
2. Right-click the Secure folder, and then click Properties.
4. In the Secure Communications dialog box, select the Require secure channel (SSL) check box, and then click OK.

In ITUAM Administrator:
1. Click System Administration ▶ Configuration Information ▶ Web tab ▶ General subtab.
2. Select the Secure Login check box.
3. If you are using an SSL port other than the default port 443 for the Web site, type the port number in the Secure Port check box.
4. Click OK when you are finished.
Set Up SQL Server Reporting Services

**Note** • This section is applicable only if you selected SQL Server Reporting Services when you initialized the ITUAM database.

The steps in this section that are performed in the Reporting Services interface reflect Reporting Services 2000. If you are using Reporting Services 2005, refer to the Microsoft documentation if needed.

To use SQL Server Reporting Services with ITUAM, perform the following configuration steps in the order presented.

Make sure that you have installed Reporting Services as described in *Installing SQL Server Reporting Services* on page 2-18.

**Enter the Reporting Services Report Server URL**

The fully qualified URL for Reporting Services Report Server must be entered as a configuration option. From the ITUAM Administrator main Window, click **System Administration ▶ Configuration Information** to open the Configuration dialog box and then click the **Web** tab. The URL is entered in the **Report Server URL** box (see *Web Settings* on page 4-47).

The value that appears in the **Report Server URL** box can be any of the following. *In all situations, change the value to a fully qualified URL.* For example, type `http://abcserver.abcco.com/ReportServer` rather than `http://abcserver/ReportServer`.

- If you are upgrading from a previous ITUAM release, the placeholder **ServerName** appears in the URL (e.g., `http://ServerName/ReportServer`).
- If you are installing ITUAM for the first time and have initialized the database, a URL will be displayed in the **Report Server URL** box if Reporting Services is on the local server.
- If Reporting Services is not found on the local server, the **Report Server URL** box is blank and you must type the URL for the remote server.

**Note** • The **Report Server URL** box will also be blank if ITUAM Administrator could not connect to Reporting Services on the local server during initialization. For example, IIS or Report Server was not running.
Configure Reporting Services With ITUAM Administrator

ITUAM Administrator must perform certain configuration tasks in Reporting Services. If ITUAM Administrator is able to connect to Reporting Services on the local server, these configuration tasks are performed during the ITUAM database initialization process.

If ITUAM Administrator is unable to connect to Reporting Services, either because Reporting Services is installed on a remote server or another issue is preventing connection, the following message is displayed during initialization:

Correct the issue and then click System Administration › Reporting › Configure Reporting Services with ITUAM Administrator.

Set IIS User Authentication for Report Manager and Report Server

As described in Set the User Authentication Method for the Web Sites on page 2-94, it is strongly recommended that you set Integrated Windows authenticated access for the IIS Default Web Site and its virtual directories (which include the Reporting Services Reports and ReportServer virtual directories). Because Reporting Services can be installed on any server, Reports and ReportServer may be on the Web server or another server.

If Reporting Services and the Web Server are on Separate Servers, Install ITUAM Report Component on the Reporting Services Server

ITUAM Report Component contains ITUAM components required by SQL Server Reporting Services. ITUAM Report Component is installed by default when you install the ITUAM components on the Web server. If Reporting Services and the Web server are on separate servers, run the CIMSRSLibSTD.msi file to install ITUAM Report Component on the Reporting Services server.

You can find the CIMSRSLibSTD.msi file in the ...IBM\ITUAM\Redist\CIMSWebRsReports folder.

When you run the CIMSRSLibSTD.msi file, the ITUAM Report Component DLL (CIMSRSLibSTD.dll) is installed in the Report Server bin folder.
Create a Role in Reporting Services

Reporting Services uses a role definition to define which tasks a user is allowed to perform in connection with a folder, report, or other item. In Reporting Services Report Manager, create one role definition for all ITUAM Web Reporting users and set the user options for that role as described in the following sections.

To create a role:

1. Start Report Manager.

   If Reporting Services is installed on a remote server, you must access Report Manager through your Web browser using the Report Manager URL. For example:

   http://roca/Reports

   If Reporting Services is installed on the local server, you can use the URL or you can click Start > Programs > Microsoft SQL Server > Reporting Services > Report Manager.

   Note • If you receive a message stating that the report server cannot decrypt the symmetric key when you try to start Report Manager, follow the steps in Report Server cannot decrypt the symmetric key message is displayed on page 11-15.

2. Click Site Settings in the upper right corner of the Report Manager home page.

3. On the Site Settings page, click Configure item-level role definitions under Security.


5. On the New Role page, do the following:

   • In the Name box, type a name for the role. The name ITUAM is used in this guide, but you can use any name for the role.

   • In the Description box, type a description for the role. For example, Role used for ITUAM users to view/deploy reports.

   • Click the following tasks:

     • Manage data sources
     • Manage folders
     • Manage reports
     • Manage resources
     • View reports
     • View resources

6. Click OK.
The role is saved to the Reporting Services Report Server database. The role name and description is displayed on the Item-Level Roles page as shown in example Figure 2-30.

![Figure 2-30 • Report Manager Item-Level Roles Page](image_url)
Assign Windows User Accounts to the ITUAM Role

The Windows user account or accounts that you can add to the ITUAM role depend on whether you created a ITUAMUser account in Setting Up a Windows Account for ITUAM on page 2-34. If you did not create an ITUAMUser account, the user accounts that you can use depend on whether Reporting Services is running on the Web server or on a separate server.

If you created a Windows ITUAMUser account:

If you created an ITUAMUser account, you can add this account to the ITUAM role regardless of whether Reporting Services is running on the Web server or on a separate server. To use the ITUAMUser account with Reporting Services, do the following:

1. Assign the following security permissions for ITUAMUser account to the folders shown. To assign security permissions to a folder, right-click the folder, click Sharing and Security, and then click the Security tab. If the ITUAMUser account is not displayed on the Security tab, add the account.

   - Full Control ...WINDOWS\Microsoft.NET\Framework\v1.1.4322\Temporary ASP.NET Files
   - Read and Write ...Program Files\IBM\ITUAM\Server\ReportsMSRS

2. If Reporting Services is running on a server other than the Web server, make sure that IIS is set for Integrated Windows authentication on both the Web Server and the server running Reporting Services. If you are using anonymous access, contact IBM Software Support.

3. Add the ITUAMUser account to the Reporting Services ITUAM role (see To assign users to a role: on page 2-103).

If you did not create a Windows ITUAMUser account:

The Windows account or accounts that you can add to the ITUAM role are dependent on whether you are running Reporting Services on the Web server or another server.

- If you are running Reporting Services on the Web server, you can add the following local Windows user account to the role (see To assign users to a role:). This account enables all users to access Reporting Services.

   - computername\ASPNET (Windows 2000)

   Or

   - NT AUTHORITY\NETWORK SERVICE (Windows 2003)
If you are running Reporting Services on a server other than the Web server, you cannot use the local user account ASPNET or NETWORK SERVICE. In this situation, do the following:

1. Uncomment the following line in the IBM\ITUAM\Server\Web\CIMSReporting\Web.config file:

   ```xml
   <!--
   <identity impersonate="true" userName="ITUAMUser"
   password="password"/>
   -->
   ```

   You can then edit this line as needed. For example, change the userName and password attribute values for the applicable Windows account or, if the Web site is run under multiple accounts, remove the userName and password attributes.

   **Note** • The updated Web.config file will not be overwritten when you upgrade to a new release of ITUAM.

2. Assign the following security permissions for the user account or accounts to the folders shown. To assign security permissions to a folder, right-click the folder, click Sharing and Security, and then click the Security tab. If an account is not displayed on the Security tab, add the account.

   - **Full Control** ...WINDOWS\Microsoft.NET\Framework\v1.1.4322\ Temporary ASP.NET Files
   - **Read and Write** ...Program Files\IBM\ITUAM\Server\ReportsMSRS

3. Make sure that IIS is set for Integrated Windows authentication on both the Web Server and the server running Reporting Services. If you are using anonymous access, contact IBM Software Support.

4. Add the user account to the Reporting Services ITUAM role (see To assign users to a role).

   **To assign users to a role:**

   1. On the Report Manager home page, click the ITUAMReports folder. This is the folder that contains the ITUAM reports.

   2. On the ITUAMReports page, click the Properties tab.

   3. Click the Security link in the left frame.

   4. Click New Role Assignment. (If New Role Assignment is not displayed, click Edit Item Security, and then click OK in the message box.)

   5. In the Group or user name box, type ITUAMUser.

   6. Select the check box for the role that you created in To create a role: on page 2-100.

   7. Click OK.

   The user is saved to the Reporting Services Report Server database. The user name and role is displayed on the Properties tab as shown in example Figure 2-31.
Figure 2-31  Report Manager Properties Tab
Set Up Crystal Reports

Configure Crystal Reports Server

Note • This section is applicable only if you selected Crystal Reports XI when you initialized the ITUAM database.

This section provides information to enable you to quickly configure Crystal Reports Server to work with ITUAM. If you want more detailed information about configuring Crystal Reports Server, refer to the documentation that accompanies the product including the BusinessObjects Enterprise 11 Administrator’s Guide.

To use Crystal Reports XI with ITUAM, you must add ITUAM users as Crystal Reports Server users and deploy ITUAM reports to Crystal Reports Server. ITUAM Administrator provides a wizard that enables you to perform these steps easily as described in Configuration in ITUAM Administrator: on page 2-106.

Before you run the wizard in ITUAM Administrator, it is recommended that you start BusinessObjects Enterprise Central Management Console and perform the steps in the following section, Configuration in BusinessObjects Enterprise Central Management Console:. (Crystal Reports Server is a component of BusinessObjects Enterprise.) Detailed instructions for using Central Management Console are provided in the application’s Help files and in the BusinessObjects Enterprise 11 Administrator’s Guide.

Configuration in BusinessObjects Enterprise Central Management Console:

1  To log on to the Central Management Console, open your Web browser and go to the following page:


Where webserver is the name of the Web server. If you changed this default virtual directory on the Web server, type your URL accordingly.

2  On the BusinessObjects Enterprise Administration Launchpad page, click Central Management Console.

The Central Management Console Log On page is displayed.

3  Type Administrator in the User Name box. (This default account does not have a password until you create one, so leave the Password box blank. To create a password, see Step 6 on page 2-106.)

4  Click Enterprise in the Authentication Type list.

5  Click Log On.
6 From the Central Management Console home page, do the following:

- The default administrator account for Crystal Reports Server is Administrator with no password. You can use this default account for ITUAM; however, it is recommended that you assign a password for the account as follows:
  
  a Click Users.
  
  b On the All Users page, click the Administrator account.
  
  c Set a password for the Administrator account.

If you do not want to use the Administrator account, you can click New User on the All Users page to create another account and password for use by ITUAM.

- The user password requirements (e.g., number and type of characters) differs between ITUAM and Crystal Reports Server. You will receive an error message when you try to add a password in ITUAM Web Reporting or ITUAM Administrator that does not match the requirement for Crystal Reports Server. To avoid this message, you can change the password restrictions in BusinessObjects Enterprise Central Management Console as follows:
  
  a From the Central Management Console home page, click Authentication and clear the restriction check boxes on the Authentication page.
  
  b Click Update.

**Configuration in ITUAM Administrator:**

- **Note** If you are running the ITUAM system components on separate servers and have ITUAM Administrator installed on multiple computers, make sure that you perform the following steps in the ITUAM Administrator that is on the same server that is running Crystal Reports.

1 In the ITUAM Administrator main window, click System Administration ➔ Reporting ➔ Configure BusinessObjects Enterprise Server.

2 When the Configure BusinessObjects Enterprise Wizard is displayed, click Next.

3 Enter the following, and then click Next.

  - **Enterprise Server Name.** Type the name of the server running Crystal Reports Server.
  
  - **User Name.** Type the default user account Administrator or the user account that you created for ITUAM.
  
  - **Authentication Type.** If you are using the default Administrator account, click Enterprise. If you are using another account, click the applicable authentication type (Enterprise or Windows).
  
  - **Password.** Type the password for the account.
4 Type a name for the BusinessObjects Enterprise user group for ITUAM users or accept the default (ITUAM Users), and then click Next.

5 Type a name for the BusinessObjects Enterprise folder in which ITUAM reports will be deployed, or accept the default (ITUAM Reports). Click Next.

6 ITUAM provides an optional auto logon feature that enables users to access the ITUAM Web Reporting Web site without entering a user ID and password (see Web Settings on page 4-47). If you want to use this feature, click Single sign-on is enabled. Otherwise, the auto logon feature will be disabled in ITUAM Administrator. That is, the setting in the Single sign-on is enabled check box controls the setting of the Enable Intranet Auto Logon check box in the Configuration dialog box.

7 In the ITUAM Users box, click the ITUAM users that you want to include as Crystal Reports Server users, and then click Add to move the users to the appropriate tab in the BusinessObjects Enterprise Users box. Note that depending on when you run the wizard, the ITUAM user Admin may be the only user that is displayed in the ITUAM Users box (see Notes About Using the Configure BusinessObjects Enterprise Wizard on page 2-108).

The tab or tabs that are displayed for adding the users depends on the type and number of licenses that you purchased for Crystal Reports. The type and number of licenses available are displayed in blue on the line that begins with Enterprise Licenses. If you are licensed for named users, the number of unassigned named user licenses available is provided below the Enterprise Licenses line.

- If Crystal Reports is licensed for named users, the tab Named is displayed in the BusinessObjects Enterprise Users box. Add the ITUAM users that you want to specify as named users (up to the maximum number of licensed named users allowed). If you do not have a named users or processor license, this tab is not displayed.

- If Crystal Reports is licensed for concurrent users, the tab Concurrent is displayed in BusinessObjects Enterprise Users box. You can add or remove as many ITUAM users from this tab as you want to share concurrent licenses. If you do not have a concurrent users license, this tab is not displayed.

- If Crystal Reports is licensed for processor, the tab Named is displayed in the BusinessObjects Enterprise Users box. Add the ITUAM users that you want to specify as named users (up to the maximum number of licensed named users allowed). In this situation, the Concurrent tab is not displayed.

Note • You can also use the Configure BusinessObjects Enterprise Wizard to remove ITUAM users from Crystal Reports Server.

8 Click Finished.

9 Click OK in the configuration ran successfully message box, and then click OK to close the wizard.
Notes About Using the Configure BusinessObjects Enterprise Wizard

- The wizard is intended to provide an easy-to-use interface that enables you to access Crystal Reports Server to perform the basic configuration required to run ITUAM reports. You can perform the same steps using the BusinessObjects Enterprise Central Management Console.

- The wizard is intended to deploy ITUAM users and reports to Crystal Reports Server in the following situations:
  - You are setting up ITUAM for the first time.
  - You have upgraded from an earlier release of Crystal Reports to Crystal Reports XI.
  - You have changed the Crystal Reports Server account that you were previously using for ITUAM.

After using the wizard to initially deploy ITUAM users and reports, you will be able to add users and reports to Crystal Reports Server when you are adding users or reports in ITUAM Administrator.

- When you use the wizard to add ITUAM users to Crystal Reports Server, the users' passwords are not saved in the Crystal Reports Server database. To update the passwords in Crystal Reports Server, perform the following steps for each ITUAM user:
  1. Log on to the ITUAM Web Reporting Web site using the ITUAM user ID with the password password. Logging on the Web site is discussed in Start ITUAM Web Reporting.
  2. At the prompt to change the password, type a password. You can use the user’s previous password or choose a new password.

Update the Number of Database Records Returned for Crystal Reports

By default, Crystal Reports Page Server and Crystal RAS return a maximum of 20,000 database records for reports. For most organizations, this number will be insufficient and reporting errors might occur if the default is not changed. Perform the following steps to change the maximum number or records to unlimited for both Crystal Reports Page Server and RAS.

For additional information, refer to the Business Objects Knowledge Base Article c2018701.

To update Crystal Reports Page Server:

1. Start the BusinessObjects Central Management Console and log on with an Administrator’s account.
2. Click Servers, and then click the Crystal Reports Page Server (servername.pageserver).
3. On the Properties tab, go to the option Database Records To Read When Previewing Or Refreshing a Report and click Unlimited records.
4. Click Update.
5. Restart the Crystal Reports Page Server service.
**To update Crystal RAS:**

1. Click Start › Programs › Business Objects 11 › Central Configuration Manager.
2. Click Report Application Server, and then click the Stop button.
3. Right-click Report Application Server, and then click the Parameters tab on the Report Application Server Properties dialog box.
4. In the Option Type list, click Database.
5. Under Max Number of Records, click Unlimited, and then click OK.
6. In Central Configuration Manager, make sure that Report Application Server is selected, and then click the Start button.
Start ITUAM Web Reporting

1. In your Web browser, enter the address for the Web server. This is the server that you set up in Set Up the Web Server on page 2-93.

2. Click Login to open the Login page.

3. Type the user ID admin and the password password, and then click OK. This is a default user and password created by ITUAM (see About Users and Groups on page 2-111).

If you are using Crystal Reports XI, you will be prompted to change the password. You can type a new password or you can type in password if you want to continue using this password. Passwords are alphanumeric and case-sensitive and can be a maximum of 16 characters.

**Note** • You can enable the auto logon feature that allows users to access ITUAM Web Reporting without entering a user ID and password. For more information, see Web Settings on page 4-47.

If you have successfully loaded sample data, you should be able to create reports from the Reports Run Reports menu (see Figure 2-32). For instructions, refer to the IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide.

---

![Figure 2-32 • ITUAM Web Reporting—Reports Menu](Image)
Note • If you are using Crystal Reports for Web reporting, you can select the Crystal Report viewer that you want to use to view reports (see Web Settings on page 4-47). The default is the HTML viewer.

If you select the ActiveX or Java viewer, you will receive a warning message asking if you want to install and run Crystal Smart Viewer for ActiveX or Java when you attempt to run a report after installing ITUAM for the first time. Click Yes. It is also advisable that you select the Always trust content from Crystal Decisions, Inc check box.

About Users and Groups

A user is an individual with access rights to ITUAM Web Reporting. Each user can belong to only one user group. Users are granted the rights and privileges granted to the group. This system of users and groups allows you to control which reports a user can access, the clients that the user can view in reports, and the administrative privileges for the user.

When you initialized the database (see page 2-83), ITUAM added the default administrator user admin that belongs to the user group Admin. The group Admin has administrative privileges in ITUAM Web Reporting and can view all reports and clients.

For instructions on how to create users and groups, see Working With Users and Groups on page 4-27.

Troubleshooting

For troubleshooting information, see Chapter 11, Troubleshooting and Additional Information.

Starting ITUAM Administrator from IBM Director

If ITUAM Administrator is installed on the same server as IBM Director, you can start the application from the IBM Director Console Tasks menu. Click External Application Launch & ITUAM Administrator.

Moving and Resizing Dialog Boxes

You can move and resize the dialog boxes in ITUAM Administrator. To move a dialog box, simply drag the box. To resize the box, point to the horizontal or vertical edge of the box. When the double arrow is displayed, click the edge of the box and drag it to the size that you want.

To return a dialog box to its original position and size, click View & Reset Form Position to Default where this command is available. Where this command is not available, the dialog box returns to its original location and size when it is closed and reopened.

Viewing Online Help

Press <F1> to view context-sensitive online help in ITUAM Administrator.
Installing ITUAM on Windows and Getting Started

Viewing Online Help
Installing ITUAM on UNIX/Linux and Getting Started

**Note** • This chapter is applicable only if you are running ITUAM Processing Engine on a UNIX or Linux system.

Because the ITUAM system also includes the Windows-based ITUAM Administrator and ITUAM Web Reporting applications, you must complete the steps in *Chapter 2, Installing ITUAM on Windows and Getting Started* in addition to completing the steps in this chapter.

This chapter provides installation, configuration, and upgrade procedures for ITUAM Processing Engine on a UNIX or Linux system. This chapter also provides a Getting Started section to help you to quickly set up the ITUAM Processing Engine components. If you are installing or setting up ITUAM for the first time, you should review the information in this chapter in the order presented.

In this chapter, `$ITUAM_HOME` refers to the top-level directory where ITUAM is installed. For example, assume that the top-level directory is `/usr/ituam`. In this example, `/usr/ituam` is designated by `$ITUAM_HOME` (for example, `/usr/ituam/jlib/lib` is shown as `$ITUAM_HOME/jlib/lib`).

**ITUAM System Components** ................................................................. 3-3

**System Specifications** ................................................................. 3-4

**Installing Perl** .............................................................................. 3-5

**Installing ITUAM** ........................................................................ 3-5

**System Setup Checklist** ................................................................. 3-6

**About ITUAM Installation** ............................................................... 3-7

**Installing ITUAM Processing Engine and ITUAM Data Collectors for UNIX and Linux** ........ 3-11
Installing JDBC Drivers ................................................................. 3-13
Installing and Setting Up the DB2 JDBC Driver .......................... 3-13
Installing the SQL Server JDBC Drivers .................................. 3-16
Installing the Oracle JDBC Driver ............................................. 3-16
Installing Other JDBC Drivers .................................................. 3-17

Setting Up and Connecting to a Database ................................. 3-18
About ITUAM Data Sources .................................................... 3-18

Getting Started ........................................................................ 3-19
Set Up the ITUAMDBConfig.xml Configuration File ................. 3-19
About the ituam.par File .......................................................... 3-25
Working With the processes Directory .................................... 3-26
Run a Sample Process ............................................................. 3-27
ITUAM System Components

**Note** • For an overview of the ITUAM system architecture, including detailed information about the following components, see Chapter 1, About ITUAM.

The ITUAM system hardware/software components that can be run on a UNIX or Linux system are as follows:

- **ITUAM Data Collectors for UNIX and Linux.** ITUAM Data Collectors read and convert usage metering data generated by applications (usually standard usage metering files such as log files) and produce a common output file that is used by ITUAM.

- **ITUAM Processing Engine, Processing Engine Administrator, and processing scripts.** The ITUAM Processing Engine processes the CSR or CSR+ files and load the output into the ITUAM database. For detailed information about the ITUAM Processing Engine components, Chapter 8, Processing Data on UNIX or Linux.

  ITUAM Processing Engine Administrator is a Java GUI application used to maintain ITUAM configuration files. For more information about this application, see Set Up the ITUAMDBConfig.xml Configuration File on page 3-19.

  ITUAM processing scripts are Perl-based scripts that automate the task of processing of data from various feeds and loading output data into the database.

- **A database server.** The database contains the administrative and configuration data needed for chargeback and reporting as well as the output records that are produced by ITUAM Processing Engine.

  **Note** • ITUAM Processing Engine and the database can reside on the same server or on separate servers. In general, a configuration involving separate servers might offer users better performance.

The following are the required ITUAM Windows-based applications:

- **ITUAM Administrator.** This application is used to maintain the information in the ITUAM database.

- **ITUAM Web Reporting.** This application provides comprehensive cost accounting, chargeback, and resource reporting in an easy-to-use, browser-based environment.

To install and get started using ITUAM Administrator and ITUAM Web Reporting, see Chapter 2, Installing ITUAM on Windows and Getting Started.
System Specifications

The following are the server specifications for ITUAM components on a UNIX or Linux platform.

- For the ITUAM Processing Engine and ITUAM Data Collectors for UNIX and Linux:
  - Any of the following UNIX or Linux operating systems:
  - Any of the following UNIX or Linux operating systems:
    - AIX® 5.1, 5.1.0.c, 5.2, or 5.3
    - Solaris 7, 8, 9, or 10
    - HP-UX 11, 11i, or 11.23
    - HP-UX 11.23 Itanium
    - Red Hat Enterprise Linux (RHEL) 3.0 or 4.0 for IA32
    - RHEL 3.0 or 4.0 for AMD64 and EM64T
    - RHEL 3.0 or 4.0 for System z (31 and 64 bit)
    - SuSE Linux Enterprise Server (SLES) 8, 9, or 10 for IA32
    - SLES 9 or 10 for AMD64 and EM64T
    - SLES 8 or 9 for System z (31 bit)
    - SLES 9 for System z (64 bit)
    - SLES 9 or 10 for PowerPC®
    - Linux Itanium for RHEL 3.0 and 4.0 and SLES 9.
  - 5 GB minimum available hard drive space for the following:
    - ITUAM Process Engine installation (requires 100 MB minimum)
    - The data associated with ITUAM Data Collectors (log files, collector directories, process definition directories, etc.).
      Process definitions are described in Working With the processes Directory on page 3-26. Log files and collector-related files and directories are described in the IBM Tivoli Usage and Accounting Manager Data Collectors for UNIX and Linux User's Guide.
    - 1 GB minimum of memory.
- For all other components of the ITUAM system, including the database, see System Specifications on page 2-5.
Installing Perl

Perl 5 ships with most common UNIX and Linux systems (e.g., AIX, HP-UX, Solaris). If Perl 5 is not installed on your computer, you can get the Perl source and binary distributions at www.cpan.org/ports.

By default, ITUAM accesses Perl at /usr/bin/perl. If the Perl executable is not in this location, you need to create a soft link to the executable in /usr/bin. For example:

> ln -s /usr/local/bin/perl /usr/bin/perl

If the Perl executable is not in /usr/bin/perl, you will be asked if you want to create a soft link to the executable during installation.

Installing ITUAM

The ITUAM installation includes the ITUAM Processing Engine and ITUAM Data Collectors for UNIX and Linux. Before you install these components, make sure that you have installed Perl 5 and that you complete the pre-installation steps in System Setup Checklist on page 3-6.

**Note** • IBM 32-bit JRE version 1.4 is included in the installation. However, you can use version 1.4 or 5.0 with ITUAM. If you want to use version 5.0, you need to specify the path to the JRE in the ituam.par file (see About the ituam.par File on page 3-25).

The optional ITUAM Web Console application requires version 5.0. For more information about this application, see Chapter 10, Working With ITUAM Web Console.
### System Setup Checklist

Before installing ITUAM, completed the following steps.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Perform Backups</strong></td>
<td><strong>If you are installing ITUAM:</strong> although ITUAM does not interfere with or modify the UNIX or Linux system, it is a good precautionary measure to ensure that the system has been recently backed up before you install or upgrade any system level product.</td>
</tr>
<tr>
<td></td>
<td><strong>If you are upgrading ITUAM:</strong> before you perform an upgrade, back up the ITUAM database and directories so you can recover to the original state, if necessary. In addition, back up any ITUAM scripts that you have modified.</td>
</tr>
<tr>
<td><strong>Verify That You Have Enough Disk Space for Installation</strong></td>
<td>Make sure you have enough disk space for installing ITUAM. the application and files require 20 to 25 MB. the additional space requirement is dependent on the size of the accounting files generated on the computer.</td>
</tr>
<tr>
<td><strong>Create an ITUAM User Account</strong></td>
<td>ITUAM is a system level product that operates in conjunction with the UNIX or Linux operating system. you have the option of having root maintain ITUAM or setting up an ITUAM user account. the advantage of a user account is that the ITUAM administrator does not need root privileges on a daily basis for maintenance.</td>
</tr>
<tr>
<td></td>
<td>You can set up a user account before installing ITUAM or during the installation (see installing ITUAM processing engine and ITUAM data collectors for UNIX and Linux on page 3-11).</td>
</tr>
<tr>
<td><strong>Create an ITUAM Group (Optional)</strong></td>
<td>Creating an ITUAM GID is recommended. you can set up a user account before you install ITUAM or during the installation (see installing ITUAM processing engine and ITUAM data collectors for UNIX and Linux on page 3-11).</td>
</tr>
</tbody>
</table>
About ITUAM Installation

The ITUAM installation for a UNIX or Linux system is composed of a base ITUAM package, which contains the ITUAM Processing Engine, and five collector packages for each of the UNIX/Linux operating systems that are supported by ITUAM (see System Specifications on page 3-4). For example, the base installation package for the AIX operating system is setup-ituam-<version-release>-<aix>.bin and the collector packages are setup-ituam-pkg#-<version-release>-<aix>.bin, where # specifies the package number.

Table 3-1 describes each of the packages and their contents. The base ITUAM installation consists of the ITUAM Base Package and Collector Base Package. The availability of the other collector packages depends on the packages that have been purchased for your organization.

The Collector Base Package (collector package 1) and Collector Package for Databases (collector package 3) must be installed on each computer from which you want to collect operating system, file system, or database data. To install these collectors from a central location to multiple computers, refer to the IBM Tivoli Usage and Accounting Manager Data Collectors for UNIX and Linux User’s Guide.

**Important!** All data collector packages other than the Collector Base Package and the Collector Package for Databases, must be installed on the same server as the ITUAM Base Package. The Collector Base Package and the Collector Package for Databases do not require the ITUAM Base Package on the same server.

<table>
<thead>
<tr>
<th>ITUAM Package</th>
<th>Contents</th>
<th>Installation File</th>
<th>Systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITUAM Base Package</td>
<td>This package contains ITUAM Processing Engine and its administrative tools and scripts. This package also creates the directory structure required by ITUAM Data Collectors for UNIX and Linux.</td>
<td>setup-ituam-6-1-aix.bin</td>
<td>AIX® 5.1, 5.1.0.c, 5.2, or 5.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>setup-ituam-6-1-solaris.bin</td>
<td>Solaris 7, 8, 9, or 10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>setup-ituam-6-1-hpux11x.bin</td>
<td>HP-UX, 11, 11i, or 11.23</td>
</tr>
<tr>
<td></td>
<td></td>
<td>setup-ituam-6-1-hpuxIA.bin</td>
<td>HP-UX 11.23 Itanium</td>
</tr>
</tbody>
</table>

Table 3-1 • ITUAM Installation Programs by Package
## Installing ITUAM on UNIX/Linux and Getting Started

### Installing ITUAM

#### ITUAM Package

<table>
<thead>
<tr>
<th>ITUAM Package</th>
<th>Contents</th>
<th>Installation File</th>
<th>Systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITUAM Base Package</td>
<td>setup-ituam-6-1-linuxz.bin</td>
<td>RHEL 3.0 or 4.0 for System z (31 and 64 bit)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SLES 8 or 9 for System z (31 bit)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SLES 9 for System z (64 bit)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>setup-ituam-6-1-linuxi.bin</td>
<td>RHEL 3.0 or 4.0 for IA32</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>RHEL 3.0 or 4.0 for AMD64 and EM64T</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SLES 8, 9, or 10 for IA32</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SLES 9 or 10 for AMD64 and EM64T</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Linux Itanium for RHEL 3.0 and 4.0 and SLES 9.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>setup-ituam-6-1-linuxp.bin</td>
<td>SLES 9 or 10 for PowerPC</td>
<td></td>
</tr>
<tr>
<td>Collector Base</td>
<td>This package contains the data collectors for UNIX and Linux operating system and file system data.</td>
<td>setup-ituam-pkg1-6-1-aix.bin</td>
<td>See ITUAM Base Package on page 3-7 for supported system by package.</td>
</tr>
<tr>
<td>Package</td>
<td>setup-ituam-pkg1-6-1-solaris.bin</td>
<td>setup-ituam-pkg1-6-1-hpux11x.bin</td>
<td></td>
</tr>
<tr>
<td></td>
<td>setup-ituam-pkg1-6-1-hpuxIA.bin</td>
<td>setup-ituam-pkg1-6-1-linuxz.bin</td>
<td></td>
</tr>
<tr>
<td></td>
<td>setup-ituam-pkg1-6-1-linuxi.bin</td>
<td>setup-ituam-pkg1-6-1-linuxp.bin</td>
<td></td>
</tr>
<tr>
<td></td>
<td>setup-ituam-pkg1-6-1-linxm.bin</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 3-1 • ITUAM Installation Programs by Package (Continued)
<table>
<thead>
<tr>
<th>ITUAM Package</th>
<th>Contents</th>
<th>Installation File</th>
<th>Systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collector Package for Databases</td>
<td>This package contains data collectors for DB2 and Oracle databases. It also includes the data collectors the Collector Base Package (package 1). Therefore, if you install this package, do not install the base collector package.</td>
<td>setup-ituam-pkg3-6-1-aix.bin setup-ituam-pkg3-6-1-solaris.bin setup-ituam-pkg3-6-1-hpux11x.bin setup-ituam-pkg3-6-1-hpuxIA.bin setup-ituam-pkg3-6-1-linuxz.bin setup-ituam-pkg3-6-1-linuxi.bin setup-ituam-pkg3-6-1-linuxp.bin</td>
<td>See ITUAM Base Package on page 3-7 for supported system by package.</td>
</tr>
<tr>
<td>Collector Package for Internet Infrastructure</td>
<td>This package contains data collectors for Internet applications.</td>
<td>setup-ituam-pkg4-6-1-aix.bin setup-ituam-pkg4-6-1-solaris.bin setup-ituam-pkg4-6-1-hpux11x.bin setup-ituam-pkg4-6-1-hpuxIA.bin setup-ituam-pkg4-6-1-linuxz.bin setup-ituam-pkg4-6-1-linuxi.bin setup-ituam-pkg4-6-1-linuxp.bin</td>
<td>See ITUAM Base Package on page 3-7 for supported system by package.</td>
</tr>
<tr>
<td>Collector Package for Network and Printing</td>
<td>This package contains data collectors for network and printing.</td>
<td>setup-ituam-pkg6-6-1-aix.bin setup-ituam-pkg6-6-1-solaris.bin setup-ituam-pkg6-6-1-hpux11x.bin setup-ituam-pkg6-6-1-hpuxIA.bin setup-ituam-pkg6-6-1-linuxz.bin setup-ituam-pkg6-6-1-linuxi.bin setup-ituam-pkg6-6-1-linuxp.bin</td>
<td>See ITUAM Base Package on page 3-7 for supported system by package.</td>
</tr>
<tr>
<td>Collector Package for Enterprise</td>
<td>This package contains all of the data collectors contained in the preceding packages. If you install this package, the individual collector packages are not required.</td>
<td>setup-ituam-pkg7-6-1-aix.bin setup-ituam-pkg7-6-1-solaris.bin setup-ituam-pkg7-6-1-hpux11x.bin setup-ituam-pkg7-6-1-hpuxIA.bin setup-ituam-pkg7-6-1-linuxz.bin setup-ituam-pkg7-6-1-linuxi.bin setup-ituam-pkg7-6-1-linuxp.bin</td>
<td>See ITUAM Base Package on page 3-7 for supported system by package.</td>
</tr>
</tbody>
</table>

**Table 3-1 • ITUAM Installation Programs by Package (Continued)**

For examples of installations using these packages, *Example Installations.*
Example Installations
The use of the ITUAM packages is shown in the following examples.

You have purchased just the base ITUAM components:
Install the following packages:
- ITUAM Base Package
- Collector Base Package

Note • The Collector Base Package is usually also installed on other servers from which you want to collect data.

You have purchased the base ITUAM components and all ITUAM Data Collectors for UNIX and Linux:
Install the following packages:
- ITUAM Base Package
- Collector Package for Enterprise (Collector package 7)

You have purchased the base ITUAM components, the database collectors, and the e-mail collectors:
Install the following packages:
- ITUAM Base Package
- Collector Package for Databases (Collector package 3)

Note • The Collector Package for Databases is usually also installed on other servers from which you want to collect data.

- Collector Package for E-Mail (Collector package 5)
Installing ITUAM Processing Engine and ITUAM Data Collectors for UNIX and Linux

Note • This section describes how to install ITUAM Data Collectors for UNIX and Linux. For detailed information about how to configure and run these collectors, refer to the IBM Tivoli Usage and Accounting Manager Data Collectors for UNIX and Linux User's Guide

The following are the steps for installing ITUAM Processing Engine on a UNIX or Linux system, although it is not required to install ITUAM Data Collectors for UNIX and Linux.

To install the ITUAM Base Package:

1. Log on to the UNIX system using the Super-User (root) account. ITUAM installation requires root privilege to create directories and execute privileged commands.

2. Change to the directory in which the ITUAM installation files are located.

3. Type the following command to launch the installation:

   
   ./setup-ituam-<version-release>-<OS>.bin

   Example:

   ./setup-ituam-6-1-002-aix.bin

4. Complete the steps in the InstallShield Wizard as follows:

   a. At the welcome screen, click Next.

   b. Review the terms of the license agreement, click I accept the terms of the license agreement, and then click Next. You must accept the terms to continue the installation.

   c. Click Next to install ITUAM to the default directory (opt/IBM/tivoli/ituam). If you do not want to use the default directory, enter the directory in the Directory Name box (type the directory or click Browse to find the directory).

   d. Type a user name and group for the ITUAM administrator or accept the defaults (ituam for both). If the user name and group are not pre-existing, select the Add UserName and Group check box.

   e. Select the features that you want to install, and then click Next. All features are selected by default. Do not clear the check box for a feature unless you do not want to install that feature.

   f. Review the summary information and click Install to continue or click Back to change the installation options.

   g. Click Finish when the installation is complete.
Installing ITUAM on UNIX/Linux and Getting Started

Installing ITUAM

To install the ITUAM collectors packages:

1. In the directory in which the ITUAM installation files are located, type the command to launch the installation.

   If are installing the ITUAM Enterprise Collector package (which contains all collectors), type:
   
   
   ```bash
   ./setup-ituam-pkg7-<version-release>-<OS>.bin
   ```
   
   Example:
   
   ```bash
   ./setup-ituam-pkg7-6-1-002-aix.bin
   ```

   If your are installing individual collector packages, type the applicable command for each package as follows:

   - **To install the Operating System and File System Collector package, type** 
     
     ```bash
     ./setup-ituam-pkg1-<version-release>-<OS>.bin
     ```
     
     Example:
     
     ```bash
     ./setup-ituam-pkg1-6-1-002-aix.bin
     ```

   - **To install the Database Collector package, type** 
     
     ```bash
     ./setup-ituam-pkg3-<version-release>-<OS>.bin
     ```
     
     Example:
     
     ```bash
     ./setup-ituam-pkg3-6-1-002-aix.bin
     ```

   - **To install the Internet Infrastructure Collector package, type** 
     
     ```bash
     ./setup-ituam-pkg4-<version-release>-<OS>.bin
     ```
     
     Example:
     
     ```bash
     ./setup-ituam-pkg4-6-1-002-aix.bin
     ```

   - **To install the Network and Printing Collector package, type** 
     
     ```bash
     ./setup-ituam-pkg6-<version-release>-<OS>.bin
     ```
     
     Example:
     
     ```bash
     ./setup-ituam-pkg6-6-1-002-aix.bin
     ```

   Complete the steps in the InstallShield Wizard. These are the same steps shown in Step 4 on page 3-11 with the exception that you are not asked for the installation directory or the ITUAM administrator user name and group.
Installing JDBC Drivers

JDBC is an application program interface (API) specification for connecting programs written in Java to the data in a wide range of databases. To enable ITUAM Processing Engine to access a DB2, SQL Server, or Oracle database, the appropriate JDBC drivers must be available.

By default, ITUAM Processing Engine assumes that you will use one of the following JDBC drivers:

- For DB2, the JDBC driver is the DB2 Universal JDBC Driver (Type 4). If you select JDBC support during the installation steps for any DB2 for Linux, UNIX, and Windows product, the driver is included in the installation.

- For SQL Server and Oracle, the JDBC drivers are `mssqlserver.jar`, `msbase.jar` and `msutil.jar` (Microsoft) or `ojdbc14.jar` (Oracle). The drivers are available from the Microsoft and Oracle Web sites.

However, you can use other drivers, such as DataDirect. In this case, you must specify that you want to override the default driver as described on page 3-21.

Installing and Setting Up the DB2 JDBC Driver

As described in Installing JDBC Drivers on page 3-13, if you select JDBC support during the installation steps for any DB2 for Linux, UNIX, and Windows product, the JDBC driver JAR file (`db2jcc.jar`) is included in the installation.

The following are the steps required to configure and access the driver depending on the type of database that you want to connect to: DB2 for Linux, UNIX and Windows or DB2 for z/OS.

**For a DB2 for Linux, UNIX, or Windows database:**

To enable ITUAM Processing Engine to access to the JDBC driver JAR file (`db2jcc.jar`) and the license JAR file (`db2jcc_license_cu.jar`), place a link to these files in the `$ITUAM_HOME/jlib/lib` directory as shown in the following example command:

```
/opt/IBM/tivoli/ituam/jlib/lib>ln -s /usr/opt/db2_08_01/java/*
```

Where the JAR files are in the `java` directory in this example. Note that you can also copy the JAR files to the `jlib/lib` directory, but a link is recommended in case the files are updated.
Installing JDBC Drivers

For a DB2 for z/OS database:

Note • Information regarding installing and setting up the DB2 JDBC driver is provided in the IBM DB2 UDB for z/OS V8 Application Programming Guide and Reference for Java. While not all of the steps in the IBM guide are required, the following steps must be performed.

1 Install the DB2 JDBC driver as follows:
   • If you are running ITUAM Processing Engine on a z/OS USS system, allocate and load the DB2 Universal JDBC driver libraries when you allocate and load the DB2 for z/OS libraries. A DB2 Connect license must be installed on the system.
   • If you are running ITUAM Processing Engine on UNIX or Linux server, you can copy the driver from DB2 for z/OS, or if you have DB2 for Linux, UNIX, or Windows installed, the driver is included in installation. A DB2 Connect license must be installed on the server.

2 To enable ITUAM Processing Engine to access to the JDBC driver JAR file (db2jcc.jar) and the license JAR file (db2jcc_license_cu.jar), place a link to these files in the $ITUAM_HOME/jlib/lib directory as shown in the following example command:

   /opt/IBM/tivoli/ituam/jlib/lib>ln -s /usr/opt/db2_08_01/java/*.

   Where the JAR files are in the java directory in this example. Note that you can also copy the JAR files to the jlib/lib directory, but a link is recommended in case the files are updated.

3 On z/OS, enable TCP/IP. For more information, refer to the IBM TCP/IP for MVS: Customization and Administration Guide.

4 In DB2 for z/OS, do the following:
   a Enable distributed data facility (DDF) and TCP/IP support.
   b Set the subsystem parameter DESCSTAT to YES (if it is not already set). For more information, see Set the DESCSTAT System Parameter on page 2-49.

5 Enable stored procedures for Universal JDBC driver support as follows:
   • In DB2 for z/OS, install and enable the following stored procedures supplied with DB2. These stored procedures are used by the Universal JDBC driver.
     - SQLCOLPRIVILEGES
     - SQLCOLUMNS
     - SQLFOREIGNKEYS
     - SQLGETTYPEINFO
     - SQLPRIMARYKEYS
     - SQLPROCEDURECOLS
     - SQLPROCEDURES
- SQPSPECIALCOLUMNS
- SQLSTATISTICS
- SQLTABLEPRIVILEGES
- SQLTABLES
- SQLUDTS
- SQLCAMESSAGE

For more information about enabling stored procedures, refer to the IBM DB2 UDB for z/OS V8 Installation Guide.

6 Run the DB2binder utility to bind and grant access to packages for the Universal JDBC driver. The DB2binder utility grants EXECUTE authority on packages to PUBLIC. For more information, refer to the IBM DB2 UDB for z/OS V8 Application Programming Guide and Reference for Java Guide.

Example

The following is an example of binding the JDBC packages for a DB2 Universal JDBC driver instance on the DB2 subsystem that has IP address mvs1, port number 446, and DB2 location name SJCEC1.

```
java com.ibm.db2.jcc.DB2Binder -url jdbc:db2://mvs1:446/SJCEC1 -user SYSADM -password mypass -keepdynamic yes -reopt once
```
Installing ITUAM on UNIX/Linux and Getting Started

Installing JDBC Drivers

Installing the SQL Server JDBC Drivers

**Note** • The steps in this section are for the JDBC drivers for SQL Server 2000. To use JDBC driver for SQL Server 2005, follow the steps in this section using the sqljdbc.jar file. Because the SQL Server 2005 driver is not an ITUAM default driver, you must also specify that you want to override the default driver as described on page 3-21.

The JAR files that contain the native SQL Server JDBC driver support are mssqlserver.jar, msbase.jar, and msutil.jar. To download these drivers, download SQL Server 2000 for JDBC Service Pack 3 from the Microsoft Web site.

**Setting up SQL Server JDBC Driver Access**

To enable ITUAM Processing Engine to access to the mssqlserver.jar, msbase.jar, and msutil.jar files, place a link to these files in the $ITUAM_HOME/jlib/lib directory as shown in the following example command:

```
/opt/IBM/tivoli/ituam/jlib/lib>ln -s /opt/msSQLjdbc/lib/*.
```

Where the JAR files are in the lib directory in this example. Note that you can also copy the JAR files to the jlib/lib directory, but a link is recommended in case the files are updated.

Installing the Oracle JDBC Driver

The JAR file that contains the native Oracle JDBC driver is ojdbc14.jar. If you are installing ITUAM on a computer that has an Oracle database installed, this driver is already installed. If you are installing on a computer that does not have an Oracle database, you can copy the ojdbc14.jar file from another computer or you can download the file from the Oracle Web site.

Select the ojdbc14.jar file without the tracing information.

**Setting up Oracle JDBC Driver Access**

To enable ITUAM Processing Engine to access to the ojdbc14.jar file, to place a link to the file in the $ITUAM_HOME/jlib/lib directory as shown in the following example command:

```
/opt/IBM/tivoli/ituam/jlib/lib>ln -s /opt/oracle/product/10g/jdbc/lib/*.
```

Where the JAR file is in the lib directory in this example. Note that you can also copy the JAR file to the jlib/lib directory, but a link is recommended in case the file is updated.
Installing Other JDBC Drivers

To install another JDBC driver, refer to the documentation for the driver. To enable ITUAM Processing Engine to access to the driver JAR file, place a link to the file in the $ITUAM_HOME/jlib/lib directory.

If you use a JDBC driver other than a one of the default drivers, you must specify that you want to override the default driver as described in "To add an ITUAM Data Source:" on page 3-20.
Setting Up and Connecting to a Database

The database stores the output records produced by ITUAM Processing Engine. These records are called the Ident, Detail, and Summary records and contain data processed from CSR or CSR+ records. Each process definition in the `processes` directory produces separate Ident, Detail and Summary files.

The database can be any of the following:
- DB2 UDB for Linux, UNIX, and Windows Version 8.1 or 8.2
- DB2 UDB for z/OS Version 8
- Microsoft SQL Server 2000 or 2005 with the latest service pack
- Oracle 9 or 10 (for UNIX or Windows)

**Note** • ITUAM supports only native Oracle drivers for Oracle.

- MSDE 2000. MSDE 2000 is included with the ITUAM installation for the Windows.

To set up and connect to a database, see *Setting Up and Connecting to a Database* on page 2-38.

About ITUAM Data Sources

An ITUAM Data Source is required to connect to the ITUAM database.

On the Windows ITUAM application server, an ITUAM data source points to an ODBC data source, which points to a database. Regardless of the type of database you are using and the location of the database (Windows, UNIX/Linux, or z/OS), you must create an ITUAM Data Source for the database using ITUAM Administrator. The steps for creating an ITUAM Data Source are provided by database type beginning with *Setting Up and Connecting to a DB2 for Linux, UNIX, and Windows Database* on page 2-40.

If you are running ITUAM Processing Engine on a UNIX or Linux system, you must create an ITUAM Data Source in two places:

- On the Windows system using ITUAM Administrator

  And

- On the UNIX or Linux system using the `ITUAMDBConfig.xml` file (see *Modifying the ITUAMDBConfig.xml File* on page 3-19). On a UNIX or Linux system, ITUAM Processing Engine uses a JDBC driver to connect to the database.

The ITUAM Data Source on both the Windows and UNIX or Linux system must point to the same database.
Getting Started

This section takes you through the steps required to set up ITUAM Processing Engine on a UNIX or Linux system. You should follow these steps in the order presented.

To help you to get started quickly, this section does not contain the detailed information found in other chapters in this guide. Where applicable, references to more detailed information are provided.

Set Up the ITUAMDBConfig.xml Configuration File

Before the ITUAM Processing Engine can process data, you must set up the configuration file ITUAMDBConfig.xml. This file provides parameters required to connect to the database.

The ITUAMDBConfig.xml file is built in the $ITUAM_HOME/config directory during installation, but the file must be updated before it can be used. To update the file, use the ITUAM Processing Engine Administrator GUI program (ITUAMAdmin.jar) or the ITUAMDBConfig utility (ITUAMDBConfig.jar). ITUAM Processing Engine Administrator provides an easy-to-use interface for modifying the ITUAMDBConfig.xml and ituam.par files; however, the GUI requires an XTERM server. If you are running ITUAM on z/OS USS and do not have an XTERM server, you can use the ITUAMDBConfig utility to modify these files.

Important! • Do not rename the ITUAMDBConfig.xml file or move the file from the config directory.

Modifying the ITUAMDBConfig.xml File

The ITUAM Processing Engine components (CIMSAcct, CIMSBill, and CIMSLoad) access the database through a JDBC interface. The ITUAMDBConfig.xml file contains the parameters needed to connect to one or more databases within your organization. Each database must have an ITUAM Data Source entry in the file that points to the database.

If you have multiple ITUAM Data Sources, you must specify one as the default data source. The default data source is stored in the ituam.par configuration file (see About the ituam.par File on page 3-25).

The following are the steps for modifying the ITUAMDBConfig.xml file using the ITUAM Processing Administrator GUI or the ITUAMDBConfig utility (see page 3-23).

Using ITUAM Processing Engine Administrator to Modify the ITUAMDBConfig.xml File

To start ITUAM Processing Engine Administrator:

1. At the command prompt, type:

```bash
> $ITUAM_HOME/bin/ITUAMAdmin
```
Because ITUAM Processing Engine Administrator is a Java GUI application, you can define the `DISPLAY` environment or supply it on the command line as shown in the following example:

```
> $ITUAM_HOME/BIN/ITUAMAdmin -d ITUAM:0
```

Where `ITUAM:0` is the node name and display.

2 The ITUAM Processing Engine Administrator main window appears. To access the ITUAM Data Source definitions, click **Data Source Configuration**.

The ITUAM JDBC Data Source Configuration dialog box is displayed. Use this dialog box to create an ITUAM Data Source to point to the ITUAM database.

A default ITUAM Data Source named `ITUAM`. You can optionally modify this data source to point to the database that you created for ITUAM (see example Figure 3-1).

As described in About ITUAM Data Sources on page 3-18, the ITUAM Data Source on both the Windows and UNIX or Linux system must point to the same database.

The following sections to provide the steps required to add, edit, or remove an ITUAM Data Source.

**To add an ITUAM Data Source:**

1 Click **Add** to add an ITUAM Data Source entry.

   The ITUAM JDBC Data Source Definition dialog box is displayed.

2 Edit the ITUAM Data Source settings as follows:

   - **Data Source ID.** Type an ID for the ITUAM Data Source (maximum of 32 characters). You can use the same database name as the data source ID or use another ID.

   - **Database Name.** The name of the database referenced by the ITUAM Data Source (maximum of 32 characters).

   - **Database Schema.** If you are using an Oracle or DB2 database, the name of the database schema. If you are using a SQL Server database, the database owner prefix (usually `dbo`).

   - **Database Type.** Click the database type (Oracle, SQL Server, or DB2).

   - **Database Port.** The TCP/IP server port that is assigned to the database server. The default port is dependent on the database:

     - For Oracle, the default port is 1521
     - For SQL Server, the default port is 1433
     - For DB2, the default port is 446

   - **Database Server.** The domain name or IP address of the database server.

   - **User ID and Password.** The user ID and password for the database.
Note • If you are using SQL Server, you must use a SQL Server-authenticated user ID. You cannot use a Windows-authenticated user ID.

- Overrides. If you do not want to use the default Oracle, SQL Server, or DB2 JDBC driver(s), you can override the default driver values using the following settings:

  - **Database URL.** The database server URL.

  - **Database Driver.** The database driver. The driver JAR file(s) or a link to the file(s) must be in the $ITUAM_HOME/jlib/lib directory.

  Refer to the driver documentation for the URL and driver syntax.

  Example: If you want to use a DataDirect SQL Server driver, you might enter the following:

    - **Database URL**: jdbc:datadirect:sqlserver://serverabc.acmeco.corp:1433
    - **Database Driver**: com.ddtek.jdbc.sqlserver.SQLServerDriver

3 Click **Test** to confirm that the settings for the data source are correct. A message appears notifying you that the connection is successful or unsuccessful.

4 Click **OK** when you are finished. The ITUAM Data Source entry appears in the ITUAM JDBC Data Source Configuration dialog box.

5 Click **Apply** to apply the change to the ITUAMDBConfig.xml file or click **OK** to apply the change and close the dialog box.

**To set an ITUAM Data Source as the default:**

Click the ITUAM Data Source that you want to set as the default, and then click **Set as Default**. Yes appears in the **Default** column for the data source.

**To edit an ITUAM Data Source:**

1 Double-click the ITUAM Data Source entry, or click the entry and then click **Edit**.

2 In the ITUAM JDBC Data Source Definition dialog box, follow the steps in **To add an ITUAM Data Source:** on page 3-20 beginning with **Step 2**.

**To remove an ITUAM Data Source:**

Click the ITUAM Data Source entry, and then click **Remove**.
Example of Creating an ITUAM Data Source Definition in ITUAM Processing Engine Administrator

By default, ITUAM provides an ITUAM Data Source named ITUAM that points to the database type DB2. You can modify this data source to point to the database that you have created for ITUAM as shown in example Figure 3-1. In this example, the database is also named ITUAM.

![ITUAM JDBC Data Source Configuration](image)

**Figure 3-1 • Configuring ITUAM Data Sources**

For an example of the corresponding ITUAM Data Source configuration in the ITUAM Administrator application on Windows, see Figure 2-3 on page 2-46.

Example of the Data Source Definition in the ITUAMDBConfig.xml File

The ITUAMDBConfig.xml file that contains the definition shown in Figure 3-1 would appear as follows:

```xml
<?xml version="1.0" encoding="utf-8" ?>
<ITUAMDBConnections version= "1.0">
  <Connection
    dataSourceId="ITUAM"
    databaseName="ITUAM"
    databasePrefix="ITUAMSCHEMA"
    databaseType="DB2"
    databasePort="446"
    databaseServer="192.165.222.58"
    user="ITUAMADMIN"
    password="E3ah9XfNsMw=">
  </Connection>
</ITUAMDBConnections>
```
Using the ITUAMDBConfig Utility to Modify the ITUAMDBConfig.xml File

USS on z/OS does not provide an XTERM server. You can rlogin into USS from another UNIX or Linux server and set DISPLAY to use the base system’s XTERM server or you can use the ITUAMDBConfig utility, which is a command line utility that updates the ITUAMDBConfig.xml file.

The syntax for the ITUAMDBConfig utility is:

```
java -jar ITUAMDBConfig.jar [mode] [parameters]
```

Where:

- **mode** =
  - ? Display this help
  - -add Add a new connection
  - -delete Delete a connection
  - -update Update a connection
  - -default Set the connection as the default
  - -test Test the connection

- **parameters** =

  **Note:** For more detailed descriptions of the following parameters, see To add an ITUAM Data Source on page 3-20. The parameters are the same as those in the ITUAM Processing Engine Administrator GUI.

  - -d datasourcename The data source name
  - -n databasename The database name (location DB2)
  - -o owner The database owner or schema
  - -p port The database port
  - -s server The server where the database resides
  - -t type DB2, Oracle, or SQL Server
  - -u user Database user for sign on
  - -w user password for sign on
  - -r url URL override
  - -v driver Database driver override
Example of Creating an ITUAM Data Source Definition in the ITUAMDBConfig.xml File Using the ITUAMDBConfig Utility

The ITUAM Data Source Definition example on page 3-22, which was produced using the ITUAM Processing Engine Administrator GUI, could have also been produced by executing the ITUAMDBConfig utility twice. The first execution would add the data source and the second execution would make the data source the default as shown in the following examples.

To add the data source:

Java -jar ITUAMDBConfig.jar -add -d ITUAM -n ITUAM -o ITUAMSCHEMA -t DB2 -p 446 -s 192.165.222.58 -u ITUAMADMIN -w ADMIN

To make the data source the default:

Java -jar ITUAMDBConfig.jar -default -d ITUAM
### About the ituam.par File

| Note | The parameters in the ituam.par file are automatically set during installation. Do not rename the ituam.par file or move the file from the config directory. |

The `$ITUAM_HOME/config/ituam.par` file contains the parameters needed to run ITUAM Processing Engine. This file contains the following parameters.

- **defaultDataSourceID.** This is the default ITUAM Data Source ID to be used by ITUAM. This value is set using the ITUAM Processing Engine Administrator application or the ITUAMDBConfig utility.

  You can override the default ITUAM Data Source ID if needed by including the `dataSourceId` parameter in the XML control file. For more information about this file, see Setting Up the Control File (ProcCntl.xml) on page 3-15.

- **Javapath.** The directory where the JRE is installed. This value is populated automatically when ITUAM is installed.

- **Processesdir.** The directory that contains the process definitions. The default directory is `$ITUAM_HOME/processes`. For more information about process definitions, see Working With the processes Directory on page 3-26.

### Example ituam.par File

```plaintext
defaultDataSourceId=ITUAM
javapath=/opt/IBM/tivoli/ituam/_jvm/bin
processesdir=/opt/IBM/tivoli/ituam/processes
```
Working With the processes Directory

The ITUAM Process Engine installation includes the $ITUAM_HOME/sample_processes directory. The subdirectories in sample_processes are referred to as process definitions. A process definition is a directory that contains the files required to process usage data from a particular source such as a database, operating system, or application.

When you install ITUAM Process Engine, the sample_processes directory and all of its contents are copied to the $ITUAM_HOME/processes directory and the processes directory is defined in the ituam.par configuration file. (See About the ituam.par File on page 3-25.) Each time that you re-install ITUAM Process Engine or upgrade to a new release, the application searches for the processes directory and recreates the directory if it does not exist.

When a new release of ITUAM Process Engine contains a new process definition directory or changes to an existing subdirectory or its contents, the additions and changes are made in the sample_processes directory. You can then copy the new or updated directories/files to the processes directory.

To help to ensure that you do not lose data, it is recommended that you include the processes directory in your back up schedule.
Run a Sample Process

**Note** • This is an optional step intended to provide a quick introduction to processing CSR and CSR+ files. For more information about processing these files, see *Chapter 8, Processing Data on UNIX or Linux*.

ITUAM includes the following default process definition directories in the $ITUAM_HOME/processes directory:

- AACCT_1, AACCT_4, AACCT_6, AACCT_7, AACCT_8, AACCT_11, AACCT_16
- Apache
- FTPD
- UnixDB2
- UnixDB2storage
- UnixFS
- UnixORA
- UnixORASTORAGE
- UnixOS

Each of these directories contains sample CSR files. To process these CSR files and load the output data into the database, run the $ITUAM_HOME/nightly.sh script. (For information about the nightly.sh script, refer to page 8-47.)

To verify that the output data has been loaded to the database, in the ITUAM Administrator main Windows, click **Chargeback Administration ➤ Database Loading ➤ Load Tracking**. The data for each process definition appear as Summary, Ident, and Detail files on the **Loads** tab.
Installing ITUAM on UNIX/Linux and Getting Started

Getting Started
Setting Up the System

This chapter describes how to use ITUAM Administrator to set up the system, including defining the account code structure, entering rates and rate groups, creating users and groups, and setting reporting options.

Setting Up the Account Code Structure .................................................. 4-3
Account Code Structure Example ......................................................... 4-3
Defining the Account Code Structure ................................................... 4-4
Defining Alternate Account Code Structures ........................................ 4-8

Working With Rates .................................................................................. 4-9
Defining Rate Codes .................................................................................. 4-9
Defining Alternate Rate Tables ................................................................. 4-15
Defining Rate Groups ................................................................................ 4-16

Working With Clients ................................................................................. 4-19
Defining Clients ......................................................................................... 4-19
Setting Up Client Budgets ........................................................................ 4-21
Defining Client Contacts .......................................................................... 4-24

Setting Up a Calendar .................................................................................. 4-25
Setting Up Calendar Information ............................................................... 4-25
Using 13 Accounting Periods ..................................................................... 4-26
Calendar Considerations .......................................................................... 4-26

Working With Users and Groups ............................................................... 4-27
Default Administrator User and Group .................................................... 4-27
Defining Users ......................................................................................... 4-27
Defining User Groups .............................................................................. 4-32

Using Web Reporting Headlines ............................................................... 4-38

Maintaining Identifiers .............................................................................. 4-39
## Setting Up the System

<table>
<thead>
<tr>
<th>Configuring System Settings</th>
<th>4-41</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization Information</td>
<td>4-42</td>
</tr>
<tr>
<td>Processing Settings</td>
<td>4-43</td>
</tr>
<tr>
<td>Reporting Settings</td>
<td>4-44</td>
</tr>
<tr>
<td>Database Settings</td>
<td>4-46</td>
</tr>
<tr>
<td>Web Settings</td>
<td>4-47</td>
</tr>
<tr>
<td>Table Audit Settings</td>
<td>4-52</td>
</tr>
<tr>
<td>Database Load Archive Settings</td>
<td>4-53</td>
</tr>
<tr>
<td>Configuration Options</td>
<td>4-54</td>
</tr>
</tbody>
</table>
Setting Up the Account Code Structure

ITUAM uses an account code to identify entities for billing and reporting. This code determines how ITUAM interprets and reports input data.

One of the first steps in implementing ITUAM is defining the account code structure. This structure defines the account code levels that appear in invoices and other reports.

For more information about account codes, see Setting Up Account Codes and Performing Account Code Conversion on page 7-40 (for Windows) or page 8-31 (for UNIX or Linux).

Account Code Structure Example

An account code can contain up to 128 bytes. The structure of the account code reflects the chargeback hierarchy for your organization arranged from highest to lowest level (e.g., company, division, department). You can define as many account code levels as necessary within the maximum available 128-byte field length.

For example, the following 17-byte account code contains four levels:

AABBBBBCCCCDDDDDDDDDD

Level 1, AA
  Full Length = 2 bytes
  Description = Company

Level 2, ABBBBB
  Full Length = 6 bytes
  Description = Division

Level 3, ABBBBBBCC
  Full Length = 9 bytes
  Description = Department

Level 4, ABBBBBBCCCCDDDDDDDD
  Full Length = 17 bytes
  Description = User

To see how you would define this account code for ITUAM, see Figure 4-3 on page 4-6.

Note • You can use business rules to map identifiers to applications in addition to or instead of business units, departments, cost centers, etc.
Defining the Account Code Structure

ITUAM includes a default account code structure called Standard. Use this structure to define your account code.

If you need to create additional account code structures for reporting, see Defining Alternate Account Code Structures on page 4-8.

To create account code levels:

1. In the ITUAM Administrator main window, click Chargeback Administration ➔ Chargeback Table Maintenance ➔ Account Code Structure.

The Account Code Structure List Maintenance dialog box is displayed as shown in Figure 4-1.

Figure 4-1 • Account Code Structure List Maintenance Dialog Box
2 Click Edit.

The Account Code Structure Maintenance dialog box is displayed as shown in Figure 4-2.

![Account Code Structure Maintenance Dialog Box](image)

**Figure 4-2 • Account Code Structure Maintenance Dialog Box**

3 In the Starting Offset into Account Code box, accept the default to begin reporting from the first account code level or enter another starting position to begin reporting at another level (see *To set the starting offset number:* on page 4-7).

4 In the Description and Length boxes, edit the sample description and length for each level of the account code (maximum of 128 levels where each level is a length of 1). To add a level to the end of the account code structure, click Add Entry. To add a level above an existing level, click the level, and then click Insert Entry.

For example, the account codes structure shown in *Account Code Structure Example* on page 4-3 is entered as shown in Figure 4-3 on page 4-6.
Setting Up the System

Setting Up the Account Code Structure

Figure 4-3 • Example Account Code Structure

Note the difference between the length and full length. The length is the number of bytes representing the specific entity. For example, the 4-byte BBBB in Level 2 represents the division.

The full length is automatically calculated and represents the total number of bytes for the level. For example, Level 2 includes 2 bytes for the company and 4 bytes for the division for a total of 6 bytes.

5 Click OK when you are finished.
To set the starting offset number:

The starting offset number determines the account code levels that are presented in reports. If you want to begin reporting from a level other than Level 1, enter the offset position for the level at which you want to begin reporting.

For example, if you have two user groups and one group wants to begin reporting at the User level shown in Figure 4-3 on page 4-6, you could set up a second account code structure with one level for User and an offset of 10 (the position where the User level begins in the account code structure) as shown in Figure 4-4.

Note that in this situation, users in groups using this account code structure cannot view any account code levels other than User in ITUAM Web Reporting. To avoid this restriction, your report developer could create a report for the User level rather than create an additional account code structure. For more information, contact IBM Software Support.

To remove an account code level:

Click the level, and then click Remove Entry.
Defining Alternate Account Code Structures

If needed, you can create additional account code structures. For example, you might need account codes with different levels or different offset positions.

**Note** • You can assign multiple account code structures to a user group. This enables users of the group to select the account code structure that they want to use for reports on the ITUAM Web Reporting Web site. For more information, see *To add a user group:* on page 4-32.

**To add an alternate account code structure:**

1. In the ITUAM Administrator main window, click Chargeback Administration ➤ Chargeback Table Maintenance ➤ Account Code Structure.

   The Account Code Structure List Maintenance dialog box is displayed.

2. Click Add.

3. In the Add Account Code Structure dialog box, enter the name of the new account code structure (maximum of 32 characters), and then click OK.

   The Account Code Structure Maintenance dialog box is displayed.

4. In the Starting Offset into Account Code box, accept the default or enter a starting offset number (see *To set the starting offset number:* on page 4-7).

5. Click Add Entry to add each level. (To add a level above an existing level, click the level, and then click Insert Entry).

6. Click OK when you are finished.

**To rename an alternate account code structure:**

1. Click the structure, and then click Rename.

2. In the Change Account Code Structure Name dialog box, enter the new name of the account code structure, and then click OK.

**To remove an alternate account code structure:**

Click the structure, and then click Remove.
Working With Rates

ITUAM uses a rate to calculate a cost for each resource being reported. Rates are organized by rate codes, tables, and groups as described in the following sections.

Defining Rate Codes

The CSR and CSR+ files used by ITUAM contain rate codes. Rate codes represent the resource units being reported (CPU time used, jobs started, data received or sent, disk space used, lines printed, etc.).

To enable ITUAM to process and report the rate codes in the CSR or CSR+ file, the codes must be defined in the CIMSRate table. The definition for each rate code includes a monetary value for the rate code and other rate processing information.

Many of the rate codes produced by the ITUAM Data Collectors are pre-loaded in the STANDARD rate table within the CIMSRate table. You can then use ITUAM Administrator to modify rate code values, delete rate codes that you do not use, and add rate codes that are not included in the STANDARD table by default.

**Note** • One of the settings associated with a rate code is the rate value. You can use ITUAM Financial Modeler to calculate and update rates for rate codes as described in Chapter 9, Working With ITUAM Financial Modeler.

If you need to perform differential costing, for example, you want to charge Client A different rates than Client B, you can create other rate tables in addition to the STANDARD table (see Defining Alternate Rate Tables on page 4-15).

Each rate code belongs to one rate group. Rate groups are logical groups that are used for grouping resources on invoices and other reports and for drill down (detailed) reporting. For more information about rate groups, see Defining Rate Groups on page 4-16.

**To add a rate code:**

**Note** • A rate table can contain a maximum of 999 rate codes.

1. In the ITUAM Administrator main window, click Chargeback Administration ▶ Chargeback Table Maintenance ▶ Rate Codes.

   The Rate Code List Maintenance dialog box is displayed.

2. If the Rate Table list contains multiple tables, click the rate table that you want to add the rate to. (If there are multiple tables, All is displayed in the Rate Table list by default.)

3. Click Add Rate.

4. In the Add New Rate Code dialog box, enter the new rate code (maximum of eight characters), and then click OK.
Setting Up the System

Working With Rates

**Important!** Rate codes are case-sensitive. Type the rate code exactly as it appears in the CSR or CSR+ file.

The Rate Code Maintenance dialog box is displayed as shown in example Figure 4-5.

![Rate Code Maintenance Dialog Box](image)

**Figure 4-5 • Rate Code Maintenance Dialog Box**

5 Edit the rate code settings as follows:

- **Description.** Enter a meaningful description of the rate code (maximum of 255 characters). The description is displayed on reports, graphs, and spreadsheets. It is recommended that you include units of measurement (GB, MB, hours, minutes, etc.) as applicable.

- **Value.** Enter the amount to be charged for the consumption of the resource represented by this rate code. Keep in mind:
  - Rate value corresponds to the specified rate code.
  - The following currency values are for example purposes only. ITUAM supports all currencies.
  - $25 is input as 25.
  - $1.25 is input as 1.25.
  - Negative values are preceded by a minus (e.g., –1).
  - Maximum Rate is 99999999v99999999.
• The value is multiplied by the resource amount contained in matching CSR or CSR+ file. For example, if the rate code value is 25 and a matching resource file contains a value of 5 hours, then the total charge would be $125.

• **Rate Index.** The rate index defaults to the order in which the rate code is displayed in reports. You can change the order; however, you cannot enter an index number that is already in use.

• **Rate Group.** Click the rate group for the rate code or click Add rate group to create a new rate group. All rate codes must be assigned to a rate group.

**Note**  • You can also create rate groups and assign rate codes using the Rate Group Maintenance dialog box (see Defining Rate Groups on page 4-16).

• **Use 4 decimals for rate.** This option determines the number of decimal digits that appear in the rate value in reports. If this check box is selected, the rate value includes four decimal digits. If this check box is not selected, the rate value includes eight decimal digits. For an example of rate values in a report, see page 5-11.

• **Rate is per thousand.** Select this check box to change the rate in reports from per resource unit to per thousand units.

• **Do not adjust for zero cost.** Select this check box if you do not want the associated rate code to be included in zero cost calculations.

**About Zero Costing**

It is possible within ITUAM Web Reporting to enter a target recovery amount for the billing period. (See the IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide for information about the Zero Cost Center Invoice). ITUAM then makes the appropriate adjustments to recover the targeted amount rather than the amount reflected by the standard multiplication of rate by resource units. This zero costing allows IT departments to recover a specified amount each billing period rather than show a profit or loss.

It is not always desirable to apply zero costing to all rates. Often, fixed cost items such as leased line charges, delivery services, or license fees are excluded from zero costing. The cost of these items is used as part of the overall calculation, but the specific rate is not adjusted.

• **Flat fee money charges.** Select this check box if the resource units for the rate code are considered a monetary amount rather than units of utilization. In this situation, the resource units and the charges are the same in reports.

**Note**  • When this check box is selected, the Value box is not displayed and any rate value previously entered in the Value box is ignored. However, the rate value is displayed in the rate column in ITUAM standard reports. You can customize the standard reports to remove or modify this value as needed.

• **CPU Value.** Select this check box to normalize CPU usage for this rate (see Normalizing CPU Values on page 7-56 [for Windows] or page 8-44 [for UNIX or Linux]).
• **Resource Conversion.** You can adjust the total resource units value in reports using the following conversion factors:
  
  • **Default.** No conversion is performed.
  
  • **Divide By or Multiply By.** The total resource units are divided or multiplied by a set conversion factor (e.g., Divide by 1000, Multiply by 60, etc.).
  
  • **Multiply By Conversion Factor.** The total resource units are multiplied by the factor in the **Conversion Factor** box.
  
  • **Conversion Factor.** This box is available only when **Multiply By Conversion Factor** is selected in the **Resource Conversion** box. Type a number by which you would like to multiply the total resource units for the rate code. This factor can be up to 16 digits including a decimal.
  
  • **Resource Decimals.** This option determines the number of decimal digits that appear in the resource units value in reports (e.g., 0= 99, 4 = 99.9999). The default is two decimal digits. For an example of resource units in a report, see page 5-11.
  
  • **Report Flag 1 and 2.** The use of these boxes is user-specified. These boxes allow you to type a one-character value that you can use in custom reports.
  
  • **Currency Symbol.** The use of this box is user-specified. This box allows you to type a currency symbol (maximum of three characters) that you can use in custom reports.
  
  • **Detail Description.** The use of this box is user-specified. This box allows you to type a description of the rate code that you can use in custom reports. Maximum of 255 characters.
  
  • **Comments.** Type any comments regarding the rate code. Maximum of 255 characters.

6 Click **OK** when you are finished.

You cannot add duplicate rate codes to a rate table. Each rate code in a table must be unique. If you want to use the same rate code more than once, e.g., you charge different clients different rates for the same resource, you must create separate tables (see **Defining Alternate Rate Tables** on page 4-15).

**Note** • Rates in the Rate Code List Maintenance dialog box are sorted by the index number. To sort the rates by rate code, rate group, description, etc., click the appropriate column header. To reverse the sort order, click the column header again.
To edit a rate code:

1. Double-click the code, or click the code and then click Edit Rate.
   
The Rate Code Maintenance dialog box is displayed.

2. Follow the steps in To add a rate code: beginning with Step 5 on page 4-10.

To remove a rate code:

Click the rate code, and then click Remove Rate.

Setting Rate Shifts

Rate shifts allow you to set different rates based on the time of day. For example, if a user is using a computer's resources at 4 a.m., you might charge the user less than if he uses these resources at 1 p.m. By default, every rate code has one shift. If your CSR or CSR+ files contain multiple shift codes, you can define up to eight additional rate shifts for rate code for a total of nine shifts.

You can set rate shifts by clicking the Edit Rate Shifts button from either of the following locations:

- From the Rate Code List Maintenance dialog box. First click the rate code that you want to apply rate shifts to.
- From the Rate Code Maintenance dialog box for a specific rate code.

The Rate Shift Maintenance dialog box is displayed. Complete this dialog box as follows:

1. Click the Rate Value box next to the shift number and enter a monetary value. In the adjacent Description box, enter an optional short description of the rate shift. See example Figure 4-6.

![Rate Shift Maintenance Dialog Box](image)

Figure 4-6 • Rate Shift Maintenance Dialog Box
2  Click OK when you are finished.

**Note** • To enable ITUAM to use rate shift values to calculate costs for a rate code, you must have the Use Shift Codes option enabled. If you do not have this option enabled, the default rate shift 1 is used for processing regardless of the rate codes that appear in the CSR or CSR+ file.

To enable the Use Shift Codes option, see page 7-33 (for Windows) or page 8-41 (for UNIX or Linux).

**Removing Rate Shifts**

Once you click OK in the Rate Shift Maintenance dialog box, the rate values for the shifts are applied as applicable when CSR or CSR+ files are processed. Therefore, if a rate shift value is set to 0, a rate of 0 appears in reports for the applicable rate code and shift.

If you decide that you do not want to use rate shifts after you have saved them for a rate code, you can remove the shifts by clicking the **Remove Rate Shifts** button from either of the following locations:

- From the Rate Code List Maintenance dialog box. First click the rate code that you want to remove the rate shifts from.
- From the Rate Code Maintenance dialog box for a specific rate code.
Defining Alternate Rate Tables

If needed, you can create rate tables in addition to the STANDARD table. For example, you might have clients who are charged different rates for the same resource usage (the Finance department is charged $20 per hour of CPU usage while the Marketing department is charged $5 per hour). In this case, you could use the STANDARD table for the Finance department and create a second rate table with the same rate codes but different values for the Marketing department.

Note • To use a rate table other than STANDARD for a client, you must assign the rate table to the client in the Client Maintenance dialog box (see Defining Clients on page 4-19) and enable the client search option for each process (see page 7-35 [for Windows] or page D-36 [for UNIX or Linux]).

To add a rate table:
1. In the ITUAM Administrator main window, click Chargeback Administration ➤ Chargeback Table Maintenance ➤ Rate Codes.
   
   The Rate Code List Maintenance dialog box is displayed.

2. Click Add Table at the top of the dialog box.

3. In the Add New Rate Table dialog box, enter a name (maximum of eight characters), and then click OK.
   
   The new rate table is displayed in the Rate Code List Maintenance dialog box.

4. To add rates to the table, follow the steps for adding a rate code in To add a rate code: on page 4-9.

To duplicate a rate table:
1. Click a table in the Rate Table list, and then click Duplicate Table.

2. In the Duplicate Rate Table dialog box, enter a name (maximum of eight characters), and then click OK.
   
   The new rate table is displayed in the Rate Code List Maintenance dialog box. The new table contains all of the rate codes contained in the original rate table.

3. To edit the rates in the table, double-click the code, or click the code and then click Edit Rate, and follow the steps in To add a rate code: beginning with Step 5 on page 4-10.

To remove a rate table:
Click the table in the Rate Table list, and then click Remove Table.

WARNING • When you remove a rate table, you lose all rate codes with their associated rates specific to that table.
Defining Rate Groups

**Tip** • When working with rate groups, you can access commands for an item by clicking the appropriate button, or you can access the same commands by right-clicking the item.

Creating and using rate groups lets you create rate subtotals in reports, graphs, and spreadsheets. Grouping rates such as Mainframe charges, Windows charges, and UNIX charges allows reports to be summarized in a way that is meaningful. It also allows users to create reports based on grouping rates that have the same identifier or identifiers.

All rate codes must be assigned to a group. For more information, see *Adding an Unassigned Rate Code to a Rate Group* on page 4-18.

**Note** • It is recommended that you do not assign rate codes with different identifiers to the same rate group. Combining rate codes with different identifiers within the same group results in reporting anomalies.

*Suggestion:* Create a separate rate group for each resource file type. For example a UNIX charges group for UNIX resource files with the same identifiers. This ensures that the rate codes within the group have the same identifiers.

**To add a rate group:**

1. In the ITUAM Administrator main window, click Chargeback Administration ➔ Chargeback Table Maintenance ➔ Rate Groups.

2. The Rate Group Maintenance dialog box is displayed showing an expandable hierarchy of existing rate groups. Individual rate codes appear within each rate group. See example *Figure 4-7* on page 4-17.
Figure 4-7  Rate Group Maintenance Dialog Box

3 Click **Rate Groups** at the top of the group list (if it is not selected), and then click **Add Rate Group**.

4 In the Add Rate Group dialog box, enter a description of the rate group (maximum of 32 characters), and then click **OK**.

**To remove a rate group:**

Click the rate group, and then click **Remove Rate Group**. If the rate group contains rate codes, you must delete the codes before you can delete the group.

**Changing the Rate Group Description and Title**

When you add a rate group, the description and title default to the description that you assigned to the group. You can change both the description and title of the rate group. In most cases you do not need to change the title unless you require a shorter field length for custom reports. Standard reports show the description field, not the title field.

**To change the rate group description:**

1 Click the group and click **Change Rate Group Description**.

2 In the Change Rate Group Description dialog box, enter the new description of the rate group (maximum of 255 characters), and then click **OK**.
To change the rate group title:

1. Click the group and click Change Rate Group Title.
2. In the Change Rate Group Title dialog box, enter the new title of the rate group (maximum of 32 characters), and then click OK.

Changing the Rate Group Sequence

The sequence in which the rate groups are displayed in the tree is the sequence that the groups appear in reports. You can sequence the rate groups in any order.

To change the group sequence:

1. Click Change Rate Group Sequence.
   The Rate Group Display Sequence dialog box is displayed.
2. Click a group, and then click the up or down arrow to reposition the group.
3. Click OK when you are finished.

Adding an Unassigned Rate Code to a Rate Group

To add an unassigned rate code to a rate group:

1. Click the group, and then click Add Unassigned Rates to Group.
   The Select Rate Code dialog box is displayed.
2. Choose the code or codes that you want to add, and then click OK.

   Note: In most cases, rate codes are assigned to a rate group when the rate code is added (see Defining Rate Codes on page 4-9).

Moving an Assigned Rate Code to Another Rate Group

To move a rate code from one group to another, click the rate code that you want to move and drag it to the desired rate code description.

Removing a Rate Code from a Rate Group

To remove a rate code from a rate group, click the rate code, and then click Remove Rate From Group.
Working With Clients

Once you have created the account code structure (see Setting Up the Account Code Structure on page 4-3), you can assign descriptions for the clients represented by your structure. These descriptions appear in place of the client’s account code in invoices and other reports. For example, if account code AABBBBCCC represents the Marketing department, you might assign the description Marketing Department for this code.

You can also specify the rate table used for the client and set up budget and contact and information.

Note • ITUAM provides sample clients. You should remove these sample clients before adding clients for your organization (see To remove a client: on page 4-21).

Defining Clients

To add a client:

1. In the ITUAM Administrator main window, click Chargeback Administration ▶ Chargeback Table Maintenance ▶ Clients.

The Client List Maintenance dialog box is displayed as shown in example Figure 4-8.

Note • Clients in the Client List Maintenance dialog box are sorted by account code. To sort the clients by account name, rate table, etc., click the appropriate column header. To reverse the sort order, click the column header again.

Figure 4-8 • Client List Maintenance Dialog Box
2 Click Add.

3 In the Add Account Code dialog box, enter the account code for the client (maximum of 128 characters), and then click OK. The Client Maintenance dialog box is displayed.

4 Edit the client settings as follows:
   - **Account Name.** Enter the name of the client as you want it to appear in invoices and other reports. Maximum of 255 characters.
   - **Alternate Account Code.** Enter an alternate account code if used for reporting to a General Ledger system or other types of reporting where the standard account code is different. Maximum of 128 characters.
   - **Rate table.** If other than STANDARD, click the rate table used for calculating the client’s charges. Alternate rate tables are used for clients who are charged different rates for the same resource usage. For example, the Finance department is charged $20 per hour of CPU usage, while the Marketing department is charged $5 per hour. For more information, see Defining Alternate Rate Tables on page 4-15.
   - **Invoice Contact.** If a contact is available for this client, the contact is displayed in this list box (see Defining Client Contacts on page 4-24). If there are multiple contacts for this client, click the appropriate contact from the list.
   - **Action Codes.** ITUAM does not use action codes. These codes are strictly for reporting purposes and can be used in the custom reporting process for selecting data.

5 Click OK when you are finished.

An example of a configured Client Maintenance dialog box is shown in Figure 4-9.

![Client Maintenance Dialog Box](image)

**Figure 4-9 • Client Maintenance Dialog Box**
For information on adding a budget and contact for the client, see *Setting Up Client Budgets* on page 4-21 and *Defining Client Contacts* on page 4-24.

**To edit a client:**

1. Double-click the client or click the client, and then click Edit.
   
   The Client Maintenance dialog box is displayed.

2. Follow the steps in *To add a client*: beginning with Step 4 on page 4-20.

**To remove a client:**

Click the client, and then click Remove.

---

**Setting Up Client Budgets**

Using ITUAM’s powerful budgeting feature, you can establish budgets by amount or units for the individual resources used or all resources used by a client. These budgets allow users to report on client actual vs. budget information.

ITUAM includes reports that you can use as templates to create custom account level and resource level budget reports for your organization. For more information about ITUAM budget reports, see the *IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide*.

**To create a budget:**

1. In the ITUAM Administrator main window, click Chargeback Administration > Chargeback Table Maintenance > Clients.
   
   The Client List Maintenance dialog box is displayed.

2. Click the client that you want to establish a budget for, and then click Budgets.
   
   The Client Budget Maintenance dialog box is displayed.

3. Edit the budget settings as follows:
   
   - **Year.** Click the appropriate year. If the year is not listed, click Budget > Add Year.
   
   - **Overall Account Budget.** You can set both an overall account budget and budgets for individual resources.

      To set an overall budget for an account, click Overall Account Budget.

      To set a budget for individual resources, click Budget > Add Resource Budget or right-click Overall Account Budget, and then click Add Resource Budget. The Select Rate Codes dialog box is displayed. Select the rate code or codes for the resources that you want, and then click OK. The rate codes are displayed under Overall Account Budget.
Budget Amount/Budget Units. You can budget by the monetary amount of consumed resources (Budget Amount) or the unit amount of consumed resources (Budget Units). You can enter a total budget and a budget for each month (period) within the year.

Enter the total budget amount or budget units for the year in the Total box and the budget amount for each period in the Period boxes (1 through 12/13). (To use 13 month periods, see page 4-26.)

Divide Total (Budget Amount and Budget Units). Click Divide Total to divide the total budget amount of budget units by the number of periods and automatically populate the Period boxes with the result. Note that if you change a total, you must perform this step again.

Sum Periods (Budget Amount and Budget Units). Click Sum Periods to add the amounts entered in Period boxes and automatically enter the sum in the Budget Amount Total or Budget Units Total boxes. Note that if you change the amount for a period or periods, you must perform this step again.

Click Apply to save the changes or click OK to save the changes and close the dialog box.

An example of a configured Client Budget Maintenance dialog box is shown in Figure 4-10. In this example, a budget is set for the resource represented by rate code Z003.
To remove a budget:

To remove all budget information for a year, click **Budget ➤ Remove Year**. This removes the overall budget and all individual resource budgets for the year selected in the **Year** box.

To remove an individual resource budget, click the budget, and then click **Budget ➤ Remove Resource Budget**, or right-click the budget, and then click **Remove Resource Budget**. *The budget is removed from all years.*
Defining Client Contacts

You can create one or multiple contacts for each client. Contact information includes name, street and e-mail addresses, phone numbers, and department.

The first contact in the client contact list appears in ITUAM standard invoices. However, you might develop custom reports that display multiple contacts.

To add a contact:

1. In the ITUAM Administrator main window, click Chargeback Administration ▶ Chargeback Table Maintenance ▶ Clients.

   The Client List Maintenance dialog box is displayed.

2. Click the client that you want to establish a contact for, and then click Contacts.

   The Client Contact List Maintenance dialog box is displayed.

3. Click Add.

4. In the Client Contact Maintenance dialog box, edit the contact settings as follows:

   - **Address tab.** Type the contact’s name and company and e-mail addresses. You can type the street address on any address line or lines. However, if want to use the View Address Map button to view a map for the address, enter the address in the following order:
     - Address Line 1: Street Address
     - Address Line 3: City, State, Zip
   - **Phone tab.** Enter the contact’s phone numbers.
   - **Other tab.** Enter other contact information such as department, comments, and Web site URL.

5. Click OK when you are finished.

   The contact is displayed in the Client Contact Maintenance dialog box with an index number. This number is a key that uniquely identifies the contact for reports.

To edit a contact:

Click the contact, and then click Edit.

To remove a contact:

Click the contact, and then click Remove.

Importing and Exporting Client Data

Client information is contained in the CIMSCClient table. You can load and unload data to/from the CIMSCClient table via a number of custom scripts that are provided with ITUAM. For more information, see Appendix C, Scripts.
Setting Up a Calendar

ITUAM Administrator includes a default calendar with the standard 12 monthly periods (the first day of the month to the last day) by year. Organizations using standard monthly/yearly periods do not need to change the calendar.

If you do not want to run billings using standard monthly/yearly periods, you can change the period start and end dates and optionally include 13 periods per year (see page 4-26).

Setting Up Calendar Information

1. Click Chargeback Administration ▶ Chargeback Table Maintenance ▶ Calendar.

   The Setup Calendar dialog box is displayed as shown in example Figure 4-11.

   ![Setup Calendar Dialog Box](image)

   **Figure 4-11 • Setup Calendar Dialog Box**

2. Edit the calendar as follows:
   - In the Year list, click the appropriate year if it is not displayed.
   - Set the Beginning Date and Ending Date for each period as needed.
   - To have all periods proceed sequentially from the first period, click Set From Period 1.
   - To add a new year, click Add Year.
   - To remove the currently displayed year, click Remove Year.
Note that the Close Date for the period is displayed if a day-of-month close date has been set (see page 4-43). The close date is displayed for the period in which it was set, the previous period, and future periods. In example Figure 4-11 on page 4-25, a first of the month close date was set in Period 7 (July). Therefore Period 6 and all future periods show a close date.

**Note** • If you do not set a close date or set a specific close date rather than a day-of-month date, the Close Date column is not displayed in the CIMSCalendar table.

3 Click **Apply** to save the changes or click **OK** to save the changes and close the dialog box.

**Using 13 Accounting Periods**

If your organization uses 13 accounting periods, you can set this calendar format as follows:

1 In the ITUAM Administrator main window, click **System Administration → Configuration Information**.
2 In the Configuration dialog box, click the **Processing** tab.
3 On the **Options** subtab, select the **Use 13 Periods** check box, and then click **OK**.

**Calendar Considerations**

- The maximum entries that CIMSAcct or CIMSBill reads from the CIMSCalendar table is 52. (See page A-14 for more information about the CIMSCalendar table.) Therefore, you must delete periods from previous years as they pass.
- The periods for a particular year must be entered in date sequence.
- The CIMSCalendar table must have the current and previous periods defined.
Working With Users and Groups

A user is an individual with access rights to ITUAM Web-based applications (i.e., ITUAM Web Reporting, ITUAM Financial Modeler, etc.). Each user can belong to only one user group. Users are granted the rights and privileges granted to the group.

In ITUAM Web Reporting, this system of users and groups allows you to control the following:

- The reports that a user can access in ITUAM Web Reporting. A user can access only those reports that are assigned to the user’s group.
- The clients (account codes) that a user can view in reports. A user can view only those clients that are assigned to the user’s group.
- The administrative privileges for a user. A user assigned to a group with administrative privileges can update configuration and other information in ITUAM Web Reporting.

In other ITUAM Web applications, this system allows you to control who can access the applications.

Default Administrator User and Group

When you initialize the database during the setup process (see Initialize the Database on page 2-83), ITUAM adds a default user and user group. This group has administrative privileges in ITUAM Web Reporting and can view all reports and clients.

The ID for the default user is admin and the password is password. The ID for the default user group is Admin.

Defining Users

You can use ITUAM Administrator to create and maintain user information such as e-mail address, ID, password, and other user-specific options.

To add a user:

1. In the ITUAM Administrator main window, click System Administration ▶ Users and Groups ▶ Users.

The User List Maintenance dialog box is displayed as shown in example Figure 4-12 on page 4-28.
2 Click Add.

3 In the Add New User dialog box, enter an ID for the user (maximum of eight characters) and the click OK. The User Maintenance dialog box is displayed.

4 Edit the user settings as follows.

- **Full Name.** Type the user’s full name.

- **Email Address.** ITUAM includes an automatic report distribution feature (see Distributing Published Reports on page 5-24). To enable the user to receive reports using this feature, type the user’s e-mail address.

- **Display full path on Favorites page.** Select this check box to display the full path for published reports on the Favorites page of ITUAM Web Reporting. For more information, refer to the IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide.

- **Display full path on Published Reports page.** Select this check box to display the full path for published reports on the Published Reports page of ITUAM Web Reporting. For more information, refer to the IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide.

- **Crystal Viewer.** Click the Crystal viewer used for this user in ITUAM Web Reporting. (To set this option for all users, see Web Settings on page 4-47.) If you are using SQL Server Reporting Services for reporting, leave this box set to Default. You can choose one of the following. For the advantages and disadvantages of each viewer, see page 4-47.

  - **Default.** This option uses the viewer set on the Web tab of the Configuration dialog box.
• **ActiveX.** This option works only in Internet Explorer.

• **Java using Browser JVM.** This option works in Internet Explorer or Netscape Navigator. This viewer requires the Java Virtual Machine. Because this viewer might be more difficult to set up, the use of the HTML or ActiveX viewer is recommended.

• **HTML.** This option works in Internet Explorer or Netscape Navigator.

• **Group.** Click the group that you want to add the user to or accept the default Admin group. Note that if you need to add a new group for the user, you can create the group and add the user as described in *Defining User Groups* on page 4-32.

• **Configuration Options Maintenance.** When you click this button, the User Configuration Options List Maintenance dialog box is displayed. You can add user configuration options that can be used for custom reports and Web pages in this dialog box. See *To add configuration options:* on page 4-54.

  IBM recommends that you consult technical support for assistance in adding user configuration options.

• **Domain Name/Domain User ID.** ITUAM Web Reporting and the other ITUAM Web-based applications provide an automatic logon feature. To enable a user to use this feature, enter the user’s Windows domain name and user ID. You also must enable auto logon see *Web Settings* on page 4-47) and to set IIS security for the ITUAM Web Reporting Web site and any other ITUAM sites to Integrated Windows authentication (see page 2-94).

  You can click **Browse** to select the domain and user from the Select Domain Name and User ID dialog box. To find a domain and user in the **Select Location** and **Select User** lists:

  a  Type a complete or partial value in the text box and then click **Find** or use the scroll bar.

  b  Click **OK** when you are finished.
• **Password.** If you are not using the automatic logon feature for ITUAM Web applications, use this box to enter a password for the user or to change an existing password as follows:
  a. Type the password. The password is alphanumeric and case-sensitive and can be a maximum of 16 characters.
  b. Re-type the password in the **Confirm Password** dialog box.

If you are using Crystal Reports XI, note the following:

• The user password requirements (e.g., number and type of characters) differs between ITUAM and Crystal Reports Server. You will receive an error message when you try to add a ITUAM user password that does not match the requirements for Crystal Reports Server. To avoid this message, you can change the password restrictions in BusinessObjects Enterprise Central Management Console as described in *Configuration in BusinessObjects Enterprise Central Management Console*: on page 2-105.

• When the user logs on to the ITUAM Web Reporting Web site for the first time, the user will be prompted to change the password. The user can use the password entered here or choose a new password.

5. Click **OK** when you have finished editing the user settings. If you are using Crystal XI for reporting, a message is displayed asking if you would like to add the user to BusinessObjects Enterprise Manager. Click **Yes**.

An example of a configured User Maintenance dialog box is shown in *Figure 4-13.*

![User Maintenance Dialog Box](image-url)
To edit a user:

1. Click the user, and then click Edit.
   
The User Maintenance dialog box is displayed.

2. Follow the steps in To add a user: beginning with Step 4 on page 4-28.

To remove a user:

Click the user, and then click Remove. If you are using Crystal XI for reporting, the user is automatically removed as a Crystal Reports Server user.
Defining User Groups

You can use ITUAM Administrator to create and maintain user groups including adding users to groups; defining one or multiple account code structures for a group; assigning group access to reports and clients for Web reporting; and assigning access rights to ITUAM Web applications.

**Tip** • When working with groups, you can access commands for an item from the menu bar, or you can access the same commands by right-clicking the item.

**Note** • A user can belong to only one group. If you need to place a user in more than one group, create a new group for the user. For example, a user who needs access to the reports assigned to Group A and Group B should be assigned to Group C that has access to the combined reports of Group A and Group B. Assigning a user to only one group makes it easier to determine the user’s full access rights.

To add a user group:

1. In the ITUAM Administrator main window, click **System Administration ➤ Users and Groups ➤ Groups**. The Group List Maintenance dialog box is displayed as shown in example Figure 4-14.

![Figure 4-14 • Group List Maintenance Dialog Box](image)

2. Click **Groups ➤ Add Group** on the menu bar.

3. In the Add Group dialog box, enter an ID for the group (maximum of eight characters), and then click **OK**. The Group Maintenance dialog box is displayed.
4. Edit the group settings as follows:

- **Description.** Use this box to change the description of the group (the default is the group ID followed by “Group”). Note that if you add a description, the description rather than the group ID is displayed in the Group List Maintenance dialog box.

- **Selected Account Code Structures/Available Account Code Structures.** Use these boxes to define the account code structure or structures that the users of the group can use for reporting.

You can add and remove structures from one box to the other. All structures that are displayed in the **Selected Account Code Structures** box are available to users in the group from the ITUAM Web Reporting Web site. This feature enables users to dynamically select the account code structure that they want to use to generate reports.

If you have multiple account code structures in the **Selected Account Code Structures** box, set one of the structures as the default structure by clicking the structure and then clicking **Make Default**. The default structure is displayed on the Set User Options page of the ITUAM Web Reporting Web site until another structure is selected from the Web site. The default structure is also used when publishing reports in batch for a user or group (see Working With Batch Reporting/Published Reports on page 5-23).

**Note** • The account code structure selected as the default in the Select Account Code Structures box initially determines the structure that is displayed on the Web site when the site is accessed by a user in the group. However, once the user selects another account code structure on the Web site, that structure is stored in a cookie and not the ITUAM database. Changing the default structure in ITUAM Administrator does not change default structure on the Web site.

- **Allow Transaction Maintenance.** Select this check box to allow the users in this group to perform transaction maintenance in ITUAM Web Reporting. For more information, refer to the IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide.

- **Administrative Access.** Select this check box to give the users in this group administrative configuration options in ITUAM Web Reporting. For more information, refer to the IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide.

- **Allow Financial Modeler Access.** Select this check box to allow users in this group to access ITUAM Financial Modeler. If this check box is selected, Financial Modeler is displayed as a link in the ITUAM Web Reporting Admin menu. For more information about ITUAM Financial Modeler, see Chapter 9, Working With ITUAM Financial Modeler.
• **Allow Web Console Access.** Select this check box to allow users in this group to access ITUAM Web Console. If this check box is selected, **Web Console** is displayed as a link in the ITUAM Web Reporting **Admin** menu. For more information about ITUAM Web Console, see *Chapter 10, Working With ITUAM Web Console*.

• **Split Account Code on Transaction Entry.** If this check box is selected (the default), users in this group are allowed to enter account codes by levels when adding account codes in the Miscellaneous, Recurring, and Credit Transaction pages in ITUAM Web Reporting. Users can either type the account code in the box for each level or select the code if an accompanying select box is available. The following option, **Max Levels of Account Code to Display**, determines the number of account code levels that include a select box.

The account code levels displayed are dependent on the levels defined in the account code structure selected for the group.

For more information about using transactions in ITUAM Web Reporting, refer to the *IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide*.

• **Max Level of Account Code to Display.** If the **Split Account Code on Transaction Entry** check box is selected, type the number of levels that you want to include select boxes for. For example, if you have five account code levels, but only want to include select boxes for the three highest levels, type 3 in this box. The remaining two levels will have a text box in which users can type the account code, but no select box to browse for the account code.

The data loaded in the select boxes is pulled from the CIMSClient table. If the CIMSClient table is large, the transaction page can take more time to load if multiple select boxes are included. Limiting the number of select boxes can reduce the amount of time required for the transaction page to load.

The default, 0, specifies that all account code levels include select boxes.

• **Configuration Options Maintenance.** When you click this button, the Group Configuration Options List Maintenance dialog box is displayed. This dialog box contains entries for some of the group configuration options that you have set. For example, the option **TransSplitAccountCode** represents the **Split Account Code on Transaction Entry** check box. **Do not delete these entries.**

You can add group configuration options that can be used for custom reports and Web pages in this dialog box. See *To add configuration options:* on page 4-54.

It is recommended that you consult technical support for assistance in adding group configuration options.

5 Click **OK** when you are finished editing the group settings.

An example of a configured Group Maintenance dialog box for the **Admin** group is shown in Figure 4-15 on page 4-35. In this example, the account code structure **Alternate** has been added to the list of structures that the users in this group can use for reporting. This group has been given all group privileges.
To edit a user group:

1. Click the group and click **Groups** ▶ **Edit** on the menu bar.
   
The Group Maintenance dialog box is displayed.

2. Follow the steps in To add a user group: beginning with Step 4 on page 4-33.

To add a user to a user group:

1. Click the group, and then click **Groups** ▶ **Add User** on the menu bar.
   
The Select User dialog box is displayed.

2. Choose the user or users, and then click **OK**.

**Note**  • You can edit a user’s settings by double-clicking the user in the Group List Maintenance dialog box.
To remove a user from a user group:
Click the user, and then click **Users ▼ Remove** on the menu bar.

To remove a user group:
Click the group, and then click **Groups ▼ Remove** on the menu bar.

Adding or Removing Report Access to/from a Group

By default, new users are added to the **Admin** group, which has administrative access enabled and full access to all reports. If you want to restrict user access to reports, perform the following steps:

- Select the **Use Report Access Security** check box on the Configuration dialog box **Reporting/Options** subtab (see page 4-44). If this check box is not selected, all users can access all reports regardless of whether administrative access is enabled for their group.

- Create a group or groups that do not have administrative access enabled (the **Administrative Access** check box is not selected) and add the appropriate users. (Users that belong to a group that has administrative access enabled have access to all reports.)

- Add reports to the group as described in **To add access to reports**.

**Note** • If you change the Use Report Access Security option (i.e., you select the check box or clear it), the change will not take effect in ITUAM Web Reporting until you click **Upgrade Configuration** on the Edit Configuration page or restart IIS.

To add access to reports:
Expand the group, click **Reports Allowed**, and do one of the following:

- To allow all reports, click **Reports ▼ Allow All Reports** on the menu bar. When you add a group, this is the default.

- To allow certain reports, click **Reports ▼ Add** on the menu bar. In the Select Report dialog box, choose the report or reports that you want to add, and then click **OK**.

**Reports Allowed** expands to show **All Reports** or the reports that you added.

To remove access to a report:
1. Expand **Reports Allowed**.
2. Click the report, and then click **Reports ▼ Remove** on the menu bar.
Adding or Removing Client Access to/from a Group

You can add access to clients to each group. This allows members of the group to see these client account codes in reports. For more information about clients, see Working With Clients on page 4-19.

To add access to clients:

1. Expand the group, click Clients Allowed, and do one of the following:
   - To allow all clients, click Clients ▶ Allow All Clients on the menu bar. When you add a group, this is the default.
   - To allow certain clients, click Clients ▶ Add on the menu bar. In the Select Client dialog box, choose the client or clients that you want to add, and then click OK.

   **Note** To prevent duplicate data in reports, you cannot add a client with an account code that overlaps an existing client account code in the Clients Allowed list. For example, if you add client AABBB you cannot add client AA or AABBBCC.

2. Expand Clients Allowed to view the clients that you added.

   Note that the account code structure selected for the group might have an offset position greater than 1. However, client access is always determined by the first position in the account code, regardless of the offset position. The clients that you add will contain the full account code as assigned for the clients in the CIMSClient table.

   Although the full account code is displayed for the clients in the Clients Allowed list for the group, the users assigned to the group will be able to view data for only the account code level(s) specified by the offset.

   For example, assume that you have the following account codes:

   - AABBB
   - AACCC

   In the account code structure selected for the group, the first level of the account code is defined as a length of 2 and the second level is defined as a length of 3. The offset position for the account code is 3, which determines that users assigned to the group can view data for clients BBB and CCC only. However, the complete client account codes AABBB and AACCC are displayed in the Clients Allowed list.

   For more information about the account code structure, see Setting Up the Account Code Structure on page 4-3.

To remove access to clients:

1. Double-click Clients Allowed.

2. Click the client, and then click Clients ▶ Remove on the menu bar.

Accessing User, Report, and Client Lists

You can edit user, report, and client settings by clicking Users, Reports, or Clients in the Group List Maintenance dialog box.
Using Web Reporting Headlines

Headlines are links that are displayed on the home page of the ITUAM Web Reporting Web site. A headline can link to any URL. This feature has many uses including displaying announcements such as the latest ITUAM chargeback data is available, a new report is available, etc.

To add a headline:

1  In the ITUAM Administrator main window, click System Administration ➤ Reporting ➤ Web Reporting Headlines.

   The Web Reporting Headline Maintenance dialog box is displayed.

2  Click Add.

   The Headline Maintenance dialog box is displayed.

3  Enter the headline settings as follows:

   •  Date. Click the date that you want to assign to the headline. Note that this is not the date that the headline appears on the Web site—the headline is displayed as soon as it is created.

   •  Headline. Type the text of the headline.

   •  Headline Link. Type the URL for the headline (the headline is displayed as a link).

4  Click OK when you are finished.

An example of a configured Headline Maintenance dialog box is shown in Figure 4-16.

To edit a headline:

1  Click the headline and in the Web Reporting Headline Maintenance dialog box, and then click Edit. The Headline Maintenance dialog box is displayed.

2  Follow the steps in To add a headline: on page 4-38 beginning with Step 3.

To remove a headline:

Click the headline in Web Reporting Headline Maintenance dialog box, and then click Remove.
Maintaining Identifiers

When you process a CSR or CSR+ file, the identifier names within that file are stored in the CIMSIdent table. You can perform the following maintenance tasks for the identifiers:

- **Add a description for the identifier.** By default, the identifier description is the same as the identifier name. For reporting purposes, you can add detailed descriptions for identifiers that are difficult to decipher such as alphanumeric strings. In reports that provide drill down by identifier, the identifier descriptions are displayed in the Identifier list to enable drill down of units or rates by identifier.

- **Remove unused identifiers.** You can remove any unused identifiers from the CIMSIdent table. Unused identifiers are those that are not contained in the CIMSDetailIdent table. For more information about the CIMSIdent and CIMSDetailIdent tables, see Appendix A, Database Tables.

- **Enable options for custom reporting.** You can set options for each identifier, such as flags, for custom reporting.

**To add an identifier description:**

1. In the ITUAM Administrator main window, click System Administration > Identifiers Maintenance. The Identifier List Maintenance dialog box is displayed.

2. Click the identifier that you want to edit, and then click Edit. The Identifier Maintenance dialog box is displayed.

3. Enter the identifier settings as follows:

   - **Active/Inactive.** These options are available for custom reports. The use of these options is user-specified.

   - **Name.** This is the name of the identifier as it appears in the CSR or CSR+ file. Do not change the name unless you want to assign a new identifier to the same description. For example, the identifier `ABC` has been changed to `ABCD`. The identifier name has changed, but the description remains the same.

   - **Description.** Enter a description for the identifier (maximum of 255 characters).

   - **Report Flag.** This box allows you to enter a one-character value that you can use in custom reports. The value for this flag is user-specified.

An example of a configured Identifier Maintenance dialog box is shown in Figure 4-17 on page 4-40.
Figure 4-17 • Identifier Maintenance Dialog Box

To remove unused identifiers:

Click Remove Unused Identifiers.
Configuring System Settings

You can configure the following system settings using ITUAM Administrator:

- **Organization information.** Name and address of your organization.
- **Processing settings.** Global processing settings for the system such as the path to the Processes folder and whether a close date is used for processing.
- **Reporting settings.** Report-related settings such as file location, invoice numbering, and security.
- **Database settings.** Database-related settings such as time-out period and load priority.
- **Web settings.** Web site settings for ITUAM Web Reporting.
- **Table audit settings.** Table audit options.
- **Database load archive settings.** Settings for archiving database loads.
- **Configuration options.** Additional settings for custom reports and Web pages.

**Important!** If you change any of these settings in ITUAM Administrator, the changes will not take effect in ITUAM Web Reporting until you click Upgrade Configuration on the Edit Configuration page or restart IIS.

In addition, some of these settings can be configured in ITUAM Administrator or ITUAM Web Reporting. If ITUAM Web Reporting is open when you make these changes, click Refresh before you click Upgrade Configuration. This ensures that the settings are populated with the values that you set in ITUAM Administrator.
To configure the system settings:

1. In the ITUAM Administrator main window, click System Administration ▶ Configuration Information.

   The Configuration dialog box is displayed as shown in example Figure 4-18.

   ![Configuration Dialog Box](image)

   **Figure 4-18 • Configuration Dialog Box**

2. Complete the tabs in the dialog box as shown in the following sections, and then click OK to save the settings and close the dialog box.

   **Note** • To return the settings in all tabs to the original default settings, click Reset To Defaults.

### Organization Information

Use the Organization tab to type the name and address of your organization (maximum of 255 characters in each line), and then click OK. This information is displayed in the standard invoices that ship with ITUAM.

You can also type this information on the Edit Configuration page in ITUAM Web Reporting.
Processing Settings

Use the Path, Options, and Closing subtabs on the Processing tab to set the processing settings for ITUAM.

Path Subtab

- **Process Definition Path.** Enter the path for the process definitions (maximum of 255 characters). For more information about process definitions, Chapter 7, Processing Data on Windows or Chapter 8, Processing Data on UNIX or Linux.

Options Subtab

- **Use 13 Periods.** Select this check box if your organization uses 13 accounting periods. For more information, see Using 13 Accounting Periods on page 4-26.

- **Decimal positions used in money calculation.** Enter the number of decimal digits (0–6) that you want to appear in money values in the CIMSSummary table. Before you set this value, you should review Defining Decimal Positions for Money Values in the CIMSSummary Table on page 5-11.

Closing Subtab

- **Close Date.** You can set an optional close date for processing input file records. Records that contain dates before or after this date are processed as described in How Accounting Dates Are Calculated on page 7-19. You can also set close dates for an individual process definition or definitions (see page 7-32 [for Windows] or page 8-26 [for UNIX or Linux]). If you set a close date for an individual process definition, it overrides the date that you set here.

Click one of the following:

- **No Close Date.** No close date is set.
- **Use Specific Date.** Enter a specific close date.
- **Use Day Of Month.** Type the day of the month that you want to set as the close date. For example, type 15 if you want a close date of the fifteenth of each month.
Setting Up the System
Configuring System Settings

Reporting Settings

Use the Paths, Options, and Invoice subtabs on the Reporting tab to set the report settings for ITUAM Web Reporting.

Note • You can also enter some of these settings on the Edit Configuration page in ITUAM Web Reporting.

Paths Subtab

- **Path to standard reports folder.** Enter the path for standard reports (maximum of 255 characters). Standard reports are those that are provided with ITUAM. In most cases, standard reports require customizing for your organization.

  It is recommended that you keep the Standard folder in the default location because standard reports may be updated or added with a new version or release of ITUAM.

- **Path to custom reports folder.** Enter the path for custom reports (maximum of 255 characters). Custom reports are those that your report developer creates either independently or from the standard reports provided with ITUAM. Custom and standard (if applicable) reports are available to users via the Reports or Spreadsheets page of ITUAM Web Reporting.

- **Path to published reports folder.** Enter the path for published reports (maximum of 255 characters). Published reports are reports that have been saved with the data that was generated at the time the reports were run. Publishing a report enables users to view a report without having to regenerate it.

  ITUAM provides a batch reporting feature that creates and distributes published reports. This feature includes the option of distributing reports via a UNC link in an e-mail message. If you want to use this option, you must type a UNC path in this box. For example, if you are using the default Published folder for published reports, the UNC path might be `\\servername\Published`.

  For more information about creating and distributing published reports in batch, see Working With Batch Reporting/Published Reports on page 5-23.

  Note • End user access to published reports is dependent on the share permissions described in Folder Permissions Required for Publishing and Viewing Batch Reports on page 5-48.
Options Subtab

- **Last Reporting Date.** Enter the last reporting date for reports that ITUAM Web Reporting users who do not have administrative privileges can view. For example, if you do not want non-administrator users to view reports for dates after March 2006, enter 03/31/2006. Users with administrative privileges can view reports for any date.

- **Rate Drilddown Report.** This setting is for future use.

- **Rate Group Drilldown Report.** This setting is for future use.

- **Report Script Timeout.** Enter the length of time in seconds that the ASP page will allow a script to generate a report before timing out. The default is 900 seconds (15 minutes). The minimum value for this setting is 600 seconds (10 minutes) and the maximum value is 2700 seconds (45 minutes).

  **Note** • IIS allows you to set the time-out value for ASP scripts. The value set for Report Script Timeout overrides the time set in IIS only for scripts that are generating reports. All other scripts use the time-out value set in IIS.

- **Currency Symbol.** The use of this box is user-specified. This box allows you to enter a currency symbol that you can use in custom reports (maximum of three characters).

- **Currency Description.** The use of this box is user-specified. This box allows you to enter a currency description that you can use in custom reports (maximum of 255 characters).

- **Use Report Access Security.** Select this check box to set access to reports by user group (see Adding or Removing Report Access to/from a Group on page 4-36). If this check box is not selected, users within a group can view all reports regardless of whether the report is allowed for the group.

- **Use only 1 Crystal Report License on drilldown reports.** This setting is deprecated. Leave this check box unselected.

- **Use PDF for Published Reports.** This option is required only if you are using Crystal Reports XI and you have not purchased the full Crystal Reports Server license. In this case, published reports cannot be viewed in Crystal Reports. If this check box is selected, reports are published as PDF files and Acrobat Reader rather than Crystal Reports is invoked when the file is viewed. Note that the group tree that is used for navigation in a report is not displayed in reports published as PDF files.

  This option is applicable only when reports are published from the ITUAM Web Reporting Web site. For information about publishing reports in batch, including how to set the report format for batch reports, see Working With Batch Reporting/ Published Reports on page 5-23.
### Invoice Subtab

- **Invoice Number Automation.** When this check box is selected, invoice numbers in ITUAM Web Reporting increase sequentially from the number set in the Invoice Number box.

  When this check box is selected, the parameter Invoice Number is not displayed as a report parameter in ITUAM Web Reporting. For more information about Web report parameters, refer to the *IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide*.

- **Invoice Number.** If the Invoice Number Automation check box is selected, use this box to set the number at which you want invoice numbers to begin. Invoice numbers increase in sequential order from this number. If the Invoice Number Automation check box is not selected, the invoice number entered as a report parameter in ITUAM Web Reporting is used.

### Database Settings

Use the Database tab to set the following:

- **Connection Timeout (seconds).** Type the maximum number of seconds (maximum of 9999) that a database may respond to a query before timing out. If this time period is exceeded, ITUAM Administrator assumes that the database server is not responding and returns an error message.

  If you accept the default (0), no time-out period is applied.

- **Database Load—Process Priority Class.** This setting determines the priority in which ITUAM processes are run (CIMSAcct, CIMSBill, database loads, etc.). Because these processes can use a large amount of CPU time, the default (Below Normal) is recommended. This priority allows other processes (for example, IIS and SQL Server tasks) to take precedence. Consult IBM before using a priority other than Below Normal.

*Note* • Below Normal will not cause processes to run longer if the system is idle. However, if other tasks are running, processes will take longer to run.
Web Settings

Use the General, User Logging, and Customization subtabs on the Web tab to set the Web site settings for ITUAM Web Reporting, including optional custom settings.

General Subtab

- **Session Timeout Minutes.** Enter the number of minutes of inactivity that are allowed before a ITUAM Web Reporting user is automatically logged off the system. The minimum is 1 minute and the maximum is 9999 minutes. The default is 60 minutes.

- **Display Account Code Selection to Level.** This setting determines the level of account codes that are displayed in the Starting Account Code and Ending Account Code parameter lists in ITUAM Web Reporting. For example, if you type 1, only the top level account codes are displayed. However, if you type 3, the first, second, and third level account codes are displayed. For more information, about using starting and ending account codes, refer to the *IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide.*

You can also enter this setting on the Edit Configuration page in ITUAM Web Reporting.

- **Crystal Report Viewer.** Click the Crystal viewer used for ITUAM Web Reporting. If you are using SQL Server Reporting Services for reporting, leave this box set to Default. You can also enter this setting on the Edit Configuration page in ITUAM Web Reporting.

**Note** • You can set different viewers for individual users. ITUAM Web Reporting uses the viewer set for the user if it differs from the viewer set here. To set this option for an individual user, see page 4-27.

You can choose the following:

- **Default.** The default is the HTML viewer.

- **ActiveX.** This option works only in Internet Explorer. This viewer has the following advantages and disadvantages:

  **Advantage:** This viewer provides more features than the HTML viewer provides.

  **Disadvantage:** This viewer requires that the Crystal Smart Viewer for ActiveX be installed on the user’s computer (see *Start ITUAM Web Reporting* on page 2-110). The user might not have the administrative privileges required to install and run the viewer.

- **Java using Browser JVM.** This option works in Netscape Navigator or Internet Explorer. This viewer requires the Java Virtual Machine. Because this viewer might be more difficult to set up, the use of the HTML or ActiveX viewer is recommended.
Setting Up the System

Configuring System Settings

- **HTML.** This option works in Internet Explorer or Netscape Navigator. This viewer has the following advantages and disadvantages:

  **Advantage:** This viewer works with any browser and does not require any additional files or set up.

  **Disadvantage:** This viewer provides fewer features than the ActiveX viewer provides.

- **Crystal Release.** Click the Crystal Reports release that you are using for Web reporting: 90, 10, or XI.

  Or


  For more information about the Report Server URL, see *Enter the Reporting Services Report Server URL* on page 2-98.

- **Port Number.** If SSL is not enabled for the ITUAM Web Reporting Web site and a port other than port 80 is used, type the port number.

- **Secure Port.** If SSL is enabled for the ITUAM Web Reporting Web site and a port other than port 443 is used, type the port number.

- **Site Localization ID (LCID):** If you want to use regional settings other than US English for ITUAM Web Reporting Web site, type the locale ID for the settings that you want to use. This must be one of the decimal values provided at `http://msdn.microsoft.com/library/en-us/script56/html/vsmsclcid.asp`. Do not use the short string or hex values.

- **Enable Intranet Auto Logon.** Select this check box to enable users to automatically log on to ITUAM Web Reporting and other ITUAM Web-based applications. This feature saves time for users and eliminates the need to maintain user passwords in the ITUAM database.

  To use this feature, the Windows domain name and user ID for the user must be entered in the User Maintenance dialog box (see page 4-27) and IIS security for the ITUAM Web Reporting Web site and any other ITUAM Web sites must be set to Integrated Windows authentication (see page 2-94).

- **Secure Login.** Select this check box if SSL is enabled for the ITUAM Web Reporting Web site. For more information about enabling SSL, see page 2-97.

- **Allow Password Change.** Select this check box to enable users to change their user password on the ITUAM Web Reporting Login page.

- **Display Account Name on Account Code drop downs.** Select this check box to display the account code description in the **Starting Account Code** and **Ending Account Code** parameter lists in ITUAM Web Reporting. If you do not select this check box, the account code description is not displayed with the account code.
Enable Client Dropdown Exact Length. When this check box is selected, only account codes of the level set in the Display Account Code Selection to Level box are displayed as parameters in ITUAM Web Reporting.

For example, assume that you have an account code of AABBBCCCC, where AA is level 1, AABBB is level 2, and AABBBCCCC is level 3. If Display Account Code Selection to Level is set to 3, only code AABBBCCCC is displayed in the Starting Account Code and Ending Account Code parameter lists in ITUAM Web Reporting.

Note that if you select this check box and you do not have clients defined in the CIMSClient table for the level set in Display Account Code Selection to Level, the parameter lists will contain no account codes.

User Logging Subtab

Log File. If you are logging the usage of ITUAM Web Reporting, enter the path for the log file.

Log IP Address To Skip. If you are logging the usage of ITUAM Web Reporting, type the IP address of any client that you do not want to track in the log file. If you enter only the first number or numbers of an address, any address that begins with the number(s) will not be shown in the log file. For example, if you enter 127.0.0, the addresses 127.0.0.0 and 127.0.0.1 are not included.

Require Company Name on login. When this check box is selected, the user must enter a company or organization name when logging on to ITUAM Web Reporting. A text box for the name is displayed on the Login page.
Customization Subtab

ITUAM enables you to create custom Web site settings for ITUAM Web Reporting. For example, you might want the Web site to conform to your corporate standards or to use a custom startup ASP page.

You can use the custom settings feature to select the cascading style sheets, images, background color, and menu alignment for the Web site.

To use custom Web site settings, you must first set up the appropriate folders and files in Windows.

In Windows:

1. Make sure that you have a Custom folder in C:\Program Files\IBM\ITUAM\Server\Web. (This is the default location. The location of the Web folder might differ on your system.) The Custom folder should contain an images folder. See example Figure 4-19.

2. Copy everything in Web\images to Web\Custom\images. (Click Yes to replace the existing topographic.gif file in Custom\images).

3. Copy the CIMS.css file from the Web folder to Web\Custom.

4. Customize the CIMS.css file in the Custom folder as needed.

5. Customize the images in Custom\images as needed.
6 In Web\Custom\images, replace the topgraphic.gif file with your own image. This is the image that is displayed at the top of all Web pages. The image must be named topgraphic.gif, but it can be in the GIF or JPEG format.

7 In the Custom folder, customize the default.asp page. This is the home page.

In ITUAM Administrator:

1 On the Web tab, click Custom in the Custom Site box. Edit the following:
   - **Background Color.** Type the hexadecimal number for the background color.
   - **CSS Location.** Type Custom\CIMS.css (do not add beginning or ending slashes).
   - **Image Location.** Type Custom\images (do not add beginning or ending slashes).
   - **Menu Vertical Start Position.** Enter the start position (in pixels) for the menu. The menu begins at the specified number of pixels from the top of the page. The number of pixels depends on the size of your topgraphic.gif image. To determine the number of pixels:
     - a Right-click the topgraphic.gif file, and then click Properties.
     - b Click the Summary tab to get the image height.

2 Click OK when you are finished.
Table Audit Settings

**Important!** Auditing a table can degrade the table’s performance because the audit feature uses SQL triggers. Do not use this feature for tables that you do not need to audit.

This feature is available only if you are using a SQL Server database.

Use the Auditing tab to audit changes to certain database tables. Auditing tracks changes that have been made to the data in the tables, including the Windows user ID of the person who made the change and the date and time that the change occurred.

**Note** Transaction audits might reflect the SQL Server login ID rather than the Windows user ID. For more information, see *Create User Logins for the Database* on page 2-61.

To audit tables, select the appropriate check boxes in the Select audit types area. Audit data for a table is stored in an additional table named CIMSAudit<audit type>. For example, the CIMSAuditRate table tracks changes to the CIMSRate table.

You can also view changes to the CIMSClient, CIMSRate, and CIMSTransaction tables via the following standard Web reports (Crystal Reports only):

- Client Audit Report (file name RACLX001.rpt)
- Rate Audit Report (file name RARTX001.rpt)
- Transaction Audit Report (file name RATRX001.rpt)

For more information about these reports, including examples, refer to the *IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide*.

**Note** You must add these reports to the reports list in the Report List Maintenance Dialog box and to a report group in the Report Group Maintenance Dialog box if the reports are not already present (see *Adding Reports to the Report List* on page 5-17 and *Defining Report Groups* on page 5-19).
Database Load Archive Settings

**Note**: These settings support the database load archive feature described in Archiving, Purging, and Restoring Database Loads on page 6-19.

Use the Archiving tab to set the archiving options for database loads. Archiving saves selected database loads in a format that you can reload (restore) into the database if the loads are purged.

- **Archive Path.** Enter the path for storing the archived database loads. The default path is `C:\Program Files\IBM\ITUAM\Admin\Archive\DSNname`, where `DSNname` is the name of the ITUAM Data Source selected in the Select ITUAM Data Source list. If you are using multiple databases with ITUAM, you should store the archived loads from each database in separate folders. The archived database loads are stored in a zip file and you cannot determine the data source by the zip file name.

- **Compression Type.** Click the compression type that you want to use for the archive files or None. The default, Deflate, is recommended; however, Deflate64 and BurrowsWheeler may be used for zip tools that support them.

- **Compression Level.** Move the slider to set the compression level. The compression level controls the amount of compression to be applied when compressing data. The greater the amount of compression applied, the greater the time it takes to perform the compression.
### Configuration Options

The Option List tab stores the following variables used by ITUAM for batch reporting. These variables should not be deleted or changed without consulting IBM.

- **BatchPortNumber**
- **BatchServerNode**
- **BatchVirtualDir**

The Option List tab also stores the following variables for use with Crystal Reports XI. These variables are set using the Configure BusinessObjects Enterprise Wizard (see Set Up Crystal Reports on page 2-105 for more information about using the wizard).

- **BOEnterpriseAuthenticationMethod**
- **BOEnterpriseFolderName**
- **BOEnterpriseServerName**
- **BOEnterpriseUserGroupName**
- **BOEnterpriseUserName**

You can use this tab to add optional configuration settings as documented in other sections in this guide and to add options for use in custom reports. IBM recommends that you consult technical support for assistance in adding configuration settings for custom reports.

**To add configuration options:**

1. Click **Add**.

2. In the Add New Configuration Option dialog box, enter the name for the new option (maximum of 80 characters), and then click **OK**. The Configuration Option Maintenance dialog box is displayed.

3. Enter the following information for the option:
   - **Description.** An optional description of the setting. Maximum of 80 characters.
   - **Value.** The value for the setting (e.g., a folder path or a flag value). Maximum of 255 characters.
   - **Data Type.** The data type for the value: String, Integer, Floating Point, or Date/Time.
This chapter describes how to use ITUAM Administrator to define and group the reports that are displayed on the ITUAM Web Reporting site. This chapter also describes how to generate and distribute published reports in batch mode.

**About ITUAM Reports** ................................................................. 5-3
Location of ITUAM Reports ......................................................... 5-3
Types of ITUAM Reports .............................................................. 5-4

**Tables Used for Reports** ............................................................. 5-5
CIMSSummary Table ................................................................. 5-5
CIMSDetail Table ................................................................. 5-6
CIMSIdentTable and CIMSDetailIdent Tables ................................. 5-9

**Defining Decimal Positions for Unit, Rate, and Money Values in Reports** .............. 5-10
Defining Decimal Positions for Money Values in the CIMSSummary Table ............ 5-11

**Customizing Report Parameters (Optional)** .................................. 5-14
Creating Custom Parameters for Web Reports .................................. 5-14
Creating Custom Parameters for Batch Reports Only ............................. 5-16
Saving Custom Parameters ......................................................... 5-16

**Adding Reports to the Report List** ............................................. 5-17

**Defining Report Groups** ............................................................. 5-19

**Changing the Logo in Reports** .................................................. 5-22
<table>
<thead>
<tr>
<th>Report Administration</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Working With Batch Reporting/Published Reports</strong></th>
<th>5-23</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating Published Reports</td>
<td>5-23</td>
</tr>
<tr>
<td>Distributing Published Reports</td>
<td>5-24</td>
</tr>
<tr>
<td>Storing Published Reports Using the Published Folder Structure</td>
<td>5-25</td>
</tr>
<tr>
<td>Deleting Published Reports</td>
<td>5-26</td>
</tr>
<tr>
<td>Creating a Report Cycle</td>
<td>5-27</td>
</tr>
<tr>
<td>Running a Report Cycle</td>
<td>5-44</td>
</tr>
<tr>
<td>Folder Permissions Required for Publishing and Viewing Batch Reports</td>
<td>5-48</td>
</tr>
<tr>
<td>Creating a Virtual Directory for the Published Folder</td>
<td>5-49</td>
</tr>
<tr>
<td>Drilling Down in Published Reports</td>
<td>5-50</td>
</tr>
</tbody>
</table>
About ITUAM Reports

ITUAM processes data contained in an input CSR or CSR+ file and produces Ident, Detail, and Summary files. The data in these files is loaded into the CIMSSummary, CIMSDetail, CIMSDetailIdent, and CIMSSIdent tables in the ITUAM database. The data in these tables is then used for reporting. For more information, see Tables Used for Reports on page 5-5.

ITUAM includes a variety of standard reports that can be used “as is” or can be customized for your organization. For a description of each of the standard reports, refer to the IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide.

This section describes the folder hierarchy for storing ITUAM reports and describes the types or reports available.

Location of ITUAM Reports

If ITUAM is installed in the default location, reports are located in the following folders. Each of these folders contains the subfolders Standard, Custom, and Published. For example, ReportsMSRS\Standard, ReportsMSRS\Custom, and ReportsMSRS\Published.

Crystal Reports

- ../ReportsORADB2 (contains Crystal reports for Oracle and DB2)
- ../ReportsSQL (contains Crystal reports for SQL Server)

SQL Server Reporting Services Reports

- C:\Program Files\IBM\ITUAM\Server\ReportsMSRS

Note • SQL Server Reporting Services is not available for MSDE.

How ITUAM Determines the Report Folder to Use

During database initialization, ITUAM determines the default folder to be used for reporting based on the following:

- If you selected Crystal Reports 9, 10, or XI, the type of database determines the default folder (e.g., if the database selected for initialization is a SQL Server database, the default reports folder is ReportsSQL).

- If you selected SQL Server Reporting Services, the ReportsMSRS folder is used.

If you move the report folder to another location or move the Standard, Custom, or Published subfolders, you must change the paths on the Reporting tab in the Configuration dialog box (see Reporting Settings on page 4-44).
Types of ITUAM Reports

There are four types of reports available with ITUAM:

- **Standard or Custom Reports.** ITUAM includes a variety of standard Crystal and SQL Server Reporting Services reports. These standard reports include invoice, budget, summary, trend, and variance reports in report, graph, and spreadsheet format. Standard reports are available as .rpt files for Crystal Reports and .rdl files for SQL Server Reporting Services.

  Standard Crystal and Reporting Services reports are stored in the 'Reports<database type>\Standard' folder and the 'ReportsMSRS\Standard' folder, respectively. For a description of each of the standard reports, refer to the *IBM Tivoli Usage and Accounting Manager Web Reporting User's Guide*.

  Typically, your report developer will customize the ITUAM standard reports for your organization or will create new reports. The ITUAM installation includes a default 'Reports<database type>\Custom' or 'ReportsMSRS\Custom' folder that you can use to store these custom reports.

  If a report of the same name is in both the Standard and Custom folder, ITUAM will use the report in the Custom folder.

  Once you have the standard and custom reports in the appropriate folders, you must specify which of the reports that you want to use with ITUAM (see *Adding Reports to the Report List* on page 5-17 and *Defining Report Groups* on page 5-19). Users can then run these reports from the ITUAM Web Reporting Web site.

- **ITUAM Web User Created Reports.** Web reporting end users create these reports directly within the ITUAM Web Reporting Web site using report templates that are supplied with ITUAM or developed by your Crystal Reports developer. These templates are stored in the 'Standard\Templates' folder. For more information about these reports, refer to the *IBM Tivoli Usage and Accounting Manager Web Reporting User's Guide*.

  By default, Web user-created reports are placed in the Custom or Custom Spreadsheets report groups. However, you can use ITUAM Administrator to define any report group as the default group for user-created reports (see *To set the default group for reports created by ITUAM Web users*: on page 5-21).

- **Published Reports.** Published reports are standard or custom reports that have been saved with the data that was generated at the time the reports were run. Publishing a report enables users to view a report without having to regenerate it. Published reports are stored in the 'Published' folder that is defined in the Configuration dialog box.

  Users can publish reports from the ITUAM Web Reporting Web site or you can use ITUAM Administrator and batch reporting scripts to automatically generate and publish reports. For more information about generating and publishing reports in batch, see *Working With Batch Reporting/Published Reports* on page 5-23.
Tables Used for Reports

ITUAM processes data contained in an input CSR or CSR+ file and loads the data into the tables described in this section.

CIMSSummary Table

All reports that include money values use the CIMSSummary table. The CIMSSummary table contains summarized resource units, rate, and money values for the lowest level of the account code by rate code/date range. That is, if there are multiple records in the CSR/CSR+ file for the same account code, date range, and rate code, the values in the records are aggregated together.

Example CIMSSummary Table Data

Assume that the following are the lowest level account codes that appear in the CIMSSummary table:

- AABBBCCC
- AAEEEFFF

The CIMSSummary table might contain the following data:

<table>
<thead>
<tr>
<th>AccountCode</th>
<th>RateCode</th>
<th>StartDate</th>
<th>EndDate</th>
<th>Resource Units</th>
<th>Rate Value</th>
<th>Money Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AABBBCCC</td>
<td>LLG104</td>
<td>7/01/2005</td>
<td>7/01/2005</td>
<td>1.247</td>
<td>0.01</td>
<td>0.01</td>
</tr>
<tr>
<td>AABBBCCC</td>
<td>LLG105</td>
<td>7/01/2005</td>
<td>7/01/2005</td>
<td>2.940</td>
<td>0.018</td>
<td>0.05</td>
</tr>
<tr>
<td>AAEEEFFF</td>
<td>LLG104</td>
<td>7/01/2005</td>
<td>7/01/2005</td>
<td>1.182</td>
<td>0.01</td>
<td>0.01</td>
</tr>
<tr>
<td>AAEEEFFF</td>
<td>LLG105</td>
<td>7/01/2005</td>
<td>7/01/2005</td>
<td>0.759</td>
<td>0.018</td>
<td>0.01</td>
</tr>
<tr>
<td>AABBBCCC</td>
<td>LLG104</td>
<td>7/02/2005</td>
<td>7/02/2005</td>
<td>1.984</td>
<td>0.01</td>
<td>0.02</td>
</tr>
<tr>
<td>AABBBCCC</td>
<td>LLG105</td>
<td>7/02/2005</td>
<td>7/02/2005</td>
<td>1.201</td>
<td>0.018</td>
<td>0.01</td>
</tr>
<tr>
<td>AAEEEFFF</td>
<td>LLG104</td>
<td>7/02/2005</td>
<td>7/02/2005</td>
<td>3.084</td>
<td>0.01</td>
<td>0.03</td>
</tr>
<tr>
<td>AAEEEFFF</td>
<td>LLG105</td>
<td>7/02/2005</td>
<td>7/02/2005</td>
<td>1.199</td>
<td>0.018</td>
<td>0.02</td>
</tr>
<tr>
<td>AABBBCCC</td>
<td>LLG104</td>
<td>7/03/2005</td>
<td>7/03/2005</td>
<td>1.083</td>
<td>0.01</td>
<td>0.01</td>
</tr>
<tr>
<td>AABBBCCC</td>
<td>LLG105</td>
<td>7/03/2005</td>
<td>7/03/2005</td>
<td>2.162</td>
<td>0.018</td>
<td>0.04</td>
</tr>
<tr>
<td>AAEEEFFF</td>
<td>LLG104</td>
<td>7/03/2005</td>
<td>7/03/2005</td>
<td>0.014</td>
<td>0.01</td>
<td>0.00</td>
</tr>
<tr>
<td>AAEEEFFF</td>
<td>LLG105</td>
<td>7/03/2005</td>
<td>7/03/2005</td>
<td>0.875</td>
<td>0.018</td>
<td>0.02</td>
</tr>
</tbody>
</table>

Note that the CIMSSummary table contains fields other than those shown. For a description of the fields in the CIMSSummary table, see page A-39.
To run a report, the user must specify the account code level and date for the data that will appear in the report. Data aggregation is performed in the report from the lowest to the highest account code level for the specified date range.

For example, assume that the highest level account code for account codes AABBBCCC and AAEEEFFF is AA. The second level account code is AABBB or AAEEE. If the report is run with a date range of 7/01/2005 to 7/03/2005 for the second level account code, the following aggregated data appears in the report:

<table>
<thead>
<tr>
<th>AccountCode</th>
<th>RateCode</th>
<th>StartDate</th>
<th>EndDate</th>
<th>Resource Units</th>
<th>Rate Value</th>
<th>Money Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AABBB</td>
<td>LLG104</td>
<td>7/01/2005</td>
<td>7/03/2005</td>
<td>4.314</td>
<td>0.01</td>
<td>0.04</td>
</tr>
<tr>
<td>AABBB</td>
<td>LLG105</td>
<td>7/01/2005</td>
<td>7/03/2005</td>
<td>6.303</td>
<td>0.018</td>
<td>0.11</td>
</tr>
<tr>
<td>AAEEE</td>
<td>LLG104</td>
<td>7/01/2005</td>
<td>7/03/2005</td>
<td>4.28</td>
<td>0.01</td>
<td>0.04</td>
</tr>
<tr>
<td>AAEEE</td>
<td>LLG105</td>
<td>7/01/2005</td>
<td>7/03/2005</td>
<td>2.833</td>
<td>0.018</td>
<td>0.05</td>
</tr>
</tbody>
</table>

In this example, the resource units for July 1 through July 3 are aggregated by account code/rate code.

**CIMSDetail Table**

Some reports use the CIMSDetail table rather than the CIMSSummary table. These reports do not include money values, which are not included in the CIMSDetail table. In addition, the drill down reports IINXC001.rpt through IINXC007.rpt (which are invoked from a main report) use the CIMSDetail table.

The CIMSDetail stores resource data in the most detailed level. Each record in this table corresponds to a specific record in the input CSR or CSR+ file and contains a single rate code and its resource units from that record. For example, if one input CSR/CSR+ contains the rate codes LLG104 and LLG105, a separate record is created for each rate code in the CIMSDetail table.

Each record in the CIMSDetail table identifies the number of the original CSR or CSR+ record from which the rate code and resource units were taken (i.e., 1 if it is the first record, 2 if it is the second record, etc.). This number is used to associate the rate codes from the input CSR/CSR+ records with identifiers that are in the input records. The identifier values from the input records are stored in the CIMSDetailIdent table.
Example CIMSDetail Table Data

Using the same account codes, rate codes, and date ranges shown in the CIMSSummary table example on page 5-5, the CIMSDetail might contain the following data. As with the CIMSSummary table, the account codes in the CIMSDetail table are always the lowest level account code.

<table>
<thead>
<tr>
<th>DetailLine</th>
<th>AccountCode</th>
<th>RateCode</th>
<th>StartDate</th>
<th>EndDate</th>
<th>Resource Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>AABBBCCC</td>
<td>LLG104</td>
<td>7/01/2005</td>
<td>7/01/2005</td>
<td>0.599</td>
</tr>
<tr>
<td>2</td>
<td>AABBBCCC</td>
<td>LLG104</td>
<td>7/01/2005</td>
<td>7/01/2005</td>
<td>0.233</td>
</tr>
<tr>
<td>3</td>
<td>AABBBCCC</td>
<td>LLG104</td>
<td>7/01/2005</td>
<td>7/01/2005</td>
<td>0.415</td>
</tr>
<tr>
<td>4</td>
<td>AAEEEFFF</td>
<td>LLG104</td>
<td>7/01/2005</td>
<td>7/01/2005</td>
<td>1.003</td>
</tr>
<tr>
<td>5</td>
<td>AAEEEFFF</td>
<td>LLG104</td>
<td>7/01/2005</td>
<td>7/01/2005</td>
<td>0.179</td>
</tr>
</tbody>
</table>

Comparing this example to the CIMSSummary table example on page 5-5, the CIMSDetail record contains multiple records for the same rate code, rate code, and date range, while the CIMSSummary table contains one record with an aggregated resource units value.

Note that CIMSDetail table contains fields other than those shown. For a description of the fields in the CIMSDetail table, see page A-22.
Drilling Down on Resource Units by Identifier

You can drill down on resource values in a report to view a second report that shows the resources by broken down by specified identifier values such system ID, work ID, user name, server name, etc. For example, the following CSR records for the same date range contain the same identifier names and rate codes, but different identifier values:

```
Exchange,20050916,20050916,01:00:47,01:00:47,,1,User."joe",1,EXEMRCV,1
Exchange,20050916,20050916,01:00:47,01:00:47,,1,User."mary",1,EXEMRCV,2
```

In this example, an aggregated resource units value of 3 appears in reports for rate code EXEMRCV. However, you could drill down to view the units by identifier values broken down by joe and mary.

The number in the DetailLine column of the CIMSDetail table indicates the record in the CSR or CSR+ file from which the data was taken. Record numbers are also specified in the CIMSDetailIdent table which contains identifier values. ITUAM uses the record numbers in the CIMSDetail and CIMSDetailIdent tables to determine which identifier values are associated with the resource units.

For more information about drill down reports, including examples, refer to the *IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide*. 
CIMSIdentTable and CIMSDetailIdent Tables

The CIMSIdent table contains the identifier names from the input CSR or CSR+ file records. The CIMSDetailIdent table contains the identifier values associated with the identifier names in the CIMSIdent table.

Example CIMSIdent and CIMSDetailIdent Table Data

In this example, the identifier SYSTEM_ID and USERNAME are stored in CIMSIdent table. These identifiers are represented by the numbers 1 and 2, respectively.

CIMSIdent Table

<table>
<thead>
<tr>
<th>IdentNumber</th>
<th>IdentName</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SYSTEM_ID</td>
</tr>
<tr>
<td>2</td>
<td>USERNAME</td>
</tr>
</tbody>
</table>

The identifier values that appear in the CSR or CSR+ records for SYSTEM_ID and USERNAME are stored in the CIMSDetailIdent table. The number in the DetailLine column identifies the number of the original CSR or CSR+ record from which the identifier value was taken (i.e., 1 if it is the first record, 2 if it is the second record, etc.). The value in the IdentNumber column correlates to the IdentNumber in the CIMSIdent table.

CIMSDetailIdent Table

<table>
<thead>
<tr>
<th>DetailLine</th>
<th>IdentNumber</th>
<th>IdentValue</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>zeus</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>root</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>zeus</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>cims</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>zeus</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>cims</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>athena</td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>adm</td>
</tr>
<tr>
<td>5</td>
<td>1</td>
<td>athena</td>
</tr>
<tr>
<td>5</td>
<td>2</td>
<td>webadm</td>
</tr>
</tbody>
</table>

Note that CIMSDetailIdent and CIMSIdent tables contain fields other than those shown. For a description of the fields in these tables, see page A-23 and page A-24.
Defining Decimal Positions for Unit, Rate, and Money Values in Reports

Most reports use the CIMSSummary table, which includes resource unit, rate, and money values. Other reports and all drill down reports use the CIMSDetail table, which include rate or money values. The number of decimal digits shown for the unit, rate, and money values in reports may or may not match the number shown in the originating table depending on the rate code and configuration settings as follows:

- **Units and rate values.** The number of unit and rate decimal digits that appear in reports are set by rate code. The decimal digits for units can be 0–5. The decimal digits for rate values can be 4 or 8. To set the unit and rate decimal digits for a rate code, see Defining Rate Codes on page 4-9.

- **Money values.** Money values in reports always contain two decimal digits. However, the number of decimal digits that are included in the money value in the CIMSSummary table can be 0–6 positions. For more information, see Defining Decimal Positions for Money Values in the CIMSSummary Table on page 5-11.

In the following report example, the decimal digits set for the unit values in the Units column and rate values in the Rate column are two and four, respectively. The Charge column contains money values, which are always shown with two decimal digits.

<table>
<thead>
<tr>
<th>Units</th>
<th>Rate</th>
<th>Charge</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit Process Block I/O (1,000x)</td>
<td>2</td>
<td>0.1000 /M 0.20</td>
</tr>
<tr>
<td>Unit Process Character I/O (100,000x)</td>
<td>33,102</td>
<td>0.0020 /M 0.19</td>
</tr>
<tr>
<td>Unit Process Image Time (Hours)</td>
<td>5,780.92</td>
<td>0.0000 0.00</td>
</tr>
<tr>
<td>Unit Process User CPU (Minutes)</td>
<td>156.60</td>
<td>0.0100 1.57</td>
</tr>
<tr>
<td>Unit Process System CPU (Minutes)</td>
<td>44.50</td>
<td>0.0130 0.74</td>
</tr>
<tr>
<td>Unit Process Total CPU (Minutes)</td>
<td>201.10</td>
<td>0.0300 6.02</td>
</tr>
<tr>
<td>Unit Process Memory (Mb Days)</td>
<td>332,795.35</td>
<td>0.0006 /M 0.26</td>
</tr>
<tr>
<td>Unit Process Image Count</td>
<td>33,489</td>
<td>0.0200 /M 0.62</td>
</tr>
</tbody>
</table>

Figure 5-1 • Example Report 1
Defining Decimal Positions for Money Values in the CIMSSummary Table

As described in the previous section, money values in ITUAM standard reports always contain two decimal positions. However, you can define the number of decimal positions (0–6) that appear in the money value in the CIMSSummary table. To set the decimal positions for the money value that appears in the CIMSSummary table, see Processing Settings on page 4-43.

Note: For the advantage and disadvantage of using a greater number of decimal positions for money values in the CIMSSummary table, see page 5-13.

Example Using Four Decimal Digits

Looking at Figure 5-1 on page 5-10, note that many of the money values do not match the corresponding units multiplied by rate. For example, the units for rate code Unix Process System CPU (Minutes) are 44.50 and the rate is .0180. If you multiply the units by the rate code, the sum is .801 (which would be rounded to .80). However, .74 appears as the sum in the report.

This discrepancy is due to the rounding that occurs in the CIMSSummary table for money values. In Figure 5-1, the money values in the CIMSSummary table were rounded to two decimal digits. If the decimal digits in the money values had been set to four in the CIMSSummary table, the report would appear as shown in Figure 5-2.

![Figure 5-2](image)

The charges for each rate code in the report now match the units multiplied by the rates. Assume that the charges for each rate code represent the total for all of the days in June. Using the rate code Unix Process System CPU as an example, Table 5-1 shows the difference between the money calculations using two digits and four digits.

<table>
<thead>
<tr>
<th>Date</th>
<th>Units</th>
<th>Rate</th>
<th>Money Value 2 Dec. Digits</th>
<th>Money Value 4 Dec. Digits</th>
</tr>
</thead>
<tbody>
<tr>
<td>6/1</td>
<td>1.295</td>
<td>0.018</td>
<td>0.02</td>
<td>0.0233</td>
</tr>
<tr>
<td>6/2</td>
<td>1.316</td>
<td>0.018</td>
<td>0.02</td>
<td>0.0237</td>
</tr>
<tr>
<td>6/3</td>
<td>1.323</td>
<td>0.018</td>
<td>0.02</td>
<td>0.0238</td>
</tr>
<tr>
<td>6/4</td>
<td>2.182</td>
<td>0.018</td>
<td>0.04</td>
<td>0.0393</td>
</tr>
<tr>
<td>6/5</td>
<td>2.117</td>
<td>0.018</td>
<td>0.04</td>
<td>0.0381</td>
</tr>
</tbody>
</table>

Table 5-1 • Money Value Calculation Example
### Table 5-1  Money Value Calculation Example (Continued)

<table>
<thead>
<tr>
<th>Date</th>
<th>Units</th>
<th>Rate</th>
<th>Money Value 2 Dec. Digits</th>
<th>Money Value 4 Dec. Digits</th>
</tr>
</thead>
<tbody>
<tr>
<td>6/6</td>
<td>1.575</td>
<td>0.018</td>
<td>0.03</td>
<td>0.0284</td>
</tr>
<tr>
<td>6/7</td>
<td>2.934</td>
<td>0.018</td>
<td>0.05</td>
<td>0.0528</td>
</tr>
<tr>
<td>6/8</td>
<td>2.899</td>
<td>0.018</td>
<td>0.05</td>
<td>0.0522</td>
</tr>
<tr>
<td>6/9</td>
<td>2.923</td>
<td>0.018</td>
<td>0.05</td>
<td>0.0526</td>
</tr>
<tr>
<td>6/10</td>
<td>1.887</td>
<td>0.018</td>
<td>0.03</td>
<td>0.0340</td>
</tr>
<tr>
<td>6/11</td>
<td>0.665</td>
<td>0.018</td>
<td>0.01</td>
<td>0.0120</td>
</tr>
<tr>
<td>6/12</td>
<td>0.581</td>
<td>0.018</td>
<td>0.01</td>
<td>0.0105</td>
</tr>
<tr>
<td>6/13</td>
<td>2.076</td>
<td>0.018</td>
<td>0.04</td>
<td>0.0374</td>
</tr>
<tr>
<td>6/14</td>
<td>1.352</td>
<td>0.018</td>
<td>0.02</td>
<td>0.0243</td>
</tr>
<tr>
<td>6/15</td>
<td>1.636</td>
<td>0.018</td>
<td>0.03</td>
<td>0.0294</td>
</tr>
<tr>
<td>6/16</td>
<td>1.413</td>
<td>0.018</td>
<td>0.03</td>
<td>0.0254</td>
</tr>
<tr>
<td>6/17</td>
<td>1.317</td>
<td>0.018</td>
<td>0.02</td>
<td>0.0237</td>
</tr>
<tr>
<td>6/18</td>
<td>0.691</td>
<td>0.018</td>
<td>0.01</td>
<td>0.0124</td>
</tr>
<tr>
<td>6/19</td>
<td>0.567</td>
<td>0.018</td>
<td>0.01</td>
<td>0.0102</td>
</tr>
<tr>
<td>6/20</td>
<td>1.572</td>
<td>0.018</td>
<td>0.03</td>
<td>0.0283</td>
</tr>
<tr>
<td>6/21</td>
<td>1.339</td>
<td>0.018</td>
<td>0.02</td>
<td>0.0241</td>
</tr>
<tr>
<td>6/22</td>
<td>1.313</td>
<td>0.018</td>
<td>0.02</td>
<td>0.0236</td>
</tr>
<tr>
<td>6/23</td>
<td>1.302</td>
<td>0.018</td>
<td>0.02</td>
<td>0.0234</td>
</tr>
<tr>
<td>6/24</td>
<td>1.350</td>
<td>0.018</td>
<td>0.02</td>
<td>0.0243</td>
</tr>
<tr>
<td>6/25</td>
<td>0.692</td>
<td>0.018</td>
<td>0.01</td>
<td>0.0125</td>
</tr>
<tr>
<td>6/26</td>
<td>0.575</td>
<td>0.018</td>
<td>0.01</td>
<td>0.0104</td>
</tr>
<tr>
<td>6/27</td>
<td>1.578</td>
<td>0.018</td>
<td>0.01</td>
<td>0.0284</td>
</tr>
<tr>
<td>6/28</td>
<td>1.365</td>
<td>0.018</td>
<td>0.03</td>
<td>0.0246</td>
</tr>
<tr>
<td>6/29</td>
<td>1.326</td>
<td>0.018</td>
<td>0.02</td>
<td>0.0239</td>
</tr>
<tr>
<td>6/30</td>
<td>1.336</td>
<td>0.018</td>
<td>0.02</td>
<td>0.0240</td>
</tr>
</tbody>
</table>

**Totals**: 44.497 0.74 0.801
Advantage and Disadvantage of Setting a Greater Number of Decimal Digits for Money Values

The following are the advantage and disadvantage of changing the number of decimal digits for money values from the default setting (2 digits) to a greater number of digits.

**Advantage**
- A greater number of decimal digits in the money values ensures that the charges in reports match the units multiplied by the rate on a line-by-line basis. Usually four decimal digits are sufficient.

  Compare Figure 5-1 on page 5-10 to Figure 5-2 on page 5-11 for an example of the same report using money values with two underlying decimal digits vs. four underlying decimal digits.

**Disadvantage**
- There is a possibility of a plus or minus one cent difference between totals in the reports for an account across account levels. For example, the total for account code AA might be 4309.33, but the total money value for account code AABBB might equal 4309.34. There is also the possibility of the same difference between the sum of individual charges shown in a report and the total for those charges. This is because total charges are calculated from the four decimal digit money values in the CIMSSummary table, not from the two digit money values in the report. For example, the total charge in the report in Figure 5-2 appears as 9.42. However, if you add the money values that appear in the report, the total is 9.43.

  If the CIMSSummary table contains two or fewer decimal digits, total charges will always match the sum of the money values within a report and charges will match across account code levels. Two decimal digits are set as the default because accuracy across account levels is usually more important than accuracy across the individual lines of a report.

  If you want to see the difference that the decimal digits setting makes in the money value, run a report for a single day of data at the lowest account level. In this situation, there are no differences in the money value on a line-by-line basis or in total charge values, regardless of the number of decimal digits that you have set. Then run the report for a month of data and compare the differences.
Customizing Report Parameters (Optional)

The ITUAM standard reports include parameter field names that correlate to ASP.NET .ascx files (user controls). If you installed ITUAM in the default location, these user controls are in C:\Program Files\IBM\ITUAM\Server\Web\CIMSReporting\CIMSParameters\CIMSComponents\Standard.

If you want to use parameters other than the default parameters provided with ITUAM, create parameter fields in your reports and user controls in the CIMSComponents\Custom folder. The process for creating custom parameters differs depending on whether your organization generates reports from the ITUAM Web Reporting Web site or generates reports in batch only.

You can also customize the standard user controls for the parameters provided with ITUAM. However, the ability to customize is limited to changing presentation logic.

Creating Custom Parameters for Web Reports

Creating Parameters Using ITUAM Templates

To create custom parameters used by reports that run from the Web site, modify the paramTemplate.ascx user control and paramTemplate.ascx.cs source file in the Custom folder. For assistance with modifying these files, contact IBM Software Support.

When you modify the user control and source file, all of the following must match:

- The file name of the user control and source file.
- The parameter field name defined in the report.
- The control name for the parameter within the user control.

For example, if the user control and source files are paramABC.ascx and paramABC.ascx.cs, the parameter field name in the report must be ABC (or @ABC if the parameter is not used in a stored procedure), and the control name must be "ABC".

You should save custom parameter files in the Custom subfolder on the ITUAM application server (see Saving Custom Parameters on page 5-16).

Note • If parameter files of the same name are in both the Standard and Custom parameter folder, the parameter files in the Custom folder are used.
Creating Parameters Using Parameter Fields (Crystal Reports Only)

You can also use parameter fields to create parameters within a report. To add parameter fields:

1. Open the report in Crystal Reports, and then click Insert Field Object.

2. Right-click Parameter Fields, and then click New.

3. In the Create Parameter Field dialog box, type the name of the field.

4. In the Prompting text box, type one of the following:
   - LEN= This creates a text box with the specified maximum character length on the report parameters page in ITUAM Web Reporting. For example, LEN=6 limits the maximum characters that can be typed in the box to six.
   - YorN This creates a Y/N select box on the report parameters page in ITUAM Web Reporting.

5. In the Value type box, leave the value at String (the default).

6. Click OK to save the parameter field.

Note: You can set options in the Options area of the Create Parameter Field dialog box. However, these options are not used by ITUAM Web Reporting. Refer to your Crystal Reports documentation for more information about these options.
Creating Custom Parameters for Batch Reports Only

If you are distributing reports in batch mode only, the .ascx and .ascx.cs files required for Web reports are not needed. To use custom parameters with batch reports, do the following:

1. Create a blank .txt file with the same name as the parameter field name in the report.

2. Save the file in the CIMSParameters/CIMSComponents/PlaceHolders/Show folder on the ITUAM application server (see Saving Custom Parameters on page 5-16).

For example, if the parameter field name is paramAAADate, create an empty file named paramAAADate.txt in the Show folder as shown example Figure 5-3.

Note • The Show folder contains default parameter files used by some standard reports when the reports are run in batch mode only. All of these files are empty and are used only when reports are run in batch.

Saving Custom Parameters

If the ITUAM application server and the Web server are on separate servers, make sure that you save custom parameter files in the Custom or Show folder (as applicable) on the application server. The files are not read from the Web server.
Adding Reports to the Report List

The report list in conjunction with the reports assigned to the user groups (see Defining User Groups on page 4-32) determines the reports that users can access from the ITUAM Web Reporting Web site. You must add a report to this list before it can be assigned to a user group and be displayed on the Web site.

By default, the report list contains ITUAM standard reports (either Crystal or SQL Server Reporting Services reports). If you are using custom reports, you can remove the standard reports from the list (see To remove a report: on page 5-18). If a standard report is in a report group, you must first remove the report from the group (see To remove a report from a report group: on page 5-20).

To add a report:

1. In the ITUAM Administrator main window, click System Administration ▶ Reporting ▶ Reports.

The Reports List Maintenance dialog box is displayed as shown in example Figure 5-4.

---

**Note** • Reports in the Report List Maintenance dialog box are sorted by ID number. To sort the reports by name or description, click the appropriate column header. To reverse the sort order, click the column header again.

---

![Figure 5-4 • Reports List Maintenance Dialog Box](image-url)
2 Click Add.

3 In the Add New Report dialog box, enter the name of the report (e.g., Cost Variance), and then click OK. Maximum of 32 characters.

The Report Maintenance dialog box is displayed.

4 Enter the report settings as follows:
   - **Name.** Use this box to change the name of the report.
   - **File Name.** The name of the report file without the path (maximum of 255 characters). To browse for a report file, click the Browse button.
   - **Template File Name.** Consult IBM before using this option.
   - **Description.** Enter a description of the report. Maximum of 255 characters.

5 Click OK when you are finished.

If you added a SQL Server Reporting Services report, the report is automatically deployed to the Reporting Services Report Server. If you added a Crystal report and are using Crystal Reports XI, the report is automatically deployed to Crystal Reports Server.

An example of a configured Report Maintenance dialog box is shown in Figure 5-5.

![Figure 5-5 • Report Maintenance Dialog Box](image)

**To edit the settings for a report:**

1 Click the report, and then click **Edit**.

The Report Maintenance dialog box is displayed.

2 Follow the steps in **To add a report:** beginning with **Step 4**.

**To remove a report:**

Click the report, and then click **Remove**. If the report is in a report group or a report cycle, you must first remove the report from the group or cycle (see **Defining Report Groups** on page 5-19 and **Creating a Report Cycle** on page 5-27).

If you are using Crystal XI for reporting, the report is automatically removed from Crystal Reports Server.
Defining Report Groups

**Tip** - When working with report groups, you can access commands for an item from the menu bar, or you can access the same commands by right-clicking the item.

Report groups are useful in ITUAM Web Reporting because they allow you to categorize related reports in a single group. For example, you might create groups by report type (e.g., invoice, variance, account) or by data type (e.g., Mainframe, UNIX, Windows).

There are two types of report groups:

- **Start Groups**. These are the larger groups that contain other groups.
- **Groups**. These are the standard report groups that are contained in a Start Group. Groups contain reports.

There are three default Start Groups: Reports, Graphs, and Spreadsheets. Although you can add other Start Groups, only the default groups is displayed on the ITUAM Web Reporting Web site. To use Start Groups other than the default groups, you must create a customized Web site.

The default Start Groups (Reports, Graphs, and Spreadsheets) are required for ITUAM Web Reporting and must be ordered 1, 2, and 3 as shown Figure 5-6. Do not remove, rename, or reorder these groups.

**To add a report group:**

1. In the ITUAM Administrator main window, click **System Administration** ➤ **Reporting** ➤ **Report Groups**. The Report Group Maintenance dialog box is displayed as shown in example Figure 5-6.

![Report Group Maintenance Dialog Box](image)
Report Administration

Defining Report Groups

2 Do one of the following:

- To add a Start Group, click Group ▶ Add Start Group on the menu bar. In the Add Start Group dialog box, enter the name of the Start Group, and then click OK.

- To add a group to a Start Group, click the Start Group, and then click Group ▶ Add Group on the menu bar. In the Add Group dialog box, enter the name of the group, and then click OK.

To add a report to a report group:

1 To add a report to a report group, click the group, and then click Group ▶ Add Report on the menu bar. Note that you cannot add a report to a Start Group.

   The Select Report dialog box is displayed.

2 Choose the report or reports that you want to add, and then click OK.

To view the reports that you added, double-click the group.

Note • Report groups that do not contain at least one report will not be displayed on the Reports page on the ITUAM Web Reporting Web site.

To remove a report from a report group:

Click the report, and then click Report ▶ Remove Report from Group on the menu bar.

Note • Removing a report deletes the report from the report group, not from the system.

To remove a report group:

Click the group, and then click Group ▶ Remove Group on the menu bar. If the report group contains groups or reports, you must delete the groups and reports before you can delete the group.

Other Report Group Options

Once you have created a report group, you can:

- Rename the group or change its description.
- Re-sort the group or report display order.
- Make a group the default group for reports created by ITUAM Web users.

To rename a report group or change its description:

1 Click the group, and then click Group ▶ Change Group Name or Change Group Description on the menu bar.

2 In the Change Group Name/Description dialog, box enter the new name or description. Note that the description is the same as the group name by default.
To re-sort the group or report display order:

1 Click the group that contains the groups or reports that you want to re-sort, and then click Group ▶ Change Group Display Order or Change Report Display Order on the menu bar.

   The Report Group/Report Display Sequence dialog box is displayed.

2 Click a group/report, and then click the up or down arrow to reposition the item.

3 Click OK when you are finished.

To set the default group for reports created by ITUAM Web users:

In ITUAM Web Reporting, end users can create reports using the standard templates provided with ITUAM or custom templates developed by your Crystal Reports developer. For more information about these reports and descriptions of the standard templates, refer to the IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide.

To make a group the default group for reports or spreadsheets created by end users, click the group, and then click Group ▶ Default Report/Spreadsheet Group on the menu bar. The default group is shown in bold and is designated by *Reports/Spreadsheet Default in the lower right corner of the Report Group Maintenance dialog box.

The user-defined reports or spreadsheets are displayed in the group selected as the default group on the Reports or Spreadsheets page of the ITUAM Web Reporting Web site.

The default group for user-defined reports is Custom and the default group for user-defined spreadsheets is Custom Spreadsheets.
Changing the Logo in Reports

By default, the ITUAM logo is displayed in reports. If you want to replace this logo with a custom logo, complete the following steps. The steps differ depending on whether you are using Crystal or SQL Server Reporting Services reports.

**Note** • If the custom logo is not the same height as the ITUAM logo, report header data might be lost.

For Crystal reports, you must modify each report file to include the logo that you want. For Reporting Services, all reports automatically use the report image that is published to the Reporting Services Report Server.

**To change the logo for Crystal reports:**

1. In Crystal Reports, open the report that you want to change.
2. Right-click logo, and then click **Delete**.
3. On the menu bar, click **Insert** ➤ **Picture**.
4. Locate the file for the logo that you want to use and place it in the report.
5. Save the report in the **Custom** reports folder.

**To change the logo for Reporting Services reports:**

1. If you installed ITUAM in the default location, locate the `ReportLogo.jpg` file in `C:\Program Files\IBM\ITUAM\Server\Web\Images`.
3. Place the file for the logo that you want to use in the **Images** folder. The file must be named `ReportLogo.jpg`, but it can be in the JPEG or GIF format.
4. In the ITUAM Administrator main window, click **System Administration** ➤ **Reporting** ➤ **Configure Reporting Services with ITUAM Administrator**. This publishes the new logo file to the Reporting Services Report Server where it is used by all Reporting Services reports provided with ITUAM.
Working With Batch Reporting/Published Reports

Note • This section is not applicable for SQL Server Reporting Services reports.

Batch reporting enables you to automate the generation of published reports. A published report is a report that has been saved with the data that was generated at the time the report was run.

Publishing a report enables users to view a report without having to regenerate it. The report displays quickly because the data has already been read from the database and formatted.

Batch reporting also enables you to provide published reports to end users in a way that best meets the needs of users, including attaching the report to an e-mail or including a link to the report in an e-mail. The distribution methods for published reports are described in detail in Distributing Published Reports on page 5-24.

This section describes how to create and distribute published reports in batch using ITUAM Administrator in conjunction with the ReportDistribution.wsf script. If you installed ITUAM in the default location, this script is in C:\Program Files\IBM\ITUAM\Scripts\Batch Reporting.

Creating Published Reports

Published reports can be created in either of the following ways:

■ From the ITUAM Web Reporting Web site. This method requires that users publish reports from the Web site by clicking Publish after the report is generated. This method is described in detail in the IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide.

■ In batch. You can use the ReportDistribution.wsf script to automatically create, publish, and distribute reports. To publish reports using this script, perform the following steps:

  a Create a report cycle in ITUAM Administrator for the report or reports that you want to publish. The ReportDistribution.wsf script uses the definitions in the report cycle to generate and distribute the reports. For more information about distributing published reports and creating report cycles, see Distributing Published Reports on page 5-24 and Creating a Report Cycle on page 5-27.

  b Set up and run the ReportDistribution.wsf script as described in Running a Report Cycle on page 5-44.
Distributing Published Reports

To best meet the needs of your users, ITUAM provides you with the flexibility to distribute published reports in any of the following ways.

- **Distribute reports from the ITUAM Web Reporting Web site.** This method requires that users search for and access published reports from the Web site by clicking Reports › View Published Reports. This method is described in detail in the *IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide*.

  You can use this distribution method with or without the following e-mail distribution feature. E-mail distribution notifies a user or users that the report is available and provides a link to the ITUAM Web Reporting Web site.

- **Distribute reports via e-mail.** This method enables you to “push” published reports to users. You can deliver the reports in any of the following ways:
  
  • **Attach the report to the e-mail.** A benefit of this method is that the user receives the report directly. A disadvantage is that large reports included as attachments can affect the performance of your e-mail system.
  
  • **Provide a link to the report in the e-mail subject or body.** This method saves e-mail space and enables the user to easily access the report by clicking the link. Published reports are stored in subfolders within the Published folder on the ITUAM application server. (See *Storing Published Reports Using the Published Folder Structure* on page 5-25.)
  
  • **Provide a link to the ITUAM Web Reporting Web site in the e-mail subject or body.** You can use this method to provide a link to the Web site home page or a link directly to the report on the Web site if auto logon is enabled for the user (see *Web Settings* on page 4-47). A benefit of this method is that the security set up for the Web site is used to control user access to published reports (see *Security Requirements for Viewing Reports* on page 5-48).

  To use the e-mail report distribution feature, you must create a report cycle in ITUAM Administrator as described in *Creating a Report Cycle* on page 5-27.
Storing Published Reports Using the Published Folder Structure

The Published folder contains the following subfolders for storing published reports. (The path to the Published folder is defined on the Reporting tab on the Configuration dialog box). The subfolder in which a report is stored is specified by the ITUAM Web end users if the report is published from the ITUAM Web Reporting Web site or is defined in the report cycle if the report was produced in batch (see Creating a Report Cycle on page 5-27).

The security and access rights for the published reports differ depending on whether users are accessing a published report from the Web site or directly from a link (see Folder Permissions Required for Publishing and Viewing Batch Reports on page 5-48).

- **user.** This folder contains subfolders for specific users. Each subfolder name reflects a ITUAM user ID. The following is the structure for the user folder. Note that the structure of the lowest two subfolders within the user folder is the same for the group, account, and global folders.
  - Published\userid\periodpublished\reports (contains Crystal reports and reports and spreadsheets published as PDF files)
  - Published\userid\periodpublished\spreadsheets (contains Excel spreadsheets)
  - Published\userid\periodpublished\CSV (contains reports and spreadsheets published as CSV files)

  For example, user\Joan\200507\reports contains Crystal reports and reports/spreadsheets in PDF format for the user Joan that were published in July 2005 (if you are using the default periods in the CIMSCalendar table).

  **Note** • Published reports in the CSV subfolder are not accessible from the ITUAM Web Reporting Web site.

- **group.** This folder contains subfolders for specific user groups. Each subfolder name reflects a ITUAM user group ID. The following is the structure for the group folder:
  Published\groupid\periodpublished\reports/spreadsheets/CSV

  For example, group\AP\200507\spreadsheets contains Excel spreadsheets for the group AP that were published in July 2005 (if you are using the default periods in the CIMSCalendar table).

- **account.** This folder contains subfolders for specific account codes. The following is the structure for the account folder:
  Published\account\accountcode\periodpublished\reports/spreadsheets/CSV

  For example, account\AABBCCC\200507\CSV contains reports and spreadsheets published as CSV files for the account code AABBCCC in July 2005 (if you are using the default periods in the CIMSCalendar table).

  You cannot publish reports to the account folder if you are using a report cycle.
global. Reports in this folder are for all users, groups, and accounts. The following is the structure for the global folder:

\texttt{Published\global\datepublished\reports/spreadsheets/CSV}

For example, \texttt{global\200507\reports} contains Crystal reports and reports/spreadsheets in PDF format that were published in July 2005 (if you are using the default periods in the CIMSCalendar table).

You cannot publish reports to the global folder if you are using a report cycle.

**Deleting Published Reports**

To delete published reports, start Windows Explorer and navigate to the Published folder. Delete the reports from the applicable subfolder.
Creating a Report Cycle

The report cycle defines such information as the reports that you want to publish, the output format for the reports, how you want to distribute the reports (attachment or link), and the user or user group that you want to distribute the reports to.

To add a report cycle:

1. In the ITUAM Administrator main window, click System Administration ▶ Reporting ▶ Report Distribution.

   The Report Cycle List Maintenance dialog box is displayed. This dialog box initially contains an example report cycle as shown in example Figure 5-7. You can use this report cycle as a reference or you can edit the cycle to publish and distribute your reports. If you want to edit this cycle, continue to Step 4.

   ![Figure 5-7 • Report Cycle List Maintenance Dialog Box](image)

2. Click Add.

3. In the Add New Report Cycle dialog box, enter the name of the report cycle (e.g., Invoice), and then click OK. Maximum of 8 characters.

   The Report Cycle Maintenance dialog box is displayed.
4 Enter the report distribution settings as follows. For an example, see Figure 5-8 on page 5-42.

- **Report Cycle ID.** The report cycle ID number is automatically assigned to the report cycle. Report cycle IDs are assigned in sequential order.

- **Name.** Use this box to change the name of the report cycle if needed.

- **Description.** Enter a description of the report cycle (e.g., Invoice by Account). Maximum of 255 characters.

- **Link type.** If you want to distribute a report by providing a link directly to the report, click the type of link that you want to use: UNC or URL. The Link type box is applicable only if one of the following formats is selected in the Report format box on the Report Cycle Distribution Request dialog box (see Step 6 on page 5-30):
  - PDF: E-mail with link to report
  - Excel: E-mail with link to file
  - CSV: E-mail with link to file

If any other format is selected, the value in this box is ignored.

If you click UNC, the UNC path for the Published folder must be entered in the Path to published reports box on the Reporting tab of the Configuration dialog box (see Reporting Settings on page 4-44). An example of the use of a UNC path is for in-house users on the same network as the Web server.

If you click URL, a virtual directory must exist for the Published folder. For more information, see Creating a Virtual Directory for the Published Folder on page 5-49. An example of the use of a URL path is to enable users who cannot access the reports through the network to access reports through the intranet.

- **ITUAM Server URL.** If you want to distribute a report by providing a link to the ITUAM Web Reporting Web site, type the URL for the site in this box.

This box is applicable only if one of the following formats is selected in the Report format box in the Report Cycle Distribution Request dialog box (see Step 6 on page 5-30):

- Crystal: E-mail with link to report (this provides a direct link to the report on the Web site)
- Crystal: E-mail with link to Web site (this provides a link to the Web site home page)
- Excel: E-mail with link to Web site (this provides a link to the Web site home page)

If any other format is selected, the value in this box is ignored.

- **Reports URL.** If you selected URL in the Link type box, type the URL for the virtual directory for the report.
• **E-mail from address.** Type the fully qualified e-mail address of the sender of the e-mail.

**Note** • The “to” address for the recipient of the e-mail is defined by user in the User Maintenance dialog box. For more information, see *To add a user:* on page 4-27.

• **Mail server.** The name of the SMTP mail server that will be used to send the e-mail distribution.

• **E-mail subject and E-mail body.** Use these boxes to type the subject and body of the e-mail.

It is very important that you include an &WebSite or &Location variable in the subject or body if you select a report format that includes a link. The &WebSite variable provides the URL link to the ITUAM Web Reporting Web site. The &Location variable provides pre-defined text and a URL link to the ITUAM Web Reporting Web site or a URL or UNC link to the published report.

To add these variables and other optional variables, click *Add variable* and then click the variable that you want to add (see the following descriptions). The variables will be automatically populated with the correct information in the e-mail.

• **Link to Reporting Web Site (WebSite).** Provides a URL link for the ITUAM Web Reporting Web site. For example, http://roca.

• **Link to Location (Location).** Provides text and a UNC or URL link. The link is provided with the following text depending on whether the link is directly to the report or to the ITUAM Web Reporting Web site:

  “*Report name may be found by using this link:*”

  **Example:** Account Budget for Period YTD may be found by using this link: http://Server1/Published/USER/Joan/200508/Reports/RBGTC001.pdf

  “*Report name has been published at the site:*”

  **Example:** Account Budget for Period YTD has been published at the site: http://Server1

• **User Name (UserName).** The ITUAM user name for the user defined for the report.

• **User ID (UserID).** The ITUAM user ID for the user defined for the report.

• **Report Name (ReportName).** The report name.

• **Report Cycle Name (CycleName).** The report cycle for the report.

• **Date report was published (Date).** The date that the report was published and the e-mail notification sent.

• **Report Period (ReportPeriod).** The period in which the report was published as defined in the CIMSCalendar table.
• **Requests.** This box contains requests for the reports that you want to publish. A report request defines the settings for the report such as the format that you want to publish the report in, the parameters for the report, and the report recipient(s).

5 Under the **Requests** box, click **Add**.

The Report Cycle Distribution Request dialog box is displayed.

6 In the Report Cycle Distribution Request dialog box, enter the settings for the report that you want to publish as follows. For an example, see Figure 5-8 on page 5-42.

   • **Report cycle ID.** The report cycle ID number is automatically assigned to the report cycle.

   • **Request ID.** You must create a separate request for each report that you want to publish. The request ID number is automatically assigned to the request. Request IDs are assigned in sequential order.

   • **Report format.** Click the format that you want the published report to be displayed in. This setting also specifies the distribution method (i.e., link or attachment).

   **Note** • The format that you select in this box should support the report or spreadsheet that you select in the Report box. For example, if you select a spreadsheet in the Report box, you might not get the desired results if you select the Crystal report format in this box.

   • **PDF : E-mail with report attached.** The report is published as a PDF document and attached to the e-mail. The text “*Report name is attached*” is placed in the e-mail body.

Adobe Reader must be installed on the client computer to enable the e-mail recipient to view the report.

This report format has the following advantages and disadvantage:

**Advantages**

• The recipient receives the report directly.

• The recipient does not require Windows folder or IIS security privileges to access the report.

**Disadvantage**

• Large reports included as attachments can affect the performance of your e-mail system.
• **PDF : E-mail with link to report.** The report is published as a PDF document and a link to the report is included in the e-mail. The format of the link, UNC or URL, is determined by the value in the **Link type** box of the Report Cycle Maintenance dialog box (see Step 4 on page 5-28).

Adobe Reader must be installed on the client computer to enable the e-mail recipient to view the report.

This report format has the following advantage and disadvantage:

**Advantage**

• Enables users to easily access the report without having to attach the report to the e-mail.

**Disadvantage**

• If you want to use a URL link for to the report, you must create a virtual directory for the Published report folder.

• **Crystal : E-mail with link to report.** The report is published as a Crystal report and a link directly to the report on the ITUAM Web Reporting Web site is included in the e-mail. To use this option, the Web site must have Windows authenticated access enabled and the recipient must be set up to use the auto logon feature for the ITUAM Web Reporting Web site (see Web Settings on page 4-47).

Note that if you are using Crystal Reports XI and you have not purchased the full Crystal Reports Server license, you cannot publish reports as Crystal Reports because users cannot view the report from the Web site (this applies to the following two Crystal Reports formats as well). You must select another report format for distributing the report.

This report format has the following advantage and disadvantage:

**Advantage**

• Provides a link directly to the report on the Web site.

**Disadvantage**

• The Web site must have Windows authenticated access enabled and the recipient must be set up to use the auto logon feature for the ITUAM Web Reporting Web site.
- **Crystal : E-mail with link to web site.** The report is published as a Crystal report and a link to the home page of the ITUAM Web Reporting Web site is included in the e-mail.

This report format has the following advantage and disadvantage:

**Advantage**

- Enables recipients who are not set up to use the auto logon feature for the ITUAM Web Reporting Web site (see *Web Settings* on page 4-47) to go to the Web site home page via a link. The recipient can then log on to ITUAM Web Reporting and view the published report.

**Disadvantage**

- Links to the home page for the ITUAM Web Reporting Web site rather than directly to the published report on the Web site.

- **Crystal : No e-mail.** The report is published as a Crystal report, but an e-mail is containing a link to the report is not sent.

- **Excel : E-mail with file attached.** The report is published as an Excel spreadsheet and attached to the e-mail. The text “Spreadsheet name is attached” is placed in the e-mail body.

Excel must be installed on the client computer to enable the e-mail recipient to view the spreadsheet.

This report format has the following advantages and disadvantages:

**Advantages**

- The recipient receives the spreadsheet directly.

- The recipient does not require Windows folder or IIS security privileges to access the spreadsheet.

**Disadvantages**

- Large spreadsheets included as attachments can affect the performance of your e-mail system.

- The spreadsheet is not displayed on the Published Spreadsheets page of the ITUAM Web Reporting Web site and cannot be accessed from the Web site.
- **Excel : E-mail with link to file.** The report is published as an Excel spreadsheet and a link to the report is included in the e-mail. The format of the link, UNC or URL, is determined by the value in the **Link type** box of the Report Cycle Maintenance dialog box (see Step 4 on page 5-28).

Excel must be installed on the client computer to enable the e-mail recipient to view the spreadsheet.

This report format has the following advantage and disadvantage:

**Advantage**

- Enables users to easily access the spreadsheet without having to attach the report to the e-mail.

**Disadvantage**

- If you want to use a URL link for to the spreadsheet, you must create a virtual directory for the **Published** report folder.

- **Excel : E-mail with link to web site.** The report is published as an Excel spreadsheet and a link to the home page of ITUAM Web Reporting Web site is included in the e-mail.

This report format has the following advantage and disadvantage:

**Advantage**

- Enables recipients to go to the Web site home page via a link. The recipient can then log on to ITUAM Web Reporting and view the published spreadsheet.

**Disadvantage**

- Links to the home page for the ITUAM Web Reporting Web site rather than directly to the published spreadsheet.

- **Excel : No e-mail.** The report is published as an Excel spreadsheet, but an e-mail containing the spreadsheet or a link to the spreadsheet is not sent.
• **CSV : E-mail with file attached.** The report is published as a comma-separated values (CSV) file and attached to the e-mail. The text “Report name is attached” is placed in the e-mail body.

This report format has the following advantages and disadvantages:

**Advantages**

• The recipient receives the CSV file directly.

• The recipient does not require Windows folder or IIS security privileges to access the CSV file.

**Disadvantages**

• Large CSV files included as attachments can affect the performance of your e-mail system.

• The CSV file is not displayed on the Published Reports or Published Spreadsheets page of the ITUAM Web Reporting Web site and cannot be accessed from the Web site.

• **CSV : E-mail with link to file.** The report is published as a CSV file and a link to the report is included in the e-mail. The format of the link, UNC or URL, is determined by the value in the **Link type** box of the Report Cycle Maintenance dialog box (see Step 4 on page 5-28).

This report format has the following advantage and disadvantage:

**Advantage**

• Enables users to easily access the CSV file without having to attach the report to the e-mail.

**Disadvantage**

• If you want to use a URL link for to the CSV file, you must create a virtual directory for the **Published** report folder.

• **Report.** Click the report that you want to publish.

• **Set default parameters for all users of this report.** Click this button to set the parameters for the report. These parameters will be applied to reports for all users unless you set override parameters by user or user group (see **Set optional override parameters for this user/user group**).

For a description of all report parameters for the standard reports provided with ITUAM, see **Setting Report Parameters** on page 5-36. If you are using custom reports, your report parameters might differ.
Report Administration

Working With Batch Reporting/Published Reports

- **User Type—User or User group.** This setting determines the user or user group that you want to send the published report to and where the published report is stored. If you click User, the report is stored in the Published\user folder in a subfolder with the same name as the user. For example, Published\user\Joan.

If you click User group, the report is stored in Published\group folder in a subfolder with the same name as the user group. For example, Published\group\AP.

**Note** • Make sure that you have entered an e-mail address for each user that you want to send the report to as described in *To add a user:* on page 4-27.

- **Set optional override parameters for this user/user group.** Click this button to set any parameters that are specific to a user or user group. These parameters will override the parameters set for all users.

  7 Click OK when you are finished and then click OK again to close the Report Cycle Maintenance dialog box.

  The report request is displayed in the Requests area of the Report Cycle Maintenance dialog box. A separate e-mail is sent for each report defined in the Requests area.

  **To edit a report cycle:**

  1 Click the report cycle, and then click Edit. The Report Cycle Maintenance dialog box is displayed.

  2 Follow the steps in *Creating a Report Cycle* on page 5-27 beginning with Step 4.

  **To remove a report cycle:**

  Click the report cycle, and then click Remove.
Setting Report Parameters

**Note** • This section describes the parameters for the standard reports provided with ITUAM. Your reports might use other parameters that are custom for your organization.

To set the parameters for a report:

1. Click **Set Default Parameters for all users of this report** in the Report Cycle Distribution Request dialog box.

   The Report Distribution Request Parameters dialog box is displayed.

2. Type the parameters values that you want to use for the report. Click **OK** when you are finished. A description of each of the parameters is provided in Report Parameters for ITUAM Standard Reports on page 5-37.

3. Click **OK** when you are finished.

These parameters will be applied to reports for all users unless you set override parameters by user or user group. To set override parameters for a specific user or user group:

1. Click **User** or **User Group** and then click the user or group that you want to apply the override parameters to.

2. Click **Set Optional Override Parameters for this User/User Group**.

   The Report Distribution Request Parameters dialog box is displayed.

3. Type values for only those parameters that you want to override. All other parameters will remain the same as the parameters for all users.

4. Click **OK** when you are finished.
Report Parameters for ITUAM Standard Reports

The following are the parameters for the standard reports provided with ITUAM. The parameters are presented in alphabetical order with the exception of InvoiceLevel, which is the first parameter for many reports.

**Note** • Parameters vary by report.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InvoiceLevel</td>
<td>The account code level that you want to view in the report. For example, the account code AABBBBCCCC might contain the following levels: Level 1, the two-digit company code AA Level 2, the 6-digit division code AABBBB Level 3, the 9-digit department code AABBBBCCC In this example, the account code level that you can select is 1, 2, or 3. The resource use and charge data will reflect the level that you select.</td>
</tr>
<tr>
<td>AccountCodeStart and</td>
<td>These parameters work in conjunction with the InvoiceLevel parameter to specify the account codes for that level that are displayed in the report. For example, if the InvoiceLevel parameter is set to 1 (level 1), and level one of the account code is the 2-digit company code, only 2-digit account codes in the range specified by these parameters are displayed in the report. If you want all account codes for the account code level to be displayed in the report, you can leave these parameters blank or set the AccountCodeStart parameter to the lowest account code (for example, AA) and AccountCodeEnd to the highest account code (for example, ZZ).</td>
</tr>
<tr>
<td>AccountCodeEnd</td>
<td></td>
</tr>
</tbody>
</table>

Table 5-2 • Standard Report Parameters
## Report Administration

### Working With Batch Reporting/Published Reports

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AuditType</td>
<td>The type of changes that you want to view in CIMSCALLient, CIMSRate, and CIMSTransaction table audit reports. Valid values are:</td>
</tr>
<tr>
<td></td>
<td>■ A or blank. View all table changes.</td>
</tr>
<tr>
<td></td>
<td>■ I. View table additions.</td>
</tr>
<tr>
<td></td>
<td>■ U. View table updates.</td>
</tr>
<tr>
<td></td>
<td>■ D. View table deletions.</td>
</tr>
<tr>
<td>DateStart and DateEnd</td>
<td>The start and end dates for the data that you want to be displayed in the report. You can use a ITUAM date keyword or a date value for either the start or end date. The dates for the keywords are calculated using the date the report is published. CIMS date keywords:</td>
</tr>
<tr>
<td></td>
<td>■ RNDATE If used for either the start or end date, the date is the current day.</td>
</tr>
<tr>
<td></td>
<td>■ CURDAY If used for the start date, the date is the previous day. If used for the end date, the day is the current day.</td>
</tr>
<tr>
<td></td>
<td>■ CURWEK If used for the start date, the date is the first day of the current week (Sun–Sat). If used for the end date, the date is the last day of the current week.</td>
</tr>
<tr>
<td></td>
<td>■ CURMON If used for the start date, the date is the first day of the current month. If used for the end date, the date is the last day of the current month.</td>
</tr>
<tr>
<td></td>
<td>■ PREDAY If used for either the start or end date, the date is the previous day.</td>
</tr>
<tr>
<td></td>
<td>■ PREWEK If used for the start date, the date is the first day of the previous week (Sun–Sat). If used for the end date, the date is the last day of the previous week.</td>
</tr>
<tr>
<td></td>
<td>■ PREMON If used for the start date, the date is the first day of the previous month. If used for the end date, the date is the last day of the previous month.</td>
</tr>
</tbody>
</table>

*Table 5-2 • Standard Report Parameters (Continued)*
### DateStart and DateEnd (continued)

**CURRENT**  
If used for the start date, the date is the first day of the current period as defined in the CIMSCalendar table. If used for the end date, the date is the last day of the current period.

**PREVIOUS**  
If used for the start date, the date is the first day of the previous period as defined in the CIMSCalendar table. If used for the end date, the date is the last day of the previous period.

**Date value:**

The date must be in month/day/year format as follows:

- month and day with or without a leading 0
- 2 or 4-digit year

For example, 9/16/2005, 09/16/2005, 9/16/05, or 09/16/05.

**Graph**  
This parameter specifies whether a graph is displayed on the first page of the report. Valid values are:

- Y (a graph is displayed)
- N or blank (a graph is not displayed)

**Identifier or AllIdent**  
The name of the identifier that you want to retrieve data for.

**InvoiceNumber**  
Some invoice reports contain separate invoices for the account codes selected. If you leave this parameter blank, the invoice numbering begins with the invoice number defined in the CIMSCConfigOptions table. If you provide an invoice number for this parameter, invoice numbering begins with that number.

**Month**  
The month for the data that you want to be displayed in the report. The format is numeric, 1–12.

**Period**  
The period (1-13) for the data that you want to be displayed in the report. Periods are defined in the CIMSCalendar table (see *Setting Up a Calendar* on page 4-25).

**Prorate**  
The amount that you want to prorate across accounts in proration reports.

**RateCode**  
The rate code that you want to retrieve data for.

---

**Table 5-2 • Standard Report Parameters (Continued)**
### Working With Batch Reporting/Published Reports

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RateGroup, RateGroup4DetRpts, or RateGroupwithIdentifiers</td>
<td>The rate group that you want to retrieve data for. This can be the rate group title, description, or index number.</td>
</tr>
<tr>
<td>Start_Value and End_Value</td>
<td>This parameter provides data by the selected identifier value range. For example, if you want data for the following three identifier values: Server1, Server2, and Server3, type Server1 as the start and Server3 as the end.</td>
</tr>
<tr>
<td>Trans_ID_Start and Trans_ID_Start End</td>
<td>This parameter provides data by the selected CICS® transaction ID range. For example, if you want data for the following three transaction IDs: CESF, DEGV, and TINQ, type CESF as the start and TINQ as the end.</td>
</tr>
<tr>
<td>TopN</td>
<td>This parameter specifies the number of account codes that are displayed in a report or the drill down for a report. For example, if you type 1, only the account code that used the most resources or incurred the most charges are displayed. If you type 2, the highest and second highest account codes are displayed.</td>
</tr>
<tr>
<td>TransactionType</td>
<td>The transaction type that you want to retrieve data for. Valid values are:</td>
</tr>
<tr>
<td></td>
<td>- A or blank. All transactions.</td>
</tr>
<tr>
<td></td>
<td>- M. Miscellaneous transactions.</td>
</tr>
<tr>
<td></td>
<td>- R. Recurring transactions.</td>
</tr>
<tr>
<td></td>
<td>- C. Credit transactions.</td>
</tr>
<tr>
<td></td>
<td>For more information about transactions, refer to the IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide.</td>
</tr>
<tr>
<td>Year</td>
<td>The two or four-digit year for the data that you want to be displayed in the report.</td>
</tr>
</tbody>
</table>

Table 5-2 • Standard Report Parameters (Continued)
The Zero Cost Invoice report may be processed in two ways:

- **Factor total.** This factors the invoice total by the zero cost amount. To factor by total, type `A` for this parameter.
- **Factor rates.** This factors each resource rate by the zero cost amount. To factor by rate, type `B` or leave the parameter blank.

For more information about zero cost, see page 4-11.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZeroCostOption</td>
<td>The zero cost amount. You can type this amount with or without the decimal point. For example, 100000 or 100000.00.</td>
</tr>
</tbody>
</table>

**Table 5-2  • Standard Report Parameters (Continued)**
Creating a Report Cycle Example

Figure 5-8 shows configured report cycle dialog boxes for the example report cycle Budget.

Reports generated using this report cycle are distributed via a URL link to the virtual directory Published (see Creating a Virtual Directory for the Published Folder on page 5-49).

The variables &ReportName in the subject and &Location in the body are automatically updated with the report name and a link to the report as shown in Figure 5-9 on page 5-43.

The report Invoice by Account Level is published as a PDF file and distributed via a URL link in the e-mail. The e-mail will be sent to the ITUAM user Joan. The user's e-mail address is defined in the User Maintenance dialog box (see Defining Users on page 4-27).

Only first level account codes between AA and CC are displayed in the report. The data presented for the report is for resources used during the previous month as defined in the CIMSCalendar table.
Report Administration

Working With Batch Reporting/Published Reports

The e-mail generated from the settings in the report cycle is shown in Figure 5-9. The e-mail includes a URL link to the report.

![Figure 5-9 • E-mail Report Distribution Example](image-url)
Running a Report Cycle

Once you have created a report cycle, run the ReportDistribution.wsf script to create, publish, and distribute the reports defined in the cycle. If you installed ITUAM in the default location, this script is in \Program Files\IBM\ITUAM\Scripts\Batch Reporting.

Defining the Web Server (If Applicable)

Note • This section is not applicable if you are using Crystal Reports XI.

Crystal Reports 9 and 10 use the Crystal Report Application Server (RAS) interface, which is installed on the Web server. If you are using Crystal Reports 9 or 10 and are not running the ReportDistribution.wsf script on the Web server, you must create a configuration option in ITUAM Administrator to define the name of the Web server that contains the RAS interface. To set this option:

1 In the ITUAM Administrator main window, click System Administration ▶ Configuration Information.

2 On the Option List tab, click Add.

3 In the Add New Configuration Option dialog box, type RASServer and click OK. The Configuration Option Maintenance dialog box is displayed.

4 Enter the following information as shown in example figure Figure 5-10:
   - Description. An optional description of this option. Maximum of 80 characters.
   - Value. The name of the Web server.
   - Data Type. String.

Figure 5-10 • Configuration Option Maintenance Dialog Box
Running the ReportDistribution.wsf Script

To run the ReportDistribution.wsf script, you should use the Job Runner console application and an XML job file as used for the data collection process for ITUAM. The Job Runner application and its related architecture are described in detail IBM Tivoli Usage and Accounting Manager Data Collectors for Microsoft Windows User’s Guide. This architecture provides the following benefits:

- You can run the ReportDistribution.wsf script automatically on a scheduled basis (daily, monthly, etc.) using Windows Task Scheduler.
- You can receive a log file via e-mail that provides the results of the report generation and distribution process. If a warning or failure occurs during processing, the file indicates at which point the warning/failure occurred. The log file can be sent to multiple recipients.

ITUAM includes a sample job file, SampleReportDist.xml, that you can modify and use to run the ReportDistribution.wsf script. If you installed ITUAM in the default location, the SampleReportDist.xml file is in C:\Program Files\IBM\ITUAM\JobFiles.

Modifying the SampleReportDist.xml File

The contents of the SampleReportDist.xml job file are shown here. You can simply modify the values in this file for your organization.

```xml
<?xml version="1.0" encoding="utf-8"?>
<Jobs xmlns="http://www.cimslab.com/CIMSJobs.xsd">
  <Job id="Report Distribution" description="Report Distribution" processPriorityClass="Low" smtpSendJobLog="true" smtpServer="mail.ITUAMCustomerCompany.com" smtpFrom="ITUAM@ITUAMCustomerCompany.com" smtpTo="John.ITUAMUser@ITUAMCustomerCompany.com" dataSourceId="" stopOnProcessFailure="false" joblogWriteToXMLFile="false" joblogShowStepOutput="true" joblogShowStepParameters="true" active="true">
    <Process id="Report Distribution" description="Report Distribution" buildProcessFolder="false" joblogShowStepOutput="true" joblogShowStepParameters="true" active="true">
      <Steps>
        <Step id="Report Distribution" description="Report Distribution" type="Process" programName="Batch Reporting\ReportDistribution.wsf" programType="wsf" active="true">
          <Parameters>
            <Parameter Cycle="Reports"/>
            <Parameter DataSourceID=""/>
            <Parameter Email="Y"/>
          </Parameters>
        </Step>
      </Steps>
    </Process>
  </Job>
</Jobs>
```
The step that runs the `ReportDistribution.wsf` script includes the parameters that are passed to the script. Modify the values for these parameters as described in Table 5-3.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cycle (required)</td>
<td>Provide the name of the report cycle that you want to run.</td>
</tr>
<tr>
<td>DataSourceID (optional)</td>
<td>Provide the ITUAM Data Source ID for the database that you want to use for reporting.</td>
</tr>
<tr>
<td></td>
<td>If this parameter is not provided, the data source that is set as the Web/collector default in the ITUAM Data Source Maintenance dialog box is used (see page 6-6).</td>
</tr>
<tr>
<td></td>
<td>To use a ITUAM Data Source other than the default, set this parameter to the appropriate data source ID.</td>
</tr>
<tr>
<td>Email (optional)</td>
<td>This parameter is helpful in testing or other situations in which you want to publish reports but do not want to distribute the reports via e-mail or you want to send an e-mail for reports that have already been published.</td>
</tr>
<tr>
<td></td>
<td>Valid values are:</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Trial</strong>. An e-mail message containing the reports is not sent, but the reports are published.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Only</strong>. An e-mail is message is sent, but reports are not published. The e-mail contains a link to the previously published report.</td>
</tr>
<tr>
<td>Debug (optional)</td>
<td>If this parameter is set to <strong>Y</strong>, debugging information is included in the log file. If this parameter is set to <strong>N</strong> or is not provided, this information is not included in the log file.</td>
</tr>
</tbody>
</table>

Table 5-3 • `ReportDistributionScript Parameters`
Schedule Job Runner to Run the Job File

Once you have created a job file, you can schedule Job Runner to run the file using Windows Task Scheduler as follows:

1. In Windows Control Panel, double-click **Scheduled Tasks**.
2. Double-click **Add Scheduled Task**.
3. The **Scheduled Task Wizard** is displayed. Click **Next**.
4. Click **Browse** to find the program `CIMSJobRunner.exe`, and then double click the program. If you installed ITUAM in the default location, this program is in `C:\Program Files\IBM\ITUAM\Process Engine`.
5. Type a name for the task or accept the default and click the schedule for the task. Click **Next**.
6. Select the time and day to start the task, and then click **Next**.
7. Type the password for the user account under which you want the scheduled task to run. The password cannot be blank. Click **Next**.

   **Note** • Make sure that the user account has a security permission of Full Control for the folder.

8. Select the **Open advanced properties for this task when I click Finish** check box, and then click **Finish**.

9. In the **Task** tab, type following in the **Run** box where `jobfilename.xml` is the name of the job file that you want to run:

   "C:\Program Files\IBM\ITUAM\Process Engine\CIMSJobRunner.exe" 
   `jobfilename.xml`

10. Click **OK**.

11. In the Set Account Information dialog box, type the password for the user account again, and then click **OK**.

The task is displayed in the Scheduled Task list. To execute `CIMSJobRunner.exe` immediately, right-click the task, and then click **Run**. For more information about Task Scheduler, refer to the Microsoft documentation.
Folder Permissions Required for Publishing and Viewing Batch Reports

The following sections describe the folder permissions required for the person who is publishing reports in batch mode and for the users accessing reports.

Permissions for Publishing Reports

To publish a report to a folder, the Windows account of the person who is publishing the report must have a security permission of Full Control for the folder.

If the folder is shared and is on a server other than the server where you are running the ReportDistribution.wsf script, the Windows account must also have a share permission of Full Control. If you are using Windows 2000, the default is to assign Full Control to the Everyone group. However, if you are using Windows XP with Service Pack 2 or Windows 2003, the default is to assign only the Read permission to the Everyone group.

Security Requirements for Viewing Reports

The security for accessing published reports is dependent on whether a user is viewing the report from the ITUAM Web Reporting Web site or directly from a folder via a link.

Web Site Security

If a user is accessing published reports from the Web site, the ITUAM user ID that the user logs on with determines which reports the user can view. For example, if the user Joan of the group AP logs on to the Web site, the user can view reports in the Published\user\Joan, the Published\group\AP folder, and the Published\global folder. The user can also view reports in any Published\group\account\accountcode folder if the account code for which the folder is named is assigned to the AP group.

Folder Security

If a user is accessing a published report directly from a folder via a link, the permissions set for the folder determines whether the user can view the report.

If the link is a UNC path, the Windows account must have a minimum security and share permission of Read for the folder.

If the link is a URL path to a virtual directory with Windows authenticated access enabled, the user's Windows account is used to determine whether the user can view a report in a folder. The user's Windows account must have a minimum security permission of Read for the folder.

If the link is a URL path to a virtual directory with Anonymous access enabled, the Windows account IUSR_computername is used for all users. To enable users to access reports using this account, the account must have a minimum security permission of Read for all applicable folders.
Creating a Virtual Directory for the Published Folder

**Important!** This section is applicable only if you are providing a URL link directly to a published report. It is not applicable if you are providing a link to the ITUAM Web Reporting Web site.

If you are providing a URL link directly to a published report, you must create a virtual directory for the Published folder. It is recommended that you create the virtual directory under the ITUAM Web Reporting Web site (usually Default Web Site) as follows:

1. In Windows Control Panel, double-click **Administrative Tools** ➤ **Computer Management**.
2. Expand **Services and Applications** and navigate to **Internet Information Services** ➤ **Default Web Site**.
3. Right-click **Default Web Site**, and then click **New ➤ Virtual Directory**.

The Virtual Directory Creation Wizard is displayed. Complete the wizard as follows:

a. Click **Next** at the welcome screen.

b. Type an alias for the virtual directory, and then click **Next**.

c. Enter the path for the Published folder, and then click **Next**.

d. When prompted for access permissions, it is recommended that you click only the **Read** access permission. You can optionally also click the **Browse** permission if you want users to be able to browse the entire directory (i.e., the entire contents of the Published folder) from a browser.

e. Click **Next** and then click **Finish** to create the virtual directory.

The virtual directory is displayed below **Default Web Site**.

4. Right-click the virtual directory, and then click the **Directory Security** tab in the properties dialog box.

5. In the **Anonymous access and authentication control** area click **Edit**. The Authentication Methods dialog box is displayed.

6. Click **Anonymous access** or **Integrated Windows access** (see **Folder Security** on page 5-48).

7. Click **OK** until the properties dialog box closes.

8. Restart IIS (see page 11-5).

For additional assistance, consult your IIS administrator.
**Drilling Down in Published Reports**

A key feature of ITUAM Web Reporting is the ability to drill down on items in a report to view more detailed information.

Depending on the report, you can drill down on items in reports published as a Crystal report or as a PDF document. Drill down is not available for CSV files for spreadsheets regardless of the format in which the spreadsheet is published.

If a report is published as a PDF, it is not accessible via the ITUAM Web Reporting Web site and does not have all of the drill down options that are available from the Web site.

However, if the cursor icon becomes a hand when the user points to an item in a PDF report, the user can drill down on that item. In this case, the applicable page on the ITUAM Web Reporting Web site is opened to allow drill down.

For more information about drilling down in reports, including drill down options by report, refer to the *IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide*. 
Database Administration

This chapter describes how to use ITUAM Administrator to create and administer databases.

Creating a Database ................................................................. 6-2
Creating a Database in Microsoft SQL Server .............................. 6-2
Creating a Database in MSDE 2000 .......................................... 6-3
Creating an ITUAM Data Source and Initializing the Database ........... 6-4
Backing Up and Maintaining Databases ...................................... 6-4
Setting the Database Recovery Model ....................................... 6-5
Managing ITUAM Data Sources ............................................... 6-5
Setting a ITUAM Data Source as the Web Site/ITUAM Data Collectors Default ........................... 6-6
Using Multiple Databases for ITUAM Web Reporting .................... 6-8
Managing Database Tables ....................................................... 6-10
Loading and Exporting Tables ................................................... 6-11
Loading and Exporting Client and Rate Tables ............................ 6-12
Creating and Dropping Tables .................................................. 6-13
Converting Daily Summary Tables to a Monthly Summary Table ....... 6-13
Updating the Rate Identifiers Table .......................................... 6-13
Viewing Tables ...................................................................... 6-13
Managing Database Objects ..................................................... 6-14
Creating and Dropping Database Objects .................................... 6-15
Loading, Archiving, and Purging the Database .............................. 6-17
Loading the Database ................................................................ 6-17
Archiving, Purging, and Restoring Database Loads ....................... 6-19
Tracking the History of Database Loads ..................................... 6-22
Profiling the Database and Tables .............................................. 6-24
Upgrading the Database ............................................................ 6-25
Creating a Database

**Note** • This section is applicable only if you are using a SQL Server database. If you are using an Oracle or DB2 database, refer for database setup requirements in *Setting Up and Connecting to a Database* on page 2-38.

You might have already created a database using the steps in *Setting Up and Connecting to a DB2 for Linux, UNIX, and Windows Database* on page 2-40. However, you can use more than one database with ITUAM. For example, you might have a production database and a development database. The following sections provide steps for creating additional databases in Microsoft SQL Server or MSDE. If you require further assistance, consult your SQL Server DBA.

**Creating a Database in Microsoft SQL Server**

**Note** • The steps in this section reflect creating a database in SQL Server 2000. If you are using SQL Server 2005, refer to the Microsoft documentation if needed.

1. In Windows, click Start ▶ Programs ▶ Microsoft SQL Server ▶ Enterprise Manager.
2. In the Tree window, under Console Root, navigate to Microsoft SQL Server ▶ SQL Server Group ▶ computername ▶ Databases.
3. Right-click the Databases folder, and then click New Database.
4. In the Database Properties dialog box, enter the configuration information for the new database as follows:
   - On the General tab do the following:
     - In the Name box, type a name for the database.
     - In the Collation name box, click SQL_Latin1_General_CP1_CI_AS. Make sure that you select only this database collation type and not a type that looks similar. ITUAM currently does not support other collation types.
     - Unless you need to change the default settings for the database, you do not need to reset values in the Data File or Transaction Log tabs.
5. Click OK when you are finished.

**Creating User Logins for the SQL Server Database**

There are two types of ITUAM users: the ITUAM administrator or administrators and ITUAM Web Reporting end users. After you create the database, you must create database logins for these users as described in *To create a user login* on page 2-62.
Creating a Database in MSDE 2000

To create an MSDE database, use either the OSQL or ISQL command-line interface as follows. Press <Enter> after each command.

1. At the command prompt, log on to the database server. For example:

   osql -S servera-test -E

   Where -S servera-test indicates the server name and -E indicates use a trusted connection. Note that there are other switches that you may have to use depending on your environment. For example, you may have to specify the login ID (-U) and password (-P) switches. To view the OSQL switches, type osql /? at the command prompt.

2. At the 1> prompt, type:

   create database database name

   Where database name is the name that you want to give the database.

3. At the 2> prompt, type:

   go

   The following messages are displayed:

   The CREATE DATABASE process is allocating 0.63 MB on disk 'database name'.
   The CREATE DATABASE process is allocating 0.49 MB on disk 'database name_log'.

4. At the 1> prompt, type:

   quit

   The database is created in C:\Program Files\Microsoft SQL Server\MSSQL\Data (if you installed ITUAM, including MSDE, in the default location). You should include the Data folder in your backup schedule.

Creating User Logins for the MSDE Database

There are two types of ITUAM users: the ITUAM administrator or administrators and ITUAM Web Reporting end users. It is recommended that you use the default SQL Server user login sa with a password of sa for both ITUAM administrators and end users.

If you want to use a user login or logins other than sa, you can use the OSQL or ISQL command-line interface or a third-party product for maintaining the MSDE database.
Creating an ITUAM Data Source and Initializing the Database

Once you have created a database, follow the steps in Set Up ITUAM on page 2-83, including the steps for creating an ITUAM Data Source for the database and initializing the database.

**WARNING** • Before you initialize the database, make sure that you have selected the correct data source for the database in the Select ITUAM Data Source List at the bottom of ITUAM Administrator main window. Initializing overwrites any existing data in a database.

Backing Up and Maintaining Databases

It is extremely important that you back up your ITUAM database(s) so that you can recover your data in case of media failure or natural disaster. It is recommended that you back up your database(s) weekly and that you back up to a different server at another site.

If you are using an Oracle or DB2 database, consult your DBA for assistance in backing up and maintaining the database.

If you are using a SQL Server database, it is recommended that you use the Database Maintenance Plan feature included with SQL Server to schedule and perform backup up and maintenance tasks for databases. To use this feature:

1. In Windows, click Start ▶ Programs ▶ Microsoft SQL Server ▶ Enterprise Manager.
2. In the Tree window, under Console Root, navigate to Microsoft SQL Server ▶ SQL Server Group ▶ computername ▶ Management ▶ Database Maintenance Plans.
3. Right-click Database Maintenance Plans, and then click New Maintenance Plan.
4. Follow the steps provided in the Database Maintenance Plan Wizard.

If you are using a SQL Server or MSDE database, you can also use the script SampleSQLMaintenance.bat to back up and maintain the database. For more information about this script, see SampleSQLMaintenance.bat Script on page C-24.
Setting the Database Recovery Model

Note • This section is not applicable if you are using an Oracle or DB2 database. For information regarding database recovery, consult your DBA.

It is recommended that you change the SQL Server recovery model from Full, the default, to Simple.

Full recovery allows the database to be recovered to the point of failure. Simple recovery allows the database to be recovered to the most recent backup. Because any lost data can be recovered and reloaded from the CSR or CSR+ files, the benefit offered by the Full recovery is not as beneficial as the smaller SQL Server log file size and disk space savings provided by Simple recovery.

To set the database recovery model:

1. In Enterprise Manager, navigate to the database that you want.
2. Right-click the database, and then click Properties.
3. On the Options tab, click Simple in the Recovery Model list.
4. Click OK.

Managing ITUAM Data Sources

ITUAM Administrator, the ITUAM Web Reporting Web site, ITUAM batch reporting, and ITUAM Data Collectors all require access to the databases that you create for ITUAM. To enable these components to use a database, perform the following steps:

■ Create an ODBC Data Source that points to the database.
■ Create a ITUAM Data Source that points to the ODBC Data Source. The ITUAM components use the ITUAM Data Source to identify and access the correct ODBC Data Source.

The steps required to create the ODBC and ITUAM Data Source depend on the database that you are using with ITUAM. The steps for each database type are provided in Setting Up and Connecting to a Database on page 2-38.

Once you have created the ODBC and ITUAM Data Source, you can maintain the configuration via the ITUAM Data Source Maintenance dialog box. To open this dialog box, click System Administration ▶ ITUAM Data Source Maintenance in the ITUAM Administrator main window.

To add an ITUAM Data Source:

1. Click Add.
2. In the Add ITUAM Data Source dialog box, type an ID for the data source, and then click OK.
3. Follow the steps that are applicable to your database as described in Setting Up and Connecting to a Database on page 2-38.
To edit a ITUAM Data Source:
1. Click the ITUAM Data Source, and then click Edit. The Configure ITUAM Data Source dialog box is displayed.
2. Edit the ITUAM Data Source as applicable for your database as described in Setting Up and Connecting to a Database on page 2-38.

To rename the ITUAM Data Source:
1. Click the ITUAM Data Source, and then click Edit Rename ITUAM Data Source.
2. In the Rename ITUAM Data Source dialog box, type the new ID for the data source and then click OK.

To remove a ITUAM Data Source:

**Important!** • Before you remove a ITUAM Data Source, make sure that the data source is not used by any ITUAM components (Web reporting, batch reporting, data collectors, etc.).

1. Click the ITUAM Data Source, and then click Remove.
2. Click Yes to confirm that you want to remove the ITUAM Data Source.

Setting a ITUAM Data Source as the Web Site/ITUAM Data Collectors Default

If there are multiple entries in the ITUAM Data Source List Maintenance dialog box, you can set any of the entries as the default data source. The default data source setting is used as follows:

- **For Web reporting**, ITUAM Web Reporting uses the default ITUAM Data Source as described in Using Multiple Databases for ITUAM Web Reporting on page 6-8.
- **For batch reporting**, the default ITUAM Data Source is used for batch reporting unless another data source is passed as a parameter to the ReportDistribution.wsf script. See Running the ReportDistribution.wsf Script on page 5-45.
- **For ITUAM Data Collectors**, ITUAM Data Collectors load data to the database specified by the default ITUAM Data Source unless another data source is specified in the job file. For more information, refer to the IBM Tivoli Usage and Accounting Manager Data Collectors for Microsoft Windows User’s Guide.

**Important!** • If you are using a ITUAM Data Collector that collects data from a database, you must create an ITUAM Data Source for that database as described in the IBM Tivoli Usage and Accounting Manager Data Collectors for Microsoft Windows User’s Guide. Make sure that you do not select a non-ITUAM database as the default.
Until you specifically set one of the ITUAM Data Sources as the default, the data source selected in the Select ITUAM Data Source list at the bottom of the ITUAM Administrator main window is set as the default.

**Notes** • The default setting is not applicable when you are using ITUAM Administrator to access a database. ITUAM Administrator points to the ITUAM Data Source that is selected in the Select ITUAM Data Source list regardless of whether the data source is set as the Web/collector default.

You should never select a data source for a non-ITUAM database in the Select ITUAM Data Source list.

If you accidently select an ITUAM Data Source for a SQL Server or MSDE database that you are collecting data from and that data source points to the master database, you will be asked whether you want to create another database. Click No.

To set a ITUAM Data Source as the default:

- Click the ITUAM Data Source, and then click **Set Web/Collector Default**. Yes is displayed in the **Default for Web/Collectors?** column for the data source entry as shown in example Figure 6-1.

![Fig 6-1](image.png)
Using Multiple Databases for ITUAM Web Reporting

There are two scenarios for using multiple databases for Web reporting:

- One Web server with one virtual directory. This scenario allows you to point your Web site to the default database set in ITUAM Data Source Maintenance dialog box. You can change the default database as needed and then update ITUAM Web Reporting to connect that database.

- One Web server with multiple virtual directories. This scenario allows you to access multiple databases without changing the settings in ITUAM Administrator. You can access multiple databases during a ITUAM Web Reporting session by creating individual virtual directories for each database other than the default database.

Both scenarios can be used for development, testing, and upgrade purposes. However, the second scenario is more commonly used.

**To use one Web server and one virtual directory:**

1. In the ITUAM Administrator main window, click **System Administration  ITUAM Data Source Maintenance**.

   The ITUAM Data Source Maintenance dialog box is displayed.

2. Click the ITUAM Data Source ID for the database that you want to use as the default, and then click **Set Web/Collector Default**.

3. Click **Upgrade Configuration** on the Edit Configuration page of ITUAM Web Reporting or restart IIS. The correct data source should be displayed in the ODBC DSN field on the Edit Configuration page.

4. Repeat this procedure each time you want to use a different database.

**To use one Web server and multiple virtual directories:**

A typical configuration for multiple virtual directories is one in which the default directory is pointing to the production database and another directory is created to point to a development database. Using this scenario as an example:

1. In ITUAM Administrator, set the production database as the default ITUAM Data Source (see Step 1 and Step 2 in To use one Web server and one virtual directory).

2. In Windows, copy the ITUAM Web folder and its contents to create a Web site that will point to the development database. If you installed ITUAM in the default location, the Web folder is in C:\Program Files\IBM\ITUAM\Server.
3 In the new folder, do the following:

- Open the WebReportingDataSource.asp file and enter the ITUAM Data Source ID for the development database as follows:

  \[\text{Application("WebsiteUID") = "UID" (where UID is the ITUAM Data Source ID for the development database [see Managing ITUAM Data Sources on page 6-5])}.\]

- Expand the CIMSReporting subfolder. Right click the data subfolder and assign Read, Write, and Modify permissions for the following user:

  - computername\ASPNET (Windows 2000 or XP)

  Or

  - NT AUTHORITY\NETWORK SERVICE (Windows 2003)

4 In IIS Manager, create a virtual directory that points to the development Web site folder. For assistance, consult your IIS administrator.

5 Expand the new virtual directory and do the following:

  a Right-click the CIMSReporting folder, and then click Properties.

  b Click the Create button next to the Application name box.

  c Click OK when you are finished.

6 To access the database that you want, enter the address that points to the virtual directory for that database in the Address bar of the browser. For example, http://Server1/development.

**Important!** • The files and subfolders in the Web folder might change from one ITUAM release to the next. If you upgrade to a new release of ITUAM, you must delete all Web site folders that you have created and repeat Step 2 and Step 3.
Managing Database Tables

ITUAM Administrator includes many powerful tools for managing database tables used with the ITUAM system. You can easily create, drop, load, export, and view database tables.

**Note** • All database objects, including tables, are XML files that can be customized for your site. For more information about tables and other database objects, see *Managing Database Objects* on page 6-14.

**About Exporting, Loading, Dropping, and Creating Tables**

The following is a description of the drop, create, export, and load functions used for database tables:

- **Exporting** a table from the database creates a comma-delimited text file with the same name as the table, but does not remove the table or its data. Exporting a table is useful as a means of backup—the file can be reloaded into the database.

- **Loading** a table into the database first deletes all data currently in the table and then loads the table from the file in the directory that you specify. You can load files that were previously exported from the database or you can load files from another source such as a mainframe file.

  The file must have the same name as the table (e.g., `CIMSRate.txt` for the `CIMSRate` table) and must contain the following:

  - The table column heads in the first record of the file.

  - All required fields for the table provided in comma-delimited format. To determine whether a field is required, view the table properties in the applicable database administration tool. Fields that *are not* specified as nullable (DB2) or *do not* have the *Nulls* check box selected (SQL Server and Oracle) must be included in file.

  For an example of the required format for a file, you can export the table to a file. For a description of the fields in the file, see the applicable table description in *Appendix A, Database Tables*.

  **WARNING** • Extreme caution should be used when loading a table. Deleting or overwriting data can cause unexpected results. Be sure a backup exists before performing this procedure.

- **Dropping** a table removes the table and its data from the database. You should consult IBM before you drop tables.

- **Creating** a table creates the table with no data in the database after the table is dropped.
Loading and Exporting Tables

To load or export a table:

1. In the ITUAM Administrator main window, click **System Administration ▶ Database ▶ Database Table Manager**.

   The Database Table dialog box is displayed as shown in **Figure 6-2**.

   ![Database Table Manager](image)

   **Figure 6-2 • Database Table Dialog Box**

2. To load a table, select it in the list of tables. To select all table check boxes, click **Select all tables**. Note that the ability to select all tables is dependent on the privileges assigned by your DBA.

3. Click **Load selected tables** or **Export selected tables**. A dialog box that prompts you to select the location that you want to load tables from or export tables to is displayed. Select the correct folder, and then click **OK**.
Loading and Exporting Client and Rate Tables

The most commonly exported and loaded tables are the CIMSClient and CIMSRate tables and their related tables. You can export and load these tables from the Database Table Manager or you can use the Chargeback Tables dialog box. This dialog box includes only client and rate-related tables.

**Note** • You can also use the Table.wsf script to load the CIMSClient and CIMSRate tables in batch. For more information about this script, see *Table.wsf Script* on page C-27.

**To load or export a client or rate table:**

1. In the ITUAM Administrator main window, click **Chargeback Administration ➔ Chargeback Table Maintenance ➔ Table Manager.**

   The Chargeback Tables dialog box is displayed.

2. Select the tables that you want to export or load as shown in example **Figure 6-3.** (Note that if you select **Client** or **Rate**, all related tables are selected by default. You can clear those tables that you do not want.)

   ![Figure 6-3 • Chargeback Tables Dialog Box](image)

3. Click **Export Selected Tables** or **Load Selected Tables**. A dialog box that prompts you to select the location that you want to load tables from or export tables to is displayed. Select the correct folder, and then click **OK.**

**Note** • Because referential integrity rules are used in ITUAM tables, some tables must be loaded in combination with other tables.
Database Administration
Managing Database Tables

Creating and Dropping Tables

**WARNING** • You should consult IBM before you drop tables. Dropping a table removes the table and its data from the database.

**To create or drop a table:**

1. In the ITUAM Administrator main window, click **System Administration ➤ Database ➤ Database Table Manager**.
   The Database Table Manager dialog box is displayed.

2. Select the table(s) you want to create or drop. To select all tables, click **Select all tables**.

3. Click **Create selected tables** or **Drop selected tables**. A confirmation message is displayed. Click Yes.

Converting Daily Summary Tables to a Monthly Summary Table

You can consolidate your daily Summary records so that data is stored in an aggregated monthly record. This consolidation minimizes storage (there is typically a 90 percent or greater reduction in records) and decreases the time required to generate monthly reports. A drawback to this consolidation is that you cannot run costed daily reports against the CIMSSummary table.

To perform the consolidation process, use the **ConvertSummaryDailyToMonthly.wsf** script. For more information about this script, see page C-8.

**Important!** • You should consult IBM before using this script.

Updating the Rate Identifiers Table

A key feature of viewing invoices in ITUAM Web Reporting is the ability to drill down on the units consumed for a resource by identifier. This feature uses the CIMSRateIdentifiers table, which contains the rate codes that are processed from the CSR or CSR+ files and correlates them to their corresponding identifier names in the CIMSIIdent table.

If the identifiers in the CSR or CSR+ files have changed or a rate code or codes in the resource files have changed, the CIMSRateIdentifiers table will retain unused data in addition to the current data. Although this does not cause processing problems, the table can accumulate a large amount of data. To update the table so that it contains only the current data, in the ITUAM Administrator main window, click **Chargeback Administration ➤ Database Loading ➤ Update Rate Identifiers**.

Viewing Tables

To view tables, in the ITUAM Administrator main window, click **System Administration ➤ Database ➤ Table Viewers ➤ Table Name**.
Managing Database Objects

**WARNING** • Certain reports are dependent on database objects. Dropping or altering database objects could disable these reports.

All database objects are XML files. The standard database objects that are included with ITUAM are located in C:\Program Files\IBM\ITUAM\Admin\DBObjects\Standard (if you installed ITUAM in the default location). You can also create custom objects and store them in the Custom folder. If you create a custom object with the same name as a standard object, ITUAM uses the custom object.

ITUAM includes the following types of database objects:

- **Tables.** Tables are database objects that contain all the data in a database. A table definition is a collection of columns. In tables, data is organized in a row-and-column format similar to a spreadsheet. Each row represents a unique record, and each column represents a field within the record.

  **Note** • You can manage tables from the Database Table Manager dialog box as described in *Managing Database Tables* on page 6-10 or from the Database Objects Manager dialog box described in this section. However, the Database Table Manager offers more options.

- **Views.** Each view is essentially a saved SQL statement that performs a query that allows the system to generate a report or reports.

- **Stored Procedures.** Each procedure is set of SQL statements that can perform both queries and actions that allow the system to generate a report or reports. Stored procedures can accept parameters at runtime, whereas views cannot.

- **Indexes.** These are files that contain the SQL statements that define how a table index is created. A table index allows the database program to find data in a table without scanning the entire table. There can be multiple indexes per table or no index at all.

- **Triggers.** A trigger is a special type of stored procedure that executes when data in a specified table is modified. A trigger can query other tables and can include complex SQL statements.
Creating and Dropping Database Objects

You can create or drop (completely remove) standard or custom database objects in the database.

**WARNING** • You should consult IBM before you drop tables. Dropping a table removes the table and its data from the database.

**To create or drop database objects:**

1. In the ITUAM Administrator main window, click **System Administration ➤ Database ➤ Database Objects Manager**.

   The Database Objects Manager dialog box is displayed as shown in Figure 6-4.

![Database Objects Manager Dialog Box](image)

2. In the **Object Location** list, click the location of the database objects that you want to create or drop (i.e., the **Standard** or **Custom** folder).

3. In the **Object Type** list, click the object type or accept the default (**All**).

4. Select the object(s) that you want to create or drop. To select all object check boxes, click **Select All**.
5 Click Create Selected Objects or Drop Selected Objects. A confirmation message is displayed. Click Yes.

**Note** • If the user ID that you are using to access the database does not have sufficient system administration authority, you might not be able to create database objects or to create objects with the appropriate permissions. In this situation, a warning message is displayed recommending that you contact your database administrator before continuing.

To confirm that an object exists in the database, make sure that Yes is displayed in the Exists column for that object.
Loading, Archiving, and Purging the Database

This section provides the procedures for loading, archiving, and purging the ITUAM database using the ITUAM Administrator. You can also perform much of the functionality described in this section via scripts as described in Appendix C, Scripts.

Loading the Database

If you are using ITUAM Data Collectors, the batch collection process automatically creates the Ident, Detail, and Summary files used for reporting and loads them into the ITUAM database on a defined schedule (daily, monthly, etc.). For more information about scheduling data collection for ITUAM, refer to the IBM Tivoli Usage and Accounting Manager Data Collectors for Microsoft Windows User’s Guide.

However, for testing and debugging purposes, you might want to load an individual file or files into the database. You can load files from the Edit Process definition dialog box (see ITUAM Administrator Processing on page 7-21) or you can use the dialog boxes described in the following sections.

**Note** • If you receive a warning stating that a file with the same date range has already been loaded, you are probably loading duplicate data. You can click Yes to continue to load the data, but you should delete the previous load immediately after the current load is completed (see Tracking the History of Database Loads on page 6-22).

**Loading From ITUAM Administrator**

This section describes how to load Ident, Detail, and Summary files into the ITUAM database using ITUAM Administrator. Note that this process is normally not required because the files are automatically loaded at the end of batch processing.

**To load a database from ITUAM Administrator:**

1. In the ITUAM Administrator main window, click Chargeback Administration ➤ Database Loading ➤ From ITUAM. The File Load dialog box is displayed as shown in example Figure 6-5.

   ![Figure 6-5 • Server File Load Dialog Box](image-url)
2 Complete the dialog box as follows:

- **File Type.** Click one of the following:
  - **Ident.** This file is created by CIMSAcct. This is the identification file that contains fields such as User ID, department code, division code, server name, etc. These fields are used during account code conversion to create your account code structure.
  - **CIMSAcct Detail.** This file is created by CIMSAcct. This file provides an account code for each input file record processed. This file is used as an input into CIMSBill. *You will rarely need to load this file.*
  - **CIMSBill Detail.** This file is created by CIMSBill. This file is loaded into the database for use in the drill down reports. This file contains resource utilization data.
    
    The CIMSBill Detail file differs from the CIMSAcct Detail file in that the CIMSBill Detail file reflects any proration, CPU normalization, or include/exclude processing that was performed. The CIMSBill Detail file also includes accounting dates.
  - **Summary.** This file is created by CIMSBill. This file contains summarized usage records with applied rates. You can load any number of Summary files individually.

- **File Name.** Enter the path of the database file that you want to load. To browse for a file, click **Select File.** To view the file in Windows Notepad, click **View File.**

- **Destination.** This defaults to the ITUAM Data Source selected in the **Select ITUAM Data Source** list at the bottom of the ITUAM Administrator main window. The files are loaded into the database represented by the data source.

- **Use Bulk Load Interface.** Select this check box to perform a bulk load when loading the database. This option is recommended because it increases the speed of loads. A disadvantage is that if there is an error in the data, a generic rather than specific error message is displayed. In this case, clear this check box and reload to view the specific error message.

3 Click **Load Data.**
Archiving, Purging, and Restoring Database Loads

Note • This feature is available only if you are using SQL Server database.

Archiving and purging database loads is a powerful feature that enables you to remove space and performance consuming data from the database and to store the data in compressed zip files. You can then easily restore the archived data to the database if needed.

Archiving, purging, and restoring loads in the database are defined as follows:

- **Archive.** Saves selected Summary, CIMSBill Detail, Ident, and CIMSAcct Detail loads in a format that you can reload (restore) into the database. Archiving does not delete the load from the database.

- **Purge.** Deletes selected loads from the database.

- **Restore.** Reloads selected purged loads into the database. To use this feature, the loads must be archived.

You can archive loads, archive and purge loads, or purge loads without archiving them. To view a history of the loads that have been archived or purged, see Tracking the History of Database Loads on page 6-22.

Note • You can also use the PurgeLoads.wsf script to purge loads in batch. However, you should consult IBM before using this script because it does not archive the loads before purging them. For more information about this script, see PurgeLoads.wsf Script on page C-17.

To archive database loads:

1. In the ITUAM Administrator main window, click Chargeback Administration → Database Loading → Load Archiving & Purging.

   The Load Archive dialog box is displayed as shown in example Figure 6-6 on page 6-20.
2 In the **Loads Filter** area, set the following filters. These filters determine the loads that are displayed on the **Archive** tab. For example, you can select only CIMSBill Detail loads or only those loads with end dates that are in a certain date range.

- **End Date Range.** Loads are selected by the end date stored in the CIMSLoadTracking table. Click **Use All Dates**, **Use Specific Dates**, or a date keyword to select loads with end dates that fall within the specified date range. For example, if you click **Current Month**, loads with end dates in the current month are selected. If you select **Use Specific Dates**, enter the dates in the from/to boxes.

- **Load Types.** Select the check box or boxes for the load types that you want to archive. These are the loads created by ITUAM Processing Engine. For more information, see Chapter 7, *Processing Data on Windows* or Chapter 8, *Processing Data on UNIX or Linux*.

- **Source File Location.** Click **All** to select loads from all applicable process definitions or click a specific process definition.

- **Show archived loads.** Select this check box to show loads that have been archived. This filter is displayed only when the **Archive** tab is active.
3 Click Apply Filters to retrieve the loads that match the filter criteria.

**Note** • When you change a setting in the Loads Filter area, the loads on the Archive tab disappear until you click Apply Filters or click another tab and return to the Archive tab. Each time that you change the filters, you must apply them.

4 If you want to purge the loads after they are archived, select the Purge loads after archiving check box.

5 On the Archive tab, click the load or loads that you want to archive or click Select All to archive all loads, and then click Archive.

The archived loads are stored in a zip file in the path and folder shown at the bottom of the Load Archive dialog box. This path is set in the on the Archiving tab of the Configuration dialog box (see Database Load Archive Settings on page 6-19). The naming convention for the zip file is CIMSArchive_StartDate_EndDate_SequenceNumber.zip.

**Important!** • If you initialize a database, you should delete any archived files for that database. Errors can occur if you try to reload these files to the originating database or another database.

To purge database loads:

**Important!** • Purging removes database loads from the database. If the loads are not archived before they are purged, you cannot restore the loads to the database.

To purge loads automatically after they are archived, click the Purge loads after archiving check box on the Archive tab.

To purge loads independently of archiving:

1 Set and apply the filters for the loads that you want to purge as described in To archive database loads: on page 6-19.

2 On the Purge tab, click the load or loads that you want to purge or click Select All to purge all loads, and then click Purge.

To restore database loads:

1 Set and apply the filters for the loads that you want to restore as described in To archive database loads: on page 6-19.

2 On the Restore tab, click the individual load or loads that you want to restore or click Select All to restore all loads, and then click Restore.
Tracking the History of Database Loads

You can track the history of Summary, CIMSBill Detail, Ident, and CIMAacct Detail files that have been loaded to or deleted from the database.

To track loads:

1. In the ITUAM Administrator main window, click Chargeback Administration ▶ Database Loading ▶ Load Tracking.

The Load Tracking dialog box is displayed as shown in example Figure 6-7.

2. Use the Loads tab to track the files that have been loaded to the database. This tab provides information such as the type of files loaded, the earliest accounting start date and the latest accounting end date in the files, the date the files were loaded to the database, and whether the files have been archived. You can delete and view loads as follows:

   - **Delete Load.** To remove a load or loads from the database, click the load(s) or click Select All to select all loads, and then click Delete Load.

   - **Delete Load Entry.** To remove a deleted load or loads from the database, click the load(s), and then click Delete Load Entry. Deleted loads are displayed when the Show deleted loads check box on the Filters tab is selected.

   - **Select All.** To select all loads, click Select All.

   - **View Load.** To view a load, click the load, and then click View Load.
3 Use the Filters tab to determine the loads that are displayed on the Loads tab. For example, you can choose to track only CIMSBill Detail file loads or only files that were loaded during a certain date range.

- **Load Types.** Select the check box or boxes for the load types that you want to view. These are the loads created by ITUAM Processing Engine. For more information, see Chapter 7, Processing Data on Windows or Chapter 8, Processing Data on UNIX or Linux.

- **Source File Location.** Click All to view loads from all applicable process definitions or click a specific process definition.

- **End Date Range.** Loads are selected by the accounting end date of the data in the loads. (Note that CIMSAcct Detail loads are selected by the usage end date.) Click Show All Dates, Use Specific Dates, or a date keyword to select loads with end dates that fall within the specified date range. If you select Use Specific Dates, enter the dates in the from/to boxes.

- **Date Loaded Range.** Click Show All Dates, Use Specific Dates, or a date keyword to select loads that were loaded within the specified date range.

- **Show deleted loads.** Select this check box to view loads that have been deleted.

- **Apply Filters.** Click this button to view the loads that match the filter criteria.
Profiling the Database and Tables

You can view profiles of the database and tables. These profiles provide detailed attributes of the data.

To view profiles of a database or table:

1. In the ITUAM Administrator main window, click System Administration ➔ Database ➔ Database Profiler.
   
   The Database Profiler dialog box is displayed.

2. Under Database, you can navigate to view attributes of the database. Under Tables, you can navigate to a specific table and view Dates (created or modified), Columns, Indexes, or Properties information. See Figure 6-8.

Figure 6-8 • Database Profiler Dialog Box
Upgrading the Database

**Important!**  • Back up the database or make sure that it has recently been backed up before you upgrade the database.

The new version or release of ITUAM might contain a new database version. In this case, you will receive notification that a database upgrade is available when you start ITUAM Administrator. Click **Yes**, and then click **Upgrade Database**. If you have more than one database, you will receive this notification each time that you select a ITUAM Data Source that points to a database that is not the latest version.

To view the version of a database at any time, make sure that the ITUAM Data Source for the database is selected in the **Select ITUAM Data Source** list and then click **System Administration ➤ Database ➤ Upgrade Database**.
Processing Data on Windows

This chapter provides an overview of the ITUAM data processing cycle on a Windows system.

About Processing Data ................................................................. 7-3
Data Processing Frequency ......................................................... 7-4
Required Folder or Directory Permissions for Data Processing .......... 7-5
ITUAM Processing Engine Components ........................................ 7-6
CIMSAcct ................................................................. 7-7
CIMSSort ................................................................. 7-11
CIMSBill ................................................................. 7-11
CIMSAdminLib ................................................................. 7-15
ITUAM Processing Engine Architecture Diagram ....................... 7-16
Account Codes and Account Code Conversion .......................... 7-17
About Exception File Processing ................................................. 7-17
Accounting Dates ................................................................. 7-18
About the Close Date ............................................................... 7-18
How Accounting Dates Are Calculated .................................... 7-19
ITUAM Administrator Processing ............................................. 7-21
Adding Process Definitions ....................................................... 7-22
Setting Process Definition Options ......................................... 7-23
Processing Data Using ITUAM Administrator ............................ 7-38
Viewing Events ................................................................. 7-38
Setting Up Account Codes and Performing Account Code Conversion 7-40
Defining the Account Code Structure ...................................... 7-40
Defining the Account Code ..................................................... 7-41
Setting the Account Code Conversion Options ......................... 7-43
Creating an Account Code Conversion Table ............................ 7-45
Account Code Conversion Example ......................................... 7-47
Processing Data on Windows

Prorating Resources ................................................................. 7-50
Prorating Resources vs. Prorating Money .................................. 7-55
Normalizing CPU Values ......................................................... 7-56
Include/Exclude Processing ..................................................... 7-59
Rebilling Rate Codes After Changing Rate Code Values or Conversion Factors .......... 7-65
About Processing Data

ITUAM processes and applies business rules to resource usage data from any application, system, or operating system on any platform. The primary method for loading this data into ITUAM is the CSR or CSR+ file.

You can process data on a Windows system in either of the following ways:

■ **In batch (recommended).** Using the ITUAM console application, ITUAM Job Runner, ITUAM Data Collectors that run on Windows can be run in batch mode on a defined schedule (daily, monthly, etc.) to convert usage metering data created by your system into CSR or CSR+ files. For more information about ITUAM Data Collectors and Job Runner, refer to the *IBM Tivoli Usage and Accounting Manager Data Collectors for Microsoft Windows User's Guide*.

Once the CSR or CSR+ files are created, the data in the files is processed and the output is loaded into the database using the ITUAM Processing Engine components `CIMSACCT.dll`, `CIMSBILL.dll`, `CIMSSORT.dll`, `CIMSAdminLib.dll`, and `CIMSResr1.dll`.

■ **From ITUAM Administrator.** Although not intended for daily processing, you can also process CSR or CSR+ files using ITUAM Administrator. For example, you can use ITUAM Administrator to process the sample files that are provided with ITUAM for demonstration purposes. To process files using ITUAM Administrator, see *Processing Data Using ITUAM Administrator* on page 7-38.

The primary use of ITUAM Administrator in regards to processing is to set the processing options required by the key processing programs, CIMSAcct and CIMSBill. These programs are responsible for assigning accountability and cost for resources consumed, respectively. The process settings for CIMSAcct and CIMSBill are described in *ITUAM Administrator Processing* on page 7-21.
Data Processing Frequency

The preferred method of processing is to run the full data processing cycle as the data becomes available. The data produced by the various operating systems (z/OS®, UNIX, Linux, Windows, Open VMS, etc.) and applications/databases (CICS, DB2, Oracle, IIS, Exchange Server, etc.) are usually made available for processing on a daily basis. Other feeds such as time accounting, help desk, line charges, equipment charges, and other shared services are usually produced on a monthly basis.

There are several advantages to running the full costing cycle on a daily or data availability basis:

- The volume of data created makes it more practical to process daily. A daily Apache Web server access log might contain millions of records. It is more efficient to process these records each day of the month rather than try to run many millions of records through the processing cycle at month end.

- It is easier to catch processing errors when the data is reviewed on a daily basis. It is more difficult to troubleshoot a problem when it is discovered at month end. If an unusual increase in utilization is observed for a specific resource at month end, the entire month’s records must be checked to determine when the increase first took place.

   Because there are fewer jobs, transactions, or records to review, the task of determining what caused the utilization spike is much simpler if caught on the day in which it occurred.

- If the program CIMSBill is run monthly, the start date is the first day of the month and the end date is the last day of the month. Because of this date range, it is not possible to view Summary records for a single day or week. The smallest time range that may be used is the entire month.
Required Folder or Directory Permissions for Data Processing

The administrator that executes processes using ITUAM Data Collectors or ITUAM Administrator requires full access to files in the Processes folder (that is, the ability to create, modify, delete, overwrite, etc.). Therefore, the Windows user account or group account for the administrator must have Full Control security permissions for the Processes folder and all subfolders.
ITUAM Processing Engine Components

ITUAM Processing Engine is composed of COM components. Each component performs particular functions in the processing cycle. Table 7-1 describes the ITUAM Processing Engine COM components in the order that they are used in the processing cycle and the output files created by the objects as applicable.

<table>
<thead>
<tr>
<th>COM Object</th>
<th>Description</th>
<th>Output Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIMSACCT.dll</td>
<td>Performs account code conversion, shift determination, date selection, and identifier extraction on the data contained in the CSR or CSR+ file. The input file could also be the CIMSAct Detail File previously produced by CIMSAcct.</td>
<td>▪ Ident. This file is loaded into the database.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ CIMSAct Detail. This file is input into CIMSSort or can be reprocessed through CIMSAcct.</td>
</tr>
<tr>
<td></td>
<td>For more information about CIMSAcct, including a description if its input and output files, see page 7-7.</td>
<td>▪ Sorted CIMSAcct Detail. This file is input into CIMSBill.</td>
</tr>
<tr>
<td>CIMSSORT.dll</td>
<td>Sorts the CIMSAcct Detail file and produces a version of the file that is ready to be processed by CIMSBill.</td>
<td>▪ CIMSBill Detail. This file is loaded into the database or can be reprocessed through CIMSBill.</td>
</tr>
<tr>
<td>CIMSBILL.dll</td>
<td>Processes the sorted CIMSAcct Detail file from CIMSSort and performs shift processing, CPU normalization, proration, and include/exclude processing and creates files that contain the billing information used to generate invoices and reports.</td>
<td>▪ Summary. This file is loaded into the database or can be reprocessed through CIMSAcct.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Summary. This file is loaded into the database or can be reprocessed through CIMSAcct.</td>
</tr>
<tr>
<td>CIMSAdminLib.dll</td>
<td>Contains the class CCIMSCBSLoad that loads the output files from CIMSAcct and CIMSBill into the database.</td>
<td>▪ Summary. This file is loaded into the database or can be reprocessed through CIMSAcct.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Summary. This file is loaded into the database or can be reprocessed through CIMSAcct.</td>
</tr>
<tr>
<td>CIMSResr1.dll</td>
<td>Supports CIMSAcct and CIMSBill.</td>
<td>▪ Summary. This file is loaded into the database or can be reprocessed through CIMSAcct.</td>
</tr>
</tbody>
</table>

Table 7-1 • ITUAM Processing Engine Components (Windows)
CIMSAcct

CIMSAcct is the first data processing program that is executed. CIMSAcct processes the records in the input file (see CIMSAcct Input on page 7-8) and performs the following:

- **Identifier extraction and account code conversion.** CIMSAcct extracts the identifiers from the input file records and creates the Ident file, which is loaded into the database. It also uses specified identifiers to build the account code and perform account code conversion if required. For more information, see Setting Up Account Codes and Performing Account Code Conversion on page 7-40.

- **Date selection.** CIMSAcct selects the input file records to be processed based on the specified date or date range. For more information, see Date Selection on page 7-27.

- **Shift determination.** CIMSAcct can determine the shift to be used for processing in either of the following ways:
  - Use the shift code from the input file records. If a shift code is not included, the default shift code is 1.
  - Recalculate the shift using the start date/time in the records. For more information, see Shifts Subtab on page 7-29.

CIMSAcct produces the CIMSAcct Detail file, which contains records that are properly formatted for input into CIMSBill.

**Reprocessing CIMSAcct and CIMSBill Output Files**

You can reprocess the CIMSAcct Detail file and the Summary file from CIMSBill through CIMSAcct. This is usually done to reprocess data for further account code conversion. To reprocess either of these files during the data collection process, specify the file name in the XML job file used for data collection. For more information, refer to the documentation on the CIMSAcct parameter attribute `inputFile` in the IBM Tivoli Usage and Accounting Manager Data Collectors for Microsoft Windows User’s Guide.
CIMSAcct Input

Table 7-2 lists the input and processing files used by CIMSAcct. These files are in the process definition subfolders in the Processes folder.

The file names in Table 7-2 are the default names used by both ITUAM Data Collectors and ITUAM Administrator. If you do not use the default names, you should ensure that the same file names are used for both programs.

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Files (CIMSAcct can process usage data from any of the following sources)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CSR or CSR+ file</td>
<td>CurrentCSR.txt</td>
<td>These are the most commonly used files for processing data through ITUAM.</td>
</tr>
<tr>
<td></td>
<td>Or</td>
<td>To view the record layout for these files, see Appendix B, File Layouts.</td>
</tr>
<tr>
<td></td>
<td>yyyyymmdd.txt</td>
<td></td>
</tr>
<tr>
<td>CIMSAcct Detail file</td>
<td>Detail.txt</td>
<td>This file is the output from a previous run of CIMSAcct.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This file provides an account code for each input file record. This file is input into the CIMSSort process.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When used as input into CIMSAcct, this file is used primarily in the reprocessing of data for date selection or further account code conversion.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The records within this file are also referred to as maintenance or 991 records.</td>
</tr>
<tr>
<td>Summary file</td>
<td>BillSummary.txt</td>
<td>This file is the output from a previous run of CIMSBill. When used as input into CIMSAcct, this file is used primarily for reprocessing data for further account code conversion.</td>
</tr>
</tbody>
</table>
### Processing Files

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control file</td>
<td>AcctCntl.txt</td>
<td>This file contains the CIMSAcct control statements (see CIMSAcct Control Statements on page D-2).</td>
</tr>
<tr>
<td>Account Code Conversion Table</td>
<td>AcctTabl.txt</td>
<td>This optional file contains the account code conversion table (see Creating an Account Code Conversion Table on page 7-45).</td>
</tr>
<tr>
<td>Process Control file</td>
<td>ProcessCntl.txt</td>
<td>This file contains the processing statements used by ITUAM Administrator (see Processing Control Statements on page D-24).</td>
</tr>
</tbody>
</table>

Table 7-2 • CIMSAcct Input (Continued)
CIMSAcct Output

Table 7-3 lists the CIMSAcct output files. These files are in the process definition subfolders in the Processes folder.

The file names in Table 7-3 are the default names used by both ITUAM Data Collectors and ITUAM Administrator. If you do not use the default names, you should ensure that the same file names are used for both programs.

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIMSAcct Detail file</td>
<td>Detail.txt</td>
<td>This file provides an account code for each input file record. This file is input into CIMSSort.</td>
</tr>
<tr>
<td>Ident file</td>
<td>Ident.txt</td>
<td>This file contains all the identifiers (such as user ID, jobname, department code, server name, etc.) that are contained in the input records. These identifiers are used during account code conversion to create your target account code structure. This file is loaded into the database.</td>
</tr>
<tr>
<td>CIMSAcct Message file</td>
<td>AcctMsg.txt</td>
<td>This file contains processing messages related to CIMSAcct.</td>
</tr>
<tr>
<td>CIMSAcct COBOL Message file</td>
<td>AcctMsg_cob.txt</td>
<td>This file contains any runtime COBOL messages related to CIMSAcct. If there are no errors, this file is blank.</td>
</tr>
<tr>
<td>CIMSAcct Results file</td>
<td>AcctResults.txt</td>
<td>This file contains the CIMSAcct processing results.</td>
</tr>
<tr>
<td>Exception file</td>
<td>Exception.txt</td>
<td>This is an optional file in CSR or CSR+ format that contains all records that did not match during account code conversion. These files can be reprocessed through the processing cycle as described in About Exception File Processing on page 7-17. To produce this file, you must have exception file processing enabled (see page 7-43).</td>
</tr>
<tr>
<td>CSR+ file</td>
<td>CSRFile.txt</td>
<td>The output of a CSR+ file from CIMSAcct is optional.</td>
</tr>
<tr>
<td>Windows Message Events</td>
<td></td>
<td>Events are written to the Windows Event Viewer when the CIMSAcct process starts and ends and when and warnings or errors are encountered while processing.</td>
</tr>
</tbody>
</table>
CIMSSort

CIMSSort sorts the CIMSAcct Detail file and produces a version of the file that is ready to be processed by CIMSBill.

CIMSBill

The cost of information services, and which departments are using the services, is of considerable interest to an organization. When users are made aware of the costs and are held financially responsible for those costs, they are more likely to use the resources in a prudent manner. ITUAM provides comprehensive computer center billing through the program CIMSBill.

The primary function of CIMSBill is to perform cost extensions within ITUAM and to summarize cost and resource utilization by account code. CIMSBill uses the rate table assigned to the client (see Working With Clients on page 4-19) to determine the amount to be charged for each resource consumed. It is possible to have a unique rate table for each client.

There are specific rules that CIMSBill follows when charging resource consumption:

- If a resource has a corresponding entry with a monetary amount in the rate table, the number of resource units are multiplied by this amount. The result appears in the Summary records.
- If a resource has a corresponding entry with no or zero currency amount in the rate table, a zero cost appears in the Summary records for that resource.
- If a resource does not have a corresponding entry in the rate table, the data for that resource does not appear in the Summary records.
- If none of the resources in the CIMSBill input file have a corresponding entry in the rate table, the Summary file will contain no records. If the Load Summary records check box is selected in ITUAM Administrator (see page 7-24), the Ident file, CIMSBill Detail file, and Summary file are not loaded to the database—the process fails and a failure message is issued. You must have at least one rate code from the input file in the rate table to produce Summary records.

If the Load Summary records check box is not selected, the Ident file and CIMSBill Detail file load to the database if the Load Ident records and Load CIMSBILL Detail records check boxes are selected.
In addition to standard costing, CIMSBill also performs the following:

- Processes non-standard costs such as miscellaneous, recurring, and credit transactions. For more information about creating and using transactions, refer to the *IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide*.

- Performs proration. See *Prorating Resources* on page 7-50.

**Note** • Although you can perform proration using CIMSBill, the CIMSPPrat program provides more options for proration and enables you to prorate resources multiple times. For more information about proration using CIMSPPrat, refer to the *IBM Tivoli Usage and Accounting Manager Data Collectors for Microsoft Windows User’s Guide*.

- Performs CPU Normalization. See *Normalizing CPU Values* on page 7-56.

- Performs include/exclude processing. See *Include/Exclude Processing* on page 7-59.
CIMSBill Input

Table 7-4 lists the input and processing files used by CIMSBill. These files are in the process definition subfolders in the Processes folder.

The file names in Table 7-4 are the default names used by both ITUAM Data Collectors and ITUAM Administrator. If you do not use the default names, you should ensure that the same file names are used for both programs.

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Files</td>
<td>CIMSSort/CIMSAcct</td>
<td>This is the sorted Detail file from CIMSAcct.</td>
</tr>
<tr>
<td></td>
<td>Detail.txt</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CIMSBill Detail file</td>
<td>This file is the output from a previous run of CIMSBill. When used as input into CIMSBill, this file is used primarily for performing additional proration functions. To reprocess this file during the data collection process, define the file as an input to CIMSBill in the XML job file. For more information, refer to the IBM Tivoli Usage and Accounting Manager Data Collectors for Microsoft Windows User’s Guide.</td>
</tr>
<tr>
<td></td>
<td>BillDetail.txt</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Summary file</td>
<td>This file is the output from a previous run of CIMSBill. When used as input into CIMSBill, this file is used primarily for performing additional proration functions. To reprocess this file during the data collection process, define the file as an input to CIMSBill in the XML job file. For more information, refer to the IBM Tivoli Usage and Accounting Manager Data Collectors for Microsoft Windows User’s Guide.</td>
</tr>
<tr>
<td></td>
<td>BillSummary.txt</td>
<td></td>
</tr>
</tbody>
</table>

Table 7-4  •  CIMSBill Input
Processing Data on Windows
ITUAM Processing Engine Components

Table 7-5 lists the CIMSBill output files. These files are in the process definition subfolders in the Processes folder.

The file names in Table 7-5 are the default names used by both ITUAM Data Collectors and ITUAM Administrator. If you do not use the default names, you should ensure that the same file names are used for both programs.

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIMSBill Detail file</td>
<td>BillDetail.txt</td>
<td>This file is loaded into the database for use in drill down reports. This file contains resource utilization data. The CIMSBill Detail file differs from the CIMSAcct Detail file in that the CIMSBill Detail file reflects any proration, CPU normalization, or include/exclude processing that was performed. The CIMSBill Detail file also includes accounting dates.</td>
</tr>
<tr>
<td>Summary file</td>
<td>BillSummary.txt</td>
<td>This file is loaded into the database for use in producing reports. This file contains both resource utilization and cost data.</td>
</tr>
<tr>
<td>Prorate Report</td>
<td>ProrateRep.txt</td>
<td>This is an optional report that contains the original record and all subsequently-generated prorated records. To enable this report, see page 7-50.</td>
</tr>
<tr>
<td>CIMSBill Message file</td>
<td>BillMsg.txt</td>
<td>This file contains processing messages related to CIMSBill.</td>
</tr>
</tbody>
</table>

Table 7-5 • CIMSBill Output
CIMSAdminLib is the central controlling library for all Windows-based ITUAM functions. It contains all the COM objects used to manipulate ITUAM data. These objects are called from ITUAM Administrator and Windows Script Host (.wsf) scripts used by ITUAM Data Collectors and ITUAM.

CIMSAdminLib contains the class CCIMSCBSLoad that loads the output files from CIMSAcct and CIMSBill into the database.
ITUAM Processing Engine Architecture Diagram

The diagram in Figure 7-1 shows the input and output for ITUAM Processing Engine on a Windows system. For simplicity, this diagram shows only the key input and output. For a complete description of all input and output, refer to the preceding sections.
Account Codes and Account Code Conversion

Within chargeback and resource accounting, an account code uniquely identifies an individual, billing, or reporting entity. The actual definition of what the account code represents depends on how ITUAM is used. For example, an account code can represent an organization, a department in an organization, or an individual.

A key feature of CIMSAcct is its ability to use business rules to convert the identifier values in the CSR or CSR+ files into account codes. In some cases, the identifier value in the CSR or CSR+ file is the actual account code. However, in most cases, the identifier value represents the source of the consumed resources (i.e., a user ID, IP address, server name, jobname, transaction ID, terminal ID, etc.).

CIMSAcct uses an account code conversion table to convert identifier values into an account code. For example, an IP address of 10.26.12.255 is converted to the account code for Human Resources while an address of 10.26.12.260 is converted to the account code for Accounts Payable. These departments can then be charged for the consumption of the resources associated with their IP addresses.

For the steps required to set up account code conversion, see page 7-40. For an example of these steps, see page 7-47.

About Exception File Processing

During account code conversion, CIMSAcct might encounter input file records that do not match any entry in the account code conversion table. CIMSAcct includes an optional exception file processing feature that automatically identifies and removes unmatched records so that they can be reprocessed with the correct accounting information.

When this feature is enabled, all unmatched records are output to an exception file in the process definition subfolder. You can use the exception file to identify the information that needs to be corrected, either in the records in the exception file or in the account code conversion table, and then reprocess the exception file.

To enable the exception file processing feature, see Setting the Account Code Conversion Options on page 7-43.
Accounting Dates

ITUAM input records contain a usage start date and end date that specify the date range in which the resources in the record were consumed. CIMSBill uses the usage end date to calculate accounting start and end dates, which are used for billing and reporting.

If a close date is not set, the accounting dates produced by CIMSBill are always the same as the usage end date in the input file records.

If a close date is set, the accounting dates may be the same as or different than the usage end date depending on the factors described in How Accounting Dates Are Calculated on page 7-19.

The accounting start and end dates are stored in the following fields in the CIMSBill output files:

- **CIMSBill Detail file.** The accounting dates are in the `ACCOUNTING-START-DATE` and `ACCOUNTING-END-DATE` fields (starting positions 159 and 168, respectively).

- **Summary file.** The accounting dates are in the `AccountingFromDate` and `AccountingToDate` fields (starting positions 167 and 175, respectively). The `Period` and `Year` fields also reflect the accounting end dates. (These fields are at starting positions 282 and 284, respectively.) For example, if the end date is 20050916 and the date falls within the 9th period in the CIMSCalendar table, the `Period` field would contain 09 and the `Year` field 2005.

About the Close Date

You can set an optional close date for processing input file records. Typically, the close date is set for the same date each month to close data processing for the previous month. For example, if you set the close date for the third of each month, the close date for January data would be February 3, the close date for February data would be March 3, etc. This allows any input records with usage end dates from the previous month to be processed with that month.

**Example**

Assume that in November you are processing input records with usage end dates in October. If the close date is the third of each month, all records with an October usage end date that are processed on November 1–3 will be processed with accounting dates in October. All records with an October usage end date processed from November 4 to December 3 will be processed with accounting dates in November.

You can set a system-wide close date or set close dates for individual process definitions. To set a system-wide close date, see page 4-43. To set close dates for an individual process definition or definitions, see page 7-32.
Using a Specific Close Date

When you set a specific close date, that date is applied to the applicable period in the CIMSCalendar table. For example, if you are using the default periods in the CIMSCalendar table and you set a close date of October 3, this close date is set for period 9 (September 1—September 30). When you set a specific close date, you should set the close date for the current period or the preceding period only.

How Accounting Dates Are Calculated

The accounting dates are calculated according to the usage end dates, the close date (see About the Close Date on page 7-18), and the periods defined in the CIMSCalendar table. The accounting dates may be the same as or different than the usage end date depending on the factors described in the following sections.

Scenarios in Which Accounting Dates and Usage End Dates are Always the Same

The accounting dates and usage end date are always the same in the following situations:

- If no close date is set.
- If both the CIMSBill run date and the usage end date are in the same period (as set in the CIMSCalendar table), regardless of the close date.

Example Using Calendar Month Periods With Monthly Close Date

<table>
<thead>
<tr>
<th>Current Period</th>
<th>Close Date for Current Period</th>
<th>CIMSBill Run Date</th>
<th>Usage End Date</th>
<th>Accounting Dates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sept. 1–30 (Period 9)</td>
<td>Oct. 3</td>
<td>Sept. 30</td>
<td>Sept. 16</td>
<td>Sept. 16</td>
</tr>
</tbody>
</table>

Example Using Non Calendar Month Periods With Specific Close Date

<table>
<thead>
<tr>
<th>Current Period</th>
<th>Close Date for Current Period</th>
<th>CIMSBill Run Date</th>
<th>Usage End Date</th>
<th>Accounting Dates</th>
</tr>
</thead>
</table>
If the usage end date is in the previous period and the CIMSBill run date is prior to the close date for that period.

Example Using Calendar Month Periods With Monthly Close Date

<table>
<thead>
<tr>
<th>Previous Period</th>
<th>Close Date for Prev. Period</th>
<th>Current Period</th>
<th>CIMSBill Run Date</th>
<th>Usage End Date</th>
<th>Accounting Dates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aug. 1–31 (Period 8)</td>
<td>Sept. 3</td>
<td>Sept. 1–30 (Period 9)</td>
<td>Sept. 2</td>
<td>Aug. 16</td>
<td>Aug. 16</td>
</tr>
</tbody>
</table>

Example Using Non Calendar Month Periods With Specific Close Date

<table>
<thead>
<tr>
<th>Previous Period</th>
<th>Close Date for Prev. Period</th>
<th>Current Period</th>
<th>CIMSBill Run Date</th>
<th>Usage End Date</th>
<th>Accounting Dates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aug. 23–Sept. 22 (Period 8)</td>
<td>Sept. 25</td>
<td>Sept. 23–Oct. 22 (Period 9)</td>
<td>Sept. 24</td>
<td>Sept. 1</td>
<td>Sept. 1</td>
</tr>
</tbody>
</table>

Scenarios in Which Accounting Dates and Usage End Dates are Different

The accounting dates and usage end date are different in the following situations:

- If the usage date is in any previous period and the CIMSBill run date is after the close date for the period immediately prior to the current period, the accounting dates are set to the previous day from the day CIMSBill was run.

Example Using Calendar Month Periods With Monthly Close Date

Note that for example purposes, the period immediately prior to the current period is used. However, this example is applicable for any previous period.

<table>
<thead>
<tr>
<th>Previous Period</th>
<th>Close Date for Prev. Period</th>
<th>Current Period</th>
<th>CIMSBill Run Date</th>
<th>Usage End Date</th>
<th>Accounting Dates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aug. 1–31 (Period 8)</td>
<td>Sept. 3</td>
<td>Sept. 1–30 (Period 9)</td>
<td>Sept. 5</td>
<td>Aug 16 (CIMSBill run date -1 day)</td>
<td>Sept. 4</td>
</tr>
</tbody>
</table>

Example Using Non Calendar Month Periods With Specific Close Date

<table>
<thead>
<tr>
<th>Previous Period</th>
<th>Close Date for Prev. Period</th>
<th>Current Period</th>
<th>CIMSBill Run Date</th>
<th>Usage End Date</th>
<th>Accounting Dates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aug. 23–Sept. 22 (Period 8)</td>
<td>Sept. 25</td>
<td>Sept. 23–Oct. 22 (Period 9)</td>
<td>Oct. 22</td>
<td>Sept. 1 (CIMSBill run date -1 day)</td>
<td>Oct. 21</td>
</tr>
</tbody>
</table>
If the usage end date is in any period prior to the previous period and the CIMSBill run date is before the close date for the previous period, the accounting dates are set to the last day of the previous period.

Example Using Calendar Month Periods

<table>
<thead>
<tr>
<th>Period Prior to Previous Period</th>
<th>Close Date for Prev. Period</th>
<th>Current Period</th>
<th>CIMSBill Run Date</th>
<th>Usage End Date</th>
<th>Accounting Dates</th>
</tr>
</thead>
<tbody>
<tr>
<td>July 1–31 (Period 7)</td>
<td>Sept. 3</td>
<td>Sept. 1–30 (Period 9)</td>
<td>Sept. 2</td>
<td>July 16</td>
<td>Aug. 31 (Last day of previous period)</td>
</tr>
</tbody>
</table>

Example Using Non Calendar Month Periods With Specific Close Date

<table>
<thead>
<tr>
<th>Period Prior to Previous Period</th>
<th>Close Date for Prev. Per. (Aug. 23–Sept.22)</th>
<th>Current Period</th>
<th>CIMSBill Run Date</th>
<th>Usage End Date</th>
<th>Accounting Dates</th>
</tr>
</thead>
<tbody>
<tr>
<td>July 23–Aug. 22 (Period 7)</td>
<td>Sept. 25</td>
<td>Sept. 23–Oct. 22 (Period 9)</td>
<td>Sept. 24</td>
<td>July 20</td>
<td>Sept. 22 (Last day of previous period)</td>
</tr>
</tbody>
</table>

ITUAM Administrator Processing

In ITUAM Administrator, you can set processing definitions that instruct ITUAM how to execute processing jobs for different types of input resource data. A process definition is a folder that contains the files required to process usage data from a particular source such as a database, operating system, or application.

**Note** If you are using ITUAM Data Collectors, process definition folders and required processing files are created automatically.

The settings that you select for the process definition are stored in the AcctCntl.txt, BillCntl.txt, and ProcessCntl.txt files in the process definition folder. AcctCntl.txt and BillCntl.txt contain the CIMSAcct and CIMSBill control statements, respectively. (For a list of these statements, see page D-2 and page D-13). ProcessCntl.txt contains process settings used by ITUAM Administrator (see page D-24).

You can edit these files using a text editor or through ITUAM Administrator. For example, if you select the Perform Account Code Conversion check box in ITUAM Administrator (see page 7-43), the control statement ACCOUNT CODE CONVERSION is automatically added to the AcctCntl.txt file.
Adding Process Definitions

When you add a process definition, ITUAM Administrator builds a folder within the process definition path (see Processing Settings on page 4-43) and creates the necessary process definition files within this new folder. The folder shares the name of the process definition.

To add a process definition:

1. In the ITUAM Administrator main window, click Chargeback Administration ➤ Processing ➤ Process Definitions. The Process Definitions List Maintenance dialog box is displayed as shown in example Figure 7-2.

![Process Definitions List Maintenance Dialog Box]

2. Click Add.

3. Type a name for the process definition in the Add New Process Definition dialog box, and then click OK.

   The Edit Process Definition dialog box is displayed.

4. Edit the new process definition as needed (see Setting Process Definition Options on page 7-23).

To remove or rename a process definition, click the definition in the Process Definitions Maintenance List dialog box and click Remove or Rename.
Setting Process Definition Options

The Edit Process Definition dialog box includes a number of tabs and subtabs that contain settings for the process definition. The main tabs are:

- Process Options
- Account Options
- Bill Options
- Process Results
- Versions

The following sections describe the options that are available on these tabs by subtab. Where applicable, the correlating control or processing statement for each option is also provided.

**Process Options Tab**
This tab contains the following subtabs: General, Processing, and Database.

**General Subtab**
This subtab displays the name and path of the process definition. You can also use this tab to add a description of the process definition.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Correlating Control File and Statement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Definition Path</td>
<td>None</td>
</tr>
<tr>
<td>The path for the process definition folders. The use of a UNC path is recommended (e.g., <code>\SRV1\D$\Processes</code>).</td>
<td></td>
</tr>
<tr>
<td>Process Name</td>
<td>None</td>
</tr>
<tr>
<td>The process name. This name is also shared by the folder that contains the process definition files.</td>
<td></td>
</tr>
<tr>
<td>Process Description</td>
<td>File: ProcessCntl.txt</td>
</tr>
<tr>
<td>Type an optional short description of the process definition.</td>
<td>Statement:</td>
</tr>
<tr>
<td></td>
<td>Description description</td>
</tr>
</tbody>
</table>
### Processing Subtab
Use this subtab to specify the processing options such as processing programs that you want to run and the output files that you want to load to the database.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Correlating Control File and Statement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Run CIMSACCT</strong></td>
<td>File: ProcessCntl.txt</td>
</tr>
<tr>
<td>Select this check box to instruct the system to run CIMSACct as part of this process.</td>
<td>Statement: RunCIMSACct Yes/No</td>
</tr>
<tr>
<td><strong>Run CIMSBILL</strong></td>
<td>File: ProcessCntl.txt</td>
</tr>
<tr>
<td>Select this check box to instruct the system to run CIMSBILL as part of this process.</td>
<td>Statement: RunCIMSBill Yes/No</td>
</tr>
<tr>
<td><strong>Remove output files before processing</strong></td>
<td>File: ProcessCntl.txt</td>
</tr>
<tr>
<td>Select this check box if you want to delete previous output files from the process definition folder. This ensures that old data is not loaded into the database. This check box should be selected unless you are running CIMSBILL or database loads only.</td>
<td>Statement: RemoveFilesBeforeProcessing Yes/No</td>
</tr>
<tr>
<td><strong>Archive process files</strong></td>
<td>File: ProcessCntl.txt</td>
</tr>
<tr>
<td>Select this check box to archive previous output files before processing. Archived files contain a date in the file name. Archived files for the same date are indicated by a number (1, 2, 3...) at the end of the file name. Note that if you select this option, you can potentially have a large number of archived files in the process definition folder.</td>
<td>Statement: ArchiveProcessFiles Yes/No</td>
</tr>
<tr>
<td><strong>Note:</strong> This option is not related to the archive database loads feature described in Archiving, Purging, and Restoring Database Loads on page 6-19.</td>
<td></td>
</tr>
<tr>
<td><strong>Load Ident records</strong></td>
<td>File: ProcessCntl.txt</td>
</tr>
<tr>
<td>Select this check box to load Ident files from CIMSACct into the database.</td>
<td>Statement: AutoLoadIdentFile Yes/No</td>
</tr>
<tr>
<td><strong>Load Summary records</strong></td>
<td>File: ProcessCntl.txt</td>
</tr>
<tr>
<td>Select this check box to load Summary files from CIMSBILL into the database.</td>
<td>Statement: AutoLoadSummaryFile Yes/No</td>
</tr>
</tbody>
</table>
### Setting

<table>
<thead>
<tr>
<th><strong>Load CIMSBILL Detail records</strong></th>
<th>Correlating Control File and Statement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select this check box to load CIMSBill Detail files into the database.</td>
<td>File: ProcessCntl.txt</td>
</tr>
<tr>
<td>Statement: AutoLoadDetailFile Yes/No</td>
<td>Statement:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Load CIMSAcct Detail records</strong></th>
<th>Correlating Control File and Statement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select this check box to load the CIMSAcct Detail files into the database. Consult IBM before using this option.</td>
<td>File: ProcessCntl.txt</td>
</tr>
<tr>
<td>Statement: AutoLoadResourceFile Yes/No</td>
<td>Statement:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Use bulk load interface</strong></th>
<th>Correlating Control File and Statement</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you are using a SQL Server database, select this check box to perform a bulk load when loading the database. (Bulk load is performed automatically if you are using an Oracle database.)</td>
<td>File: ProcessCntl.txt</td>
</tr>
<tr>
<td>This option is recommended because it increases the speed of loads. A disadvantage is that if there is an error in the data, a generic rather than specific error message is displayed. In this case, clear this check box and reprocess to view the specific error message.</td>
<td>Statement: UseBulkLoadInterface Yes/No</td>
</tr>
</tbody>
</table>
### Database Subtab

Use this subtab to select the ODBC data source for the ITUAM database that you want to use for processing the data and storing the output Ident, Detail, and Summary files. In most cases, this will be the database that ITUAM Administrator is currently pointing to.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Correlating Control File and Statement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use same database connection information as ITUAM Administrator</td>
<td>File: ProcessCntl.txt</td>
</tr>
<tr>
<td>Leave this check box selected (the default) to use the database that ITUAM Administrator is currently pointing to.</td>
<td>Statement: DSN name</td>
</tr>
<tr>
<td>Automatically generate ODBC INF file</td>
<td>File: ProcessCntl.txt</td>
</tr>
<tr>
<td>Leave this check box selected (the default). This file is required.</td>
<td>Statement: GenerateODBCINF Yes/No</td>
</tr>
<tr>
<td>Data Source Name</td>
<td>File: ProcessCntl.txt</td>
</tr>
<tr>
<td>Database User ID/Password</td>
<td>Statements:</td>
</tr>
<tr>
<td>These options are deprecated and are retained for legacy purposes only.</td>
<td>DSN name</td>
</tr>
<tr>
<td></td>
<td>DSNUID user ID</td>
</tr>
<tr>
<td></td>
<td>DSNPWD password</td>
</tr>
</tbody>
</table>
Account Options Tab

This tab contains the following subtabs: General, Files, Account Codes, Shifts, and Trace.

General Subtab

Use this subtab to specify general CIMSAcct settings such as the record type and date range for the input records to be processed.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Correlating Control File and Statement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Type</td>
<td>File: AcctCntl.txt</td>
</tr>
<tr>
<td></td>
<td>Statement:</td>
</tr>
<tr>
<td></td>
<td>Process record type (see page D-9)</td>
</tr>
<tr>
<td>Date Selection</td>
<td>File: AcctCntl.txt</td>
</tr>
<tr>
<td></td>
<td>Statement:</td>
</tr>
<tr>
<td></td>
<td>DATE SELECTION YYYYMMDD YYYYMMDD/keyword (see page D-5)</td>
</tr>
</tbody>
</table>

No Date Selection

Use Specific Dates. Enter the dates in the Start Date and End Date boxes.

Run Date (Today). Selects records based on the run date.

Previous Day to Current Day. Selects records based on the run date and the run date less one day.

Current Week. Selects records based on the run week (Sat–Sun).

Current Month. Selects records based on the run month.

Previous Day. Selects records based on the run date, less one day.

Previous Week. Selects records based on the previous week (Sat–Sun).

Previous Month. Selects records based on the previous month.
### Files Subtab

Use this subtab to define the CIMSAcct input and output files.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Correlating Control File and Statement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input File</strong></td>
<td>File: ProcessCntl.txt</td>
</tr>
<tr>
<td>The input file to be processed by CIMSAcct. The default is <code>CurrentCSR.txt</code>. To select another file, click <code>Browse</code>. To edit the file in Windows Notepad, click <code>Edit</code>.</td>
<td>Statement: <code>AcctInputFile filename</code></td>
</tr>
<tr>
<td><strong>Output Files</strong></td>
<td>File: ProcessCntl.txt</td>
</tr>
<tr>
<td>The names of the CIMSAcct output files (the CIMSAcct Detail, Ident, Exception, and CSR+ [optional] files). CIMSAcct writes these files to the path listed above the file names. The use of the default file names is recommended.</td>
<td>Statement: <code>AcctOutputDetailFile filename</code> <code>AcctOutputIdentFile filename</code> <code>AcctOutputExceptionFile filename</code> <code>CSRPFFile filename</code></td>
</tr>
<tr>
<td><strong>Create CSR Plus</strong></td>
<td>File: ProcessCntl.txt</td>
</tr>
<tr>
<td>The creation of a CSR+ file is optional. Select this check box to create a CSR+ file.</td>
<td>Statement: <code>CreateCSRPFFile Yes</code></td>
</tr>
</tbody>
</table>
Account Codes Subtab
This subtab allows you to build the account code from the identifiers in the input file and to convert the account code if needed. For a description of the options on this subtab and an explanation of account codes and account code conversion, see Setting Up Account Codes and Performing Account Code Conversion on page 7-40.

Shifts Subtab
As described in Setting Rate Shifts on page 4-13, you can set rates for a rate code by shift. This optional feature enables you to set different rates based on the time of day.

If you want ITUAM to use the shift codes that appear in the input records to process the rate codes in the record, leave this tab blank. The shift codes that appear in the input records will appear in the CIMSAcct Detail file. If there is no shift code in the input record, the default shift code is 1.

If you do not want to use the shift codes in the input record for processing, you can use this subtab to recalculate the shifts using the start date/time in the records. For each shift that you want to create, enter a shift number and a time for the end of the shift. CIMSAcct compares the start dates and times in the input records to the daily shifts that you specify on this subtab and calculates new shift codes.

You can enter up to nine shifts per day. The shift end times must be listed in 4-character, 24-hour format (see example Figure 7-3 on page 7-30). The recalculated shift codes rather than the original shift codes appear in the CIMSAcct Detail file.

Regardless of whether you use the rate codes from the input file or recalculate the rate codes, you must select the Use Shift Codes check box on the Bill Options/General subtab (see page 7-33). If you do not select this check box, CIMSBill uses the default rate shift 1 regardless of the shift code that appears in the CIMSAcct Detail file.

For the related AcctCntl.txt control statements for setting up shifts, see page D-11.

In the following example, shift 3 is from midnight to 8 a.m., shift 1 is from 8 a.m. to 4 p.m., and shift 2 is from 4 p.m. to midnight.
Figure 7-3 • Shifts Subtab
Trace Subtab

**Note** • By default, tracing is disabled. Consult IBM before using one of the CIMSAcct trace flags described in this section.

Use this subtab to include the following trace messages in the CIMSAcct Message file, AcctMsg.txt:

- **General processing.** This is information related to CIMSAcct processing of the information in the account, define, and move fields.

- **Account code conversion.** This is information related to the account code conversion, including the information in the account, define, and move fields and the account code conversion table, and the number of unmatched records (if applicable).

<table>
<thead>
<tr>
<th>Setting</th>
<th>Correlating Control File and Statement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trace flag</td>
<td><strong>File:</strong> AcctCntl.txt <strong>Statement:</strong> TEST A or Y (see page D-11)</td>
</tr>
</tbody>
</table>

**Check for bad file input**

Select this check box to validate each identifier. Some systems may pass data in identifier fields that are not valid ASCII display characters. This can cause unexpected results during processing. By pre-validating the data, the system verifies that the data passes through ITUAM successfully.

**Note:** This option slows down the processing of CIMSAcct. Consult IBM before using this option.
Bill Options Tab
This tab contains the following subtabs: General, Files, Define Fields, Include/Exclude Records, Proration, Client, and Trace.

General Subtab
Use this subtab to specify general CIMSBill settings such as the record type and date range for the input and output records, to set the close date if other than the system close date, and enable other options such as CPU normalization and shift code processing.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Correlating Control File and Statement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Type</td>
<td>File: BillCnt1.txt</td>
</tr>
<tr>
<td></td>
<td>Statement:</td>
</tr>
<tr>
<td></td>
<td>PROCESS record type (see page D-19)</td>
</tr>
<tr>
<td>Default Close Day</td>
<td>File: BillCnt1.txt</td>
</tr>
<tr>
<td></td>
<td>Statement:</td>
</tr>
<tr>
<td></td>
<td>DEFAULT CLOSE DAY = nn (see page D-16)</td>
</tr>
<tr>
<td>Input—Date Selection</td>
<td>File: BillCnt1.txt</td>
</tr>
<tr>
<td></td>
<td>Statement:</td>
</tr>
<tr>
<td></td>
<td>DATE SELECTION YYYYMMDD YYYYMMDD/keyword (see page D-15)</td>
</tr>
</tbody>
</table>

No Date Selection

- Use Specific Dates. Enter the dates in the Start Date and End Date boxes.
- Run Date (Today). Selects records based on the run date.
- Previous Day to Current Day. Selects records based on the run date and the run date less one day.
- Current Week. Selects records based on the run week (Sun–Sat).
- Current Month. Selects records based on the run month.
Input—Date Selection (continued)

- **Previous Day.** Selects records based on the run date, less one day.
- **Previous Week.** Selects records based on the previous week (Sun–Sat).
- **Previous Month.** Selects records based on the previous month.
- **Current Period from Calendar.** Selects records based on the current period from the CIMSCalendar table.
- **Previous Period from Calendar.** Selects records based on the previous period from the CIMSCalendar table.

For example, if you click Current Month, records with end dates in the current month are processed.

### Output-Summary Date Range

This setting is used to determine the accounting dates in the CIMSBill output files. To ensure that the accounting dates are calculated correctly, the use of the default keyword, Auto, is strongly recommended. This setting enables ITUAM to calculate the accounting dates as described in Accounting Dates on page 7-18. Consult IBM before changing this setting.

#### None

### Back Load Data

When this check box is selected, the close date is ignored. The accounting dates created by CIMSBill are the same as the usage end date, regardless of the close date.

#### File: BillCntl.txt

Statement:

BACKLOAD DATA (see page D-14)

### Normalize CPU Values

Select this check box to normalize the processing speeds of computers in the system (see Normalizing CPU Values on page 7-56).

#### File: BillCntl.txt

Statement:

NORMALIZE CPU VALUES (see page D-19)

### Use Shift Codes

Select this check box to instruct CIMSBill to use the shift character specified in the CIMSAcct Detail record and apply the appropriate rate shift value.

#### File: BillCntl.txt

Statement:

USE SHIFT CODES (see page D-23)
Files Subtab
Use this subtab to define the CIMSBill input and output files.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Correlating Control File and Statement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input File</td>
<td>File: ProcessCntl.txt</td>
</tr>
<tr>
<td></td>
<td>Statement:</td>
</tr>
<tr>
<td></td>
<td>BillInputFile filename</td>
</tr>
<tr>
<td></td>
<td>Statement:</td>
</tr>
<tr>
<td></td>
<td>BillDetailFile filename</td>
</tr>
<tr>
<td></td>
<td>BillSummaryFile filename</td>
</tr>
</tbody>
</table>

Output Files
The names of the CIMSBill output files (the CIMSBill Detail and Summary files). CIMSBill writes these files to the path listed above the file names. The use of the default file names is recommended.

Define Fields Subtab and Include/Exclude Records Subtab
These subtabs are used together to define data that you would like to include or exclude for CIMSBill processing. This is useful if there is certain data that your organization does not want to report on. For a description of how to use these tabs, see Include/Exclude Processing on page 6-58.

Proration Subtab
This subtab allows you to charge resources to more than one account. For a description of the options on this subtab and how to use proration, see Prorating Resources on page 6-49.

Note • Although you can perform proration using CIMSBill, the CIMSPrat program provides more options for proration and enables you to prorate resources multiple times. For more information about proration using CIMSPrat, refer to the IBM Tivoli Usage and Accounting Manager Data Collectors for Microsoft Windows User’s Guide.
Client Subtab

Use this subtab to enable CIMSBill to search for the applicable rate table (if you are using multiple rate tables) and to dynamically add clients to the CIMSClient table.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Correlating Control File and Statement</th>
</tr>
</thead>
</table>
| Enable client search | File: BillCntl.txt  
Statement:  
CLIENT SEARCH ON (see page D-14) |
| Add new clients to Client table | File: BillCntl.txt  
Statement:  
DYNAMIC CLIENT ADD ON (see page D-18) |

Account Code Search Fields

When CIMSBill is searching the client table or adding clients to the table, it needs to know the account code structure that you want to use. In the Account Structure box, click the account code structure that you want, and then click Populate Fields. The account code structure is displayed in Fields 1–9.

For more information about the account code structure, see Setting Up the Account Code Structure on page 4-3.

Note: This option can quickly fill up the CIMSClient table. Use this option with caution.
Trace Subtab

**Note** • By default, tracing is disabled. Consult IBM before using one of the CIMSBill trace flags described in this section.

Use this subtab to include the following trace messages in the CIMSBill Message file, BillMsg.txt:

- **Date processing.** Includes the CIMSBill run date, the input file usage end date(s), and accounting start and end dates.

- **Rate processing.** Includes rate code information from the rate tables that are used during processing.

- **General processing.** Includes options selected, high–low date calculation, and other general processing messages.

- **Client processing.** Includes information related to the clients that are processed.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Correlating Control File and Statement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trace flag</td>
<td>File: BillCntl.txt</td>
</tr>
<tr>
<td>Click Tracing Disabled, D – Trace Date Processing, R – Trace Rate Processing, Y – Trace General Processing, or Z – Trace Client Processing.</td>
<td>Statement: TEST D, R, Y, or Z (see page D-23)</td>
</tr>
</tbody>
</table>
**Process Results Tab**

This tab contains the following subtabs: **Account**, **Bill**, and **Event Viewer**.

**Account and Bill Subtabs**

- **View Message File.** Select this check box to view the most recent version of the CIMSAcct/CIMSBill Message file.

- **View Results File.** Click this to view the CIMSAcct/CIMSBill Results file, which describes results of the most recent CIMSAcct/CIMSBill processing.

- **View Detail File.** Select this check box to view the CIMSAcct/CIMSBill Detail file.

- **View Ident File (CIMSAcct only).** Click this to view the Ident file.

- **View Exception File (CIMSAcct only).** Click this to view the exception file. This button is unavailable if no exception file is available.

- **View CSR Plus File (CIMSAcct only).** Click this to view the CSR+ file. This file is created if the Create CSR Plus check box is selected (see page 7-28).

- **View Summary File (CIMSBill only).** Click this to view the Summary file.

- **View Proration Report (CIMSBill only).** Click this to view the proration report. This button is unavailable if no proration report is available.

- **Use External Viewer.** When you select this check box and then click one of the preceding buttons, the files open in Windows Notepad.

- **Word Wrap.** Select this check box to enable word wrap for the displayed files.

- **Copy to Clipboard.** Click this to copy the contents of the currently displayed file to the Windows clipboard.

**Event Viewer Subtab**

- **Show Process Events.** Click this to view all process events in the Event Viewer (see page 7-38).

- **Show All ITUAM Events.** Click this to view all ITUAM-related events in the Event Viewer.

- **Start Windows Event Viewer.** Click this to open the Windows Event Viewer and view system-wide events.

**Versions Tab**

This tab provides the version number and path for CIMSAcct, CIMSBill, and CIMSORT.
Processing Data Using ITUAM Administrator

To process data using ITUAM Administrator, click the process definition that you want to process, and then click Process. You can also click Process in the Edit Process Definition dialog box for the definition.

Note • If you receive a warning stating that a file with the same date range has already been loaded, you are probably loading duplicate data. You can click Yes to continue to load the data, but you should delete the previous load immediately after the current load is completed (see Tracking the History of Database Loads on page 6-22).

Viewing Events

ITUAM Administrator enables you to view system events related to ITUAM and the processing of data. This is helpful if you want to see details about a processing job and any associated problems with it. To view these events:

1 In the ITUAM Administrator main window, click Chargeback Administration » Processing » Event Viewer. The Event Viewer dialog box is displayed as shown in example Figure 7-4.

![Event Viewer Dialog Box](image-url)

Figure 7-4 • Event Viewer Dialog Box
2 Click any event to view the event message at the bottom of the dialog box. To view
Windows system-wide events, click **Windows Event Viewer**.

3 If you want to change the criteria for the events that are displayed in Event Viewer, use
the options in the **Filter** area, and then click **Apply Filters**.

**Note** • To refresh the list of events in the Event Viewer dialog box, press **<F5>**.
Setting Up Account Codes and Performing Account Code Conversion

This section describes the account codes structure and how to define and convert the account code.

Defining the Account Code Structure

One of the first steps in implementing ITUAM is deciding on a final account code structure. The structure is the chargeback hierarchy for the organization. The levels of this hierarchy are arranged from highest to lowest level within the account code. The account code can consist of up to 128 characters.

For example, your final account code structure could consist of:

DDDCCCUUUUUU
D = Division (three characters) (highest level)
C = Cost Center (four characters)
U = User (eight characters) (lowest level)

*Note* You can use business rules to map identifiers to applications in addition to or instead of business units, departments, cost centers, etc.

The next step is to set the account code structure in ITUAM Administrator, see *Setting Up the Account Code Structure* on page 4-3.

Once you have set up the account code structure, you can create an account code conversion table to convert the identifier values in the input file into an account code that fits within the final hierarchy pattern.
Defining the Account Code

The account code is derived from an identifier or identifiers in the input file. In ITUAM Administrator, specify the identifier(s) that you want to use to define the account code as follows:

- If the input file contains an `Account_Code` identifier, the `Account_Code` identifier value is automatically used to define the account code. If this value fits your account code hierarchy, you can use the value as your account code. If this value does not meet your account code requirements, you can convert the value to the appropriate account code.

- If the input file meets any of the following criteria, you must specify an identifier or identifiers that you want to use to define the account code:
  - The input file does not contain an `Account_Code` identifier.
  - The input file contains an `Account_Code` identifier, but you want to use other identifiers instead.
  - The input file contains an `Account_Code` identifier and other identifiers that you want to use. In this case, you must define the `Account_Code` identifier in addition to the other identifiers.

  If the identifier values fit your account code hierarchy, you can use the combined values as your account code. However, in most cases you will need to convert combined values to the appropriate account code.

The identifiers that you use (either via the `Account_Code` identifier values or the identifiers that you specify) are referred to as the account code input field. For an example of how to define an account code input field, see Figure 7-5 on page 7-48.

To define the account code input field:

**Note** • You do not need to define the account code input field if the input file contains the `Account_Code` identifier and you are using only it to define your account code.

1. In the ITUAM Administrator main window, click Chargeback Administration ► Processing ► Process Definitions.

2. In the Process Definition List dialog box, click the process definition that you want, and then click Edit.

3. Click the Account Options tab.
4 Complete the **Account Codes** subtab as follows:

- **Account Fields.** Define the identifier(s) that you want to use for the account code input field beginning at **Field 0** and continuing sequentially as needed.

  If you want to use the full value for an identifier, use an offset of 1 and the length of the longest identifier value as defined in the input file. For example, if the longest identifier value is 7 characters, type 1 as the offset and 7 as the length.

  If you want to use a portion of the identifier value, use the offset position at which you want to start the value and the corresponding length. For example, if you want to start the 7-character identifier value at the second character, type 2 as the offset and 6 as the length. You could also select a shorter length if you wanted to further reduce the identifier value length.

  You can define up to 10 account fields (**Field 0** – **Field 9**). The maximum number of characters for an account field is 128.

  **Note** - Although the maximum number of characters for each account field is 128, the overall length of all account fields added together cannot exceed 128 characters.

  Also, keep in mind that the total output account code, including any literals and move field values, cannot exceed 128 bytes.

  The corresponding control statement in the **AcctCnt1.txt** file is **ACCOUNT FIELD** (see page D-4).

- **Convert account fields to uppercase during processing.** Select this check box to convert lowercase account code input field values to uppercase values in the resulting account code. For example, the value **ddic** would be converted to **DDIC**. By using this option, CIMSAcct account code processing becomes case-insensitive and makes defining account conversion tables much easier.

  The corresponding control statements in the **AcctCnt1.txt** file is **UPPERCASE ACCOUNT FIELDS** (see page D-11).
Setting the Account Code Conversion Options

To perform account conversion, regardless of whether you are using the Account_Code identifier or another identifier, you must set the conversion options described in this section and create an account code conversion table as described on page 7-45. Account codes are assigned by matching identifier values in the input file records to the values in the account code conversion table.

For an example of how to set the account code conversion options, see Figure 7-5 on page 7-48.

To set the account code conversion options:

Complete the Account Codes subtab as follows.

- **Perform Account Code Conversion.** If this check box is selected, the account code conversion occurs as defined by the following Define Field and Move Field settings and the account code conversion table:

  The corresponding control statement in the AcctCntl.txt file is ACCOUNT CODE CONVERSION (see page D-3).

- **Define Fields.** Use this area to specify the offset and length of the account code input field values that you want to use for conversion. Begin at Field 0 and continue sequentially as needed. Note that if you created the account code input field using account fields as described in To define the account code input field: on page 7-41, the define fields correlate to the account field values, not to the original identifier values in the input file.

  For example, if you defined the following two identifiers as account fields, the resulting account code input field value would be JJJJJJUUUUUUU, where J represents the Jobname identifier and U represents the User identifier.

  - Account Field 0—Jobname offset 2, length 6
  - Account Field 1—User offset 1, length 7

  You would set the Define Field 0 to offset 1, length 6 and Define Field 1 to offset 7, length 7. You could also select a shorter length if you wanted to further reduce the define field value.

  You can define up to 10 define fields (Field 0 – Field 9). The maximum number of characters for a define field is 128.

**Note** • Although the maximum number of characters for each define field is 128, the overall length of all define fields added together cannot exceed 128 characters.

Also, keep in mind that the total output account code, including any literals and move field values, cannot exceed 128 bytes.

The corresponding control statement in the AcctCntl.txt file is DEFINE FIELD (see page D-6).
Move Fields. Use this optional setting to include either the define field(s) value or a literal in the output account code.

If you specify a define field as the move field, the define field value will be included in the account code. For example, if the define field represents the Jobname value DDIC, DDIC will appear at the beginning, end, or within the account code as specified in the account code conversion table.

If you specify a literal, the literal value will be included in the account code. For example, if the type a literal value of A/P, A/P will appear in the at the beginning, end, or within the account code as specified in the account code conversion table. The literal can be a maximum of 40 characters.

For an example of how move fields are used, see Account Code Conversion Example on page 7-47.

Begin at Field 0 and continue sequentially as needed. You can define up to 10 move fields (Field 0 – Field 9).

**Note** • Although the maximum number of characters for each move field is 128, the overall length of all move fields added together cannot exceed 128 characters.

Also, keep in mind that the total output account code, including any literals and move field values, cannot exceed 128 bytes.

The corresponding control statement in the AcctCnt1.txt file is DEFINE MOVEFLD (see page D-7).

Conversion Table. This is the file name for the account code conversion table. If the table is located in the definition folder for the process, the file name is displayed without the path. If the table is located in a location other than the process definition folder (e.g., you are using the same table for multiple processes and have the table in a central location), the file path is displayed.

To select a table, click Browse. To edit the table, click Edit. To create a table, see Creating an Account Code Conversion Table on page 7-45.

The corresponding control statement in the ProcessCnt1.txt file is ACCTCODECONVERSIONTABLE filename.

Enable Exception Processing. Select this check box to enable exception file processing. This instructs the system to write all non-matched records to an exception file. If this check box is not selected, the records that are not matched are written to the CIMSAcct Detail file with the unconverted account code input field value.

If you enable exception processing, do not include a default account code as the last entry in the account code conversion table (e.g., ", , DEFAULTCODE"). If a default account number is used, records will not be written to the exception file.

The corresponding control statement in the AcctCnt1.txt file is EXCEPTION FILE PROCESSING ON (see page D-8).
Creating an Account Code Conversion Table

The account code conversion table contains the definitions required to convert the identifier values defined by the account code input field to user-defined output account codes. For an example of how to create the account code conversion table, see Figure 7-6 on page 7-49.

Consider the following when creating the account code conversion table:

- The account code conversion table is case-sensitive. For convenience, you can enter uppercase values in the table and then select the Convert account fields to uppercase during processing check box on the Account Codes subtab (see To define the account code input field: on page 7-41). This is especially helpful if you are using one account code conversion table for multiple process definitions. This ensures that account code input field values that are lowercase or mixed case are processed.

- Each record in the table can be up to 386 characters (129 for the low identifier, 129 for the high identifier, and 128 for the new account code).

- The identifier fields follow these rules:
  - Each low and high identifier field is compared to the corresponding account code input field values. If the compares are true, the account code is assigned.
  - The low identifier fields are padded with x'00' and the high value fields are padded with x'FF'.
  - The high identifier field is set equal to the low field plus the high padding when the high identifier field value is null.

- You can include a default account code as the last entry in the account code conversion table by leaving the low and high identifier fields empty (e.g., ",,DEFAULTCODE"). In this case, all records that contain identifier values that do not match an entry in the account code conversion table will be matched to the default code.

- If you do not include a default account code, input file records that contain identifier values that do not match an entry in the account code conversion table are written to the CIMSAcct Detail file with the unconverted account code input field value. If you want unmatched records to go to an exception file for reprocessing at a later time, select the Enable Exception Processing check box on the Account Codes subtab (see page 7-43). If you enable exception file processing, make sure that you have not included a default account code entry in the account code conversion table.

- If the PRINT ACCOUNT NO-MATCH statement is included in the AcctCntl.txt file, a message is printed in the CIMSAcct Message file showing the identifier values from the input file that were not matched during account code conversion. If this statement is not present, only the total number of unmatched records is provided. The system prints up to 1000 messages.

- The number of definition entries that you can enter in the table is limited only by the memory available to CIMSAcct.
To create an account code conversion table:

1. In the Conversion Table box, it is recommended that you type the default file name AcctTabl.txt, which is also the default for ITUAM Data Collectors. However, you can type any name in the format filename.txt.

2. Click Edit.

3. In the Account Code Conversion Table Maintenance dialog box, click Add Entry and type the following for each account code input field value that you want to convert.

   - The low and high identifier value that you want to use for conversion. You can enter up to 10 fields of 128 bytes each for the low and high identifiers. (However, all fields added together cannot equal more than 128 characters.) Each field must be delimited by a colon (:).

   For example, if you type AA as the low identifier and CC as the high identifier, all account codes that begin with characters greater than or equal to AA or less than or equal to CC are converted to the specified account code. If you type AAAAAAAA:BB as the low identifier and CCCCCCCC:DD as the high identifier, all account codes that begin with characters greater than or equal to AAAAAAAABB or less than or equal to CCCCCCCCDD are converted to the specified account code.

   The asterisk (*) and the question mark (?) characters can be used as wildcard characters for both the low and high identifiers. Note that using the wildcard characters can degrade performance; use them only when needed.

   If you do not set a high value, the value is equal to the low value by default.

   - The account code value that you want to convert to (maximum of 128 characters).

4. To set additional account code conversion entries, click Insert Entry. To remove an entry, click the entry and then click Remove Entry.

5. Click OK when you are finished.

By default, the table is saved to the process definition folder. But you can move the table to any location.
Account Code Conversion Example

Note • This section provides examples to supplement the preceding sections. Please refer to these sections for more detailed information.

Assume that you want to use the User identifier values in an input file to define your account code and that your account code is in the following structure:

DDDCCCUUUUUU

D = Division (three characters) (highest level)
C = Cost Center (four characters)
U = User (eight characters) (lowest level)

The following table shows the User identifier values that are in the input file records and the corresponding account code that you want to convert the value to.

<table>
<thead>
<tr>
<th>User Identifier Value from Input File</th>
<th>Final Account Code</th>
<th>Division Account Code</th>
<th>Cost Center Account Code</th>
<th>User Account Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>DDIC</td>
<td>FINACTGDDIC</td>
<td>FIN</td>
<td>ACTG</td>
<td>DDIC</td>
</tr>
<tr>
<td>SAP</td>
<td>ISDDEVPSSAP</td>
<td>ISD</td>
<td>DEVP</td>
<td>SAP</td>
</tr>
<tr>
<td>SAPCOMM</td>
<td>OPSMKTGSAPCOMM</td>
<td>OPS</td>
<td>MKTG</td>
<td>SAPCOMM</td>
</tr>
<tr>
<td>SAPSYS</td>
<td>MISPRODSAPSYS</td>
<td>MIS</td>
<td>PROD</td>
<td>SAPSYS</td>
</tr>
<tr>
<td>TEAM718</td>
<td>MISTESTTEAM718</td>
<td>MIS</td>
<td>TEST</td>
<td>TEAM718</td>
</tr>
<tr>
<td>TEAMF99</td>
<td>OPSTESTTEAMF99</td>
<td>OPS</td>
<td>TEST</td>
<td>TEAMF99</td>
</tr>
</tbody>
</table>

To convert the User identifier values to the final account code, you would complete the steps in the following sections.
Define the Account Code and Conversion Options for CIMSAcct

In this example, the User identifier is entered for an offset of 1 and length of 7 because you want to use the entire identifier value and the longest values (SAPCOMM, TEAM718, and TEAMF99) are 7 characters.

For account code conversion, you must define the value from the account field (USER) at the full 7-character length. Because you also want to include the account field value at the end of the account code, you must define a move field for the value.

Figure 7-5  •  Defining the Account Code and Conversion Options Example
Create the Account Code Conversion Table

The account code conversion table contains the following entries. Note that the high identification code is not needed in this example because the low and high identification codes are the same.

The @0 at the end of the account code value specifies that the move field defined in the previous step will be included at the end of the account code. For example, the resulting account code for the first table entry would be FINACTGDDIC. If you placed the @0 at the beginning of the account code value, the resulting account code would be DDIC<three spaces>FINACTG. You could place the @0 anywhere in the account code.

![Account Code Conversion Table Maintenance](image)

Figure 7-6 • Creating the Account Code Conversion Table Example

If you had additional move fields defined, they would be represented by @1, @2, @3, etc. For example, if you had used another identifier for account conversion in addition to User and had defined move fields for each (move field 0 and move field 1), @1FINACTG@0 would place the value for move field 1 at the beginning of the account code and the value for move field 0 at the end of the account code.

Process the CSR File

The converted account codes appear in the CIMSAcct Detail, CIMSBill Detail, and Summary files.
Prorating Resources

Note • Although you can perform proration using CIMSBill, the CIMSPrat program provides more options for proration and enables you to prorate resources multiple times. For more information about proration using CIMSPrat, refer to the IBM Tivoli Usage and Accounting Manager Data Collectors for Microsoft Windows User’s Guide.

Proration is taking the overall or individual resources used by an account and distributing those resources and the cost of the resources across multiple accounts at a specified percentage.

A common use of proration is the equitable allocation of overhead costs across the user community. An application or system that is normally assigned to the overhead category tends to be one that does not produce metering data to the end user or account level, or the processing of such data is considered too expensive to be practical at the end user or account level.

For example, you have an application that controls print in a centralized environment. To prorate the costs associated with this application among multiple accounts, do the following:

- Assign the print program resource utilization and cost to a non-billable overhead account.
- Set the proration options for CIMSBill.
- Create a proration table assigning the percentage of print program costs for the non-billable account to the accounts that you want to bill.

To set the proration options:

1. In the ITUAM Administrator main window, click Chargeback Administration ▶ Processing ▶ Process Definitions.
2. In the Process Definition List dialog box, click the process definition that you want, and then click Edit.
3. Click the Bill Options tab.
4. On the Proration subtab, set the following options:
   - Proration Type. Click type of proration to be performed: Resources or Money. For a description of each option including its advantages and disadvantages, see Prorating Resources vs. Prorating Money on page 7-55.

   The corresponding control statements in the BillCnt1.txt file are PRORATE MONEY (see page D-20) and PRORATE RESOURCES (see page D-21).
**Processing Data on Windows**

### Prorating Resources

- **Match Length.** The level of the account code that you want to match for proration. For example, if you type 5, accounts AAABB, AAABBBB, and AAABBCC are prorated. If you type 7, only accounts AAABBBB and AAABBCC are prorated.

  This is included in the `PRORATE MONEY` or `PRORATE RESOURCES` statement in the `BillCntl.txt` file. For example, `PRORATE RESOURCES 5` where 5 is the match length.

- **Proration Table.** This is the file name for the proration table. If the table is located in the definition folder for the process, the file name is displayed without the path. If the table is located in a location other than the process definition folder (e.g., you are using the same table for multiple processes and have the table in a central location), the file path is displayed.

  To select a table, click **Browse**. To edit the table, click **Edit**. To create a table, see *To create a proration table:* on page 7-51.

  The corresponding control statement in the `ProcessCntl.txt` file is `BillMultiFile filename`.

- **Print Proration Report.** Select this check box to create a proration report as part of the process. The report will reside in the process definition folder.

  The corresponding control statement in the `BillCntl.txt` file is `PRINT PRORATION REPORT` (see page D-21).

**To create a proration table:**

1. In the **Proration Table** box, type a name for the table in the format `filename.txt`, and then click **Edit**.

2. In the Proration Table Maintenance dialog box, click **Add Entry** and type the following for each account that you want to prorate to.
   - The original account code that you want to prorate from.
   - The account code that you want to prorate to.
   - The percentage that you want to prorate to the account code.

   **Note** You can prorate resource costs at any percentage. The prorate percentage can be less than or greater than 100 percent.

   - The individual rate code(s) that you want to prorate or **All** to prorate all rate codes.

3. To set additional proration entries, click **Insert Entry**. To remove an entry, click the entry and then click **Remove Entry**.

4. Click **OK** when you are finished.

By default, the table is saved to the process definition folder. But you can move the table to any location.
Proration Table Examples

Assume that you want to split all resources used by overhead account code AAABB among three different accounts: A1, A2, and A3. A1 on average uses about 50 percent of the resources assigned to the AAABB account, A2 uses about 30 percent, and A3 uses about 20 percent.

Complete the Proration Table Maintenance dialog box as shown in Figure 7-7.
You can also split *individual* resources among multiple accounts. Using the preceding example, assume that the only resources from account AAABB that you want to prorate are represented by the rate codes Z001 and Z002. Create the proration table as shown in example Figure 7-8.

![Proration Table Maintenance](image)

**Figure 7-8 • Proration Example 2**
In this example, all resources other than Z001 and Z002 would still be charged to the AAABB account.

If you want to charge account AAABB for a portion of the resources used, for example you want to charge account AAABB 40 percent and account AACCC 60 percent for all resources, create the proration table as shown in example Figure 7-9.

![Figure 7-9 • Proration Example 3](image)
Prorating Resources vs. Prorating Money

In ITUAM Administrator, you can set the option to prorate on resources or on money. Both options display the same prorated units and charges in Web reports. However, you cannot drill down on resource units by identifier if you prorate by money. The following describes the advantages and disadvantages of prorating resources and prorating money:

Prorating resources. The CIMSAcct Detail file from CIMSSort is prorated before CIMSBill applies rates and figures money and a new CIMSAcct Detail file is built with all the prorated resources. The new CIMSAcct Detail file is then used in the CIMSBill process.

An advantage of prorating resources is that the CIMSBill Detail records match the records in the Summary file. Therefore, users can drill down on resource units by identifier when viewing invoices in ITUAM Web Reporting. A disadvantage is that the CIMSBill Detail file can contain a potentially large number of records.

Prorating money. The Summary file is prorated just before CIMSBill ends. A new Summary file is built with the prorated values.

An advantage of prorating money is that the CIMSBill Detail file contains fewer records than it would if you prorated by resources. A disadvantage is that the CIMSBill Detail records do not match the Summary records and drilling down by identifier will not produce accurate data.
Normalizing CPU Values

Computers within an organization have different processing speeds. This speed difference might cause users to request that their work be run on the faster machine to reduce costs. This situation could lead to heavy workloads on the faster computers while the slower units stand idle. To avoid this problem, you can normalize the processing speeds to more evenly charge for CPU utilization. That is, you can assign a percentage of the original CPU time used by a system rather than the actual time to be used during the billing process.

For example, your organization has two z/OS® systems, AL90 and AL95. System AL95 is 20 percent faster than AL90. If you use AL95 as the base system, use a factor of .80 to normalize AL90 to reflect the speed of AL95.

**Note** • Due to the disparity between the way different operating systems capture performance statistics, it is not desirable to normalize the processor times between platforms (e.g., z/OS to UNIX or UNIX to Windows).

To perform normalization, do the following:

- Select the CPU Value option for the rate code or codes for which you want to perform normalization.
- Set the normalization factor for the applicable system or systems.
- Select the Normalize CPU Values option for the process definition.

### To set the rate code as a CPU value:

1. In the ITUAM Administrator main window, click **Chargeback Administration ➤ Chargeback Table Maintenance ➤ Rate Codes**.
2. In the Rate Code Maintenance List dialog box, click the rate code that you want to set as a CPU value, (for example, Mainframe CPU Minutes [Z003]), and then click **Edit**.
3. Select **CPU Value** check box, and then click **OK**.

**Note** • If this item is not checked, the rate code value will not be normalized during CIMSBill processing.

### To set the normalization factor by system:

1. In the ITUAM Administrator main window, click **Chargeback Administration ➤ Processing ➤ CPU Normalization**.
2. Click **Add** in the CPU Normalization Maintenance List dialog box.
3 Enter the following:

- **System ID.** The name of the system. For z/OS, this is the four-character System Model ID, for UNIX and Windows, it is the computer name. Note that the input file must contain an identifier named `System_ID` to identify the system name for CIMSBill.

- **Work ID.** The subsystem name. This is any other system value that can narrow the normalization (i.e., the CICS region name, the DB2 plan name, the Oracle instance, etc.). Note that the input file must contain an identifier named `Work_ID` to identify the subsystem name for CIMSBill.

- **Factor.** This is the actual normalization factor. In the example at the beginning of this section, this would be .80.

4 Click **OK**.

An example of a configured CPU Normalization List Maintenance dialog box is shown in Figure 7-10.

![CPU Normalization List Maintenance Dialog Box](image)

**Figure 7-10 • CPU Normalization List Maintenance Dialog Box**

To edit or remove a factor, click the factor, and then click **Edit** or **Remove**. Note that you cannot change the System or Work ID when you edit the factor.
Processing Data on Windows

Normalizing CPU Values

To set the CPU normalization option for the process definition:

1. In the ITUAM Administrator main window, click Chargeback Administration ▶ Processing ▶ Process Definitions.

2. In the Process Definition List dialog box, click the process definition that you want, and then click Edit.

3. Click the Bill Options tab.

4. On the General subtab, select the Normalize CPU Values check box.

   The corresponding control statement in the BillCntl.txt file is NORMALIZE CPU VALUES (see page D-19).

About Ghost Machines

Many organizations attempt to perform normalization against a “ghost machine”. This is the factor applied to all the processors in the enterprise today, using as a base the speed of the slowest machine running in the environment. In an attempt to keep costing philosophy as simple as possible, the old technology “ghost” system is kept as the baseline for processor speed. This concept worked well when processor speeds were relatively constant. However, as processor speeds continue to increase, it becomes difficult to relate the higher CPU speeds of today’s computers to older technology. It is recommended that processor speed factors be restricted to those multipliers and divisors applicable to the existing environment.
Include/Exclude Processing

By default, CIMSBill processes all records within the input CIMSAcct Detail file. However, you might want to process only certain records or you might want to exclude certain records. This is useful if there is data that your organization does not want to report on.

You can exclude records by date using the date selection option in ITUAM Administrator. See page 7-27 to set this option for CIMSAcct and page 7-32 to set this option for CIMSBill.

You can also include or exclude records by identifier values in the records. For example, you might want to exclude all records that contain a particular Jobname identifier value.

To include or exclude records by identifier values, do the following in ITUAM Administrator:

- Define identifier fields that you want to use.

  If the input record identifier fields that you want to include or exclude are other than System_ID, Work_ID, or Account_Code, you must define identifier fields that you want to use. The values for these defined identifiers are stored consecutively beginning at starting position 301 of the CIMSAcct Detail file (see page B-7 for the file layout).

  If you want to include or exclude System_ID or Work_ID identifier fields, you do not need to define the fields. The values for these identifiers are always stored at starting positions 57 and 90 (respectively) of the CIMSAcct Detail file.

  If you want to include or exclude the Account_Code identifier field, you do not need to define the field unless the account code has been converted. If the account code has been converted, the code (stored in position 163 of the CIMSAcct Detail file) will not match the Account_Code identifier value in the input record. You must define the field so that the original identifier value is used.

- Define the identifier fields for CIMSBill.

- Specify whether you want CIMSBill to include or exclude the defined fields.

  **To define the input record identifier fields that you want to include or exclude:**

  1. In the ITUAM Administrator main window, click Chargeback Administration ▶ Processing ▶ Process Definitions.

  2. In the Process Definition List dialog box, click the process definition that you want, and then click Edit.

  3. Click the Account Options tab.
4 On the General subtab, enter the following in the Include Fields area beginning at Field 0:

- The identifier name that you want to use to include or exclude records. For example Jobname, Server, User, etc.

- The offset position at which you want to start the identifier value that you want to include or exclude. If you want to start the identifier value at the first character of the value, type 1. If you want to start the identifier at the second character, type 2, etc. For example, you could start the eight-character Jobname identifier value DFMALE02 at position 1, which specifies the full value or at any other position such as position 4, which specifies just ALE02. This would specify that only those records with Jobname identifier values that contain ALE02 are included or excluded from processing.

- The length of the identifier value. This can be the entire length of the identifier value starting at the offset position, or a shorter length. Using the preceding example of ALE02, you might want just ALE. In this case, you would type a length of 3.

**Note** • The overall length of all include fields added together can not exceed 60 characters.

The corresponding control statement in the AcctCntl.txt file is INCLUDE FIELD (see page D-9).

If you want to specify more than one identifier for include/exclude processing repeat these steps for each identifier. However, consult IBM before doing this to determine if it is necessary.

To insert an entry in the Include Fields area, click Insert Entry. To remove an entry, click the entry and then click Remove Entry.

**To define the identifier fields for CIMSBill:**

1 Click the Bill Options tab.

2 On the Define Fields subtab, click Add Entry and enter the following for each field that you specified on the Account Options ➤ General subtab (see page 7-27).

   - A two-character ID for the identifier. You will use this ID to specify the records that you want to include or exclude (see To include or exclude the defined fields in CIMSBill Processing on page 7-61).

   - The offset position at which you want to start the identifier value that you want to include or exclude. Unlike the offset position 1 through x that you specified for CIMSAcct processing, this is the position in the CIMSAcct Detail file in which the identifier value begins. As with the offset position used by CIMSAcct, you can specify any offset position within the identifier value. For example, if the Jobname identifier value DFM begins at position 301, you can set the offset at 302 to specify just FM. This would specify that only those records with Jobname identifier values that contain FM are included or excluded from processing.
Processing Data on Windows

Include/Exclude Processing

- The length of the identifier value. This can be the entire length of the identifier value starting at the offset position, or a shorter length.
- An optional description of the field.

The corresponding control statement in the BillCntl.txt file is Define (see page D-16).

To insert an entry on the Define Fields subtab, click Insert Entry. To remove an entry, click the entry that you want to remove and then click Remove Entry. To add an entry, click Add Entry.

To include or exclude the defined fields in CIMSBill Processing

On the Include/Exclude Records subtab, click Add Entry and enter the following for each field that you specified on the Bill Options ▶ Define Fields subtab:

- Click Include or Exclude.
- Click the identifier ID that you created in To define the identifier fields for CIMSBill: on page 7-60.
- In the Low Value and High Value fields, type the range for the identifier values that you want to include or exclude. For example, if you want to include only those identifiers that start with ALI type ALI in both fields. If you want identifiers that start with ALI and ALE, type ALE as the low value and ALI as the high value.

The corresponding control statements in the BillCntl.txt file are EXCLUDE (see page D-18) and INCLUDE (see page D-19).

To insert an entry on the Include/Exclude Records subtab, click Insert Entry. To remove an entry, click the entry that you want to remove and then click Remove Entry. To add an entry, click Add Entry.
Include/Exclude Processing Example
Assume that you have a CSR from a z/OS system with the following identifiers:

...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALI09999,Jobname,BKMALI01,Start_date,20050714...
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALI09999,Jobname,BKMALI02,Start_date,20050715...
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALI09999,Jobname,BKMALI03,Start_date,20050716...
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALE09999,Jobname,DFMASE01,Start_date,20050714...
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALE09999,Jobname,DFMASE02,Start_date,20050715...
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALE09999,Jobname,DFMASE03,Start_date,20050716...
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALU09999,Jobname,LCHALU01,Start_date,20050714...
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALU09999,Jobname,LCHALU02,Start_date,20050715...
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALU09999,Jobname,LCHALU03,Start_date,20050716...

You want to exclude those records that contain **DFM** in the **Jobname** identifier value. Define the identifier field as shown in **Figure 7-11**.

![Figure 7-11 - Edit Process Definition—Include Fields](image)

In this example, only the first three characters of the **Jobname** identifier value are required. Therefore, the offset is 1 and the length is 3.
Next you must define the identifier field for CIMSBill as shown in example Figure 7-12.

Figure 7-12 • Edit Process Definition—Define Fields Subtab

In this example, the Jobname identifier value is assigned the ID A1 and begins in position 301 of the CIMSACct Detail file (the starting position for include/exclude identifier values).
Next you must define DFM as the exclude identifier value as shown in example Figure 7-13. Records that contain DFM as the first three characters of the Jobname identifier value will not be processed.

Figure 7-13 • Edit Process Definition—Include/Exclude Records Subtab
Rebilling Rate Codes After Changing Rate Code Values or Conversion Factors

**Important!** • The following scripts change the data in the ITUAM database. You should back up the database before running these scripts.

You can recalculate rate codes that you previously processed and loaded into the ITUAM database using a different rate value or resource conversion factor without reprocessing the data. That is, if you change the rate value or resource conversion factor for a rate code in the CIMSRate table, you can update the rate value and conversion factor and recalculate the money value directly in the CIMSSummary table. (For more information about the rate code value and resource conversion factor, see *Working With Rates* on page 4-9.)

ITUAM includes the following scripts to perform this process:

- **Rebill.wsf.** This script updates the rate code value and recalculates the money value for a rate code or codes in the CIMSSummary table. If you have not changed the resource conversion factor for a rate code or codes, you do not need to run the ResourceConversion.wsf script.

- **ResourceConversion.wsf.** This script updates the rate code resource conversion factor in the CIMSSummary table. You must run the Rebill.wsf script after running this script to recalculate the money value for the rate code.

**Important!** • Consult IBM before using the ResourceConversion.wsf script. If you run this script more than once for the same rate code or codes, the resource units that are converted are the units that were converted previously, not the original units. For example, if the conversion factor for a rate code is Divide by 60 and the resource units are 120, the resource unit value after calculating once is 2, after calculating twice it is .033 (2/60), etc.

This scenario is not applicable to the Rebill.wsf script—you can run this script multiple times for the same rate code or codes.

For the parameters required for these scripts, see page C-20.
Processing Data on Windows

Rebilling Rate Codes After Changing Rate Code Values or Conversion Factors
Processing Data on UNIX or Linux

This chapter provides an overview of the ITUAM data processing cycle on a UNIX or Linux system. For more a detail explanation of the data processing, refer to the IBM Tivoli Usage and Accounting Manager Data Collectors for UNIX and Linux User’s Guide.

In this chapter, $ITUAM_HOME refers to the top-level directory where ITUAM is installed. For example, assume that the top-level directory is /usr/ituam. In this example, /usr/ituam is designated by $ITUAM_HOME (for example, /usr/ituam/lib/CIMS_lib/CS_libs.pm is shown as $ITUAM_HOME/lib/CIMS_lib/CS_libs.pm).

About Processing Data ............................................................... 8-3
Data Processing Frequency ....................................................... 8-3
Required Folder or Directory Permissions for Data Processing .......... 8-4
ITUAM Processing Engine Components ......................................... 8-5
CIMSAcc ................................................................. 8-6
CIMSSort ............................................................. 8-10
CIMSBill ............................................................. 8-10
CIMSSLoad ............................................................ 8-13
CS_libs ............................................................. 8-14
CS_aggtools ......................................................... 8-14
ITUAM Processing Engine Architecture Diagram ...................... 8-15
Setting Up the Control File (ProcCntl.xml) ............................... 8-16
Control File Example .................................................. 8-16
Control File Structure .................................................. 8-17
Accounting Dates .......................................................... 8-26
About the Close Date ................................................. 8-26
How Accounting Dates Are Calculated .................................. 8-27
Account Codes and Account Code Conversion ......................... 8-30
About Exception File Processing ........................................ 8-30
Setting Up Account Codes and Performing Account Code Conversion .................. 8-31
Defining the Account Code Structure ....................................................... 8-31
Defining the Account Code ................................................................. 8-32
Setting the Account Code Conversion Options ........................................... 8-34
Creating an Account Code Conversion Table ........................................... 8-36
Account Code Conversion Example ......................................................... 8-39

Setting Up Shifts ....................................................................................... 8-41
Using the SHIFT Control Statement ......................................................... 8-42

Normalizing CPU Values ........................................................................ 8-44

Include/Exclude Processing ..................................................................... 8-46

Processing Data: Setting Up the Data Processing Scripts ......................... 8-47
Nightly Script (nightly.sh) ................................................................. 8-47
Nightly Job Script (nightly.pl) ............................................................... 8-49
Processing Script (procCIMS.pl) ............................................................ 8-49
About Processing Data

ITUAM processes and applies business rules to resource usage data from any application, system, or operating system on any platform. The primary method for loading this data into ITUAM is the CSR or CSR+ file.

Using the ITUAM nightly.sh script, ITUAM Data Collectors that run on UNIX or Linux can be run in batch mode on a defined schedule (daily, monthly, etc.) to convert usage metering data created by your system into CSR or CSR+ files. You can use any batch scheduler to run the nightly.sh script. For more information about the nightly.sh script, see Nightly Script (nightly.sh) on page 8-47.

Once the CSR or CSR+ files are created, the data in the files is processed and the output is loaded into the database using the ITUAM Processing Engine components CIMSAcct.jar, CIMSBill.jar, the CIMSSort subroutine, and CIMSLoad.jar.

Data Processing Frequency

The preferred method of processing is to run the full data processing cycle as the data becomes available. The data produced by the various operating systems and applications/databases are usually made available for processing on a daily basis. Other feeds such as time accounting, help desk, line charges, equipment charges, and other shared services are usually produced on a monthly basis.

There are several advantages to running the full costing cycle on a daily or data availability basis:

- The volume of data created makes it more practical to process daily. A daily Apache Web server access log might contain millions of records. It is more efficient to process these records each day of the month rather than try to run many millions of records through the processing cycle at month end.

- It is easier to catch processing errors when the data is reviewed on a daily basis. It is more difficult to troubleshoot a problem when it is discovered at month end. If an unusual increase in utilization is observed for a specific resource at month end, the entire month’s records must be checked to determine when the increase first took place.

Because there are fewer jobs, transactions, or records to review, the task of determining what caused the utilization spike is much simpler if caught on the day in which it occurred.

- If the program CIMSBill is run monthly, the start date is the first day of the month and the end date is the last day of the month. Because of this date range, it is not possible to view Summary records for a single day or week. The smallest time range that may be used is the entire month.
Required Folder or Directory Permissions for Data Processing

The administrator that executes processing requires full access to files in the `processes` directory (that is, the ability to create, modify, delete, overwrite, etc.). Therefore, the UNIX user and group for the ITUAM administrator must have read, write, and execute permissions (mod 0770) for the `processes` directory and all subdirectories.
**ITUAM Processing Engine Components**

ITUAM Processing Engine is composed of Java programs and Perl modules. Each engine component performs particular functions in the processing cycle. The following table describes the components in the order that they appear in the processing cycle and the output files created by the objects as applicable.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
<th>Output Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIMSAcct.jar</td>
<td>Performs account code conversion, shift determination, and date selection on the data contained in the CSR or CSR+ file. For more information about CIMSAcct, including a description of its input and output files, see page 8-6.</td>
<td>■ CIMSAcct Output CSR+. This file is input into the CIMSSort subroutine or can be reprocessed through CIMSAcct.</td>
</tr>
<tr>
<td>CIMSSort subroutine</td>
<td>Sorts the CIMSAcct Output CSR+ file and produces a version of the file that is ready to be processed by CIMSBill.</td>
<td>■ Sorted CIMSAcct Output CSR+. This file is input into CIMSBill.</td>
</tr>
<tr>
<td>CIMSBill.jar</td>
<td>Processes the sorted CIMSAcct Output CSR+ file and performs shift processing, CPU normalization, and include/exclude processing and creates files that contain the billing information used to generate invoices and reports. For more information about CIMSBill, including a description of its input and output files, see page 8-10.</td>
<td>■ CIMSBill Detail. This file is loaded into the database or can be reprocessed through CIMSBill.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Summary. This file is loaded into the database or can be reprocessed through CIMSAcct.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Ident. This file is loaded into the database.</td>
</tr>
<tr>
<td>CIMSMLoad.jar</td>
<td>Loads the CIMSBill Detail, Summary, and Ident files into the database. For more information about CIMSMLoad, including a description of its input and output files, see page 8-13.</td>
<td></td>
</tr>
</tbody>
</table>

**Table 8-1 • ITUAM Processing Engine Components**
CIMSAcct

CIMSAcct is the first data processing program that is executed. CIMSAcct processes the records in the input file (see CIMSAcct Input on page 8-7) and performs the following:

- **Account code conversion.** CIMSAcct uses specified identifiers from the input file to build the account code and perform account code conversion if required. For more information, see Setting Up Account Codes and Performing Account Code Conversion on page 8-31.

- **Date selection.** CIMSAcct selects the input file records to be processed based on the specified date or date range.

- **Shift determination.** CIMSAcct can determine the shift to be used for processing in either of the following ways:
  - Use the shift code from the input file records. If a shift code is not included in the records, the default shift code is 1.
  - Recalculate the shift using the start date/time in the records. For more information, see Setting Up Shifts on page 8-41.

CIMSAcct produces the Output CSR+ file, which contains records that are properly formatted for input into CIMSBill.

Reprocessing the CIMSAcct Output CSR+ Files Through CIMSAcct

You can reprocess the CIMSAcct Output CSR+ file through CIMSAcct. This is usually done to reprocess data for further account code conversion. To reprocess this file, you need modify the `procCIMS.pl` script. For more information about this script, see Processing Script (procCIMS.pl) on page 8-49.
CIMSAcct Input

The following table lists the input and processing files used by CIMSAcct. These files are in the process definition subdirectories in the processes directory.

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input Files</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CSR or CSR+ file</td>
<td>CurrentCSR.txt</td>
<td>These are the most commonly used files for processing data through ITUAM.</td>
</tr>
<tr>
<td>Or</td>
<td>yyyyymmdd.txt</td>
<td>To view the record layout for these files, see Appendix B, File Layouts.</td>
</tr>
<tr>
<td>CIMSAcct Output</td>
<td>AcctCSR.txt</td>
<td>This file is the output from a previous run of CIMSAcct.</td>
</tr>
<tr>
<td>CSR+ file</td>
<td></td>
<td>This file provides an account code for each input file record. This file is input into the CIMSSort subroutine.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When used as input into CIMSAcct, this file is used primarily for further account code conversion.</td>
</tr>
<tr>
<td><strong>Processing Files</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control file</td>
<td>ProcCntl.xml</td>
<td>These files contain the CIMSAcct parameters. ProcCntl.xml contains the parameters for CIMSAcct, CIMSBill, and CIMSLoad. AcctCntl.xml contains the parameters for CIMSAcct only.</td>
</tr>
<tr>
<td>Or</td>
<td>AcctCntl.xml</td>
<td>Unless you need to use separate control files (for example, you want to run CIMSAcct twice for additional account code conversion), it is recommended that you use the ProcCntl.xml file.</td>
</tr>
<tr>
<td>Account Code Conversion table</td>
<td>AcctTabl.txt</td>
<td>This optional file contains the account code conversion table (see Creating an Account Code Conversion Table on page 8-36).</td>
</tr>
</tbody>
</table>

Table 8-2 • CIMSAcct Input
## Processing Data on UNIX or Linux

### ITUAM Processing Engine Components

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Source Configuration file</td>
<td>CIMSDBConfig.xml</td>
<td>This file contains the database connection parameters. Database access is required by CIMSAcct only if the DATE SELECTION PREVIOUS or DATE SELECTION CURRENT control statement is used. Because the period is defined in the CIMSCalendar table in the database, CIMSAcct requires access to the table to determine the period.</td>
</tr>
<tr>
<td>ITUAM Parameter file</td>
<td>ituam.par</td>
<td>This file contains the parameters used to run CIMSAcct and the other ITUAM Processing Engine components.</td>
</tr>
</tbody>
</table>

### Table 8-2 • CIMSAcct Input (Continued)
### CIMSAcct Output

The following table lists the CIMSAcct output files. These files are in the process definition subdirectories in the `processes` directory.

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIMSAcct Output</td>
<td>AcctCSR.txt</td>
<td>This file provides an account code for each input file record. This file is input into the CIMSSort subroutine.</td>
</tr>
<tr>
<td>CSR+ file</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CIMSAcct Message file</td>
<td>User Defined</td>
<td>This optional file contains processing messages and results related to CIMSAcct.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If a message file is not defined in the control file (see page 8-19), all CIMSAcct messages will go to STDOUT.</td>
</tr>
<tr>
<td>Exception file</td>
<td>Exception.txt</td>
<td>This is an optional file in CSR or CSR+ format that contains all records that did not match during account code conversion. These files can be reprocessed through the processing cycle as described in <em>About Exception File Processing</em> on page 8-30.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To produce this file, you must have exception file processing enabled (see page 8-30).</td>
</tr>
</tbody>
</table>

**Table 8-3 • CIMSAcct Output**
CIMSSort

The CIMSSort is a Perl subroutine that sorts the CIMSAcct Output CSR+ file by account code and produces a version of the file that is ready to be processed by CIMSBill.

CIMSBill

The cost of information services, and which departments are using the services, is of considerable interest to an organization. When users are made aware of the costs and are held financially responsible for those costs, they are more likely to use the resources in a prudent manner. ITUAM provides comprehensive computer center billing through the program CIMSBill.

The primary function of CIMSBill is to perform cost extensions within ITUAM and to summarize cost and resource utilization by account code. CIMSBill uses the rate code table assigned to the client to determine the amount to be charged for each resource consumed. It is possible to have a unique rate code table for each client.

There are specific rules that CIMSBill follows when charging resource consumption:

- If a resource has a corresponding entry with a monetary amount in the rate code table, the number of resource units are multiplied by this amount. The result appears in the Summary records.
- If a resource has a corresponding entry with no or zero currency amount in the rate code table, a zero cost appears in the Summary records for that resource.
- If a resource does not have a corresponding entry in the rate code table, the data for that resource does not appear in the Summary records.
- If none of the resources in the CIMSBill input file have a corresponding entry in the rate code table, the Summary file will contain no records. You must have at least one rate code from the input file in the rate code table to produce Summary records.

In addition to standard costing, CIMSBill also performs the following:

- Processes non-standard costs such as miscellaneous, recurring, and credit transactions. For more information about creating and using transactions, refer to the IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide.
- Performs CPU Normalization. See Normalizing CPU Values on page 8-44.
- Performs include/exclude processing. See Include/Exclude Processing on page 8-46.
## CIMSBill Input

The following table lists the input and processing files used by CIMSBill. These files are in the process definition subdirectories in the `processes` directory.

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input File</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CIMSSORT/</td>
<td>AcctCSR.txt</td>
<td>This is the sorted Output CSR+ file from CIMSAcct.</td>
</tr>
<tr>
<td>CIMSAcct Output</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CSR+ file</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Processing Files</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control file</td>
<td>ProcCntl.xml or</td>
<td>These files contain the CIMSBill parameters.</td>
</tr>
<tr>
<td>BillCntl.xml</td>
<td>ProcCntl.xml</td>
<td>ProcCntl.xml contains the parameters for CIMSAcct, CIMSBill, and CIMSLoad.</td>
</tr>
<tr>
<td></td>
<td>BillCntl.xml</td>
<td>BillCntl.xml contains the parameters for CIMSBill only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unless you want to use separate control files, it is recommended that you use the ProcCntl.xml file.</td>
</tr>
<tr>
<td>Data Source</td>
<td>CIMSDBConfig.xml</td>
<td>This file contains the database connection parameters.</td>
</tr>
<tr>
<td>Configuration file</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ITUAM Parameter</td>
<td>ituam.par</td>
<td>This file contains the parameters used to run CIMSBill and the other ITUAM Processing Engine components.</td>
</tr>
<tr>
<td>file</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Table 8-4  • CIMSBill Input**
### CIMSBill Output

The following table lists the CIMSBill output files. These files are in the process definition subdirectories in the `processes` directory.

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIMSBill Resource file</td>
<td>BillResource.txt or a user defined name.</td>
<td>This optional file is the same as the CIMSBill Detail file except that no CPU normalization or include/exclude processing has been performed and accounting dates are not set. This file is produced only when the CIMSBill <code>resourceFile</code> attribute is provided (see page 8-21) and is loaded into the database only when the CIMSLoad <code>loadType</code> attribute is set to <code>Resource</code> (see page 8-24).</td>
</tr>
<tr>
<td>CIMSBill Detail file</td>
<td>BillDetail.txt</td>
<td>This file is loaded into the database for use in drill down reports. This file contains resource utilization data. The CIMSBill Detail file differs from the CIMSBill Resource file in that the Detail file reflects any CPU normalization or include/exclude processing that was performed on the CIMSAct Output CSR+ file. The CIMSBill Detail file also includes accounting dates.</td>
</tr>
<tr>
<td>Summary file</td>
<td>BillSummary.txt</td>
<td>This file is loaded into the database for use in producing reports. This file contains both resource utilization and cost data.</td>
</tr>
<tr>
<td>Ident File</td>
<td>Ident.txt</td>
<td>This file contains all the identifiers that are contained in the input records (e.g., user ID, jobname, department code, server name). These identifiers are used during account code conversion to create your target account code structure. This file is loaded into the database.</td>
</tr>
<tr>
<td>CIMSBill Message file</td>
<td>User Defined</td>
<td>This optional file contains processing messages and results related to CIMSBill. If a message file is not defined in the control file (see page 8-22), all CIMSBill messages will go to STDOUT.</td>
</tr>
</tbody>
</table>

Table 8-5 • CIMSBill Output
CIMSLoad

CIMSLoad loads the output files from CIMSBill into the database. By default, CIMSLoad loads the CIMSBill Detail, Ident, and Summary files. However, you can use the `loadType` parameter to specify all files (including the CIMSBill Resource file) or just specific files as described on page 8-24.

CIMSLoad Input

The following table lists the input and processing files used by CIMSLoad. These files are in the process definition subdirectories in the `processes` directory.

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input Files</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CIMSBill Resource</td>
<td><em>BillResource.txt</em> or a user defined name.</td>
<td>This optional file is the same as the CIMSBill Detail file except that no CPU normalization or include/exclude processing has been performed and accounting dates are not set. This file is loaded into the database only when the CIMSLoad <code>loadType</code> attribute is set to Resource (see page 8-24).</td>
</tr>
<tr>
<td>CIMSBill Detail file</td>
<td><em>BillDetail.txt</em></td>
<td>This file is loaded into the database for use in drill down reports. This file contains resource utilization data.</td>
</tr>
<tr>
<td>Summary file</td>
<td><em>BillSummary.txt</em></td>
<td>This file is loaded into the database for use in producing reports. This file contains both resource utilization and cost data.</td>
</tr>
<tr>
<td>Ident File</td>
<td><em>Ident.txt</em></td>
<td>This file contains all the identifiers that are contained in the input records (e.g., user ID, jobname, department code, server name). These identifiers are used during account code conversion to create your target account code structure. This file is loaded into the database.</td>
</tr>
</tbody>
</table>

Table 8-6  •  CIMSLoad Input
### Processing Data on UNIX or Linux

#### ITUAM Processing Engine Components

#### CIMSLoad Output

The following table lists the CIMSLoad output files. These files are in the process definition subdirectories in the `processes` directory.

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIMSLoad Message file</td>
<td>User Defined</td>
<td>This optional file contains processing messages and results related to CIMSLoad. If a message file is not defined in the control file (see page 8-24), all CIMSLoad messages will go to STDOUT.</td>
</tr>
</tbody>
</table>

#### Table 8-7 • CIMSLoad Output

**CS_libs**

`$ITUAM_HOME/lib/CIMS_lib/CS_libs.pm` is a Perl module that contains subroutines that validate arguments, search directories, scan files, and perform other operational tasks required by job and conversion scripts.

**CS_aggtools**

`$ITUAM_HOME/lib/CIMS_lib/CS_aggtools.pm` is a Perl module that contains the subroutines and objects used to support the ITUAM Perl Aggregation Engine.
ITUAM Processing Engine Architecture Diagram

The diagram in Figure 8-1 shows the input and output for ITUAM Processing Engine on a UNIX or Linux system. For simplicity, this diagram shows only the key input and output. For a complete description of all input and output, refer to the preceding sections.

Figure 8-1 • Architecture of the ITUAM System
Setting Up the Control File (ProcCntl.xml)

The parameters for the CIMSAcct, CIMSBill, and CIMSLoad programs are defined in an XML control file, ProcCntl.xml. A sample ProcCntl.xml file is included in each of the sample process definition directories provided with ITUAM. You can edit this file as needed.

ITUAM also includes separate XML control files for each program. These files are named AcctCntl.xml, BillCntl.xml, and LoadCntl.xml and contain the same parameters for that program as are contained in the ProcCntl.xml file. Unless you need to use separate control files (for example, you want to run CIMSAcct twice for additional account code conversion), it is recommended that you use the ProcCntl.xml file.

Control File Example

```xml
<?xml version="1.0" encoding="utf-8" ?>
<CIMSProcessing version="4.0">
  <Step id="Process Acct" programName="CIMSAcct">
    <Parameters>
      <Parameter accCodeConvTable="AcctTabl.txt"/>
      <Parameter fullMessageFormat="true"/>
      <Parameter messageFile="AcctMsg.log"/>
      <Parameter trace="false"/>
      <Parameter ControlCard="Account Code Conversion Sort"/>
      <Parameter ControlCard="Print Account No-Match"/>
      <Parameter ControlCard="ACCOUNT FIELD0,SYSTEM_ID,1,8"/>
      <Parameter ControlCard="ACCOUNT FIELD1,OR_BASE,1,8"/>
      <Parameter ControlCard="DEFINE FIELD0,1,8"/>
      <Parameter ControlCard="DEFINE FIELD1,9,8"/>
      <Parameter ControlCard="DEFINE MOVEFLD0,1,8"/>
      <Parameter ControlCard="DEFINE MOVEFLD1,9,8"/>
    </Parameters>
  </Step>
  <Step id="Process Bill" programName="CIMSBill">
    <Parameters>
      <Parameter fullMessageFormat="true"/>
      <Parameter messageFile="BillMsg.log"/>
      <Parameter trace="false"/>
    </Parameters>
  </Step>
  <Step id="Load Detail" programName="CIMSLoad">
    <Parameters>
      <Parameter loadType="ALL"/>
      <Parameter bulkLoad="true"/>
      <Parameter detailFile="BillDetail.txt"/>
      <Parameter identFile="Ident.txt"/>
      <Parameter summaryFile="BillSummary.txt"/>
      <Parameter messageFile="LoadMsg.log"/>
      <Parameter trace="true"/>
    </Parameters>
  </Step>
</CIMSProcessing>
```

For a description of the Step element and attributes, see page 8-17.

For descriptions of the parameters for the CIMSAcct program, see page 8-18.

For descriptions of all CIMSAcct and CIMSBill control statements, see page D-26.

For descriptions of the parameters for the CIMSBill program, see page 8-21.

For descriptions of the parameters for the CIMSLoad program, see page 8-23.
Control File Structure

This section describes the required and optional elements and attributes in a control file. Note that the sample control files provided with ITUAM do not include all of the attributes and parameters described in this section.

CIMSProcessing Element

The CIMSProcessing element is the root element of the control file. All other elements are child elements of CIMSProcessing. There are no attributes for the CIMSProcessing element.

Step Element

XML tree structure: CIMSProcessing/Step

A Step element defines a step within the control file. You can define one step for each program (CIMSAcct, CIMSBill, and CIMSLoad). If you define multiple steps for a program, only the attributes and parameters in first step are used.

The following table lists the attributes for the Step element.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Required or Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>Required</td>
<td>A text string name for the step. Example: id=&quot;Process Acct&quot; In this example, the step is executing the CIMSAcct program.</td>
</tr>
<tr>
<td>programName</td>
<td>Required</td>
<td>The name of the program that the step supports. Valid values are CIMSAcct, CIMSBill, or CIMSLoad.</td>
</tr>
<tr>
<td>dataSourceId</td>
<td>Optional</td>
<td>The ITUAM Data Source ID to use as the default if other than the default specified in the ituam.par file (see About the ituam.par File on page 3-25).</td>
</tr>
</tbody>
</table>

Table 8-8 • Step Element Attributes
### Parameters Element

XML tree structure: `CIMSProcessing/Step/Parameters`

A **Parameters** element is a container for one or more **Parameter** elements.

### Parameter Element

XML tree structure: `CIMSProcessing/Step/Parameters/Parameter`

A **Parameter** element defines a parameter to a step.

The following rules apply to parameter attributes:

- Some optional attributes have default values. If you do not include these attributes or provide blank values, the default values are used.

- For attributes that enable you to define the names of input and output files, do not include the path with the file name. These programs should reside in the process definition directory. The exception is the account code conversion table, which can be in any directory and requires a path if it is not in the process definition directory.

The following table lists the attributes for the Parameter element by program: CIMSAcct, CIMSBill, and CIMSLoad.

<table>
<thead>
<tr>
<th>Program Name or Type</th>
<th>Attribute</th>
<th>Required or Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIMSAcct</td>
<td>inputFile</td>
<td>Optional</td>
<td>The name of the CSR or CSR+ file to be processed. This file must be in the process definition directory—do not include a path. The default is &quot;CurrentCSR.txt&quot;.</td>
</tr>
</tbody>
</table>

For a description of this program, see page 8-6.

For an example of the parameters for this program in a control file see see Control File Example on page 8-16.
Setting Up the Control File (ProcCntl.xml)

Table 8-9  Parameter Element Attributes (Continued)

<table>
<thead>
<tr>
<th>Program Name or Type</th>
<th>Attribute</th>
<th>Required or Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIMSAcct (continued)</td>
<td>outputFile</td>
<td>Optional</td>
<td>The name of the CIMSAcct Output CSR+ file. This file must be in the process definition directory—do not include a path. The default is &quot;AcctCSR.txt&quot;.</td>
</tr>
<tr>
<td></td>
<td>accCodeConvTable</td>
<td>Optional</td>
<td>The name of account code conversion table used by CIMSAcct. Include a path if the table is in a location other than the process definition directory. Example: accCodeConvTable= &quot;/usr/local/cims/cimslab/AcctTab1.txt&quot; The default is &quot;AcctTab1.txt&quot;.</td>
</tr>
<tr>
<td></td>
<td>messageFile</td>
<td>Optional</td>
<td>The name of the CIMSAcct Message and Results file. This file must be in the process definition directory—do not include a path. If this attribute is not provided or is left blank, all messages will go to Standard Output (STDOUT). The default is STDOUT.</td>
</tr>
<tr>
<td></td>
<td>exceptionFile</td>
<td>Optional</td>
<td>The name of the exception file produced by CIMSAcct. This file must be in the process definition directory—do not include a path. The default is &quot;Exception.txt&quot;.</td>
</tr>
</tbody>
</table>
Processing Data on UNIX or Linux

Setting Up the Control File (ProcCntl.xml)

CIMSAcct (continued)

<table>
<thead>
<tr>
<th>Program Name or Type</th>
<th>Attribute</th>
<th>Required or Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIMSAcct</td>
<td>fullMessageFormat</td>
<td>Optional</td>
<td>Specifies whether all messages produced by CIMSAcct are prefixed with the date and time. Valid values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- &quot;true&quot; (the date and time are included)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- &quot;false&quot; (the date and time are not included)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The default is &quot;true&quot;.</td>
</tr>
<tr>
<td></td>
<td>trace</td>
<td>Optional</td>
<td>Specifies whether trace messages are produced in CIMSAcct Message and Results file or STDOUT. Valid values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- &quot;true&quot; (trace messages are produced)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- &quot;false&quot; (trace messages are not produced)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The default is &quot;false&quot;.</td>
</tr>
<tr>
<td></td>
<td>ControlCard</td>
<td>Optional</td>
<td>A valid CIMSAcct control statement.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>&lt;parameter ControlCard= &quot;PRINT ACCOUNT NO-MATCH&quot; /&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>&lt;parameter ControlCard= &quot;DEFINE FIELD0,1,8&quot; /&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>For a description of all CIMSAcct control statements, see CIMSAcct Control Statements on page D-26.</td>
</tr>
</tbody>
</table>

Table 8-9 • Parameter Element Attributes (Continued)
### Program Name or Type

- **CIMSBill**

  For a description of this program, see page 8-10.

  For an example of the parameters for this program in a control file see see *Control File Example* on page 8-16.

### Attribute

#### inputFile

- **Optional**

  The name of the CIMSAct Output CSR+ file to be processed. This file must be in the process definition directory—do not include a path.

  The default is "AcctCSR.txt".

#### resourceFile

- **Optional**

  The name of the optional CIMSBill Resource file. It is recommended that you use the name BillResource.txt. This file must be in the process definition directory—do not include a path.

  If this attribute is not provided, the CIMSBill Resource file is *not* created.

#### detailFile

- **Optional**

  The name of the CIMSBill Detail file produced. This file must be in the process definition directory—do not include a path.

  The default is "BillDetail.txt".

#### summaryFile

- **Optional**

  The name of the Summary file produced. This file must be in the process definition directory—do not include a path.

  The default is "BillSummary.txt".

### Table 8-9 • Parameter Element Attributes (Continued)
### Program Name or Type

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Required or Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>identFile</td>
<td>Optional</td>
<td>The name of the Ident file. This file must be in the process definition directory—do not include a path. The default is &quot;Ident.txt&quot;.</td>
</tr>
<tr>
<td>messageFile</td>
<td>Optional</td>
<td>The name of the CIMSBill Message and Results file. This file must be in the process definition directory—do not include a path. If this attribute is not provided or is left blank, all messages will go to Standard Output (STDOUT). The default is STDOUT.</td>
</tr>
<tr>
<td>fullMessageFormat</td>
<td>Optional</td>
<td>Specifies whether all messages produced by CIMSBill are prefixed with the date and time. Valid values are: &quot;true&quot; (the date and time are included) &quot;false&quot; (the date and time are not included) The default is &quot;true&quot;.</td>
</tr>
<tr>
<td>trace</td>
<td>Optional</td>
<td>Specifies whether trace messages are produced in CIMSBill Message and Results file or STDOUT. &quot;true&quot; (trace messages are produced) &quot;false&quot; (trace messages are not produced) The default is &quot;false&quot;.</td>
</tr>
</tbody>
</table>

Table 8-9 • Parameter Element Attributes (Continued)
### Processing Data on UNIX or Linux

#### Setting Up the Control File (ProcCntl.xml)

- **CIMSBill (continued)**
  - **ControlCard**
    - **Attribute**: ControlCard
    - **Required or Optional**: Optional
    - **Description**: A valid CIMSBill control statement.
      - **Example**:
        ```xml
        <parameter ControlCard= "CLIENT SEARCH ON" />
        <parameter ControlCard= "DEFAULT CLOSE DAY=15" />
        ```
      - For a description of all CIMSBill control statements, see [CIMSBill Control Statements](#) on page D-35.

- **CIMSLoad**
  - **bulkLoad**
    - **Attribute**: bulkLoad
    - **Required or Optional**: Optional
    - **Description**: Specifies whether to use bulk insertions or single record insertions into the database.
      - Valid values are:
        - "true" (use bulk insertions)
        - "false" (use single record insertions)
      - The default is "true".

- **identFile**
  - **Attribute**: identFile
  - **Required or Optional**: Optional
  - **Description**: The name of the Ident file to be loaded. This file must be in the process definition directory—do not include a path.
    - The default is Ident.txt.

- **detailFile**
  - **Attribute**: detailFile
  - **Required or Optional**: Optional
  - **Description**: The name of the CIMSBill Detail file to be loaded. This file must be in the process definition directory—do not include a path.
    - The default is BillDetail.txt.

<table>
<thead>
<tr>
<th>Program Name or Type</th>
<th>Attribute</th>
<th>Required or Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIMSBill</td>
<td>ControlCard</td>
<td>Optional</td>
<td>A valid CIMSBill control statement.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><code>&lt;parameter ControlCard= &quot;CLIENT SEARCH ON&quot; /&gt;</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><code>&lt;parameter ControlCard= &quot;DEFAULT CLOSE DAY=15&quot; /&gt;</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>For a description of all CIMSBill control statements, see <a href="#">CIMSBill Control Statements</a> on page D-35.</td>
</tr>
<tr>
<td>CIMSLoad</td>
<td>bulkLoad</td>
<td>Optional</td>
<td>Specifies whether to use bulk insertions or single record insertions into the database. Valid values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ &quot;true&quot; (use bulk insertions)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ &quot;false&quot; (use single record insertions)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The default is &quot;true&quot;.</td>
</tr>
<tr>
<td></td>
<td>identFile</td>
<td>Optional</td>
<td>The name of the Ident file to be loaded. This file must be in the process definition directory—do not include a path.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The default is Ident.txt.</td>
</tr>
<tr>
<td></td>
<td>detailFile</td>
<td>Optional</td>
<td>The name of the CIMSBill Detail file to be loaded. This file must be in the process definition directory—do not include a path.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The default is BillDetail.txt.</td>
</tr>
</tbody>
</table>

Table 8-9 • Parameter Element Attributes (Continued)
### Processing Data on UNIX or Linux

#### Setting Up the Control File (ProcCntl.xml)

<table>
<thead>
<tr>
<th>Program Name or Type</th>
<th>Attribute</th>
<th>Required or Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIMSLoad (continued)</td>
<td>summaryFile</td>
<td>Optional</td>
<td>The name of the Summary file to be loaded. This file must be in the process definition directory—do not include a path. The default is BillSummary.txt.</td>
</tr>
<tr>
<td></td>
<td>resourceFile</td>
<td>Optional</td>
<td>The name of the optional CIMSBill Resource file. It is recommended that you use the name BillResource.txt. This file must be in the process definition directory—do not include a path.</td>
</tr>
<tr>
<td></td>
<td>loadType</td>
<td>Optional</td>
<td>Specifies the type of files to be loaded to the database. Valid values are: Summary (Summary file), Detail (CIMSBill Detail file), Resource (CIMSBill Resource file), Ident (Ident file), All (All files except the CIMSBill Resource file)</td>
</tr>
<tr>
<td></td>
<td>messageFile</td>
<td>Optional</td>
<td>The name of the CIMSLoad Message and Results file. This file must be in the process definition directory—do not include a path. If this attribute is not provided or is left blank, all messages will go to Standard Output (STDOUT). The default is STDOUT.</td>
</tr>
</tbody>
</table>

Table 8-9  •  Parameter Element Attributes (Continued)
<table>
<thead>
<tr>
<th>Program Name or Type</th>
<th>Attribute</th>
<th>Required or Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIMSLoad (continued)</td>
<td>fullMessageFormat</td>
<td>Optional</td>
<td>Specifies whether all messages produced by CIMSLoad are prefixed with the date and time. Valid values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- &quot;true&quot; (the date and time are included)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- &quot;false&quot; (the date and time are not included)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The default is &quot;true&quot;.</td>
</tr>
<tr>
<td></td>
<td>trace</td>
<td>Optional</td>
<td>Specifies whether trace messages are produced in CIMSLoad Message and Results file or STDOUT. Valid values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- &quot;true&quot; (trace messages are produced)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- &quot;false&quot; (trace messages are not produced)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The default is &quot;false&quot;.</td>
</tr>
</tbody>
</table>

Table 8-9 - Parameter Element Attributes (Continued)
Accounting Dates

ITUAM input records contain a usage start date and end date that specify the date range in which the resources in the record were consumed. CIMSBill uses the usage end date to calculate accounting start and end dates, which are used for billing and reporting. The accounting start and end dates may be the same as or different than the usage end date (see How Accounting Dates Are Calculated on page 8-27).

The accounting start and end dates are stored in the following fields in the CIMSBill output files:

- **CIMSBill Detail file.** The accounting dates are in the **ACCOUNTING-START-DATE** and **ACCOUNTING-END-DATE** fields.

- **Summary file.** The accounting dates are in the **AccountingFromDate** and **AccountingToDate** fields (starting positions 167 and 175, respectively). The **Period** and **Year** fields also reflect the accounting end dates. (These fields are at starting positions 282 and 284, respectively.) For example, if the end date is 20060916 and the date falls within the 9th period in the CIMSCalendar table, the **Period** field would contain 09 and the **Year** field 2006.

About the Close Date

You can set an optional close date for processing input file records. Records that contain usage end dates before or after this date are processed as described in How Accounting Dates Are Calculated on page 8-27. The close date can be a specific date or a day of the month (the first, fifteenth, thirtieth, etc.).

You can set a system-wide close date for all process definitions and/or you can set close dates for an individual process definition or definitions. Close dates set for individual process definitions override the system-wide close date.

The close date for individual process definitions is set using the CIMSBill control statement parameter **ControlCard="DEFAULT CLOSE DAY"** in the control file (see page D-37).

The system-wide close date is set in the Configuration dialog box in ITUAM Administrator (see Closing Subtab on page 4-43).
How Accounting Dates Are Calculated

The accounting dates are calculated according to the usage end dates, the close date (see About the Close Date on page 8-26), and the periods defined in the CIMSCalendar table. The accounting dates may be the same as or different than the usage end date depending on the factors described in the following sections.

Scenarios in Which Accounting Dates and Usage End Dates are Always the Same

The accounting dates and usage end date are always the same in the following situations:

- If no close date is set.
- If both the CIMSBill run date and the usage end date are in the same period (as set in the CIMSCalendar table), regardless of the close date.

Example Using Calendar Month Periods With Monthly Close Date

<table>
<thead>
<tr>
<th>Current Period</th>
<th>Close Date for Current Period</th>
<th>CIMSBill Run Date</th>
<th>Usage End Date</th>
<th>Accounting Dates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sept. 1–30 (Period 9)</td>
<td>Oct. 3</td>
<td>Sept. 30</td>
<td>Sept. 16</td>
<td>Sept. 16</td>
</tr>
</tbody>
</table>

Example Using Non Calendar Month Periods With Specific Close Date

<table>
<thead>
<tr>
<th>Current Period</th>
<th>Close Date for Current Period</th>
<th>CIMSBill Run Date</th>
<th>Usage End Date</th>
<th>Accounting Dates</th>
</tr>
</thead>
</table>
If the usage end date is in the previous period and the CIMSBill run date is prior to the close date for that period.

Example Using Calendar Month Periods With Monthly Close Date

<table>
<thead>
<tr>
<th>Previous Period</th>
<th>Close Date for Prev. Period</th>
<th>Current Period</th>
<th>CIMSBill Run Date</th>
<th>Usage End Date</th>
<th>Accounting Dates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aug. 1–31</td>
<td>Sept. 3</td>
<td>Sept. 1–30</td>
<td>Sept. 2</td>
<td>Aug. 16</td>
<td>Aug. 16</td>
</tr>
</tbody>
</table>

(Period 8) (Period 9)

Example Using Non Calendar Month Periods With Specific Close Date

<table>
<thead>
<tr>
<th>Previous Period</th>
<th>Close Date for Prev. Period</th>
<th>Current Period</th>
<th>CIMSBill Run Date</th>
<th>Usage End Date</th>
<th>Accounting Dates</th>
</tr>
</thead>
</table>

(Period 8) (Period 9)

**Scenarios in Which Accounting Dates and Usage End Dates are Different**

The accounting dates and usage end date are *different* in the following situations:

- If the usage date is in *any* previous period and the CIMSBill run date is after the close date for the period immediately prior to the current period, the accounting dates are set to the previous day from the day CIMSBill was run.

Example Using Calendar Month Periods With Monthly Close Date

Note that for example purposes, the period immediately prior to the current period is used. However, this example is applicable for any previous period.

<table>
<thead>
<tr>
<th>Previous Period</th>
<th>Close Date for Prev. Period</th>
<th>Current Period</th>
<th>CIMSBill Run Date</th>
<th>Usage End Date</th>
<th>Accounting Dates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aug. 1–31</td>
<td>Sept. 3</td>
<td>Sept. 1–30</td>
<td>Sept. 5</td>
<td>Aug 16</td>
<td>Sept. 4</td>
</tr>
</tbody>
</table>

(Period 8) (Period 9) (CIMSBill run date -1 day)

Example Using Non Calendar Month Periods With Specific Close Date

<table>
<thead>
<tr>
<th>Previous Period</th>
<th>Close Date for Prev. Period</th>
<th>Current Period</th>
<th>CIMSBill Run Date</th>
<th>Usage End Date</th>
<th>Accounting Dates</th>
</tr>
</thead>
</table>

(Period 8) (Period 9) (CIMSBill run date -1 day)
If the usage end date is in any period prior to the previous period and the CIMSBill run date is before the close date for the previous period, the accounting dates are set to the last day of the previous period.

**Example Using Calendar Month Periods**

<table>
<thead>
<tr>
<th>Period Prior to Previous Period</th>
<th>Close Date for Prev. Period (Aug. 1–31)</th>
<th>Current Period</th>
<th>CIMSBill Run Date</th>
<th>Usage End Date</th>
<th>Accounting Dates</th>
</tr>
</thead>
<tbody>
<tr>
<td>July 1–31 (Period 7)</td>
<td>Sept. 3</td>
<td>Sept. 1–30 (Period 9)</td>
<td>Sept. 2</td>
<td>July 16</td>
<td>Aug. 31 (Last day of previous period)</td>
</tr>
</tbody>
</table>

**Example Using Non Calendar Month Periods With Specific Close Date**

<table>
<thead>
<tr>
<th>Period Prior to Previous Period</th>
<th>Close Date for Prev. Per. (Aug. 23–Sept.22)</th>
<th>Current Period</th>
<th>CIMSBill Run Date</th>
<th>Usage End Date</th>
<th>Accounting Dates</th>
</tr>
</thead>
<tbody>
<tr>
<td>July 23–Aug. 22 (Period 7)</td>
<td>Sept. 25</td>
<td>Sept. 23–Oct. 22 (Period 9)</td>
<td>Sept. 24</td>
<td>July 20</td>
<td>Sept. 22 (Last day of previous period)</td>
</tr>
</tbody>
</table>
Account Codes and Account Code Conversion

Within chargeback and resource accounting, an account code uniquely identifies an individual, billing, or reporting entity. The actual definition of what the account code represents depends on how ITUAM is used. For example, an account code can represent an organization, a department in an organization, or an individual.

A key feature of CIMSAcct is its ability to use business rules to convert the identifier values in the CSR or CSR+ files into account codes. In some cases, the identifier value in the CSR or CSR+ file is the actual account code. However, in most cases, the identifier value represents the source of the consumed resources (i.e., a user ID, IP address, server name, jobname, transaction ID, terminal ID, etc.).

CIMSAcct uses an account code conversion table to convert identifier values into an account code. For example, an IP address of 10.26.12.255 is converted to the account code for Human Resources while an address of 10.26.12.260 is converted to the account code for Accounts Payable. These departments can then be charged for the consumption of the resources associated with their IP addresses.

For the steps required to set up account code conversion, see page 8-31. For an example of these steps, see page 8-39.

About Exception File Processing

During account code conversion, CIMSAcct might encounter input file records that do not match any entry in the account code conversion table. CIMSAcct includes an optional exception file processing feature that automatically identifies and removes unmatched records so that they can be reprocessed with the correct accounting information.

When this feature is enabled, all unmatched records are output to an exception file in the process definition subdirectory. You can use the exception file to identify the information that needs to be corrected, either in the records in the exception file or in the account code conversion table, and then reprocess the exception file.

To enable the exception file processing feature, see Setting the Account CodeConversion Options on page 8-34. For assistance in processing exception files, contact IBM Technical Support.
Setting Up Account Codes and Performing Account Code Conversion

This section describes the account codes structure and how to define and convert the account code using the parameters in the control file. For an example of the account code conversion parameters in a control file, see Control File Example on page 8-16.

For descriptions of the control statements referenced in this section, see ITUAM Processing Engine Control Statements (UNIX or Linux) on page D-26.

Defining the Account Code Structure

One of the first steps in implementing ITUAM is deciding on a final account code structure. The structure is the chargeback hierarchy for the organization. The levels of this hierarchy are arranged from highest to lowest level within the account code. The account code can consist of up to 128 characters.

For example, your final account code structure could consist of:

DDDCCCCUUUUUUUUU

D = Division (three characters) (highest level)
C = Cost Center (four characters)
U = User (eight characters) (lowest level)

Note • You can use business rules to map identifiers to applications in addition to or instead of business units, departments, cost centers, etc.

The next step is to set the account code structure in ITUAM Administrator as described in Defining the Account Code Structure on page 8-31.

Once you have set up the account code structure, you can create an account code conversion table to convert the identifier values in the input file into an account code that fits within the final hierarchy pattern.
Defining the Account Code

The account code is derived from an identifier or identifiers in the input file. You need to specify the identifier(s) that you want to use to define the account code as follows:

- If the input file contains an `Account_Code` identifier, the `Account_Code` identifier value is automatically used to define the account code. If this value fits your account code hierarchy, you can use the value as your account code. If this value does not meet your account code requirements, you can convert the value to the appropriate account code.

- If the input file meets any of the following criteria, you need to specify an identifier or identifiers that you want to use to define the account code:
  - The input file does not contain an `Account_Code` identifier.
  - The input file contains an `Account_Code` identifier, but you want to use other identifiers instead.
  - The input file contains an `Account_Code` identifier and other identifiers that you want to use. In this case, you must define the `Account_Code` identifier in addition to the other identifiers.

If the identifier values fit your account code hierarchy, you can use the combined values as your account code. However, in most cases you will need to convert combined values to the appropriate account code.

The identifiers that you use (either via the `Account_Code` identifier values or the identifiers that you specify) are referred to as the account code input field.

Defining the Account Code Input Field

To define the account code input field in the control file, use the `ACCOUNT FIELD` control statement parameter to define the identifiers that you want to use. Begin with `Field0` and continue sequentially as needed as shown in the following example:

```
<Parameter ControlCard="ACCOUNT FIELD0,UserName,1,10"/>
<Parameter ControlCard="ACCOUNT FIELD1,Division,1,2"/>
```

In this example, the identifiers that will be used are `UserName` and `Division`.

The numbers that follow the identifiers are the offset and length. If you want to use the full value for an identifier, use an offset of 1 and the maximum length of the identifier value as defined in the input file.

For example, assume that the maximum value for `UserName` identifier in the input file is 10 characters and that the input file contains three `UserName` values, `KSMITH`, `GBONIFANT`, and `CGREENHALL`. If you set the offset to 1 and the length to 10 and the entire identifier values would be used.

If you want to use a portion of the identifier value, use an offset position at which you want to start the value and the corresponding length. Using the `UserName` example, if you set the offset at 2 and length at 8, the identifier values used would be `SMITH`, `BONIFANT`, and `GREENHALL`. 
You can define up to 10 account fields (Field0-Field9). The maximum number of characters for an account field is 128.

**Note** • Although the maximum number of characters for each account field is 128, the overall length of all account fields added together cannot exceed 128 characters.

Also, keep in mind that the total output account code, including any literals and move field values (see page 8-35), cannot exceed 128 bytes.

**Converting Account Code Input Field Values to Uppercase**

Use the `UPPERCASE ACCOUNT FIELDS` control statement parameter to convert lowercase account code input field values to uppercase values in the resulting account code. For example, the value `ddic` would be converted to `DDIC`. By using this option, CIMSAcct account code processing becomes case-insensitive and makes defining account conversion tables much easier.
Setting the Account Code Conversion Options

To perform account conversion, regardless of whether you are using the Account Code identifier or another identifier, you need to set the conversion options described in this section in the control file and create an account code conversion table as described on page 8-36. Account codes are assigned by matching identifier values in the input file records to the values in the account code conversion table.

Enabling Account Code Conversion

To enable account code conversion, use the ACCOUNT CODE CONVERSION SORT control statement parameter in the control file as follows:

```
ControlCard="ACCOUNT CODE CONVERSION SORT"
```

Defining the Identifier Values for Account Code Conversion

Use the DEFINE FIELD control statement parameter in the control file to specify the offset and length of the account code input field values that you want to use for conversion. Begin at Field0 and continue sequentially as needed. Note that if you created an account code input field as described in Defining the Account Code Input Field on page 8-32, the define fields correlate to the account field values, not the original identifiers in the input file.

For example, assume that you defined the account code input field as follows:

```
<Parameter ControlCard="ACCOUNT FIELD0,UserName,2,10"/>
<Parameter ControlCard="ACCOUNT FIELD1,Division,1,2"/>
```

If you wanted to use the full values defined for the account code input field, you would use the following DEFINE FIELD statements:

```
<Parameter ControlCard="DEFINE FIELD0,1,10"/>
<Parameter ControlCard="DEFINE FIELD1,11,2"/>
```

The DEFINE FIELD0 statement has an offset of 1 and length of 10 to accommodate the full 10 character length for the UserName identifier as defined by the ACCOUNT FIELD0 statement.

The DEFINE FIELD1 statement has an offset of 11 and length of 2 because the Division identifier starts in position 11 of the combined account code input field.

If you did not want to use the full values, you would change the offset and/or length for the define fields.

You can define up to 10 define fields (Field0–Field9). The maximum number of characters for an account field is 128.

**Note** • Although maximum number of characters for each define field is 128, the overall length of all define fields added together cannot exceed 128 characters.

Also, keep in mind that the total output account code, including any literals and move field values (see page 8-35), cannot exceed 128 bytes.
Defining Optional Move Fields

Use the optional `DEFINE MOVEFIELD` control statement parameter in the control file to include either the define field values or a literal in the output account code. Begin at Field0 and continue sequentially as needed. You can define up to 10 move fields (Field0–Field9). Each move field can be a maximum of 128 characters.

**Note** • Although the maximum number of characters for each move field is 128, the overall length of all move fields added together cannot exceed 128 characters.

Also, keep in mind that the total output account code, including any literals and move field values, cannot exceed 128 bytes.

To define a define field as move field:

If you specify a define field as the move field, the define field value will be included at the beginning, end, or within the account code as defined in the account code conversion table (see Creating an Account Code Conversion Table on page 8-36). For example assume that you have defined define fields as follows:

\[
<Parameter ControlCard="DEFINE FIELD0,1,10"/>
<Parameter ControlCard="DEFINE FIELD1,11,2"/>
\]

If you want to define the entire define field `UserName` value as a move field, the control statement parameter would be as follows:

\[
<Parameter ControlCard="DEFINE FIELD0,1,10"/>
<Parameter ControlCard="DEFINE FIELD1,11,2"/>
<Parameter ControlCard="DEFINE MOVEFLD0,1,10"/>
\]

If you did not want to use the full values, you would change the offset and/or length for the move fields.

To define a literal as move field:

If you specify a literal as the move field, the literal value will be included at the beginning, end, or within the account code as defined in the account code conversion table (see Creating an Account Code Conversion Table on page 8-36). For example, if you want to define the literal `abc` as a move field, the control statement parameter would be as follows:

\[
<Parameter ControlCard="DEFINE MOVEFLD0,,abc"/>
\]
Defining the Account Code Conversion Table

To define the account code conversion table that you want to use, use the parameter attribute `accCodeConvTable` in the control file. Include a path if the table is in a location other than the process definition directory in which the job script is located. For example:

```xml
<Parameter accCodeConvTable="AcctTab1.txt"/>
```

(if the table is in the process definition directory)

Or

```xml
<Parameter accCodeConvTable="/usr/local/cims/cimslab/AcctTab1.txt"/>
```

(if the table is not the process definition directory)

Enabling Exception Processing

Exception processing instructs the system to write all records that do not match an entry in the account code conversion table to an exception file. To enable exception file processing, include the control statement parameter `EXCEPTION FILE PROCESSING ON` in the control file as follows:

```xml
<Parameter ControlStatement="EXCEPTION FILE PROCESSING ON"/>
```

If this control statement is not present, the records that are not matched are written to the CIMSAccOutput CSR+ file with the unconverted account code input field value.

Considerations for Exception Processing

- If you enable exception processing, do not include a default account code as the last entry in the account code conversion table (e.g., ",,DEFAULTCODE"). If a default account number is used, records will not be written to the exception file. For more information, see page 8-36

- The default file name for the exception file is `Exception.txt`. You should rename the output exception file so that it is not overwritten when subsequent files are written.

Creating an Account Code Conversion Table

The account code conversion table is an ASCII text file that contains the definitions required to convert the identifier values defined by the account code input field to user-defined output account codes as shown in the following example:

```
ABC,DEF,ATM@0
GHI,JKL,COM@0
MNO,PQR,MTG@0
```

The fields in the account code conversion table entries are low identifier, high identifier, the account code that you want to convert to (maximum of 128 characters), and an optional move field indicator, which can be placed before, after, or within the account code. In the preceding example, the move field value will appear at the end of the account code. For an example of how to create a account code conversion table, including the use of a move field, see `Account Code Conversion Example` on page 8-39.
Consider the following when creating the account code conversion table:

- The account code conversion table is case-sensitive. For convenience, you can enter uppercase values in the table and use the `UPPERCASE ACCOUNT FIELDS` control statement parameter. This is especially helpful if you are using one account code conversion table for multiple process definitions. This ensures that account code input field values that are lowercase or mixed case are processed.

- Each record in the table can be up to 386 characters (129 for the low identifier, 129 for the high identifier, and 128 for the new account code).

- The identifier fields follow these rules:
  - Each low and high identifier field is compared to the corresponding account code input field values. If the compares are true, the account code is assigned.
  - The low identifier fields are padded with `x'00'` and the high value fields are padded with `x'FF'`.
  - The high identifier field is set equal to the low field plus the high padding when the high identifier value is null.
  - You can enter up to 10 levels of 128 characters each for the low and high identifier fields. Each level must be delimited by a colon (`:`).

  **Note** • Although the maximum number of characters for each field level is 128, the overall length of all levels added together cannot exceed 128 characters.

  For example, if you type `AA` as the low identifier and `CC` as the high identifier, all account codes that begin with characters greater than or equal to `AA` or less than or equal to `CC` are converted to the specified account code. If you type `AAAAAAAA:BB` as the low identifier and `CCCCCCCC:DD` as the high identifier, all account codes that begin with characters greater than or equal to `AAAAAAAAABB` or less than or equal to `CCCCCCCCDD` are converted to the specified account code.

- You can include a default account code as the last entry in the account code conversion table by leaving the low and high identifier fields empty (e.g., `,,DEFAULTCODE`). In this case, all records that contain identifier values that do not match an entry in the account code conversion table will be matched to the default code.
If you do not include a default account code, input file records that contain identifier values that do not match an entry in the account code conversion table are written to the CIMSAcct Output CSR+ file with the unconverted account code input field value as the account code.

If you want unmatched records to go to an exception file for reprocessing at a later time, you need to use the EXCEPTION FILE PROCESSING ON control statement parameter. If you enable exception file processing, make sure that you have not included a default account code entry in the account code conversion table.

If the PRINT ACCOUNT NO-MATCH statement is included in the control file, a message is written to STDOUT or the CIMSAcct Message file showing the identifier values from the input file that were not matched during account code conversion. If this statement is not present, only the total number of unmatched records is provided. The system prints up to 1000 messages.

Note • The messageFile parameter attribute in the control file determines whether messages are written to STDOUT or the CIMSAcct Message file. See page 8-19.

The number of definition entries that you can enter in the table is limited only by the memory available to CIMSAcct.
Account Code Conversion Example

**Note** • This section provides examples to supplement the preceding sections. Please refer to these sections for more detailed information.

Assume that you want to use the User identifier values in an input file to define your account code and that your account code is in the following structure:

```
DDDCCCUUUUJJJJJJJJJJJ
```

D = Division (three characters) (highest level)
C = Cost Center (four characters)
U = User (eight characters) (lowest level)

The following table shows the User identifier values that are in the input file records and the corresponding account code that you want to convert the value to.

<table>
<thead>
<tr>
<th>User Identifier Value from Input File</th>
<th>Final Account Code</th>
<th>Division Account Code</th>
<th>Cost Center Account Code</th>
<th>User Account Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>DDIC</td>
<td>FINACTGDDIC</td>
<td>FIN</td>
<td>ACTG</td>
<td>DDIC</td>
</tr>
<tr>
<td>SAP</td>
<td>ISDDEVPSAP</td>
<td>ISD</td>
<td>DEVP</td>
<td>SAP</td>
</tr>
<tr>
<td>SAPCOMM</td>
<td>OPSMKTGSAPCOMM</td>
<td>OPS</td>
<td>MKTG</td>
<td>SAPCOMM</td>
</tr>
<tr>
<td>SAPSYS</td>
<td>MISPRODSAPSYS</td>
<td>MIS</td>
<td>PROD</td>
<td>SAPSYS</td>
</tr>
<tr>
<td>TEAM718</td>
<td>MISTESTTEAM718</td>
<td>MIS</td>
<td>TEST</td>
<td>TEAM718</td>
</tr>
<tr>
<td>TEAMF99</td>
<td>OPSTESTTEAMF99</td>
<td>OPS</td>
<td>TEST</td>
<td>TEAMF99</td>
</tr>
</tbody>
</table>

To convert the User identifier values to the final account code, you would complete the steps in the following sections.
Define the Account Code and Conversion Parameters in the Control File

In the example on page 8-39, the longest value for the User identifier is 7 characters (SAPCOMM, TEAM718, and TEAMF99). To use the entire value, you need to define the account input field and the define field with an offset of 1 and a length of 7 as follows:

```xml
<Parameter ControlCard="Account Code Conversion Sort"/>
<Parameter ControlCard="ACCOUNT FIELDS, User, 1, 7"/>
<Parameter ControlCard="DEFINE FIELDS, 1, 7"/>
<Parameter ControlCard="DEFINE MOVE FIELDS, 1, 7"/>
<Parameter ControlCard="EXCEPTION FILE PROCESSING ON"/>
```

Because you also want to include the define field value at the end of the account code, you need to define a move field for the value, also with an offset of 1 and a length of 7.

Note that the ACCOUNT CODE CONVERSION SORT control statement parameter is required to enable account code conversion. The EXCEPTION FILE PROCESSING ON control statement parameter instructs CIMSAcct to produce an exception file.
Create the Account Code Conversion Table

The account code conversion table would contain the following entries. Note that the high identification code is not needed in this example because the low and high identification codes are the same.

DDIC,,FINACTG@0
SAP,,ISDDEVP@0
SAPCOM,,OPSMKTG@0
SAPSYS,,MISPROD@0
TEAM718,,MISTEST@0
TEAMF99,,OPSTEST@0

The @0 at the end of the account code value specifies that the move field defined in the previous step will be included at the end of the account code. For example, the resulting account code for the first table entry would be FINACTGDDIC. If you placed the @0 at the beginning of the account code value, the resulting account code would be DDIC<three spaces>FINACTG. You could place the @0 anywhere in the account code.

If you had additional move fields defined, they would be represented by @1, @2, @3, etc. For example, if you had used another identifier for account conversion in addition to User and had defined move fields for each (move field 0 and move field 1), @1FINACTG@0 would place the value for move field 1 at the beginning of the account code and the value for move field 0 at the end of the account code.

Setting Up Shifts

In ITUAM Administrator, you can set rates for a rate code by shift. This optional feature enables you to set different rates based on the time of day. For more information about setting rates by shift, see Setting Rate Shifts on page 4-13.

You can use either of the following methods to determine the shift codes that are used for processing. These shift codes appear in the CIMSAcct Output CSR+ records.

- Use the shift code from the input file records. If a shift code is not included in the records, the default shift code is 1.

- If you do not want to use the shift codes in the input record for processing, you can recalculate the shifts using the start date/time in the records and the CIMSAcct control statement parameter SHIFT as described in Using the SHIFT Control Statement on page 8-42.

Important! Regardless of whether you use the rate codes from the input file or recalculate the rate codes, you need to include the CIMSBill control statement parameter USE SHIFT CODES in the control file. If this control statement is not present, CIMSBill uses the default rate shift 1 regardless of the shift code that appears in the CIMSAcct Ouput CSR+ file.
Using the SHIFT Control Statement

You can use the CIMSAcct control statement parameter SHIFT in the control file to enter daily shifts. You can include a maximum of seven SHIFT control statement parameters (one for each day of the week). Up to 9 shifts can be specified for each SHIFT statement.

CIMSAcct compares the start dates and times in the input records to the daily shifts that you specify using the SHIFT control statement parameters and calculates new shift codes. The recalculated shift codes rather than the original shift codes appear in the CIMSAcct Output CSR+ file.

The syntax for the SHIFT control statement is as follows

SHIFT [day] [code] [end time] [code] [end time] ... [code] [end time]

day = SUN | MON | TUE | WED | THU | FRI | SAT

code = 1–9 (the shift code)

end time = the end time of the shift

The shift end times must be listed in 4-character, 24-hour format.
Control File Example With Shifts

In this example, three shifts have been defined for each day of the week. Shift 3 is from midnight to 8 a.m., shift 1 is from 8 a.m. to 4 p.m., and shift 2 is from 4 p.m. to midnight. Note that the required CIMSBill control statement parameter USE SHIFT CODES is included.

```xml
<?xml version="1.0" encoding="utf-8" ?>
<CIMSProcessing version= "4.0">
  <Step id="Process Acct"
      programName="CIMSAcct">
    <Parameters>
      <Parameter accCodeConvTable="AcctTab1.txt"/>
      <Parameter FullMessageFormat="True"/>
      <Parameter MessageFile="AcctMsg.log"/>
      <Parameter trace="false"/>
      <Parameter ControlCard="Account Code Conversion Sort"/>
      <Parameter ControlCard="Print Account No-Match"/>
      <Parameter ControlCard="ACCOUNT FIELD0,SYSTEM_ID,1,8"/>
      <Parameter ControlCard="ACCOUNT FIELD1,OR_BASE,1,8"/>
      <Parameter ControlCard="DEFINE FIELD0,1,8"/>
      <Parameter ControlCard="DEFINE FIELD1,9,8"/>
      <Parameter ControlCard="DEFINE MOVEFLD0,1,8"/>
      <Parameter ControlCard="DEFINE MOVEFLD1,9,8"/>
      <Parameter ControlCard="SHIFT SUN 3 0800 1 1600 2 2400"/>
      <Parameter ControlCard="SHIFT MON 3 0800 1 1600 2 2400"/>
      <Parameter ControlCard="SHIFT TUE 3 0800 1 1600 2 2400"/>
      <Parameter ControlCard="SHIFT WED 3 0800 1 1600 2 2400"/>
      <Parameter ControlCard="SHIFT THU 3 0800 1 1600 2 2400"/>
      <Parameter ControlCard="SHIFT FRI 3 0800 1 1600 2 2400"/>
      <Parameter ControlCard="SHIFT SAT 3 0800 1 1600 2 2400"/>
    </Parameters>
  </Step>

  <Step id="Process Bill"
      programName="CIMSBill">
    <Parameters>
      <Parameter FullMessageFormat="true"/>
      <Parameter MessageFile="BillMsg.log"/>
      <Parameter trace="false"/>
      <Parameter ControlCard="USE SHIFT CODES"/>
    </Parameters>
  </Step>

  <Step id="Load Detail"
      programName="CIMSLoad">
    <Parameters>
      <Parameter LoadType="ALL"/>
      <Parameter BulkLoad="True"/>
      <Parameter detailFile="BillDetail.txt"/>
      <Parameter identFile="Ident.txt"/>
      <Parameter summaryFile="BillSummary.txt"/>
      <Parameter trace="true"/>
    </Parameters>
  </Step>
</CIMSProcessing>
```
Normalizing CPU Values

Computers within an organization have different processing speeds. This speed difference might cause users to request that their work be run on the faster machine to reduce costs. This situation could lead to heavy workloads on the faster computers while the slower units stand idle. To avoid this problem, you can normalize the processing speeds to more evenly charge for CPU utilization. That is, you can assign a percentage of the original CPU time used by a system rather than the actual time to be used during the billing process.

For example, your organization has two z/OS systems, AL90 and AL95. System AL95 is 20 percent faster than AL90. If you use AL95 as the base system, use a factor of .80 to normalize AL90 to reflect the speed of AL95.

**Note** • Due to the disparity between the way different operating systems capture performance statistics, it is not desirable to normalize the processor times between platforms (e.g., z/OS to UNIX or UNIX to Windows).

To perform normalization, you need to do the following:

- In the control file that contains the CIMSBill parameters (see page 8-16), include the NORMALIZE CPU VALUES control statement parameter.

- In ITUAM Administrator, do the following:
  - Select the CPU Value option for the rate code or codes for which you want to perform normalization.
  - Set the normalization factor for the applicable system or systems.

**To set the rate code as a CPU value:**

1. In the ITUAM Administrator main window, click Chargeback Administration ‣ Chargeback Table Maintenance ‣ Rate Codes.

2. In the Rate Code Maintenance List dialog box, click the rate code that you want to set as a CPU value, (for example, Mainframe CPU Minutes [Z003]), and then click Edit.

3. Select CPU Value check box, and then click OK.

**Note** • If this item is not checked, the rate code value will not be normalized during CIMSBill processing.
To set the normalization factor by system:

1. In the ITUAM Administrator main window, click Chargeback Administration ▶ Processing ▶ CPU Normalization.

2. Click Add in the CPU Normalization Maintenance List dialog box.

3. Enter the following:
   - **System ID**. The name of the system. For z/OS, this is the four-character System Model ID, for UNIX and Windows, it is the computer name. Note that the input file must contain an identifier named `System_ID` to identify the system name for CIMSBill.
   - **Work ID**. The subsystem name. This is any other system value that can narrow the normalization (i.e., the CICS region name, the DB2 plan name, the Oracle instance, etc.). Note that the input file must contain an identifier named `Work_ID` to identify the subsystem name for CIMSBill.
   - **Factor**. This is the actual normalization factor. In the example at the beginning of this section, this would be .80.

4. Click OK.

An example of a configured CPU Normalization List Maintenance dialog box is shown in Figure 8-2.

![CPU Normalization List Maintenance Dialog Box](image)

Figure 8-2 • CPU Normalization List Maintenance Dialog Box

To edit or remove a factor, click the factor, and then click Edit or Remove. Note that you cannot change the System or Work ID when you edit the factor.
Include/Exclude Processing

By default, CIMSBill processes all records within the input CIMSAcct Output CSR+ file. However, you might want to process only certain records or you might want to exclude certain records. This is useful if there is data that your organization does not want to report on.

You can exclude records by date using the DATE SELECTION control statement parameter for CIMSAcct or CIMSBill.

You can also include or exclude records by identifier values in the records. For example, you might want to exclude all records that contain a particular Jobname identifier value.

To include or exclude records by identifier values, you need to include the CIMSBill control statement parameters INCLUDE or EXCLUDE in the control file.

Example

Assume that you have a CIMSAcct Output CSR+ from a DB2 system with the following identifiers:

...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALI09999,Jobname,BKMALI01,Start_date,20060714...
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALI09999,Jobname,BKMALI02,Start_date,20060715...
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALI09999,Jobname,BKMALI03,Start_date,20060716...
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALI09999,Jobname,DFMALE01,Start_date,20060714...
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALI09999,Jobname,DFMALE02,Start_date,20060715...
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALI09999,Jobname,DFMALE03,Start_date,20060716...
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALI09999,Jobname,LCMALU01,Start_date,20060715...
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALI09999,Jobname,LCMALU02,Start_date,20060715...
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALI09999,Jobname,LCMALU03,Start_date,20060716...
...System_ID,ALIJ,Work_ID,JES2,Account_Code,ALI09999,Jobname,LCMALU04,Start_date,20060716...

You want to exclude those records that contain DFM in the Jobname identifier value, you need to include the following control statement parameter in the control file:

<Parameter ControlCard="EXCLUDE,S390DB2,JOBNAME,1,3,DFM,DFM"/>

The syntax for this control statement is as follows:

- Record header (in this example, S390DB2)
- Identifier value (in this example, JOBNAME)
- Offset (in this example, 1)
- Length (in this example, 3)
- Low identifier value (in this example, DFM)
- High identifier value (in this example, DFM)

Note • For CSR+ files, use the second record header in the file. The first header is used for sorting.

Note • The high identifier is required even if it is the same as the low identifier.
Processing Data: Setting Up the Data Processing Scripts

The $ITUAM_HOME/scripts directory contains the scripts described in the following sections. The scripts are ordered by their position in the processing cycle.

Nightly Script (nightly.sh)

The ITUAM Data Collectors for UNIX and Linux installation includes the sample_nightly.sh script. When you install ITUAM Data Collectors for UNIX and Linux, the sample_nightly.sh script is copied to create the nightly.sh script. Each time that you re-install ITUAM Data Collectors for UNIX and Linux or upgrade to a new release, the application searches for the nightly.sh script and recreates the script if it does not exist.

You need to set variable values in the nightly.sh script. If a new release of ITUAM Data Collectors for UNIX and Linux contains changes to the sample_nightly.sh script, you can incorporate those changes into the nightly.sh script that you have modified rather than replacing the script. If you replace the script, any existing variable values that you have set are overwritten.

The nightly.sh script performs the following tasks:

- Calls the nightly.pl Perl script to begin processing.
- Calls the mailx utility to send e-mail notification of successful, successful with warning, or failed processing.

The nightly.sh script must be scheduled to run on a regular basis. You can use any batch scheduler to run this script. It is recommended that you run the script using the ITUAM user account designated during the installation of ITUAM Data Collectors for UNIX and Linux.

Example

To schedule the nightly.sh script to run every morning at 4:15, the following crontab entry could be used:

```
15 4 * * * /usr/cims/scripts/nightly.sh
```

Defining Variables in the nightly.sh Script

You need to define the following variables in the nightly.sh script:

- `MAIL_UTIL`: The name of the mail utility used to send mail messages on this computer. Usually mail or mailx.

- `MAIL_LIST`: A comma-separated list of e-mail recipients. For example, csanchez@xyzco.com,bhughes@xyzco.com,....
Using the LogDate Parameter

The nightly.sh script requires the LogDate parameter. This parameter is used to select the files that are processed by ITUAM Data Collectors for UNIX and Linux.

The following are valid values for the LogDate parameter.

- preday (previous day)
- rundate (current day)
- curday (current day and previous day)
- date in yyyyMMdd format

This parameter is entered in the command line when running the nightly.sh script.

For more information about the use of the LogDate parameter, refer to the IBM Tivoli Usage and Accounting Manager Data Collectors for UNIX and Linux User's Guide.
Nightly Job Script (nightly.pl)

Note • The nightly.pl script follows the same conventions as described for the nightly.sh script (see Nightly Script (nightly.sh) on page 8-47).

The nightly.pl script calls all jobs that you want to run. This script contains the Perl array @job_list, which defines the process definition jobs that will be executed. Jobs are called in the order that they appear in the list. You can add and remove jobs to and from this list.

The nightly.pl script requires the LogDate parameter, which is entered in the command line when running the nightly.sh script.

The nightly.pl script contains the stopOnProcessFailure parameter. If set to TRUE, the nightly process will stop if a failure is returned for a job. If set to FALSE, processing will continue to the next job defined in the @job_list array.

Processing Script (procCIMS.pl)

The procCIMS.pl script calls the CIMSAcct, CIMSBill, and CIMSLoad programs described in ITUAM Processing Engine Components on page 8-5.

The procCIMS.pl script also calls the CIMSSort subroutine that produces a sorted version of the CSR+ Output file created by CIMSAcct. This file is used as input into CIMSBill.

The procCIMS.pl script requires the parameters shown in the following table. These parameters are passed from the job script.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProcessName</td>
<td>The process definition directory that contains the XML control file for CIMSAcct, CIMSBill, and CIMSLoad.</td>
</tr>
<tr>
<td>XML.JobFile</td>
<td>The control file for CIMSAcct, CIMSBill, and CIMSLoad. The default file name is ProcCnt1.xml. This file contains the parameters used by the processing programs.</td>
</tr>
</tbody>
</table>

Table 8-10 • procCIMS Script Parameters
Processing Data on UNIX or Linux

Processing Data: Setting Up the Data Processing Scripts
# Working With ITUAM Financial Modeler

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About ITUAM Financial Modeler</td>
<td>9-2</td>
</tr>
<tr>
<td>Installing ITUAM Financial Modeler</td>
<td>9-2</td>
</tr>
<tr>
<td>Starting ITUAM Financial Modeler</td>
<td>9-3</td>
</tr>
<tr>
<td>Logging On to ITUAM Financial Modeler</td>
<td>9-3</td>
</tr>
<tr>
<td>Getting Started—Open or Create a Cost Model</td>
<td>9-3</td>
</tr>
<tr>
<td>Opening an Existing Cost Model</td>
<td>9-3</td>
</tr>
<tr>
<td>Creating a New Cost Model</td>
<td>9-4</td>
</tr>
<tr>
<td>Setting Up Cost Models</td>
<td>9-5</td>
</tr>
<tr>
<td>Creating Budgets</td>
<td>9-5</td>
</tr>
<tr>
<td>Adding and Removing Cost Pools and Subpools</td>
<td>9-6</td>
</tr>
<tr>
<td>Distributing Budgeted Costs</td>
<td>9-7</td>
</tr>
<tr>
<td>Adding and Removing Rate Codes</td>
<td>9-8</td>
</tr>
<tr>
<td>Calculating Rates</td>
<td>9-9</td>
</tr>
<tr>
<td>Sharing the Cost Model</td>
<td>9-15</td>
</tr>
<tr>
<td>Managing Cost Models</td>
<td>9-16</td>
</tr>
<tr>
<td>Working With Reports</td>
<td>9-17</td>
</tr>
<tr>
<td>Running Reports</td>
<td>9-17</td>
</tr>
<tr>
<td>Saving, Printing, and Editing Reports</td>
<td>9-21</td>
</tr>
</tbody>
</table>
About ITUAM Financial Modeler

ITUAM Financial Modeler is a Web-based program that enables ITUAM administrators to easily perform IT finance-related tasks, including the following:

- Determine usage-based cost allocation for resources.
- Calculate and set rates for resource usage (including updating rates in the CIMSRate table).
- Perform cost analysis.

ITUAM Financial Modeler presents data in a familiar spreadsheet format in which data is presented in cost models containing cost pools and subpools. A cost pool represents the overall category of costs while the subpool specifies specific cost drivers. For example, the cost pool Software may contain the subpools Mainframe, UNIX, and Windows, which contain software-related resource usage costs by computer platform.

ITUAM Financial Modeler requires an ITUAM user ID to access the application. The ID must belong to a user group that has ITUAM Financial Modeler access enabled (see Defining User Groups on page 4-32).

When ITUAM Financial Modeler is installed on the Web server, a virtual directory named FinancialModeler is automatically created on the IIS Default Web Site. (The IIS Default Web Site is used for ITUAM Web Reporting.)

Installing ITUAM Financial Modeler

ITUAM Financial Modeler is included in the ITUAM installation.

You can also install ITUAM Financial Modeler independently of the ITUAM installation. For example, you want to install the application with an earlier release of ITUAM.

You can find the ITUAM Financial Modeler executable CIMSFinancialModelerSetup.msi in the ...IBM\ITUAM\Redist\CIMSFinancialModeler folder.
Starting ITUAM Financial Modeler

You can start ITUAM Financial Modeler in either of the following ways:

- From the Web browser, type \http://servername/FinancialModeler, where servername is the Web server name.

- From ITUAM Web Reporting, click Admin ➤ Financial Modeler. Note that the Financial Modeler link is displayed only if the ITUAM user ID that is used to log on to Web Reporting belongs to a user group that has ITUAM Financial Modeler access enabled.

Logging On to ITUAM Financial Modeler

If auto logon is enabled for the ITUAM user ID that you are using to access ITUAM Financial Modeler, you do not have to manually log on to the application. (To set the auto logon feature, see Web Settings on page 4-47.)

If auto logon is not enabled for the ITUAM user ID, the Login dialog box is displayed. Type the user ID and password, and then click Login.

User Authentication for the ITUAM Financial Modeler Web Site

If you want to use the auto logon feature with ITUAM Financial Modeler, Windows authenticated access must be set for the FinancialModeler virtual directory. For more information about IIS authentication, see Set the User Authentication Method for the Web Sites on page 2-94.

Getting Started—Open or Create a Cost Model

When you log on to ITUAM Financial Modeler, the Open Model dialog box is displayed. You can either open an existing cost model from this dialog box or close the dialog box (click Cancel) and create a new model.

The Open Model dialog box initially contains a cost model named ITUAM Standard Model. You can use this cost model as a reference or you can edit the cost model for your organization.

Opening an Existing Cost Model

To open an existing model, click the model in the Open Model dialog box and then click OK.
Creating a New Cost Model

To create a new model:

1. On the toolbar, click **New**. The Cost Model Wizard is displayed.
2. Type the model name (e.g., Storage) and then click **Next**.
3. On the Add Cost Pool page, type a name for the first cost pool that you want to create, and then click **Next**.
4. On the Add Subpool page, create one or more subpools for the cost pool. Type each subpool name in the **Name** box and then click **Add**. For example, if the cost pool is Storage, you might add the subpools Windows, UNIX, and Mainframe. When you are finished, click **Next**.

   To remove a subpool, click the entry from the **Subpools** list, and then click **Remove**.
5. On the Add Another Cost Pool page, click **Yes** or **No** and then click **Next**.

   If you click **Yes**, the Add Cost Pool and Add Subpool pages are displayed again. If you click **No**, the Add Rate Codes to Model page is displayed.

   **Note** • You can add or remove cost pools and subpools at any time after completing the wizard as described in *Adding and Removing Cost Pools and Subpools* on page 9-6.

6. On the Add Rate Codes page, select the rate codes that you want to be displayed in the cost model and move them to the Selected Rate Codes box.

   • If you want all move all rate codes to the Selected Rate Codes box, click the >> button.

   • If you want to move selected rate codes, click the codes that you want and then click the > button.

   You can move rate codes from one box to the other using the arrow buttons.

   **Note** • You can add or remove cost rate codes at any time after completing the wizard as described in *Adding and Removing Rate Codes* on page 9-8.

7. When you are finished, click **Finish**.

8. Click **Save** to save the cost model. The data in the model is saved in an XML file in the `...\IBM\ITUAM\Server\Web\FinancialModeler\data` folder. The file names assigned to the XML files do not include the cost model name. However, you can determine the applicable cost model if needed by looking at the `name` attribute in the XML.

ITUAM Financial Modeler opens with the **Budget Values** tab displayed. This tab shows the cost pools and subpools that you created in the Cost Model Wizard. Use this tab to create budgets for each subpool as described in *Creating Budgets* on page 9-5 and to add or remove cost pools and subpools as needed.
Setting Up Cost Models

Follow the steps in the following sections to set up cost models.

Creating Budgets

You must create a budget for each subpool in a cost pool. A budget is the projected cost for the resources represented by the subpool over a specific period of time.

To create budgets:

1. Click the Budget Values tab if it is not already selected.
2. Use Period Type select box to specify the type of budget that you want to create (daily, weekly, monthly, or yearly) and then use the Number of Periods box to specify the number of periods that you want to apply to the period type.

Example: If you want to create a six-month budget, click Months in the Period Type box and then enter 6 in the Number of Periods box.

3. In the Enter Total Budget Amounts cell for each subpool, type the total budget amount for that subpool. This amount is divided by the number of periods that you entered in the Number of Periods box. The resulting charges are displayed in the Budget Per <Day/Week/Month/Year> cell.

Note: Throughout ITUAM Financial Modeler, cells that you can type in are yellow.

Example Figure 9-1 presents six month budgets for storage and software resource usage. In this example, the cost pools Storage and Software have been created and each cost pool contains the subpools Windows, UNIX, and Mainframe.

![Figure 9-1: Setting Up Budgets](image)

The numbers in the Budget Per <Period> cells are the quotients of the total budget amount for the subpool ÷ by the value entered in the Number of Periods box.

Use the Period Type and Number of Periods boxes to define the type and length of the budget.

"Working With ITUAM Financial Modeler"
Adding and Removing Cost Pools and Subpools

The Budget Values tab also enables you to add or remove subpools from a cost model. When this tab is open, the Add Pool/Subpool and Remove Pool/Subpool buttons are active or inactive on the toolbar depending on the cells that you have selected on the Budget Values tab.

Note • You can also use the commands in the Action menu to add and remove Cost Pools and Subpools.

To add a cost pool:

1. Click any cost pool or subpool on the Budget Values tab and then click Add Pool.

2. In the Add Cost Pool dialog box, type the pool name, and then click Next.

3. In the Add Subpool dialog box, create subpools for the cost pool, and then click Finish.

The new cost pool and subpools are displayed on the Budget Values, Percent Allocation, and Cost Calculations tabs.

To add a subpool:

1. Click the cost pool that you want to add the subpool to, and then click Add Subpool.

2. In the Add Subpool dialog box, do the following:
   a. Confirm that the cost pool that you want to create the subpool for is selected in the Cost Pool box.
   b. Type the subpool name in the Subpool Name box.

3. Click OK when you are finished.

The new subpool is displayed under the applicable cost pool.

To remove a cost pool:

1. Click the pool that you want to remove, and then click Del Pool.

To remove a subpool:

1. Click the subpool that you want to remove, and then click Del Subpool.
Distributing Budgeted Costs

The Percent Allocation tab enables you to distribute the budgeted amount for each subpool by rate code. For each rate code within a subpool, enter the percentage of the budget that you want to apply to that rate code as shown in example Figure 9-2. (Note that the broken-line boxes in this example are for illustration purposes only and do not appear in the application.)

Figure 9-2 • Allocating Budgets

To view the actual cost allocations for the budgeted amounts, click the Cost Calculations tab.
Adding and Removing Rate Codes

The **Percent Allocation** tab also enables you to add or remove rate codes to and from a cost model. When this tab is open, the **Add Rate** and **Remove Rate** buttons are active or inactive on the toolbar depending on the cells that you have selected on the **Percent Allocation** tab.

**Note** • You can also use the commands in the Action menu to add and remove rate codes.

To add a rate code:

1. Click any cell on the **Percent Allocation** tab, and then click **Add Rate** on the toolbar.

   ![Image](image.png)

2. In the **Add Rate Code** dialog box, click the rate code or codes that you want to add, and then click **OK**.

   The new rate code or codes are added to the top of the displayed rate codes.

To remove a rate code:

- Click the rate code or rate codes that you want to remove, and then click **Del Rate**.
Calculating Rates

The Rate Calculations tab enables you to determine the rates that you want to apply to the rate codes in the cost model. By default, a rate is calculated as a zero cost value for the budget that you entered for the period. You can use this zero cost value or enter any rate value. After you have set the rate values that you want to use, you can use ITUAM Financial Modeler to automatically update the rate values in the CIMSRate table.

The following describes the options and columns on the Rate Calculations tab:

- **Exclude Accounts.** If you do not want resource units for a specific account or accounts to be included in the rate calculations, click the + sign in the Exclude Accounts box. Click the account or accounts that you want to exclude, and then click OK.

  To remove accounts from the list of excluded accounts, click the accounts and then click the - sign.

- **Start Date and End Date.** Use these boxes to select a date range for calculating the actual number of resource units consumed during that range.

  Once you have entered the data range, click Calculate Rates.

- **Resource Name.** The resources that you want to calculate rates for as specified on the Percent Allocation tab.

- **Budget Per <Day/Week/Month/Year>.** The budgeted amount for each resource for the day, week, month, or year.

- **Total Units.** The actual number of resource units consumed for each resource for the date range selected in the Start Date and End Date boxes.

- **Units Per <Day/Week/Month/Year>.** This column presents the units adjusted to match the budget period type. The values in this column are calculated based on the total units, the number of days selected in the Start Date and End Date boxes, and the period type as follows:

  **Period Type Days**

  If the period type is days, the Units Per Day value is calculated by dividing the value in the Total Units column by the number of days specified in the start and end dates.

  \[
  \text{Units Per Day} = \frac{\text{Total Units}}{\text{Number of Days}}
  \]

  **Example:** Total Units = 700, Date Range = 61 days, Units Per Day is 11.47541 (700÷61 rounded to 5 decimal places)
Working With ITUAM Financial Modeler

Setting Up Cost Models

Period Type Weeks

If the period type is weeks, the Units Per Week value is calculated by dividing the value in the Total Units column by the quotient of the number of days specified in the Start Date and End Date boxes divided 7.

\[
\text{Units Per Week} = \frac{\text{Total Units}}{\frac{\text{number of days in date range}}{7}}
\]

Example: Total Units=700, Date Range = 61 days, Units Per Week is 80.32783 (700÷[61÷7] rounded to 5 decimal places)

Per. Type Months and Per. Type Years

Depending on number of days in the date range, calculations for units per month and per year are more complex than calculating days and weeks. The following are some examples of how units per month and year are calculated.

Calculating Units Per Month Examples

- If the number of days specified in the Start Date and End Date boxes are equal to full months, the Units Per Month value is calculated by dividing the value in the Total Units box by the number of months in the date range.

\[
\text{Units Per Month} = \frac{\text{Total Units}}{\text{number of months in date range}}
\]

Example: Total Units=700, Date Range = August 1 through October 31, Units Per Month is 233.33333 (700 ÷ 3 months)

- If the number of days specified in the Start Date and End Date boxes are not equal to full months, the Units Per Month value is calculated by dividing the value in the Total Units column by a factor that is determined by:
  - Calculating the total number of days in the months that the date range falls in divided by the number of months that the date range falls in. Quotient = x.
  - Dividing the number of days in date range by the quotient x to get the factor.

Example: Total Units=700, Date Range = 45 days (September 1 through October 15), Units Per Month is 474.44444...

61 days ÷ 2 months = 30.5
45 days in date range ÷ 30.5 = 1.475409...
700 ÷ 1.4754098... = 474.44444...
Calculating Units Per Year Examples

- If the number of days specified in the Start Date and End Date boxes are equal to full years, the Units Per Year value is calculated by dividing the value in the Total Units box by the number of years in the date range.

\[
\text{Units Per Year} = \frac{\text{Total Units}}{\text{number of years in date range}}
\]

**Example:** Total Units=700, Date Range = January 1, 2005 through December 31, 2006, Units Per Year is 350 (700 ÷ 2 years)

- If the number of days specified in the Start Date and End Date boxes are equal to full months, the Units Per Year value is calculated by multiplying the value in the Total Units column by the applicable number to equal 12 months. That is:

  If the date range is 1 month, multiply by 12
  ...2 months, multiply by 6
  ...3 month, multiply by 4
  etc.

**Example:** Total Units=700, Date Range = March 31 through April 30, 2006 (two months), Units Per Year is 4200 (700 x 6)

- If the number of days specified in the Start Date and End Date boxes are not equal to full years or full months, the Units Per Year value is calculated by dividing the value in the Total Units box by a factor that is determined by:
  
  - Calculating the total number of days in the months that the date range falls in divided by the number of months that the date range falls in. Quotient = x.
  
  - Dividing the number of days in date range by the quotient x to get a factor and then dividing that factor by 12.

**Example:** Total Units=700, Date Range = 45 days (September 1 through October 15), Units Per Year is 5693.33333...

\[
\text{Units Per Year} = \frac{\text{Total Units}}{\text{factor}}
\]

\[
\text{factor} = \frac{\text{number of days in date range}}{\text{quotient}}
\]

\[
\text{quotient} = \frac{\text{total number of days in the months the date range falls in}}{\text{number of months the date range falls in}}
\]

\[
\text{Units Per Year} = \frac{700}{\frac{45}{30.5} ÷ 12} = 5693.33333...
\]

- **Current Rate.** The current rate for each resource as set in the CIMSRate table.
Per 1000. An M in this column indicates that the rate for this resource is per thousand units. The zero cost rate is calculated as follows:

\[
\text{budget amount} \div \text{units per period} \div 1000
\]

For example, if the budgeted amount is 10,000 and the units per period amount is 5,000, the zero cost rate is .002 (10,000 ÷ 5,000 = 2 and 2 ÷ 1,000 = .002)

- **Zero Cost Rate.** The zero cost rate for each resource (i.e., budgeted amount ÷ units per period = zero cost rate).
- **Factor.** A factor that you want to multiply the zero cost rate by to determine the new rate for each resource. The default is one.
- **New Rate.** By default, the new rate for each resource is the zero cost rate. However, you can enter any rate. The factor adjusts accordingly.

- **Calculate Rates.** Click this button to refresh the values on the Rate Calculations tab.
- **Update Rates.** Click this button to update the CIMSRate table with the rates in the New Rate column.

Once you have updated the rates, the Update Rates button becomes the Rollback Rates button. Use the Rollback Rates button in the following situations:

- You want to revert to the rates as they were when you opened the cost model.
- You have changed something in the cost model and want to update the rates again.

**Important!** If you want to roll back rates, make sure you click Rollback Rates before you close the cost model. When you update rates and then close the cost model, the initial rates are deleted.
Example 1—Monthly Rate Calculation

Assume that you created a budget for a six-month period as shown in Figure 9-1 on page 9-5. You want to determine the rates for this budget based on the actual resource units consumed during a two-month period (September–October). In this scenario you would set the start and end date as follows:

![Image of budget values](image-url)

Figure 9-3 shows example data based on this date range. Because the budget period type is months and the days in the date range are equal to two full months, the units per month are calculated by dividing the total units by two.

![Image of budget calculation](image-url)

M specifies the rate is per thousand. Zero cost rate is calculated as:

\[
\text{Budget amount} \div \text{units per period} \div 1000
\]

Figure 9-3 • Example 1—Monthly Rate Calculation
Example 2—Excluding an Account Code

Assume that you are using the same scenario as shown in Example 1—Monthly Rate Calculation on page 9-13, but you want to exclude resources for account code ATM from the calculations. In this case, you would add the account code ATM to the Exclude Accounts List, and then click Calculate Rates.

If you compare the following figure to Figure 9-3 on page 9-13, you see the data has changed due to the excluded account code.

![Figure 9-4  Example 2—Excluding an Account Code](image-url)
Example 3—Changing the Factor

Continuing with the previous examples, assume that you change the factor from 1 to 2 for all resources. The new rate values automatically recalculate as shown in Figure 9-5.

```
<table>
<thead>
<tr>
<th>Resource Name</th>
<th>Budget Per Month</th>
<th>Total Units</th>
<th>Units Per Month</th>
<th>Current Rate</th>
<th>Per 1000</th>
<th>Zero Cost Rate</th>
<th>Factor</th>
<th>New Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBKU26 - MS Windows File Server...</td>
<td>18,683</td>
<td>3,8544</td>
<td>2,096</td>
<td>0,0320</td>
<td>0,03286</td>
<td>2.0</td>
<td>0,0360</td>
<td></td>
</tr>
<tr>
<td>DBKU26 - MS Windows File in Folder</td>
<td>130,000</td>
<td>2273293</td>
<td>4,0000</td>
<td>0,0198</td>
<td>0,02056</td>
<td>2.0</td>
<td>0,0235</td>
<td></td>
</tr>
<tr>
<td>LXL105 - Unix Filesystem Used (GB)</td>
<td>29,187</td>
<td>133199497</td>
<td>0,0000</td>
<td>0,0010</td>
<td>0,00187</td>
<td>2.0</td>
<td>0,0074</td>
<td></td>
</tr>
<tr>
<td>LXL104 - Unix Filesystem Size (GB)</td>
<td>29,187</td>
<td>222105296</td>
<td>0,0000</td>
<td>0,0010</td>
<td>0,00286</td>
<td>2.0</td>
<td>0,0082</td>
<td></td>
</tr>
<tr>
<td>LXL103 - Unix Filesystem Number</td>
<td>25,000</td>
<td>25100000</td>
<td>0,0000</td>
<td>0,0010</td>
<td>0,0019</td>
<td>2.0</td>
<td>0,0091</td>
<td></td>
</tr>
<tr>
<td>ZD9DF01 - Secondary Stripe Alloc...</td>
<td>50,000</td>
<td>1450294, 3737</td>
<td>0,0000</td>
<td>0,0100</td>
<td>0,0108</td>
<td>2.0</td>
<td>0,0197</td>
<td></td>
</tr>
<tr>
<td>ZD9DF01 - Unix Filesystem Used (GB)</td>
<td>52,250</td>
<td>133199497</td>
<td>1,3000</td>
<td>0,0130</td>
<td>0,01619</td>
<td>2.0</td>
<td>0,0098</td>
<td></td>
</tr>
<tr>
<td>ZD9DF01 - Unix Filesystem Number</td>
<td>43,780</td>
<td>16479435</td>
<td>7,5200</td>
<td>0,0330</td>
<td>0,03731</td>
<td>2.0</td>
<td>0,0182</td>
<td></td>
</tr>
<tr>
<td>EBF9F9R - MS Exchange Bytes Sent</td>
<td>65,200</td>
<td>6758493737</td>
<td>0,0000</td>
<td>0,0010</td>
<td>0,0016</td>
<td>2.0</td>
<td>0,0070</td>
<td></td>
</tr>
<tr>
<td>EBF9F9R - MS Exchange Bytes Received</td>
<td>20,803</td>
<td>6758493737</td>
<td>0,0000</td>
<td>0,0010</td>
<td>0,00362</td>
<td>2.0</td>
<td>0,0125</td>
<td></td>
</tr>
<tr>
<td>LGL005 - Unix Process CPU (%...</td>
<td>10,780</td>
<td>156091</td>
<td>54000</td>
<td>0,0000</td>
<td>0,00396</td>
<td>2.0</td>
<td>0,01799</td>
<td></td>
</tr>
<tr>
<td>LGL004 - Unix Process User CPU (%...</td>
<td>10,437</td>
<td>255219</td>
<td>50000</td>
<td>0,0000</td>
<td>0,00396</td>
<td>2.0</td>
<td>0,01632</td>
<td></td>
</tr>
<tr>
<td>LGL004 - Unix Process System CPU (%...</td>
<td>12,500</td>
<td>1131424</td>
<td>0,0000</td>
<td>0,0010</td>
<td>0,02210</td>
<td>2.0</td>
<td>0,01419</td>
<td></td>
</tr>
<tr>
<td>Z232 - OEC Transactions (Record)</td>
<td>9,187</td>
<td>2623777</td>
<td>0,0000</td>
<td>0,0010</td>
<td>0,00699</td>
<td>2.0</td>
<td>0,01397</td>
<td></td>
</tr>
<tr>
<td>Z232 - OEC Transactions (Record)</td>
<td>7,530</td>
<td>1177041</td>
<td>26550</td>
<td>0,0010</td>
<td>0,01270</td>
<td>2.0</td>
<td>0,02564</td>
<td></td>
</tr>
</tbody>
</table>
```

Figure 9-5 • Example 3—Changing the Factor

Sharing the Cost Model

By default, the a cost model can be opened only by the ITUAM user that created the model. To enable other ITUAM users to open and modify a model, click Shared on the toolbar or click Action ▶ Share Model on the menu bar.

Note • If you share a cost model, other users can delete the model.
Managing Cost Models

To create a cost model:
Click the New on the toolbar or File ▶ New on the menu bar and follow the instructions provided in Creating a New Cost Model on page 9-4.

To save a cost model:
Click the Save button on the toolbar or File ▶ Save on the menu bar.

To open a cost model:
Click the Open button on the toolbar or File ▶ Open on the menu bar.

To rename a cost model:
Click File ▶ Rename on the menu bar.

To delete a cost model:
Click File ▶ Delete on the menu bar.

To close a cost model:
Click the Close button or click Logout on the toolbar.
Working With Reports

You can run reports that reflect the data presented in ITUAM Financial Modeler. At this time, only the Cost Comparison Report is available with ITUAM Financial Modeler.

The Cost Comparison Report enables you to view the current and adjusted rates by account code or resource.

Note • The reports included with ITUAM Financial Modeler are separate from those used by the ITUAM Web Reporting application. ITUAM Financial Modeler reports do not require the administration steps required for ITUAM Web Reporting reports.

Running Reports

To run a report:

1. On the Rate Calculations tab, click Run Report.

2. In the report parameters dialog box, enter the following parameters:
   - Order Output By. Click Account or Resource. If you click Account, the data in the report is displayed by account code. If you click Resource, the data in the report is displayed by resource.
   - Account Code Level. The account code level that you want to view in the report. The resource use and charge data will reflect the level that you select. For more information about account codes, see Setting Up the Account Code Structure on page 4-3.
   - Date Range. The range for the data that you want to be displayed in the report. Click This Month, Last Month, Current Year, Previous Year, or Custom.
   - From and To. Enter the beginning and end date if you selected Custom in the Date Range box.

3. Click OK to run the report.

The report opens in Microsoft Excel in a separate Web browser window.
Report Examples

The following are examples of the Cost Comparison Report by account code and resource. With the exception of the output type, the parameters are the same for both report types.

Cost Comparison Report by Account Code

In this example, the parameters are set as follows:

![Cost Comparison Report](image)

The resulting report is displayed as shown in Figure 9-6.

![Example Cost Comparison Report by Account Code](image)

Figure 9-6 • Example Cost Comparison Report by Account Code

Note that the resource units and rates are accumulated for all of the resources for the account code. To view units and rates by resource for an account code, click the + sign next to the account code to drill down. In this example, account code BB is expanded as shown in Figure 9-7 on page 9-19.
Figure 9-7  •  Example Cost Comparison Report by Account Code Drill Down

Note that not all of the individual resources for account code BB are shown in the example figure.
Cost Comparison Report by Resource

In this example, the parameters are set as follows:

![Cost Comparison Report](image)

The resulting report is displayed as shown in Figure 9-8.

![Example Cost Comparison Report by Resource](image)

Figure 9-8 • Example Cost Comparison Report by Resource

Note that the resource units and rates are accumulated for all of the account codes for the resource. To view units and rates by account code for a resource, click the + sign next to the resource to drill down. In this example, resource rate code IPRT is expanded as shown in Figure 9-9 on page 9-21.
Working With ITUAM Financial Modeler

Working With Reports

Figure 9-9 • Example Cost Comparison Report by Account Code Drill Down

Note that in this example, account codes FF and GG (which were shown in the previous report by account code example) did not consume resources for rate code 1PRT and are not included in the report.

Saving, Printing, and Editing Reports

Because reports open in Excel within the browser, you can save, print, and edit the reports using Excel commands. To view the Excel Standard toolbar in the browser, click View ▶ Toolbars ▶ Standard.
Working With ITUAM Web Console

About ITUAM Web Console .................................................................10-2
Setting Up and Starting ITUAM Web Console ....................................10-2
Configuring IIS for Apache Tomcat ....................................................10-2
Starting ITUAM Web Console ............................................................10-3
Logging On to ITUAM Web Console ..................................................10-4
Viewing Job Logs ..............................................................................10-4
About ITUAM Web Console

ITUAM Web Console is a Web-based application that provides a interface for viewing job logs.

ITUAM Web Console requires an ITUAM user ID to access the application. The ID must belong to a user group that has ITUAM Web Console access enabled (see Defining User Groups on page 4-32).

Setting Up and Starting ITUAM Web Console

Configuring IIS for Apache Tomcat

ITUAM Web Console uses Apache Tomcat, a servlet container for Java Servlet and JavaServer Pages (JSP) technologies. To configure IIS for use with Tomcat, you must perform the following steps depending on the Microsoft Windows version that you are using.

For Microsoft Windows 2000 Server:

1. In IIS Manager, navigate to the Default Web Site.
2. Right-click Default Web Site, and then click Properties.
3. In the Properties dialog box, click the ISAPI Filters tab.
4. On the ISAPI Filters tab, click Add.
5. In the Filter Properties dialog box, type the filter name jakarta, and then click Browse.

Note • Make sure that you type jakarta in lowercase as shown.

6. Browse to the folder ...IBM\ITUAM\Server\Web\Tomcat\bin\win32, click isapi_redirector.dll, and then click Open.

The path to the DLL is displayed in the Executable box in the Filter Properties dialog box.

7. Click OK until the Filter Properties and Properties dialog boxes close.
8. Restart IIS (see page 11-5).

For Microsoft Windows Server 2003:

1. Complete the steps to set the ISAPI filter as described in For Microsoft Windows 2000 Server. (Do not restart IIS until you complete the following steps.)
2. In IIS Manager, navigate to Web Server Extensions and click it.
3. Click Add a new Web service extension.
4 In the New Web Service Extension dialog box, type the extension name jakarta, and then click Add.

**Note** • Make sure that you type jakarta in lowercase as shown.

5 In the Add file dialog box, click Browse.

6 Browse to the folder ...
IBM\ITUAM\Server\Web\Tomcat\bin\win32, click isapi_redirector.dll, and then click Open.

The path to the DLL is displayed in the Path to file box in the Add file dialog box.

7 Click OK to close the Add file dialog box.

8 In the New Web Service Extension dialog box, select Set extension status to Allowed, and then click OK.

The extension jakarta is displayed in the Web Service Extension list with a status of Allowed.

9 Restart IIS (see page 11-5).

### Starting ITUAM Web Console

**Note** • To start ITUAM Web Console, you must have job log files in XML format. To set the file format for job log files, refer to the *IBM Tivoli Usage and Accounting Manager Data Collectors for Microsoft Windows User’s Guide*.

You can start ITUAM Web Console in either of the following ways:

- From the Web browser, type http://servername/ITUAMAdmin/ where servername is the Web server name.

- From ITUAM Web Reporting, click Admin ▶ Web Console. Note that the Web Console link is displayed only if the ITUAM user ID that is used to log on to Web Reporting belongs to a user group that has ITUAM Web Console access enabled.
Logging On to ITUAM Web Console

By default, auto logon is enabled for the ITUAM Web Console. The auto logon feature for ITUAM Web Console is independent of auto logon for other ITUAM Web applications.

To enable manual log on, change require.login=false to require.login=true in the cims.properties file. If you installed ITUAM in the default location, this file is in C:\Program Files\IBM\ITUAM\Server\Web\Tomcat\webapps\ITUAMAdmin\WEB-INF\conf.

Viewing Job Logs

The job logs that are displayed in ITUAM Web Console are determined by the path that is specified in the location box and the date that is selected in the date box.

By default, the log path is ...\ITUAM\IBM\LogFiles. All XML log files that are contained in the subfolders within the LogFiles folder are included on the Job Runner Results page for the date selected. If your log files are in a location other than the default, you can change the path to the top-level folder that contains your log subfolders and files. To change the location, type the path and then click Change Location. If you want to reset to the default path, click Reset Default.

The log date is the date that the log was generated. The most recent log or logs are displayed by default. For more information about jobs and job logs, refer to the IBM Tivoli Usage and Accounting Manager Data Collectors for Microsoft Windows User’s Guide.

To view a job log, select the date for the log, and then click Refresh. Expand the job and drill down (see example Figure 10-1 on page 10-5) to quickly see whether a job, process, or step completed successfully ✅, completed with warnings ⚠️, or failed ❌.
Working With ITUAM Web Console

Viewing Job Logs

To view the contents of a log, expand the job. In this example, the job Nightly is selected.

In this example, the process CIMSWinDisk has completed successfully. The other processes, UnixFS and Universal, have failed and completed with a warning, respectively.

To view the step that caused the error or warning, expand the process.

The CIMSBill step in the Universal process produced a warning. To view the cause of the warning, click the link.

The warning occurred because the rate code Employee is not included in the CIMSRate table.

Figure 10-1  Job Log Example
Troubleshooting and Additional Information

This chapter describes problems you may encounter while setting up and using the ITUAM system and how to solve them.

**Installation Problems** ................................................................. 11-3
Unable to launch regasm.exe error is displayed ................................... 11-3

**Data Processing Problems** ......................................................... 11-3
General data processing problems ................................................... 11-3
When account codes are converted using CIMSAcct, some records seem to be lost .......... 11-3

**System Problems** ........................................................................ 11-4
A prompt for the Windows installation CD is displayed while you are using ITUAM Administrator ......................................................... 11-4
Performance of the ITUAM system is slow ......................................... 11-4
Computer "locks up", provides unexpected results, or seems to run very slowly .......... 11-4

**Web Reporting Problems** .............................................................. 11-5
Problems accessing the Web site or generating reports ........................ 11-5
An error message is displayed when ActiveX Data Objects (ADO) or ODBC is used to open a database connection in an ASP page ................................. 11-12

**Database Connection Problems** .................................................. 11-13
An error message is displayed when selecting an ITUAM Data Source (Oracle only) .... 11-13

**The ITUAM Web Reporting Session Is Lost** (Oracle only) ............. 11-13

**Crystal XI Problems** ................................................................. 11-14

**SQL Server Reporting Services Problems** ..................................... 11-15
Report Server cannot decrypt the symmetric key message is displayed ............... 11-15
The user account does not have adequate permissions message is displayed when you try to generate a report .................................................. 11-15
Troubleshooting and Additional Information

- Executing Stored Procedures to Debug ITUAM ................................. 11-16
- Creating a Test Database for Troubleshooting .................................. 11-17
  Option 1: Using the SaveDBSQLServer.wsf Script ............................. 11-17
  Option 2: Exporting Data From a Database ....................................... 11-18
- Loading Data Into a Test Database ................................................. 11-19
- Performing Disaster Recovery ....................................................... 11-21
- About ITUAM Data Sources for SQL Server Databases ...................... 11-22
- Installing Crystal Reports 9 ........................................................... 11-24
- Installing Crystal Reports 10 ......................................................... 11-25
Installation Problems

Unable to launch regasm.exe error is displayed

This problem occurs because the current user does not have the correct permissions for the following key in the Windows registry:

HKEY_CLASSES_ROOT\Component Categories\{62C8FE65-4EBB-45e7-B440-6E39B2CDBF29}\n
To resolve this problem, refer to the Microsoft Knowledge Base Article 327507.

Data Processing Problems

General data processing problems

You can use the following tools to diagnose general data processing problems:

- Check the Process Results tab for the process definition (Chargeback Administration ▶ Processing ▶ Process Definitions). This tab provides message and results files for both CIMSAcct and CIMSBILL. These files provide information about errors encountered during processing. Also, click Show All ITUAM Events on the Event Viewer subtab and check for unusual messages.

- When processing data using ITUAM Administrator, check the status bar in the lower left corner of the Edit Process Definition dialog box to note the point in the processing cycle that the error occurs.

- Check the Load Tracking dialog box (Chargeback Administration ▶ Database Loading ▶ Load Tracking) to see if any database loads have completed.

For SQL Server database problems:

- Enable the Simple recovery model for SQL Server (see Setting the Database Recovery Model on page 6-5) to decrease the size of the SQL Server log files.

- View the messages in the SQL Server log (Program Files ▶ Microsoft SQL Server ▶ MSSQL ▶ Log).

When account codes are converted using CIMSAcct, some records seem to be lost

Records that do not match any account code entries in the account code conversion table are written to CIMSAcct Detail file with the unconverted account code. If you want unmatched records to go to an exception file for reprocessing at a later time, you must enable exception processing in ITUAM Administrator (see Setting the Account Code Conversion Options on page 7-43 (for Windows) or Enabling Exception Processing on page 8-36 (for UNIX or Linux).
System Problems

A prompt for the Windows installation CD is displayed while you are using ITUAM Administrator

In most cases, Windows is calling for dependencies that are not essential for you to run the application properly. Click Cancel when these messages are displayed.

Visit the Microsoft Web site and download all updates for your version of Windows and Microsoft Office (if you use Office). These updates should include the necessary dependent files.

Performance of the ITUAM system is slow

This could be caused by a number of things, including excessive network usage, problems with the network, excessive ITUAM usage, etc.

It is also possible that the database you are using has become so large that it is difficult for the server housing the data to adequately store and access it. In this case, consider archiving certain data (see Loading, Archiving, and Purging the Database on page 6-17) or upgrading the machine. You can also off load non-essential or non-ITUAM-related processing to other machines.

Performance might also be affected by computer-related problems (see the following problem).

Computer “locks up”, provides unexpected results, or seems to run very slowly

There could be some type of memory problem. Close ITUAM Administrator and any other Windows applications. Reopen ITUAM Administrator as the only Windows application and see if the problem corrects itself. If that fails to correct it, close Windows and then restart it. Open ITUAM Administrator again and see if the same results occur.

The computer might not have enough memory to process. Try running the application on a computer with more memory (preferably 256 MB or more).
Web Reporting Problems

Problems accessing the Web site or generating reports

The following are problems that might occur as you are using the ITUAM Web Reporting Web site to generate reports. The problems are presented in the order are they are most likely to occur, beginning with accessing the Web site.

| Problem                                                        | Solution(s)                                                                                           |
|                                                               |                                                                                                         |
| User cannot access the Web site                              | Verify that the users have appropriate network permissions and are using Internet Explorer 5.5 or later on the Windows platform. Verify the following: |
|                                                               | - Your Internet or network connection is working properly.                                             |
|                                                               | - User has appropriate network permissions and are using Internet Explorer 5.5 or later.                |
|                                                               | - User entered the correct URL.                                                                         |
|                                                               | - User has the required security permissions for the ITUAM program folders as discussed in Assign Folder Security Permissions on the Web Server on page 2-96. |
| Web site is not opening properly or is having problems starting | If the following error is displayed, see page 8-10 for a possible solution:                           |
|                                                               | Microsoft OLE DB Provider for ODBC Drivers error '80004005' [Microsoft] ODBC Driver ] Data source name not found and no default driver specified. |
|                                                               | If this does not resolve the problem, try the following:                                               |
|                                                               | - Restart IIS.                                                                                         |
|                                                               | - Click Start ➔ Run. In the Open box, type iisreset /restart, and then click OK.                       |
|                                                               | - Check the security settings on the computer running the Web server (see Set the User Authentication Method for the Web Sites on page 2-94). |
|                                                               | - Install the latest service pack for Microsoft SQL Server.                                           |
**Troubleshooting and Additional Information**

*Web Reporting Problems*

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution(s)</th>
</tr>
</thead>
</table>
| If using multiple Web sites, Web sites other than the default Web site do not open. The following message is displayed: *Server Error in '/virtual directory name' Application* | In IIS Manager, navigate to the virtual directory for the Web site and do the following:  
1. Expand the virtual directory.  
2. Right-click the CIMSReporting folder, and then click **Properties**.  
3. Click the **Create** button next to the **Application name** box.  
4. Click **OK** when you are finished.  
Make sure that you copied the `...IBM\ITUAM\Server\Web` folder to create the folder for the Web site. You must recreate the Web site folder from the `Web` folder each time that you upgrade to a new ITUAM release. For more information, see *Using Multiple Databases for ITUAM Web Reporting* on page 6-8. |
| Auto logon feature is not working for a user. | Check the following:  
1. The **Enable Intranet Auto Logon** check box is selected on the Web tab of the Configuration dialog box (see *Web Settings* on page 4-47). This is the default setting.  
2. The correct domain name and user ID is entered for the user in the User Maintenance dialog box (see *Defining Users* on page 4-27).  
3. IIS is using Windows authenticated access rather than anonymous access (see *Set the User Authentication Method for the Web Sites* on page 2-94). The auto logon feature is not available if anonymous access is enabled for IIS. |
| Report parameters page does not open when a report is selected—a 405 error is displayed | Do the following:  
1. Make sure that ASP.NET is enabled as described in *Enabling ASP.NET (Windows 2003 Server Only)* on page 2-17.  
2. Apply any Microsoft critical updates with latest .NET service pack. |
### Web Reporting Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report parameters page opens, but report is not generated from the page—one of the following error occurs:</td>
<td>In ITUAM Administrator, click System Administration ➔ Database ➔ Database Object. In the Database Objects Manager dialog box, add any database objects that do not exist in the database (i.e., Exists = No). See Managing Database Objects on page 6-14. If this does not solve the problem, drop all stored procedures, indexes, triggers, and views in the Database Objects Manager dialog box and then create them again. <strong>Important!</strong> Do not drop the tables in the Database Objects Manager dialog box. Dropping a table removes the table and its data from the database. To view the detailed error message, run the report directly from Crystal Reports (not the Web).</td>
</tr>
<tr>
<td>■ A time-out message is displayed immediately or the following message is displayed:</td>
<td>-2147192179 An error has occurred on the server in attempting to access the data source</td>
</tr>
<tr>
<td>■ A 404 “page not found” error is displayed.</td>
<td></td>
</tr>
<tr>
<td>■ A 404 “page not found” error is displayed.</td>
<td></td>
</tr>
<tr>
<td>■ A 404 “page not found” error is displayed.</td>
<td></td>
</tr>
<tr>
<td>■ A 404 “page not found” error is displayed.</td>
<td></td>
</tr>
<tr>
<td>■ A 404 “page not found” error is displayed.</td>
<td></td>
</tr>
</tbody>
</table>

Check the following:

- Make sure that ASP.NET is enabled as described in the solution for a preceding problem, *Report parameters page does not open when a report is selected—a 405 error is displayed.*

- If you are using SQL Server Reporting Services, make sure that a fully qualified URL for the Report Server virtual directory is entered in the Configuration dialog box (Web tab ➔ Report Server URL box, see Web Settings on page 4-47).
<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>You are using Crystal Reports 10 and a clientdoc.dll failure occurs.</td>
<td>Do the following:</td>
</tr>
<tr>
<td></td>
<td>In Crystal License Manager, make sure that the Crystal licenses are entered for the Crystal Reports Advanced and Embedded editions.</td>
</tr>
<tr>
<td></td>
<td>Make sure that the Crystal Report Application Server service is running (Control Panel ➤ Administrative Tools ➤ Services).</td>
</tr>
</tbody>
</table>
You are using Crystal Reports XI and one of the following messages is displayed:

Failed to read data from report file C:\WINDOWS\TEMP\tmp.rpt.
Reason: Failed to open print engine for C:\WINDOWS\TEMP\tmpreport\<report>. Ensure that CRPE32 is installed on this computer.

This error message occurs on Windows 2003 computers running IIS 6.0 where the default application pool is running under the NETWORK SERVICE account. This account does not have sufficient rights to the fields and registry needed to create a copy of the report in the Crystal Reports enterprise system.

To resolve this problem, do the following:

1. In IIS Manager, expand the local computer and then expand the Application Pools folder.
2. Right-click DefaultAppPool, and then click Properties.
3. In the DefaultAppPool Properties dialog box, click the Identity tab.
4. Make sure that the Predefined radio button is selected, and then select the Local System account from the Predefined drop-down list.
5. Restart IIS.

Error adding report <report> to Enterprise-File Repository Server error : File system operation for C:\WINDOWS\TEMP\tmpreport\<report> on File Repository Server failed.

This error occurs when reports that are created on the ITUAM Web Reporting Web site using the report templates provided with ITUAM are run.

To correct the problem, navigate to the C:\WINDOWS\TEMP\tmpreport folder and grant the Windows user account that is used to run the ITUAM Web Reporting Web site a security permission of Full Control.
## Troubleshooting and Additional Information

### Web Reporting Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution(s)</th>
</tr>
</thead>
</table>
| Max processing time or Max records limit reached | This error occurs because the Crystal Reports Page Server and Report Application Server return a maximum of 20,000 records by default.  
To resolve this problem, see page 2-108.  
For more possible Crystal XI problems and solutions, see page 11-14. |
| You are using SQL Server Reporting Services and the following message is displayed:  
The User Account `<account name>` does not have adequate permissions in Reporting Services. Make sure the User Account belongs to the Reporting Services's `<role name>` Role | Make sure that the Windows user account that is accessing the Web site has been assigned to the Reporting Services role as described in Assign Windows User Accounts to the ITUAM Role on page 2-102.  
For more possible Reporting Services problems and solutions, see page 11-15. |
| Report is generated, but the following problems occur: |  
- General problems viewing the report. For example, headers and data are not displayed.  
Change the viewer used to view reports. For more information, see Defining Users on page 4-27 and Web Settings on page 4-47.  
**Note:** If you are using the Crystal Reports ActiveX viewer, you may not have administrative privileges to allow the viewer to be automatically downloaded and installed on the computer on which you are trying to run the report. Use the Crystal HTML or Java viewer instead. |  
- Old or sample data is displayed in the report.  
One or more old loads have not been removed from the database. Unload the old data. For more information, see Tracking the History of Database Loads on page 6-22. |
## Web Reporting Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot drill down in reports.</td>
<td>Certain items do not have any additional information available. If you place the cursor on an item and the cursor icon becomes a magnifying glass or a hand, you can drill down. If it does not, there is no detailed information available about the item.</td>
</tr>
</tbody>
</table>
| Cannot print report when using the HTML viewer with Crystal Reports. The following message is displayed:  

There was an error opening this document. This file cannot be found. | When prompted to open or save the file, click **Save** and then click **Open**. |
An error message is displayed when ActiveX Data Objects (ADO) or ODBC is used to open a database connection in an ASP page

When you use ActiveX Data Objects (ADO) or ODBC to open a database connection in an ASP page, you may receive the following error message:

Microsoft OLE DB Provider for ODBC Drivers error '80004005' [Microsoft] [ODBC Driver ] Data source name not found and no default driver specified.

Solution

Note • Make sure that you have completed the steps in Set the User Authentication Method for the Web Sites on page 2-94.

The Windows 2000/2003 user account that is used to process the request for the ASP page does not have sufficient permissions to read the registry key that stores the specified ODBC Driver's configuration information. The Driver parameter in a DSN-less connection string specifies the ODBC driver that is used to establish the database connection.

Grant the Windows 2000 user account Read access to the specified ODBC Driver registry key as follows:

1 Determine which account is used to process the request for the ASP page.
2 From the Start menu, click Run, type regedt32.exe, and then click OK to start Registry Editor.
3 In the HKEY_LOCAL_MACHINE window, browse to the HKLM\SOFTWARE\ODBC\ODBCINST.INI key. The ODBCINST.INI key contains a subkey for each ODBC Driver that is installed on the server.
4 Click the Driver registry key for the driver that is specified in the ADO connection string.
5 From the Security menu, click Permissions.
6 Add the user account that you identified in Step 1 to the list of users who can access this key, and select the Read check box for this user.
7 Click Apply, and then close Registry Editor.

This information was taken from the Microsoft Knowledge Base Article 306345.
Database Connection Problems

An error message is displayed when selecting an ITUAM Data Source (Oracle only)

The ITUAM Data Source for an Oracle database assigns an Oracle user to the schema for the ITUAM database.

A trigger (logon_schema) must also be created to assign the user to the schema.

If the schema defined in the trigger differs from the schema defined for the ITUAM Data Source, the following message is displayed when you select a data source in the Select ITUAM Data Source list.

Checking Oracle environment failed: The datasource schema name 'name' does not match the current schema 'name'

To correct the problem, change the schema defined in ITUAM Data Source (see page 2-73) or run the OracleLogonTrigger.bat script to change the schema in the trigger (see page C-14).

The ITUAM Web Reporting Session Is Lost (Oracle only)

By default, IIS worker processes recycle after 120 minutes. If an ASP application is not designed to store a session-state while a worker process is recycled, then the session-state in the application can be lost.

To correct this problem, you can either store the session-state in a database (contact your DBA for more information) or, in Windows Server 2003, you can disable worker process recycling as follows:

1. In IIS Manager, expand the local computer and then expand Application Pools folder.
2. Right-click DefaultAppPool, and then click Properties.
3. In the DefaultAppPool Properties dialog box, click the Recycling tab.
4. Clear the Recycle worker processes (in minutes) check box, and then click Apply.
5. Restart IIS.
Crystal XI Problems

The following are general troubleshooting steps for Crystal XI.

**Important!** Follow the steps in the order presented and see if a step solves the problem before continuing to the next step.

1. Install Crystal Reports Service Pack 1.

2. Delete and re-enter the Crystal Reports and Crystal Reports Server license keys.

   To access the Crystal Reports license key, start Business Objects License Manager (Start > Programs > Business Objects 11).

   To access the Crystal Reports Server license key, start BusinessObjects Enterprise Central Management Console and click License Key. To log on to the Central Management Console, open your Web browser and go to the following page:


   Where *webserver* is the name of the Web server. If you changed this default virtual directory on the Web server, type your URL accordingly.

3. In Central Management Console, click Servers and then do the following:

   a. Select the check box for each server that is disabled (indicated by a server with a red circle), and then click Enable.

   b. If the preceding step does not enable a server, click the server check box and then click Delete. Close the Central Management Console and then go to Services on the Windows operating system and restart the Crystal Report Application Server. To access Services, in Windows Control Panel, double-click Administrative Tools > Services.

4. Perform a full uninstall of Crystal Reports Server and Crystal Reports, restart the server, and then reinstall both applications as described in *Installing Crystal Reports* on page 2-20. Make sure that you re-enter the license keys.
SQL Server Reporting Services Problems

Report Server cannot decrypt the symmetric key message is displayed

If you encounter the following error, you must delete encrypted data from the Report Server database and restart the ReportServer service.

The report server cannot decrypt the symmetric key used to access sensitive or encrypted data in a report server database. You must either restore a backup key or delete all encrypted content and then restart the service. Check the documentation for more information.

To delete the encrypted data and restart, make sure that the ReportServer services is running, and then do the following:

1. Click Start ▶ Run.
2. In the Open box, type rskeymgmt -delete, and then click OK.
3. Type Y to delete the data, and then press <Enter>.

The user account does not have adequate permissions message is displayed when you try to generate a report

If the following message is displayed when you try to generate a report:

The User Account <account name> does not have adequate permissions in Reporting Services. Make sure the User Account belongs to the Reporting Services's <role name> Role

Make sure that the Windows user account that is accessing the Web site has been assigned to the Reporting Services role as described in Assign Folder Security Permissions on the Web Server on page 2-96.
Executing Stored Procedures to Debug ITUAM

**WARNING** • Because some stored procedures update data, you should use care when executing procedures for debugging.

You can execute stored procedures from ITUAM Administrator for debugging purposes. To execute a stored procedure:

1. In the ITUAM Administrator main window, click **System Administration** ▶ **Database** ▶ **Execute Stored Procedure**.

   The Stored Procedure Execute dialog box is displayed.

2. On the **Stored Procedures** tab, click the stored procedure that you want to run, enter the parameters for the procedure, and then click **Execute**.

When the stored procedure has finished running, the results are displayed on the **Results** tab.
Creating a Test Database for Troubleshooting

For troubleshooting purposes, you might need to send a copy of your database to IBM.

If you are using a SQL Server database, it is recommended that you use the `SaveDBSQLServer.wsf` script to detach the database and create a zip file containing the database files. See Option 1: Using the SaveDBSQLServer.wsf Script on page 11-17.

If you are using an Oracle or DB2 database, or the zip file containing your detached SQL Server database is too large to send to IBM, you can export data from the database and send it. See Loading Data Into a Test Database on page 11-19.

Option 1: Using the SaveDBSQLServer.wsf Script

**Note** • This script supports SQL Server only.

The `SaveDBSQLServer.wsf` script automates the process of detaching the database, creating a zip file containing the `.MDF` and `.LDF` files, and reattaching the database. You can then send the zipped database files to IBM.

**Note** • You cannot use this script to detach the master database.

SaveDBSQLServer.wsf Script Parameters

The `SaveDBSQLServer.wsf` script uses the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServerName (required)</td>
<td>The name of the server that contains the database.</td>
</tr>
<tr>
<td>DatabaseName (required)</td>
<td>The name of the database.</td>
</tr>
<tr>
<td>ArchiveFilename (required)</td>
<td>The full path and file name for the output zip file that contains the <code>.MDF</code> and <code>.LDF</code> files.</td>
</tr>
<tr>
<td>ODBCUserID and ODBCPassword (optional)</td>
<td>The SQL Server user ID and password for the database (if required).</td>
</tr>
</tbody>
</table>

Table 11-1 • SaveDBSQLServer Script Parameters
Creating a Test Database for Troubleshooting

Option 2: Exporting Data From a Database

This option requires that you export the tables from the database and archive any database loads that you want to include for testing. The archived load files are automatically placed in a zip file. You should also create a zip file for the exported tables, and then send the zipped archive and table files to IBM.

Export the Database Tables

To export database tables:

1. In the ITUAM Administrator main window, go to the Select ITUAM Data Source box and click the data source for the database that you want to export tables from.

2. Click System Administration ▶ Database ▶ Database Table Manager.
   The Database Table Manager dialog box is displayed.

3. Click Select all tables.
   The check boxes for all tables are selected. Note that the ability to select all tables is dependent on the privileges assigned by your DBA.

4. Clear the following check boxes:
   - Audit–Client, Audit–Client Contact, Audit–Client Contact Number, Audit–Rate, and Audit-Transaction
   - Detail, DetailIdent, and Ident
   - Load Tracking
   - Summary, Summary Daily, and Summary to Detail

5. Click Export selected tables. (Note that exporting a table does not remove the table or its data.)

6. A dialog box that prompts you to select the location that you want to load the tables to is displayed. Select the correct folder, and then click OK.

The exported tables are saved as comma-delimited text files with the same name as the original table. For example, the CIMSRate table is exported as CIMSRate.txt.
Troubleshooting and Additional Information

Creating a Test Database for Troubleshooting

**Archive the Database Loads**

To include database loads in the test database, you must archive the loads that you want from the original database. To archive loads:

1. In the ITUAM Administrator main window, click **Chargeback Administration** ➤ **Database Loading** ➤ **Load Archiving & Purging**.
   
   The Load Archive dialog box is displayed.

2. On the **Archive** tab, select the loads that you want to include in the new database. (To define the loads that are displayed on the Archive tab, set the options in the **Loads Filter** and then click **Apply Filters**.)

3. Click **Archive**.

   The archived loads are stored in a zip file in the path and folder shown at the bottom of the Load Archive dialog box. This path is set on the **Archiving** tab of the Configuration dialog box (see *Database Load Archive Settings* on page 4-53). The naming convention for the zip file is `CIMSArchive_StartDate_EndDate_SequenceNumber.zip`.

**Loading Data Into a Test Database**

*Note* • The information in this section is intended for use by IBM technical support personnel to load customer data into a test database.

**Create the Database and ITUAM Data Source ID**

To create the database and ITUAM Data Source ID, see *Setting Up and Connecting to a Database* on page 2-38.

**Create and Load the Tables**

1. In the ITUAM Administrator main window, go to the **Select ITUAM Data Source** box and click the data source that you created for the test database.

2. In the Database Table Manager dialog box (**System Administration** ➤ **Database** ➤ **Database Table Manager**), click **Select all tables** and then click **Create selected tables**.

3. When the tables have been created, click **OK**.

4. In the Database Table Manager dialog box, clear the following check boxes:
   - Audit–Client, Audit–Client Contact, Audit–Client Contact Number, Audit–Rate, and Audit-Transaction
   - Detail, DetailIdent, and Ident
   - Load Tracking
   - Summary, Summary Daily, and Summary to Detail
5 Click Load selected tables, and then click OK in the subsequent message boxes.

6 A dialog box that prompts you to select the location that you want to load the tables from is displayed. Select the correct folder, and then click OK.

**Build the Database Objects**
In the Database Objects Manager dialog box (System Administration ➤ Database ➤ Database Objects Manager), click Select All and then click Create Selected Objects.

**Restore the Database Loads**
1 In the Load Archive dialog box (Chargeback Administration ➤ Database Loading ➤ Load Archiving & Purging), click the Restore tab.

2 Click Select All, and then click Restore.
Performing Disaster Recovery

In the event that the ITUAM application server becomes inoperable due to media failure or natural disaster, the following steps are required to recover the ITUAM system (including all databases, reports, folders, and files) to a new server.

Note that these steps reflect ITUAM application server, the database server, and the Web server on one computer. If your previous installation included multiple servers, you must restore accordingly.

To recover the ITUAM system on a new server:

1. Install the DBMS.
2. Install Microsoft Internet Information Services (IIS).
3. Install ITUAM with the same options as the previous installation.
4. Restore a full backup of the database or databases that you are using for ITUAM.
5. Restore the backup of the Program Files\IBM\ITUAM folder structure.
6. Restore the backup of the Processes folder.
7. If your Reports folder or any of its subfolders are not installed in the IBM\ITUAM folder, restore the backup of the Reports folder or subfolders.
### About ITUAM Data Sources for SQL Server Databases

**Note**  •  For more information about creating ITUAM Data Sources, see *Setting Up and Connecting to a Database* on page 2-38.

The number of ODBC Data Sources and ITUAM Data Sources that you need to configure for a SQL Server database depends on the number of logins that you created for the database and the authentication method used for the logins. Table 11-2 shows the different database login configurations that might be used and the ODBC Data Source(s) and ITUAM Data Source(s) required for each configuration.

<table>
<thead>
<tr>
<th>Database Login(s)</th>
<th>ODBC Data Source(s)</th>
<th>ITUAM Data Source(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>One login (Windows or SQL Server authentication). (This is a common configuration.)</td>
<td>One ODBC Data Source.</td>
<td>One ITUAM Data Source.</td>
</tr>
<tr>
<td>x number of SQL Server authenticated logins. (This is a common configuration.)</td>
<td>One ODBC Data Source.</td>
<td>Separate ITUAM Data Sources for each login. For example, if you have one login for the ITUAM administrator and one login for the Web reporting end users, create two ITUAM Data Sources for the same ODBC Data Source. The ITUAM Data Sources store the SQL server ID and password for each login.</td>
</tr>
</tbody>
</table>

*Table 11-2  •  Possible ODBC Data Source and ITUAM Data Source Configurations*
### About ITUAM Data Sources for SQL Server Databases

**Troubleshooting and Additional Information**

<table>
<thead>
<tr>
<th>Database Login(s)</th>
<th>ODBC Data Source(s)</th>
<th>ITUAM Data Source(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>x number of SQL Server authenticated logins.</td>
<td>One ODBC Data Source for the SQL Server authenticated logins.</td>
<td>Separate ITUAM Data Sources for each login.</td>
</tr>
<tr>
<td>And</td>
<td></td>
<td></td>
</tr>
<tr>
<td>y number of Windows authenticated logins. (This configuration is uncommon.)</td>
<td>One ODBC Data Source for the Windows authenticated logins.</td>
<td>One ITUAM Data Source for all logins.</td>
</tr>
<tr>
<td>y number of Windows authenticated logins. (This configuration is very rare.)</td>
<td>One ODBC Data Source.</td>
<td>One ITUAM Data Source for all logins.</td>
</tr>
</tbody>
</table>

*Table 11-2: Possible ODBC Data Source and ITUAM Data Source Configurations*
Installing Crystal Reports 9

Crystal Reports 9 Advanced Developer Edition includes Crystal Enterprise 9 Report Application Server Edition. You must install both of these components and Crystal Reports 9 Service Pack 2 in the following order:


**To install Crystal Reports 9 Advanced Developer Edition:**
1. Log on to Windows as a user in the Administrators group.
2. Do one of the following:
   - If you are installing from the installation CD, insert the Crystal Reports CD. If the CD does not start automatically, browse to your CD-ROM drive and double-click Setup.exe.
   - If you are installing from another location, for example from a network drive, double-click Setup.exe.
3. Click Install and follow the instructions in the Installation Wizard. A typical installation is recommended (i.e., click Typical in the Select Installation Type dialog box).

**To install Crystal Enterprise 9 Report Application Server Edition:**
Follow the same steps provided for installing Crystal Reports. However, install Crystal Enterprise Report Application Server Edition rather than Crystal Reports. A full installation is recommended (i.e., click Full in the Installation Type dialog box).

**To install Crystal Reports 9 Service Pack 2:**
Double-click cr90win_en_sp2.exe and follow the instructions in the InstallShield wizard.
Installing Crystal Reports 10

The following are the steps required to install Crystal Reports 10 Advanced Edition. This edition includes Crystal Enterprise 10 Embedded Edition provided on a separate CD.

**To install Crystal Reports 10 Advanced Edition:**

1. Log on to Windows as a user in the Administrators group.

2. Do one of the following:
   - If you are installing from the installation CD, insert the Crystal Reports CD. If the CD does not start automatically, browse to your CD-ROM drive and double-click `setup.exe`.
   - If you are installing from another location, for example from a network drive, double-click `setup.exe`.

3. Click **Install** and follow the instructions in the Installation Wizard. A typical installation is recommended (i.e., click **Typical** in the Select Installation Type dialog box).

**To install Crystal Enterprise 10 Embedded Edition:**

Follow the same steps provided for installing Crystal Reports. However, install Crystal Enterprise Embedded Edition rather than Crystal Reports. A full installation is recommended (i.e., click **Full** in the Installation Type dialog box).
Troubleshooting and Additional Information

Installing Crystal Reports 10
Database Tables

This appendix describes the layout of all database tables used by ITUAM and provides Entity Relationship Diagrams (ERDs) for the tables in the ITUAM database.

- CIMSAuditClient Table .......................................................... A-4
- CIMSAuditClientContact Table .................................................. A-5
- CIMSAuditClientContactNumber Table .................................... A-7
- CIMSAuditRate Table ............................................................. A-9
- CIMSAuditTransactionTable ..................................................... A-11
- CIMSCalendar Table ............................................................. A-14
- CIMSCalendar Table ............................................................. A-14
- CIMSCalendar Table ............................................................. A-15
- CIMSCalendar Table ............................................................. A-16
- CIMSCalendar Table ............................................................. A-17
- CIMSCalendar Table ............................................................. A-18
- CIMSCalendar Table ............................................................. A-20
- CIMSCalendar Table ............................................................. A-21
- CIMSCalendar Table ............................................................. A-21
- CIMSCalendar Table ............................................................. A-22
- CIMSCalendar Table ............................................................. A-23
- CIMSCalendar Table ............................................................. A-23
- CIMSCalendar Table ............................................................. A-24
- CIMSCalendar Table ............................................................. A-24
- CIMSCalendar Table ............................................................. A-24
<table>
<thead>
<tr>
<th>Database Tables</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
<tr>
<td>CIMSLanguage Table ........................................... A-25</td>
</tr>
<tr>
<td>CIMSLoadTracking Table ....................................... A-26</td>
</tr>
<tr>
<td>CIMSRate Table .................................................. A-28</td>
</tr>
<tr>
<td>CIMSRateGroup Table ............................................ A-31</td>
</tr>
<tr>
<td>CIMSRateIdentifiers Table .................................... A-31</td>
</tr>
<tr>
<td>CIMSRateShift Table ............................................ A-32</td>
</tr>
<tr>
<td>CIMSRateToRateGroup Table .................................... A-33</td>
</tr>
<tr>
<td>CIMSReport Table ................................................ A-33</td>
</tr>
<tr>
<td>CIMSReportCustomFields Table ................................ A-34</td>
</tr>
<tr>
<td>CIMSReportDistribution Table ................................ A-34</td>
</tr>
<tr>
<td>CIMSReportDistributionCycle Table ............................ A-35</td>
</tr>
<tr>
<td>CIMSReportDistributionParm Table .............................. A-36</td>
</tr>
<tr>
<td>CIMSReportDistributionType Table .............................. A-36</td>
</tr>
<tr>
<td>CIMSReportGroup Table ........................................... A-36</td>
</tr>
<tr>
<td>CIMSReportStart Table .......................................... A-37</td>
</tr>
<tr>
<td>CIMSReportToReportGroup Table ................................ A-37</td>
</tr>
<tr>
<td>CIMSResourceUtilization Table ................................ A-38</td>
</tr>
<tr>
<td>CIMSSummary Table ............................................... A-39</td>
</tr>
<tr>
<td>CIMSSummaryDaily Table ........................................ A-42</td>
</tr>
<tr>
<td>CIMSSummaryToDetail Table .................................... A-42</td>
</tr>
<tr>
<td>CIMSTransaction Table ......................................... A-43</td>
</tr>
<tr>
<td>CIMSUser Table .................................................... A-45</td>
</tr>
<tr>
<td>CIMSUserConfigOptions Table ................................ A-46</td>
</tr>
<tr>
<td>CIMSUserFavorites Table ....................................... A-46</td>
</tr>
<tr>
<td>CIMSUserGroup Table ............................................. A-47</td>
</tr>
<tr>
<td>CIMSUserGroupAccountCode Table ............................... A-48</td>
</tr>
<tr>
<td>CIMSUserGroupAccountStructure Table ......................... A-48</td>
</tr>
<tr>
<td>CIMSUserGroupConfigOptions Table ............................ A-48</td>
</tr>
<tr>
<td>CIMSUserGroupReport Table ..................................... A-50</td>
</tr>
</tbody>
</table>
### Database Entity Relationship Diagrams

- Summary-Related Tables
- Client Tables
- User Tables
- Report Tables
- Report Distribution Tables
- Transaction-Related Tables
CIMSAuditClient Table

If auditing is enabled, this table tracks changes made to the CIMSClient table. To enable auditing of the CIMSClient table, see page 4-52.

For a detailed description of the fields in this table (with the exception of TransType, DateTimeChanged, and UserID), refer to the field descriptions for the CIMSClient table (see page A-14).

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TransType</td>
<td></td>
<td>char(1)</td>
<td>The type of change that was made to the table:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>▪ U = update to existing data</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>▪ I = addition of new data</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>▪ D = deletion of data</td>
</tr>
<tr>
<td>DateTimeChanged</td>
<td></td>
<td>datetime</td>
<td>The date and time that the change was made.</td>
</tr>
<tr>
<td>UserID</td>
<td>char(30)</td>
<td></td>
<td>The Windows user ID of the user who made the change.</td>
</tr>
<tr>
<td>OldAccountCode</td>
<td>char(128)</td>
<td></td>
<td>The old client account code.</td>
</tr>
<tr>
<td>OldAltAccountCode</td>
<td>char(128)</td>
<td></td>
<td>The old alternate client account code.</td>
</tr>
<tr>
<td>OldAccountName</td>
<td>varchar(255)</td>
<td></td>
<td>The old client name.</td>
</tr>
<tr>
<td>NewAccountName</td>
<td>varchar(255)</td>
<td></td>
<td>The new client name.</td>
</tr>
<tr>
<td>OldLoadTrackingUID</td>
<td>int</td>
<td></td>
<td>The old load tracking unique identifier for the client.</td>
</tr>
<tr>
<td>NewLoadTrackingUID</td>
<td>int</td>
<td></td>
<td>The new load tracking unique identifier for the client.</td>
</tr>
<tr>
<td>OldRateTable</td>
<td>char(8)</td>
<td></td>
<td>The old rate table for the client.</td>
</tr>
<tr>
<td>NewRateTable</td>
<td>char(8)</td>
<td></td>
<td>The new rate table for the client.</td>
</tr>
<tr>
<td>OldInvoiceContact</td>
<td>int</td>
<td></td>
<td>The old index number for the contact name that is displayed on the invoice.</td>
</tr>
</tbody>
</table>
If auditing is enabled, this table tracks changes made to the CIMSClientContact table. To enable auditing of the CIMSClientContact table, see page 4-52.

For a detailed description of the fields in this table (with the exception of TransType, DateTimeChanged, and UserID), refer to the field descriptions for the CIMSClientContact table (see page A-16).

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NewInvoiceContact</td>
<td>int</td>
<td></td>
<td>The new index number for the contact name that is displayed on the invoice.</td>
</tr>
<tr>
<td>OldActionCode1–OldActionCode8</td>
<td>char(1)</td>
<td></td>
<td>The old action codes—see the ActionCode field description for the CIMSClient table.</td>
</tr>
</tbody>
</table>

**CIMSAuditClientContact Table**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TransType</td>
<td>char(1)</td>
<td></td>
<td>The type of change that was made to the table:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ U = update to existing data</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ I = addition of new data</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ D = deletion of data</td>
</tr>
<tr>
<td>DateTimeChanged</td>
<td>datetime</td>
<td></td>
<td>The date and time that the change was made.</td>
</tr>
<tr>
<td>UserID</td>
<td>char(30)</td>
<td></td>
<td>The Windows user ID of the user who made the change.</td>
</tr>
<tr>
<td>OldLoadTrackingUID</td>
<td>int</td>
<td></td>
<td>The old load tracking unique identifier for the client.</td>
</tr>
<tr>
<td>NewLoadTrackingUID</td>
<td>int</td>
<td></td>
<td>The new load tracking unique identifier for the client.</td>
</tr>
<tr>
<td>OldAccountCode</td>
<td>char(128)</td>
<td></td>
<td>The old client account code.</td>
</tr>
<tr>
<td>OldContactIdx</td>
<td>int</td>
<td></td>
<td>The old index number for the contact.</td>
</tr>
</tbody>
</table>
## Database Tables

### CIMSAuditClientContact Table

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NewContactIdx</td>
<td>int</td>
<td>The new index number for the contact.</td>
<td></td>
</tr>
<tr>
<td>OldAddressLine1</td>
<td>varchar(255)</td>
<td>The old address line by line number.</td>
<td></td>
</tr>
<tr>
<td>OldAddressLine5</td>
<td>varchar(255)</td>
<td>The old address line by line number.</td>
<td></td>
</tr>
<tr>
<td>NewAddressLine1</td>
<td>varchar(255)</td>
<td>The new address line by line number.</td>
<td></td>
</tr>
<tr>
<td>NewAddressLine5</td>
<td>varchar(255)</td>
<td>The new address line by line number.</td>
<td></td>
</tr>
<tr>
<td>OldContactName</td>
<td>varchar(255)</td>
<td>The old contact name.</td>
<td></td>
</tr>
<tr>
<td>NewContactName</td>
<td>varchar(255)</td>
<td>The new contact name.</td>
<td></td>
</tr>
<tr>
<td>OldDepartment</td>
<td>varchar(255)</td>
<td>The old contact department.</td>
<td></td>
</tr>
<tr>
<td>NewDepartment</td>
<td>varchar(255)</td>
<td>The new contact department.</td>
<td></td>
</tr>
<tr>
<td>OldOffice</td>
<td>varchar(255)</td>
<td>The old contact office.</td>
<td></td>
</tr>
<tr>
<td>NewOffice</td>
<td>varchar(255)</td>
<td>The new contact office.</td>
<td></td>
</tr>
<tr>
<td>OldComments</td>
<td>varchar(255)</td>
<td>The old contact comments.</td>
<td></td>
</tr>
<tr>
<td>NewComments</td>
<td>varchar(255)</td>
<td>The new contact comments.</td>
<td></td>
</tr>
</tbody>
</table>
### CIMSAuditClientContactNumber Table

If auditing is enabled, this table tracks changes made to the CIMSClIENTCONTACTNUMBER table. To enable auditing of the CIMSClIENTCONTACTNUMBER table, see page 4-52.

For a detailed description of the fields in this table (with the exception of \texttt{TransType}, \texttt{DateTimeChanged}, and \texttt{UserID}), refer to the field descriptions for the CIMSClIENTCONTACTNUMBER table (see page A-17).

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\texttt{TransType}</td>
<td>char(1)</td>
<td></td>
<td>The type of change that was made to the table:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ U = update to existing data</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ I = addition of new data</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ D = deletion of data</td>
</tr>
<tr>
<td>\texttt{DateTimeChanged}</td>
<td>datetime</td>
<td></td>
<td>The date and time that the change was made.</td>
</tr>
<tr>
<td>\texttt{UserID}</td>
<td>char(30)</td>
<td></td>
<td>The Windows user ID of the user who made the change.</td>
</tr>
<tr>
<td>\texttt{OldLoadTrackingUID}</td>
<td>int</td>
<td></td>
<td>The old load tracking unique identifier for the client.</td>
</tr>
<tr>
<td>\texttt{NewLoadTrackingUID}</td>
<td>int</td>
<td></td>
<td>The new load tracking unique identifier for the client.</td>
</tr>
<tr>
<td>\texttt{OldAccountCode}</td>
<td>char(128)</td>
<td></td>
<td>The old client account code.</td>
</tr>
<tr>
<td>\texttt{OldContactIdx}</td>
<td>int</td>
<td></td>
<td>The old contact index number.</td>
</tr>
<tr>
<td>\texttt{NewContactIdx}</td>
<td>int</td>
<td></td>
<td>The new contact index number.</td>
</tr>
<tr>
<td>\texttt{OldNumberIdx}</td>
<td>int</td>
<td></td>
<td>The old index number for the contact number or e-mail address.</td>
</tr>
<tr>
<td>\texttt{NewNumberIdx}</td>
<td>int</td>
<td></td>
<td>The new index number for the contact number or e-mail address.</td>
</tr>
<tr>
<td>\texttt{OldNumberDescription}</td>
<td>varchar(255)</td>
<td></td>
<td>The old contact number description.</td>
</tr>
<tr>
<td>\texttt{NewNumberDescription}</td>
<td>varchar(255)</td>
<td></td>
<td>The new contact number description.</td>
</tr>
</tbody>
</table>
### Database Tables

**CIMSAuditClientContactNumber Table**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OldNumberValue</td>
<td></td>
<td>VARCHAR</td>
<td>The old contact number.</td>
</tr>
<tr>
<td>NewNumberValue</td>
<td></td>
<td>VARCHAR</td>
<td>The new contact number.</td>
</tr>
</tbody>
</table>
CIMSAuditRate Table

If auditing is enabled, this table tracks changes made to the CIMSRate table. To enable auditing of the CIMSRate table, see page 4-52.

For a detailed description of the fields in this table (with the exception of TransType, DateTimeChanged, and UserID), refer to the field descriptions for the CIMSRate table (see page A-28).

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TransType</td>
<td>char(1)</td>
<td></td>
<td>The type of change that was made to the table:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ U = update to existing data</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ I = addition of new data</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ D = deletion of data</td>
</tr>
<tr>
<td>DateTimeChanged</td>
<td>datetime</td>
<td></td>
<td>The date and time that the change was made.</td>
</tr>
<tr>
<td>UserID</td>
<td>char(30)</td>
<td></td>
<td>The Windows user ID of the user who made the change.</td>
</tr>
<tr>
<td>OldLoadTrackingUID</td>
<td>int</td>
<td></td>
<td>The old load tracking unique identifier for the rate code.</td>
</tr>
<tr>
<td>NewLoadTrackingUID</td>
<td>int</td>
<td></td>
<td>The new load tracking unique identifier for the rate code.</td>
</tr>
<tr>
<td>OldRateTable</td>
<td>char(8)</td>
<td></td>
<td>The old rate table for the rate code.</td>
</tr>
<tr>
<td>NewRateTable</td>
<td>char(8)</td>
<td></td>
<td>The new rate table for the rate code.</td>
</tr>
<tr>
<td>OldRateCode</td>
<td>char(8)</td>
<td></td>
<td>The old rate code.</td>
</tr>
<tr>
<td>NewRateCode</td>
<td>char(8)</td>
<td></td>
<td>The new rate code.</td>
</tr>
<tr>
<td>OldRateIndex</td>
<td>int</td>
<td></td>
<td>The old index number for the rate code.</td>
</tr>
<tr>
<td>NewRateIndex</td>
<td>int</td>
<td></td>
<td>The new index number for the rate code.</td>
</tr>
<tr>
<td>OldRateValue</td>
<td>decimal(18,8)</td>
<td></td>
<td>The old per unit value for the rate code.</td>
</tr>
<tr>
<td>NewRateValue</td>
<td>decimal(18,8)</td>
<td></td>
<td>The new per unit value for the rate code.</td>
</tr>
<tr>
<td>OldResourceValue</td>
<td>decimal(19,4)</td>
<td></td>
<td>Deprecated.</td>
</tr>
</tbody>
</table>
# Database Tables

**CIMSAuditRate Table**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NewResourceValue</td>
<td></td>
<td>decimal(19,4)</td>
<td>Deprecated.</td>
</tr>
<tr>
<td>OldDiscountDollars</td>
<td></td>
<td>decimal(19,4)</td>
<td>Deprecated.</td>
</tr>
<tr>
<td>NewDiscountDollars</td>
<td></td>
<td>decimal(19,4)</td>
<td>Deprecated.</td>
</tr>
<tr>
<td>OldDiscount</td>
<td></td>
<td>decimal(7,4)</td>
<td>Deprecated.</td>
</tr>
<tr>
<td>NewDiscount</td>
<td></td>
<td>decimal(7,4)</td>
<td>Deprecated.</td>
</tr>
<tr>
<td>OldDiscountIndex</td>
<td></td>
<td>int</td>
<td>Deprecated.</td>
</tr>
<tr>
<td>NewDiscountIndex</td>
<td></td>
<td>int</td>
<td>Deprecated.</td>
</tr>
<tr>
<td>OldDescription</td>
<td></td>
<td>varchar(255)</td>
<td>The old rate code description.</td>
</tr>
<tr>
<td>NewDescription</td>
<td></td>
<td>varchar(255)</td>
<td>The new rate code description.</td>
</tr>
<tr>
<td>OldFactor</td>
<td></td>
<td>numeric</td>
<td>The old resource conversion factor.</td>
</tr>
<tr>
<td>NewFactor</td>
<td></td>
<td>numeric</td>
<td>The new resource conversion factor.</td>
</tr>
<tr>
<td>OldRateValue1 – OldRateValue11</td>
<td></td>
<td>char(1)</td>
<td>The old rate values—see the RateValue field descriptions for the CIMSRate table.</td>
</tr>
<tr>
<td>NewRateValue1 – NewRateValue11</td>
<td></td>
<td>char(1)</td>
<td>The new rate values—see the RateValue field descriptions for the CIMSRate table.</td>
</tr>
<tr>
<td>OldEffDate</td>
<td></td>
<td>datetime</td>
<td>The old effective date for the rate code. For future use.</td>
</tr>
<tr>
<td>NewEffDate</td>
<td></td>
<td>datetime</td>
<td>The new effective date for the rate code. For future use.</td>
</tr>
<tr>
<td>OldTermDate</td>
<td></td>
<td>datetime</td>
<td>The old end date for the rate code. For future use.</td>
</tr>
<tr>
<td>NewTermDate</td>
<td></td>
<td>datetime</td>
<td>The new end date for the rate code. For future use.</td>
</tr>
<tr>
<td>OldComments</td>
<td></td>
<td>varchar(255)</td>
<td>The old comments for the rate code.</td>
</tr>
<tr>
<td>NewComments</td>
<td></td>
<td>varchar(255)</td>
<td>The new comments for the rate code.</td>
</tr>
</tbody>
</table>
If auditing is enabled, this table tracks changes made to the CIMSTransaction table. To enable auditing of the CIMSTransaction table, see page 4-52.

For a detailed description of the fields in this table (with the exception of TransType, DateTimeChanged, and UserID), refer to the field descriptions for the CIMSTransaction table (see page A-43).

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TransType</td>
<td>char(1)</td>
<td></td>
<td>The type of change that was made to the table:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ U = update to existing data or transaction marked as deleted</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ I = addition of new data</td>
</tr>
<tr>
<td>DateTimeChanged</td>
<td>datetime</td>
<td></td>
<td>The date and time that the change was made.</td>
</tr>
<tr>
<td>UserID</td>
<td>char(30)</td>
<td></td>
<td>The user ID of the user who made the change (usually the Windows user ID or the SQL Server login ID).</td>
</tr>
<tr>
<td>OldTransactionUID</td>
<td>char(32)</td>
<td></td>
<td>The old unique identifier for the transaction.</td>
</tr>
<tr>
<td>OldAccountCode</td>
<td>char(128)</td>
<td></td>
<td>The old account code for the transaction.</td>
</tr>
<tr>
<td>OldTransactionType</td>
<td>char(1)</td>
<td></td>
<td>The old transaction type—see the TransactionType field description for the CIMSTransaction table.</td>
</tr>
<tr>
<td>NewTransactionType</td>
<td>char(1)</td>
<td></td>
<td>The old transaction type—see the TransactionType field description for the CIMSTransaction table.</td>
</tr>
<tr>
<td>OldShiftCode</td>
<td>char(1)</td>
<td></td>
<td>The old shift code.</td>
</tr>
<tr>
<td>OldRateCode</td>
<td>char(8)</td>
<td></td>
<td>The old rate code.</td>
</tr>
</tbody>
</table>
### Database Tables

**CIMSAuditTransactionTable**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NewRateCode</td>
<td></td>
<td>char(8)</td>
<td>The new rate code.</td>
</tr>
<tr>
<td>OldResourceAmount</td>
<td></td>
<td>decimal(18,5)</td>
<td>The old resource amount for the transaction.</td>
</tr>
<tr>
<td>NewResourceAmount</td>
<td></td>
<td>decimal(18,5)</td>
<td>The new resource amount for the transaction.</td>
</tr>
<tr>
<td>OldFrequency1–OldFrequency2</td>
<td></td>
<td>Int</td>
<td>The old frequency number—see the Frequency field descriptions for the CIMSTransaction table.</td>
</tr>
<tr>
<td>NewFrequency1–NewFrequency2</td>
<td></td>
<td>Int</td>
<td>The new frequency number—see the Frequency field descriptions for the CIMSTransaction table.</td>
</tr>
<tr>
<td>OldFromDate</td>
<td></td>
<td>datetime</td>
<td>The old from date.</td>
</tr>
<tr>
<td>NewFromDate</td>
<td></td>
<td>datetime</td>
<td>The new from date.</td>
</tr>
<tr>
<td>OldToDate</td>
<td></td>
<td>datetime</td>
<td>The old to date.</td>
</tr>
<tr>
<td>NewToDate</td>
<td></td>
<td>datetime</td>
<td>The new to date.</td>
</tr>
<tr>
<td>OldDateTimeSent</td>
<td></td>
<td>datetime</td>
<td>The old date and time sent.</td>
</tr>
<tr>
<td>NewDateTimeSent</td>
<td></td>
<td>datetime</td>
<td>The new date and time sent.</td>
</tr>
<tr>
<td>OldDateTimeModified</td>
<td></td>
<td>datetime</td>
<td>The old date and time modified.</td>
</tr>
<tr>
<td>NewDateTimeModified</td>
<td></td>
<td>datetime</td>
<td>The new date and time modified.</td>
</tr>
<tr>
<td>OldDateTimeEntered</td>
<td></td>
<td>datetime</td>
<td>The old date and time entered.</td>
</tr>
<tr>
<td>NewDateTimeEntered</td>
<td></td>
<td>datetime</td>
<td>The new date and time entered.</td>
</tr>
<tr>
<td>OldDateTimeStartProcessing</td>
<td></td>
<td>datetime</td>
<td>The old processing start date and time.</td>
</tr>
<tr>
<td>NewDateTimeStartProcessing</td>
<td></td>
<td>datetime</td>
<td>The new processing start date and time.</td>
</tr>
<tr>
<td>OldDateTimeStopProcessing</td>
<td></td>
<td>datetime</td>
<td>The old processing end date and time.</td>
</tr>
<tr>
<td>NewDateTimeStopProcessing</td>
<td></td>
<td>datetime</td>
<td>The new processing end date and time.</td>
</tr>
</tbody>
</table>
### CIMSAuditTransactionTable

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OldUserID</td>
<td>char(8)</td>
<td></td>
<td>The old ITUAM user ID of the user who made the change.</td>
</tr>
<tr>
<td>NewUserID</td>
<td>char(8)</td>
<td></td>
<td>The new ITUAM user ID of the user who made the change.</td>
</tr>
<tr>
<td>OldDateTimeDeleted</td>
<td>datetime</td>
<td></td>
<td>The old date and time that the transaction was deleted.</td>
</tr>
<tr>
<td>NewDateTimeDeleted</td>
<td>datetime</td>
<td></td>
<td>The new date and time that the transaction was deleted.</td>
</tr>
<tr>
<td>OldNote</td>
<td>varchar(255)</td>
<td></td>
<td>The old note for the transaction.</td>
</tr>
<tr>
<td>NewNote</td>
<td>varchar(255)</td>
<td></td>
<td>The new note for the transaction.</td>
</tr>
</tbody>
</table>
## CIMSCalendar Table

This table defines the billing periods for a billing organization.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year</td>
<td>PK</td>
<td>int</td>
<td>The calendar year.</td>
</tr>
<tr>
<td>Period</td>
<td>PK</td>
<td>int</td>
<td>The calendar period (1 – 13).</td>
</tr>
<tr>
<td>PeriodBeginDate</td>
<td></td>
<td>datetime</td>
<td>The beginning date of the period</td>
</tr>
<tr>
<td>PeriodEndDate</td>
<td></td>
<td>datetime</td>
<td>The ending date of the period</td>
</tr>
<tr>
<td>CloseDate</td>
<td></td>
<td>datetime</td>
<td>The processing close date.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key

## CIMSClient Table

This is the primary table for storing client information. All other client tables are related to this table.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AccountCode</td>
<td>PK</td>
<td>char(128)</td>
<td>The account code for the client.</td>
</tr>
<tr>
<td>AltAcctCode</td>
<td></td>
<td>char(128)</td>
<td>The alternate account code for the client (optional).</td>
</tr>
<tr>
<td>AccountName</td>
<td></td>
<td>varchar(255)</td>
<td>The client name.</td>
</tr>
<tr>
<td>LoadTrackingUID</td>
<td></td>
<td>int</td>
<td>A unique identifier that tracks the client when loaded to the database from a location outside of ITUAM.</td>
</tr>
<tr>
<td>RateTable</td>
<td></td>
<td>char(8)</td>
<td>The rate table for the client.</td>
</tr>
<tr>
<td>InvoiceContact</td>
<td></td>
<td>int</td>
<td>The index number for the client contact name that is displayed on the invoice.</td>
</tr>
<tr>
<td>ActionCode1 - ActionCode8</td>
<td></td>
<td>char(1)</td>
<td>These user-defined codes are strictly for reporting purposes and can be used in the custom reporting process for selecting data. ITUAM does not use action codes.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key
## CIMSClientBudget Table

This table stores budget and actual information for amounts and resource units by account code, date, and rate code.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LoadTrackingUID</td>
<td>int</td>
<td>A unique identifier that tracks the client when loaded to the database from a location outside of ITUAM.</td>
<td></td>
</tr>
<tr>
<td>RateCode</td>
<td>PKa</td>
<td>char(8)</td>
<td>A valid rate code for an individual resource budget or TOTAL for an overall account budget.</td>
</tr>
<tr>
<td>Year</td>
<td>PKa</td>
<td>int</td>
<td>The budget year.</td>
</tr>
<tr>
<td>Period</td>
<td>PKa</td>
<td>int</td>
<td>The budget period (0 – 13).</td>
</tr>
<tr>
<td>BudgetAmt</td>
<td></td>
<td>decimal(19,4)</td>
<td>The budget monetary amount for the period.</td>
</tr>
<tr>
<td>ActualAmt</td>
<td></td>
<td>decimal(19,4)</td>
<td>Deprecated. The actual amount is in the CIMSSummary table.</td>
</tr>
<tr>
<td>BudgetUnits</td>
<td></td>
<td>decimal(18,5)</td>
<td>The budget units for the period.</td>
</tr>
<tr>
<td>ActualUnits</td>
<td></td>
<td>decimal(18,5)</td>
<td>Deprecated. The actual units consumed are in the CIMSSummary table.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key
## CIMSClientContact Table

This table stores client contacts.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LoadTrackingUID</td>
<td>int</td>
<td>A unique identifier that tracks the client when loaded to the database from a location outside of ITUAM.</td>
<td></td>
</tr>
<tr>
<td>ContactIdx</td>
<td>PKa</td>
<td>int</td>
<td>The index number for the contact.</td>
</tr>
<tr>
<td>AddressLine1</td>
<td>varchar(255)</td>
<td>Address Line 1</td>
<td></td>
</tr>
<tr>
<td>AddressLine2</td>
<td>varchar(255)</td>
<td>Address Line 2</td>
<td></td>
</tr>
<tr>
<td>AddressLine3</td>
<td>varchar(255)</td>
<td>Address Line 3</td>
<td></td>
</tr>
<tr>
<td>AddressLine4</td>
<td>varchar(255)</td>
<td>Address Line 4</td>
<td></td>
</tr>
<tr>
<td>AddressLine5</td>
<td>varchar(255)</td>
<td>Address Line 5</td>
<td></td>
</tr>
<tr>
<td>ContactName</td>
<td>varchar(255)</td>
<td>The name of the client contact.</td>
<td></td>
</tr>
<tr>
<td>Department</td>
<td>varchar(255)</td>
<td>The contact department.</td>
<td></td>
</tr>
<tr>
<td>Office</td>
<td>varchar(255)</td>
<td>The contact office.</td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td>varchar(255)</td>
<td>Comments related to the contact.</td>
<td></td>
</tr>
</tbody>
</table>

a. PK = Primary Key
## CIMSClientContactNumber Table

This table stores numbers (phone, fax, etc.) and e-mail addresses for contacts.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LoadTrackingUID</td>
<td></td>
<td>int</td>
<td>A unique identifier that tracks the client when loaded to the database from a location outside of ITUAM.</td>
</tr>
<tr>
<td>ContactIdx</td>
<td>PKa</td>
<td>int</td>
<td>The index number for the contact.</td>
</tr>
<tr>
<td>NumberIdx</td>
<td>PKa</td>
<td>int</td>
<td>The index number for the contact number or e-mail address.</td>
</tr>
<tr>
<td>NumberDescription</td>
<td></td>
<td>varchar(255)</td>
<td>The type of number (VOICE, FAX, EMAIL, etc.)</td>
</tr>
<tr>
<td>NumberValue</td>
<td></td>
<td>varchar(255)</td>
<td>The contact number or e-mail address.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key
This table defines configuration options that have a GUI option in ITUAM Administrator. One CIMSCfgConfig record is allowed per ITUAM database.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OrgName</td>
<td>varchar(255)</td>
<td>varchar(255)</td>
<td>The organization name</td>
</tr>
<tr>
<td>AddressLine1</td>
<td>varchar(255)</td>
<td>varchar(255)</td>
<td>Address Line 1</td>
</tr>
<tr>
<td>AddressLine2</td>
<td>varchar(255)</td>
<td>varchar(255)</td>
<td>Address Line 2</td>
</tr>
<tr>
<td>AddressLine3</td>
<td>varchar(255)</td>
<td>varchar(255)</td>
<td>Address Line 3</td>
</tr>
<tr>
<td>AddressLine4</td>
<td>varchar(255)</td>
<td>varchar(255)</td>
<td>Address Line 4</td>
</tr>
<tr>
<td>InvoiceNo</td>
<td>int</td>
<td>int</td>
<td>Deprecated. This is stored in the CIMSCfgConfigOptions table.</td>
</tr>
<tr>
<td>InvoiceNumberType</td>
<td>char(1)</td>
<td>char(1)</td>
<td>Deprecated.</td>
</tr>
<tr>
<td>Use13Periods</td>
<td>char(1)</td>
<td>char(1)</td>
<td>Indicates whether 13 periods are used:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ Y (Yes)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ N (No)</td>
</tr>
<tr>
<td>UseCalendar</td>
<td>char(1)</td>
<td>char(1)</td>
<td>Indicates whether the ITUAM calendar is used:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ Y (Yes)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ N (No)</td>
</tr>
<tr>
<td>ReportAccessSecurity</td>
<td>char(1)</td>
<td>char(1)</td>
<td>Indicates whether report security is used:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ Y (Yes)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ N (No)</td>
</tr>
<tr>
<td>LocationStandardReports</td>
<td>varchar(255)</td>
<td>varchar(255)</td>
<td>The path to the ITUAM standard reports.</td>
</tr>
<tr>
<td>LocationCustomReports</td>
<td>varchar(255)</td>
<td>varchar(255)</td>
<td>The path to custom reports.</td>
</tr>
<tr>
<td>LocationSavedReports</td>
<td>varchar(255)</td>
<td>varchar(255)</td>
<td>The path to published reports.</td>
</tr>
<tr>
<td>DatabaseVersion</td>
<td>char(7)</td>
<td>char(7)</td>
<td>The ITUAM database version number.</td>
</tr>
<tr>
<td>LastProcessUID</td>
<td>int</td>
<td>int</td>
<td>Used by CIMSAcct and CIMSBill.</td>
</tr>
<tr>
<td>CustomReportGroupID</td>
<td>int</td>
<td>int</td>
<td>The unique identifier for the default report group for user-defined Web reports.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Key</td>
<td>Type</td>
<td>Field Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CustomSpreadsheetGroupID</td>
<td>int</td>
<td></td>
<td>The unique identifier for the default report group for user-defined Web spreadsheets.</td>
</tr>
<tr>
<td>SessionTimeoutMinutes</td>
<td>int</td>
<td></td>
<td>The number of minutes before a ITUAM Web Reporting session expires and a new login is required.</td>
</tr>
<tr>
<td>AccountParameterSelectionLevel</td>
<td>int</td>
<td></td>
<td>In ITUAM Web Reporting, this setting determines the level of account codes that are displayed in the Starting Account Code and Ending Account Code parameter lists.</td>
</tr>
<tr>
<td>DefaultCrystalViewer</td>
<td>int</td>
<td></td>
<td>The unique identifier for the browser viewer used to view Crystal Reports.</td>
</tr>
<tr>
<td>DBConnectionTimeout</td>
<td>int</td>
<td></td>
<td>The maximum number of seconds that a database may respond to a query before timing out.</td>
</tr>
<tr>
<td>WebCustomSite</td>
<td>char(1)</td>
<td></td>
<td>Indicates the Web site to be used:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ D (Default)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ C (Custom)</td>
</tr>
<tr>
<td>WebBGColor</td>
<td>varchar(32)</td>
<td></td>
<td>The hexadecimal number for the background color of a custom Web site.</td>
</tr>
<tr>
<td>WebCSSLocation</td>
<td>varchar(255)</td>
<td></td>
<td>The path to the CSS for a custom Web site.</td>
</tr>
<tr>
<td>WebImageLocation</td>
<td>varchar(255)</td>
<td></td>
<td>The path to the images for a custom Web site.</td>
</tr>
<tr>
<td>WebMenuVertStartPos</td>
<td>int</td>
<td></td>
<td>The start position (in pixels) for the menu of a custom Web site.</td>
</tr>
<tr>
<td>LastReportingDate</td>
<td>datetime</td>
<td></td>
<td>The last reporting date for reports that end users who do not have administrative privileges can view.</td>
</tr>
</tbody>
</table>
Database Tables

CIMSConfigOptions Table

This table defines configuration options that the administrator can add manually in ITUAM Administrator.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PropertyName</td>
<td>PKa</td>
<td>varchar(80)</td>
<td>The name of the configuration option.</td>
</tr>
<tr>
<td>PropertyValue</td>
<td></td>
<td>varchar(255)</td>
<td>The value for the configuration option.</td>
</tr>
<tr>
<td>PropertyType</td>
<td>int</td>
<td></td>
<td>The data type of the configuration option:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ 1 (String)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ 2 (Integer)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ 3 (Floating Point)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ 4 (Date/Time)</td>
</tr>
<tr>
<td>Sequence</td>
<td>int</td>
<td></td>
<td>For future use.</td>
</tr>
<tr>
<td>PropertyDescription</td>
<td></td>
<td>varchar(255)</td>
<td>A description of the configuration option.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key
**CIMSConfigAccountLevel Table**

This table defines the account code structure.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AccountStructureName</td>
<td>char(32)</td>
<td></td>
<td>The account code structure name (e.g., Standard).</td>
</tr>
<tr>
<td>StartPosition</td>
<td>int</td>
<td></td>
<td>The starting offset position for the account code.</td>
</tr>
<tr>
<td>AccountLevel</td>
<td>int</td>
<td></td>
<td>The account code level.</td>
</tr>
<tr>
<td>AccountLength</td>
<td>int</td>
<td></td>
<td>The length of the account code level.</td>
</tr>
<tr>
<td>AccountDescription</td>
<td>varchar(255)</td>
<td></td>
<td>A description of the account code level.</td>
</tr>
</tbody>
</table>

**CIMSCPUNormalization Table**

The table allows for differences in CPU speed.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SystemID</td>
<td>PKa</td>
<td>char(32)</td>
<td>The system identifier for the computer that you want to normalize. For z/OS, this is the four-character System Model ID. For UNIX and Windows, it is the computer name.</td>
</tr>
<tr>
<td>WorkID</td>
<td>PKa</td>
<td>char(32)</td>
<td>The subsystem name (e.g., CICS region name, DB2 plan name, Oracle instance, etc.).</td>
</tr>
<tr>
<td>Factor</td>
<td></td>
<td>decimal(10,4)</td>
<td>The normalization factor.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key
## CIMSDetail Table

This table stores the information contained in the CIMSBill Detail file. The table contains the resource information collected from the records in the input CSR or CSR+ file. Each record in this table represents a single resource used/time period. This is the most granular form of the resource data stored in the database.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LoadTrackingUID</td>
<td>int</td>
<td></td>
<td>The load tracking unique identifier from the CIMSLoadTracking table.</td>
</tr>
<tr>
<td>DetailUID</td>
<td>int</td>
<td></td>
<td>The unique identifier that tracks the CIMSBill Detail load.</td>
</tr>
<tr>
<td>DetailLine</td>
<td>int</td>
<td></td>
<td>The number of the record in the input CSR or CSR+ file that contains the resource (i.e., 1 if it is the first record, 2 if it is the second record, etc.).</td>
</tr>
<tr>
<td>AccountCode</td>
<td>char(128)</td>
<td></td>
<td>The account code.</td>
</tr>
<tr>
<td>Aggregate</td>
<td>int</td>
<td></td>
<td>A count of the number of original input records that have been aggregated into this record.</td>
</tr>
<tr>
<td>StartDate</td>
<td>datetime</td>
<td></td>
<td>The resource usage start date.</td>
</tr>
<tr>
<td>EndDate</td>
<td>datetime</td>
<td></td>
<td>The resource usage end date.</td>
</tr>
<tr>
<td>ShiftCode</td>
<td>char(1)</td>
<td></td>
<td>The resource usage shift code.</td>
</tr>
<tr>
<td>AuditCode</td>
<td>varchar(255)</td>
<td></td>
<td>The audit code (if applicable).</td>
</tr>
<tr>
<td>SourceSystem</td>
<td>char(8)</td>
<td></td>
<td>The system identifier for this resource.</td>
</tr>
<tr>
<td>RateCode</td>
<td>char(8)</td>
<td></td>
<td>The rate code of this resource.</td>
</tr>
<tr>
<td>ResourceUnits</td>
<td>decimal(18,5)</td>
<td></td>
<td>The quantity of the resource used.</td>
</tr>
<tr>
<td>AccountingStartDate</td>
<td>datetime</td>
<td></td>
<td>The accounting start date.</td>
</tr>
<tr>
<td>AccountingEndDate</td>
<td>datetime</td>
<td></td>
<td>The accounting end date.</td>
</tr>
</tbody>
</table>
CIMSDetailIdent Table

This table stores the information contained in the Ident file. The table contains the identifier values collected from the records in the input CSR or CSR+ file. The identifier names are stored in the CIMSIdent table and are represented by a number assigned to the identifier name.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LoadTrackingUID</td>
<td></td>
<td>int</td>
<td>The load tracking unique identifier from the CIMSLoadTracking table.</td>
</tr>
<tr>
<td>DetailUID</td>
<td>PKa</td>
<td>int</td>
<td>The unique identifier that tracks the CIMSBill Detail load.</td>
</tr>
<tr>
<td>DetailLine</td>
<td>PKa</td>
<td>int</td>
<td>The number of the record in the input CSR or CSR+ file that contains the identifier (i.e., 1 if it is the first record, 2 if it is the second record, etc.).</td>
</tr>
<tr>
<td>IdentNumber</td>
<td>PKa</td>
<td>int</td>
<td>A sequential number assigned to the identifier in the CIMSIdent table.</td>
</tr>
<tr>
<td>IdentValue</td>
<td></td>
<td>varchar(255)</td>
<td>The value of the identifier.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key

CIMSHeadline Table

This table defines the headlines that are displayed on the ITUAM Web Reporting home page.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Key</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HeadlineUID</td>
<td>PKa</td>
<td>int</td>
<td>The sequential UID that tracks the headline.</td>
</tr>
<tr>
<td>HeadLineDate</td>
<td></td>
<td>datetime</td>
<td>The date that the headline was created.</td>
</tr>
<tr>
<td>Headline</td>
<td></td>
<td>varchar(255)</td>
<td>The headline text.</td>
</tr>
<tr>
<td>HeadlineLink</td>
<td></td>
<td>varchar(255)</td>
<td>The URL for the headline link.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key
**CIMSIdent Table**

This table stores all identifier names contained in the input CSR or CSR+ files processed. As a file is processed, the identifier names in the file records are added to this table. This table will continue to store identifier names even if the identifiers are no longer used by records loaded in the database. To delete unused identifier names if needed, see *Maintaining Identifiers* on page 4-39.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IdentNumber</td>
<td>PKa</td>
<td>int</td>
<td>A sequential number assigned to the identifier.</td>
</tr>
<tr>
<td>IdentName</td>
<td>varchar(32)</td>
<td>A short name for the identifier.</td>
<td></td>
</tr>
<tr>
<td>IdentDescription</td>
<td>varchar(255)</td>
<td>A full description of the identifier name (optional).</td>
<td></td>
</tr>
</tbody>
</table>
| IdentActiveFlag  | char(1) | Indicates whether Active or Inactive has been selected for custom reports:  
  ■ Blank (Active)  
  ■ I (Inactive) |
| IdentReportFlag  | char(1) | User-defined report flag. |

a. PK = Primary Key

**CIMSInpSrcCategory Table**

This table is for future use.

**CIMSInpSrcCategorySource Table**

This table is for future use.

**CIMSInpSrcMachineList Table**

This table is for future use.
**CIMSLanguage Table**

This table is for future use. It is intended to display GUI options (menus, links, etc.) in ITUAM Web Reporting in the required language.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>StringName</td>
<td>PKa</td>
<td>varchar(80)</td>
<td>The tag name in the Web reporting ASP page.</td>
</tr>
<tr>
<td>ENG</td>
<td></td>
<td>varchar(255)</td>
<td>The GUI option in English.</td>
</tr>
<tr>
<td>SPA</td>
<td></td>
<td>varchar(255)</td>
<td>The GUI option in Spanish.</td>
</tr>
<tr>
<td>FRA</td>
<td></td>
<td>varchar(255)</td>
<td>The GUI option in French.</td>
</tr>
<tr>
<td>DUT</td>
<td></td>
<td>varchar(255)</td>
<td>The GUI option in Dutch.</td>
</tr>
<tr>
<td>ITA</td>
<td></td>
<td>varchar(255)</td>
<td>The GUI option in Italian.</td>
</tr>
<tr>
<td>GER</td>
<td></td>
<td>varchar(255)</td>
<td>The GUI option in German.</td>
</tr>
<tr>
<td>FIN</td>
<td></td>
<td>varchar(255)</td>
<td>The GUI option in Finnish.</td>
</tr>
<tr>
<td>SWE</td>
<td></td>
<td>varchar(255)</td>
<td>The GUI option in Swedish.</td>
</tr>
<tr>
<td>JPN</td>
<td></td>
<td>varchar(255)</td>
<td>The GUI option in Japanese.</td>
</tr>
<tr>
<td>POR</td>
<td></td>
<td>varchar(255)</td>
<td>The GUI option in Portuguese.</td>
</tr>
<tr>
<td>OTH</td>
<td></td>
<td>varchar(255)</td>
<td>The GUI option in another language.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key
**CIMSLoadTracking Table**

This table records the loading of any data to the database. This enables database loads to be deleted if required.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LoadTrackingUID</td>
<td>PKa</td>
<td>int</td>
<td>The unique identifier for the database load.</td>
</tr>
<tr>
<td>FileType</td>
<td></td>
<td>char(8)</td>
<td>The type of file processed:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Summary</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Detail (CIMSBill Detail)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Ident</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Resource (CIMSAcctDetail)</td>
</tr>
<tr>
<td>FileName</td>
<td></td>
<td>varchar(255)</td>
<td>The path and name of the file that was processed</td>
</tr>
<tr>
<td>DateLoaded</td>
<td></td>
<td>datetime</td>
<td>The date and time the input CSR or CSR+ file was processed by CIMSAcct.</td>
</tr>
<tr>
<td>DateDeleted</td>
<td></td>
<td>datetime</td>
<td>The date and time the load was removed from the database.</td>
</tr>
<tr>
<td>TotalRecsLoaded</td>
<td></td>
<td>int</td>
<td>The number of records loaded.</td>
</tr>
<tr>
<td>StartDate</td>
<td></td>
<td>datetime</td>
<td>The accounting start date for Summary, Detail, and Ident records. The usage end date for resource records.</td>
</tr>
<tr>
<td>EndDate</td>
<td></td>
<td>datetime</td>
<td>The accounting end date for Summary, Detail, and Ident records. The usage end date for resource records.</td>
</tr>
<tr>
<td>SourceSystem</td>
<td></td>
<td>varchar(32)</td>
<td>The name of the computer that produced the data.</td>
</tr>
<tr>
<td>SourceFeed</td>
<td></td>
<td>varchar(32)</td>
<td>The system that produced the data (e.g., IIS, Exchange, z/OS, etc.)</td>
</tr>
<tr>
<td>DateArchived</td>
<td></td>
<td>datetime</td>
<td>The date and time that the load was archived.</td>
</tr>
</tbody>
</table>
### CIMSLoadTracking Table

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ArchiveLocation</td>
<td>varchar(255)</td>
<td>varchar(255)</td>
<td>The location of the archived load.</td>
</tr>
<tr>
<td>LoadGroupUID</td>
<td>int</td>
<td>int</td>
<td>The unique identifier for the group that the database load belongs to.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key
## Database Tables

### CIMSRate Table

This table stores the rate codes and rates for resource usage.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LoadTrackingUID</td>
<td>int</td>
<td>The unique identifier that tracks the rate when loaded to the database from a location outside of ITUAM.</td>
<td></td>
</tr>
<tr>
<td>RateTable</td>
<td>PKa</td>
<td>char(8)</td>
<td>The name of the rate table that contains the rate code.</td>
</tr>
<tr>
<td>RateCode</td>
<td>PKa</td>
<td>char(8)</td>
<td>The code for the rate.</td>
</tr>
<tr>
<td>RateIndex</td>
<td>int</td>
<td>The index number for the rate code.</td>
<td></td>
</tr>
<tr>
<td>RateValue</td>
<td></td>
<td>decimal(18,8)</td>
<td>The per unit value for the rate code.</td>
</tr>
<tr>
<td>ResourceValue</td>
<td></td>
<td>decimal(19,4)</td>
<td>Deprecated.</td>
</tr>
<tr>
<td>DiscountDollars</td>
<td></td>
<td>decimal(19,4)</td>
<td>Deprecated.</td>
</tr>
<tr>
<td>Discount</td>
<td></td>
<td>decimal(7,4)</td>
<td>Deprecated.</td>
</tr>
<tr>
<td>DiscountIndex</td>
<td>int</td>
<td></td>
<td>Deprecated.</td>
</tr>
<tr>
<td>Description</td>
<td></td>
<td>varchar(255)</td>
<td>A description of the rate code.</td>
</tr>
<tr>
<td>Factor</td>
<td></td>
<td>decimal(15,8)</td>
<td>A user-defined resource conversion factor value for the resource unit value in reports.</td>
</tr>
<tr>
<td>RateValue1</td>
<td>char(1)</td>
<td></td>
<td>Indicates whether four decimal positions are used in the rate value in reports:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- F (Four digits are used)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Blank (Eight digits are used [the default])</td>
</tr>
<tr>
<td>RateValue2</td>
<td>char(1)</td>
<td></td>
<td>Indicates whether the rate is per resource unit or per thousand units in reports:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- M (Per thousand units)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Blank (Per unit)</td>
</tr>
</tbody>
</table>
### CIMSRate Table

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RateValue3</td>
<td>char(1)</td>
<td></td>
<td>Indicates the resource conversion factor for the resource unit value in reports:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ 1 (Divide total resource value by 60)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ 2 (Divide total resource value by 3600)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ 3 (Divide total resource value by 1000)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ 4 (Multiply total resource value by 60)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ 5 (Divide total resource value by 60000)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ # (Multiple total resource value by user-defined number in Factor field.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ Blank (No conversion factor)</td>
</tr>
<tr>
<td>RateValue4</td>
<td>char(1)</td>
<td></td>
<td>Indicates whether the rate code is included in zero cost calculations:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ N (The rate will not be included in zero cost calculations)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ Blank (The rate will be included in zero cost calculations)</td>
</tr>
<tr>
<td>RateValue5</td>
<td>char(1)</td>
<td></td>
<td>For more information about zero cost calculations, see page 4-11.</td>
</tr>
<tr>
<td>RateValue6</td>
<td>char(1)</td>
<td></td>
<td>Indicates the number of decimal digits that appear in the resource units value in reports:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ 0-5 (0 through 5 digits)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ Blank (2 digits, the default)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>For future use.</td>
</tr>
</tbody>
</table>
### Database Tables

#### CIMSRate Table

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RateValue7</td>
<td>char(1)</td>
<td></td>
<td>Indicates the whether the resource units for the rate code are considered a monetary amount rather than units if utilization:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- $ (flat fee)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Blank (not flat fee)</td>
</tr>
<tr>
<td>RateValue8</td>
<td>char(1)</td>
<td></td>
<td>User-defined report flag.</td>
</tr>
<tr>
<td>RateValue9</td>
<td>char(1)</td>
<td></td>
<td>For future use.</td>
</tr>
<tr>
<td>RateValue10</td>
<td>char(1)</td>
<td></td>
<td>User-defined report flag.</td>
</tr>
<tr>
<td>RateValue11</td>
<td>char(1)</td>
<td></td>
<td>Indicates whether the rate should be included in CPU normalization:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Y (Yes)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- N (No)</td>
</tr>
<tr>
<td>EffDate</td>
<td>datetime</td>
<td></td>
<td>The effective date for the rate code.</td>
</tr>
<tr>
<td>TermDate</td>
<td>datetime</td>
<td></td>
<td>The end date for the rate code.</td>
</tr>
<tr>
<td>Comments</td>
<td>varchar(255)</td>
<td></td>
<td>Comments for the rate code.</td>
</tr>
<tr>
<td>DetailDescription</td>
<td>varchar(255)</td>
<td></td>
<td>User-defined description of the rate code for custom reports.</td>
</tr>
<tr>
<td>CurrencySymbol</td>
<td>varchar(3)</td>
<td></td>
<td>User-defined currency symbol for custom reports.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key
**CIMSRateGroup Table**

This table defines the rate groups.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RateGroup</td>
<td>PKa</td>
<td>int</td>
<td>A sequential number assigned to the rate group.</td>
</tr>
<tr>
<td>ParentUID</td>
<td></td>
<td>int</td>
<td>For future use.</td>
</tr>
<tr>
<td>GroupTitle</td>
<td></td>
<td>char(32)</td>
<td>The rate group title.</td>
</tr>
<tr>
<td>GroupTitleLong</td>
<td></td>
<td>varchar(255)</td>
<td>A description of the rate group.</td>
</tr>
<tr>
<td>PrintIndex</td>
<td></td>
<td>int</td>
<td>The order in which the rate group is displayed in reports.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key

**CIMSRateIdentifiers Table**

This table correlates rate codes to identifiers to enable drill down on the units consumed for a resource by identifier.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RateCode</td>
<td>PKa</td>
<td>char(8)</td>
<td>The rate code.</td>
</tr>
<tr>
<td>IdentNumber</td>
<td>PKa</td>
<td>int</td>
<td>A sequential number assigned to the identifier for the rate code.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key
## CIMSRateShift Table

This table defines the optional rate shifts for rate codes.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RateTable</td>
<td>PKa</td>
<td>char(8)</td>
<td>The name of the rate table.</td>
</tr>
<tr>
<td>RateCode</td>
<td>PKa</td>
<td>char(8)</td>
<td>The rate code.</td>
</tr>
<tr>
<td>ShiftCode</td>
<td>PKa</td>
<td>char(1)</td>
<td>The shift code.</td>
</tr>
<tr>
<td>RateValue</td>
<td></td>
<td>decimal(18,8)</td>
<td>The rate value for the shift.</td>
</tr>
<tr>
<td>Description</td>
<td></td>
<td>varchar(255)</td>
<td>A description of the shift (Swing, Night, etc.).</td>
</tr>
<tr>
<td>RateValue1</td>
<td></td>
<td>char(1)</td>
<td>For future use.</td>
</tr>
<tr>
<td>RateValue2</td>
<td></td>
<td>char(1)</td>
<td>For future use.</td>
</tr>
<tr>
<td>RateValue3</td>
<td></td>
<td>char(1)</td>
<td>For future use.</td>
</tr>
<tr>
<td>RateValue4</td>
<td></td>
<td>char(1)</td>
<td>For future use.</td>
</tr>
<tr>
<td>RateValue5</td>
<td></td>
<td>char(1)</td>
<td>For future use.</td>
</tr>
<tr>
<td>RateValue6</td>
<td></td>
<td>char(1)</td>
<td>For future use.</td>
</tr>
<tr>
<td>RateValue7</td>
<td></td>
<td>char(1)</td>
<td>For future use.</td>
</tr>
<tr>
<td>RateValue8</td>
<td></td>
<td>char(1)</td>
<td>For future use.</td>
</tr>
<tr>
<td>RateValue9</td>
<td></td>
<td>char(1)</td>
<td>For future use.</td>
</tr>
<tr>
<td>RateValue10</td>
<td></td>
<td>char(1)</td>
<td>For future use.</td>
</tr>
<tr>
<td>RateValue11</td>
<td></td>
<td>char(1)</td>
<td>For future use.</td>
</tr>
<tr>
<td>EffDate</td>
<td></td>
<td>datetime</td>
<td>The effective date for the rate code.</td>
</tr>
<tr>
<td>TermDate</td>
<td></td>
<td>datetime</td>
<td>The end date for the rate code.</td>
</tr>
<tr>
<td>Comments</td>
<td></td>
<td>varchar(255)</td>
<td>For future use.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key
**CIMSRateToRateGroup Table**

This table correlates rate codes to rate groups.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RateCode</td>
<td>PKa</td>
<td>char(8)</td>
<td>The rate code.</td>
</tr>
<tr>
<td>RateGroup</td>
<td>PKa</td>
<td>int</td>
<td>A sequential number assigned to the rate group.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key

**CIMSReport Table**

This table stores information about the reports used for ITUAM Web Reporting. These reports are entered in the Report List Maintenance dialog box (see *Adding Reports to the Report List* on page 5-17).

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReportID</td>
<td>PKa</td>
<td>int</td>
<td>The unique identifier for the report.</td>
</tr>
<tr>
<td>ReportName</td>
<td></td>
<td>char(32)</td>
<td>The name of the report.</td>
</tr>
<tr>
<td>ReportFile</td>
<td></td>
<td>varchar(255)</td>
<td>The .rpt file name for the report. Also, the executable for all reports (except user-defined reports).</td>
</tr>
<tr>
<td>ReportDescription</td>
<td></td>
<td>varchar(255)</td>
<td>A description of the report.</td>
</tr>
<tr>
<td>UserID</td>
<td></td>
<td>char(8)</td>
<td>For a user-defined reports, the ITUAM user ID of the person who created the report.</td>
</tr>
<tr>
<td>ReportTemplateFile</td>
<td></td>
<td>varchar(255)</td>
<td>The .rpt file to be used as the executable for user defined reports.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key
**CIMSReportCustomFields Table**

This table stores the values for the user-defined reports that can be stored in the database and supplied to the report automatically at run time.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReportID</td>
<td>PK</td>
<td>int</td>
<td>The unique identifier for the report.</td>
</tr>
<tr>
<td>RateCode</td>
<td></td>
<td>char(8)</td>
<td>The rate code</td>
</tr>
<tr>
<td>ReportPosition</td>
<td>PK</td>
<td>int</td>
<td>The position within the report where the values are used beginning with 1 and continuing sequentially.</td>
</tr>
<tr>
<td>DecimalPlaces</td>
<td></td>
<td>int</td>
<td>The number of decimal places to display for the resource usage amount in reports.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key

**CIMSReportDistribution Table**

This table store the values for the report distribution requests. These requests are associated with a report cycle.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UserID</td>
<td></td>
<td>char(8)</td>
<td>The ITUAM user ID for the user assigned to the report.</td>
</tr>
<tr>
<td>GroupID</td>
<td></td>
<td>char(8)</td>
<td>The ITUAM user group ID for the user group assigned to the report.</td>
</tr>
<tr>
<td>ReportID</td>
<td></td>
<td>int</td>
<td>The unique identifier for the report.</td>
</tr>
<tr>
<td>ReportCycleID</td>
<td>PK</td>
<td>int</td>
<td>The unique identifier for the report cycle.</td>
</tr>
<tr>
<td>RequestID</td>
<td>PK</td>
<td>int</td>
<td>The unique identifier for the report distribution request.</td>
</tr>
<tr>
<td>ReportFormat</td>
<td></td>
<td>int</td>
<td>The unique identifier for the report format.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key
### CIMSReportDistributionCycle Table

This table stores values for report cycles.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReportCycleName</td>
<td></td>
<td>char(8)</td>
<td>The report cycle name.</td>
</tr>
<tr>
<td>ReportCycleDescription</td>
<td></td>
<td>int</td>
<td>The report cycle description.</td>
</tr>
<tr>
<td>EmailFromAddress</td>
<td></td>
<td>int</td>
<td>The address of the e-mail sender.</td>
</tr>
<tr>
<td>EmailSubject</td>
<td></td>
<td>int</td>
<td>The text in the e-mail subject.</td>
</tr>
<tr>
<td>EmailText</td>
<td></td>
<td>int</td>
<td>The text in the e-mail body.</td>
</tr>
<tr>
<td>WebSiteCIMS</td>
<td></td>
<td>varchar(80)</td>
<td>The URL for the ITUAM Web Reporting Web site.</td>
</tr>
<tr>
<td>WebSiteReports</td>
<td></td>
<td>varchar(255)</td>
<td>The URL for the virtual directory for published reports.</td>
</tr>
<tr>
<td>LinkType</td>
<td></td>
<td>int</td>
<td>The link type:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ 1 (UNC)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ 2 (URL)</td>
</tr>
<tr>
<td>MailServer</td>
<td></td>
<td>varchar(80)</td>
<td>The name of the SMTP mail server used to send the e-mail.</td>
</tr>
<tr>
<td>UserSelectable</td>
<td></td>
<td>int</td>
<td>For future use.</td>
</tr>
<tr>
<td>EmailAdminAddress</td>
<td></td>
<td>varchar(128)</td>
<td>The address of the ITUAM administrator to receive the report distribution log file.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key
**CIMSReportDistributionParm Table**

This table stores the values for each report assigned to a report cycle.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReportID</td>
<td>PK</td>
<td>int</td>
<td>The unique identifier for the report.</td>
</tr>
<tr>
<td>ReportCycleID</td>
<td>PK</td>
<td>int</td>
<td>The unique identifier for the report cycle.</td>
</tr>
<tr>
<td>RequestID</td>
<td>PK</td>
<td>int</td>
<td>The unique identifier for the report request.</td>
</tr>
<tr>
<td>ParmName</td>
<td>PK</td>
<td>varchar(255)</td>
<td>The parameter name.</td>
</tr>
<tr>
<td>ParmValue</td>
<td></td>
<td>varchar(255)</td>
<td>The parameter value.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key

**CIMSReportDistributionType Table**

This table stores the values for report formats.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TypeID</td>
<td>PK</td>
<td>int</td>
<td>The unique identifier for the report format.</td>
</tr>
<tr>
<td>TypeValue</td>
<td></td>
<td>varchar(255)</td>
<td>The description of the report format.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key

**CIMSReportGroup Table**

This table stores information about report groups.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReportGroupID</td>
<td>PK</td>
<td>int</td>
<td>The unique identifier for the report group</td>
</tr>
<tr>
<td>ReportGroupName</td>
<td></td>
<td>char(32)</td>
<td>The report group name</td>
</tr>
</tbody>
</table>

a. PK = Primary Key
**CIMSReportStart Table**

This table defines the order in which reports are displayed in ITUAM Web Reporting.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReportStartID</td>
<td></td>
<td>int</td>
<td>A unique identifier for the start group.</td>
</tr>
<tr>
<td>ReportStartGroupId</td>
<td></td>
<td>int</td>
<td>A sequential number that is assigned to the start group. The number is dependent on the order in which the group was created.</td>
</tr>
</tbody>
</table>

**CIMSReportToReportGroup Table**

This table relates reports to report groups.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MemberID</td>
<td>PKa</td>
<td>int</td>
<td>The unique identifier of the report.</td>
</tr>
<tr>
<td>MemberType</td>
<td>PKa</td>
<td>char(1)</td>
<td>R (Report)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>G (Graph)</td>
</tr>
<tr>
<td>ReportGroupId</td>
<td>PKa</td>
<td>int</td>
<td>The unique identifier for the report group.</td>
</tr>
<tr>
<td>Sequence</td>
<td></td>
<td>int</td>
<td>The order of the report in the report group list.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key
### CIMSResourceUtilization Table

This table stores the resource information contained in the CIMSAcct Detail file. In most cases, you will not need to load the data in CIMSAcct Detail file to the database.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key Type</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LoadTrackingUID</td>
<td>int</td>
<td>int</td>
<td>The load tracking unique identifier from the CIMSLoadTracking table.</td>
</tr>
<tr>
<td>DetailUID</td>
<td>int</td>
<td>int</td>
<td>The unique identifier that tracks the CIMSAcct Detail load.</td>
</tr>
<tr>
<td>DetailLine</td>
<td>int</td>
<td>int</td>
<td>The number of the record in the input CSR or CSR+ file that contains the resource (i.e., 1 if it is the first record, 2 if it is the second record, etc.)</td>
</tr>
<tr>
<td>AccountCode</td>
<td>char(128)</td>
<td>char(128)</td>
<td>The account code.</td>
</tr>
<tr>
<td>Aggregate</td>
<td>int</td>
<td>int</td>
<td>A count of the number of original input CSR or CSR+ records that have been aggregated into this record.</td>
</tr>
<tr>
<td>StartDate</td>
<td>datetime</td>
<td>datetime</td>
<td>The resource usage start date.</td>
</tr>
<tr>
<td>EndDate</td>
<td>datetime</td>
<td>datetime</td>
<td>The resource usage end date.</td>
</tr>
<tr>
<td>ShiftCode</td>
<td>char(1)</td>
<td>char(1)</td>
<td>The resource usage shift code.</td>
</tr>
<tr>
<td>AuditCode</td>
<td>varchar(255)</td>
<td>varchar(255)</td>
<td>The audit code (if applicable).</td>
</tr>
<tr>
<td>SourceSystem</td>
<td>char(8)</td>
<td>char(8)</td>
<td>The system identifier for this resource.</td>
</tr>
<tr>
<td>RateCode</td>
<td>char(8)</td>
<td>char(8)</td>
<td>The rate code of this resource.</td>
</tr>
<tr>
<td>ResourceUnits</td>
<td>decimal(18,5)</td>
<td>decimal(18,5)</td>
<td>The quantity of the resource used.</td>
</tr>
</tbody>
</table>
CIMSSummary Table

This table stores the information contained in the Summary file created by CIMSBill. This table contains both resource utilization and cost data for reports. Note the BillFlag fields reflect the flags that were set in the CIMSRate table at the time that CIMSBill was run.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LoadTrackingUID</td>
<td>int</td>
<td>int</td>
<td>The load tracking unique identifier from the CIMSLoadTracking table.</td>
</tr>
<tr>
<td>Year</td>
<td>int</td>
<td>int</td>
<td>The resource usage year.</td>
</tr>
<tr>
<td>Period</td>
<td>int</td>
<td>int</td>
<td>The resource usage period</td>
</tr>
<tr>
<td>Shift</td>
<td>char(1)</td>
<td>char(1)</td>
<td>The resource usage shift code.</td>
</tr>
<tr>
<td>AccountCode</td>
<td>char(128)</td>
<td>char(128)</td>
<td>The account code.</td>
</tr>
<tr>
<td>LenLevel1</td>
<td>int</td>
<td>int</td>
<td>Values are the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- 0—The record was created from a Detail record.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- 1—The record was by created by reprocessing a Summary record.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- 2—The record was by created by processing a Summary record twice. If the</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Summary record was processed more than twice, the value would be 3, 4, 5, etc.</td>
</tr>
<tr>
<td>LenLevel2</td>
<td>int</td>
<td>int</td>
<td>A value of 0.</td>
</tr>
<tr>
<td>LenLevel3</td>
<td>int</td>
<td>int</td>
<td>A value of 0.</td>
</tr>
<tr>
<td>LenLevel4</td>
<td>int</td>
<td>int</td>
<td>A value of 0.</td>
</tr>
<tr>
<td>RateTable</td>
<td>char(8)</td>
<td>char(8)</td>
<td>The name of the rate table that contains the rate code.</td>
</tr>
<tr>
<td>RateCode</td>
<td>char(8)</td>
<td>char(8)</td>
<td>The rate code for the resource.</td>
</tr>
<tr>
<td>StartDate</td>
<td>datetime</td>
<td>datetime</td>
<td>The accounting start date.</td>
</tr>
<tr>
<td>EndDate</td>
<td>datetime</td>
<td>datetime</td>
<td>The accounting end date.</td>
</tr>
</tbody>
</table>
### Database Tables

**CIMSSummary Table**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BillFlag1</td>
<td>char(1)</td>
<td>Indicates whether four decimal positions are used in the rate value in reports:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ <strong>F</strong> (Four digits are used)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ <strong>Blank</strong> (Eight digits are used [the default])</td>
</tr>
<tr>
<td>BillFlag2</td>
<td>char(1)</td>
<td>Indicates whether the rate is per resource unit or per thousand units in reports:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ <strong>M</strong> (Per thousand units)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ <strong>Blank</strong> (Per unit)</td>
</tr>
<tr>
<td>BillFlag3</td>
<td>char(1)</td>
<td>Indicates the resource conversion factor for the resource unit value in reports:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ <strong>1</strong> (Divide total resource value by 60)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ <strong>2</strong> (Divide total resource value by 3600)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ <strong>3</strong> (Divide total resource value by 1000)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ <strong>4</strong> (Multiply total resource value by 60)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ <strong>5</strong> (Divide total resource value by 60000)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ <strong>#</strong> (Multiple total resource value by user-defined number in Factor field.)</td>
</tr>
<tr>
<td>BillFlag4</td>
<td>char(1)</td>
<td>Indicates whether the rate code is included in zero cost calculations:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ <strong>N</strong> (The rate will not be included in zero cost calculations)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ <strong>Blank</strong> (The rate will be included in zero cost calculations)</td>
</tr>
</tbody>
</table>

For more information about zero cost calculations, see page 3-11.
**CIMSSummary Table**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BillFlag5</td>
<td>char(1)</td>
<td>Indicates the number of decimal digits that appear in the resource units value in reports:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- 1-5 (1 through 5 digits)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Blank (2 digits, the default)</td>
</tr>
<tr>
<td>BillFlag6</td>
<td>char(1)</td>
<td>For future use.</td>
<td></td>
</tr>
<tr>
<td>BillFlag7</td>
<td>char(1)</td>
<td>Indicates the whether the resource units for the rate code are considered a monetary amount rather than units if utilization:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- $ (flat fee)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Blank (not flat fee)</td>
</tr>
<tr>
<td>BillFlag8</td>
<td>char(1)</td>
<td>User-defined report flag.</td>
<td></td>
</tr>
<tr>
<td>BillFlag9</td>
<td>char(1)</td>
<td>For future use.</td>
<td></td>
</tr>
<tr>
<td>RateValue</td>
<td>decimal(18,8)</td>
<td>Per unit charge for this rate.</td>
<td></td>
</tr>
<tr>
<td>ResourceUnits</td>
<td>decimal(18,5)</td>
<td>The total units for this rate.</td>
<td></td>
</tr>
<tr>
<td>BreakId</td>
<td>int</td>
<td>Deprecated.</td>
<td></td>
</tr>
<tr>
<td>MoneyValue</td>
<td>decimal(19,6)</td>
<td>The total currency units for this rate. <strong>Note:</strong> This will be 21,6 only if using an existing Oracle database prior to 4.2 and then upgrading to 4.2 or later.</td>
<td></td>
</tr>
<tr>
<td>UsageStartDate</td>
<td>datetime</td>
<td>The resource usage start date.</td>
<td></td>
</tr>
<tr>
<td>UsageEndDate</td>
<td>datetime</td>
<td>The resource usage end date.</td>
<td></td>
</tr>
<tr>
<td>RunDate</td>
<td>datetime</td>
<td>The date and time that CIMSBill was run.</td>
<td></td>
</tr>
<tr>
<td>BillFlag10</td>
<td>char(1)</td>
<td>User-defined report flag.</td>
<td></td>
</tr>
<tr>
<td>BillFlag11</td>
<td>char(1)</td>
<td>Indicates whether the rate should be included in CPU normalization:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Y (Yes)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- N (No)</td>
<td></td>
</tr>
</tbody>
</table>
Database Tables

CIMSSummaryDaily Table

This table stores the data in the CIMSSummary table at a monthly rather than daily level. The fields are the same as the CIMSSummary table.

For more information about converting daily records to monthly records, see ConvertSummaryDailyToMonthly.wsf Script on page C-8.

CIMSSummaryToDetail Table

This table is obsolete.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SummaryLoadTrackingUID</td>
<td>PK</td>
<td>int</td>
<td>The load tracking unique identifier from the CIMSLoadTracking table.</td>
</tr>
<tr>
<td>DetailUID</td>
<td>PK</td>
<td>int</td>
<td>The unique identifier that tracks the CIMSBill Detail load.</td>
</tr>
<tr>
<td>StartDate</td>
<td></td>
<td>datetime</td>
<td>The accounting start date.</td>
</tr>
<tr>
<td>EndDate</td>
<td></td>
<td>datetime</td>
<td>The accounting end date.</td>
</tr>
<tr>
<td>DetailConverted</td>
<td></td>
<td>char(1)</td>
<td>Indicates whether the CIMSBill Detail records have been converted:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Y (Yes)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Null (No)</td>
</tr>
<tr>
<td>SummaryConverted</td>
<td></td>
<td>char(1)</td>
<td>Indicates whether the Summary records have been converted:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Y (Yes)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Null (No)</td>
</tr>
</tbody>
</table>

a. PK = Primary Key
## CIMSTransaction Table

This table stores miscellaneous, recurring, and credit transactions. For more information about creating and using transactions, refer to the *IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide*.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TransactionUID</td>
<td>PKa</td>
<td>char(32)</td>
<td>The unique identifier for the transaction.</td>
</tr>
<tr>
<td>AccountCode</td>
<td></td>
<td>char(128)</td>
<td>The account code for the transaction.</td>
</tr>
<tr>
<td>TransactionType</td>
<td></td>
<td>char(1)</td>
<td>The transaction type:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- M (Miscellaneous)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- R (Recurring)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- C (Credit)</td>
</tr>
<tr>
<td>ShiftCode</td>
<td></td>
<td>char(1)</td>
<td>The shift code for the transaction.</td>
</tr>
<tr>
<td>RateCode</td>
<td></td>
<td>char(8)</td>
<td>The rate code for the transaction.</td>
</tr>
<tr>
<td>ResourceAmount</td>
<td></td>
<td>decimal(18,5)</td>
<td>The amount of the transaction.</td>
</tr>
<tr>
<td>Frequency1</td>
<td></td>
<td>int</td>
<td>Applicable only to recurring transactions. The frequency that the transaction should occur (every month, every 6 months, etc.). Frequency is based on the calendar year (January–December)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- 1 (monthly)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- 2 (every other month)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- 3 (every quarter)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- 4 (every four months)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- 6 (every six months)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- 12 (once a year)</td>
</tr>
<tr>
<td>Field Name</td>
<td>Key</td>
<td>Type</td>
<td>Field Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------</td>
<td>-----------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Frequency2</td>
<td>int</td>
<td>int</td>
<td>Applicable only to recurring transactions. The period in which the transaction should be processed. This value corresponds to the value in the Frequency1 field. For example, if the value in the Frequency1 field is 6, a value of 1 in this field indicates the first month of a 6 month period (January or July).</td>
</tr>
<tr>
<td>FromDate/ToDate</td>
<td>datetime</td>
<td>datetime</td>
<td>Applicable only to miscellaneous and credit transactions. The date range that the transaction occurred.</td>
</tr>
<tr>
<td>DateTimeSent</td>
<td>datetime</td>
<td>datetime</td>
<td>The date and time that the transaction was exported to a flat file.</td>
</tr>
<tr>
<td>DateTimeModified</td>
<td>datetime</td>
<td>datetime</td>
<td>The date and time that the transaction was last modified.</td>
</tr>
<tr>
<td>DateTimeEntered</td>
<td>datetime</td>
<td>datetime</td>
<td>The date and time that the transaction was created.</td>
</tr>
<tr>
<td>DateTimeStartProcessing</td>
<td>datetime</td>
<td>datetime</td>
<td>Applicable only to recurring transactions. The first day that the transaction will be processed.</td>
</tr>
<tr>
<td>DateTimeStopProcessing</td>
<td>datetime</td>
<td>datetime</td>
<td>Applicable only to recurring transactions. The last day that the transaction will be processed.</td>
</tr>
<tr>
<td>UserID</td>
<td>char(8)</td>
<td>char(8)</td>
<td>The ITUAM user ID of the person who entered the transaction.</td>
</tr>
<tr>
<td>DateTimeDeleted</td>
<td>datetime</td>
<td>datetime</td>
<td>The date and time that the transaction was deleted.</td>
</tr>
<tr>
<td>Note</td>
<td>varchar(255)</td>
<td>varchar(255)</td>
<td>A description of the transaction.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key
**CIMSUser Table**

This table stores the user options entered in the User Maintenance dialog box (see *Defining Users* on page 4-27).

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UserID</td>
<td>PKa</td>
<td>char(8)</td>
<td>The ITUAM user ID.</td>
</tr>
<tr>
<td>Password</td>
<td></td>
<td>int</td>
<td>A hash of the user password.</td>
</tr>
<tr>
<td>SessionID</td>
<td></td>
<td>int</td>
<td>A unique session identifier.</td>
</tr>
<tr>
<td>UserFullName</td>
<td></td>
<td>varchar(255)</td>
<td>The full name of the user.</td>
</tr>
<tr>
<td>UserFlag1</td>
<td></td>
<td>char(1)</td>
<td>Indicates whether full report path for published reports is displayed for the user on Favorites page in ITUAM Web Reporting:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>▪ Y (Yes)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>▪ N (No)</td>
</tr>
<tr>
<td>UserFlag2</td>
<td></td>
<td>char(1)</td>
<td>Indicates whether full report path for published reports is displayed for the user on Published Reports page in ITUAM Web Reporting:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>▪ Y (Yes)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>▪ N (No)</td>
</tr>
<tr>
<td>CrystalViewer</td>
<td></td>
<td>int</td>
<td>The unique identifier for the browser viewer used by the user to view Crystal Reports.</td>
</tr>
<tr>
<td>DomainUserName</td>
<td></td>
<td>varchar(255)</td>
<td>The Windows domain and user name for the user.</td>
</tr>
<tr>
<td>EmailToAddress</td>
<td></td>
<td>varchar(255)</td>
<td>The e-mail address for the user.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key
CIMSUserConfigOptions Table

This table stores the user configuration options entered in the User Configuration Options List Maintenance dialog box (see Defining Users on page 4-27).

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PropertyName</td>
<td>PK</td>
<td>varchar(80)</td>
<td>The name of the configuration option.</td>
</tr>
<tr>
<td>UserID</td>
<td>PK</td>
<td>char(8)</td>
<td>The ITUAM user ID.</td>
</tr>
<tr>
<td>PropertyValue</td>
<td></td>
<td>varchar(255)</td>
<td>The value for the configuration option.</td>
</tr>
<tr>
<td>PropertyType</td>
<td></td>
<td>int</td>
<td>The data type of the configuration option:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ 1 (String)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ 2 (Integer)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ 3 (Floating Point)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ 4 (Date/Time)</td>
</tr>
<tr>
<td>Sequence</td>
<td></td>
<td>int</td>
<td>For future use.</td>
</tr>
<tr>
<td>PropertyDescription</td>
<td></td>
<td>varchar(255)</td>
<td>A description of the configuration option.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key

CIMSUserFavorites Table

This table stores information regarding the ITUAM Web Reporting users favorite reports. For more information about favorite reports, refer to the IBM Tivoli Usage and Accounting Manager Web Reporting User's Guide.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UserID</td>
<td></td>
<td>char(8)</td>
<td>The ITUAM user ID.</td>
</tr>
<tr>
<td>FavoriteReportGroup</td>
<td></td>
<td>int</td>
<td>The unique identifier for the report group that the favorite report belongs to.</td>
</tr>
<tr>
<td>FavoriteReport</td>
<td></td>
<td>int</td>
<td>The unique identifier for the favorite report.</td>
</tr>
<tr>
<td>DisplayOrder</td>
<td></td>
<td>int</td>
<td>The order in which the favorite report is displayed.</td>
</tr>
</tbody>
</table>
**CIMSUserGroup Table**

This table relates users to user groups.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GroupID</td>
<td>PKa</td>
<td>char(8)</td>
<td>The user group ID.</td>
</tr>
<tr>
<td>GroupFullName</td>
<td></td>
<td>varchar(255)</td>
<td>The full name of the group.</td>
</tr>
<tr>
<td>TransactionSecurity</td>
<td></td>
<td>char(1)</td>
<td>Indicates whether group has transaction maintenance privilege:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0 (No)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>9 (Yes)</td>
</tr>
<tr>
<td>RateSecurity</td>
<td></td>
<td>char(1)</td>
<td>For future use.</td>
</tr>
<tr>
<td>ClientSecurity</td>
<td></td>
<td>char(1)</td>
<td>For future use.</td>
</tr>
<tr>
<td>GroupType</td>
<td></td>
<td>char(1)</td>
<td>Type of user:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 (Client)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>9 (Admin)</td>
</tr>
<tr>
<td>AllowFinModeler</td>
<td></td>
<td>char(1)</td>
<td>Indicates whether group has access to ITUAM Financial Modeler:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0 (No access)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>9 (Access)</td>
</tr>
<tr>
<td>AllowWebConsole</td>
<td></td>
<td>char(1)</td>
<td>Indicates whether group has access to ITUAM Web Console:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0 (No access)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>9 (Access)</td>
</tr>
</tbody>
</table>

a. PK = Primary Key
**CIMSUserGroupAccountCode Table**

This table defines the account codes that users within a user group can view.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GroupID</td>
<td>PK</td>
<td>char(8)</td>
<td>The user group ID.</td>
</tr>
<tr>
<td>AccountCode</td>
<td>PK</td>
<td>char(128)</td>
<td>The client account code that can be viewed. If the group has access to all clients, this field is blank.</td>
</tr>
</tbody>
</table>

a. PK = Primary Key

**CIMSUserGroupAccountStructure Table**

This table stores the account code structures assigned to a user group.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GroupID</td>
<td>PK</td>
<td>char(8)</td>
<td>The user group ID.</td>
</tr>
<tr>
<td>AccountStructureName</td>
<td>PK</td>
<td>char(32)</td>
<td>The name of the account code structure.</td>
</tr>
<tr>
<td>GroupDefault</td>
<td></td>
<td>int</td>
<td>Indicates whether the account code structure is the default:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 (default)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0 (not default)</td>
</tr>
</tbody>
</table>

**CIMSUserGroupConfigOptions Table**

This table stores the user configuration options entered in the Group Configuration Options List Maintenance dialog box (see Defining Users on page 4-27).

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PropertyName</td>
<td>PK</td>
<td>varchar(80)</td>
<td>The name of the configuration option.</td>
</tr>
<tr>
<td>GroupID</td>
<td>PK</td>
<td>char(8)</td>
<td>The ITUAM user group ID.</td>
</tr>
<tr>
<td>PropertyValue</td>
<td></td>
<td>varchar(255)</td>
<td>The value for the configuration option.</td>
</tr>
</tbody>
</table>
### CIMSUserGroupConfigOptions Table

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PropertyType</td>
<td>int</td>
<td>The data type of the configuration option:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 (String)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 (Integer)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 (Floating Point)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 (Date/Time)</td>
<td></td>
</tr>
<tr>
<td>Sequence</td>
<td>int</td>
<td>For future use.</td>
<td></td>
</tr>
<tr>
<td>PropertyDescription</td>
<td>varchar(255)</td>
<td>A description of the configuration option.</td>
<td></td>
</tr>
</tbody>
</table>

a. PK = Primary Key
This table defines the reports that users within a user group can view. If a group has access to all reports, it is not included in this table.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Key</th>
<th>Type</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GroupID</td>
<td>PKa</td>
<td>char(8)</td>
<td>The ITUAM user group ID.</td>
</tr>
<tr>
<td>ReportID</td>
<td>PKa</td>
<td>int</td>
<td>The unique identifier of the report.</td>
</tr>
<tr>
<td>ReportExecute</td>
<td></td>
<td>char(1)</td>
<td>Permission for users in this group to run the report:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Y (Yes)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- N (No)</td>
</tr>
</tbody>
</table>

a. PK = Primary Key
Database Entity Relationship Diagrams

This section provides Entity Relationship Diagrams (ERDs) for most of the tables in the ITUAM database. (Tables that do not have explicit relationships are not shown.)

These diagrams show the following:

- The relationships of the client, report, and user tables
- The relationship of the CIMSTransaction and CIMSSummary tables to other tables

The following conventions are used in these diagrams:

- PK = Primary Key
- Bold = A required field

Related tables are specified by their related fields. Related fields are connected by a line with a single arrow on one side and double arrow on the other. This line specifies both the related fields and the relationship of the tables. All linked tables reflect a one-to-many relationship. For example, the CIMSClient table has a one-to-many relationship with the CIMSClientBudget table (i.e., clients can have budgets for multiple resources).

Note that some tables are shown in more than one diagram.
Summary-Related Tables

The ERD in Figure A-1 shows the relationship of the CIMSSummary table to other tables.
**Client Tables**

The ERD in Figure A-2 shows the relationships of the client tables.

**User Tables**

The ERD in Figure A-3 shows the relationships of the user tables.
Report Tables

The ERD in Figure A-4 shows the relationships of the report tables.

Figure A-4 • Report Tables ERD
Report Distribution Tables

The ERD in Figure A-5 shows the relationships of the report distribution tables.

Figure A-5 • Report Distribution Tables ERD
Transaction-Related Tables

The ERD in Figure A-6 shows the relationship of the CIMSTransaction table to the CIMSClient and CIMSRate tables.
File Layouts

This appendix describes the layout of key files used by ITUAM.

CSR File ................................................................. B-2
CSR+ File ............................................................ B-4
CIMSAcct Detail File ................................................... B-7
Ident File ............................................................... B-8
CIMSBill Detail File ..................................................... B-9
Summary File .......................................................... B-11
CSR File

The primary method for input into ITUAM is the CSR file. The CSR file is automatically produced by ITUAM Data Collectors and can also be produced and read by many other third-party products.

The CSR records are in a standard ASCII display format (no packed, binary, or bit data) with commas for delimiters and decimal points included in resource amounts. A negative sign should precede negative numeric data, with no sign when the data is positive. When the identifier data contains commas, there must be double quotes around the identifier character data.

CSR records can be up to 32,000 bytes long and can contain a very large number of identifiers and resources. However, the maximum length for the records in the output CIMSAcct Detail file is 5,000 bytes with a limit of 100 resources.

The following table describes the fields in the CSR record.

<table>
<thead>
<tr>
<th>Pos.</th>
<th>Field Name</th>
<th>Length</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Header</td>
<td>8</td>
<td>Character</td>
<td>Defines the source of data. For example, storage data from the CIMSWinDisk data collector contains a header of WinDisk. There is no standard for this header and any unique combination of characters can be used.</td>
</tr>
<tr>
<td>2</td>
<td>Start Date of Usage</td>
<td>8</td>
<td>Number</td>
<td>Date in format YYYYMMDD.</td>
</tr>
<tr>
<td>3</td>
<td>End Date of Usage</td>
<td>8</td>
<td>Number</td>
<td>Date in format YYYYMMDD.</td>
</tr>
<tr>
<td>4</td>
<td>Start Time of Usage</td>
<td>8</td>
<td>Character</td>
<td>Time in format HH:MM:SS.</td>
</tr>
<tr>
<td>5</td>
<td>End Time of Usage</td>
<td>8</td>
<td>Character</td>
<td>Time in format HH:MM:SS.</td>
</tr>
<tr>
<td>6</td>
<td>Shift Code</td>
<td>1</td>
<td>Character</td>
<td>Alphanumeric code denoting time of day usage occurred. Allows billing different rates by shift. If you do not want to charge by shift, the field should be blank.</td>
</tr>
<tr>
<td>7</td>
<td>Number of Identifiers</td>
<td>2</td>
<td>Number</td>
<td>Number of identifiers in the following fields.</td>
</tr>
<tr>
<td>8</td>
<td>Identifier Name 1</td>
<td>32</td>
<td>Character</td>
<td>The name of the identifier.</td>
</tr>
<tr>
<td>Pos.</td>
<td>Field Name</td>
<td>Length</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>------------------</td>
<td>--------</td>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>9</td>
<td>Identifier Value 1</td>
<td>Variable</td>
<td>Character</td>
<td>Includes items such as database name, server name, LAN ID, user ID, program name, region, system ID, and so forth. This should be shortened as much as possible to a meaningful code for further translation.</td>
</tr>
<tr>
<td>10</td>
<td>Identifier Name 2</td>
<td>32</td>
<td>Character</td>
<td>The name of the identifier.</td>
</tr>
<tr>
<td>11</td>
<td>Identifier Value 2</td>
<td>Variable</td>
<td>Character</td>
<td>Includes items such as database name, server name, LAN ID, user ID, program name, region, system ID, and so forth. This should be shortened as much as possible to a meaningful code for further translation.</td>
</tr>
<tr>
<td>12</td>
<td>Identifier Name x</td>
<td>32</td>
<td>Character</td>
<td>The name of the identifier.</td>
</tr>
<tr>
<td>13</td>
<td>Identifier Value x</td>
<td>Variable</td>
<td>Character</td>
<td>Includes items such as database name, server name, LAN ID, user ID, program name, region, system ID, and so forth. This should be shortened as much as possible to a meaningful code for further translation.</td>
</tr>
<tr>
<td></td>
<td>Number of Resources</td>
<td>2</td>
<td>Number</td>
<td>Number of resources being tracked in the following fields.</td>
</tr>
<tr>
<td></td>
<td>Rate Code 1</td>
<td>8</td>
<td>Character</td>
<td>The rate code for the resource.</td>
</tr>
<tr>
<td></td>
<td>Resource Value 1</td>
<td>Variable</td>
<td>Number</td>
<td>Resource usage value such as CPU time, Input/Outputs, megabytes used, lines printed, transactions processed, etc.</td>
</tr>
<tr>
<td></td>
<td>Rate Code 2</td>
<td>8</td>
<td>Character</td>
<td>The rate code for the resource.</td>
</tr>
<tr>
<td></td>
<td>Resource Value 2</td>
<td>Variable</td>
<td>Number</td>
<td>Resource usage value such as CPU time, Input/Outputs, megabytes used, lines printed, transactions processed, etc.</td>
</tr>
<tr>
<td></td>
<td>Rate Code x</td>
<td>8</td>
<td>Character</td>
<td>The rate code for the resource.</td>
</tr>
<tr>
<td></td>
<td>Resource Value x</td>
<td>Variable</td>
<td>Number</td>
<td>Resource usage value such as CPU time, Input/Outputs, megabytes used, lines printed, transactions processed, etc.</td>
</tr>
</tbody>
</table>
**CSR+ File**

*Note* • The description of the CSR file format and length is also applicable to the CSR+ file (see page B-2).

The format of the CSR+ file record is the same as the CSR record with the exception that the CSR+ record contains an additional header at the beginning of the record. This is a fixed header that enables the records to be sorted more easily. The header is in the following format:

"CSR+<usage start date><usage end date><account code length><account code><x'40'>".

Note that the quotation marks and comma are included in the header.

**Examples**

"CSR+2006022820060228010aaaaaaaaa ,S390DB2,20060228,...
"CSR+2006022820060228010bbbbbbbbb ,S390DB2,20060228,...

In these examples, the usage start and end dates are February 28, 2006 (20060228). The account codes aaaaaaaaaa and bbbbbbbbb are 10 characters. The account codes are followed by a space (x'40'). The information after the header (S90DB2,20060228,...) represents the remaining fields found in the record. These fields are described in the following table.

*Note* • The CSR+ record does not supersede the CSR record. ITUAM uses both record types.

<table>
<thead>
<tr>
<th>Pos.</th>
<th>Field Name</th>
<th>Length</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Header</td>
<td>153</td>
<td>Character</td>
<td>A fixed header used for sorting.</td>
</tr>
<tr>
<td>2</td>
<td>Header</td>
<td>8</td>
<td>Character</td>
<td>Defines the source of data. For example, storage data from the CIMSWinDisk collector contains a header of WinDisk. There is no standard for this header and any unique combination of characters can be used.</td>
</tr>
<tr>
<td>3</td>
<td>Start Date of Usage</td>
<td>8</td>
<td>Number</td>
<td>Date in format YYYYMMDD.</td>
</tr>
<tr>
<td>4</td>
<td>End Date of Usage</td>
<td>8</td>
<td>Number</td>
<td>Date in format YYYYMMDD.</td>
</tr>
<tr>
<td>5</td>
<td>Start Time of Usage</td>
<td>8</td>
<td>Character</td>
<td>Time in format HH:MM:SS.</td>
</tr>
<tr>
<td>6</td>
<td>End Time of Usage</td>
<td>8</td>
<td>Character</td>
<td>Time in format HH:MM:SS.</td>
</tr>
</tbody>
</table>
### CSR+ File

<table>
<thead>
<tr>
<th>Pos.</th>
<th>Field Name</th>
<th>Length</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Shift Code</td>
<td>1</td>
<td>Character</td>
<td>Alphanumeric code denoting time of day usage occurred. Allows billing different rates by shift. If you do not want to charge by shift, the field should be blank.</td>
</tr>
<tr>
<td>8</td>
<td>Number of Identifiers</td>
<td>2</td>
<td>Number</td>
<td>Number of identifiers in the following fields.</td>
</tr>
<tr>
<td>9</td>
<td>Identifier Name 1</td>
<td>32</td>
<td>Character</td>
<td>The name of the identifier.</td>
</tr>
<tr>
<td>10</td>
<td>Identifier Value 1</td>
<td>Variable</td>
<td>Character</td>
<td>Includes items such as database name, server name, LAN ID, user ID, program name, region, system ID, and so forth. This should be shortened as much as possible to a meaningful code for further translation.</td>
</tr>
<tr>
<td>11</td>
<td>Identifier Name 2</td>
<td>32</td>
<td>Character</td>
<td>The name of the identifier.</td>
</tr>
<tr>
<td>12</td>
<td>Identifier Value 2</td>
<td>Variable</td>
<td>Character</td>
<td>Includes items such as database name, server name, LAN ID, user ID, program name, region, system ID, and so forth. This should be shortened as much as possible to a meaningful code for further translation.</td>
</tr>
<tr>
<td>13</td>
<td>Identifier Name x</td>
<td>32</td>
<td>Character</td>
<td>The name of the identifier.</td>
</tr>
<tr>
<td>14</td>
<td>Identifier Value x</td>
<td>Variable</td>
<td>Character</td>
<td>Includes items such as database name, server name, LAN ID, user ID, program name, region, system ID, and so forth. This should be shortened as much as possible to a meaningful code for further translation.</td>
</tr>
<tr>
<td>X</td>
<td>Number of Resources</td>
<td>2</td>
<td>Number</td>
<td>Number of resources being tracked in the following fields.</td>
</tr>
<tr>
<td>X</td>
<td>Rate Code 1</td>
<td>8</td>
<td>Character</td>
<td>The rate code for the resource.</td>
</tr>
<tr>
<td>X</td>
<td>Resource Value 1</td>
<td>Variable</td>
<td>Number</td>
<td>Resource usage value such as CPU time, Input/Outputs, megabytes used, lines printed, transactions processed, etc.</td>
</tr>
<tr>
<td>X</td>
<td>Rate Code 2</td>
<td>8</td>
<td>Character</td>
<td>The rate code for the resource.</td>
</tr>
</tbody>
</table>
## File Layouts

### CSR+ File

<table>
<thead>
<tr>
<th>Pos.</th>
<th>Field Name</th>
<th>Length</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>Resource Value 2</td>
<td>Variable</td>
<td>Number</td>
<td>Resource usage value such as CPU time, Input/Outputs, megabytes used, lines printed, transactions processed, etc.</td>
</tr>
<tr>
<td>X</td>
<td>Rate Code x</td>
<td>8</td>
<td>Character</td>
<td>The rate code for the resource.</td>
</tr>
<tr>
<td>X</td>
<td>Resource Value x</td>
<td>Variable</td>
<td>Number</td>
<td>Resource usage value such as CPU time, Input/Outputs, megabytes used, lines printed, transactions processed, etc.</td>
</tr>
</tbody>
</table>
CIMSAcct Detail File

This file is created by CIMSAcct and contains all the resource data processed by the CIMSAcct run. The CIMSAcct Detail file is basically the same as the CIMSBill Detail file (see page B-10), but without CPU normalization, proration, or include/exclude processing applied to the resources.

The following is the file layout for the CIMSAcct Detail file.

<table>
<thead>
<tr>
<th>Field</th>
<th>Starting Position</th>
<th>Length</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DETAIL-REC-TYPE</td>
<td>1</td>
<td>3</td>
<td>Always '991'.</td>
</tr>
<tr>
<td>DETAIL-REC-ID</td>
<td>5</td>
<td>8</td>
<td>Identifies the type of record. For example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>OS390DB2 - (OS/390 DB2 records)</td>
</tr>
<tr>
<td>DETAIL-EYE-CATCH</td>
<td>14</td>
<td>7</td>
<td>The version of the record.</td>
</tr>
<tr>
<td>DETAIL-LOAD-ID</td>
<td>22</td>
<td>10</td>
<td>The unique ID of the file that contained this detail record.</td>
</tr>
<tr>
<td>DETAIL-REC-NUMBER</td>
<td>33</td>
<td>10</td>
<td>The record number within the original detail file.</td>
</tr>
<tr>
<td>DETAIL-NUM-RECS</td>
<td>44</td>
<td>10</td>
<td>The number of records that were aggregated to make this one record. This</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>field applies only to mainframe data.</td>
</tr>
<tr>
<td>DETAIL-SORT-ID</td>
<td>55</td>
<td>1</td>
<td>(Reserved)</td>
</tr>
<tr>
<td>DETAIL-SYSTEM-ID</td>
<td>57</td>
<td>32</td>
<td>The system ID of the source of the record.</td>
</tr>
<tr>
<td>DETAIL-WORK-ID</td>
<td>90</td>
<td>32</td>
<td>The work id where the record came from (could be subsystem name, could be</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Oracle instance name).</td>
</tr>
<tr>
<td>DETAIL-START-DATE</td>
<td>123</td>
<td>8</td>
<td>The start date of the record.</td>
</tr>
<tr>
<td>DETAIL-END-DATE</td>
<td>132</td>
<td>8</td>
<td>The end date of the record.</td>
</tr>
<tr>
<td>DETAIL-START-TIME</td>
<td>141</td>
<td>8</td>
<td>The start time of the record.</td>
</tr>
<tr>
<td>DETAIL-END-TIME</td>
<td>150</td>
<td>8</td>
<td>The end time of the record.</td>
</tr>
<tr>
<td>DETAIL-SHIFT</td>
<td>159</td>
<td>1</td>
<td>The shift code.</td>
</tr>
<tr>
<td>DETAIL-DOW</td>
<td>161</td>
<td>1</td>
<td>The day of week.</td>
</tr>
<tr>
<td>DETAIL-ACCOUNT-CODE</td>
<td>163</td>
<td>128</td>
<td>The account code.</td>
</tr>
<tr>
<td>DETAIL-AUDIT-CODE</td>
<td>292</td>
<td>8</td>
<td>The audit code.</td>
</tr>
</tbody>
</table>
Ident File

This file is created by CIMSAcct and contains all the identifiers (such as user ID, jobname, department code, server name, etc.) that are contained in the input records. These identifiers are used during account code conversion to create your target account code structure. This is a simple, comma-delimited file.

The following is the file layout for the Ident file.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unique Load ID</td>
<td>The unique ID for the load.</td>
</tr>
<tr>
<td>Record Number</td>
<td>The record number.</td>
</tr>
<tr>
<td>Identifier Name</td>
<td>The name of the identifier (e.g., Jobname).</td>
</tr>
<tr>
<td>Identifier Value</td>
<td>The value for the identifier (e.g., ACPSJEFU).</td>
</tr>
</tbody>
</table>
CIMSBill Detail File

This file is created by CIMSBill and is a key component of the drill down feature of ITUAM Web Reporting.

The CIMSBill Detail file differs from the CIMSAcct Detail file in that the CIMSBill Detail file reflects any proration, CPU normalization, or include/exclude processing that was performed. The CIMSBill Detail file also includes accounting dates.

The following is the file layout for the CIMSBill Detail file.

<table>
<thead>
<tr>
<th>Field</th>
<th>Starting Position</th>
<th>Length</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DETAIL-REC-TYPE</td>
<td>1</td>
<td>3</td>
<td>Always '991'.</td>
</tr>
<tr>
<td>DETAIL-REC-ID</td>
<td>5</td>
<td>8</td>
<td>Identifies the type of record. For example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>OS390DB2 - (OS/390 DB2 records)</td>
</tr>
<tr>
<td>DETAIL-EYE-CATCH</td>
<td>14</td>
<td>7</td>
<td>The version of the record.</td>
</tr>
<tr>
<td>DETAIL-LOAD-ID</td>
<td>22</td>
<td>10</td>
<td>The unique ID of the file that contained this detail record.</td>
</tr>
<tr>
<td>DETAIL-REC-NUMBER</td>
<td>33</td>
<td>10</td>
<td>The record number within the original detail file.</td>
</tr>
<tr>
<td>DETAIL-NUM-RECS</td>
<td>44</td>
<td>10</td>
<td>The number of records that were aggregated to make this one record. This</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>field applies only to mainframe data.</td>
</tr>
<tr>
<td>DETAIL-SORT-ID</td>
<td>55</td>
<td>1</td>
<td>(Reserved)</td>
</tr>
<tr>
<td>DETAIL-SYSTEM-ID</td>
<td>57</td>
<td>32</td>
<td>The system ID of the source of the record.</td>
</tr>
<tr>
<td>DETAIL-WORK-ID</td>
<td>90</td>
<td>32</td>
<td>The work id where the record came from (could be subsystem name, could be</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>oracle instance name).</td>
</tr>
<tr>
<td>DETAIL-START-DATE</td>
<td>123</td>
<td>8</td>
<td>The start date of the record.</td>
</tr>
<tr>
<td>DETAIL-END-DATE</td>
<td>132</td>
<td>8</td>
<td>The end date of the record.</td>
</tr>
<tr>
<td>DETAIL-START-TIME</td>
<td>141</td>
<td>8</td>
<td>The start time of the record.</td>
</tr>
<tr>
<td>DETAIL-END-TIME</td>
<td>150</td>
<td>8</td>
<td>The end time of the record.</td>
</tr>
<tr>
<td>ACCOUNTING-START-DATE</td>
<td>159</td>
<td>8</td>
<td>The accounting period start date.</td>
</tr>
<tr>
<td>ACCOUNTING-END-DATE</td>
<td>168</td>
<td>8</td>
<td>The accounting period end date.</td>
</tr>
<tr>
<td>DETAIL-SHIFT</td>
<td>177</td>
<td>1</td>
<td>The shift code.</td>
</tr>
</tbody>
</table>
### File Layouts

**CIMSBill Detail File**

<table>
<thead>
<tr>
<th>Field</th>
<th>Starting Position</th>
<th>Length</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DETAIL-DOW</td>
<td>179</td>
<td>1</td>
<td>The day of week.</td>
</tr>
<tr>
<td>DETAIL-ACCOUNT-CODE</td>
<td>181</td>
<td>128</td>
<td>The account code.</td>
</tr>
<tr>
<td>DETAIL-AUDIT-CODE</td>
<td>310</td>
<td>8</td>
<td>The audit code.</td>
</tr>
<tr>
<td>DETAIL-IN克莱XCL-AREA</td>
<td>319</td>
<td>60</td>
<td>Include/exclude data range.</td>
</tr>
<tr>
<td>DETAIL-RES-NUMBER</td>
<td>380</td>
<td>2</td>
<td>Number of resources being tracked in the following fields.</td>
</tr>
<tr>
<td>DETAIL-RES-INFO</td>
<td>383</td>
<td>x</td>
<td>Occurs 1 to 100 times depending detail-res-number (see above).</td>
</tr>
<tr>
<td>DETAIL-RATE-CODE</td>
<td></td>
<td></td>
<td>The resources rate code.</td>
</tr>
<tr>
<td>DETAIL-RESOURCE-VAL</td>
<td></td>
<td></td>
<td>The resource value.</td>
</tr>
<tr>
<td>DETAIL-RESOURCE-SIGN</td>
<td></td>
<td></td>
<td>This field is blank if the resource is positive and ‘-‘ if the resource is negative.</td>
</tr>
</tbody>
</table>
**Summary File**

This file is created by CIMSBill and provides resource usage and cost data used for Web reports or for input to other financial or resource accounting systems.

The following is the file layout for the Summary file.

<table>
<thead>
<tr>
<th>Field</th>
<th>Start Position</th>
<th>Length</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>“SUMMARY”</td>
<td>1</td>
<td>8</td>
<td>Character</td>
</tr>
<tr>
<td>Version</td>
<td>9</td>
<td>3</td>
<td>Numeric</td>
</tr>
<tr>
<td>Reserved</td>
<td>12</td>
<td>3</td>
<td>Numeric</td>
</tr>
<tr>
<td>Reserved</td>
<td>15</td>
<td>3</td>
<td>Numeric</td>
</tr>
<tr>
<td>Reserved</td>
<td>18</td>
<td>3</td>
<td>Numeric</td>
</tr>
<tr>
<td>AccountCode</td>
<td>21</td>
<td>128</td>
<td>Character</td>
</tr>
<tr>
<td>RateTable</td>
<td>149</td>
<td>8</td>
<td>Character</td>
</tr>
<tr>
<td>SourceSystem</td>
<td>157</td>
<td>1</td>
<td>Character</td>
</tr>
<tr>
<td>RateCode</td>
<td>158</td>
<td>8</td>
<td>Character</td>
</tr>
<tr>
<td>ShiftCode</td>
<td>166</td>
<td>1</td>
<td>Numeric</td>
</tr>
<tr>
<td>AccountingFromDate</td>
<td>167</td>
<td>8</td>
<td>Numeric</td>
</tr>
<tr>
<td>AccountingToDate</td>
<td>175</td>
<td>8</td>
<td>Numeric</td>
</tr>
<tr>
<td>BillFlag1</td>
<td>183</td>
<td>1</td>
<td>Character</td>
</tr>
<tr>
<td>BillFlag2</td>
<td>184</td>
<td>1</td>
<td>Character</td>
</tr>
<tr>
<td>BillFlag3</td>
<td>185</td>
<td>1</td>
<td>Character</td>
</tr>
<tr>
<td>BillFlag4</td>
<td>186</td>
<td>1</td>
<td>Character</td>
</tr>
<tr>
<td>BillFlag5</td>
<td>187</td>
<td>1</td>
<td>Character</td>
</tr>
<tr>
<td>BillFlag6</td>
<td>188</td>
<td>1</td>
<td>Character</td>
</tr>
<tr>
<td>BillFlag7</td>
<td>189</td>
<td>1</td>
<td>Character</td>
</tr>
<tr>
<td>BillFlag8</td>
<td>190</td>
<td>1</td>
<td>Character</td>
</tr>
<tr>
<td>BillFlag9</td>
<td>191</td>
<td>1</td>
<td>Character</td>
</tr>
<tr>
<td>BillFlag10</td>
<td>192</td>
<td>1</td>
<td>Character</td>
</tr>
<tr>
<td>BillFlag11</td>
<td>193</td>
<td>1</td>
<td>Character</td>
</tr>
<tr>
<td>RateValue</td>
<td>194</td>
<td>18</td>
<td>Numeric</td>
</tr>
</tbody>
</table>
### File Layouts

**Summary File**

<table>
<thead>
<tr>
<th>Field</th>
<th>Start Position</th>
<th>Length</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ResourceUnits</td>
<td>212</td>
<td>18</td>
<td>Numeric</td>
</tr>
<tr>
<td>MoneyValue</td>
<td>230</td>
<td>18</td>
<td>Numeric</td>
</tr>
<tr>
<td>BreakId</td>
<td>248</td>
<td>1</td>
<td>Character</td>
</tr>
<tr>
<td>Conv Factor</td>
<td>249</td>
<td>13</td>
<td>Numeric</td>
</tr>
<tr>
<td>Release ID</td>
<td>262</td>
<td>6</td>
<td>Numeric</td>
</tr>
<tr>
<td>Date-Century</td>
<td>268</td>
<td>2</td>
<td>Numeric</td>
</tr>
<tr>
<td>Date-Year</td>
<td>270</td>
<td>2</td>
<td>Numeric</td>
</tr>
<tr>
<td>Date-Month</td>
<td>272</td>
<td>2</td>
<td>Numeric</td>
</tr>
<tr>
<td>Date-Day</td>
<td>274</td>
<td>2</td>
<td>Numeric</td>
</tr>
<tr>
<td>Time-HH</td>
<td>276</td>
<td>2</td>
<td>Numeric</td>
</tr>
<tr>
<td>Time-MM</td>
<td>278</td>
<td>2</td>
<td>Numeric</td>
</tr>
<tr>
<td>Time-SS</td>
<td>280</td>
<td>2</td>
<td>Numeric</td>
</tr>
<tr>
<td>Period</td>
<td>282</td>
<td>2</td>
<td>Numeric</td>
</tr>
<tr>
<td>Year</td>
<td>284</td>
<td>4</td>
<td>Numeric</td>
</tr>
<tr>
<td>UsageStartDate</td>
<td>288</td>
<td>8</td>
<td>Numeric</td>
</tr>
<tr>
<td>UsageEndDate</td>
<td>296</td>
<td>8</td>
<td>Numeric</td>
</tr>
</tbody>
</table>
Scripts

**Note** • The scripts described in this section run on the Windows system. For a description of the scripts that run in UNIX or Linux, refer to the *IBM Tivoli Usage and Accounting Manager Data Collectors for UNIX and Linux User’s Guide*.

This appendix describes the scripts included in the ITUAM installation. These scripts are located in the following locations (if you installed ITUAM in the default location):

- C:\Program Files\IBM\ITUAM\Scripts
- ...\Scripts\Batch Reporting
- ...\Scripts\Client Load

**Important!** • Some scripts change or purge the data in your database. If you are unsure whether you should use a particular script, consult IBM.

If you make changes to a script, make sure that you rename the file. Otherwise, the file will be overwritten when you upgrade to a new version of ITUAM.

**Running Scripts** .............................................................. C-3
Running Scripts Using Job Runner ............................................. C-3
Running Scripts Using a Batch File .......................................... C-5

**General Scripts** ................................................................. C-6
BuildCSRFromDB.wsf Script ....................................................... C-6
CLMLib.wsf Script .................................................................... C-7
CLMSUtils.wsc Script ............................................................... C-7
ClientPropagate.wsf Script ....................................................... C-7
ConvertSummaryDailyToMonthly.wsf Script ................................. C-8
CSRAggregator.wsf Script ......................................................... C-11
DropIdentFromDB.wsf Script ...................................................... C-12
DropIdentBeforeLoad.wsf Script ................................................ C-12
FTP.wsc and FTPSample.wsf Scripts ......................................... C-13
Scripts

ListUnusedIdentifiers.wsf ................................................................. C-13
OracleLogonTrigger.bat Script .......................................................... C-14
ProRate.wsf Script ........................................................................ C-16
PurgeLoads.wsf Script .................................................................. C-17
Rebill.wsf and ResourceConversion.wsf Scripts .............................. C-19
SampleBulkUserLoad.wsf Script ....................................................... C-22
SampleExportSummary.wsf Script ..................................................... C-23
SampleSQLMaintenance.bat Script .................................................. C-24
SaveDBSQLServer.wsf ................................................................. C-26
Schedule.wsf ............................................................................ C-26
Table.wsf Script ......................................................................... C-27
ZeroCost.wsf Script .................................................................... C-28

Batch Reporting Scripts .................................................................. C-29
ReportDistribution.wsf Script ......................................................... C-30
BatchReport.wsf Script ................................................................ C-31
AllAccts.wsf Script ...................................................................... C-38
EmailDistribution.wsf Script .......................................................... C-40

Client Load Scripts ....................................................................... C-41
LoadClientTableFromCSVFile.wsf Script ....................................... C-41

Data Source Parameters ................................................................ C-41
Running Scripts

It is recommended that you run the scripts described in this chapter using the ITUAM Job Runner application and a job file. This architecture provides the following benefits:

- It enables you to run the script automatically on scheduled basis (daily, monthly, etc.) using Windows Task Scheduler.
- You can receive a log file via e-mail that provides the results of the report generation and distribution process. If a warning or failure occurs during processing, the file indicates at which point the warning/failure occurred. The log file can be sent to multiple recipients.

You can also use a .bat file to run a script on a scheduled basis. However, this method does not provide notification of the success or failure of the script run.

**Note** - ITUAM scripts use the StepRunWSF.dll file. If you installed ITUAM in the default location, this DLL is in C:\Program Files\IBM\ITUAM\Process Engine\JobLibrary.

Running Scripts Using Job Runner

To run a script via Job Runner, you must create a job file for the script and then run Job Runner to execute the job file as shown in the following steps.

**Create a Job File for the Script**

In the JobFiles folder, create an XML job file for the script. For an example of a job file that runs a script, refer to the SampleReportDist.xml file. This job file runs the ReportDistribution.wsf script as described in Running the ReportDistribution.wsf Script on page 5-45. (If you installed ITUAM in the default location, the SampleReportDist.xml file is in C:\Program Files\IBM\ITUAM\JobFiles).

You can copy and modify the SampleReportDist.xml file to run any script. The valid parameters for each ITUAM script are provided in this appendix.

For a complete description of the components of a job file, refer to the IBM Tivoli Usage and Accounting Manager Data Collectors for Microsoft Windows User’s Guide.
Run Job Runner

Once you have created a job file, you can run Job Runner to execute the file using Windows command prompt or Windows Task Scheduler.

To run Job Runner from command prompt:

At the `C:\Program Files\IBM\ITUAM\Process Engine>` prompt type cimsjobrunner.exe `jobfilename.xml` where `jobfilename.xml` is the name of the job file, and then press <Enter>. Or from any prompt, type `"C:\Program Files\IBM\ITUAM\Process Engine\CIMSJobRunner.exe" jobfilename.xml`, and then press <Enter>.

Examples

C:\Program Files\IBM\ITUAM\Process Engine>CIMSJobRunner.exe jobfilename.xml

Or

C:\>"C:\Program Files\IBM\ITUAM\Process Engine\CIMSJobRunner.exe" jobfilename.xml

To run Job Runner from Task Scheduler:

1. In Windows Control Panel, double-click Scheduled Tasks.
2. Double-click Add Scheduled Task.
3. The Scheduled Task Wizard is displayed. Click Next.
4. Click Browse to find the program CIMSJobRunner.exe, and then double-click the program. If you installed ITUAM in the default location, this program is in `C:\Program Files\IBM\ITUAM\Process Engine`.
5. Type a name for the task or accept the default and click the schedule for the task. Click Next.
6. Select the time and day to start the task, and then click Next.
7. Type the password for the user account under which you want the scheduled task to run. The password cannot be blank. Click Next.
8. Select the Open advanced properties for this task when I click Finish check box, and then click Finish.
9. In the Task tab, type following in the Run box where `jobfilename.xml` is the name of the job file that you want to run:

   "C:\Program Files\IBM\ITUAM\Process Engine\CIMSJobRunner.exe" jobfilename.xml

10. Click OK.
11. In the Set Account Information dialog box, type the password for the user account again, and then click OK.

The task is displayed in the Scheduled Task list. To execute CIMSJobRunner.exe immediately, right-click the task, and then click Run. For more information about Task Scheduler, refer to the Microsoft documentation.
Running Scripts Using a Batch File

You can use a batch file to run a script and pass parameters. For example, ITUAM includes a default batch file `rebill.bat` for the `Rebill.wsf` script. This file contains the following:

```bash
cscript Rebill.wsf Premon Premon "All"
```

You can modify the parameters provided in the batch file as needed. In this example, the values `Premon Premon` are the start and end data parameters and "All" is the value for the rate code parameter. (For all valid parameters for the `Rebill.wsf` script, see page C-20). The valid parameters for each ITUAM script are provided in this appendix.

If a default batch file is not included for a script, you can copy and modify a similar file. If you are unsure as to what to include in the batch file, refer to the example that is provided in each script.

**To run a batch file from command prompt:**

1. Change the command prompt directory to the path that contains the `.bat` file that you want to run. For example, `C:\Program Files\IBM\ITUAM\Scripts>`.  
2. Type the name of the `.bat` file and then press <Enter>. For example, `C:\Program Files\IBM\ITUAM\Scripts>rebill.bat`.

**To run a batch file from Task Scheduler:**

1. In Windows Control Panel, double-click `Scheduled Tasks`.  
2. Double-click `Add Scheduled Task`.  
3. The `Scheduled Task Wizard` is displayed. Click `Next`.  
4. Click `Browse` to find the `.bat` file that you want to run, and then double-click the file.  
5. Type a name for the task or accept the default and click the schedule for the task. Click `Next`.  
6. Select the time and day to start the task, and then click `Next`.  
7. Type the password for the user account under which you want the scheduled task to run. The password cannot be blank. Click `Next`.  
8. Click `Finish`.  

The task is displayed in the Scheduled Task list. To execute the script immediately, right-click the task, and then click `Run`. For more information about Task Scheduler, refer to the Microsoft documentation.
General Scripts

The scripts described in this section are in `C:\Program Files\IBM\ITUAM\Scripts` (if you installed ITUAM in the default location).

BuildCSRFromDB.wsf Script

The BuildCSRFromDB.wsf script extracts information from the CIMSIIdent and CIMSDetail tables and creates an output file containing CSR records for further processing (e.g., to perform account code conversion, proration, and other processing that requires a CSR file).

BuildCSRFromDB.wsf Script Parameters

The BuildCSRFromDB.wsf script uses the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Date and End Date (required)</td>
<td>These parameters specify the date range for the records that you want to select from the CIMSDetail table. Any records that have accounting start and end dates in this range are selected for processing. Valid values are:</td>
</tr>
<tr>
<td></td>
<td>preday (previous day)</td>
</tr>
<tr>
<td></td>
<td>premon (previous month)</td>
</tr>
<tr>
<td></td>
<td>rndate (current day)</td>
</tr>
<tr>
<td></td>
<td>curmon (current month)</td>
</tr>
<tr>
<td></td>
<td>date in <code>yyyyMMdd</code> format or a format valid for your operating system’s regional settings</td>
</tr>
<tr>
<td>Output Filename (required)</td>
<td>The full path and file name for the output CSR file.</td>
</tr>
<tr>
<td>Rate Code (optional)</td>
<td>The rate code or codes that you want to appear in the output CSR file records. If you set this parameter to <code>All</code> or do not include the parameter, all rate codes in the selected CIMSDetail table records are included.</td>
</tr>
<tr>
<td>DataSourceID (optional)</td>
<td>See Data Source Parameters on page C-42.</td>
</tr>
</tbody>
</table>

Table 3-1  •  BuildCSRFromDB Script Parameters
**CIMSLib.wsf Script**

For information about this script, refer to the *IBM Tivoli Usage and Accounting Manager Data Collectors for Microsoft Windows User’s Guide*.

**CIMSUtils.wsc Script**

For information about this script, refer to the *IBM Tivoli Usage and Accounting Manager Data Collectors for Microsoft Windows User’s Guide*.

**ClientPropagate.wsf Script**

The `ClientPropagate.wsf` script propagates the account name and contact information of top level account codes to lower level account codes that *do not have account names*. This script will not overwrite existing names for lower level account codes that have names or add contacts to those levels.

For example, the account code AABBBBCCCC contains three levels: the two-digit company code AA, the 6-digit division code AABBBB, and the 9-digit department code AABBBBCCCC. If account name for the account code AA is ABC Headquarters, the name ABC Headquarters and any contact information will be assigned to account codes AABBBB and AABBBBCCCC.

**ClientPropagate.wsf Script Parameters**

The `ClientPropagate.wsf` script uses the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>TopLevelLength (required)</td>
<td>The length of the top level account code. The top level account code must have a valid account name.</td>
</tr>
<tr>
<td>DataSourceID, ODBCUserID, and ODBCPassword (optional)</td>
<td>See <em>Data Source Parameters</em> on page C-42.</td>
</tr>
</tbody>
</table>

*Table 3-2  * ClientPropagate Script Parameters
**ConvertSummaryDailyToMonthly.wsf Script**

**Important!** • This script consolidates daily Summary records into a monthly record. Consult IBM before using this script.

The ConvertSummaryDailyToMonthly.wsf script consolidates the daily data in your CIMSSummary table so that data is stored at a monthly level. (For more information about the CIMSSummary table, see [CIMSSummary Table](#) on page 5-5). This script calls the CIMSSp_ConvertSummaryDailyToMonthly stored procedure, which is built in the ITUAM database. This stored procedure aggregates the daily Summary records and produces a monthly Summary record with Monthly Aggregation listed as the source file name in the CIMSLoadTracking table.

This consolidation process minimizes storage space used (there is typically a 90 percent or greater reduction in Summary records) and decreases the time required to generate monthly reports. A drawback to this consolidation is that you cannot run costed daily reports against the CIMSSummary table.

**Note** • The ConvertSummaryDailyToMonthly.wsf script is intended primarily to improve reporting performance. To drastically reduce storage space used by the database, you can run the PurgeLoads.wsf script (see [PurgeLoads.wsf Script](#) on page C-17).

Before the monthly Summary aggregated data is created, daily data is copied from the CIMSSummary table to the CIMSSummaryDaily table for archival purposes. You can then run daily summary reports against the CIMSSummaryDaily table.
## ConvertSummaryDailyToMonthly.wsf Script Parameters

The `ConvertSummaryDailyToMonthly.wsf` script uses the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
</table>
| StartDate and EndDate (required) | These parameters specify the date range for the records that you want to consolidate from the CIMSSummary table. Any records that have accounting start and end dates in this range are consolidated. Typically, the start date is the first day of the month and the end date is the last day of the month. Valid values are:  
  - `preday` (previous day)  
  - `premon` (previous month)  
  - `rdate` (current day)  
  - `curmon` (current month)  
  - `date in yyyymmdd format or a format valid for your operating system's regional settings`  
If you use the `premon` or `curmon` keyword for the start date or end date, the first day of the month is used for the start date and the last day of the month is used for the end date. |
| DataSourceID, ODBCUserID, and ODBCPassword (optional) | See `Data Source Parameters` on page C-42. |
| RemoveSummaryDaily (optional) | If this parameter is set to `true`, the daily records that are archived in the CIMSSummaryDaily table for this date range are purged.  
If this parameter is set to `false` or is not provided, the records are maintained in the table. |

### Table 3-3 • ConvertSummaryDailyToMonthly Script Parameters
**ConvertSummaryDailyToMonthly.wsf Script Considerations**

- If an error occurs while processing the `ConvertSummaryDailyToMonthly.wsf` script, the script will back out all database changes. You can then correct the error and run the script again.

- You cannot run the script with an `EndDate` parameter equal to or greater than the current day.

- It is recommended that you run the script only once for a particular date range. Although the script can be run multiple times against the same date range, the `CIMSSummaryDaily` table is updated only once. If there is new data in a daily `CIMSSummary` table and you run the script a second time, the script will fail and the update will be backed out of the database because the data in the `CIMSSummaryDaily` table does not match the data in the `CIMSSummary` table. In this situation, you should run the script with the `RemoveSummaryDaily` parameter set to `true` and then rerun the script with this parameter set to `false`. For more information, contact IBM Software Support.

- The script could run for more than an hour per month. A status is not displayed while the script is running.
CSRAggregator.wsf Script

Although ITUAM Data Collectors automatically aggregate the records in the output CSR and CSR+ file records, you might want to use the CSRAggregator.wsf script to further aggregate the records in the following situations:

- You want to remove an identifier or identifiers from the aggregated records. For example, you might want to remove an identifier such as Time from the records to reduce the size of the CSR or CSR+ file.

- You want to remove a rate code or codes from the aggregated records. For example, the records contain a rate code that is not contained in the CIMSRate table and you do not want to receive the CIMSBill message “One or more rate codes were missing”.

- You want to aggregate the records in a CSR or CSR+ file that was created by a source other than ITUAM Data Collectors. In this situation, all records that contain the same identifier values are aggregated into one record that contains sum total resource values for the rate codes within these records.

CSRAggregator.wsf script can read CSR files that have multiple record formats. That is, records that have different identifier names and rate codes.

CSRAggregator.wsf Script Parameters

The CSRAggregator.wsf script uses the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>InputFilename (required)</td>
<td>The full path and file name of the input CSR or CSR+ file.</td>
</tr>
<tr>
<td>OutputFilename (required)</td>
<td>The full path and file name of the aggregated CSR or CSR+ file.</td>
</tr>
<tr>
<td>ExceptionFilename (optional)</td>
<td>For future use.</td>
</tr>
<tr>
<td>IdentifiersToRemove (optional)</td>
<td>The identifier name or names that you want to remove. If you want to remove multiple identifiers, separate the identifier names by commas (e.g., time,feed,server). The identifier names can be in any order. If a record contains any of the specified identifiers, the identifier or identifiers are removed.</td>
</tr>
</tbody>
</table>

Table 3-4 • CSRAggregator Script Parameters
The DropIdentFromDB.wsf script deletes a specified identifier from the CIMSDetailIdent and CIMSIdent tables. You should use the ListUnusedIdentifiers.wsf script (see page C-13) to determine which identifiers are obsolete before using this script. You must run this script for each identifier that you want to delete.

**WARNING** • Because this script irreversibly changes the database, it is highly recommended that you back up the database before you run the script.

**DropIdentFromDB.wsf Script Parameters**

The DropIdentFromDB.wsf script uses the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>ResourcesToRemove (optional)</td>
<td>The rate code or codes that you want to remove. If you want to remove multiple rate codes, separate the codes by commas (e.g., Z018,Z000,Z003). The rate codes can be in any order. If a record contains any of the specified rate codes, the rate code or rate codes are removed.</td>
</tr>
<tr>
<td>DataSourceID, ODBCUserID, and ODBCPassword (optional)</td>
<td>See Data Source Parameters on page C-42.</td>
</tr>
</tbody>
</table>

Table 3-4 • CSRAggregator Script Parameters

**DropIdentBeforeLoad.wsf Script**

The DropIdentBeforeLoad.wsf script deletes a specified identifier from the Ident.txt file. Consult IBM before using this script.
FTP.wsc and FTPSample.wsf Scripts

The FTP.wsc and FTPSample.wsf scripts assist in performing FTP transfers from a script.

ListUnusedIdentifiers.wsf

The ListUnusedIdentifiers.wsf script creates a list of identifiers in the CIMSDetailIdent table that are unused as of a specified date. You can use this script to determine identifiers that might be obsolete and then delete the obsolete identifiers using the DropIdentFromDB.wsf script (see page C-12).

The criteria for including an identifier in the list is based on the date entered for the DateSelection parameter as follows:

- If an identifier is contained in the CIMSDetailIdent table with usage end dates before and after the DateSelection date, the identifier is not included in the list.
- If an identifier is contained in the CIMSDetailIdent table with usage end dates before the DateSelection date only, the identifier is included in the list.

ListUnusedIdentifiers.wsf Script Parameters

The ListUnusedIdentifiers.wsf script uses the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>OutputFilename (required)</td>
<td>The full path and file name of the output list file.</td>
</tr>
<tr>
<td>DateSelection (required)</td>
<td>The date that you want to use to select identifiers.</td>
</tr>
<tr>
<td>DataSourceID (optional)</td>
<td>See Data Source Parameters on page C-42.</td>
</tr>
</tbody>
</table>

Table 3-6 • ListUnusedIdentifiers Script Parameters
**OracleLogonTrigger.bat Script**

The **OracleLogonTrigger.bat** script enables you to install a trigger (`logon_schema`) that changes a user's default schema to the schema for the ITUAM database at log on. When the user logs on to the database, the schema defined in the trigger rather than the default schema is used.

**Note** • You must also define the user and the schema in the Configure ITUAM Data Source Dialog box as described in *Enable Connection to the Oracle Database* on page 2-73.

The **OracleLogonTrigger.bat** script presents the following command line options that enable you to create, remove, and test the `logon_schema` trigger. Following each option is a description of the parameters that you are prompted to enter for that option.

<table>
<thead>
<tr>
<th>Option/Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1&gt;Create Oracle logon trigger</td>
<td>Calls the <code>logon_trigger_create.sql</code> script to install the trigger for a specified user.</td>
</tr>
<tr>
<td>Enter Oracle Database</td>
<td>If this prompt is displayed, type the TNS service name for the database.</td>
</tr>
<tr>
<td>Enter User ID for database</td>
<td>If this prompt is displayed, type a user ID for the database that has administrative privileges required to add or remove the trigger.</td>
</tr>
<tr>
<td>Password for user ID</td>
<td>If this prompt is displayed, type the password for the user ID.</td>
</tr>
<tr>
<td>Enter user to modify</td>
<td>Type the user that you want to create the trigger for.</td>
</tr>
<tr>
<td>New Schema for user</td>
<td>Type the new schema that you want to assign to the user.</td>
</tr>
<tr>
<td>2&gt;Remove Oracle logon trigger</td>
<td>Calls the <code>logon_trigger_drop.sql</code> script to remove the trigger for a specified user.</td>
</tr>
<tr>
<td>Enter Oracle Database, User ID, and Password (if prompted for)</td>
<td>See parameter descriptions for <code>logon_trigger_drop.sql</code> script.</td>
</tr>
<tr>
<td>Enter user to remove trigger from</td>
<td>Type the user that you want to remove the trigger from.</td>
</tr>
</tbody>
</table>

*Table 3-7  *OracleLogonTrigger Script Options and Parameters
Running the PLSQL Scripts Manually

You can execute any of the PLSQL scripts manually by typing the following at the appropriate command prompt (e.g., C:\Program Files\IBM\ITUAM\Scripts>).

**To create a trigger:**

```sql
sqlplus <user ID>/<password>@<database> @logon_trigger_create.sql <user> <schema>
```

- **user ID** = user ID used to install the trigger
- **password** = password for the user ID
- **database** = TNS service name for the database
- **user** = user you want to create the trigger for
- **schema** = new schema for the user
To remove a trigger:

sqlplus <user ID>/<password>@<database> @logon_trigger_drop.sql <user>

Where:
password = user ID used to remove the trigger
password = password for the user ID
database = TNS service name for the database
user = user you want to remove the trigger from

To test a trigger:

sqlplus <user>/<password>@<database> @logon_trigger_test.sql

Where:
user = user you want to test the trigger for
password = user’s password
database = TNS service name for the database

**ProRate.wsf Script**

The ProRate.wsf script is provided for backward compatibility. You should use the CIMSPrat program as described in *CIMS Data Collectors for Microsoft Windows Installation and User Guide*. 
PurgeLoads.wsf Script

**Important!** • This script permanently removes data from the CIMSSummary, CIMSDetail, CIMSDetailIdent, and CIMSResourceUtilization tables. Consult IBM before using this script.

The CIMSSummary, CIMSDetail, CIMSDetailIdent, and CIMSResourceUtilization tables can accumulate a large amount of data. To control the size of these tables, you can use the PurgeLoads.wsf script to delete loads that have accounting start and end dates within a specified date range. All data loaded to the database within this date range is removed permanently, not archived.

PurgeLoads.wsf Script Parameters

The PurgeLoads.wsf script uses the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
</table>
| StartDate and EndDate (required) | These parameters specify the date range for the loads that you want to delete from the tables. Any loads that have accounting start and end dates in this range are deleted. Valid values are:  
  - preday (previous day)  
  - premon (previous month)  
  - rndate (current day)  
  - curmon (current month)  
  - date in yyyymdd format or a format valid for your operating system’s regional settings  
  If you use the premon or curmon keyword for the start date or end date, the first day of the month is used for the start date and the last day of the month is used for the end date. |
| PurgeSummary, PurgeBillDetail, PurgeIdent, or PurgeAcctDetail (required) | These parameters specify whether the CIMSSummary, CIMSDetail, CIMSDetailIdent, or CIMSResourceUtilization tables are purged. If set to true, the table is purged. If set to false the table is not purged. |

Table 3-8 • PurgeLoads Script Parameters
### Scripts

**General Scripts**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>SkipConfirmation</td>
<td>If this parameter is set to false or is not provided, a message is displayed and confirmation is required before the script is run. If this parameter is set to true, the confirmation message is not displayed.</td>
</tr>
<tr>
<td>DataSourceID (optional)</td>
<td>See <em>Data Source Parameters</em> on page C-42.</td>
</tr>
</tbody>
</table>

*Table 3-8 • PurgeLoads Script Parameters (Continued)*
Rebill.wsf and ResourceConversion.wsf Scripts

**Important!** The following scripts change the data in the ITUAM database. You should back up the database before running these scripts.

You can recalculate rate codes that you previously processed and loaded into the ITUAM database using a different rate value or resource conversion factor without reprocessing the data. That is, if you change the rate value or resource conversion factor for a rate code in the CIMSRate table, you can update the rate value and conversion factor and recalculate the money value directly in the CIMSSummary table. (For more information about the rate code value and resource conversion factor, see *Working With Rates* on page 4-9.)

ITUAM includes the following scripts to perform this process:

- **Rebill.wsf.** This script updates the rate code value and recalculates the money value for a rate code or codes in the CIMSSummary table. If you have not changed the resource conversion factor for a rate code or codes, you do not need to run the ResourceConversion.wsf script.

- **ResourceConversion.wsf.** This script updates the rate code resource conversion factor in the CIMSSummary table. You must run the Rebill.wsf script after running this script to recalculate the money value for the rate code.

**Important!** Consult IBM before using the ResourceConversion.wsf script. If you run this script more than once for the same rate code or codes, the resource units that are converted are the units that were converted previously, not the original units. For example, if the conversion factor for a rate code is *Divide by 60* and the resource units are 120, the resource unit value after calculating once is 2, after calculating twice it is .033 (2 ÷ 60), etc.

This scenario is not applicable to the Rebill.wsf script—you can run this script multiple times for the same rate code or codes.
Rebill.wsf and ResourceConversion.wsf Script Parameters

The Rebill.wsf and ResourceConversion.wsf scripts use the following parameters.

### Rebill.wsf Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>StartDate and EndDate</strong></td>
<td>These parameters specify the date range for the records that contain the rate code or codes that you want to rebill. Typically, the start date is the first day of the month and the end date is the last day of the month. Valid values are:</td>
</tr>
<tr>
<td><strong>Parameter</strong></td>
<td><strong>Description/Values</strong></td>
</tr>
<tr>
<td><strong>StartDate and EndDate</strong></td>
<td><strong>(required)</strong></td>
</tr>
<tr>
<td><strong>RateCode</strong></td>
<td>The rate code or codes that you want to recalculate. If you want to recalculate all rate codes, set the parameter to All or do not include the parameter.</td>
</tr>
<tr>
<td><strong>RateTable</strong></td>
<td>The rate table that contains the rate code or codes that you want to recalculate.</td>
</tr>
<tr>
<td><strong>DataSourceID, ODBCUserID, and ODBCPassword</strong></td>
<td>See Data Source Parameters on page C-42.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RateCode</strong></td>
<td>The rate code or codes that you want to recalculate. If you want to recalculate all rate codes, set the parameter to All or do not include the parameter.</td>
</tr>
<tr>
<td><strong>RateTable</strong></td>
<td>The rate table that contains the rate code or codes that you want to recalculate. If this parameter is set to Client or is not provided, the CIMSClient table is read to determine the rate table for each client in the CIMSSummary table. If you provide a specific rate table name, for example STANDARD, that table is used for all clients in the CIMSSummary table.</td>
</tr>
</tbody>
</table>

**DataSourceID, ODBCUserID, and ODBCPassword** (optional) See Data Source Parameters on page C-42.

Table 3-9 • Rebill.wsf Script Parameters
ResourceConversion.wsf Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>StartDate and EndDate (required)</td>
<td>See the description for Rebill.wsf Parameters on page C-20.</td>
</tr>
<tr>
<td>RateCode (optional)</td>
<td>The rate code or codes that you want to change the resource conversion factor for. If you want to change the conversion factor for all rate codes, set the parameter to All, leave the parameter blank, or do not include the parameter. It is recommended that you do not use All as a parameter because all resources for rate codes with an specified resource conversion factor will be further factored by that value. That is, if a resource has already been factored, the resulting resource number, not the original resource number, will be factored again.</td>
</tr>
<tr>
<td>DecimalPositions (optional)</td>
<td>The number of decimal positions that you want to appear in the resource units that will be written out by the conversion. For example, if you want two decimal positions to appear in the converted resource units, set this parameter to 2. If you do not include this parameter, the default is four decimal positions.</td>
</tr>
<tr>
<td>DataSourceID, ODBCUserID, and ODBCPassword (optional)</td>
<td>See Data Source Parameters on page C-42.</td>
</tr>
</tbody>
</table>

Table 3-10 • ResourceConversion Script Parameters
SampleBulkUserLoad.wsf Script

The SampleBulkUserLoad.wsf script loads users into the CIMSUser table. A user group with the same name as the user ID is created in the CIMSUserGroup table.

**Note** • You should use this script to load users to a test database before loading to a production database.

To use this script you can:

- Customize this script to automatically gather and load the user information from another source such as a database. Contact IBM Software Support for assistance in customizing this script.

  Or

- Create comma-delimited client access and report access files for the users that provide the following information. The information must be provided in the order shown.

  **Client access file format**
  
  user ID, domain user ID, domain name, full name, client account code

  **Report acces file format**
  
  user ID, domain user ID, domain name, full name, report file name

  If you want to assign specific client account codes or reports to a user, include a separate line for each client/report. If you want to assign all client account codes and reports to the user, leave the client account code and report file name fields blank.

  Do not include the extension for the report file name (e.g., .rpt, .rdl, .xml).

**SampleBulkUserLoad.wsf Script Parameters**

The SampleBulkUserLoad.wsf script uses the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>InputClientAccessFileName</td>
<td>The full path and file name for the input file containing the client or clients for the user group.</td>
</tr>
<tr>
<td>InputReportAccessFileName</td>
<td>The full path and file name for the input file containing the report or reports for the user group.</td>
</tr>
<tr>
<td>AccountCodeStructureName</td>
<td>The account code structure to assign to the user if other than the Standard structure.</td>
</tr>
<tr>
<td>DataSourceID (optional)</td>
<td>See Data Source Parameters on page C-42.</td>
</tr>
</tbody>
</table>

Table 3-11 • SampleBulkUserLoad Script Parameters
SampleExportSummary.wsf Script

This script creates a file containing the data from the CIMSSummary table in a general format. Because this script requires modification for your organization to specify the output file format, the script must be renamed ExportSummary.wsf (or another name). Renaming the script prevents it from being overwritten when you upgrade to a new version of ITUAM.

SampleExportSummary.wsf Script Parameters

The SampleExportSummary.wsf script uses the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
</table>
| StartDate and EndDate    | These parameters specify the date range for the records that you want to export from the CIMSSummary table. Any records that have accounting start and end dates in this range are exported. Valid values are:  
  ■ preday (previous day)  
  ■ premon (previous month)  
  ■ rndate (current day)  
  ■ curmon (current month)  
  ■ date in yyyyMMdd format or a format valid for your operating system’s regional settings  
  If you use the premon or curmon keyword for the start date or end date, the first day of the month is used for the start date and the last day of the month is used for the end date. |
| OutputFilename (required) | The full path and file name for the output Summary file.                           |
| DataSourceID (optional)  | The ITUAM Data Source ID for the ITUAM database. See Data Source Parameters on page C-42. |

Table 3-12 • SampleExportSummary Script Parameters
SampleSQLMaintenance.bat Script

Note • This script supports SQL Server and MSDE only.

The purpose of the SampleSQLMaintenance.bat script is to ensure that your ITUAM database(s) are backed up and maintained on a regular schedule. This script is used to set up a database backup and maintenance routine if you do not have another method in place (see Managing ITUAM Data Sources and Setting the Database Recovery Model on page 6-5).

This script performs all standard SQL Server maintenance tasks, including:

- Ensures that the database is set to a Simple recovery model.
- Backs up the database.
- Deletes backups that are over two weeks old.
- Checks the database for errors with a CheckDB command and a check of the indexes and catalog.
- Performs an index rebuild.
- Updates the database statistics.
- Removes unused space in the database with a ShrinkDatabase command.
- Writes a log file called SQLMaintyyyymmddhhmm.txt that provides feedback from the SampleSQLMaintenance.bat script and distributes the file via e-mail.

Important Notes About the SampleSQLMaint.bat Script

- Because this script requires modification for your organization, the script must be renamed SQLMaintenance.bat (or another name) so that the file is not overwritten when you upgrade to a new version of ITUAM.
- By default, all users will be disconnected from the database while this script is running. You can change this default if necessary (see the Set DB to Single User step in the script).
- Depending on the size of your database, this script could run for minutes or hours. Typically, a 5 GB database will run for less than 1 hour.
- By default, the UserID and Password parameters are not used. The script assumes that you are using Windows authentication for the database and any values set for these parameters are ignored. It is preferable to use Windows authentication for the database so that the ID and password are not kept in the script.

If a user ID and password is required for the database:

- Remove the -E from every line in which it appears.
- Add -U followed by %userID% and -P followed by %password% to these lines. For example, -U %admin% -P %global%. 
For MSDE users:

- **The steps** Setting Recovery Model to Simple, Set DB to Single User, and Set Database back to Multi User return a warning message. These messages do not require any action.

**Setting Up the SampleSQLMaint.bat Script**

Modify the SampleSQLMaint.bat script as follows:

1. Set the correct values for the SQLServerInstallLocation, BackupDirectory, Database, Server, SMTPServer, and ToEmailAddress parameters.

   The SQLServerInstallLocation parameter defines the path for the SQL Server installation.

   The BackupDirectory parameter defines the path for the database backup. A folder with the same name as the database is automatically created using this path. The database backup is placed in this folder.

   The Database parameter defines the database name.

   The Server parameter defines the name of the server that contains the database.

   The SMTPServer parameter defines the name of the SMTP mail server that will be used to send the SQLMaintyyyyymmddhhmm.txt log file.

   The ToEmailAddress parameter defines the e-mail address that the log file is sent to.

2. Follow the remarks in the script to set the values required for the remaining lines in the script.

3. Save the modified script with the name SQLMaint.bat or choose another name.

4. Use Windows Task Schedular to run this script, preferably on a weekly basis on the weekend. To use Task Schedular, see To run a batch file from Task Scheduler: on page C-5.

5. If IIS is run from a server other than the server running this script, restart IIS.
Scripts

General Scripts

SaveDBSQLServer.wsf

Note • This script supports SQL Server only.

The SaveDBSQLServer.wsf enables you to easily send your database to IBM for troubleshooting purposes. This script automates the process of detaching the database, creating a zip file containing the .MDF and .LDF files, and then reattaching the database.

Note • You cannot use this script to detach the master database.

SaveDBSQLServer.wsf Script Parameters

The SaveDBSQLServer.wsf script uses the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServerName (required)</td>
<td>The name of the server that contains the database.</td>
</tr>
<tr>
<td>DatabaseName (required)</td>
<td>The name of the database.</td>
</tr>
<tr>
<td>ArchiveFilename</td>
<td>The full path and file name for the output zip file that contains the .MDF and .LDF files.</td>
</tr>
<tr>
<td>ODBCUserID and</td>
<td>The SQL Server user ID and password for the database (if required).</td>
</tr>
<tr>
<td>ODBCPassword (optional)</td>
<td></td>
</tr>
</tbody>
</table>

Table 3-13 • SaveDBSQLServer Script Parameters

Schedule.wsf

The Schedule.wsf script runs a script or program daily at a specified time.
**Table.wsf Script**

**WARNING** • This script loads tables in the ITUAM database. Extreme caution should be used when loading a table. Deleting or overwriting data can cause unexpected results. Be sure a backup exists before using this script.

The Table.wsf script loads the CIMSClient and CIMSRate tables from comma-delimited files. This script performs the same function as the Load Selected Tables option in the Chargeback Tables dialog box (see *Loading and Exporting Client and Rate Tables* on page 6-12).

The files must have the same name as the tables (i.e., CIMSClient.txt and CIMSRate.txt) and must be in the same comma-delimited format as a file that is exported from the table (including the column headers in the first record of the file).

For examples of the required formats for the files, you can export the CIMSClient and CIMSRate tables to files using the steps on page 6-12. For a description of the fields in the files, see *CIMSClient Table* on page A-14 and *CIMSRate Table* on page A-28.

**Table.wsf Script Parameters**

The Table.wsf script uses the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSVFilesFolderPath (required)</td>
<td>The full path for the folder that contains the CIMSClient.txt and CIMSRate.txt files.</td>
</tr>
<tr>
<td>DataSourceID (optional)</td>
<td>See <em>Data Source Parameters</em> on page C-42.</td>
</tr>
</tbody>
</table>

Table 3-14 • Table Script Parameters
ZeroCost.wsf Script

The ZeroCost.wsf script recalculates the money values in the CIMSSummary table for a rate code among all accounts using a specified amount. For example, if you specify a zero cost amount of $100,000 for the rate code DISKSIZE, the resource usage for this rate code for all accounts will be factored to this amount and a new CSR file is written.

ZeroCost.wsf Script Parameters

The ZeroCost.wsf script uses the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>OutputFilename (required)</td>
<td>The full path and file name for the output CSR file.</td>
</tr>
<tr>
<td>StartDate and EndDate (required)</td>
<td>These parameters specify the date range for the records in the CIMSSummary table that contain the rate code that you want to recalculate.</td>
</tr>
<tr>
<td></td>
<td>Valid values are:</td>
</tr>
<tr>
<td></td>
<td>- preday (previous day)</td>
</tr>
<tr>
<td></td>
<td>- premon (previous month)</td>
</tr>
<tr>
<td></td>
<td>- rndate (current day)</td>
</tr>
<tr>
<td></td>
<td>- cur mon (current month)</td>
</tr>
<tr>
<td></td>
<td>- date in yyyyymmdd format</td>
</tr>
<tr>
<td></td>
<td>If you use the premon or cur mon keyword for the start date or end date, the first day of the month is used for the start date and the last day of the month is used for the end date.</td>
</tr>
<tr>
<td>ZeroCostAmount</td>
<td>The amount by which you want to factor the money values for the rate codes. You can enter the amount with or without decimals, but do not include commas or currency symbols.</td>
</tr>
<tr>
<td>AdjustmentRateCode</td>
<td>The rate code that you want to apply the zero cost value to.</td>
</tr>
<tr>
<td>DataSourceID, ODBCUserID,</td>
<td>The ITUAM Data Source ID for the ITUAM database. See Data Source Parameters on page C-42.</td>
</tr>
<tr>
<td>and ODBCPassword (optional)</td>
<td></td>
</tr>
</tbody>
</table>
Batch Reporting Scripts

ITUAM includes the following scripts for creating and distributing batch reports. These scripts are described in detail in the following sections. If you installed ITUAM in the default location, these scripts are in C:\Program Files\IBM\ITUAM\Scripts\Batch Reporting.

- **ReportDistribution.wsf**. This script automates the process of creating and distributing published reports. This script calls the BatchReport.wsf to create the reports and the EmailDistribution.wsf script to distribute the reports via a link or attachment in an e-mail message.

- **BatchReport.wsf**. This script automates the process of creating published reports and directs the reports to the proper location in the Published folder. You can run this script independently of the ReportDistribution.wsf script; however, BatchReport.wsf does not call EmailDistribution.wsf to provide e-mail report distribution.

  In addition, the ReportDistribution.wsf script automatically processes the definitions in a specified report cycle and creates the report parameters file required by the BatchReport.wsf script. If you do not use the ReportDistribution.wsf script, you must create the parameters file manually or use the optional AllAccts.wsf script to create the file.

- **AllAccts.wsf**. This script produces files that contain the report parameters used by the BatchReport.wsf script. If you are using the ReportDistribution.wsf script, this script is not applicable. If you are running the BatchReport.wsf script directly, this script is optional—you can create the report parameter files without using this script.

- **EmailDistribution.wsf**. This script automates the process of distributing reports via e-mail.

- **ReportParms.wsf**. This script is for use by IBM.

If you run these scripts on a computer other than the computer that contains the ITUAM reporting folders (Custom, Standard, and Published), you must perform the following steps:

1. Create a share for each of the folders. Set the folder share permission to Full Control for the Windows user account or accounts that are publishing the report.

2. Define the path for each folder as a UNC path in the Configuration dialog box (see Reporting Settings on page 4-44).

3. Restart IIS on the Web server (see page 11-5).

4. Run a report on the ITUAM Web Reporting Web site to make sure that the report paths are set up correctly.
**ReportDistribution.wsf Script**

The ReportDistribution.wsf script publishes all reports defined for a report cycle and distributes the resulting reports as a link or attachment in an e-mail message.

The ReportDistribution.wsf script uses the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cycle (required)</td>
<td>The name of the report cycle that you want to run.</td>
</tr>
</tbody>
</table>
| LogFolder (required) | This parameter defines the location of the following output files produced by this script:  
  - A file that logs the batch reporting process.  
  - A report parameters file used by the BatchReport.wsf script.  
  The log file is automatically assigned the file name YYYYMMDDHHMM.txt and the report parameters file is assigned the file name InputYYYYMMDDHHMM.txt. |
| DataSourceID (optional) | The ITUAM Data Source ID for the database that you want to use for reporting. See Data Source Parameters on page C-42. |
| Email (optional) | This parameter is helpful in testing or other situations in which you want to publish reports but do not want to distribute the reports via e-mail or you want to send an e-mail for reports that have already been published. Valid values are:  
  - Trial. An e-mail message is not sent, but reports are published.  
  - Only. An e-mail is sent, but reports are not published. The e-mail contains a link to the previously published report. |
| Silent (optional) | If this parameter is set to Y, no messages are displayed when the ReportDistribution.wsf script is run. If this parameter is set to N or is not provided, interactive messages are displayed and you must click OK to continue. |
| Debug (optional) | If this parameter is set to Y, debugging information is included in the log file. If this parameter is set to N or is not provided, this information is not included in the log file. |

Table 3-16 • ReportDistribution Script Parameters
BatchReport.wsf Script

The BatchReport.wsf script generates published reports and places the reports in the proper location in the Published folder. This script is called by the ReportDistribution.wsf script.

The BatchReport.wsf requires the following input:

- The report parameters file described in About the Report Parameters File.

About the Report Parameters File

The BatchReport.wsf script requires a file containing the parameters for the report(s) that you want to publish. If you are using the ReportDistribution.wsf script to run the batch reporting process, this file is created automatically using the definitions in the report cycle.

If you are not using the ReportDistribution.wsf script, you can create this file manually or you can use the AllAccts.wsf script to create the file (see AllAccts.wsf Script on page C-38).

One file may contain the parameters required to run multiple reports. ITUAM includes sample report parameters files for running a single report (input1.txt) and multiple reports (input2.txt). These files are in the Batch Reporting folder. To use these files to publish sample reports, follow the steps in the readme.txt file.

Any line in the report parameter file that begins with an asterisk (*) or does not include an equal sign (=) is considered a comment.

The parameters listed in Table 3-17 are used for the standard reports included in the ITUAM installation. The parameters required differ by report. (For a description of each of these reports and their required parameters, refer to the IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide). The parameters for custom reports used by your organization might differ.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOCALDRIVE=</td>
<td>If you are running the BatchReport.wsf script on a computer other than the Web server, the drive that you are mapping to that contains the ITUAM Reports folder. Example: LOCALDRIVE=W</td>
</tr>
</tbody>
</table>

Table 3-17 • Batch Report Parameters
To enable drill down within published invoices, set the following three parameters as required for your organization. For more information about drilling down in reports, refer to the *IBM Tivoli Usage and Accounting Manager Web Reporting User's Guide*.

**RUNSERVERNODE=**

The name of the server running the ITUAM Web Reporting Web site. For more information about drilling down in reports, refer to the *IBM Tivoli Usage and Accounting Manager Web Reporting User's Guide*.

**Example:**

```
RUNSERVERNODE=SERVERABC
```

**RUNPORTNUMBER=**

If the port number for the Web site if it is other than port 80.

**Example:**

```
RUNPORTNUMBER=81
```

**RUNVIRTUALDIRECTORY=**

The virtual directory name of the ITUAM Web Reporting Web site.

**Example:**

```
RUNVIRTUALDIRECTORY=DIRECTORYABC
```

The **RUNreporttype=** parameters indicate the beginning of a new report to be published. These parameters can be in any order, but cannot precede the run parameters described previously.

The report specified by the **RUNreporttype=** parameter must be a Crystal Report in the Custom or Standard report folder.

For an example parameter file for multiple reports, refer to the file `input2.txt` in the Batch Reporting folder.

**RUNREPORT=**

The file name of the report that you want to publish. If want to publish an invoice that provides invoice numbers, use the **RUNINVOICE** parameter.

**Example:**

```
RUNREPORT=XSUMC001.rpt
```

**RUNINVOICE=**

If you want to publish an invoice that provides invoice numbers, that is, Invoice by Account Level, Invoice with Shifts, etc., use this parameter to specify the file name of the invoice.

**Example:**

```
RUNINVOICE=RINVC007.rpt
```

**RUNSPREADSHEET=**

The file name of the spreadsheet that you want to publish.

**Example:**

```
RUNSPREADSHEET=SYTDC001.rpt
```

**RUNPDF=**

This parameter enables you to publish a report or spreadsheet as a PDF file. For example, if you want to publish the Invoice by Account Level report as a PDF, specify **RUNPDF=RINVIC007.rpt**.

### Table 3-17  •  Batch Report Parameters (Continued)
Scripts

Batch Reporting Scripts

### Parameter Description/Values

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACCOUNTSTRUCTURE= (optional)</td>
<td>The name of the account code structure to be used for the report. If you are using the account code structure Standard, this parameter is not required. If you are not using the Standard account code structure, this parameter is required after the RUNREPORTYPE= parameter. Note that you can use more than one account code structure in the parameter file. The BatchReport.wsf script will use the first account structure specified or the Standard structure until it encounters another ACCOUNTSTRUCTURE= parameter. Each time the script encounters a different parameter it will use that parameter. If the account code structure varies by report, you must specify Standard as a parameter if it follows a different ACCOUNTSTRUCTURE= parameter. <strong>Examples:</strong> ACCOUNTSTRUCTURE=Standard ACCOUNTSTRUCTURE=DivisionA</td>
</tr>
<tr>
<td>RUNDATESTART= and RUNDATEEND= (required depending on report)</td>
<td>The start and end dates for the data in the report in the format mm/dd/yyyy. All reports within the report parameter file use these parameters until another set of RUNDATESTART and RUNDATEEND parameters or another date parameter (see the following) is encountered. These parameters must be placed before the RUNreporttype= parameters. For an example, refer to the file input2.txt in the Batch Reporting folder. <strong>Example:</strong> RUNDATESTART=07/01/05 RUNDATEEND=07/31/05</td>
</tr>
<tr>
<td>REPORTMONTH= (required depending on report)</td>
<td>The month for the data in the report in the format mm. <strong>Example:</strong> REPORTMONTH=07</td>
</tr>
<tr>
<td>REPORTYEAR= (required depending on report)</td>
<td>The year for the data in the report in the format yyyy. <strong>Example:</strong> REPORTYEAR=2006</td>
</tr>
<tr>
<td>USER= (required)</td>
<td>The user ID used to execute the report. The report will contain only those clients that are assigned to the user’s user group (see Adding or Removing Client Access to/from a Group on page 4-37). If you have restricted client access for some users, make sure that you do not execute the report using a user ID that can view all clients. <strong>Example:</strong> USER=admin</td>
</tr>
</tbody>
</table>

**Table 3-17 • Batch Report Parameters (Continued)**
**Scripts**

*Batch Reporting Scripts*

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEST=</td>
<td>The report must be saved in the published reports folder specified on the Reports tab in the Configuration dialog box see Reporting Settings on page 4-44. This parameter specifies the destination location of the report as follows:</td>
</tr>
<tr>
<td></td>
<td>DEST=GLOBAL. The report will be stored in the global subfolder in the published reports folder.</td>
</tr>
<tr>
<td></td>
<td>DEST=GROUP=group id. The report will be stored in a subfolder with the same name as the group id in the group subfolder in the published reports folder. For example, the destination for DEST=GROUP=Admin would be .../group/Admin.</td>
</tr>
<tr>
<td></td>
<td>DEST=USER=user id. The report will be stored in a subfolder with the same name as the user id in the user subfolder in the published reports folder. For example, the destination for DEST=USER=joe would be .../group/joe.</td>
</tr>
<tr>
<td></td>
<td>DEST=ACCOUNT=account code. The report will be stored in a subfolder with the same name as the account code in the account subfolder in the published reports folder. For example, the destination for DEST=ACCOUNT=AA would be .../account/AA.</td>
</tr>
<tr>
<td>REPORTPERIOD=</td>
<td>Published reports are further stored in a subfolder indicating the report period. For example, .../account/AA/200607 (July 2006 if you are using the default CIMSCalendar table). The report period is in YYYYMM format. If this parameter is not provided or is left blank, the folder name defaults to the current period.</td>
</tr>
<tr>
<td></td>
<td>The report period can be any date. It does not have to reflect the dates of the data in the report.</td>
</tr>
<tr>
<td></td>
<td>Depending on the report type specified by the RUNREPORT/INVOICE/SPREADSHEET= parameter, a subfolder named Reports or Spreadsheets is automatically created in the report period folder. The published reports reside in this folder. For example, the path for a published Invoice by Account Level report might be: .../Published/account/AA/200607/Reports/rinv007.rpt.</td>
</tr>
<tr>
<td></td>
<td>Example: REPORTPERIOD=200607</td>
</tr>
</tbody>
</table>

Table 3-17 • Batch Report Parameters (Continued)
Scripts

Batch Reporting Scripts

### NAME=

The file name that you want to assign to the report. The report is saved with the extension .rpt.

If this parameter is not provided or is left blank, the name defaults to the file name specified by the RUNREPORT/INVOICE/SPREADSHEET= parameter.

Note that if you assign a new file name, the report will not be included in the end user's favorite reports list in ITUAM Web Reporting. For more information about favorite reports, refer to the *IBM Tivoli Usage and Accounting Manager Web Reporting User's Guide*.

**Example:** NAME=AccountLevelInvoice

Some invoice reports contain separate invoices for the account codes selected. The first invoice number is read from the CIMSConfigOptions table. This number is set in the in the Configuration dialog box (see Invoice Subtab on page 4-46).

The invoice numbers continue to increase sequentially in the table each time you run an invoice. For example, if the last invoice in a report was 99, the next invoice that you run will begin with invoice number 100.

If you do not want to use the invoice number in the table when you run the BatchReport.wsf script, use the INVOICENUMBER= parameter.

### INVOICENUMBER=

This parameter sets the number at which you want invoice numbers within the report to begin. Invoices numbers increase in sequential order from this number.

The invoice number in the CIMSConfigOptions table is not used or changed when this parameter is used.

**Example:** INVOICENUMBER=10

### INVOICELEVEL=

A number representing the account code level that you want to view in the report. For example, the account code AABBBBCC might contain three levels: the company code AA, the division code AABBBB, and the department code AABBBBCC. The resource usage and charge data will reflect the level that you specify—1, 2, or 3.

**Example:** INVOICELEVEL=2

### ACCOUNTCODESTART = and ACCOUNTCODEEND=

This parameter works in conjunction with the InvoiceLevel parameter (see the following) and specifies the account codes for that level that are displayed in the report. For example, if INVOICELEVEL=2 and you want data for account codes ABBBBB, BBBBBB, CCBBBB, and DDBBBB, enter AA as the starting account code and DD as the ending account code.

---

**Table 3-17 • Batch Report Parameters (Continued)**
### Batch Report Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
</table>
| GRAPH= (optional) | If this parameter is Y a graph is displayed before the report. If this parameter is N, is left blank, or is not provided, the graph is not displayed.  
**Example:** GRAPH=Y |
| IDENTIFIER= (required for some reports) | The identifier that you want to report data by.  
**Example:** IDENTIFIER=JOBNAME |
| RATECODE= (required for some reports) | The rate code that you want to report data by.  
**Example:** RATECODE=Z003 |
| RATEGROUP= (required for some reports) | The rate group that you want to report data by.  
**Example:** RATERGROUP=Oracle charges |
| PRORATE= (required for some reports) | The amount that you want to prorate across accounts in proration reports.  
**Example:** PRORATE=3000 |
| TERMINALIDSTART= and TERMINALIDEND= (required for some reports) | The CICS terminal ID range that you want to report data by.  
For example, if you want data for the terminal IDs 3191, 3C02, and 8A33, enter 3191 as the starting transaction ID and 8A33 as the ending ID. Numbers precede letters in the range order. Therefore, 3191 precedes 3C02. |
| TOPN= (optional) | The number of account codes that are displayed in a report or the drill down for a report. For example, if you enter 1, only the account code that used the most resources or incurred the most charges is displayed. If you enter 2, the highest and second highest account codes are displayed.  
**Example:** TOPN=3 |
| TRANSACTIONTYPE= (required for some reports) | The transaction type that you want to report data by. For more information about transactions, refer to the IBM Tivoli Usage and Accounting Manager Web Reporting User’s Guide.  
**Example:** TRANSACTIONTYPE=Recurring |
Batch Reporting Scripts

The BatchReport.wsf script uses the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input (required)</td>
<td>The file that contains the parameters needed to process the report.</td>
</tr>
<tr>
<td></td>
<td>(see About the Report Parameters File on page C-31).</td>
</tr>
<tr>
<td>DataSourceID (optional)</td>
<td>The ITUAM Data Source ID for the ITUAM database.</td>
</tr>
<tr>
<td></td>
<td>(see Data Source Parameters on page C-42).</td>
</tr>
<tr>
<td>Silent (optional)</td>
<td>If this parameter is set to Y, no messages are displayed when the BatchReport.wsf</td>
</tr>
<tr>
<td></td>
<td>script is run. If this parameter is set to N or is not provided, interactive</td>
</tr>
<tr>
<td></td>
<td>messages are displayed and you must click OK to continue.</td>
</tr>
<tr>
<td>Debug (optional)</td>
<td>If this parameter is set to Y, debugging information is included in the log file.</td>
</tr>
<tr>
<td></td>
<td>If this parameter is set to N or is not provided, this information is not included</td>
</tr>
<tr>
<td></td>
<td>in the log file.</td>
</tr>
</tbody>
</table>

Table 3-18 • BatchReport Script Parameters
Scripts

Batch Reporting Scripts

AllAccts.wsf Script

Note • If you are using the ReportDistribution.wsf script, this script is not applicable.

This script produces the report parameters files that are used by the BatchReport.wsf to publish reports in batch. The primary purpose of this script is to retrieve the account codes associated with a user from the database and to create the parameters required to run a separate report for each account code.

You can create the report parameters file without using the AllAccts.wsf script. In addition, the script does not provide all required parameters for some reports. To create a report parameters file or to add parameters to a file created by the AllAccts.wsf script, see About the Report Parameters File on page C-31.

The AllAccts.wsf script requires an input file to determine the content of the report parameters file. The parameters for this input file are described in Input File Parameters. The parameters required process the input file are described in AllAccts.wsf Script Parameters on page C-40.

Input File Parameters

To specify the parameters that you want to appear in the report parameter file, create an input file containing the parameters shown in Table 3-19. You can add the parameters in any order.

You can include other parameters in the input file, but only the parameters in Table 3-19 are used by the AllAccts.wsf script. Any other parameters are passed to the report parameters file.

Any line in the input file that begins with an asterisk (*) or does not include an equal sign (=) is considered a comment.

ITUAM includes a sample input file, input3.txt, that you can use to create a report parameter file. If you installed ITUAM in the default location, this file is in C:\Program Files\IBM\ITUAM\Scripts\Batch Reporting. Follow the steps in the readme.txt file.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOCALDRIVE=(optional)</td>
<td>If you are running the AllAccts.wsf script on a computer other than the Web server, the drive that you are mapping to that contains the ITUAM Reports folder. Example: LOCALDRIVE=W</td>
</tr>
<tr>
<td>ACCOUNTSTRUCTURE=(required)</td>
<td>The name of the account code structure to be used (see Defining the Account Code Structure on page 4-4). Example: ACCOUNTSTRUCTURE=Standard</td>
</tr>
</tbody>
</table>

Table 3-19 • Allacct.wsf Input File Parameters
### Batch Reporting Scripts

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>USER=</td>
<td>The user ID. Only those account codes to which the user has access are included in the report parameter file (see Adding or Removing Client Access to/from a Group on page 4-37). (required)</td>
</tr>
<tr>
<td>INVOICELEVEL=</td>
<td>A number representing the account code level that you want to view in the report. For example, the account code AABBBBCCCC might contain three levels: the company code AA, the division code AABBBB, and the department code AABBBBCCCC. The resource usage and charge data will reflect the level that you specify—1, 2, or 3. (required)</td>
</tr>
<tr>
<td>RUNREPORT=</td>
<td>The file name of the report that you want to publish. (required)</td>
</tr>
<tr>
<td>RUNINVOICE=</td>
<td>If you want to publish an invoice that provides invoice numbers, that is, Invoice by Account Level, Invoice with Shifts, etc., use this parameter to specify the file name of the invoice. (required)</td>
</tr>
<tr>
<td>RUNSPREADSHEET=</td>
<td>The file name of the spreadsheet that you want to publish. (required)</td>
</tr>
</tbody>
</table>

**Example:**
- **INVOICELEVEL=2**
- **RUNREPORT=** XSUMC001.rpt
- **RUNINVOICE=** RINVC007.rpt
- **RUNSPREADSHEET=** SYTDC001.rpt

---

Table 3-19 • Allacct.wsf Input File Parameters (Continued)
AllAccts.wsf Script Parameters

The AllAccts.wsf script uses the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>InputFile</td>
<td>The file that contains the parameters needed to create the report parameters file used by the BatchReport.wsf script (see About the Report Parameters File on page C-31).</td>
</tr>
<tr>
<td>OutputFile</td>
<td>The output report parameters file.</td>
</tr>
<tr>
<td>LogFolder</td>
<td>The full path for the output file that logs the process of creating the report parameters file. The file name is YYYYMMDDHHMM.txt.</td>
</tr>
<tr>
<td>DataSourceID, ODBCUserID, and ODBCPassword (optional)</td>
<td>See Data Source Parameters on page C-42.</td>
</tr>
<tr>
<td>Debug (optional)</td>
<td>If this parameter is set to Y, debugging information is included in the log file. If this parameter is set to N or is not provided, this information is not included in the log file.</td>
</tr>
</tbody>
</table>

Table 3-20 • AllAccts Script Parameters

EmailDistribution.wsf Script

The EmailDistribution.wsf script distributes all reports defined for a report cycle as a link or attachment in an e-mail message.

The EmailDistribution.wsf script uses the following parameters. These parameters are passed from the ReportDistribution.wsf script.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cycle</td>
<td>The name of the report cycle that is used.</td>
</tr>
<tr>
<td>DataSourceID</td>
<td>See Data Source Parameters on page C-42.</td>
</tr>
<tr>
<td>Silent (optional)</td>
<td>If this parameter is set to Y, no messages are displayed when the EmailDistribution.wsf script is run. If this parameter is set to N or is not provided, interactive messages are displayed and you must click OK to continue.</td>
</tr>
<tr>
<td>Debug (optional)</td>
<td>If this parameter is set to Y, debugging information is included in the log file. If this parameter is set to N or is not provided, this information is not included in the log file.</td>
</tr>
</tbody>
</table>

Table 3-21 • EmailDistribution Script Parameters
Client Load Scripts

The scripts described in this section are used to load the CIMSClient table. If you installed ITUAM in the default location, these scripts are in C:\Program Files\IBM\ITUAM\Scripts\Client Load.

LoadClientTableFromCSVFile.wsf Script

The LoadClientTableFromCSVFile.wsf script is provided for backward compatibility. You should use the Table.wsf script (see page C-29).

Data Source Parameters

The following optional data source parameters are common to many of the scripts described in this chapter.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description/Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>DataSourceID</td>
<td>The ITUAM Data Source ID for the database that you want to use with the script. If this parameter is not provided, the data source that is set as the Web/collector default in the ITUAM Data Source Maintenance dialog box is used (see page 6-6). To use an ITUAM Data Source other than the default, set this parameter to the appropriate data source ID.</td>
</tr>
<tr>
<td>ODBCUserID and ODBCPassword</td>
<td>These parameters are deprecated for most scripts. They were previously used to pass the SQL Server user ID and password for the database (if required). For security and convenience, the user ID and password are retrieved using the ITUAM Data Source in ITUAM Administrator.</td>
</tr>
</tbody>
</table>

Table 3-22 • Common ODBC Parameters
Control and Processing Statements

This chapter describes the control statements used by ITUAM Processing Engine. The statements are presented by the operating system on which ITUAM Process Engine is run.

**ITUAM Processing Engine Control Statements (Windows) ..................D-2**
- CIMSAcct Control Statements .................................................. D-2
- CIMSBill Control Statements .................................................... D-13
- Processing Control Statements ................................................. D-24

**ITUAM Processing Engine Control Statements (UNIX or Linux) ........... D-26**
- CIMSAcct Control Statements .................................................. D-26
- CIMSBill Control Statements .................................................... D-35
ITUAM Processing Engine Control Statements (Windows)

This section describes the statements in the AcctCntl.txt, BillCntl.txt, and ProcessCntl.txt files.

CIMSAcct Control Statements

This section describes control statements that you can use in the CIMSAcct Control file, AcctCntl.txt. By default, the control statements in the control file reflect the process definition settings in ITUAM Administrator (see Setting Process Definition Options on page 7-23). However, some optional statements do not have a corresponding GUI option and must be entered in the control file manually.

Where applicable, the control statement descriptions in this section include a reference to the corresponding option in ITUAM Administrator.

Note • Control statements are not case-sensitive, except for the literals in the DEFINE MOVEFLD statement (see page D-7).

<table>
<thead>
<tr>
<th>CONTROL STATEMENT</th>
<th>SEE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACCOUNT CODE CONVERSION</td>
<td>[page D-3]</td>
<td>Specifies processing of the account code conversion table.</td>
</tr>
<tr>
<td>ACCOUNT FIELD</td>
<td>[page D-4]</td>
<td>Defines how to build the account code from the identifiers within the input file record.</td>
</tr>
<tr>
<td>DATE SELECTION</td>
<td>[page D-5]</td>
<td>Defines a date range for records to be processed by CIMSAcct.</td>
</tr>
<tr>
<td>DEFINE FIELD</td>
<td>[page D-6]</td>
<td>Used only during account code conversion. Defines the fields for comparison within the account code input field (which is built from the ACCOUNT FIELD statements or from the identifier Account_Code).</td>
</tr>
<tr>
<td>DEFINE MOVEFLD</td>
<td>[page D-7]</td>
<td>Used only during account code conversion. Defines the fields that are to be moved from the account code input field (which is built from the ACCOUNT FIELD statements or from the identifier Account_Code) to the account code output field.</td>
</tr>
</tbody>
</table>
ACCOUNT CODE CONVERSION

Related interface option: Perform Account Code Conversion, see page 7-43.

Format:

ACCOUNT CODE CONVERSION

This statement enables account code conversion using and DEFINE FIELD and DEFINE MOVEFLD statements and the account code conversion table.

When account code conversion is enabled, all no-match records are written to the CIMSAcct Detail file with the unconverted account code input field value. If you want the record written to an exception file for later processing, you must add the control statement Exception File Processing On.

<table>
<thead>
<tr>
<th>CONTROL STATEMENT</th>
<th>SEE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXCEPTION FILE PROCESSING ON</td>
<td>[page D-8]</td>
<td>Used only during account code conversion. When present, any record that does not match an entry in the account code conversion table is written out to the exception file.</td>
</tr>
<tr>
<td>IGNORE ORIGINAL SOURCE IDENTIFIERS</td>
<td>[page D-8]</td>
<td>Specifies that CIMSAcct does not write the identifiers SourceName and SourceLine to the Ident file.</td>
</tr>
<tr>
<td>INCLUDE FIELD</td>
<td>[page D-9]</td>
<td>Moves identifiers into an area that is used by CIMSBill for include/exclude processing.</td>
</tr>
<tr>
<td>PROCESS</td>
<td>[page D-9]</td>
<td>Specifies the type of data that is contained in the input file. CIMSAcct can process only one type of data at a time.</td>
</tr>
<tr>
<td>PRINT ACCOUNT NO-MATCH</td>
<td>[page D-10]</td>
<td>Prints the first 1000 input identifiers that are not matched during account code conversion.</td>
</tr>
<tr>
<td>SHIFT</td>
<td>[page D-10]</td>
<td>Sets up the shifts within the system.</td>
</tr>
<tr>
<td>UPPERCASE ACCOUNT FIELDS</td>
<td>[page D-11]</td>
<td>Specifies that the account code built from the account code input field is uppercase.</td>
</tr>
<tr>
<td>VERIFY DATA</td>
<td>[page D-12]</td>
<td>Specifies whether CIMSAcct is to check for embedded nulls.</td>
</tr>
</tbody>
</table>
ACCOUNT FIELD

Related interface option: Account Fields, see page 7-41.

Format:

```
ACCOUNT FIELDn,identifier_name,offset_into_identifier,length
```

- \( n = 0-9 \) (up to 10 ACCOUNT FIELD statements supported)
- \( \text{offset_into_identifier} = 1-255 \)
- \( \text{length} = 1-128 \)

Note • Although the maximum number of characters for each account field is 128, the overall length of all account fields added together cannot exceed 128 characters.

Also, keep in mind that the total output account code, including any literals and move field values, cannot exceed 128 bytes.

This statement defines the identifier(s) that you want to use to build the account code. Begin at \( \text{ACCOUNT FIELD0} \) and continue sequentially as needed. The account fields are used (along with \text{DEFINE FIELD} and \text{DEFINE MOVEFLD} statements) in account code conversion if account code conversion is enabled. If account code conversion is not enabled, then the account code is built directly from this statement or from the \text{Account_Code} identifier in the input file records (if present). For more information, see \text{Defining the Account Code} on page 7-41.

Example:

```
ACCOUNT FIELD0,UserName,1,10
ACCOUNT FIELD1,Division,1,2
```

In this example, the \text{UserName} and \text{Division} identifiers will be used to create the account code. The offset for both identifier values is 1 and the length of the values are 10 and 2, respectively.

If the \text{UPPERCASE ACCOUNT FIELDS} statement is specified, lowercase identifier values in the account field are converted to uppercase values.
DATE SELECTION

Related interface option: Input—Date Selection, see page 7-27.

Format:

DATE SELECTION (YYYYMMDD YYYYMMDD | keyword)

This statement defines a date range for records to be processed by CIMSAccnt. Records are selected by the end date in the record (either the usage end date or the accounting end date, depending on the record type). You can use the following values:

- From and to dates. For a record to be selected, it must be greater than or equal to the from date and less than or equal to the to date.

  or

- One of the following keywords:

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>**RNDATE</td>
<td>Selects records based on the run date</td>
</tr>
<tr>
<td>**CURDAY</td>
<td>Selects records based on the run date and the run date less one day</td>
</tr>
<tr>
<td>**CURWEK</td>
<td>Selects records based on the run week (Sun–Sat)</td>
</tr>
<tr>
<td>**CURMON</td>
<td>Selects records based on the run month</td>
</tr>
<tr>
<td>**PREDAY</td>
<td>Selects records based on the run date, less one (day)</td>
</tr>
<tr>
<td>**PREWEK</td>
<td>Selects records based on the previous week (Sun–Sat)</td>
</tr>
<tr>
<td>**PREMON</td>
<td>Selects records based on the previous month</td>
</tr>
<tr>
<td>CURRENT</td>
<td>Selects current period from the CIMSCalendar table</td>
</tr>
<tr>
<td>PREVIOUS</td>
<td>Selects previous period from the CIMSCalendar table</td>
</tr>
</tbody>
</table>

The start and end dates of data processed through ITUAM must reflect the start and end dates of the target billing period. If the billing period runs from January 1 through January 31, any records produced with a date of February 1 (or later) should not be included as part of the processing. In most cases, this data screening has already been performed, either by ITUAM or through the creation of data inputs reflecting the desired date range.

Note that it is rare that you would need to limit the date range of the data used as input to CIMSAccnt. CIMSBill provides the ability to create billing records reflecting a specific date range (see page D-15).

Examples:

DATE SELECTION 20060601 20060630

DATE SELECTION **PREMON
**DEFINE FIELD**

Related interface option: Define Fields, see page 7-43.

**Format:**

`DEFINE FIELDe,offset,length`

- `n = 0–9` (up to 10 DEFINE FIELD statements supported)
- `offset = 1–128` (from the start of the account field or the Account_Code identifier value)
- `length = 1–128`

**Note** • Although the maximum number of characters for each define field is 128, the overall length of all define fields added together cannot exceed 128 characters.

Also, keep in mind that the total output account code, including any literals and move field values, cannot exceed 128 bytes.

This statement is used only during account code conversion. Use this statement to specify the offset and length of the account code input field value that you want to use for conversion. Begin at `DEFINE FIELDO` and continue sequentially as needed.

For more information about using define fields, see *To set the account code conversion options:* on page 7-43.

**Example:**

```
ACCOUNT FIELDO,UserName,1,10
ACCOUNT FIELD1.Division,1,2
DEFINE FIELDO,3,8
DEFINE FIELD1,11,2
```

In this example, the first two characters of `ACCOUNT FIELDO` will not be considered for account code conversion as specified by the offset of 3 for `DEFINE FIELDO`. However, the full value of `ACCOUNT FIELD1` will be used because the offset for `DEFINE FIELD1` is 11 (the Division identifier value starts in position 11 of the combined account fields) and the length for both the account field and define field are the same.

For example, if the combined value for `ACCOUNT FIELDO` and `ACCOUNT FIELD1` is `AABBCCDDEExZ`, the value as defined by the `DEFINE FIELDO` and `DEFINE FIELD1` is `BBCCDDEExZ`.

**DEFINE MOVEFLD**

Related interface option: Move Fields, see page 7-43.

**Format:**

```
DEFINE MOVEFLDn,offset,length,literal
```

- \( n = 0-9 \) (up to 10 DEFINE MOVEFLD statements supported)
- \( \text{offset} = 1-128 \) (from the start of the account field or the Account_Code identifier value)
- \( \text{length} = 1-128 \)
- \( \text{literal} = \) a literal can be moved instead of a particular field (literals in this statement are case-sensitive)

**Note** • Although the maximum number of characters for each move field is 128, the overall length of all move fields added together cannot exceed 128 characters.

Also, keep in mind that the total output account code, including any literals and move field values, cannot exceed 128 bytes.

This statement is used only during account code conversion. Use this statement to move all or a portion of the account code input field value to a position in the output account code. Begin at DEFINE MOVEFLD0 and continue sequentially as needed.

Targets within the account code conversion table are specified as @0–@9.

For more information about using move fields, see To set the account code conversion options: on page 7-43.

**Example:**

```
ACCOUNT FIELD0,UserName,1,10
ACCOUNT FIELD1,Division,1,2
DEFINE FIELD0,3,8
DEFINE FIELD1,11,2
DEFINE MOVEFLD0,11,2
```

In this example, the value for DEFINE MOVEFLD0 specifies that the value beginning at position 11 account code input field will be placed in the output account code as defined by the account code conversion table.

For example, if the 2-character value beginning at position 11 is XZ and the account code conversion table is:

```
BBC,,FINACCT@0
```

The resulting account code will be FINACCTXZ.

For more information about the account code conversion table, see Creating an Account Code Conversion Table on page 7-45.
EXCEPTION FILE PROCESSING ON
Related interface option: Enable Exception Processing, see page 7-43.

Format:

EXCEPTION FILE PROCESSING ON

This control statement is used only during account code conversion. When this statement is present, any record that does not match an entry in the account code conversion table is written to an exception file. If this control statement is not present, the records that are not matched are written to the ClMSAcct Detail file with the unconverted account code input field value.

For more information the exception file processing, see About Exception File Processing on page 7-17.

Example:

EXCEPTION FILE PROCESSING ON

Considerations
■ If you enable exception processing, do not include a default account code as the last entry in the account code conversion table (e.g., ",,DEFAULTCODE"). If a default account number is used, records will not be written to the exception file.

■ When an input file is processed through ITUAM Administrator, the default file name for the exception file is Exception.txt. You should rename the output exception file so that it is not overwritten when subsequent files are created.

IGNORE ORIGINAL SOURCE IDENTIFIERS
Related interface option: None

Format:

IGNORE ORIGINAL SOURCE IDENTIFIERS

When this control statement is present, the identifiers SourceName and SourceLine are not written to the Ident file. These identifiers are built by ITUAM Conversion Engine. The SourceName identifier, which provides the name and location of the input file, can be quite long. Use this statement if you are not interested in tracking this information and want to conserve space.
**INCLUDE FIELD**

Related interface option: Include Fields, see page 7-28.

**Format:**

```
INCLUDE FIELDn,identifier_name,offset_into_identifier_value,length
```

- \( n = 0–9 \) (up to 10 INCLUDE FIELD statements supported)
- \( offset\_into\_identifier = 1–255 \)
- \( length = 1–60 \)

**Note** • The overall length of all include fields added together can not exceed 60 characters.

Use this control statement to move identifiers from the input file records into an area that can be later used by CIMSBill for include/exclude processing. For more information about using include fields, see *Include/Exclude Processing* on page 7-59.

**Example:**

```
INCLUDE FIELD0,UserName,1,10
```

In this example, the **UserName** identifier value would be moved into the **DETAIL-INCLEXCL-AREA** field of the CIMSAcct Detail records. This field is used by the CIMSBill DEFINE control statement to define the include/exclude fields for CIMSBill (see page D-16).

---

**PROCESS**

Related interface option: Process Type, see page 7-27.

**Format:**

```
PROCESS [CIMS SERVER RESOURCE RECORDS | CIMS MAINTENANCE RECORDS FROM CIMSACCT | CIMS SUMMARY]
```

This control statement specifies the type of data that is contained in the input file. CIMSAcct can process only one type of data at a time.

**Example:**

```
PROCESS CIMS SERVER RESOURCE RECORDS
```
PRINT ACCOUNT NO-MATCH

Related interface option: None

Format:

PRINT ACCOUNT NO-MATCH

When this statement is present, a message is printed in the CIMSAcct Message file showing the identifier values from the input file that were not matched during account code conversion. If this statement is not present, only the total number of unmatched records is provided. The system prints up to 1000 messages.

SHIFT

Related interface option: Shifts, see page 7-29.

Format:

SHIFT [day] [code] [end time] [code] [end time] …. [code] [end time]

day = SUN | MON | TUE | WED | THU | FRI | SAT

code = 1–9 (the shift code)

der time = the end time of the shift

This control statement defines shifts within the system. Seven shift records are supported (one for each day of the week) and up to nine shifts can be specified on each. End times are entered in hours and minutes using the 24-hour clock.

Rules that apply to shift records:

■ Day is defined as the first three letters of the day
■ Up to nine shifts per day can be specified
■ The preceding end time must always be less than the next end time
■ No shift spans midnight

Example:

For the following shifts:

Monday through Friday
Shift 1 - 5 AM to 8 AM and 3:30 PM to 5 PM
Shift 2 - 8 AM to 11:30 AM and 1:30 PM to 3:30 PM
Shift 3 - 5 PM to 8 PM
Shift 4 - 9:30 PM to 12 AM and 12 AM to 5 AM
Shift 5 - 11:30 AM to 1:30 PM and 8 PM to 9:30 PM

Saturday and Sunday
Shift 1 - 8 AM to 5 PM

Shift 2 - 5 PM to 12 AM and 12 AM to 8 AM

The **SHIFT** statements are as follows:

SHIFT SUN 2 0800 1 1700 2 2400
SHIFT MON 4 0500 1 0800 2 1130 5 1330 2 1530 1 1700 3 2000 5 2130 4 2400
SHIFT TUE 4 0500 1 0800 2 1130 5 1330 2 1530 1 1700 3 2000 5 2130 4 2400
SHIFT WED 4 0500 1 0800 2 1130 5 1330 2 1530 1 1700 3 2000 5 2130 4 2400
SHIFT THU 4 0500 1 0800 2 1130 5 1330 2 1530 1 1700 3 2000 5 2130 4 2400
SHIFT FRI 4 0500 1 0800 2 1130 5 1330 2 1530 1 1700 3 2000 5 2130 4 2400
SHIFT SAT 2 0800 1 1700 2 2400

**TEST**

Related interface option: Trace flag, see page 7-31.

**Format:**

`TEST c`

`c` = a character (A for account code conversion messages Y for general messages)

This control statement is used to print tracing messages to the CIMSAcct Message file.

**Example:**

`TEST A`

**UPPERCASE ACCOUNT FIELDS**

Related interface option: Convert account fields to uppercase during processing, see page 7-41.

**Format:**

`UPPERCASE ACCOUNT FIELDS`

This control statement instructs CIMSAcct to convert lowercase account code input field values to uppercase values in the resulting account code. For example, the value `ddic` would be converted to `DDIC`. By using this option, CIMSAcct account code processing becomes case-insensitive and makes defining account conversion tables much easier.
**VERIFY DATA**

Related interface option: None

**Format:**

`VERIFY DATA ON|OFF`

This control statement instructs CIMSAcct to check for embedded null characters within an input record (if `ON` is specified) and changes the null characters to spaces. Null characters should be contained only at the end of record, not within a record. ITUAM standard interfaces do not embed nulls. Turning verification on slows processing and should be used only when processing non-standard feeds.

The default is `VERIFY DATA OFF`. 
CIMSBill Control Statements

This section describes control statements that you can use in the CIMSBill Control file, BillCntl.txt. By default, the control statements in the control file reflect the process definition settings in ITUAM Administrator (see Setting Process Definition Options on page 7-23).

The control statement descriptions in this section include a reference to the corresponding option in ITUAM Administrator.

<table>
<thead>
<tr>
<th>CONTROL STATEMENT</th>
<th>SEE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>BACKLOAD DATA</td>
<td>[page D-14]</td>
<td>Instructs CIMSBill to ignore the close date. The accounting dates created by CIMSBill are the same as the usage end date regardless of the close date.</td>
</tr>
<tr>
<td>CLIENT SEARCH ON</td>
<td>[page D-14]</td>
<td>Instructs CIMSBill to use the account code structure definition to search the CIMSClient table for the rate table associated with a client.</td>
</tr>
<tr>
<td>DATE SELECTION</td>
<td>[page D-15]</td>
<td>Defines a date range for records to be processed by CIMSBill.</td>
</tr>
<tr>
<td>DEFAULT CLOSE DAY</td>
<td>[page D-16]</td>
<td>Overrides the system-wide close date.</td>
</tr>
<tr>
<td>DEFINE</td>
<td>[page D-16]</td>
<td>Defines the account code structure used by the statements CLIENT SEARCH ON and DYNAMIC CLIENT ADD ON. Also defines character strings in the CIMSBill Detail record that are used for include/exclude processing.</td>
</tr>
<tr>
<td>DYNAMIC CLIENT ADD ON</td>
<td>[page D-18]</td>
<td>Specifies that CIMSBill automatically insert corresponding client entries into the CIMSClient table for all clients that have a resource usage charge.</td>
</tr>
<tr>
<td>INCLUDE</td>
<td>[page D-19]</td>
<td>Specifies an include record condition.</td>
</tr>
<tr>
<td>NORMALIZE CPU VALUES</td>
<td>[page D-19]</td>
<td>Normalizes CPU values.</td>
</tr>
<tr>
<td>PROCESS</td>
<td>[page D-19]</td>
<td>Specifies the type of data that is contained in the input file. CIMSBill can process only one type of data at a time.</td>
</tr>
<tr>
<td>PRORATE MONEY</td>
<td>[page D-20]</td>
<td>Splits money for a specific resource (or all resources) among multiple accounts.</td>
</tr>
<tr>
<td>PRORATE RESOURCES</td>
<td>[page D-21]</td>
<td>Splits a specific resource (or all resources) among multiple accounts.</td>
</tr>
</tbody>
</table>
**Control and Processing Statements**

*ITUAM Processing Engine Control Statements (Windows)*

**Control Statement**

<table>
<thead>
<tr>
<th>Control Statement</th>
<th>See</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRINT PRORATION REPORT</td>
<td>[page D-21]</td>
<td>Generates a proration report that contains the original record and all subsequently-generated prorated records.</td>
</tr>
<tr>
<td>REPORT DATE</td>
<td>[page D-22]</td>
<td>Specifies the date that is put into the Summary records created by CIMSBill.</td>
</tr>
<tr>
<td>USE SHIFT CODES</td>
<td>[page D-23]</td>
<td>Instructions CIMSBill to use the shift character specified in the CIMSAcct Detail record and apply the appropriate rate shift value.</td>
</tr>
<tr>
<td>TEST</td>
<td>[page D-23]</td>
<td>Used to print tracing messages to the CIMSBill Message file.</td>
</tr>
</tbody>
</table>

**BACKLOAD DATA**

Related interface option: Back Load Data, see page 7-33.

Format:

```
BACKLOAD DATA
```

This statement instructs CIMSBill to ignore the close date. The accounting dates created by CIMSBill are the same as the usage end date regardless of the close date.

**CLIENT SEARCH ON**

Related interface option: Enable client search, see page 7-35.

Format:

```
CLIENT SEARCH ON
```

This statement instructs CIMSBill to use the account code structure definition (by use of the DEFINE Jn fields, see page D-16) to search the CIMSClient table for the rate table associated with a client. If this statement is not specified, the STANDARD rate table is used for all clients.

CIMSBill searches the CIMSClient table in a minor–major sequence to find client information. Consider the following example control statements:

```
DEFINE J1 1 1 /DIVISION/
DEFINE J2 1 5 /DEPARTMENT/
SEQUENCE FIELDS J1 J2
CLIENT SEARCH ON
```

Assume the data value for J1 and J2 is AABBB (J1 = AA, J2 = AABBB). CIMSBill searches the CIMSClient table for account code AABBB. If account code AABBB is not found, CIMSBill then searches the table for account code AA. If account code AA is found, the rate table for account code AA is used. If account code AA is not found, the STANDARD rate table is used.
DATE SELECTION

Related interface option: Input – Date Selection, see page 7-32.

Format:

```
DATE SELECTION {YYYYMMDD YYYYMMDD | keyword}
```

This statement defines a date range for records to be processed by CIMSBill. Records are selected by the accounting end date in the record. You can use the following values:

- From and to dates. For a record to be selected, it must be greater than or equal to the from date and less than or equal to the to date.

  or

- One of the following keywords:

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RNDATE</strong></td>
<td>Selects records based on the run date</td>
</tr>
<tr>
<td><strong>CURDAY</strong></td>
<td>Selects records based on the run date and the run date less one day</td>
</tr>
<tr>
<td><strong>CURWEK</strong></td>
<td>Selects records based on the run week (Sun–Sat)</td>
</tr>
<tr>
<td><strong>CURMON</strong></td>
<td>Selects records based on run month</td>
</tr>
<tr>
<td><strong>PREDAY</strong></td>
<td>Selects records based on run date, less one (day)</td>
</tr>
<tr>
<td><strong>PREWEK</strong></td>
<td>Selects records based on previous week (Sun–Sat)</td>
</tr>
<tr>
<td><strong>PREMON</strong></td>
<td>Selects records based on previous month</td>
</tr>
<tr>
<td>CURRENT</td>
<td>Selects current period from the CIMSCalendar table</td>
</tr>
<tr>
<td>PREVIOUS</td>
<td>Selects previous period from the CIMSCalendar table</td>
</tr>
</tbody>
</table>

Examples:

```
DATE SELECTION 20060601 20060630
DATE SELECTION **PREMON
```
DEFAULT CLOSE DAY
Related interface option: Default Close Date, see page 7-32.

Format:

DEFAULT CLOSE DAY=nn

nn = 01–31

This statement overrides the system-wide close date set in the Configuration dialog box (see Processing Settings on page 4-43). The year and month used for the close day reflect the year and month in which CIMSBill is run. For more information about the close date, see page 7-18.

Example:

DEFAULT CLOSE DAY=8

This statement sets the close date to the eighth of the month. If the CIMSBill run date is 20060706, the close date is set to 20060708. If the CIMSBill run date is 20060712, the close date is also set to 20060708.

DEFINE
The DEFINE statement defines the account code structure used by the statements CLIENT SEARCH ON and DYNAMIC CLIENT ADD ON. This statement also defines character strings in the CIMSBill Detail record that are used for include/exclude processing. The format differs depending on the use of the statement as described in the following sections.

Account Code Fields Define
Related interface option: Account Code Search Fields, see page 7-35.

This statement is used with the CLIENT SEARCH ON and DYNAMIC CLIENT ADD ON statements to specify the client account code structure. You can specify up to nine account levels (fields J1–J9).

Format:

DEFINE Jn start_loc len /desc/

n = 1–9

start_loc = starting position within the account code

len = total length of the level

desc = a description for the field
Control and Processing Statements

ITUAM Processing Engine Control Statements (Windows)

Example:

Account code AAABBBCCDDDDD contains four levels. To search from the lowest level to the highest level, use the following define fields:

```
DEFINE J1 1 3
DEFINE J2 1 6
DEFINE J3 1 8
DEFINE J4 1 13
CLIENT SEARCH ON
```

For the previous define fields:

- J1 = AAA
- J2 = AAABBB
- J3 = AAABBBCC
- J4 = AAABBBCCDDDDD

CIMSBill first searches for AAABBBCCDDDDD and if it does not find an entry it searches for AAABBBCC and so on.

Include/Exclude Fields Define

Related interface option: Define Include/Exclude Fields, see page D-9.

This statement defines any string of characters within the CIMSBill Detail record for include/exclude processing.

Format:

```
DEFINE fd loc len /desc/
```

- `fd` = two-character field ID, for example A1
- `loc` = starting position in the CIMSBill Detail record (see CIMSBill Detail File on page B-9). For example 163 is the start of the account code field.
- `len` = length of the field
- `desc` = a description for the field

Example:

In this example, you want to define UserName identifier, which starts at position 301 of the CIMSBill Detail file, so that you can exclude all UserName values that begin with geo.

First, define the field in CIMSAcct using the INCLUDE FIELD statement (see page D-9):

```
INCLUDE FIELD0,UserName,1,10
```

Define the field in CIMSBill:

```
DEFINE A1 301 3 /usergeorge/
```

And then use the following EXCLUDE statement:

```
EXCLUDE A1 geo geo
```
DYNAMIC CLIENT ADD ON

Related interface option: Add new clients to Client table, see page 7-35.

Format:

DYNAMIC CLIENT ADD ON

This statement specifies that CIMSBill automatically insert corresponding client entries in the CIMSClient table for all clients that have a resource usage charge, but are not entered in the table. Use this statement with caution because it can quickly fill the CIMSClient table with extraneous records.

If you are using multiple rate tables for clients, this statement requires that the control statement CLIENT SEARCH ON is also used (see page D-14).

The inserted client entries will include account names only if a matching top level account is currently in the CIMSClient table. For example, if account code AA exists in the CIMSClient table and account code AABBB is inserted, account AABBB is assigned the same account name as AA. However, contacts and budgets assigned to the top level account are not copied to the new client.

EXCLUDE

Related interface option: Define Include/Exclude Records, see page 7-61.

Format:

EXCLUDE fd low high

fd = two-character field id (from the DEFINE control statement - see page D-16)
low = specifies the low or from selection value (1 to 8 characters)
high = specifies the high or to selection value (1 to 8 characters)

This statement specifies an exclude record condition. The specified data from the field must be equal to or greater than the low value and equal to or less than the high value.

Example:

Assume that you want to exclude records with usage start dates between the dates of June 1, 2006 and June 12, 2006. You need to define the field that contains the usage start date in the CIMSBill Detail records. This field begins at position 123.

DEFINE A1 123 8 /Start Date/
EXCLUDE A1 20060601 20060612
INCLUDE
Related interface option: Define Include/Exclude Records, see page 7-61.

Format:

INCLUDE fd low high

fd = two-character field ID (from the DEFINE control statement—see page D-16)
low = specifies the low or from selection value (1 to 8 characters)
high = Specifies the high or to selection value (1 to 8 characters)

This statement specifies an include record condition. The specified data from the field must be equal to or greater than the low value and equal to or less than the high value.

Example:

Assume that you want to include records with usage start dates between the dates of June 1, 2006 and June 12, 2006. You need to define the field that contains the usage start date in the CIMSBill Detail records. This field begins at position 123.

DEFINE A1 123 8 /Start Date/
INCLUDE A1 20060601 20060612

NORMALIZE CPU VALUES
Related interface option: Normalize CPU Values, see page 7-33.

Format:

NORMALIZE CPU VALUES

This statement instructs CIMSBill to normalize CPU values. For more information about normalizing CPU values, see page 7-56.

PROCESS
Related interface option: Process Type, see page 7-32.

Format:

PROCESS {DETAIL RECORDS | CIMS SUMMARY RECORDS}

This control statement specifies the type of data that is contained in the input file for CIMSBill. CIMSBill can process only one type of data at a time.

Example:

PROCESS DETAIL RECORDS
**PRORATE MONEY**

Related interface option: Proration Type Money, see page 7-50.

**Format:**

PRORATE MONEY len

len = the length to match for proration

This statement splits money for a specific resource (or all resources) among multiple accounts. To prorate money, a prorate table must be set up to specify how the monies are split. The length specified is used to determine at what level to match for the splitting. Assume that the following control statement is specified:

PRORATE MONEY 5

The following prorate (or split table) is defined as:

AAABB, AA1, 40, All

AAABB, AA2, 60, All

The accounts AAABB, AAABBB, and AAABBCC will match and be split into AA1 and AA2.

**Example:**

PRORATE MONEY 5

**Prorating Resources vs. Prorating Money**

In ITUAM Administrator, you can set the option to prorate on resources or on money. Both options display the same prorated units and charges in Web reports. However, you cannot drill down on resource units by identifier if you prorate by money. The following describes the advantages and disadvantages of prorating resources and prorating money:

**Prorating resources.** The CIMSAcct Detail file from CIMSSort is prorated before CIMSBill applies rates and figures money and a new CIMSAcct Detail file is built with all the prorated resources. The new CIMSAcct Detail file is then used in the CIMSBill process.

An advantage of prorating resources is that the CIMSBill Detail records match the records in the Summary file. Therefore, users can drill down on resource units by identifier when viewing invoices in ITUAM Web Reporting. A disadvantage is that the CIMSBill Detail file can contain a potentially large number or records.

**Prorating money.** The Summary file is prorated just before CIMSBill ends. A new Summary file is built with the prorated values.

An advantage of prorating money is that the CIMSBill Detail file contains fewer records than it would if you prorated by resources. A disadvantage is that the CIMSBill Detail records do not match the Summary records and drilling down by identifier will not produce accurate data.
**PRORATE RESOURCES**

Related interface option: Proration Type Resources, see page 7-50.

**Format:**

```
PRORATE RESOURCES len
```

`len = the length to match for proration`

This statement splits a specific resource (or all resources) among multiple accounts. To prorate resources, a prorate table must be set up to specify how the resources are split. The length specified is used to determine at what level to match for the splitting. Assume that the following control statement is specified:

```
PRORATE RESOURCES 5
```

The following prorate (or split table) is defined as:

```
AAABB,AA1,40,All
AAABB,AA2,60,All
```

The accounts AAABB, AAABBBB, and AAABBCC will match and be split into AA1 and AA2.

**Example:**

```
PRORATE RESOURCES 5
```

**PRINT PRORATION REPORT**

Related interface option: Print Proration Report, see page 7-50.

**Format:**

```
PRINT PRORATION REPORT
```

This statement generates a proration report that contains the original record and all subsequently-generated prorated records. The proration report will reside in the processing directory with the file name of `ProrateRep.Txt`.

**Example:**

```
PRINT PRORATION REPORT
```
REPORT DATE

Important! • The use of this statement is not recommended. This statement will place report dates rather than actual usage end dates in the accounting date fields of the CIMSBill Summary records. You should use the default Auto option in ITUAM Administrator rather than report dates (see page 7-33).

Related interface option: Output-Summary Date Range, see page 7-33.

Format:

REPORT DATE (YYYYYMMDD YYYYYMMDD | keyword)

This statement specifies the dates that are used as the accounting dates in the Summary records created by CIMSBill. This is the date that is used for reporting purposes in ITUAM. You can use the following values:

- From and to dates

- One of the following keywords:

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>**RNDATE</td>
<td>Sets the date range based on the run date</td>
</tr>
<tr>
<td>**CURDAY</td>
<td>Sets the date range based on the run date and the run date less one day</td>
</tr>
<tr>
<td>**CURWEK</td>
<td>Sets the date range based on the run week (Sun–Sat)</td>
</tr>
<tr>
<td>**CURMON</td>
<td>Sets the date range based on the run month</td>
</tr>
<tr>
<td>**PREDAY</td>
<td>Sets the date range based on the run date, less one day</td>
</tr>
<tr>
<td>**PREWEK</td>
<td>Sets the date range based on the previous week (Sun–Sat)</td>
</tr>
<tr>
<td>**PREMON</td>
<td>Sets the date range based on the previous month</td>
</tr>
<tr>
<td>CURRENT</td>
<td>Sets the date range based on the current period from the CIMSCalendar table</td>
</tr>
<tr>
<td>PREVIOUS</td>
<td>Sets the date range based on the previous period from the CIMSCalendar table</td>
</tr>
<tr>
<td>USE DETAIL DATES</td>
<td>Sets the date range based on the CIMSAcct Detail record (consult IBM before using this keyword)</td>
</tr>
</tbody>
</table>

Examples:

REPORT DATE 20060601 20060630

REPORT DATE **PREMON
**USE SHIFT CODES**

Related interface option: Use Shift Codes, see page 7-33.

**Format:**

```
USE SHIFT CODES
```

This statement instructs CIMSBill to use the shift character specified in the CIMSAcct Detail record and apply the appropriate rate shift value.

If a shift value is not defined for the rate, the default rate value for the resource will be used. The default rate value is also the SHIFT1 rate value.

**TEST**

Related interface option: Trace flag, see page 7-36.

**Format:**

```
TEST c
```

- `c` = a character (D for dates, R for display rate information [each rate code read from the database], Y for general messages, Z for trace client processing [dynamic client add and client searching])

This control statement is used to print tracing messages to the message file.

**Example:**

```
TEST Y
```
## Control and Processing Statements

**ITUAM Processing Engine Control Statements (Windows)**

### Processing Control Statements

ITUAM Administrator stores additional processing setting for each process definition in the `ProcessCntl.txt` file. This file resides in the folder of each process definition.

The following table describes the processing settings in the `ProcessCntl.txt` file and provides the corresponding GUI option in ITUAM Administrator.

<table>
<thead>
<tr>
<th>Processing Statement</th>
<th>GUI Option</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AcctInputFile</strong> filename</td>
<td>Input File, see page 7-28</td>
</tr>
<tr>
<td>Where <code>filename</code> = the name of CIMSAcct input file.</td>
<td></td>
</tr>
<tr>
<td><strong>AcctOutputDetailFile</strong> filename</td>
<td>Output Files: Detail, see page 7-28</td>
</tr>
<tr>
<td>Where <code>filename</code> = the name of CIMSAcct Detail file.</td>
<td></td>
</tr>
<tr>
<td><strong>AcctOutputIdentFile</strong> filename</td>
<td>Output Files: Ident, see page 7-28</td>
</tr>
<tr>
<td>Where <code>filename</code> = the name of Ident file.</td>
<td></td>
</tr>
<tr>
<td><strong>AcctOutputExceptionFile</strong> filename</td>
<td>Output Files: Exception, see page 7-28</td>
</tr>
<tr>
<td>Where <code>filename</code> = the name of CIMSAcct exception output file.</td>
<td></td>
</tr>
<tr>
<td><strong>ArchiveProcessFiles</strong> Yes/No</td>
<td>Archive process files, see page 7-24</td>
</tr>
<tr>
<td>This setting archives previous output files before processing.</td>
<td></td>
</tr>
<tr>
<td><strong>AutoLoadIdentFile</strong> Yes/No</td>
<td>Load record type records, see page 7-24</td>
</tr>
<tr>
<td><strong>AutoLoadSummaryFile</strong> Yes/No</td>
<td></td>
</tr>
<tr>
<td><strong>AutoLoadDetailFile</strong> Yes/No</td>
<td></td>
</tr>
<tr>
<td><strong>AutoLoadResourceFile</strong> Yes/No</td>
<td></td>
</tr>
<tr>
<td>These settings determine if the system automatically loads these files into the database at conclusion of processing.</td>
<td></td>
</tr>
<tr>
<td><strong>BillInputFile</strong> filename</td>
<td>Input File, see page 7-34</td>
</tr>
<tr>
<td>Where <code>filename</code> = the name of CIMSBill input file.</td>
<td></td>
</tr>
<tr>
<td><strong>BillDetailFile</strong> filename</td>
<td>Output Files: Detail, see page 7-34</td>
</tr>
<tr>
<td>Where <code>filename</code> = the name of the CIMSBill Detail file.</td>
<td></td>
</tr>
<tr>
<td><strong>BillSummaryFile</strong> filename</td>
<td>Output Files: Summary, see page 7-34</td>
</tr>
<tr>
<td>Where <code>filename</code> = the name of the Summary file.</td>
<td></td>
</tr>
<tr>
<td><strong>BillMultFile</strong> filename</td>
<td>Proration Table, see page 7-50</td>
</tr>
<tr>
<td>Where <code>filename</code> = the name of the proration table file.</td>
<td></td>
</tr>
</tbody>
</table>
## Control and Processing Statements

**ITUAM Processing Engine Control Statements (Windows)**

### Processing Statement

<table>
<thead>
<tr>
<th>Processing Statement</th>
<th>GUI Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>AcctCodeConversionTable filename</td>
<td>Conversion Table, see page 7-43</td>
</tr>
<tr>
<td>Where <code>filename</code> = the name of the account code conversion table.</td>
<td></td>
</tr>
<tr>
<td>CreateCSRPFile Yes/No</td>
<td>Create CSR Plus, see page 7-28</td>
</tr>
<tr>
<td>This setting creates a CSR+ file.</td>
<td></td>
</tr>
<tr>
<td>CSRPlus filename</td>
<td>CSR Plus, see page 7-28</td>
</tr>
<tr>
<td>Where <code>filename</code> = the name of the CSR+ file.</td>
<td></td>
</tr>
<tr>
<td>Description name</td>
<td>Process Description, see page 7-23</td>
</tr>
<tr>
<td>Where <code>name</code> = a description of the process definition.</td>
<td></td>
</tr>
<tr>
<td>DSN name</td>
<td>Data Source Name, see page 7-26</td>
</tr>
<tr>
<td>Where <code>name</code> = the name of the ODBC data source.</td>
<td></td>
</tr>
<tr>
<td>DSNUID user ID</td>
<td>Database User ID, see page 7-26</td>
</tr>
<tr>
<td>Where <code>user ID</code> = the user ID needed to access the ODBC data source.</td>
<td></td>
</tr>
<tr>
<td>DSNPWD password</td>
<td>Database Password, see page 7-26</td>
</tr>
<tr>
<td>Where <code>password</code> = the encrypted password needed to access the ODBC data source.</td>
<td></td>
</tr>
<tr>
<td>GenerateODBCINF Yes/No</td>
<td>Automatically generate ODBC INF file from above parameters, see page 7-26</td>
</tr>
<tr>
<td>This setting generates an INF file that passes along user ID and password information to the ODBC data source.</td>
<td></td>
</tr>
<tr>
<td>RemoveFilesBeforeProcessing Yes/No</td>
<td>Remove output files before processing, see page 7-24</td>
</tr>
<tr>
<td>This setting deletes previous output files from the process definition folder.</td>
<td></td>
</tr>
<tr>
<td>RunCIMSAcct Yes/No</td>
<td>Run CIMSAacct, see page 7-24</td>
</tr>
<tr>
<td>This setting determines whether CIMSAcct is run as part of the process.</td>
<td></td>
</tr>
<tr>
<td>RunCIMSBill Yes/No</td>
<td>Run CIMSBill, see page 7-24</td>
</tr>
<tr>
<td>This setting determines whether CIMSBill is run as part of the process.</td>
<td></td>
</tr>
<tr>
<td>UseBulkLoadInterface Yes/No</td>
<td>Use bulk load interface, see page 7-25</td>
</tr>
<tr>
<td>This setting determines whether the SQL server bulk load interface is used.</td>
<td></td>
</tr>
</tbody>
</table>
ITUAM Processing Engine Control Statements (UNIX or Linux)

This section describes the control statements for ITUAM Processing Engine on a UNIX or Linux system. These statements may be provided in one control file (ProcCntl.xml) or in separate control files (AcctCntl.xml, BillCntl.xml, and LoadCntl.xml).

For a description of the control files and statements are used, see Setting Up the Control File (ProcCntl.xml) on page 8-16.

CIMSAacct Control Statements

This section describes the CIMSAacct control statements.

Note • Control statements are not case-sensitive, except for the literals in the DEFINE MOVEFLD statement (see page D-31).

<table>
<thead>
<tr>
<th>CONTROL STATEMENT</th>
<th>SEE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACCOUNT CODE CONVERSION</td>
<td>[page D-27]</td>
<td>Specifies processing of the CIMS account code conversion table.</td>
</tr>
<tr>
<td>(SORT)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ACCOUNT FIELD</td>
<td>[page D-28]</td>
<td>Defines how to build the account code from the identifiers within the input file record.</td>
</tr>
<tr>
<td>DATE SELECTION</td>
<td>[page D-29]</td>
<td>Defines a date range for records to be processed by CIMSAacct.</td>
</tr>
<tr>
<td>DEFINE FIELD</td>
<td>[page D-30]</td>
<td>Used only during account code conversion. Defines the fields for comparison within the account code input field (which is built from the ACCOUNT FIELD statements or from the identifier Account_Code).</td>
</tr>
<tr>
<td>DEFINE MOVEFLD</td>
<td>[page D-31]</td>
<td>Used only during account code conversion. Defines the fields that are to be moved from the account code input field (which is built from the ACCOUNT FIELD statements or from the identifier Account_Code) to the account code output field.</td>
</tr>
<tr>
<td>EXCEPTION FILE PROCESSING ON</td>
<td>[page D-32]</td>
<td>Used only during account code conversion. When present, any record that does not match an entry in the account code conversion table is written out to the exception file.</td>
</tr>
</tbody>
</table>


ACCOUNT CODE CONVERSION {SORT}

Format:

ACCOUNT CODE CONVERSION {SORT}

This statement enables account code conversion using and DEFINE FIELD and DEFINE MOVEFLD statements and the account code conversion table. The SORT option is recommended because it sorts the account code conversion table in memory and increases performance.

When account code conversion is enabled, all no-match records are written to the CLMSAcct Output CSR+ file with the unconverted account code input field value as the account code. If you want the record written to an exception file for later processing, you must add the control statement Exception File Processing On.

Example:

ACCOUNT CODE CONVERSION SORT

Prints the first 1000 input identifiers that are not matched during account code conversion.

Sets up the shifts within the system.

Specifies that the account code built from the account code input field is uppercase.
**ACCOUNT FIELD**

Format:

ACCOUNT FIELD\(n\),identifier_name,offset,length

\(n = 0–9\) (up to 10 ACCOUNT FIELD statements supported)

offset = starting offset into identifier value (1–255)

length = identifier value length from offset (1–128)

---

**Note** • Although the maximum number of characters for each account field is 128, the overall length of all account fields added together cannot exceed 128 characters.

Also, keep in mind that the total output account code, including any literals and move field values (see page D-31), cannot exceed 128 bytes.

This statement defines the identifier(s) that you want to use to build the account code. Begin at ACCOUNT FIELD0 and continue sequentially as needed. The account fields are used (along with DEFINE FIELD and DEFINE MOVEFLD statements) in account code conversion if account code conversion is enabled. If account code conversion is not enabled, then the account code is built directly from this statement or from the Account_Code identifier in the input file records (if present). For more information, see *Defining the Account Code* on page 8-32.

Example:

ACCOUNT FIELD0,UserName,1,10
ACCOUNT FIELD1,Division,1,2

In this example, the UserName and Division identifiers will be used to create the account code. The offset for both identifier values is 1 and the length of the values are 10 and 2, respectively. Therefore, the account code will be the first 10 characters of the user name followed by the first 2 characters of the division.

If the UPPERCASE ACCOUNT FIELDS statement is specified, lowercase identifier values in the account field are converted to uppercase values.
DATE SELECTION

Format:

DATE SELECTION (YYYYMMDD YYYYMMDD | keyword)

This statement defines a date range for records to be processed by CIMSAcct. Records are selected by the usage end date in the record. You can use the following values:

- From and to dates. For a record to be selected, it must be greater than or equal to the from date and less than or equal to the to date.

  or

- One of the following keywords:

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RNDATE</strong></td>
<td>Selects records based on the run date</td>
</tr>
<tr>
<td><strong>CURDAY</strong></td>
<td>Selects records based on the run date and the run date less one day</td>
</tr>
<tr>
<td><strong>CURWEK</strong></td>
<td>Selects records based on the run week (Sun–Sat)</td>
</tr>
<tr>
<td><strong>CURMON</strong></td>
<td>Selects records based on the run month</td>
</tr>
<tr>
<td><strong>PREDAY</strong></td>
<td>Selects records based on the run date, less one (day)</td>
</tr>
<tr>
<td><strong>PREWEK</strong></td>
<td>Selects records based on the previous week (Sun–Sat)</td>
</tr>
<tr>
<td><strong>PREMON</strong></td>
<td>Selects records based on the previous month</td>
</tr>
<tr>
<td>CURRENT</td>
<td>Selects current period from the CIMSCalendar table</td>
</tr>
<tr>
<td>PREVIOUS</td>
<td>Selects previous period from the CIMSCalendar table</td>
</tr>
</tbody>
</table>

Note: CIMSAcct requires access to the database if the CURRENT or PREVIOUS keyword is present.

The start and end dates of data processed through CIMS Server must reflect the start and end dates of the target billing period. If the billing period runs from January 1 through January 31, any records produced with a date of February 1 (or later) should not be included as part of the processing. In most cases, this data screening has already been performed, either by CIMS Server or through the creation of data inputs reflecting the desired date range.

Note that it is rare that you would need to limit the date range of the data used as input to CIMSAcct. DATE SELECTION is usually used as CIMSBill control statement.

Examples:

DATE SELECTION 20060601 20060630

DATE SELECTION **PREMON
**DEFINE FIELD**

Format:

```
DEFINE FIELDn,offset,length
```

- **n** = 0–9 (up to 10 DEFINE FIELD statements supported)
- **offset** = starting offset into account field or the Account_Code identifier value (1–128)
- **length** = account field or identifier value length from offset (1–128)

This statement is used only during account code conversion. Use this statement to specify the offset and length of the account code input field value that you want to use for conversion. Begin at DEFINE FIELD0 and continue sequentially as needed.

**Note** • Although the maximum number of characters for each define field is 128, the overall length of all account fields added together cannot exceed 128 characters.

Also, keep in mind that the total output account code, including any literals and move field values (see page D-31), cannot exceed 128 bytes.

For more information about using define fields, see *Defining the Identifier Values for Account Code Conversion* on page 8-34.

Example:

```
ACCOUNT FIELD0,UserName,1,10
ACCOUNT FIELD1,Division,1,2
DEFINE FIELD0,3,8
DEFINE FIELD1,11,2
```

In this example, the first two characters of ACCOUNT FIELD0 will not be considered for account code conversion as specified by the offset of 3 for DEFINE FIELD0. However, the full value of ACCOUNT FIELD1 will be used because the offset for DEFINE FIELD1 is 11 (the Division identifier value starts in position 11 of the combined account fields) and the length for both the account field and define field are the same.

For example, if the combined value for ACCOUNT FIELD0 and ACCOUNT FIELD1 is AABBCCDEEXZ, the value as defined by the DEFINE FIELD0 and DEFINE FIELD1 is BBCDEEXZ.
**DEFINE MOVEFLD**

Format:

```
DEFINE MOVEFLDn,offset,length,literal
```

- **n** = 0–9 (up to 10 DEFINE MOVEFLD statements supported)
- **offset** = starting offset into account field or the Account_Code identifier value (1–128)
- **length** = account field or identifier value length from offset (1–128)
- **literal** = a literal can be moved instead of a particular field (literals in this statement are case-sensitive)

This statement is used only during account code conversion. Use this statement to move all or a portion of the account code input field value to a position in the output account code. Begin at DEFINE MOVEFLD0 and continue sequentially as needed.

Targets within the account code conversion table are specified as @0–@9.

**Note** • Although the maximum number of characters for each move field is 128, the overall length of all account fields added together cannot exceed 128 characters.

Also, keep in mind that the total output account code, including any literals and move field values, cannot exceed 128 bytes.

For more information about using move fields, see *Defining Optional Move Fields* on page 8-35.

**Example:**

```
ACCOUNT FIELD0,UserName,1,10
ACCOUNT FIELD1,Division,1,2
DEFINE FIELD0,3,8
DEFINE FIELD1,11,2
DEFINE MOVEFLD0,11,2
```

In this example, the value for DEFINE MOVEFLD0 specifies that the value beginning at position 11 account code input field will be placed in the output account code as defined by the account code conversion table.

For example, if the 2-character value beginning at position 11 is XZ and the account code conversion table is:

```
BBC,,FINACCT@0
```

The resulting account code will be FINACCTXZ.

For more information about the account code conversion table, see *Creating an Account Code Conversion Table* on page 8-36.


EXCEPTION FILE PROCESSING ON

Format:

EXCEPTION FILE PROCESSING ON

This control statement is used only during account code conversion. When this statement is present, any record that does not match an entry in the account code conversion table is written to an exception file. If this control statement is not present, the records that are not matched are written to the CIMSAcct Output CSR+ file with the unconverted account code input field value as the account code.

For more information the exception file processing, see Enabling Exception Processing on page 8-36.

Example:

EXCEPTION FILE PROCESSING ON

Considerations

- If you enable exception processing, do not include a default account code as the last entry in the account code conversion table (e.g., “.,DEFAULTCODE”). If a default account number is used, records will not be written to the exception file.

- The default file name for the exception file is Exception.txt. You should rename the output exception file so that it is not overwritten when subsequent files are created.

PRINT ACCOUNT NO-MATCH

Format:

PRINT ACCOUNT NO-MATCH

When this statement is present, a message is written to STDOUT or the CIMSAcct Message file showing the identifier values from the input file that were not matched during account code conversion. If this statement is not present, only the total number of unmatched records is provided. The system prints up to 1000 messages.

Note • The messageFile parameter attribute in the control file determines whether messages are written to STDOUT or the CIMSAcct Message file. See page 8-19.
**SHIFT**

**Format:**

SHIFT [day] [code] [end time] [code] [end time] ... [code] [end time]

day  = SUN | MON | TUE | WED | THU | FRI | SAT

code  = 1–9 (the shift code)

end time = the end time of the shift

This control statement defines shifts within the system. Seven shift records are supported (one for each day of the week) and up to nine shifts can be specified on each. End times are entered in hours and minutes using the 24-hour clock.

Rules that apply to shift records:

- Day is defined as the first three letters of the day.
- Up to nine shifts per day can be specified.
- The preceding end time must always be less than the next end time.
- No shift spans midnight.
- If you define shifts for one or more days of the week, but not all days, the shifts for the remaining days are defined as follows by default:
  
  3 0800 1 1630 2 2400

**Example:**

For the following shifts:

Monday through Friday

Shift 1 - 5 AM to 8 AM and 3:30 PM to 5 PM

Shift 2 - 8 AM to 11:30 AM and 1:30 PM to 3:30 PM

Shift 3 - 5 PM to 8 PM

Shift 4 - 9:30 PM to 12 AM and 12 AM to 5 AM

Shift 5 - 11:30 AM to 1:30 PM and 8 PM to 9:30 PM

Saturday and Sunday

Shift 1 - 8 AM to 5 PM

Shift 2 - 5 PM to 12 AM and 12 AM to 8 AM
Control and Processing Statements
ITUAM Processing Engine Control Statements (UNIX or Linux)

The SHIFT statements are as follows:

SHIFT SUN 2 0800 1 1700 2 2400
SHIFT MON 4 0500 1 0800 2 1130 5 1330 2 1530 1 1700 3 2000 5 2130 4 2400
SHIFT TUE 4 0500 1 0800 2 1130 5 1330 2 1530 1 1700 3 2000 5 2130 4 2400
SHIFT WED 4 0500 1 0800 2 1130 5 1330 2 1530 1 1700 3 2000 5 2130 4 2400
SHIFT THU 4 0500 1 0800 2 1130 5 1330 2 1530 1 1700 3 2000 5 2130 4 2400
SHIFT FRI 4 0500 1 0800 2 1130 5 1330 2 1530 1 1700 3 2000 5 2130 4 2400
SHIFT SAT 2 0800 1 1700 2 2400

UPPERCASE ACCOUNT FIELDS

Format:

UPPERCASE ACCOUNT FIELDS

This control statement instructs CIMSAcct to convert lowercase account code input field values to uppercase values in the resulting account code. For example, the value ddic would be converted to DDIC. By using this option, CIMSAcct account code processing becomes case-insensitive and makes defining account conversion tables much easier.
## CIMSBill Control Statements

This section describes the CIMSBill control statements.

<table>
<thead>
<tr>
<th>CONTROL STATEMENT</th>
<th>SEE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>BACKLOAD DATA</td>
<td>[page D-36]</td>
<td>Instructs CIMSBill to ignore the close date. The accounting dates created by CIMSBill are the same as the usage end date regardless of the close date.</td>
</tr>
<tr>
<td>CLIENT SEARCH ON</td>
<td>[page D-36]</td>
<td>Instructs CIMSBill to use the account code structure definition to search the CIMSCClient table for the rate code table associated with a client.</td>
</tr>
<tr>
<td>DATE SELECTION</td>
<td>[page D-36]</td>
<td>Defines a date range for records to be processed by CIMSBill.</td>
</tr>
<tr>
<td>DEFAULT CLOSE DAY</td>
<td>[page D-37]</td>
<td>Overrides the system-wide close date.</td>
</tr>
<tr>
<td>DEFINE</td>
<td>[page D-37]</td>
<td>Defines the account code structure used by the statements CLIENT SEARCH ON and DYNAMIC CLIENT ADD ON.</td>
</tr>
<tr>
<td>DYNAMIC CLIENT ADD ON</td>
<td>[page D-38]</td>
<td>Specifies that CIMSBill automatically insert corresponding client entries into the CIMSCClient table for all clients that have a resource usage charge.</td>
</tr>
<tr>
<td>EXCLUDE</td>
<td>[page D-38]</td>
<td>Specifies an exclude record condition.</td>
</tr>
<tr>
<td>INCLUDE</td>
<td>[page D-39]</td>
<td>Specifies an include record condition.</td>
</tr>
<tr>
<td>KEEP ORIGINAL CPU VALUES</td>
<td>[page D-39]</td>
<td>Specifies whether to include the original CPU value as an identifier.</td>
</tr>
<tr>
<td>REPORT DATE</td>
<td>[page D-40]</td>
<td>Specifies the accounting dates that are put into the Summary and Detail records created by CIMSBill.</td>
</tr>
<tr>
<td>USE SHIFT CODES</td>
<td>[page D-41]</td>
<td>Instructs CIMSBill to use the shift character specified in the CIMSAcct Output CSR+ record and apply the appropriate rate shift value.</td>
</tr>
</tbody>
</table>
**BACKLOAD DATA**

**Format:**

```
BACKLOAD DATA
```

This statement instructs CIMSBill to ignore the close date. The accounting dates created by CIMSBill are the same as the usage end date regardless of the close date.

**CLIENT SEARCH ON**

**Format:**

```
CLIENT SEARCH ON
```

This statement instructs CIMSBill to use the account code structure definition (by use of the `DEFINE Jn` fields, see page D-16) to search the CIMSClient table for the rate code table associated with a client. If this statement is not specified, the STANDARD rate code table is used for all clients.

**DATE SELECTION**

**Format:**

```
DATE SELECTION {YYYYMMDD YYYYMMDD | keyword}
```

This statement defines a date range for records to be processed by CIMSBill. Records are selected by the accounting end date in the record. You can use the following values:

- From and to dates. For a record to be selected, it must be greater than or equal to the from date and less than or equal to the to date.
- One of the following keywords:

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RNDATE</strong></td>
<td>Selects records based on the run date</td>
</tr>
<tr>
<td><strong>CURDAY</strong></td>
<td>Selects records based on the run date and the run date less one day</td>
</tr>
<tr>
<td><strong>CURWEK</strong></td>
<td>Selects records based on the run week (Sun–Sat)</td>
</tr>
<tr>
<td><strong>CURMON</strong></td>
<td>Selects records based on run month</td>
</tr>
<tr>
<td><strong>PREDAY</strong></td>
<td>Selects records based on run date, less one (day)</td>
</tr>
<tr>
<td><strong>PREWEK</strong></td>
<td>Selects records based on previous week (Sun–Sat)</td>
</tr>
<tr>
<td><strong>PREMON</strong></td>
<td>Selects records based on previous month</td>
</tr>
<tr>
<td>CURRENT</td>
<td>Selects current period from the CIMSCalendar table</td>
</tr>
<tr>
<td>PREVIOUS</td>
<td>Selects previous period from the CIMSCalendar table</td>
</tr>
</tbody>
</table>
Examples:

DATE SELECTION 20060601 20060630
DATE SELECTION **PREMON

**DEFAULT CLOSE DAY**

**Format:**

DEFAULT CLODE DAY=nn

nn = 01–31

This statement overrides the system-wide close date set in the Configuration dialog box in ITUAM Administrator. The year and month used for the close day reflect the year and month in which CIMSBill is run. For more information about the close date, see About the Close Date on page 8-26.

**Example:**

DEFAULT CLOSE DAY=8

This statement sets the close date to the eighth of the month. If the CIMSBill run date is 20060706, the close date is set to 20060708. If the CIMSBill run date is 20060712, the close date is also set to 20060708.

**DEFINE**

This statement is used with the CLIENT SEARCH ON and DYNAMIC CLIENT ADD ON statements to specify the client account code structure. You can specify up to nine account levels (fields J1–J9).

**Format:**

DEFINE Jn start_loc len /desc/

n = 1–9

start_loc = starting position within the account code

len = total length of the level

desc = a description for the field

**Example:**

Account code AAABBBCCCCDDDD contains four levels. To search from the lowest level to the highest level, use the following define fields:

DEFINE J1 1 3
DEFINE J2 1 6
DEFINE J3 1 8
DEFINE J4 1 13
CLIENT SEARCH ON
For the previous define fields:

J1=AAA
J2=AAABBB
J3=AAABBBCC
J4=AAABBBCCDDDDD

CIMSBill first searches for AAABBBCCDDDDD and if it does not find an entry it searches for AAABBBCC and so on.

**DYNAMIC CLIENT ADD ON**

**Format:**

DYNAMIC CLIENT ADD ON

This statement specifies that CIMSBill automatically insert corresponding client entries in the CIMSClient table for all clients that have a resource usage charge, but are not entered in the table. *Use this statement with caution because it can quickly fill the CIMS Client table with extraneous records.*

The inserted client entries will not include descriptions or contacts.

**EXCLUDE**

**Format:**

EXCLUDE,record_header,identifier_name,offset,length,low,high

record_id = record header
identifier_name = name of identifier
offset = starting offset into identifier value
length = identifier value length from offset (1–128)
low = low or from identifier value for comparison (1–128)
high = high or to identifier value for comparison (1–128)

When this statement is present, CIMSBill searches for records that contain the specified identifier name. Records in which the values for the identifier are equal to or greater than the low value and equal to or less than the high value are excluded from processing. All other records are included.

**Example:**

Assume that you want to exclude all UNIX storage records that contain *UserName* identifier values that begin with geo. The control statement would be:

EXCLUDE,UNIXSTOR,UserName,1,3,geo,geo
**INCLUDE**

Format:

INCLUDE,record_header,identifier_name,offset,length,low,high

record_id = record header

identifier_name = name of identifier

offset = starting offset into identifier value

length = identifier value length from offset (1–128)

low = low or from identifier value for comparison (1–128)

high = high or to identifier value for comparison (1–128)

When this statement is present, CIMSBill searches for records that contain the specified identifier name. Records in which the values for the identifier are equal to or greater than the low value and equal to or less than the high value are included in processing. All other records are excluded.

Example:

Assume that you want to include only those UNIX storage records that contain UserName identifier values that begin with geo. The control statement would be:

INCLUDE,UNIXSTOR,UserName,1,3,geo,geo

**KEEP ORIGINAL CPU VALUES**

Format:

KEEP ORIGINAL CPU VALUES

If CPU normalization is performed (see NORMALIZE CPU VALUES), this statement instructs CIMSBill to save the original CPU value as an identifier value. The identifier name is prefixed by Orig_ followed by the rate code.

Example:

Assume that a CSR record contains the CPU rate code LLA105 with a resource value of 1.15. If CPU normalization is performed and the KEEP ORIGINAL CPU VALUES control statement is present, a new identifier will be built for the record with the identifier name Orig_LLA105 and a value of 1.15.

**NORMALIZE CPU VALUES**

Format:

NORMALIZE CPU VALUES

This statement instructs CIMSBill to normalize CPU values. For more information about normalizing CPU values, see page 8-44.
**REPORT DATE**

**Important!** CIMS Lab recommends that you do not use this statement. This statement will place report dates rather than actual usage end dates in the accounting date fields of the CIMSBill Summary records.

**Format:**

```
REPORT DATE {YYYYYMMDD YYYYMMDD | keyword}
```

This statement specifies the dates that are used as the accounting dates in the CIMS Summary records created by CIMSBill. This is the date that is used for reporting purposes in CIMS Server. You can use the following values:

- From and to dates
  - or
- One of the following keywords:

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RNDATE</strong></td>
<td>Sets the date range based on the run date</td>
</tr>
<tr>
<td><strong>CURDAY</strong></td>
<td>Sets the date range based on the run date and the run date less one day</td>
</tr>
<tr>
<td><strong>CURWEK</strong></td>
<td>Sets the date range based on the run week (Sun–Sat)</td>
</tr>
<tr>
<td><strong>CURMON</strong></td>
<td>Sets the date range based on the run month</td>
</tr>
<tr>
<td><strong>PREDAY</strong></td>
<td>Sets the date range based on the run date, less one day</td>
</tr>
<tr>
<td><strong>PREWEK</strong></td>
<td>Sets the date range based on the previous week (Sun–Sat)</td>
</tr>
<tr>
<td><strong>PREMON</strong></td>
<td>Sets the date range based on the previous month</td>
</tr>
<tr>
<td>CURRENT</td>
<td>Sets the date range based on the current period from the CIMSCalendar table</td>
</tr>
<tr>
<td>PREVIOUS</td>
<td>Sets the date range based on the previous period from the CIMSCalendar table</td>
</tr>
<tr>
<td>USE DETAIL DATES</td>
<td>Sets the date range based on the CIMSAcct Detail record (consult CIMS Lab before using this keyword)</td>
</tr>
</tbody>
</table>

**Examples:**

```
REPORT DATE 20060601 20060630
REPORT DATE **PREMON
```
USE SHIFT CODES

Format:

USE SHIFT CODES

This statement instructs CIMSBill to use the shift character specified in the CIMSAcct Output CSR+ record and apply the appropriate rate shift value.

If a shift value is not defined for the rate, the default rate value for the resource will be used. The default rate value is also the SHIFT 1 rate value.
Notices

This information was developed for products and services offered in the U.S.A. IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement might not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX  78758
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurement may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.
Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

**Trademarks**

The following are trademarks of International Business Machines Corporation in the United States, other countries, or both:

<table>
<thead>
<tr>
<th>AIX</th>
<th>DB2 Connect</th>
<th>PowerPC</th>
</tr>
</thead>
<tbody>
<tr>
<td>CICS</td>
<td>DB2 Universal Database</td>
<td>Tivoli</td>
</tr>
<tr>
<td>DB2</td>
<td>IBM</td>
<td>z/OS</td>
</tr>
</tbody>
</table>

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product, or service names may be trademarks or service marks of others.
Glossary

**ASP** • Acronym for Active Server Pages. A server-side scripting environment developed by Microsoft for developing Web pages and applications.

**cascading style sheets** • Cascading style sheets contain typographical information on how an HTML page should appear (i.e., fonts, colors, table and list formats, etc.).

**CSR File** • The resource file that contains the data that is input into ITUAM. The records in this file are comma-delimited and can contain a very large number of resource identifiers and resources. *See also identifier and rate code.*

**CSR+ File** • CSR+ files are similar to CSR files, with the exception that the records in the CSR+ file contain an additional header at the beginning of the record.

**client** • 1. A computer that accesses shared network resources provided by a server. 2. In ITUAM, an entity that consumes resources. A client is represented by an account code.

**COM** • Acronym for Component Object Model. A specification developed by Microsoft for building software components that can be assembled into programs or add functionality to existing programs running on Microsoft Windows platforms.

**cookie** • A small text file that stores information about a Web site user. ITUAM Web Reporting stores user information, such as the report parameter values entered by a user, in a cookie.

**database alias** • An alias name given to a remote or local DB2 database. Database names must be unique on a DB2 server. However, a DB2 client can have connections to two different databases that have the same name if those databases reside on different servers and each database has its own alias. If an alias is not specified for a database, the default alias is the database name.

**DBMS** • Acronym for Database Management System. Software used to organize, analyze, and modify information stored in a database.

**domain** • A set of network resources (applications, printers, etc.) for a group of users. The user need only to log in to the domain to gain access to the resources, which may be located on a number of different servers in the network.

**ERD** • Acronym for Entity Relationship Diagram. A diagram that illustrates the logical structure of a database.
**identifier** • In the CSR or CSR+ record, a unique key that denotes the source of a resource that has been consumed. Examples include device name, server name, system ID, phone number, user ID, state code or building number. A consumed resource can have one to many identifiers.

**internationalization** • In software development, internationalization is the process of planning and implementing a product so that it can easily be adapted (localized) to specific languages. The word “internationalization” is sometimes abbreviated as “I18N” because there are 18 letters between the first letter “I” and the last letter “N”. See also [localization](#).

**IIS** • Acronym for Internet Information Services. Microsoft software that supports Web site creation, configuration, and management.

**Java** • An object-oriented programming language developed by Sun Microsystems. Java is designed to be platform neutral.

**JDBC** • An application program interface (API) specification for connecting programs written in Java to the data in popular databases.

**JRE** • Acronym for Java Runtime Environment. The JRE is part of the Java Development Kit (JDK), a set of programming tools for developing Java applications. The JRE provides the minimum requirements for executing a Java application; it consists of the Java Virtual Machine (JVM), core classes, and supporting files.

**localization** • In software development, the process of adapting an internationalized product for a specific language, script, culture, and coded character set. The word “localization” is sometimes abbreviated as “L10N” because there are 10 letters between the first letter “L” and the last letter “N”. See also [internationalization](#).

**ODBC** • Acronym for Open Database Connectivity. An interface providing a common language for database access.

**offset** • A number that indicates how far from a starting point an item is located.

**rate code** • A rate code represents the resource units being reported (for example, CPU time, transactions processed, or lines printed). The rate code includes the value for the resource and other rate processing information.

**UNC** • Acronym for Universal Naming Convention. A file naming system beginning with two backslashes (\") that indicates that the resource exists on a network computer. The syntax is "\servername\sharename".

**URL** • Acronym for Uniform Resource Locator. The address for a resource on the Internet or an intranet.

**Windows Script Host** • A language-independent scripting host for Windows Script-compatible scripting engines. WSH acts as a host for scripts—it makes objects and services available for the script and provides a set of guidelines within which the script is executed.

**XML** • Acronym for Extensible Markup Language. A simple, very flexible text format derived from SGML. XML allows for more precise declarations or content and more meaningful search results across multiple platforms.
Index

Numerics
13 periods, using 4-43

A
account code conversion
about 7-17, 8-30
example 7-47 to 7-49, 8-39 to 8-41
options for, setting 7-43 to 7-44, 8-34 to 8-36
table, creating 7-45 to 7-46, 8-36 to 8-38
account code structure
about 4-3
alternate 4-8
adding 4-8, 11-16
removing 4-8
renaming 4-8
example of 4-3
levels
creating 4-4 to 4-7
ing 4-4 to 4-7
offset number, setting 4-7
removing 4-7
Standard 4-4
account codes
about 7-17, 7-40, 8-30, 8-31
assigning clients to 4-19 to 4-21
defining the identifiers used for (UNIX/Linux)
8-32 to 8-33
defining the identifiers used for (Windows)
7-41 to 7-42
starting and ending code levels for Web
testing, setting 4-47
accounting dates
about 7-18, 8-26
and the close date 7-18, 8-26
calculation of 7-19 to 7-21, 8-27 to 8-29
accounting periods, using 13 periods 4-26
adding
account code structure levels 4-4 to 4-7
alternate account code structures 4-8, 11-16
alternate rate tables 4-15
budgets
for clients 4-21 to 4-22
to cost models 9-5, 9-7
client contacts 4-24
clients 4-19 to 4-20
clients to user groups 4-37
cost models 9-4
cost pools and subpools 9-6
ITUAM Data Sources 6-5
process definitions (Windows) 7-22
rate codes 4-9 to 4-12
rate codes to rate group 4-11, 4-18
rate groups 4-11, 4-16 to 4-17
rate shifts 4-13
report cycles 5-27 to 5-35
report groups 5-19 to 5-20
reports to report groups 5-20
reports to reports list 5-17 to 5-18
reports to user groups 4-36
user groups 4-32
users 4-27
users to a group 4-35
Web headlines 4-38
aggregating CSR and CSR+ files C-11
AllAccts.wsf script C-38 to C-40
Apache Tomcat
  IIS, configuring with
    on Windows 2000 Server 10-2
    on Windows Server 2003 10-2
  installing 2-6
archiving
  database loads 6-19 to 6-21
  archive file path setting 4-53
  compression type and level settings 4-53
previous ITUAM Processing Engine output (Windows) 7-24
ASP.NET, enabling 2-17
attributes
  Parameters element
    CIMSAcct 8-18 to 8-20
    CIMSBill 8-21 to 8-23
    CIMSLoad 8-23 to 8-25
  Step element 8-17
auto logon for ITUAM Web applications, enabling 4-48

B
backing up databases 6-4, C-24
backload data option (Windows) 7-33
batch reporting See published reports
BatchReport.wsf script C-31 to C-37
browser requirements
  ITUAM Web Reporting 2-9
  SQL Server Reporting Services Report Manager 2-19
budgets
  for clients
    adding 4-21 to 4-22
    removing 4-23
  in cost models, creating 9-5, 9-7
BuildCSRFromDB.wsf script C-6
bulk loading the database option (Windows) 7-25
BulkUserLoad.wsf script C-22

C
calendar
  about 4-25
  considerations 4-26
  enabling the use of 4-43
  setting 4-25 to 4-26
  using 13 accounting periods 4-26, 4-43
CIMSAcct
  about 7-7, 8-6
  control statements D-2 to D-12, D-26 to D-34
Detail file
  about B-7 to B-8
  layout of B-7 to B-8
  load option (Windows) 7-25
Exception file, about 7-10, 8-9
input
  file selection option (Windows) 7-28
  files, list of 7-8 to 7-9, 8-7 to 8-8
  record date selection option (Windows) 7-27
  record type selection option (Windows) 7-27
Message file
  about 7-10, 8-9
  printing trace messages to (Windows) 7-31
  printing unmatched identifiers to D-10
null character check, using D-12
output
  file name options (Windows) 7-28
  files, list of 7-10, 8-9
  parameters for 8-18 to 8-20
  run option (Windows) 7-24
CIMSAadminLib (Windows), about 7-15
CIMSBill
  about 7-11 to 7-12, 8-10
  control statements D-13 to D-23, D-35 to D-41
Detail file
  about B-9
  layout of B-9
  load option (Windows) 7-25
input
  file selection option 7-34
  files, list of 7-13 to 7-14, 8-11
  record date selection option (Windows) 7-32
  record type selection option (Windows) 7-32
Message file
  about 7-14, 8-12
  printing trace messages to (Windows) 7-36
output
  file name options (Windows) 7-34
  files, list of 7-14 to 7-15, 8-12
  parameters for 8-21 to 8-23
  run option (Windows) 7-24
CIMSLib.wsf script C-7
CIMSLoad (UNIX/Linux)
- about 8-13
- input files, list of 8-13 to 8-14
- output files, list of 8-14
- parameters for 8-23 to 8-25

CIMSRateIdentifiers table, updating 6-13

CIMSSort (UNIX/Linux), about 8-10

CIMSSort (Windows), about 7-11

CIMSUtil.wsf script C-7

client (account code)
- about 4-19
- add to client table option (Windows) 7-35
- adding 4-19 to 4-20
- budgets for
  - about 4-21
  - adding 4-21 to 4-22
  - removing 4-23
- contacts
  - adding 4-24
  - automatic creation of C-7
  - editing 4-24
  - removing 4-24
- data, exporting 4-24
- editing 4-20
- name
  - assigning 4-20
  - automatic creation of C-7
- rate table search option (Windows) 7-35
- removing 4-21
- table
  - exporting 6-11, 6-12
  - loading 6-11, 6-12, C-27

client (Windows computer)
- installing ITUAM Administrator on 2-8
- specifications 2-8
- system specifications 2-8 to 2-9
- viewing Web reports on 2-9

ClientPropogate.wsf script C-7

close date
- about 7-18, 8-26
- setting
  - for all process definitions 4-43
  - for an individual process definition (Windows) 7-32

configuration settings
- accessing 4-42
- defaults, returning to 4-42
- entering

database settings 4-46
- organization information 4-42
- processing settings 4-43
- report settings 4-44 to 4-46
- table audit settings 4-52
- Web settings 4-47

contacts for clients, entering 4-24

control statements
- CIMSAcct
  - (UNIX/Linux) D-26 to D-34
  - (Windows) D-2 to D-12
- CIMSBill
  - (UNIX/Linux) D-35 to D-41
  - (Windows) D-13 to D-23
- processing (Windows) D-24 to D-25

ConvertSummaryDailyToMonthly.wsf script C-8 to C-10

cost modeling See ITUAM Financial Modeler

CPU values, normalizing 7-56 to 7-58, 8-44 to 8-45

creating
- account code conversion tables 7-46, 8-36 to 8-38
- alternate account code structures 4-4 to 4-7
- alternate rate tables 4-15
- budgets for clients 4-21 to 4-22
- in cost models 9-5, 9-7
- client contacts 4-24
- clients 4-19 to 4-20
- cost models 9-4
- cost pools and subpools 9-6

databases
- DB2 for Linux, UNIX, and Windows 2-40
- DB2 for z/OS 2-49
- MSDE 2-79
- Oracle 2-72
- SQL Server 2-60

ITUAM Data Sources
- for a DB2 for z/OS database 2-51 to 2-59
- for a DB2 Linux, UNIX, and Windows database 2-41 to 2-48
- for a SQL Server database 2-64 to 2-71
- for an MSDE database 2-80 to 2-82
- for an Oracle database 2-73 to 2-78

processes folder 2-85

proration tables 7-51
rate groups 4-11, 4-16 to 4-17
rate shifts 4-13
report groups 5-19 to 5-20
user groups 4-32
users 4-27
Windows user account for ITUAM 2-34

Crystal Reports
creating parameter fields in 5-14 to 5-16
system specifications
for designing reports 2-9
for running reports 2-6
version 10, installing 11-25
version 9, installing 11-24
version XI
  configuring Crystal Reports Server 2-105 to 2-108
  installing 2-20 to 2-22
  troubleshooting 11-14
CS_aggtools (UNIX/Linux), about 8-14
CS_libs (UNIX/Linux), about 8-14
CSR file
  about 1-10 to 1-11, B-2
  format of B-2 to B-3
  identifiers in, defining for ITUAM 1-11
  rate codes in, defining for ITUAM 1-10
CSR+ file
  about 1-10 to 1-11, B-4
  format of B-4 to B-6
  identifiers in, defining for ITUAM 1-11
  rate codes in, defining for ITUAM 1-10
CSRAggregator.wsf script C-11
custom reports
  about 1-9
  path setting 2-88, 4-44
  Web site, settings for 4-50 to 4-51

D
data collectors See ITUAM Data Collectors
data processing See processing data
data sources See ITUAM Data Sources
database
  about 1-7
  backing up 6-4, C-24
  connecting to
    DB2 for Linux, UNIX, and Windows 2-41 to 2-48
    DB2 for z/OS 2-50 to 2-59
    MSDE 2-80 to 2-82
    SQL Server 2-64 to 2-71, 2-73 to 2-78
  creating and setting up
    DB2 for Linux, UNIX, and Windows 2-40
    DB2 for z/OS 2-49
    MSDE 2-79 to 2-80
    Oracle 2-72 to 2-73
    SQL Server 2-60 to 2-71
ERDs (Entity Relationship Diagrams) A-51 to A-56
initializing 2-83
ITUAM Administrator connection, confirming 6-25
ITUAM Data Source for See ITUAM Data Sources
loading 6-17 to 6-18
loading files to
  from ITUAM Administrator 6-17 to 6-18
loads
  archive settings 4-53
  archiving 6-19 to 6-21
  deleting 6-22
  purging 6-21, C-17
  restoring 6-21
  tracking 6-22
objects
  about 6-14
  creating 6-15
  dropping 6-15
  profiling 6-24
recovery model, setting (SQL Server only) 6-5
sending to IBM for troubleshooting (SQL Server only) 11-17 to 11-20
server specifications 2-7
tables
  converting daily summary data to monthly summary data C-8 to C-10
  creating 6-13
  description of A-4 to A-50
  dropping 6-13
  exporting 6-11
  loading 6-11
  viewing 6-13
time-out setting 4-46, 4-52
upgrading 6-25
using multiple databases for Web reporting 6-8 to 6-9
versions supported
DB2 for Linux, UNIX, and Windows 2-7
DB2 for z/OS 2-7
MSDE 2-7
Oracle 2-7
SQL Server 2-7
DB2 for Linux, UNIX, and Windows database
  connecting to 2-41 to 2-48
  creating and setting up 2-40
  ITUAM Data Source for, creating 2-41 to 2-48
  versions supported by ITUAM 2-7
DB2 for z/OS database
  connecting to 2-50 to 2-59
  creating and setting up 2-49
  ITUAM Data Source for, creating 2-51 to 2-59
  versions supported by ITUAM 2-7
DB2 JDBC driver, installing 3-13 to 3-15
debugging ITUAM 11-16
deleting
  account code structure levels 4-7
  alternate account code structures 4-8
  alternate rate tables 4-15
  budgets for clients 4-23
  client contacts 4-24
  clients 4-21
  clients from user groups 4-37
  cost models 9-16
  cost pools and subpools 9-6
  database loads 6-21, 6-22, C-17
  ITUAM Data Sources 6-7
  published reports 5-26
  rate codes 4-13
  rate codes from rate groups 4-18
  rate groups 4-17
  report cycles 5-35
  report groups 5-20
  reports from report groups 5-20
  reports from reports list 5-18
  reports from user groups 4-36
  unused identifiers 4-40
    from the CIMSDetailIdent table C-12
    from the CIMSIdent table C-12
  user groups 4-36
  users 4-31
  users from a group 4-36
  Web headlines 4-38
Detail file See CIMSAcct Detail file or CIMSBill Detail file
disaster recovery 11-21
DropIdentBeforeLoad.wsf script C-12
DropIdentFromDB.wsf script C-12
E
  editing
    account code structure levels 4-4 to 4-7
    client contacts 4-24
    clients 4-20
    ITUAM Data Sources 6-6
    rate codes 4-10 to 4-12
    report cycles 5-35
    report settings 5-18, 5-28
    user groups 4-33 to 4-34
    users 4-28 to 4-30
    Web headlines 4-38
EmailDistribution.wsf script C-40
Entity Relationship Diagrams (ERDs) A-51 to A-56
Event Viewer, increasing log size in 2-92
  events, viewing (Windows) 7-38 to 7-39
exception file processing
  about 7-17, 8-30
  enabling 7-44
F
  file layouts
    CIMSAcct Detail file B-7 to B-8
    CIMSBill Detail file B-9
    CSR file B-2
    CSR+ file B-4
    Summary file B-11 to B-12
    Summary file C-12 to C-13
  Financial Modeler See ITUAM Financial Modeler
  folder permissions required
    for accessing published reports 5-48
    for data processing 7-5, 8-4
    for Web user 2-96
  FTP.wsc script C-13
  FTPSample.wsf script C-13
G
  getting started 2-83 to 2-111
  groups See users and groups, report groups, or rate groups
**Index**

**H**

headlines, Web
- about 4-38
- adding 4-38
- editing 4-38
- removing 4-38

help, accessing 2-111

**I**

IBM Director, starting ITUAM Administrator from 2-111

Ident file
- about B-8
- eliminating duplicates from (Windows) 7-29
- layout of B-8
- load option (Windows) 7-24

identifiers
- adding descriptions for 4-39
- defining for account codes (UNIX/Linux) 8-32 to 8-33
- defining for account codes (Windows) 7-41 to 7-42
- definition of 1-2
- in the CSR or CSR+ file 1-11
- including or excluding from processing 7-59 to 7-64, 8-46
- removing unused 4-40
  - from the CIMSDetailIdent table C-12
  - from the CIMSIdent table C-12
- unused list, creating C-13
- updating in CIMSRateIdentifiers table 6-13

IIS
- anonymous access, enabling 2-94
- Apache Tomcat, configuring for 10-2 to 10-3
  - required version 2-5
- restarting 11-5, 11-15
- Windows authenticated access, enabling 2-94
- include fields, specifying (Windows) 7-28
- include/exclude processing 7-59 to 7-64, 8-46
  - example 7-62 to 7-64
- initializing the database 2-83
- installing
  - Crystal Reports 10 11-25
  - Crystal Reports 9 11-24
  - Crystal Reports XI 2-20 to 2-22
- ITUAM
  - modifying installation 2-32
  - on a Windows system 2-26 to 2-31
- ITUAM Administrator 2-27
- ITUAM Aggregation Engine 2-27
- ITUAM Conversion Engine 2-27
- ITUAM Data Collectors for UNIX and Linux 3-12
- ITUAM on a UNIX/Linux system 3-5 to 3-10
- ITUAM Processing Engine (Windows) 2-27
- ITUAM Web Reporting 2-27
- JDBC drivers 3-13
  - DB2 3-13 to 3-15
  - Oracle 3-16
  - other 3-17
  - other drivers 3-16
  - SQL Server 3-16
- MSDE 2-27
- Oracle client 2-73
- Perl 3-5
- internationalizing ITUAM 2-13 to 2-16
- Internet Explorer, required version 2-9
- invoice number parameter setting 5-39
- invoices
  - entering contact information for 4-24
  - entering organization information for 4-42
  - setting invoice numbers 4-46
- ITUAM
  - application server (Windows) specifications 2-5 to 2-6
  - benefits of 1-2
  - configuration settings
    - accessing 4-42
    - defaults, returning to 4-42
  - debugging 11-16
  - features 1-3
  - getting started 2-83 to 2-111
  - installing
    - on a UNIX/Linux system 3-5 to 3-10
    - on a Windows system 2-26 to 2-31
  - internationalization of 2-13 to 2-16
  - setup instructions 2-83 to 2-97
  - upgrading on a Windows system 2-32
  - Window user account for, creating 2-34
- ITUAM Administrator 2-8
- dialog boxes, moving and resizing 2-111
- help, accessing 2-111
- installing 2-27
- processing data using 7-38
- setting data processing options in (Windows) 7-21 to 7-37
starting
from IBM Director 2-111
from Windows Start menu 2-83
ITUAM Aggregation Engine, installing 2-27
ITUAM Conversion Engine, installing 2-27
ITUAM Data Collectors
about 1-4
installing
on UNIX/Linux 3-12
on Windows 2-29 to 2-32
ITUAM Data Collectors for UNIX and Linux, installing 3-12
ITUAM Data Sources
about 2-38, 6-5
adding 6-5
creating and configuring
for a DB2 for Linux, UNIX, and Windows database 2-41 to 2-48
for a DB2 for z/OS database 2-51 to 2-59
for a SQL Server database 2-64 to 2-71
for an MSDE database 2-80 to 2-82
for an Oracle database 2-73 to 2-78
default, setting 6-6
editing 6-6
removing 6-6
renaming 6-6
selecting for ITUAM Administrator 2-83
ITUAM Financial Modeler
about 9-2
access to, enabling 4-33
auto logon for, enabling 4-48
budgets
creating 9-5
distributing 9-7
cost models
adding rate codes to 9-8
creating and setting up 9-4 to 9-16
removing rate codes from 9-8
sharing 9-15
cost pools and subpools
adding 9-6
removing 9-6
installing 2-27
logging on to 9-3
rates in
calculating 9-9 to 9-15
updating 9-12
reports in
running 9-17 to 9-21
saving, printing, and editing 9-21
starting 9-3
ITUAM Processing Engine (UNIX/Linux)
about 8-5
control file
about 8-16
example 8-16
diagram 8-15
ITUAM Processing Engine (Windows)
about 7-6
archiving previous output created by 7-24
diagram 7-16
installing 2-27
removing previous output created by 7-24
ITUAM Processing Engine Administrator
starting 3-19
ITUAM Web Console
about 10-2
access to, enabling 4-34
Apache Tomcat
IIS configuration with 10-2 to 10-3
Apache Tomcat, installing 2-6
job logs, viewing 10-4 to 10-5
logging on to 10-4
requirements for 2-10
setting up 10-2 to 10-3
starting 10-3
ITUAM Web Reporting
about 1-8
auto logon, enabling 4-48
browser requirements 2-9
installing 2-27
starting 2-110
J
JDBC drivers
about 3-13
installing
DB2 3-13 to 3-15
Oracle 3-16
other 3-17
SQL Server 3-16
job logs, viewing online 10-4 to 10-5
Job Runner, about 7-3
Index

L
ListUnusedIdentifiers.wsf script C-13
LoadClientTableFromCSVfile.wsf script C-42
localizing ITUAM 2-13 to 2-16
LogDate parameter
about 8-48
values for 8-48
logo for reports, changing 5-22

M
MDAC
downloading 2-26
version in ITUAM installation 2-26
MSDE database
connecting to 2-80 to 2-82
creating and setting up 2-79 to 2-80
installing 2-27
ITUAM Data Source for, creating 2-80 to 2-82
user logins, creating 2-80
version supported by ITUAM 2-7

N
nightly.pl script
about 8-49
parameter requirements for 8-49
nightly.sh script
about 8-47
scheduling 8-47
variables in 8-47
normalizing CPU values 7-56 to 7-58, 8-44 to 8-45
null character check, using D-12

O
offsets for account code levels 4-7
Oracle database
client requirement 2-3
client, installing 2-73
connecting to 2-73 to 2-78
creating and setting up 2-72 to 2-73
ITUAM Data Source for, creating 2-73 to 2-78
versions and platforms supported by ITUAM 2-7
Oracle JDBC driver, installing 3-16
OracleLogonTrigger.bat script C-14

P
Parameter element
about 8-18
attributes
CIMSAcct 8-18 to 8-20
CIMSBill 8-21 to 8-23
CIMSLoad 8-23 to 8-25
Parameters element, about 8-18
parameters for reports
customizing 5-14 to 5-16
list of 5-37 to 5-41
password for ITUAM Web application user
default 4-27
setting 4-30
Perl, installing 3-5
permissions required (folder)
for accessing published reports 5-48
for data processing, 7-5, 8-4
for Web user 2-96
pre-installation checklist
UNIX/Linux installation 3-6
Windows and database installation 2-9
procCIMS.pl script, about 8-49
ProcCntl.xml file
about 8-16
example 8-16
Parameter element
CIMSAcct attributes 8-18 to 8-20
CIMSBill attributes 8-21 to 8-23
CIMSLoad attributes 8-23 to 8-25
Parameters element, about 8-18
Parameters element, about 8-18
Step element
attributes for 8-17
process definitions
See also processing data
samples 2-91
process definitions (Windows)
about 7-21
adding 7-22
processing options, setting 7-23 to 7-36
processes folder
creating 2-85
path setting 4-43
processing control statements (Windows) D-24 to D-25
processing data
account code conversion
  about 7-17, 8-30
  example 7-47 to 7-49
  options for, setting 7-43 to 7-44, 8-34 to 8-36
  table, creating 7-45 to 7-46, 8-36 to 8-38
account codes
  about 7-17, 8-30
accounting dates
  about 7-18, 8-26
  and the close date 7-18, 8-26
  calculation of 7-19 to 7-21, 8-27 to 8-29
CIMSAcct (UNIX/Linux)
  about 8-6
  control statements D-26 to D-34
  input files, list of 8-7 to 8-8
  output files, list of 8-9
CIMSAcct (Windows)
  about 7-7
  control statements D-2 to D-12
  output files, list of 7-10
CIMSAcct Windows input files, list of 7-8 to 7-9
CIMSAdminLib (Windows)
  about 7-15
CIMSBill
  about 7-11 to 7-12, 8-10
  input files, list of 7-13 to 7-14
  output files, list of 7-14 to 7-15
CIMSBill (UNIX/Linux)
  control statements D-35 to D-41
  input files, list of 8-11
  output files, list of 8-12
CIMSBill (Windows)
  control statements D-13 to D-23
CIMSLoad (UNIX/Linux)
  about 8-13
  input files, list of 8-13 to 8-14
  output files, list of 8-14
CIMSSort (UNIX/Linux), about 8-10
CIMSSort (Windows), about 7-11
control statements
  CIMSAcct (UNIX/Linux) D-26 to D-34
  CIMSAcct (Windows) D-2 to D-12
  CIMSBill (UNIX/Linux) D-35 to D-41
  CIMSBill (Windows) D-13 to D-23
  processing (Windows) D-24 to D-25
CPU values, normalizing 7-56 to 7-58, 8-44 to 8-45
CS_aggtools (UNIX/Linux), about 8-14
CS_libs (UNIX/Linux), about 8-14
exception file processing
  about 7-17, 8-30
  enabling 7-44
folder permissions required for 7-5, 8-4
frequency of, suggested 7-4, 8-3
include/exclude processing
  example 7-62 to 7-64
ITUAM Processing Engine (UNIX/Linux)
  about 8-5
ITUAM Processing Engine (Windows)
  about 7-6
  process definitions (Windows)
    about 7-21
    adding 7-22
process options
  account fields 7-42
  conversion table 7-44
  convert account fields to uppercase 7-42
  define fields 7-43, 8-34
  define include/exclude fields 7-60
  define include/exclude records 7-61
  enable exception processing 7-44
  include fields 7-59
  move fields 7-44, 8-35
  normalize CPU values 7-58
  perform account code conversion 7-43, 8-34
  print proration report 7-51
  proration match length 7-51
  proration table 7-51
  proration type 7-50
  process priority, setting 4-46
  proration
    about 7-50
  options, setting 7-50 to 7-55
processing data (UNIX/Linux)
  about 8-3
  scripts for 8-47 to 8-49
processing data (Windows)
  about 7-3
  events, viewing 7-38 to 7-39
  in ITUAM Administrator 7-38
  process options 7-25
  account code search fields 7-35
  add new clients to CIMSClient table 7-35
archive process files 7-24
back load data 7-33
check for bad file input 7-31
CIMSAcct input file 7-28
CIMSAcct input record date 7-27
CIMSAcct input record type 7-27
CIMSAcct output file 7-28
CIMSAcct trace flag 7-31
CIMSBill input file 7-34
CIMSBill input record date 7-32
CIMSBill input record type 7-32
CIMSBill output files 7-34
CIMSBill trace flag 7-36
client search 7-35
default close day 7-32
eliminate duplicates (from Ident file) 7-29
generate ODBC INF file 7-26
include fields 7-28
load CIMSAcct Detail file 7-25
load CIMSBill Detail file 7-25
load Ident file 7-24
load Summary file 7-24
process definition path 7-23
process description 7-23
process name 7-23
remove output files before processing 7-24
run CIMSAcct option 7-24
run CIMSBill option 7-24
use shift codes 7-33
results of, viewing 7-37
setting processing options in ITUAM Administrator 7-21 to 7-37
ProRate.wsf script C-16
proration about 7-50
account code match length setting 7-51
enabling 7-50
money vs. resources 7-55
options, setting 7-50 to 7-55
report, printing 7-51
table
creating 7-51
examples 7-52 to 7-54
specifying 7-51
published reports about 4-44, 5-23
creating 5-23
creating a report cycle for 5-27 to 5-35
deleting 5-26
distributing 5-24
drill down in 5-50
folder structure for 5-25 to 5-26
path setting 2-88, 4-44
PDF, option for publishing as 4-45
sample job file for 5-45 to 5-46
security for 5-48
virtual directory for, creating 5-49
PurgeLoads.wsf script C-17
purging database loads 6-21, 6-22, C-17
R
rate codes about 4-9
adding 4-9 to 4-12
adding to rate groups 4-11, 4-18
editing 4-10 to 4-12
in the CSR or CSR+ file 1-10
moving to another rate group 4-18
rates for calculating 9-9 to 9-15
updating in ITUAM Administrator 4-10
updating in ITUAM Financial Modeler 9-12
rebilling C-19 to C-21
removing 4-13
removing from rate groups 4-18
setting shifts for 4-13
rate groups about 4-16
adding 4-11, 4-16 to 4-17
adding rate codes to 4-11, 4-18
changing descriptions of 4-17
changing sequence of 4-18
changing titles of 4-17
moving rate codes 4-18
removing 4-17
removing rate codes from 4-18
rate tables alternate 4-15
adding 4-15
removing 4-15
duplicating 4-15
exporting 6-11, 6-12
loading 6-11, 6-12, C-27
STANDARD 4-9
RateIdentifiers table, updating 6-13
rates See rate codes
Index

Rebill.wsf script C-19 to C-21
removing
account code structure levels 4-7
alternate account code structures 4-8
alternate rate tables 4-15
budgets for clients 4-23
client contacts 4-24
clients 4-21
clients from user groups 4-37
cost models 9-16
cost pools and subpools 9-6
database loads 6-21, 6-22, C-17
ITUAM Data Sources 6-6
previous ITUAM Processing Engine output
(Windows) 7-24
rate codes 4-13
rate codes from rate groups 4-18
rate groups 4-17
rate shifts 4-14
report groups 5-20
reports from report groups 5-20
reports from reports list 5-18, 5-35
reports from user groups 4-36
unused identifiers 4-40
from the CIMSDetailIdent table C-12
from the CIMSIdent table C-12
user groups 4-36
users 4-31
users from a group 4-36
Web headlines 4-38
renaming
alternate account code structure 4-8
cost models 9-16
ITUAM Data Sources 6-6
report groups 5-20
report cycles
adding 5-27 to 5-35
editing 5-35
example set up for 5-42
parameters, setting 5-36 to 5-41
removing 5-35
running 5-44 to 5-47
report groups
about 5-19
adding 5-19 to 5-20
adding reports to 5-20
changing description of 5-20
removing 5-20
removing reports from 5-20
renaming 5-20
re-sorting display order of 5-21
types of 5-19
ReportDistribution.wsf script C-30
sample job file for 5-45 to 5-46
Reporting Services
components of 2-18
configuring for use with ITUAM Web Reporting
2-100 to 2-104
installing 2-18 to 2-20
licensing 2-18
system specifications
for designing reports 2-9
for running reports 2-19
troubleshooting 11-15
reports
adding to reports list 5-17 to 5-18
custom
about 1-9
path setting 2-88, 4-44
designing, specifications for 2-9
editing settings 5-18, 5-28
last reporting date setting 4-45
location of 5-3
logo for, changing 5-22
parameters for 5-37 to 5-41
customizing 5-14 to 5-16
path setting
custom reports 2-88, 4-44
published reports 2-88, 4-44
standard reports 2-88, 4-44
published
about 4-44
path setting 2-88, 4-44
publishing in batch 5-23 to 5-50
removing from reports list 5-18
re-sorting display order of 5-21
security, setting 4-45
standard
about 1-9
path setting 2-88, 4-44
types of 5-4
user-defined reports default group, setting 5-21
ResourceConversion.wsf script C-19 to C-21
restoring database loads 6-21
SampleExportSummary.wsf script C-23
SampleSQLMaintenance.bat script C-24
Schedule.wsf script C-26
scripts
  AllAccts.wsf C-38 to C-40
  batch reporting C-29
  BatchReport.wsf C-31 to C-37
  BuildCSRFromDB.wsf C-6
  BulkUserLoad.wsf C-22
  CIMSLib.wsf C-7
  CIMSUtil.wsf C-7
  ClientPropogate.wsf C-7
  ConvertSummaryDailyToMonthly.wsf C-8 to C-10
  CSRAggregator.wsf C-11
directory for 8-47
  DropIdentBeforeLoad.wsf C-12
  DropIdentFromDB.wsf C-12
  EmailDistribution.wsf C-40
  FTP.wsc C-13
  FTPSample.wsf C-13
  ListUnusedIdentifiers.wsf C-13
  LoadClientTableFromCSVFile.wsf C-42
  nightly.pl 8-49
  nightly.sh 8-47
  ODBC parameters for C-42
  OracleLogonTrigger.bat C-14
  procCIMS.pl 8-49
  ProRate.wsf C-16
  PurgeLoads.wsf C-17
  Rebill.wsf C-19 to C-21
  ReportDistribution.wsf C-30
    sample job file for 5-45 to 5-46
  ReportParms.wsf C-29
  ResourceConversion.wsf C-19 to C-21
running
  from a batch file C-5
  from Job Runner C-3 to C-4
  SampleExportSummary.wsf C-23
  SampleSQLMaintenance.bat C-24
  Schedule.wsf C-26
  TableManager.wsf C-27
  ZeroCost.wsf C-28
Secure Sockets Layer See SSL, enabling for Web site
shifts
  enabling CIMSBILL to process 7-33
  enabling CIMSBill to process D-41
recalculating 7-29
removing 4-14
setting 4-13
SQL Server database
  connecting to 2-64 to 2-71
  creating and setting up 2-60 to 2-71
  ITUAM Data Source for, creating 2-64 to 2-71
  simple recovery, setting 6-5
  user logins, creating 2-61 to 2-63
  versions supported by ITUAM 2-7
SQL Server JDBC driver, installing 3-16
SQLnet.ora file, modifying 2-73
SSL, enabling for Web site 2-97
standard reports
  about 1-9
  path setting 2-88, 4-44
starting
  ITUAM Administrator
    from IBM Director 2-111
    from Windows Start menu 2-83
  ITUAM Financial Modeler 9-3
  ITUAM Processing Engine Administrator 3-19
  ITUAM Web Console 10-3
  ITUAM Web Reporting 2-110
Step element
  attributes for 8-17
Summary file
  about B-11, B-12
  creating from CIMSSummary table C-23
  layout of B-11 to B-12
  load option (Windows) 7-24
system
  architecture 1-4 to 1-13
  specifications
    browser 2-9
    client (Windows computer) 2-8
    Crystal Reports 2-9
    database 2-7
    ITUAM application server (Windows) 2-5 to 2-6
    ITUAM Processing Engine on UNIX or Linux 3-4
    Reporting Services 2-9, 2-19
    Web server 2-5 to 2-6
TableManager.wsf script C-27

Tables, database
- Auditing 4-52
- Converting daily summary data to monthly summary data C-8 to C-10
- Creating 6-13
- Description of A-4 to A-50
- Dropping 6-13
- ERDs (Entity Relationship Diagrams) A-51 to A-56
- Exporting 6-11
- Loading 6-11
- Profiling 6-24
- Purging load data from C-17
- Viewing 6-13

Transactions
- Auditing 4-52
- Parameters for, customizing 5-14 to 5-16
- Troubleshooting 11-3 to 11-20

Upgrading
- ITUAM on a Windows system 2-32
- The ITUAM database 6-25
- Use bulkload interface 7-25

Users and groups
- About 4-27
- Groups
  - Adding 4-32
  - Assigning administrative privileges for 4-27, 4-33
  - Clients, adding 4-37
  - Clients, removing 4-37
  - Default 4-27
  - Editing 4-33 to 4-34
  - Removing 4-36
  - Reports, adding 4-36
  - Reports, removing 4-36
- Users
  - Adding 4-27
  - Adding to a group 4-35
  - Assigning administrative privileges for 4-27, 4-33
  - Bulk loading C-22
  - Crystal Viewer, setting 4-28
  - Default 4-27
  - Editing 4-28 to 4-30
  - Enabling automatic log on for ITUAM Web Reporting 4-29
  - Password
    - Default 4-27
    - Setting 4-30
  - Removing 4-31
  - Removing from a group 4-36

Virtual directories for Web reporting
- Using multiple directories 6-8
- Using one directory 6-8

Web
- Headlines
  - About 4-38
  - Adding 4-38
  - Editing 4-38
  - Removing 4-38
- Reporting
  - Auto logon for, enabling 4-48
  - Starting 2-110
  - Starting and ending account code levels for, setting 4-47
  - Using multiple databases for 6-8 to 6-9

Server
- About 1-8
- Installing on a separate computer 2-93, 2-99
- Setup instructions 2-93 to 2-97
- Specifications 2-5 to 2-6
- Site
  - Crystal Report Viewer, choosing 4-47
  - Customizing 4-50 to 4-51
  - Secure Sockets Layer (SSL), enabling 2-97
  - Session time-out setting 4-47
- User, required folder permissions 2-96

Web Console See ITUAM Web Console

Windows user account, creating for ITUAM 2-34

Zero costing, about 4-11
ZeroCost.wsf script C-28